
Adding Notes/FX fields to a Notes form
You exchange data between Notes and 1-2-3 by adding a field to a Notes form that matches the name of a 1-2-3 
Workbook Properties field or range name that is defined for Notes/FX™.
1. In Notes, choose Design - Forms from the Folders navigator.
2. Select a form to edit, or choose Create - Design - Form to create a new form.
3. Choose Create - Field.
4. Enter the Notes field name of a 1-2-3 Workbook Properties field or range name that is defined for Notes/FX.

{button ,AL(`H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_DETAILS',1)} See details
{button ,AL(`H_EMBEDDING_A_123_OBJECT_IN_AN_EXISTING_NOTES_FORM_STEPS;H_ENABLING_DOC_IN

FO_FIELDS_FOR_EXCHANGE_WITH_NOTES_STEPS;H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;'
,0)} See related topics



Creating a new Notes document
If a Notes form contains an embedded 1-2-3 workbook object, Notes embeds a new copy of the object in each new 
document you compose.
1. In Notes, choose Create.
2. Choose the name of a form that contains an embedded 1-2-3 workbook object.
3. If the form does not automatically start 1-2-3, double-click the 1-2-3 workbook object.
4. In 1-2-3, enter new information in the workbook.

{button ,AL(`H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_STEPS',0)} See related topics



Details: Adding Notes/FX fields to a Notes form
1-2-3 Workbook Properties fields
To create a field that exchanges Workbook Properties data, use a Notes field name and data type listed in the table 
below.

Workbook Properties
field

Notes field
name

Data
type

Created by From Text
Title Title Text
Subject Subject Text
Keywords Categories Text
Description DocumentComments Text
Revision history RevisionComments Text
Created Date Date
Last edited LastRevisionDate Date
Last edited by LastEditor Text
Total revisions NumberofEdits Number
Total edited time EditingTime Number
Sheets SizeInPages Number
Size SizeInCharacters Number
(not displayed) DocumentClass Text
(not displayed) PageTitles Text

{button ,AL(`H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_STEPS',1)} Go to procedure



Details: Embedding a 1-2-3 workbook object in a Notes document
By embedding a 1-2-3 workbook object in an existing Notes document, you can:

• Use Notes to store different 1-2-3 sheets
• Collect data for a group of otherwise unrelated sheets
• Use Notes to distribute 1-2-3 sheets to members of your workgroup
• Use Notes dial-in features to allow remote users to work on 1-2-3 sheets
• Use Notes to view and sort the 1-2-3 sheets according to contents of Notes/FX fields

For more information, see your Notes documentation.

{button ,AL(`H_EMBEDDING_A_123_OBJECT_IN_AN_EXISTING_NOTES_FORM_STEPS',1)} Go to procedure



Details: Embedding a 1-2-3 workbook object in a Notes form
By embedding a 1-2-3 workbook object in a Notes form, you can:

• Use a common template for all 1-2-3 sheets.
• Include a consistent set of fields in all 1-2-3 sheets.
• Provide a consistent 1-2-3 sheet style for a group of users who share the same Notes database.
• Use Notes security features to protect 1-2-3 sheets from unauthorized reading or editing.
• Use Notes views to organize and categorize 1-2-3 sheets for tracking and reporting. For example, you can see 

which sheets were created in a particular month or on which projects each staff member worked.
• Use Notes formulas to track the tasks for a project. For example, you could track the number of days spent 

working on a group of 1-2-3 sheets on a project.
For more information, see your Notes documentation.

{button ,AL(`H_EMBEDDING_A_123_OBJECT_IN_A_NOTES_FORM_DESIGN_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;',0)} See related topics



Details: Setting up named ranges to exchange data with Notes
Adding new Notes/FX fields from the Workbook Properties dialog box
When you set up a named range as a Notes/FX field, 1-2-3 adds the range to the list of field names on the Notes/FX 
Fields tab in the Workbook Properties dialog box. 
You can also add new Notes/FX fields by choosing New Field on the Notes/FX Fields tab in the Workbook Properties 
dialog box. Both the Workbook Properties dialog box and the InfoBox list the same ranges as Notes/FX fields.

Notes data types and exchange direction 
The Notes data type and exchange direction of a 1-2-3 range depends on the type of range.

1-2-3 range type Notes data type Exchange 
direction

Single-cell range Text, number, or 
date

Two-way

Single-cell range Computed One-way, from 
Notes to 1-2-3

Protected range Text, number, or 
date

One-way, from 1-2-
3 to Notes

Formula Number One-way, from 1-2-
3 to Notes

Multiple-cell range Text, number, or 
date with "Allow 
multiple values"

Two-way

NOTES FIELDS tables from previous releases of 1-2-3
In previous releases of 1-2-3, tables (ranges) containing Notes/FX fields were named 'NOTES FIELDS.'" This release
of 1-2-3 still includes support for NOTES FIELDS tables. However, it's best to replace NOTES FIELDS tables with 
range name entries in the Workbook Properties dialog box.
If you are using a sheet that has a NOTES FIELDS table, do not create any Notes/FX ranges that overlap with the 
NOTES FIELDS table. A field name in the list of Notes/FX fields takes precedence over the same name in a NOTES 
FIELDS table. You can use other fields listed in the NOTES FIELDS table with Notes/FX.

{button ,AL(`H_SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_STEPS',1)} Go to procedure



Embedding a 1-2-3 workbook object in a Notes document
You can embed a 1-2-3 workbook object in any rich text field in an existing Notes document that contains Notes/FX 
fields, and update the Notes/FX fields from the 1-2-3 workbook.
1. In Notes, open a document for editing.
2. Position the insertion point where you want to insert the 1-2-3 workbook object.
3. Choose Create - Object.
4. To embed a new 1-2-3 workbook object in the Notes document, select "Create a new object" and select "Lotus 1-

2-3 9 Workbook" as the object type.
5. To embed an existing 1-2-3 workbook as an object in the Notes document, select "Create an object from a file" 

and specify an existing 1-2-3 workbook.
6. Click OK.

{button ,AL(`H_EMBEDDING_A_123_OBJECT_IN_AN_EXISTING_NOTES_FORM_DETAILS',1)} See details
{button ,AL(`H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;',0)} See related topics



Embedding a 1-2-3 workbook object in a Notes form
You can embed a 1-2-3 workbook object anywhere in a Notes form that contains Notes/FX fields. New documents 
composed using this form automatically include the embedded 1-2-3 workbook object.
1. In Notes, choose Create - Design.
2. Choose Form.
3. Position the insertion point where you want to insert the 1-2-3 workbook object.
4. Choose Create - Object.
5. To embed a new 1-2-3 workbook object in the Notes document, select "Create a new object" and select "Lotus 1-

2-3 9 Workbook" as the object type.
6. To embed an existing 1-2-3 workbook as an object in the Notes form, select "Create an object from a file" and 

specify an existing 1-2-3 workbook.
7. Click OK.
8. Close the Notes form.
9. Click Yes to save the form.

{button ,AL(`H_EMBEDDING_A_123_OBJECT_IN_A_NOTES_FORM_DESIGN_DETAILS',1)} See details
{button ,AL(`H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;',0)} See related topics



Overview: Exchanging data between 1-2-3 and Notes
Notes/FX lets you exchange field data between 1-2-3 and Notes. With Notes/FX, you can:

• Display any 1-2-3 Workbook Properties field in a Notes form
• Pass text and values in a 1-2-3 named range back and forth between Notes and 1-2-3
• Use NotesFlow to publish Notes actions to 1-2-3

Using Notes/FX
To use Notes/FX with 1-2-3, complete the following tasks:

• Define fields and ranges to exchange
• Embed a 1-2-3 workbook object that contains those fields or ranges in a Notes document or form design
• Create new Notes documents that exchange data with embedded 1-2-3 workbook objects

For example, you can create a Notes form for a sales report and embed a 1-2-3 workbook object in the form. When 
you compose a new report, Notes passes data to 1-2-3, which uses this information to calculate the report.
When you complete the sales report and close 1-2-3, you can update the 1-2-3 workbook object embedded in the 
Notes form. Information from the sales report, such as the name and address of the company and the total sales for 
the period, now appears in the Notes document or in the Notes view. The sales report is centrally stored in a Notes 
database with other sales reports.

Using NotesFlow to publish Notes actions to 1-2-3
Notes/FX also lets you use NotesFlow technology to publish Notes actions to 1-2-3 and other Lotus desktop 
products. With NotesFlow, you can create a Notes action using formulas or scripts and publish the action in a Notes 
form. When you edit or view a 1-2-3 workbook object that is embedded in the form, the NotesFlow action appears in 
the 1-2-3 Actions menu.
NotesFlow publishing lets you define a sequence of tasks that gives you control over the flow of work. For example, 
you can integrate file creation and storage in other desktop products with the document sharing, storage, security, 
and management tools in Notes.
For more information about NotesFlow publishing, see the Notes application developer documentation.

{button ,AL(`H_SETTING_UP_NOTES_FIELD_EXCHANGE_OVER;H_ADDING_NOTESFX_FIELDS_TO_A_NOTE
S_FORM_STEPS;H_CREATING_A_NEW_NOTES_DOCUMENT_STEPS;H_EMBEDDING_A_123_OBJECT_IN_
AN_EXISTING_NOTES_FORM_STEPS;H_EMBEDDING_A_123_OBJECT_IN_A_NOTES_FORM_DESIGN_STE
PS;H_SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_STEPS;H_UPDATING_FIELDS_IN
_A_NOTES_DOCUMENT_FROM_123_STEPS;H_UPDATING_INFORMATION_IN_123_FROM_A_NOTES_DOC
UMENT_STEPS',0)} See related topics



Overview: Setting up Notes/FX
To set up Notes/FX, you first embed a 1-2-3 workbook object in a Notes form or document. Then, you define fields or 
ranges in the embedded workbook object to exchange with corresponding fields in Notes. You can also run Notes 
formulas and scripts while working in an embedded 1-2-3 workbook object.

What can you exchange?
You can exchange the following types of data between 1-2-3 and Notes:

• 1-2-3 Workbook Properties fields
• Data in 1-2-3 cells and named ranges

1-2-3 Workbook Properties fields
1-2-3 supplies Workbook Properties fields with predefined names that contain information about a workbook file, such
as its description and creation date. You can use any of these fields for exchange with Notes.

1-2-3 cells and named ranges
To use 1-2-3 cells and named ranges with Notes/FX, you specify a range name in 1-2-3 that matches a Notes field 
name as a Notes/FX field. You can exchange text and numbers in both directions. Data in protected cells and formula
results can only move one way, from 1-2-3 to Notes.

{button ,AL(`H_USING_NOTES_FIELD_EXCHANGE_OVER;H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FOR
M_STEPS;H_CREATING_A_NEW_NOTES_DOCUMENT_STEPS;H_EMBEDDING_A_123_OBJECT_IN_AN_EX
ISTING_NOTES_FORM_STEPS;H_EMBEDDING_A_123_OBJECT_IN_A_NOTES_FORM_DESIGN_STEPS;H_
SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_STEPS;H_UPDATING_FIELDS_IN_A_N
OTES_DOCUMENT_FROM_123_STEPS;H_UPDATING_INFORMATION_IN_123_FROM_A_NOTES_DOCUME
NT_STEPS',0)} See related topics



Setting up named ranges to exchange data with Notes
1. Select the named range.
2. Choose Range - Range Properties.
3. Click the Basics tab.

4. Specify a range name that matches a Notes field name.
5. Select "Notes/FX field."

{button ,AL(`H_SETTING_UP_FIELDS_FOR_TWOWAY_EXCHANGE_WITH_NOTES_DETAILS',1)} See details
{button ,AL(`H_ADDING_NOTESFX_FIELDS_TO_A_NOTES_FORM_STEPS',0)} See related topics



Updating fields in a Notes document from 1-2-3
You can update Notes to reflect any changes made in 1-2-3 Notes/FX fields that support updates to Notes.
1. In Notes, display the document that contains the fields you want to update.
2. Double-click the embedded 1-2-3 workbook object.
3. In 1-2-3, enter any new information into Notes/FX fields.

The Notes document is automatically updated.

{button ,AL(`H_UPDATING_INFORMATION_IN_123_FROM_A_NOTES_DOCUMENT_STEPS;H_USING_NOTES_F
IELD_EXCHANGE_OVER;',0)} See related topics



Updating information in 1-2-3 from a Notes document
When the 1-2-3 sheet contains editable fields defined for use with Notes/FX, you can update these fields in the Notes
form.
1. In Notes, select the document you want to edit.
2. Choose Actions - Edit Document.
3. Enter new information in the Notes/FX fields.

The 1-2-3 workbook object is automatically updated.

{button ,AL(`H_UPDATING_FIELDS_IN_A_NOTES_DOCUMENT_FROM_123_STEPS;H_USING_NOTES_FIELD_
EXCHANGE_OVER;',0)} See related topics



Creating an add-in
You can create an add-in file using the scripts in the current workbook. 1-2-3 leaves the source workbook in memory, 
and creates the add-in file.
1. Choose File - Add-Ins - Create Add-In.
2. Specify the file name and path in which to save the add-in file.
3. (Optional) Enter text in the "Description" box.
4. Click Save.

{button ,AL(`H_CREATING_ADDINS_DETAILS',1)} See details
{button ,AL(`H_ADDINS_OVER;H_LOADING_AN_ADDIN_STEPS;H_REGISTERING_ADDINS_STEPS;H_REMOVI

NG_AN_ADDIN_FROM_MEMORY_STEPS;H_REMOVING_ADDINS_FROM_THE_ADDIN_LIST_STEPS',0)} 
See related topics



Details: Creating an add-in
Compiling new add-ins
When you create an add-in, 1-2-3 compiles all the scripts in the source workbook. If there are any compile-time 
errors, they are shown in the Errors list in the Script Editor and the Create Add-In command is terminated. If there are
no compile-time errors, the Create Add-In dialog box appears.

Saving add-ins
When you create a new add-in, a dialog box appears asking if you want to save it.    Click Yes to name and save the 
add-in.

Naming new add-ins
When you save a new add-in, 1-2-3 automatically gives it the same name as the source file, but with the file 
extension .12A. All add-ins for this release of 1-2-3 should use this file extension.

{button ,AL(`H_CREATING_ADDINS_STEPS',1)} Go to procedure
{button ,AL(`H_SAVING_A_NEW_WORKBOOK_STEPS',0)} See related topics



Details: Loading add-ins
Specifying custom functions in add-ins
When you load an add-in that contains global functions, you can use those functions from any active file. You do not 
have to include the directory location when you specify the file name.

Reloading add-ins
If you select an add-in to be loaded, that add-in will remain checked and will be reloaded into memory in subsequent 
1-2-3 sessions. If you do not want an add-in loaded into memory, you must select it again to remove the check mark.

{button ,AL(`H_LOADING_AN_ADDIN_STEPS',1)} Go to procedure



Details: Unloading add-ins
If you remove an add-in from memory, you do not delete the file from disk. However, you must register the add-in 
before you can load it again. Any formula that contains references to @functions from an add-in not in memory 
evaluates to ERR.

{button ,AL(`H_REMOVING_AN_ADDIN_FROM_MEMORY_STEPS',1)} Go to procedure
{button ,AL(`H_ADDINS_OVER;H_CREATING_ADDINS_STEPS;H_LOADING_AN_ADDIN_STEPS;H_REGISTERIN

G_ADDINS_STEPS',0)} See related topics



Loading add-ins
You can select which add-ins to load into memory each time you start 1-2-3. An add-in must be registered before you 
can load it.
1. Choose File - Add-Ins - Manage Add-Ins.

The Manage Add-Ins dialog box appears, and lists all registered add-ins.
2. Click each add-in name to select the add-ins you want to load.

A check mark appears to the left of each selected add-in.
3. Choose Done.

The selected add-ins are loaded, and can now be used in 1-2-3.

{button ,AL(`H_LOADING_AN_ADDIN_DETAILS',1)} See details
{button ,AL(`H_ADDINS_OVER;H_CREATING_ADDINS_STEPS;H_REGISTERING_ADDINS_STEPS;H_REMOVIN

G_AN_ADDIN_FROM_MEMORY_STEPS;H_REMOVING_ADDINS_FROM_THE_ADDIN_LIST_STEPS;H_123_L
OADING_THE_DATA_QUERY_ADDIN_STEPS;::S98',0)} See related topics



Manage Add-Ins dialog box
You can use this dialog box to load an add-in, register an add-in in the add-in list, or remove an add-in from either 
memory or the add-in list.

Choose a task
Loading an add-in
Registering an add-in
Unloading an add-in
Removing an add-in from the Manage Add-Ins list

{button ,AL(`H_ADDINS_OVER',0)} See related topics



Overview: Add-ins
An add-in is a special .123 file, created by Lotus or other software developers, that you can use with 1-2-3 to extend 
its capabilities. Add-ins let you package a workbook file so that the functionality the file contains appears to be built 
into 1-2-3. Users cannot change or read these files.
1-2-3 add-in files can contain add-in applications or @functions. You access an add-in file by calling the global 
subroutines and/or functions with preassigned custom menu commands or a published set of @functions, or when 
you press an assigned CTRL-key combination.
Add-in applications perform a specific task in 1-2-3. Add-in @functions are used in formulas just like 1-2-3 
@functions.
You can create add-ins, register them, load them into memory, and remove them from memory.
You can't use add-ins designed for previous 1-2-3 releases that run in other environments, such as DOS or OS/2. If 
you want to use such an add-in, contact the developer or manufacturer of the add-in to see if a version is available for
this release of 1-2-3.

Using the Data Query Add-In (DQA)
The Data Query Add-In (DQA), an add-in that comes with 1-2-3, offers data query functionality that is similar to that in
1-2-3 Release 5. When you load the add-in, you can open 1-2-3 Release 5 files that contain query tables and work 
with them in the current version of 1-2-3 much as you did in 1-2-3 Release 5. You can also create new query tables to
examine and analyze data from one or more database tables.

{button ,AL(`H_CREATING_ADDINS_STEPS;H_LOADING_AN_ADDIN_STEPS;H_REGISTERING_ADDINS_STEP
S;H_REMOVING_AN_ADDIN_FROM_MEMORY_STEPS;H_USING_ADDIN_ATFUNCTIONS_OVER;H_REMOVI
NG_ADDINS_FROM_THE_ADDIN_LIST_STEPS;H_123_LOADING_THE_DATA_QUERY_ADDIN_STEPS;::S98',
0)} See related topics



Registering add-ins
You can register add-ins that do not appear in the list of add-ins in the Manage Add-Ins dialog box.
1. Choose File - Add-Ins - Manage Add-Ins.
2. Click Register.
3. Specify the directory that contains the add-in you want to register.

The add-ins included in the specified directory are listed.
4. Select the add-in you want to register.
5. Click Open.

{button ,AL(`H_ADDINS_OVER;H_CREATING_ADDINS_STEPS;H_REGISTERING_ADDINS_STEPS;H_REMOVIN
G_AN_ADDIN_FROM_MEMORY_STEPS;H_LOADING_AN_ADDIN_STEPS;H_REMOVING_ADDINS_FROM_T
HE_ADDIN_LIST_STEPS',0)} See related topics



Removing add-ins from the Manage Add-Ins list
You can remove add-ins from the list of registered add-ins in the Manage Add-Ins dialog box.
1. Choose File - Add-Ins - Manage Add-Ins.

The Manage Add-Ins dialog box appears, and lists all registered add-ins.
2. Click the add-in(s) you want to remove from the list.
3. Click Remove.

{button ,AL(`H_ADDINS_OVER;H_CREATING_ADDINS_STEPS;H_REGISTERING_ADDINS_STEPS;H_REMOVIN
G_AN_ADDIN_FROM_MEMORY_STEPS;H_LOADING_AN_ADDIN_STEPS',0)} See related topics



Unloading add-ins
You can select which registered add-ins to remove from memory, or unload.
1. Choose File - Add-Ins - Manage Add-Ins.

The Manage Add-Ins dialog box appears, and lists all registered add-ins. A check mark appears to the left of the 
add-ins selected to be loaded into memory.

2. Click the add-in(s) you want to unload.
The check mark next to the add-in(s) disappears.

3. Click Done.
If the add-in displays a context menu,    the menu will remain until you restart 1-2-3. If you try to use a context 
menu after unloading its add-in, you will receive an error message. 

{button ,AL(`H_REMOVING_AN_ADDIN_FROM_MEMORY_DETAILS',1)} See details
{button ,AL(`H_ADDINS_OVER;H_CREATING_ADDINS_STEPS;H_LOADING_AN_ADDIN_STEPS;H_REGISTERIN

G_ADDINS_STEPS;H_REMOVING_ADDINS_FROM_THE_ADDIN_LIST_STEPS',0)} See related topics



Using add-in @functions
You use add-in @functions just as you use 1-2-3 @functions.

Add-in @function format
Add-in @functions have the same format as any 1-2-3 @function:

@FUNCTION
or
@FUNCTION(arg1,arg2,...,argn)

where:
@FUNCTION represents the name of the @function. It tells 1-2-3 which calculation to perform.
arg1,arg2,...,argn represent arguments. Arguments supply the information 1-2-3 needs to complete the @function
calculation. For example, when 1-2-3 encounters the function @SUM(B4..B25), the argument B4..B25 tells 1-2-3 
to add the values in the range B4..B25.

File references in add-in @functions
You cannot have more than one add-in @function with the same name in memory at the same time, even if the add-
in @functions are located in different files. 1-2-3 always uses the @function from the first add-in file loaded into 
memory.
You can choose an @function from another .123 file in memory by specifying @<<FILENAME>>FUNC.    You don't 
need to specify this string for add-ins, as 1-2-3 searches them automatically. While add-ins supported in earlier 
versions of 1-2-3 won't work in the current release of 1-2-3, you can rewrite an old @function in a new add-in.
A candidate @function is any global function that returns a string or number, and whose arguments are strings, 
numbers, or range objects. Range object arguments must be declared as Variant. If a number is returned, it must be 
of data type integer, double, or long.

{button ,AL(`H_ADDINS_OVER',0)} See related topics



Argument types
Many @functions and macros require you to supply data to work on. This data is called an argument. For example, in
the following @function, the argument is the range address D1..D7, enclosed in parentheses:

@SUM(D1..D7)
1-2-3 @functions and macros accept four types of arguments: condition, location, text, and value.

Condition
A condition is an expression that uses a logical operator (=, <, >, <>, >=, <=, #NOT#, #AND#, and #OR#), or the 
address or name of a cell containing a logical expression. You can also use a formula, @function, or a number (1 for 
true, 0 for false) as a condition. The @function or macro evaluates the condition argument and proceeds according to
whether it is true or false.

Location
A location is the address or name of a range, or a formula or @function that produces the address or name of a 
range. A location argument can refer to a single cell or a multiple-cell range in one or more sheets in a single 
workbook.

Text
Text is any sequence of letters, numbers, and symbols enclosed in " " (quotation marks), the address or name of a 
cell that contains a label, or a formula or @function that produces a label. 
Note In @functions that use text arguments for dates, you should always specify a 4-digit year to make sure you get 
the results you want -- for example, "12/31/2005." If you specify a 2-digit year, 1-2-3 uses the date setting in the 1-2-3
Preferences dialog box to determine whether the year refers to the 20th or the 21st century.

Value
A value is a number, the address or name of a cell that contains a number, or a formula or @function that produces a 
number.

{button ,AL(`H_FUNC_BASICS;H_FUNC_GUIDE_STAT;H_FUNC_GUIDE_DBASE;H_ENTERING_AN_ATFUNCTIO
N_STEPS;H_123_MACROS_OVER;H_WRITING_A_MACRO_STEPS;H_CHANGING_THE_ARGUMENT_SEPA
RATOR_STEPS;',0)} See related topics



Details: Entering an @function
Other ways to enter an @function
You can also enter an @function by typing it directly in the cell and enclosing the appropriate arguments in 
parentheses.
You can add the @functions you use frequently to the @function menu; then you can enter them without having to 
search the entire list of @functions.

Replacing range argument placeholders
When you enter an @function using the menu or the dialog box, 1-2-3 inserts the @function, along with placeholders 
for any arguments. To replace the placeholders for range arguments, type a range address or name, choose a name 
from the navigator, or select a range in the sheet.

Formatting @function results
For selected @functions, 1-2-3 automatically formats the result using the number format of the specified arguments. 
For example, if A1..A4 is formatted as Japanese Yen, and you enter @SUM(A1..A4) in A5, 1-2-3 formats the result in 
A5 as Japanese Yen. 
1-2-3 does not automatically format the @function result if you:

• formatted the cell before entering the @function in it
• specified arguments that are in a different file
• combined an @function that 1-2-3 formats with an @function that 1-2-3 doesn't format

Viewing @functions
You can always view the @function in the selected cell by looking in the contents box. To display the @function in the
cell, instead of the result, change the number format of the cell to Formula format.

Printing @functions
You can print @functions along with cell contents. To print @functions, choose File - Preview & Page Setup, click the 
Include tab, and select "Formulas" in the "Show" list.

Documenting an @function
You can annotate a cell's contents using a cell comment. To add a cell comment, use Range - Cell Comment.

Using formula markers
You can use formula markers to identify cells that contain @functions. Formula markers are turned off when you first 
start 1-2-3. To turn them on, use View - Set View Preferences.

{button ,AL(`H_ENTERING_AN_ATFUNCTION_STEPS',1)} Go to procedure
{button ,AL(`H_ADDING_AN_ATFUNCTION_STEPS;H_FORMATTING_NUMBERS_STEPS;H_CREATING_A_CELL

_COMMENT_STEPS;H_PRINT_CHANGING_SELECTION_STEPS;',0)} See related topics



Entering an @function
When you enter an @function, the result of the calculation, not the @function, appears in the cell. The @function 
appears in the contents box.
1. Select the cell where you want to enter the @function.
2. Click the @function selector.

3. If the @function you want appears on the @function menu, choose it and continue to step 6.
If the @function you want does not appear on the @function menu, choose List All.

4. Select the @function from the "@Functions" list.
Tip To restrict the number of @functions in the list, select the category containing the @function.

5. Click OK.
The @function, with argument placeholders, appears in the cell. 

6. Replace any argument placeholders with the appropriate arguments.
7. Press ENTER.
If 1-2-3 displays *** (asterisks) in the cell, widen the column.

{button ,AL(`H_ENTERING_AN_ATFUNCTION_DETAILS',1)} See details
{button ,AL(`H_FUNC_BASICS;H_FUNCTION_FORMAT_OVER;H_COMMON_ERRORS_IN_FORMULAS_OVER;H

_INSTALLING_FUNCTION_HELP_STEPS;H_FUNCTIONS_ALPHA_REF;h_sizing_columns_steps;H_ARGUMEN
T_TYPES_OVER;H_CHANGING_THE_ARGUMENT_SEPARATOR_STEPS;',0)} See related topics



Entering criteria in database @functions
Criteria tell 1-2-3 which records to select from a database table.

Matching an exact label or number
Enter a label or number exactly as it appears in the database table as the value portion of the criteria. For example, 
enter CITY="Boston" as the criteria. To match a number exactly, enter the number, as in SALARY=45000.
Note 1-2-3 does not distinguish between uppercase and lowercase letters. For example, the label SMITH matches 
the entries Smith and smith.

Matching similar labels
Use wildcard characters to match similar labels. For example: 

PERIOD="Q?"

Matching a date value
When a field contains date entries, enter a date. You can enter numbers or date @functions.
For example, to select everyone born before January 8, 1967, enter: 

BIRTHDAY<@DATE(1967,1,8)

Matching values in a sheet
Use absolute references to match values in the sheet that are outside of the database table.
For example, to find all records in which sales is less than or equal to the number in cell D25, enter:

SALES<=$D$25

{button ,AL(`H_ENTERING_MULTIPLE_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;H_REFERRING_TO_MUL
TIPLE_TABLES_IN_CRITERIA_OVER;H_FUNC_GUIDE_DBASE;',0)} See related topics



Entering multiple criteria in database @functions
You can select records that meet more than one condition. For example, you might want to see records for sales in 
May that were greater than $2,000, or you might want to see sales records for May and June.

Meeting all conditions (#AND#)
Use #AND# to select records in which all conditions are true. For example, to select only records in which the month 
is May and the sales value is greater than 2000, enter this criteria:

Month="May"#AND#Sales>2000

Meeting at least one condition (#OR#)
Use #OR# to select records in which at least one of two or more conditions is true. For example, to select records in 
which the month is May or the sales value is greater than 2000, enter this criteria:

Month="May"#OR#Sales>2000

Meeting one condition and excluding one condition (#NOT#)
Use #NOT# to select records in which one condition is true and another condition is false. For example, to select 
records in which the city is Paris and the department is not Sales, enter this criteria:

City="Paris"#AND##NOT#Department="Sales"

{button ,AL(`H_FUNC_GUIDE_DBASE;H_ENTERING_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;H_REFERR
ING_TO_MULTIPLE_TABLES_IN_CRITERIA_OVER',0)} See related topics



Overview: @Functions
1-2-3 @functions are built-in formulas that perform specialized calculations automatically. You can use an @function 
by itself as a formula, combine it with other @functions and formulas, or use it in a script or a macro.
Some @functions perform simple calculations; for example, @SUM(D2..D7) adds the values in the range D2..D7 and
is easier to enter than the formula +D2+D3+D4+D5+D6+D7.
Many @functions, however, simplify your work by performing complex calculations; for example, @NPV calculates 
the net present value of a series of future cash-flow values.

Entering @functions
The 1-2-3 @function menu lists a few of the most commonly used @functions. Click the @function selector to display
the @function menu.

You can quickly use an @function by selecting it from the menu. In addition to the @functions on the menu, 1-2-3 
provides over 300 other @functions. To choose from the complete list of @functions, choose List All from the 
@function menu.
To make entering @functions faster, you can change which @functions appear on the @function menu.

 See related topics

Getting Help on individual @functions
In addition to Help that describes how to use @functions, 1-2-3 provides detailed information on individual 
@functions.
Note Help on individual @functions is installed by default. However, if you ran a customized installation (also called 
"manual install") and chose not to install @Function Help, you do not have Help on individual @functions. You can 
install @Function Help at any time.

 See related topics



Parts of an @function
@Functions can contain these parts: an @ (at sign), the name of the @function, one or more arguments, and 
argument separators.

Arguments
An argument is the data you provide for 1-2-3 to use when it calculates the @function. Depending on the particular 
@function, an argument can be a single value, a range of cells, text, or another @function.
Arguments can be required or optional. You must enter required arguments, but you can omit the optional ones. The 
optional arguments are enclosed in [ ] (brackets) in the descriptions you see in the @Function List dialog box and in 
the Help on individual @functions.
If an @function contains more than one optional argument, you must use the arguments sequentially. You can't use 
an optional argument without using the optional arguments that precede it. You can, however, use an optional 
argument without using subsequent optional arguments.
Some @functions, such as @NOW, @RAND, and @TRUE, don't have arguments.

Argument separators
When you use more than one argument with an @function, you separate the arguments with an argument separator, 
typically a ; (semicolon). You can specify a different argument separator using regional (country) settings in your 
operating system.

Quotation marks
Quotation marks enclose the text for text arguments. For example, the following @function uses the text argument 
Sales Forecast:

@LOWER("Sales Forecast")
1-2-3 assumes that text not enclosed in quotation marks is either a range name or a SmartLabel. 

Parentheses
Parentheses enclose @function arguments. Nested parentheses enclose an @function that you use as an argument 
for another @function. For example, you use nested parentheses when you use @SUM and its argument as the 
argument for @INT as follows:

@INT(@SUM(D1..D7))

{button ,AL(`H_FUNC_BASICS;H_ARGUMENT_TYPES_OVER;H_CHANGING_THE_ARGUMENT_SEPARATOR_S
TEPS;H_INSTALLING_FUNCTION_HELP_STEPS;H_ENTERING_AN_ATFUNCTION_STEPS;',0)} See related 
topics



Help on individual @functions
Help on individual @functions is not currently installed. For information, see Installing Help on individual @functions.

Using the @Function List dialog box
You can use the @Function List dialog box to enter the name of an @function in a cell, along with argument 
placeholders. To display the dialog box if it is not currently displayed, enter @ (at sign) in a cell and press F3 (NAME), 
or click the @function selector and choose List All from the @function menu.

Choose a topic
Entering an @function 
Adding an item to the @function menu
Removing an item from the @function menu

{button ,AL(`H_FUNC_BASICS',0)} See related topics



Database @function arguments
Database @functions scan one or more input database tables, select the records that match the specified criteria, 
and then perform calculations on the selected records in the field you specify.
Note A database @function that refers to external database tables is recalculated each time any value in the sheet 
changes. A database @function that refers only to database tables in the workbook is recalculated only when a value 
the @function depends on changes.

The input argument
input is the name or address of a range that contains a database table or the name of an external table.
There is no limit to the number of tables you can use in input, provided that the total number of characters in the cell 
that contains the @function does not exceed 512.
To use more than one table as an input argument, separate them with valid argument separators. When 1-2-3 
calculates a database @function, it reads the arguments from right to left. 1-2-3 uses the last argument in the 
@function as the criteria, the next to last argument as the field, and the remaining arguments as input tables.
For example, the following formula uses two input tables, SALES and INVENTORY:

@DAVG(SALES;INVENTORY;"PRICE";+Sales.ProductID=
    Inventory.ProductID#AND#PRODUCT="FILTERS")

In this formula, criteria is +Sales.ProductID=Inventory.ProductID#AND#PRODUCT="FILTERS", and field is "PRICE".

The field argument
field is the field name, enclosed in " " (quotation marks), the name or address of a cell containing the field name, or a 
field offset number.
If you use more than one table as an input argument (either in the sheet or from an external database table) and field 
is not a unique field name (it appears in more than one of the input tables), field must be the name of the table 
followed by a period and the field name, enclosed in quotation marks.
For example, if the field name Cost appears in two tables, GOTHAM and MAYFAIR, "GOTHAM.Cost" refers to the 
field name Cost in the table GOTHAM.

The criteria argument
criteria is a criteria formula or the name or address of a criteria range.
If you use only one table as an input argument, you can omit criteria. If you omit criteria, 1-2-3 includes all records 
from input.
If you use multiple tables for input, 1-2-3 performs a relational join on the tables. Therefore, make sure you specify a 
join criteria in the criteria argument. See Referring to multiple tables in criteria.
A criteria range is the name or address of a range that contains at least two rows. The first row lists some or all of the 
field names from a database table; the second and any subsequent rows contain the criteria. The criteria range 
cannot be a 3D range. Criteria are values, labels, formulas, @functions, or logical expressions.
Note @DPURECOUNT accepts only a criteria range; you cannot specify a criteria formula as the criteria argument.

Criteria range examples
A criteria range that specifies all employees who work in the Finance department might look like this:

DEPT
Finance

A criteria range that specifies all employees who work in the Finance department and earn more than $30,000 per 
year might look like this:

DEPT       SALARY
Finance    >30000

{button ,AL(`H_ARGUMENT_TYPES_OVER;H_ENTERING_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;H_EN
TERING_MULTIPLE_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;H_FUNC_BASICS;',0)} See related topics



Statistical @function arguments
Many statistical @functions perform calculations on lists of values, which are represented by the argument named 
list.
list can contain any of the following, in any combination: numbers, numeric formulas, and addresses or names of 
ranges that contain numbers or numeric formulas. You separate elements of list with argument separators.

Labels in list
Labels within ranges in list do not cause statistical @functions to evaluate to ERR. With the exception of @COUNT 
and the statistical @functions that begin with @PURE, 1-2-3 assigns the value 0 to all labels in list (either in a range 
or listed individually) and includes them in calculations.
For example, if you use @AVG to calculate the average of the values in a range and the range contains a label, 1-2-3
considers the label to have the value 0 when it calculates the average.
If you do not use the @PURE statistical @functions, always check for labels in the ranges you use in statistical 
@functions to guard against unexpected results.

Blank cells in list
1-2-3 ignores blank cells in multiple-cell ranges in list, but does not ignore references to blank cells listed individually. 
For example, if you use @AVG to average the values in a range that spans four cells (A1..A4), and the range 
contains a blank cell, 1-2-3 divides the sum by three to find the correct average. If you list those four cells individually,
however (A1;A2;A3;A4), 1-2-3 divides the sum by four.

{button ,AL(`H_ARGUMENT_TYPES_OVER;H_FUNC_BASICS;',0)} See related topics



Getting Help on an @function
If Help on individual @functions is installed, you can get detailed information on what each @function does and how 
to fill in the arguments.
1. Click the @function selector.

2. Choose List All.
3. Select the @function you want from the "@Functions" list.

Tip To restrict the number of @functions in the list, select the category containing the @function.
4. Click Help.

{button ,AL(`H_GETTING_HELP_ON_AN_ATFUNCTION_DETAILS',1)} See details
{button ,AL(`H_FUNC_BASICS;H_INSTALLING_FUNCTION_HELP_STEPS;H_FUNCTIONS_ALPHA_REF',0)} See 

related topics



Details: Getting Help on an @function
Other ways to get Help
To get Help on an @function without using the dialog box, enter the @function name in a cell and then press F1 
(HELP).
To get Help on an @function that is on the @function menu, highlight the @function in the menu and press F1 (HELP).
If you have already entered the @function in the sheet, double-click the cell that contains the @function. Then move 
the insertion point so it is in the name of the @function. Press F1 (HELP) to see the topic for that @function.
To find Help on the individual @functions from the Help Topics dialog box, click the Index tab and search for 
"@Functions, A-Z list." In the A-Z topic, click the button for the letter the @function begins with, and then click the 
name of the @function itself.
You can also use the Find tab in the Help Topics dialog box to perform a full-text search on 1-2-3 Help.

Determining whether the Help is installed
Help on individual @functions is installed by default. However, if you ran a customized installation (also called 
"manual install") and chose not to install @Function Help, you need to install it before you can get Help on individual 
@functions.
To determine whether @Function Help is installed, open the Help Topics dialog box, click the Index tab, and search 
for "@Functions, A-Z list." If that search term is in your Help index, then the Help on individual @functions is installed.

{button ,AL(`H_GETTING_HELP_ON_AN_ATFUNCTION_STEPS',1)} Go to procedure



Installing Help on individual @functions
Help on the individual @functions is automatically installed during a default installation. However, if you installed 1-2-
3 using manual install, and chose not to install @Function Help, you can install it at any time after installing 1-2-3.
Tip Print this topic so you can refer to these instructions while running Install. (Install requires that you exit from all 
open applications.)
1. Insert the 1-2-3 or SmartSuite Install CD-ROM or the first Install disk in the disk drive.

If you install 1-2-3 over a network, make sure the server where the 1-2-3 Install program is stored is connected to 
your computer. To connect to the server, choose Tools - Map Network Drive in the Windows Explorer.

2. Choose Start - Run from the Windows taskbar.
3. If you are installing from CD-ROM, type x:\lotus\install.exe (where x is the drive containing the CD-ROM), and 

click OK. For example, if your CD-ROM drive is the D drive, enter d:\lotus\install.exe.
If you are installing from disks, type x:\install.exe (where x is the drive containing the Install disk), and click OK. 
For example, if your floppy drive is the A drive, enter a:\install.exe.
If you are installing over a network, type x:\path\install.exe (where x is the drive mapped to the server with the 1-
2-3 Install directory, and path is the path to the directory where the 1-2-3 Install program is stored), and click OK. 
For example, if your server is mapped to the Q drive and the path is \lotus\123, enter q:\lotus\123\install.exe.

4. Follow the instructions on the screen until you reach the Install Options dialog box.
5. In the Install Options dialog box, select "Customize features - Manual install," and then click Next.
6. In the "Select 1-2-3 Features to Customize" dialog box, select 1-2-3, and click Customize.
7. Click the Help and Samples tab, and deselect Main 1-2-3 Help, 1-2-3 LotusScript Help, and Sample files (but 

leave @Function Help selected).
8. Deselect all other choices from all other tabs, and click OK.
9. In the "Select 1-2-3 Features to Customize" dialog box, select Approach, and click Customize.
10. Deselect all choices from the Approach and PowerKeys tabs, and click OK.
11. Finish answering all other installation questions, and then click Yes to copy your files.
If you need additional Help while installing the files, click the Help button in the Install dialog boxes.

{button ,AL(`H_FUNC_BASICS;H_GETTING_HELP_ON_AN_ATFUNCTION_STEPS',0)} See related topics



Referring to multiple tables in criteria
When entering criteria in a database @function, you can compare fields from separate tables, as long as you create 
a join formula that follows these rules:

• Precede the field name by the table name and a . (period).
• Enter field names exactly as they appear in the database tables.
• The field names do not have to match, but the two fields must contain the same type of data.
• Entries in one field must match entries in the other field, and one field should not contain duplicate entries.

For example, here is a valid join formula:
+SALES.Item=PRICE.Item_Name

In this formula, there are two tables: one named SALES with a field called Item, and one named PRICE, with a field 
called Item_Name. Item and Item_Name are located in different tables but contain similar data. Each entry in 
PRICE.Item_Name is listed only once but may be listed many times in SALES.Item.
Note 1-2-3 cannot join two database tables that have no fields in common.

{button ,AL(`H_FUNC_GUIDE_DBASE;H_ENTERING_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;H_ENTERI
NG_MULTIPLE_CRITERIA_IN_DATABASE_FUNCTIONS_OVER;',0)} See related topics



When and how formulas recalculate
1-2-3 normally reevaluates formulas automatically each time you change data they refer to. Formulas recalculate in 
order of dependence: if a formula uses the results of other formulas, those formulas recalculate before the one that 
depends on them. 
For example, if a formula in B7 depends on the result of a formula in C28, 1-2-3 recalculates the formula in C28 first, 
even though C28 is farther down the sheet. This is called recalculating in natural order.
Whenever 1-2-3 performs a recalculation pass, it recalculates only those formulas affected by changes in data. 
Because 1-2-3 skips over formulas not affected by data changes, it minimizes recalculation time, especially in large 
sheets that contain many unrelated formulas.

Order of calculation in a formula
Precedence numbers from 1 to 7 represent the order in which 1-2-3 performs operations in a formula. The lower the 
precedence number, the earlier 1-2-3 performs the operation. 1-2-3 performs operations with the same precedence 
number sequentially from left to right. 
The order in which you perform arithmetic operations with the same precedence number may produce differences in 
rounding but otherwise does not matter. However, order is important when evaluating logical operations that contain 
#AND# and #OR#. A formula can produce different results depending on the order of these operators.
The table below shows the order of precedence for all operators you can use in formulas.

Number Operation Operator
1 Exponentiation ^
2 Identification of value as 

negative or positive
– +

3 Multiplication and division * /
4 Addition and subtraction + –
5 Equal-to test =
5 Not-equal-to test <>
5 Less-than test <
5 Greater-than test >
5 Less-than-or-equal-to test <=
5 Greater-than-or-equal-to test >=
6 Logical-NOT test #NOT#
7 Logical-AND test #AND#
7 Logical-OR test #OR#
7 Text string concatenation &

Overriding order of precedence
You can override the order of precedence in a formula by enclosing operations in parentheses. 1-2-3 performs 
operations enclosed in parentheses first. Within each set of parentheses, the precedence numbers listed in the table 
above apply. 

For example, to perform addition before multiplication, enclose the addition in parentheses. To see the difference, 
compare the results of two formulas:

• When calculating 3 + 4 * 5, 1-2-3 first multiplies 4 by 5 and then adds 3, resulting in 23. 
• When calculating (3 + 4) * 5, 1-2-3 first adds 3 plus 4 and then multiplies the result by 5, resulting in 35.

Setting recalculation defaults
You can change how 1-2-3 recalculates in three ways:

• Choose whether to use automatic recalculation or manual recalculation.



• Recalculate formulas by column or by row instead of in natural order.
• Change the number of recalculation passes that 1-2-3 makes through each workbook. 

{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_STEPS',0)} See related topics



Setting recalculation defaults
You can choose how often and in which order 1-2-3 recalculates formulas and how many recalculation passes it 
makes.
1. Choose File - User Setup - 1-2-3 Preferences.

2. Click the Recalculation tab in the dialog box.
3. Select a recalculation method.
4. Select an order of recalculation.
5. Specify a number from 1 to 50 in the "Number of iterations" box.
6. Click OK.
The settings remain in effect until you end the 1-2-3 session or open another workbook with different recalculation 
settings.

{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_DETAILS',1)} See details
{button ,AL(`H_WHEN_AND_HOW_FORMULAS_RECALCULATE_OVER',0)} See related topics



Details: Setting recalculation defaults
Options: 1-2-3 Preferences dialog box (Recalculation tab)
Recalculation

• Automatic -- Immediately recalculates formulas whenever you change the data they refer to. Automatic 
recalculation occurs in the background, so you can continue working during recalculation.

• Manual -- Recalculates formulas only when you want to. Manual recalculation occurs in the foreground, so you 
must wait for 1-2-3 to complete it before continuing your work.

Order of recalculation
• Natural -- Recalculates all formulas in order of dependence. If a formula uses the results of other formulas, 1-2-3 

recalculates those formulas first. 
Recalculating in natural order is sufficient for most calculations. To control recalculation order more explicitly, 
select "By column" or "By row."

• By column -- Recalculates all formulas starting in A:A1 of the first active workbook and moves column by column 
through each sheet in each active workbook.

• By row -- Recalculates all formulas starting in A:A1 of the first active workbook and moves row by row through 
each sheet in each active workbook.

Number of iterations
Sets the number of recalculation passes 1-2-3 makes. This option takes effect only when the order of 
recalculation is "By column" or "By row," or when the order is "Natural" and a circular reference exists; otherwise, 
1-2-3 makes one pass.

Recalculating formula links to other files
Recalculation settings apply only to formulas that refer to data in active workbooks. These settings do not affect 
formulas that link to data in workbooks on disk. For more information, see Updating file links. 

Which settings should you use?
Most of the time, it's fine to use the initial recalculation settings (automatic, natural order). Change the order of 
recalculation only when necessary -- otherwise, you may get unexpected results. 

When to use manual recalculation
Recalculation is set to "Automatic" by default. You may prefer to use manual recalculation if:

• Your sheet contains a large number of formulas and data that take a long time to recalculate.
• You're making a number of changes to a sheet and don't want the formulas to recalculate until after you've made 

the changes.
• You're perfecting a formula and don't want it to affect other formulas that depend on it yet.

Ways to recalculate formulas manually
When using manual recalculation, you must tell 1-2-3 when you want to recalculate formulas. You can: 

• Press F9 (CALC) when you see the Ready indicator in the status bar.
• Click the icon shown below.

• Click the Calc button, which appears in the status bar when data changes.

{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_STEPS',1)} Go to procedure
{button ,AL(`H_USING_THE_STATUS_BAR_OVER',0)} See related topics



Overview: Creating a chart in 1-2-3
A chart is an effective way to illustrate the data in your spreadsheet. It can make relationships among numbers easy 
to see because it turns numbers into shapes (lines, bars, slices of a pie), and the shapes can then be compared to 
one another. 

Setting up the range
You can set up a range so that it contains all the elements you need to create a basic chart. 
If you select only numeric data and create a chart, 1-2-3 creates a chart with placeholders for the title, tick mark 
labels, and legend. If your selected range includes column and row headings, and text above or to the left of the 
numeric data, 1-2-3 uses the text to create the axis labels, title, subtitle, and legend.    
Suppose the range you select has text and numbers arranged as in A1..C7 in the illustration below.    1-2-3 will plot 
the chart based on range A1..C7 by column. 1-2-3 automatically creates a bar chart as in the illustration. 

How 1-2-3 plots the chart
When you create a chart, 1-2-3 plots each row or column of data in the selected range as a series -- a group of bars, 
lines, areas, or pie slices. A chart can contain up to 26 series. 1-2-3 follows rules to determine how to chart data. 
First, 1-2-3 finds the first cell containing a value that isn't a date: B4 in this example. Then, starting from cell B4, 1-2-3
counts the number of columns that contain values (two) and the number of rows that contain values (four). Based on 
this count, 1-2-3 uses the following rules:

When there are 1-2-3 plots the chart
More columns than rows By interpreting each row of values as a separate 

series. 1-2-3 uses the leftmost entry in each row 
as a legend label and the top entry in each column
as an axis label.

More rows than columns By interpreting each column of values as a 
separate series. 1-2-3 uses the top entry in each 
column as a legend label and the leftmost entry in 
each row as an axis label.

Equal rows and columns Same as when there are more rows than columns



Styling and manipulating a chart 
You can copy, move, style, and manipulate a chart the same as other graphic objects. You can switch to a different 
chart type, change the interior pattern and color, change the style of the chart border, add a designer frame, set how 
a chart is fastened to the cells behind it, and hide or lock the chart. 
Select the chart, choose Chart - Chart Properties, and make the changes you want. 
Tip Right-click in the chart to display the shortcut menu for working with charts.

{button ,AL(`H_CREATING_A_CHART_IN_123_STEPS;',0)} See related topics



Creating a chart in 1-2-3
1-2-3 creates a chart based on the range you select. 
1. Select the range or collection that contains the data to chart. 

You can include text for the chart title and legend entries in your selection.    For more information about setting up
the range for the chart, see Overview: Creating a chart in 1-2-3. 

2. From the Create menu, choose Chart.

3. Click the sheet where you want the top left corner of the chart to appear. 
Tip If the chart covers data in the sheet, you can move the chart and change its size; the data in the cells behind the 
chart will still be there.

{button ,AL(`H_CREATING_A_CHART_IN_123_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_CHART_IN_123_OVER;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS',0)} See 

related topics



Details: Creating a chart in 1-2-3
Placing a chart on a sheet
Instead of clicking the sheet to have 1-2-3 place and size the chart, you can determine the size and position of the 
chart by dragging a box in the sheet after you choose Create - Chart.

Changing the chart type
1-2-3 creates the chart using the default chart type. Initially, the default chart type is a bar chart. 
To change the default chart type, use Chart - Chart Style - Set Default Chart. To change the chart type for a particular 
chart, use Chart - Chart Type. 

How 1-2-3 names charts
1-2-3 automatically names the new chart Chart 1. Subsequent charts are named Chart 2, Chart 3, and so on. Use 
Chart - Chart Properties (Basics tab) to rename the chart. 

Changing the orientation of rows and columns
1-2-3 assigns data to the series in a chart according to how many rows or columns the range contains. You might 
want to see the data the opposite way. 
For example, suppose 1-2-3 plots a chart showing data for several cities by month. However, you might want to see 
the chart plotted by city instead. Use Chart - Ranges - Options to reassign the data, so axis labels and legends are 
reversed. 

Related SmartIcons

Changes chart properties

Changes the chart type

{button ,AL(`H_CREATING_A_CHART_IN_123_STEPS',1)} Go to procedure



Chart Assistant dialog box
1-2-3 creates a chart based on the selected range. 

Choose a task
Creating a chart in 1-2-3
Selecting a range from a dialog box

{button ,AL(`H_CREATING_A_CHART_IN_123_OVER;',0)} See related topics



Overview: 1-2-3 Classic
1-2-3 Classic is the / (slash) command menu of 1-2-3 for DOS Release 3.1, still available in 1-2-3 Release 9. To work 
with new 1-2-3 Release 9 features, you must use the pull-down menus.
When you press / (slash) in Ready mode, the 1-2-3 Classic window appears at the top of the 1-2-3 window, 
displaying the 1-2-3 Release 3.1 main menu, as shown below.
Note To see the menu shown below in its entirety, use the scroll buttons or maximize the Help window.

1-2-3 Classic window
The 1-2-3 Classic window contains a title bar and the 1-2-3 for DOS Release 3.1 control panel. However, you enter 
and edit data in the edit line of 1-2-3 Release 9. For information, see Overview: Entering data.
To move 1-2-3 Classic, you can drag the title bar with the mouse. To close 1-2-3 Classic, click the Close button.
Note The Wysiwyg menu is not available in the current release of 1-2-3. These commands perform tasks only in 
keystroke macros. However, 1-2-3 Help still provides command equivalents for the Wysiwyg (colon) commands.

Running 1-2-3 for DOS 3.1 macros
1-2-3 Release 9 can execute all Release 3.1 keystroke macros by using 1-2-3 Classic. 1-2-3 Release 9 ignores 
inoperable commands in a macro, but continues execution of the macro.

Pressing F1 (HELP) in 1-2-3 Classic
To see a list of equivalent 1-2-3 Release 9 commands for various / (slash) menu commands while you use 1-2-3 
Classic, press F1 (HELP). For example, when you choose Range in 1-2-3 Classic and then press F1 (HELP), you see a
list of equivalents for the /Range commands. 
To see information on command equivalents without opening 1-2-3 Classic, select a command from the lists that 
follow.

Main menu commands
/Worksheet
/Range
/Copy
/Move
/File
/Print
/Graph
/Data
/System
/Quit

Wysiwyg menu commands
:Worksheet
:Format
:Graph
:Print
:Display
:Special
:Text
:Named-Style
:Quit

Add-in commands



Add-in commands

{button ,AL(`H_USING_123_CLASSIC_STEPS;',0)} See related topics



Add-in commands
The table below lists Add-in commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Clear File - Add-Ins - Manage Add-Ins
Invoke No equivalent command
Load File - Add-Ins - Manage Add-Ins
Quit No equivalent command
Remove File - Add-Ins - Manage Add-Ins
Settings No equivalent command
Table No equivalent command
Table Applications No equivalent command
Table @Functions No equivalent command
Table Macros No equivalent command



:Display
The table below lists :Display commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Colors Sheet - Sheet Properties 

(Lines & Colors tab) and (View
tab)

Default Sheet - Sheet Properties 
(View tab)

Font-Directory No equivalent command
Mode No equivalent command
Options See :Display Options for 

additional commands
Quit No equivalent command
Rows No equivalent command
Zoom View - Zoom to



:Display Options
The table below lists :Display Options commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Cell-Pointer No equivalent command
Frame View - Set View Preferences
Grid View - Set View Preferences
Intensity No equivalent command
Page-Breaks View - Set View Preferences
Quit No equivalent command



:Format
The table below lists :Format commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Bold Range - Range Properties 

(Text Format tab)

Color Range - Range Properties 
(Lines & Colors tab)

Font Range - Range Properties 
(Text Format tab)

Italics Range - Range Properties 
(Text Format tab)

Lines Range - Range Properties 
(Lines & Colors tab)

Quit No equivalent command
Reset Edit - Clear
Shade Range - Range Properties 

(Lines & Colors tab)
Underline Range - Range Properties 

(Text Format tab)



:Graph
The table below lists :Graph commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Add See :Graph Add for additional 

commands
Compute No equivalent command
Edit See :Graph Edit for additional 

commands
Goto Edit - Go To
Move No equivalent command
Quit No equivalent command
Remove Edit - Clear
Settings View - Set View Preferences

Object - Object Properties 
(Lines & Colors tab)

View Edit - Go To
Zoom No equivalent command



:Graph Add
The table below lists :Graph Add commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current
release of 1-2-3.

1-2-3 Release 3.1 Current release
Blank No equivalent command
Current No equivalent command
Metafile File - Open
Named No equivalent command
PIC File - Open



:Graph Edit
The table below lists :Graph Edit commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current
release of 1-2-3.

1-2-3 Release 3.1 Current release
Add See :Graph Edit Add for 

additional commands
Color Object - Object Properties 

(Text Format tab)
Object - Object Properties 
(Lines & Colors tab)

Edit See :Graph Edit Edit for 
additional commands

Options See :Graph Edit Options for 
additional commands

View See :Graph Edit View for 
additional commands

Rearrange See :Graph Edit Rearrange for
additional commands

Select No equivalent command
Transform See :Graph Edit Transform for 

additional commands
Quit No equivalent command



:Graph Edit Add
The table below lists :Graph Edit Add commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Arrow Create - Drawing - Arrow
Ellipse Create - Drawing - Ellipse
Freehand Create - Drawing - Freehand
Line Create - Drawing - Line
Polygon Create - Drawing - Polygon
Rectangle Create - Drawing - Rectangle
Text Create - Text



:Graph Edit Edit
The table below lists :Graph Edit Edit commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Arrowheads Drawing - Drawing Properties 

(Lines & Colors tab)

Centering No equivalent command
Font Drawing - Drawing Properties 

(Text Format tab)
Line-Style Drawing - Drawing Properties 

(Lines & Colors tab)

Smoothing No equivalent command
Text No equivalent command
Width Drawing - Drawing Properties 

(Lines & Colors tab)



:Graph Edit Options
The table below lists :Graph Edit Options commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Cursor No equivalent command
Font-Magnification Object - Object Properties 

(Text Format tab)
Grid No equivalent command



:Graph Edit Rearrange
The table below lists :Graph Edit Rearrange commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Back Object - Send to Back
Copy Edit - Copy
Delete Edit - Clear
Front Object - Bring to Front
Lock Object - Object Properties 

(Basics tab)
Move No equivalent command
Restore Edit - Undo
Unlock Object - Object Properties 

(Basics tab)



:Graph Edit Transform
The table below lists :Graph Edit Transform commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Clear No equivalent command
Horizontal No equivalent command
Quarter-Turn Drawing - Drawing Properties 

(Basics tab)

Rotate Drawing - Drawing Properties 
(Basics tab)

Size No equivalent command
Vertical No equivalent command
X-Flip Drawing - Flip Top-Bottom
Y-Flip Drawing - Flip Left-Right



:Graph Edit View
The table below lists :Graph Edit View commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Down No equivalent command
Full No equivalent command
In No equivalent command
Left No equivalent command
- No equivalent command
Pan No equivalent command
+ No equivalent command
Right No equivalent command
Up No equivalent command



:Named-Style
The table below lists :Named-Style commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Define Range - Range Properties 

(Named Styles tab)
1 - 8 Range - Range Properties 

(Named Styles tab)



:Print
The table below lists :Print commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Configuration See :Print Configuration for 

additional commands
File No equivalent command
Go File - Print
Info No equivalent command
Layout File - Preview & Page Setup
Preview File - Preview & Page Setup
Quit No equivalent command
Range File - Print

Settings See :Print Settings for 
additional commands



:Print Configuration
The table below lists :Print Configuration commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Bin File - Print, then Properties
1st-Cart File - Print, then Properties
Interface No equivalent command
Orientation File - Preview & Page Setup 

(Layout tab)
Printer File - Print

Quit No equivalent command
Resolution File - Print, then Properties
2nd-Cart File - Print, then Properties



:Print Settings
The table below lists :Print Settings commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Begin File - Print
End File - Print
Frame File - Preview & Page Setup 

(Include tab)
Grid File - Preview & Page Setup 

(Include tab)
Quit No equivalent command
Reset No equivalent command
Start-Number File - Print
Wait No equivalent command



:Quit
This command has no equivalent in the current release of 1-2-3.



:Special
The table below lists :Special commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Copy Edit - Copy, then Edit - Paste 

Special
Export No equivalent command
Import No equivalent command
Move Edit - Cut, then Edit - Paste 

Special



:Text
The table below lists :Text commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Align Range - Range Properties 

(Alignment tab)

Clear No equivalent command
Edit No equivalent command

Reformat No equivalent command
Set No equivalent command



:Worksheet
The table below lists :Worksheet commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current
release of 1-2-3.

1-2-3 Release 3.1 Current release
Column Range - Range Properties 

(Basics tab)
Page Edit - Page Break

Row Range - Range Properties 
(Basics tab)









/Copy
In the current release of 1-2-3, choose Edit - Copy, select a destination range, and choose Edit - Paste.



/Data
The table below lists /Data commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.
1-2-3 gives you two ways to work with data queries:

• Use Create - Database to take advantage of database functionality available in Lotus Approach. For more 
information, see Overview: Working with 1-2-3 and Approach. 

• Use the Data Query Add-in to access additional data query functionality. For more information, see Overview: 
Data Query Add-In (DQA).    

1-2-3 Release 3.1 Current release Data Query Add-in
Distribution Range - Analyze - 

Distribution
External See /Data External 

to see additional 
commands 

See /Data External   
to see additional 
commands

Fill Range - Fill
Matrix Range - Analyze - 

Invert Matrix
Range - Analyze - 
Multiply Matrix

Parse Range - Parse
Query Create - Database 

- Query Table
Query - New Query

Regression Range - Analyze - 
Regression

Sort Range - Sort
Table Range - Analyze - 

What-if Table



/Data External
The table below lists /Data External commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.
1-2-3 gives you two ways to work with data queries:

• Use Create - Database to take advantage of database functionality available in Lotus Approach. For more 
information, see Overview: Working with 1-2-3 and Approach. 

• Use the Data Query Add-in to access additional data query functionality. For more information, see Overview: 
Data Query Add-In (DQA).    

1-2-3 Release 3.1 Current release Data Query Add-in
Create Create - Database 

- Query Table
Query - External 
Tables - Create 
Table

Delete No equivalent 
command

No equivalent 
command

List Fields No equivalent 
command

No equivalent 
command

List Tables No equivalent 
command

No equivalent 
command

Other Command No equivalent 
command

Query - External 
Tables - Send SQL

Other Refresh Query Table - 
Refresh

Query - Refresh 
Now

Other Translation No equivalent 
command

No equivalent 
command

Quit No equivalent 
command

No equivalent 
command

Reset No equivalent 
command

Query - External 
Tables - Disconnect

Use Create - Database 
- Query Table

Query - External 
Tables - Connect to 
External



/Data Matrix
The table below lists /Data Matrix commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Invert Range - Analyze - Invert Matrix
Multiply Range - Analyze - Multiply Matrix



/Data Query
The table below lists /Data Query commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.
1-2-3 gives you two ways to work with data queries:

• Use Create - Database to take advantage of database functionality available in Lotus Approach. For more 
information, see Overview: Working with 1-2-3 and Approach. 

• Use the Data Query Add-in to access additional data query functionality. For more information, see Overview: 
Data Query Add-In (DQA).    

1-2-3 Release 3.1 Current release Data Query Add-in
Criteria Create - Database 

- Query Table
Query - Set Criteria

Del No equivalent 
command; see 
Deleting records 
using a query table

Query - Delete 
Records

Extract Create - Database 
- Query Table

Query - New Query

Find No equivalent 
command; see 
Finding specific 
records in a query 
table 

Query - Set Criteria

Input Create - Database 
- Query Table

Query - New Query
Query - Set 
Database Table

Modify See /Data Query 
Modify for 
additional 
commands

See /Data Query 
Modify for additional
commands

Output Create - Database 
- Query Table

Query - New Query
Query - Append 
Records

Quit No equivalent 
command

No equivalent 
command

Reset No equivalent 
command

No equivalent 
command

Unique No equivalent 
command

Query - Set Options



/Data Query Modify
The table below lists /Data Query Modify commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the
current release of 1-2-3.
1-2-3 gives you two ways to work with data queries:

• Use Create - Database to take advantage of database functionality available in Lotus Approach. For more 
information, see Overview: Working with 1-2-3 and Approach. 

• Use the Data Query Add-in to access additional data query functionality. For more information, see Overview: 
Data Query Add-In (DQA). 

1-2-3 Release 3.1 Current release Data Query Add-in
Cancel No equivalent 

command
No equivalent 
command

Extract Create - Database 
- Query Table

Query - New Query

Insert No equivalent 
command; see    
Adding records 
using a query table

Query - Append 
Records

Replace No equivalent 
command; see 
Editing records 
using a query table

Query - Set Options



/Data Table
The table below lists /Data Table commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current
release of 1-2-3.

1-2-3 Release 3.1 Current release
1 Range - Analyze - What-if Table
2 Range - Analyze - What-if Table
3 Range - Analyze - What-if Table
Labeled No equivalent command
Reset Range - Analyze - What-if Table



/File
The table below lists /File commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Admin See /File Admin for additional 

commands

Combine File - Open
Dir File - User Setup - 1-2-3 

Preferences (File Locations 
tab)

Erase No equivalent command
Import See /File Import for additional 

commands

List No equivalent command
New File - New Workbook
Open File - Open
Retrieve File - Open
Save File - Save/Update

File - Save As/Save Copy As
Xtract File - Save As/Save Copy As



/File Admin
The table below lists /File Admin commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Link-Refresh Edit - Manage Links
Reservation File - Get Reservation

File - Release Reservation
File - Workbook Properties 
(Security tab)

Seal File - Workbook Properties 
(Security tab)

Table No equivalent command



/File Import
The table below lists /File Import commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Numbers File - Open
Text File - Open



/Graph
The table below lists /Graph commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
A - F Chart - Ranges
Group Chart - Ranges
Name See /Graph Name for 

additional commands

Options See /Graph Options for 
additional commands

Quit No equivalent command
Reset Edit - Clear
Save No equivalent command
Type Chart - Chart Type

Chart - Ranges
View Edit - Go To
X Chart - Ranges



/Graph Options Data-Labels
The table below lists /Graph Options Data-Labels commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
A - F Chart - Chart Properties, 

select "Series labels" from the 
"Properties for" list, then click 
Ranges tab

Group Chart - Chart Properties, 
select "Series labels" from the 
"Properties for" list, then click 
Ranges tab

Quit No equivalent command



/Graph Name
The table below lists /Graph Name commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Create Chart - Chart Properties 

(Basics tab)
Delete Edit - Clear
Reset Edit - Clear
Table No equivalent command
Use Edit - Go To 



/Graph Options
The table below lists /Graph Options commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Advanced See /Graph Options Advanced

for additional commands
B&W No equivalent command
Color No equivalent command
Data-Labels See /Graph Options Data-

Labels for additional 
commands

Format Chart - Chart Type
Grid Chart - Axes & Grids
Legend Chart - Legend
Quit No equivalent command
Scale Chart - Chart Properties, 

select an axis from the 
"Properties for" list, and then 
click Scale tab
Chart - Chart Properties, 
select the axis labels, and then
click Number format tab

Titles See /Graph Options Titles for 
additional commands



/Graph Options Advanced
The table below lists /Graph Options Advanced commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Colors Chart - Chart Properties, 

select "Series" from the 
"Properties for" list, and then 
click Lines & Colors tab

Hatches Chart - Chart Properties, 
select "Series" from the 
"Properties for" list, and then 
click Lines & Colors tab

Quit No equivalent command
Text Chart - Chart Properties, 

select text object from the 
"Properties for" list, and then 
click Text Format tab



/Graph Options Titles
The table below lists /Graph Options Titles commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Titles Chart - Title

Chart - Note



/Graph Type Features
The table below lists /Graph Type Features commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Drop-Shadow Chart - Chart Type
Frame Chart - Chart Properties (Lines

& Colors tab)
Horizontal Chart - Chart Type
100% Chart - Axes & Grids
Quit No equivalent command
Stacked Chart - Chart Type
2Y-Ranges Chart - Ranges
3D Chart - Chart Type
Table Chart - Chart Type
Vertical Chart - Chart Type
Y-Ranges Chart - Ranges



/Move
In the current release of 1-2-3, choose Edit - Cut, select the destination range, and choose Edit - Paste.



/Print
The table below lists /Print commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Cancel No equivalent command
Encoded No equivalent command
File File - Print
Printer See /Print [Encoded, File, 

Printer] for additional 
commands

Quit No equivalent command
Resume No equivalent command
Suspend No equivalent command



/Print [Encoded, File, Printer]
The table below lists /Print [Encoded, File, Printer] commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Align No equivalent command
Clear No equivalent command
Go File - Print
Hold No equivalent command
Image No equivalent command
Line No equivalent command
Options See /Print [Encoded, File, 

Printer] Options for additional 
commands

Page No equivalent command
Quit No equivalent command
Range File - Print
Sample No equivalent command



/Print [Encoded, File, Printer] Options
The table below lists /Print [Encoded, File, Printer] Option commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Advanced No equivalent command
Borders File - Preview & Page Setup 

(Headers & Footers tab) and 
(Include tab)

Header File - Preview & Page Setup 
(Headers & Footers tab)

Footer File - Preview & Page Setup 
(Headers & Footers tab)

Margins File - Preview & Page Setup 
(Layout tab)

Name No equivalent command
Other No equivalent command
Pg-Length No equivalent command
Quit No equivalent command
Setup No equivalent command



/Quit
In the current release of 1-2-3, choose File - Exit 1-2-3, or File - Exit 1-2-3 & Return to <application>.



/Range
The table below lists /Range commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 3.1 Current release
Erase Edit - Clear
Format Range - Range Properties 

(Number Format tab)
Input No equivalent command
Justify No equivalent command
Label Range - Range Properties 

(Alignment tab)
Name Range - Name
Prot Range - Range Properties 

(Security tab)
Sheet - Sheet Properties 
(Basics tab)

Search Edit - Find & Replace
Trans Range - Transpose
Unprot Range - Range Properties 

(Security tab)
Sheet - Sheet Properties 
(Basics tab)

Value Edit - Copy
Edit - Paste Special



/Range Name
The table below lists /Range Name commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Create Range - Name
Delete Range - Name
Labels Range - Name
Note No equivalent command
Reset Range - Name
Table No equivalent command
Undefine No equivalent command



/System
This 1-2-3 Classic command has no equivalent in the current release of 1-2-3.



/Worksheet
The table below lists /Worksheet commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the current
release of 1-2-3.

1-2-3 Release 3.1 Current release
Column See /Worksheet Column for 

additional commands
Delete See /Worksheet Delete for 

additional commands
Erase File - Close
Global See /Worksheet Global for 

additional commands
Hide See /Worksheet Hide for 

additional commands
Insert Range - Insert

Create - Sheet
Page Edit - Page Break
Status No equivalent command
Titles View - Titles
Window See /Worksheet Window for 

additional commands



/Worksheet Column
The table below lists /Worksheet Column commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Column-Range Range - Properties (Basics tab)
Display Range - Properties (Basics tab)
Hide Range - Properties (Basics tab)
Reset-Width Range - Properties (Basics tab)
Set-Width Range - Properties (Basics tab)



/Worksheet Delete
The table below lists /Worksheet Delete commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Column Range - Delete
File File - Close
Row Range - Delete
Sheet Sheet - Delete Sheet



/Worksheet Global
The table below lists /Worksheet Global commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Col-Width Sheet - Sheet Properties 

(Basics tab)
Default See /Worksheet Global 

Default for additional 
commands

Format Sheet - Sheet Properties 
(Number Format tab)

Group Sheet - Group Sheets
Sheet - Clear Sheet Group

Label Sheet - Sheet Properties 
(Alignment tab)

Prot Range - Range Properties 
(Security tab)
Sheet - Sheet Properties 
(Basics tab)

Recalc File - User Setup - 1-2-3 
Preferences (Recalculation 
tab)

Zero Sheet - Sheet Properties 
(Number Format tab)



/Worksheet Global Default
The table below lists /Worksheet Global Default commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Autoexec File - User Setup - 1-2-3 

Preferences (General tab)

Dir File - User Setup - 1-2-3 
Preferences (File Locations tab)

Ext File - User Setup - 1-2-3 
Preferences (New Workbook 
Defaults tab)

Graph No equivalent command
Other See /Worksheet Global Default 

Other for additional commands
Printer File - Print
Quit No equivalent command
Status No equivalent command
Temp No equivalent command
Update File - User Setup - 1-2-3 

Preferences



/Worksheet Global Default Other
The table below lists /Worksheet Global Default Other commands in 1-2-3 for DOS Release 3.1 and their closest 
equivalents in the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Beep File - User Setup - 1-2-3 Preferences 

(General tab)
Clock No equivalent command
Help No equivalent command
International No equivalent command
Undo File - User Setup - 1-2-3 Preferences 

(General tab)



/Worksheet Hide
The table below lists /Worksheet Hide commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in the 
current release of 1-2-3.

1-2-3 Release 3.1 Current release
Enable Sheet - Hide

Disable Sheet - Unhide



/Worksheet Window
The table below lists /Worksheet Window commands in 1-2-3 for DOS Release 3.1 and their closest equivalents in 
the current release of 1-2-3.

1-2-3 Release 3.1 Current release
Clear View - Clear Split
Display No equivalent command
Graph No equivalent command
Horizontal View - Split
Map No equivalent command
Perspective No equivalent command
Synch View - Split
Unsynch View - Unsynchronize Split
Vertical View - Split



Using 1-2-3 Classic
In the current release of 1-2-3, you can work with the 1-2-3 Release 3.1 main menu in 1-2-3 Classic, just as you did in
Release 3.1.
1. To display 1-2-3 Classic, press / (slash) in Ready mode.

Note To change the key that displays the Classic menu, choose File - User Setup - 1-2-3 Preferences, and click 
the Classic Keys tab.

2. Choose the command that you want.
To close the 1-2-3 Classic window without completing a command, press CTRL+BREAK or press ESC until the Classic 
menu disappears.

{button ,AL(`H_USING_123_CLASSIC_DETAILS',1)} See details
{button ,AL(`H_123_CLASSIC_OVER;',0)} See related topics



Details: Using 1-2-3 Classic
1-2-3 Release 3.1 main menu commands
Some Release 3.1 main menu commands don't operate in the current release of 1-2-3.    When you highlight a 
command that isn't operable, you see a message. To find out which command in the current release to use instead, 
press F1 (HELP).

Wysiwyg menu commands
You can't use any : (colon) commands to perform tasks in the current release of 1-2-3, except in keystroke macros. If 
you press : (colon) when 1-2-3 is in Ready mode, 1-2-3 enters a colon in the current cell.

Choosing commands and ranges
You must use the keyboard to choose commands in 1-2-3 Classic. You can use the keyboard or the mouse to select 
ranges required to complete a / (slash) command.

Turning off 1-2-3 Classic
If you don't want to use 1-2-3 Classic, you can turn it off by choosing File - User Setup - 1-2-3 Preferences, and then 
clicking the Classic Keys tab. When 1-2-3 Classic is turned off, pressing / (slash) or < (less-than symbol) enters the 
appropriate character in the current cell. However, you can continue to use your keystroke macros.

{button ,AL(`H_USING_123_CLASSIC_STEPS',1)} Go to procedure



Overview: Distributing workbooks with TeamConsolidate
TeamConsolidate lets you distribute workbook sheets in a Lotus Notes database to request data or modifications from
contributors. After they make changes, you can consolidate these sheets back into your original workbook. 
For example, suppose you're using 1-2-3 to track expenses on a project involving several departments. You can 
create a workbook containing a sheet for each department. Using Lotus Notes, you distribute each sheet to people in 
each department. They make updates and additions and then you can consolidate the changes into the original 
workbook. Storing the workbook in a Notes database makes the information available to everyone--even people at 
different locations--and can help you track changes over time.
Note To use TeamConsolidate, you must have Lotus Notes 4.1 or higher, and should be familiar with the basics of 
working in Notes databases. If you don't have Notes 4.1, you can perform similar tasks with File - TeamReview. For 
more information, see Overview: TeamReview in 1-2-3. 

How to distribute sheets and consolidate changes into your original document
The process for distributing the sheets of a workbook to contributors involves a single distributor and any number of 
contributors. The general procedure is outlined below. 

• A person familiar with designing and administering Notes databases sets up a Notes database that will contain 
the master workbooks and distributed sheets. This database must use the TeamConsolidate template, named 
TEAMCONS.NTF, which comes with 1-2-3. 

• In 1-2-3, the originator chooses File - Team Consolidate - Share Sheets Using Lotus Notes. 
• The originator opens the database in which to store the workbook.
• In Notes, the originator chooses Create - 1-2-3 Workbook Document, and either creates a new workbook or 

opens an existing one. 
• Next, the originator assigns individual sheets of the workbook to one or more contributors and notifies contributors

in an e-mail message.
• Next, contributors open the Notes database, and edit the 1-2-3 workbook document in place. When contributors 

finish adding data, they mark the document as ready for consolidation and save it back to the Notes database.
• After all contributors mark their documents "Ready for consolidation," the originator clicks the Consolidate 

Workbook Data button to consolidate contributors' changes into the master workbook.
• After the changes are consolidated, the originator can save the master workbook as a separate 1-2-3 file or leave 

the workbook stored in the Notes database.
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Overview: Creating the TeamConsolidate Notes database
To use TeamConsolidate, you must have Lotus Notes 4.1 or higher. 
To create a TeamConsolidate database, you need to be familiar with the process of setting up and administering 
Notes databases. You must create the TeamConsolidate database using the TeamConsolidate template, named 
TEAMCONS.NTF, which comes with 1-2-3 and is installed in your Notes data directory. 

Setting up users
After creating the TeamConsolidate database, set up the list of users who will have access to the database and 
assign them the appropriate privileges. For example, every user must have a minimum of Author access to the 
database.

Customizing the database
You can use all of the TeamConsolidate features without altering the forms and views of a TeamConsolidate 
database. 
You can, however, customize the forms and views of the template to make it suit your needs. For example, you might 
want to change the user interface to make it easy to distribute workbook documents to the same set of users every 
month. 
The forms of the TeamConsolidate database contain scripts created using the LotusScript language. To preserve the 
basic functionality of TeamConsolidate, you should exercise caution if you edit existing scripts. You can, however, add
new scripts to the forms to perform various tasks according to your needs.

Where to find more information
To find more detailed information about setting up, maintaining, and customizing a TeamConsolidate database, open 
the TeamConsolidate template database and choose Help - About This Database and Help - Using This Database. 
For general information about designing and maintaining Notes databases, consult your Lotus Notes documentation. 
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Overview: Setting up the master workbook
When you use TeamConsolidate, you work with 1-2-3 as you normally would. Because contributors will be working 
with only one sheet at a time, certain features of 1-2-3 are less important or useful, for example, features that work 
across sheets. 
Below is information to keep in mind when creating the master workbook and working in distributed sheets. 

Setting up each sheet
When you are distributing sheets from a workbook with multiple sheets, put all the data and graphic objects that you 
want to distribute to one person on a single sheet. If a workbook contains macros, it is best to put these on a separate
sheet. 

Charts, drawings, maps, and OLE embedded objects
During consolidation, if separate distributed sheets contain charts, drawings, maps, or embedded objects with the 
same names, the objects with the duplicate names are not renamed. No objects or data will be lost, but to avoid 
confusion, before you distribute a sheet, assign names to objects rather than accepting the default names suggested 
by 1-2-3.

Versions and version groups
It is a good idea to avoid 3D versions in a distributed sheet. Although contributors can use data in multiple sheets, for 
example with formula calculations, 1-2-3 only consolidates the changes made on the single sheet that was 
distributed. 
If the originator adds versions in the master workbook while sheets are distributed, the data in these versions will be 
lost during consolidation.
Version groups are not included in a distributed sheet. 

Scripts
You can add, edit, and consolidate scripts that are attached to graphic objects on the current sheet, but no other 
scripts. 
Note If a script is attached to a range in a distributed sheet, the script will not be consolidated.

Locked workbooks
You can distribute, edit, and consolidate locked workbooks. The lock is ignored when the sheet is consolidated back 
into the master workbook.

Password-protected workbooks
Since you cannot password-protect an OLE object, you cannot password-protect a master document after it is in 
Notes.
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Creating the master workbook from an existing workbook
Before you start, the Notes database for storing the workbook must be set up. If you are already in Notes, you can 
start with step 3.
1. Choose File - Team Consolidate - Share Sheets Using Lotus Notes. 
2. Click Go To Lotus Notes. 

Note The Go To Lotus Notes button is dimmed if Notes 4.1 or higher is not installed. 
3. In Notes, open the Notes database where you want to place the 1-2-3 workbook. 
4. Click the Create 1-2-3 Workbook Document button. 
5. Enter a title for the master workbook document.
6. Select "Use an existing 1-2-3 workbook" and specify the file name. 
7. Click OK. 
8. Select whether to request data for the workbook now or later. 

• If you choose to distribute the workbook now, follow the steps in Distributing sheets, starting with step 3.
• If you choose to distribute the workbook later, when you are ready, click Request Workbook Data.
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Creating a new master workbook
Before you start, the Notes database for storing the workbook must be set up. If you are already in Notes, you can 
start with step 3.
1. Choose File - Team Consolidate - Share Sheets Using Lotus Notes. 
2. Click Go To Lotus Notes. 
3. Open the Notes database where you want to place the 1-2-3 workbook. 
4. Click the Create 1-2-3 Workbook Document button.
5. Enter a title for the master workbook document.
6. Select "Create a new 1-2-3 workbook." 
7. Click OK. 
8. Set up and enter data in the 1-2-3 workbook object. 
9. Click the Notes form outside the 1-2-3 workbook object when you finish creating the master workbook.
10. Close and save the Notes document.
You are now ready to distribute the sheets in the master workbook to contributors. See Distributing sheets for 
information.
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Distributing sheets
You distribute sheets to request data from contributors. Distributing sheets assigns them to contributors and makes 
each distributed sheet a response document under the master document. 
1. Open the Notes document containing the workbook you want to distribute. 
2. Click the Request Workbook Data button. 
3. Select the sheets you want to distribute by dragging sheet names from the "Sheets in workbook" list to the 

"Sheets to distribute" list. 
4. To choose contributors for each distributed sheet, click in the Contributors list and type a name or click the 

Addresses button to select names from an address book.
You can specify more than one contributor for each sheet. Separate names with a , (comma). You can also use 
group names to specify multiple contributors. 

5. (Optional) Select "Only contributor(s) may view distributed sheets," to prevent others from seeing and entering 
data in the distributed sheets.

6. (Optional) To send e-mail to all contributors, select "Send mail with doclink to contributors," then enter your 
message in the box. 

7. (Optional) Select "Notify me when contributors have finished" if you want to receive a message when documents 
are marked "Ready to consolidate" or "Do not consolidate."

8. Click OK, and enter your e-mail password (if prompted).
After you close the document, response documents containing the distributed sheets appear beneath the master 
document with a status of "Data requested." 
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Details: Distributing sheets
If you are distributing a workbook which contains a query table, datalink table, or Web table, only the data is 
distributed, not the tables.

When you can distribute sheets
You can distribute sheets from a master workbook document that has a status of "Data not yet requested" or 
"Consolidation completed." If a master workbook document has any other status, the Request Workbook Data button 
is not available.
After you distribute a sheet, you cannot distribute it again until the master workbook document has a status of 
"Consolidation completed." Consolidation is completed when all distributed sheets have a status of "Consolidated into
Master" or "Do not consolidate." 
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Overview: Working in the TeamConsolidate database
In the TeamConsolidate database, distributed sheets appear as response documents to the master workbook 
document. You can choose from several ways to display them.

Displaying the TeamConsolidate Navigator
You can click the Navigator button to display a row of buttons on the left side of the workbook window that replace the
standard Notes navigators. The TeamConsolidate navigator contains these buttons:

• All Documents -- Displays all documents in the view by originator name 
• By Status -- Displays all documents by status of master workbooks
• By Date -- Displays all documents by modification date of master workbooks
• By Contributor -- Displays distributed sheets by contributor name, but does not display the master workbooks

Collapsing and expanding the Notes view
You can expand the Notes view to see the distributed sheets below the master workbook document. Click the triangle
to expand or collapse the view. 
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Editing a distributed sheet
Contributors can edit distributed sheets in place or out of place. When you open a document containing a distributed 
sheet, the sheet is activated for in-place editing.

Editing the sheet in place
1. In the Notes database, open the document containing the distributed sheet.
2. Make your changes or additions to the sheet.
3. (Optional) Enter a comment in the Remarks field. 
4. Close and save the Notes document. 
5. In the Status of Contributor Document dialog box, make a choice reflecting the status of your work. 

Note If you plan to add more changes later, select "In progress."
6. Click Done.

Editing the sheet out of place
1. In the Notes database, open the document containing the distributed sheet.
2. Click outside the 1-2-3 workbook object to deactivate it.
3. Click the object to select it. 
4. Choose Workbook - Open. 

The sheet appears in a full 1-2-3 window. 
5. Make your changes or additions. 
6. Choose File - Exit & Return to close 1-2-3 and go back to the Notes document. 
7. (Optional) Enter a comment in the Remarks field. 
8. Save and close the Notes document. 
9. In the Status of Contributor Document dialog box, make a choice reflecting the status of your work. 

Note If you plan to add more changes later, select "In progress."
10. Click Done.
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Details: Editing a distributed sheet
Adding comments
You can enter a comment in the response document to record any information you want about changes or additions 
you made to a distributed sheet. All comments from distributed sheets are listed in the Remarks field of the master 
workbook document after consolidation.

Limitations when editing a distributed sheet
When you are editing a distributed sheet, certain 1-2-3 commands and features are unavailable. 

• You cannot use Edit - Go To to go to objects on other sheets.
• You cannot create or delete sheets.
• You cannot create version groups.
• You cannot insert or delete rows or columns in a versioned range (unless you created the version in the 

distributed sheet).
• You cannot add or change scripts attached to ranges.

Editing sheets in place
When you edit a sheet in place, the File and Window menus contain Lotus Notes commands. File - Save stores the 
entire Notes document containing the sheet, not just the sheet. 
You can end in-place editing by clicking in the Notes document outside of the sheet. To return to editing the sheet, 
double-click it.
The 1-2-3 data is not saved until you save the Notes document. 

Editing sheets out of place
When you edit the sheet out of place, the File menu contains 1-2-3 commands.

Setting the status of your work
When you save a distributed sheet, a dialog box requests you to confirm or change the status of the document. You 
can change the status to "In progress," "Ready to consolidate," or "Do not consolidate."

Duplicate range names
When you edit a distributed sheet, all range names proposed by Version Manager (for example, Range 1) will include
the sheet name as a prefix (by default, a letter). If 1-2-3 detects a duplicate range name while consolidating 
distributed sheets back into the original workbook, 1-2-3 keeps the range name in the first sheet, but discards the 
names of any other ranges with the same name.

Embedding additional objects
You can embed objects in a distributed sheet and they will be merged back to the master workbook during 
consolidation. 
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Consolidating distributed sheets
After contributors make changes, you can consolidate distributed sheets back into the master workbook.
1. In the Notes database, open the document containing the master workbook.
2. Click the Consolidate Workbook Data button. 
3. Specify whether Notes will consolidate just those documents marked "Ready to consolidate" and whether 

contributors' documents will be deleted after consolidation. 
4. Click OK.    

You see a message confirming that the distributed documents have been consolidated successfully.
5. (Optional) To save the 1-2-3 workbook document as a 1-2-3 workbook file, click the Detach 1-2-3 Workbook 

button. 
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Details: Consolidating distributed sheets
Replication conflicts in distributed sheets
You can consolidate original response documents only. If two people edit the same document at the same time, the 
second person to save it will create a replication conflict. You must resolve replication conflicts and delete the conflict 
document before you can consolidate distributed sheets. 

Controlling which sheets are consolidated
If you don't select "Consolidate only documents marked Ready to consolidate," all documents with a status of 
anything except "Do not consolidate" will be consolidated. If you select this option, only those documents with a 
status of "Ready to consolidate" will be consolidated. If sheets are marked "Do not consolidate," "In progress", or 
"Data requested," you can consolidate them later, after the contributor changes their status.
If sheets are marked "In progress" and "Consolidate only documents marked Ready to consolidate" is selected, then 
the master workbook document will get the status of "Partially consolidated." Once the remaining sheets are marked 
"Ready to consolidate" or "Do not consolidate," you can consolidate again to incorporate the remaining data. Then 
the status of the master workbook document changes to "Consolidation completed."

Deleting contributors' documents
If you select "Delete contributors' documents after consolidating," Notes deletes the response documents after 
consolidation. This, however, does not remove replication conflicts for response documents. 
If you choose not to delete contributors' documents, they become read-only documents to prevent changes to sheets 
that have already been consolidated. 
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Merging versions and version groups
1-2-3 copies versions from named ranges in the source workbook to ranges of the same size and with the same 
names in the destination workbook. 
1. Open the workbook containing the versions you want to merge (the source workbook) and the workbook into 

which you want to merge the versions (the destination workbook). 
2. Make the destination the current workbook.
3. Choose File - Team Consolidate - Merge Versions.
4. In the "Merge versions and version groups from workbook" list, select the source workbook.
5. (Optional) To merge only versions and version groups created on or after a particular date, enter the date in the 

"On or after this date" box. Enter the date in DD-MMM-YY or DD-MMM format (for example, 15-Apr-96 or 15-Apr).
6. (Optional) To merge only versions or version groups created or last modified by a particular person, select the 

name in the "By the user" list. 
7. Click OK. 

1-2-3 merges versions and version groups from the source workbook into the destination workbook. If 1-2-3 
cannot merge any versions or version groups that meet the criteria you specified, the Merge Results dialog box 
appears. 

8. (Optional) In the Merge Results dialog box, use the range selector to specify a range and click Copy Results to 
Selected Range to copy the merge results to the range. Then click Done.
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Details: Merging versions and version groups
Options: Merge Versions Results dialog box

• Items not merged -- Lists named ranges or versions that were not merged. If a named range appears in the list, 
no versions of that range were merged. Version names are given in the form "RANGE.version," where "RANGE" 
is the range name and "version" is the version name. For example, SALES.BestCase indicates the BestCase 
version of the range named SALES.

• Reason -- Lists the reasons why ranges could not be merged. The following table explains the reasons.

Reason Description
No matching range name The named range in the 

source file does not exist in 
the destination file.

Different size The named range in the 
source file and the 
corresponding named range in
the destination file contain a 
different number of rows, 
columns, or sheets.

Protected The named range in the 
destination file is protected.

Hidden The version or version group 
in the source file is hidden and
the source file is locked.

Contains versions not merged The version group in the 
source file contains one or 
more versions that could not 
be merged.

Already exists A version or version group 
exists in the destination file 
with the same name, creation 
date, last modified date, and 
last user as the version or 
version group in the source 
file.
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Share sheets using Lotus Notes dialog box
TeamConsolidate lets you distribute workbook sheets to team members, who can add their own data. Later, you can 
consolidate the updated sheets into your original workbook. 

Overview: Distributing workbooks with Team Consolidate
Creating the master workbook from an existing workbook
Creating a new master workbook
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Create Document with 1-2-3 Workbook dialog box
Use this dialog box to create a master workbook.

Choose a task
Creating the master workbook from an existing workbook
Creating a new master workbook
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Converting a workbook to a Web page
You can convert a range, a sheet, or an entire workbook to a Web page using the Convert to Web Pages dialog 
boxes. You can format your Web page as an HTML table or jDoc format. 
When you convert a range to the HTML table format, 1-2-3 saves formulas, real number values, number formats, and
other text and table attributes to the HTML file. The result is a file that can be read back into 1-2-3 with all of the data 
and most of the formatting intact. For more information, see Working with HTML files. 
When you convert a range, sheet, or entire workbook to jDoc (print snapshot) format, 1-2-3 uses the current print 
settings (margins, header and footer, style, and so on) to produce a compact, high fidelity output. The result is a file 
that looks identical to what your printed output would look like. (A file converted to jDoc format cannot be read back 
into 1-2-3.)

Choose a Task
Converting a range to an HTML table
Converting a range, sheet, or workbook to jDoc format
Selecting layout options
Saving a file converted to a Web page



Converting a range to an HTML table
You can convert a range in your sheet to an HTML file that can be read back into 1-2-3.
1. From the File menu, choose Internet, and then choose Convert to Web Pages.
2. In the "File name for Web page" box, type a file name for your Web page.
3. Under What to convert, select "Selected range."
4. Type a range in the "Selected range" box, or use the range selector to select a range.
5. Under Format, select "HTML table."
6. Click Next to select layout options.
7. Select the HTML layout options for your Web page. See Selecting layout options for information.
8. Click Next to preview and save your file.
9. To see how your page will look, click Preview in Browser.
10. Specify where you want to save the converted file. See Saving a file converted to a Web page for information.
11. Click Save.
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Details: Converting a range to an HTML table
Specifying a file name for the Web page
The default file name is the current 1-2-3 file name with an .HTM extension. If the current 1-2-3 file is untitled, the file 
name is untitled.HTM. Valid HTML extensions are: .HTM, .HTML, and .HTML-WK.
Note If you do not enter a valid extension, 1-2-3 appends ".HTM" to your file name. For example, if you enter 
"webpage1," 1-2-3 enters "webpage1.HTM."
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Selecting layout options
Select how you want your Web page to look when it is published to the Web, and then click Next to preview and save
your file.

HTML layout options
Select the HTML layout options for your Web page.

• Header - Text you enter in the text box appears in the header for the Web page with a horizontal rule below it. The
character limit is 80. 

• Description - Text you enter in the text box appears at the top of the Web page, above the HTML table. The 
character limit is 1024.

• Show table borders - Displays borders for the HTML table.
• Add a link for downloading the 1-2-3 file - Adds a link to the Web page, centered below the table. 

When you select this option and save your converted HTML file, 1-2-3 also saves a copy of the 1-2-3 file to the 
location you specify. 

• Author name - Displays the author name to the footer at the bottom of the Web page: This file was created by 
<name> on <date>. The character limit is 80.

• E-mail address - Displays your e-mail address with a link to the footer at the bottom of the Web page: Send 
comments to <e-mail address>. The character limit is 80.

jDoc layout options
You can add a link for downloading the 1-2-3 file. Selecting this option adds a link to the Web page, centered below 
the table. 
When you select this option and save your converted file, 1-2-3 also saves a copy of the 1-2-3 file to the location you 
specify. 
1-2-3 uses the current print settings (except for printer name, what to print, number of copies, and output to file) to 
"print" to the Net-It print driver. For more information, see Overview: Print and page properties.
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Working with HTML files
In 1-2-3 Release 9, you can use File - Open to open HTML (.HTM*) files, and you can use File - Internet - Convert to 
Web Pages to save ranges to the HTML table format.

Opening HTML files
When opening an HTML file, you can either specify the file type and select the file you want, or type the file name 
with an .HTM or .HTML extension. 
1-2-3 opens the file only if it finds data in <table> or <pre> data tags. 1-2-3 creates a new Untitled workbook. At the 
top of the page, 1-2-3 adds a hyperlink to the source file (for example, Source: http://www.lotus.com). Below the 
source information, 1-2-3 displays the table data. 
If there are multiple tables of data on a Web page, 1-2-3 adds one blank row between each table.

Translating <table> tags
The table tag <table> contains the code for creating a table. Tables are specified row by row, and each row definition 
contains definitions for each of the cells in that row. The columns are calculated by how many cells are in each row. 
1-2-3 translates the following information inside the <table> tag:

• Alphanumeric content
• Lotus-specific tags
• Text attributes
• Hyperlinks (<a href>)

Note Because 1-2-3 supports one hyperlink per cell, only the first hyperlink found in an HTML table cell is 
translated and all of the text in the 1-2-3 cell becomes the hyperlink. 

• Images (<img>)
Note 1-2-3 translates the alt parameter into text. If the <img> tag appears as part of a hyperlink, 1-2-3 creates a 
text hyperlink using the "alt" text from the ALT parameter. For example:
<img width=170 height=46 src="/images/lotlogo.gif" alt="Lotus Logo"><br>

When 1-2-3 encounters an HTML tag it doesn't support, 1-2-3 adds the contents of the tag to the existing data in the 
cell.

Translating <pre> tags
The preformatted text tag <pre> lets you format text with extra white space (spaces, tabs, returns). Because browsers
normally strip out extra white space, the <pre> tag is often used to line up information in table-like columns. (This 
preformatted text is usually displayed in a monospaced font such as Courier.)
1-2-3 scans the data in the file, collecting information about the location of blanks (spaces or tabs) on each line. 1-2-3
then divides the data into spreadsheet columns wherever columns of spaces exist.
1-2-3 displays the first line of a <pre> table as a long label. If the <pre> data is less than nine lines, the data is 
brought in as long labels.

Saving HTML files
You can save ranges to an HTML table by choosing File - Internet - Convert to Web Pages.
Before you create a Web page by converting a range to HTML, you probably want to know how the table will look 
(range attributes) and what happens to the data in your workbook.
When you convert a range to an HTML table, 1-2-3 maps as many range attributes as possible to existing HTML 
tags. For most range attributes that are not supported by HTML, 1-2-3 keeps track of the attributes with 1-2-3 specific
tags so the formatting is not lost when you read the file back into 1-2-3.
Note The following range attributes are not supported when you convert a range to an HTML table: double underline,
wide underline, text orientation, background patterns, background pattern colors, designer frames, Notes/FX fields, 
cell comments, and versioned ranges.

Formulas
Formulas are saved to the HTML file in the <td formula=> attribute. This attribute allows 1-2-3 to read the formula 
when you open the HTML file in 1-2-3.
When you select a range to convert to HTML, 1-2-3 saves only the formulas that reference cells inside the selected 
range. If a formula references cells outside the selected range, 1-2-3 saves the cell value and not the formula when 
the file is converted to HTML. 



Compressing multiple blank columns and rows
When you convert a large range to the HTML table format, 1-2-3 compresses multiple consecutive rows and columns
that have no data in them. If there are more than 16 consecutive blank columns, or more than 40 blank rows, 1-2-3 
compresses the blank columns and rows down to 1 empty column and row. This empty column and row appears in 
the HTML table with a thick border between the other columns and rows. 

Hidden columns and rows
If you have hidden columns and rows in your 1-2-3 file, 1-2-3 writes the data and range attributes to the HTML file but
doesn't display the data. The HTML table cells in those columns and rows are left blank. 
When a file with hidden columns and rows is displayed in a browser, the hidden columns and rows appear in the 
HTML table with a thicker than usual border between the other columns and rows. The more consecutive hidden 
columns and rows you have in your converted file, the thicker the border.
Note The information in hidden columns and rows is not secure. You can view the contents of hidden columns and 
rows in a browser by viewing the source code and searching for the "Lotus" tags. 

{button ,AL(`H_123_CONVERTING_A_WORKBOOK_TO_A_WEB_PAGE_CS;H_123_OPENING_AN_HTML_FILE_
STEPS;H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;',0)} See related topics



Opening an HTML file
1. From the File menu, choose Open.
2. In the Files of type box, select "HTML File (HTM*)." 
3. Specify the file you want to open.
4. Click Open.

{button ,AL(`H_123_OPENING_AN_HTML_FILE_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_HTML_FILES_OVER;H_123_WORKING_WITH_INTERNET_CONNECTION

S_OVER;H_123_CONVERTING_A_WORKBOOK_TO_A_WEB_PAGE_CS;',0)} See related topics



Details: Opening an HTML file
When opening an HTML file, you can either specify the file type and select the file you want, or type the file name 
with a .HTM or .HTML extension. 
1-2-3 opens the file only if it finds data in <table> or <pre> data tags. 1-2-3 creates a new Untitled workbook. At the 
top of the page, 1-2-3 adds a hyperlink to the source file (for example, Source: http://www.lotus.com). Below the 
source information, 1-2-3 displays the table data. 
If there are multiple tables of data on a Web page, 1-2-3 adds 1 blank row between each table.

{button ,AL(`H_123_OPENING_AN_HTML_FILE_STEPS',1)} Go to procedure



Saving a file converted to a Web page
You can preview and then save your range, sheet, or workbook as a Web page. 
1. To preview your file in a browser, click Preview in Browser.
2. Specify the location where you want to save your file.

Note By default, 1-2-3 enters a directory name in the "Directory" box, based on the name of the current file. If you
have previously saved this file, 1-2-3 displays the last local or network directory to which the file was saved. 

3. Click Save.
A message appears indicating the location where your file was saved.

4. Click OK.

{button ,AL(`H_123_SAVING_A_FILE_CONVERTED_TO_A_WEB_PAGE_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_HTML_FILES_OVER;H_123_BROWSING_INTERNET_FILES_STEPS;H_12

3_CONVERTING_A_WORKBOOK_TO_A_WEB_PAGE_CS;H_123_WORKING_WITH_INTERNET_CONNECTIO
NS_OVER;',0)} See related topics



Details: Saving a file converted to a Web page
Previewing the converted file
Click Preview in Browser to launch your default browser and display the Web page.

Specifying the location for the converted file
Specify the location where you want to save your file.

• Local or network drive - Saves your file to the local or network location you specified.
• Internet server - Saves your file to the Internet server you specified. See your system administrator for more 

information. To search for the Internet location where you want to save your converted Web page, click Browse.

{button ,AL(`H_123_SAVING_A_FILE_CONVERTED_TO_A_WEB_PAGE_STEPS',1)} Go to procedure



Browsing for Internet files
Use the Browse for Directory dialog box to select the Internet location where you want to save your converted Web 
page. 
1. Click Browse.
2. Select the FTP server where the file resides.

Tip If you want to connect to a server which is not on the list, click Setup to display the FTP Hosts tab of the 
Internet Setup dialog box, where you can define additional servers.

3. To automatically connect to this server each time you open or save a file to the Internet, select “Auto-connect to 
this server next time."

4. Click Connect.
1-2-3 connects to the server you specified. You can stop the connection process by clicking the Stop button. 
When the connection is successful, the Browse for Directory dialog box expands to display the server’s directory 
tree.

5. Select the directory name from the list.
6. Click OK to return to the Convert to Web Pages dialog box.
7. Click Save to save your converted file to the Internet server.

{button ,AL(`H_123_BROWSING_INTERNET_FILES_DETAILS',1)} See details
{button ,AL(`H_123_ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS;H_123_CONVER

TING_A_WORKBOOK_TO_A_WEB_PAGE_CS;H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;'
,0)} See related topics



Details: Browsing for Internet files
FTP servers
Displays names or descriptions for the FTP server you selected.

Auto-connect to this server next time
If you select this option, 1-2-3 automatically connects to this server whenever you open or save a file to the Internet. 
You can always specify another server to connect to, if you wish. A server which is defined to connect automatically 
has “(Default)” next to its name in the FTP servers box. You can only select one default server at a time.

Save in
Displays the current directory on the server. This option does not appear unless you have specified connection setup 
information. 

Current path
Displays the selected path on the FTP server, including all lower level directories. Below it is a list of directories and 
files in the selected location. This option does not appear unless you have specified connection setup information. 

{button ,AL(`H_123_BROWSING_INTERNET_FILES_STEPS',1)} Go to procedure



Converting a range, sheet, or workbook to jDoc format
You can save a range, a sheet, or the entire workbook in jDoc format in order to maintain all of the formatting 
(including any formatting which is not supported by HTML) that appears in the sheet.
1. From the File menu, choose Internet, and then choose Convert to Web Pages.
2. In the "File name for Web page" box, type a file name for your Web page.
3. Select what you want to convert.
4. If you are converting a range, type a range in the "Selected range" box, or use the range selector to select a 

range.
5. Under Format, select "jDoc (print snapshot)."
6. Click Next.

Note If you have not installed the Net-It Now! SE print driver, a message appears prompting you to rerun the 
install program.

7. (Optional) Select "Add a link for downloading the 1-2-3 file."
8. Click Next to preview and save your file.
9. To see how your page will look, click Preview in Browser.
10. Specify where you want to save the converted file. See Saving a file converted to a Web page for information.
11. Click Save.

{button ,AL(`H_123_CONVERTING_A_RANGE_SHEET_OR_WORKBOOK_TO_A_WEB_GRAPHIC_DETAILS',1)} 
See details

{button ,AL(`H_123_WORKING_WITH_HTML_FILES_OVER;H_123_CONVERTING_A_RANGE_TO_AN_HTML_TA
BLE_STEPS;H_123_CONVERTING_A_WORKBOOK_TO_A_WEB_PAGE_CS;H_123_WORKING_WITH_INTER
NET_CONNECTIONS_OVER;',0)} See related topics



Details: Converting a range, sheet, or workbook to jDoc format
When converting ranges to the jDoc format, 1-2-3 uses the current print settings (except for printer name, what to 
print, number of copies, and output to file) to "print" to the Net-It print driver. (For more information, see Overview: 
Print and page properties.)
The result is a file that looks identical to what the printed output would look like. When you view this Web page in a 
browser, the jDoc viewer loads and displays the jDoc file. 

Specifying a file name for the Web page
The default file name is the current 1-2-3 file name with an .HTM extension. If the current 1-2-3 file is untitled, the file 
name is untitled.htm. Valid HTML extensions are: .HTM, and .HTML.

Add a link for downloading the workbook file
If you select this option, 1-2-3 adds a link below the data to your Web page. 1-2-3 also saves a copy of the 1-2-3 file 
to the location you specify.

{button ,AL(`H_123_CONVERTING_A_RANGE_SHEET_OR_WORKBOOK_TO_A_WEB_GRAPHIC_STEPS',1)} Go
to procedure



Hyperlink dialog box
Use this dialog box to create, edit, or delete hyperlinks.

Choose a task
Creating a hyperlink
Editing a hyperlink
Removing a hyperlink



Creating a hyperlink
You can create hyperlinks on cells, buttons, and pictures. Hyperlinks can point to ranges or objects in the current 
workbook, to another file, or to a location on the Internet.
1. Select the cell, button, or picture you want to create a hyperlink for.
2. From the Create menu, choose Hyperlink.
3. In the "Action" box, select the type of hyperlink you want to create.
4. In the "Link to" box, specify the path.

You can click the icon to paste a location from the Clipboard into the "Link to" box.
5. Do one of the following:

• If you're creating a hyperlink on a cell, type the text for the link; for example, "Link1." If the cell already contains 
data, the data appears in the "Cell contents" box.
Caution The text you type in this box overwrites the contents of the cell.

• If you're creating a hyperlink on a button, type the text that will appear on the button.
6. Click OK.
Now when you click the cell, button, or picture, 1-2-3 goes to the location you specified.
Note When you pause the mouse over a hyperlinked cell, picture, or button, 1-2-3 displays the path of the link in the 
title bar.

{button ,AL(`H_123_CREATING_A_HYPERLINK_DETAILS',1)} See details
{button ,AL(`H_123_EDITING_A_HYPERLINK_STEPS;H_123_REMOVING_A_HYPERLINK_STEPS;',0)} See 

related topics



Details: Creating a hyperlink
Locations you can link to
You can create a hyperlink to the following locations:

• None - Removes the link currently displayed in the "Link to" box.
• Go to an Internet location - Links to the Internet location specified in the "Link to" box.
• Go to another file - Links to the file specified in the "Link to" box.
• Go to a range or object in this workbook - Links to the range or object specified in the "Link to" box.

Tip To create a button link to the Web, click this icon in the Internet Tools SmartIcons set.

Type or use Browse to enter the URL address, file name (including the path if it is not in the default path), range 
name, or object you want to link to. You can select from a list of recently used URL addresses or file names.

Browsing for a location
When you click Browse, 1-2-3 opens a dialog box or launches a browser where you can specify the location you want
to link to, depending on the option you select in the "Action" box. 

• Go to an Internet location - Opens the URL you specified in the "Link to" box. If there is no URL in the "Link to" 
box, 1-2-3 opens lotus.com.

• Go to another file - Opens the Choose File dialog box where you can specify the file you want to link to.
• Go to a range or object in this workbook - Opens the Go To dialog box where you can specify the range or object 

you want to link to. 
Note If you use the Go To dialog box, 1-2-3 enters in the "Link to box the type of object along with the name or 
address. For example, you will see SALES:Range if you selected a range named Sales.

Attaching a hyperlink to an object
• If the selected object is a cell, 1-2-3 displays the cell address (for example, A:G12) and the contents of the cell. 
• If the selected object is a button, 1-2-3 displays the button name (for example, Button1). If you are adding a 

hyperlink to an existing button, 1-2-3 displays the existing name in the Hyperlink dialog box.
• If the selected object is a picture, 1-2-3 displays the picture name (for example, Picture 1).

Note 1-2-3 does not use the picture name as an HTML ALT tag attribute.

Appearance of hyperlinks in cells
Hyperlinks display in blue or magenta text, underlined. The hyperlink is blue if unvisited; magenta if visited.

Copying hyperlinks
When you copy a cell containing a hyperlink, the cell contents, hyperlink information, and text attributes (blue or 
magenta, underlined text) get copied. 
If you use Edit - Paste Special to paste the hyperlinked cell, the hyperlink information is pasted if you select 
"Contents" and the text attributes are pasted if you select "Styles and number formats." If you deselect "Styles and 
number formats" but select "Contents," the cell will still be hyperlinked, even though the text is not blue or magenta 
and underlined.

{button ,AL(`H_123_CREATING_A_HYPERLINK_STEPS',1)} Go to procedure





Editing a hyperlink
When you pause the mouse over a hyperlinked cell, picture, or button, 1-2-3 displays the path of the link in the title 
bar.
1. Right-click on the cell, picture, or button that contains the hyperlink you want to edit.
2. Choose Edit Hyperlink.
3. Make any changes.
4. Click OK.

{button ,AL(`H_123_EDITING_A_HYPERLINK_DETAILS',1)} See details
{button ,AL(`H_123_REMOVING_A_HYPERLINK_STEPS;H_123_CREATING_A_HYPERLINK_STEPS;',0)} See 

related topics



Details: Editing a hyperlink
Locations you can link to
You can specify one of    the following locations:

• None - Removes the link currently displayed in the "Link to" box.
• Go to an Internet location - Links to the Internet location specified in the "Link to" box.
• Go to another file - Links to the file specified in the "Link to" box.
• Go to a range or object in this workbook - Links to the range or object specified in the "Link to" box.

Type or use Browse to change the URL address, file name (including the path if it is not in the default path), range 
name, or object you want to link to. You can select from a list of recently used URL addresses or file names.

Browsing for a location
When you click Browse, 1-2-3 opens a dialog box or launches a browser where you can specify the location you want
to link to, depending on the option you select in the "Action" box. 

• Go to an Internet location - Opens the URL you specified in the "Link to" box. If there is no URL in the "Link to" 
box, 1-2-3 opens lotus.com.

• Go to another file - Opens the Choose File dialog box where you can specify the file you want to link to.
• Go to a range or object in this workbook - Opens the Go To dialog box where you can specify the range or object 

you want to link to. 
Note If you use the Go To dialog box, 1-2-3 enters in the "Link to box the type of object along with the name or 
address. For example, you will see SALES:Range if you selected a range named Sales.

Attaching a hyperlink to an object
You can change the text in the "Cell contents" or "Button text" box.

• If the selected object is a cell, 1-2-3 displays the cell address (for example, A:G12) and the contents of the cell. 
• If the selected object is a button, 1-2-3 displays the button name (for example, Button1). If you are adding a 

hyperlink to an existing button, 1-2-3 displays the existing name in the Hyperlink dialog box.
• If the selected object is a picture, 1-2-3 displays the picture name (for example, Picture 1).

Note 1-2-3 does not use the picture name as an HTML ALT tag attribute.

{button ,AL(`H_123_EDITING_A_HYPERLINK_STEPS',1)} Go to procedure



Removing a hyperlink
When you pause the mouse over a hyperlinked cell, picture, or button, 1-2-3 displays the path of the link in the title 
bar.
1. Right-click the cell, button, or picture that contains the hyperlink you want to remove.
2. From the menu, choose Remove Hyperlink.
Tip You can also remove a hyperlink by selecting the cell, button, or picture, choosing Create - Hyperlink, and then 
clicking Remove Link.
1-2-3 removes the URL and, in cells, the text attributes for the hyperlink, but does not remove the cell contents, the 
button, or the picture the hyperlink was attached to.

{button ,AL(`H_123_EDITING_A_HYPERLINK_STEPS;H_123_CREATING_A_HYPERLINK_STEPS;',0)} See related
topics



Overview: Copying and moving
After you enter data, you can copy or move it to other places in the workbook.
You can copy or move:

• Sheets
• Ranges (including cells, columns, and rows)
• Charts, maps, and drawings (such as lines, arrows, rectangles, and ellipses)
• Text blocks and buttons
• Embedded objects

The difference between copying and moving data
Copying always leaves the original unchanged. Moving relocates your data to a destination you specify. 

Why it's necessary to select the data first
Since 1-2-3 places the data you selected on the Clipboard when you choose Edit - Cut or Edit - Copy, you must 
select the data to copy first.

About the Clipboard
The Clipboard is a temporary storage area provided by the operating system. You can use it to copy data within 1-2-3
or to copy data to other applications. The Clipboard always contains the data you most recently cut or copied.

About pasting
The destination range can be in the same workbook, in another workbook, or in another active application. When you 
paste the data, 1-2-3 takes a copy of the data from the Clipboard and puts it where you specify. You can paste the 
data to as many locations as you want. If you use Edit - Paste Special, 1-2-3 displays a dialog box showing different 
options. Use the options in the Paste Special dialog box to choose which properties of the copied object you want to 
include (or exclude) when you paste. 

About drag and drop
Dragging is a quick way to copy data to one location or to move data. When you drag data between sheets in a 
workbook, 1-2-3 does not store the data on the Clipboard. If you drag data between workbooks, 1-2-3 does store the 
data on the Clipboard. If you want to drag data from one 1-2-3 workbook to another, tile the workbooks so they're 
both visible first.

What gets copied or moved
When you copy or move cells, 1-2-3 copies or moves styles as well as contents. You can choose Edit - Copy and Edit
- Paste Special to paste cell comments to another cell. Scripts attached to ranges do not get copied but can get 
moved. 
When you copy or move graphic objects, 1-2-3 also copies or moves styles and scripts associated with the objects. 
You can copy or move a group of graphic objects, but not a collection of ranges or sheets.

Ways to copy and move data
You can copy data by dragging a copy to another location, by using Edit - Copy and Edit - Paste, or by copying to fill 
adjacent cells. You can move data by dragging it to another location or by using Edit - Cut and Edit -Paste.

When you want to copy Do this:



Data to one location Drag the data 
Data to more than one 
location

Copy and paste using the Clipboard

Formulas or data across a 
column or row

Copy to adjacent cells using Edit - 
Copy Right or Edit - Copy Down 

Data to another application Copy and paste using the Clipboard

Copying and moving ranges that contain formulas
Copying or moving a range that contains formulas can affect the results of the calculations in your data. When you 
copy a formula, the formula's relative references change, but when you move a formula, the references stay the 
same. For more information, see Overview: Copying and moving formulas.

{button ,AL(`H_COPYING_123_DATA_TO_OTHER_APPLICATIONS_OVER;H_COPYING_USING_THE_CLIPBOAR
D_STEPS;H_COPYING_AND_MOVING_IN_A_SHEET_STEPS;H_COPYING_RIGHT_TO_FILL_A_RANGE_STE
PS;H_COPYING_DOWN_TO_FILL_A_RANGE_STEPS;H_COPYING_FORMATS_STEPS;H_COPYING_CELL_
COMMENTS_STEPS;H_MOVING_USING_THE_CLIPBOARD_STEPS;H_123_S98_MOVING_A_SHEET_STEP
S;H_123_COPYING_A_SHEET_STEPS;H_123_COPYING_COLUMN_WIDTHS_AND_ROW_HEIGHTS_STEPS;
H_123_COPYING_TO_FILL_A_3D_RANGE_STEPS',0)} See related topics



Copying and moving using drag and drop
You can use the mouse to copy and move data in 1-2-3. 
1. Select what you want to copy or move.
2. Move the mouse pointer to the edge of the selection so that the pointer changes to a hand.

3. To move the selection, press the mouse button, and drag the selection.

4. To copy the selection, hold down CTRL, press the mouse button, and drag a copy of the selection.

While you drag, your selection is represented as an outline.
5. Release the mouse button when the outline of your selection is where you want it.

If you're copying, release the mouse button first and then release CTRL.
Tip To get to a part of the sheet that isn't visible, drag the selection to the edge of the sheet to scroll the sheet.

{button ,AL(`H_COPYING_AND_MOVING_IN_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_CELL_COMMENTS_STEPS;H_COP

YING_DOWN_TO_FILL_A_RANGE_STEPS;H_COPYING_FORMATS_STEPS;H_COPYING_AND_MOVING_OV
ER;H_COPYING_RIGHT_TO_FILL_A_RANGE_STEPS;H_COPYING_USING_THE_CLIPBOARD_STEPS;H_MO
VING_USING_THE_CLIPBOARD_STEPS;H_123_COPYING_A_SHEET_STEPS;H_123_S98_MOVING_A_SHE
ET_STEPS',0)} See related topics



Details: Copying and moving using drag and drop
Copying or moving over existing data
If the destination already contains data, 1-2-3 asks if you want to replace the existing data with your selection or 
cancel the operation. If you accidentally delete data by dragging your selection on top of it, you can immediately 
choose Edit - Undo.

Copying or moving to another sheet
Drag the selection, without releasing the mouse button (and CTRL if copying), to the other sheet's tab, then to the 
location on the sheet.

Copying or moving to another active workbook
Tile the workbook windows so that both are visible, then drag the selection, without releasing the mouse button (and 
CTRL if copying), to the new workbook.

Dragging graphic objects
Drag a graphic object by any part except the handles; when copying or moving a shape with a transparent interior, 
drag it by the border, not the interior. If you select more than one graphic object, you can move them all by dragging 
one.

Canceling the copy or move
To cancel the drag operation, press ESC.

How moving ranges affects attached scripts
To move a script attached to a range, you must move the top left or bottom right corner of the scripted range. 1-2-3 
moves a script attached to a cell or range only if you move it within a workbook using drag and drop or Edit - Cut and 
Edit - Paste. 
To edit scripts and move them between workbooks, use the Integrated Development Environment (IDE). See 
Overview: Using LotusScript for more information.

Turning off drag and drop
You can turn off drag and drop by choosing File - User Setup - 1-2-3 Preferences (General tab), and deselecting 
"Drag and drop cells and sheets." You can also turn off the message that 1-2-3 displays when you drag over existing 
data by choosing File - User Setup - 1-2-3 Preferences (General tab), and deselecting "Confirm overwrite for drag 
and drop." 

Related SmartIcons

Lets you turn off drag and drop and set other 1-2-3 preferences

{button ,AL(`H_COPYING_AND_MOVING_IN_A_SHEET_STEPS',1)} Go to procedure



Copying a sheet
There are two ways to copy a sheet within a 1-2-3 workbook.

Using the mouse to copy a sheet (drag and drop)
Note You can copy only one sheet at a time, and you cannot copy sheets between workbooks.
1. Move the mouse pointer to the edge of the tab of the sheet you want to copy.

The mouse pointer changes to a hand.

2. Hold down CTRL and drag the sheet tab to a new location.
The triangle indicates the location for the copied sheet.

3. Release the mouse button and CTRL.

1-2-3 makes a copy of the sheet and appends a number to the sheet name to indicate that it is a copy.
Tip To copy a sheet to a location that is not visible in the window, drag the sheet over the sheet scroll buttons.

Using the menu to copy a sheet
1. From the Sheet menu, choose Move or Copy Sheet.
2. Select "Copy."
3. In the first sheet box, select the sheet you want to copy.

1-2-3 lists all sheets except hidden sheets. You cannot copy hidden sheets.
4. Select "Before" or "After."
5. In the second sheet box, select the location where you want to copy the sheet.
6. Click OK.
1-2-3 makes a copy of the sheet and appends a number to the sheet name to indicate that it is a copy.

{button ,AL(`H_123_COPYING_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_OVER;H_123_S98_

MOVING_A_SHEET_STEPS',0)} See related topics



Details: Copying a sheet
What happens to formulas?
Formulas adjust just as they do when you copy them within a sheet. For more information on copying formulas, see 
Overview: Copying and moving formulas. 

What happens to scripts?
1-2-3 copies scripts attached to graphic objects, but does not copy scripts attached to ranges.

What happens to the sheet name?
• 1-2-3 adds a number to the sheet name to indicate that it is a copy. For example, a copy of sheet A becomes A_2.

A second copy of sheet A becomes A_3, and so on. A copy of a sheet named Expenses becomes Expenses_2. 
• If a sheet's name is longer than 15 characters after you copy it, 1-2-3 truncates the name. For example, a copy of 

the sheet named Goods_And_Labor    would be Goods_And_Lab_2. 
Tip To rename the sheet, double-click the tab, type a new name, and then press ENTER. To change the name 
back to the letter name, double-click the tab, delete the sheet name, and then press ENTER.

Turning drag and drop on and off
If drag and drop is turned off, the mouse pointer will not change to a hand when you try to drag and drop. To turn drag
and drop back on, choose File - User Setup - 1-2-3 Preferences (General tab) and select "Drag and drop cells and 
sheets."

Copying a sheet containing named ranges
1-2-3 does not copy range names because you cannot have duplicate range names in a workbook. If you copy a 
sheet containing named macros, the names are not copied with the macros.

Copying a sheet containing versions
Copying a sheet with versions on it copies only the contents of the current version as a range.

Copying a sheet into a group of sheets
If you copy a sheet into a set of grouped sheets, the sheet you copy will lose its formatting and use the formats of the 
grouped sheets.

Copying a locked sheet 
If you copy a locked sheet, the copy is also locked.

Notes
• To copy a sheet before or after itself, use the menu instead of drag and drop.
• You cannot copy a sheet if the workbook is locked.
• You cannot copy a sheet if the Preview window is open.

{button ,AL(`H_123_COPYING_A_SHEET_STEPS',1)} Go to procedure



Copying using the Clipboard
The Clipboard is useful when you want to copy data to more than one location.
Note You cannot copy a sheet using the Clipboard. See Copying a sheet. 
1. Select what you want to copy.
2. From the Edit menu, choose Copy.

1-2-3 places a copy of your selection on the Clipboard.
3. Select the destination for the copied data.

Caution If you're copying a range, 1-2-3 writes over any existing data in the destination range, including data in 
hidden columns, rows, or sheets.

4. From the Edit menu, choose Paste.

{button ,AL(`H_COPYING_USING_THE_CLIPBOARD_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_IN_A_SHEET_STEP

S;H_COPYING_AND_MOVING_OVER;H_COPYING_RIGHT_TO_FILL_A_RANGE_STEPS;H_MOVING_USING
_THE_CLIPBOARD_STEPS;',0)} See related topics



Details: Copying using the Clipboard
Shortcut for pasting data
You can select the destination and press ENTER to paste the data. Pressing ENTER works only once after each copy 
or cut.

Selecting the destination
If you copy a range, the destination must be a range. If you copy a graphic object, the destination can be a range or 
graphic object.

About the destination range
You need to select only one cell of the destination range. 1-2-3 treats that cell as the top left cell of the destination 
and pastes all the data in its original size and layout. 1-2-3 pastes all the data, regardless of the size of the 
destination range. If you copy a single cell and the destination range is larger than one cell, 1-2-3 repeats the data 
until the range is full.

Pasting text into a text block
To paste text into a text block, double-click the text block and use CTRL+V instead of Edit - Paste. 

Copying named styles
When you copy a cell that uses a named style, 1-2-3 copies the named style so you can paste it into a different 
workbook. This is an easy way to share named styles between workbooks.

Related SmartIcons

Copies and fills a range to the right

Copies and fills a range down

Copies and fills a range down and right

Copies a range's styles to other ranges

{button ,AL(`H_COPYING_USING_THE_CLIPBOARD_STEPS',1)} Go to procedure



Copying right to fill a range
You can quickly copy formulas or any data across a row. 

 Show me a QuickDemo
1. Select a range that includes the data and the cells where you want to copy the data.

2. From the Edit menu, choose Copy Right.

 
Caution 1-2-3 writes over any existing data in the range, including data in hidden columns and rows.

1-2-3 copies the data from the first column to the rest of the cells in the selected range. However, when you use Edit -
Copy Right, 1-2-3 does not copy cell comments or scripts.

Related SmartIcons

Copies and fills a range down

Copies and fills a range down and right

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_IN_A_SHEET_STEP
S;H_COPYING_DOWN_TO_FILL_A_RANGE_STEPS;H_COPYING_AND_MOVING_OVER;H_COPYING_USIN
G_THE_CLIPBOARD_STEPS;H_123_COPYING_TO_FILL_A_3D_RANGE_STEPS',0)} See related topics



Copying down to fill a range
You can quickly copy formulas or any data down a column. 

 Show me a QuickDemo
1. Select a range that includes the data and the cells where you want to copy the data.

2. From the Edit menu, choose Copy Down.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns and rows.
1-2-3 copies the data from the top row to the rest of the cells in the selected range. However, when you use Edit - 
Copy Down, 1-2-3 does not copy cell comments or scripts.

Related SmartIcons

Copies and fills a range to the right

Copies and fills a range down and right

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_IN_A_SHEET_STEP
S;H_COPYING_AND_MOVING_OVER;H_COPYING_USING_THE_CLIPBOARD_STEPS;H_COPYING_RIGHT_
TO_FILL_A_RANGE_STEPS;H_123_COPYING_TO_FILL_A_3D_RANGE_STEPS',0)} See related topics



Copying styles
You can copy the styles of cells, including number formats, without copying the data in the cells. 
1. Select the range.
2. From the Edit menu, choose Copy.

3. Select the range to which you want to apply the styles.
4. From the Edit menu, choose Paste Special.

5. Do one or more of the following:
• To avoid pasting the cell data, deselect "Contents."
• To paste all styles except range borders and designer frames, select "Styles and number formats."
• To paste borders, select "Borders."
• To paste designer frames, select "Charts, maps, drawings, and designer frames."

6. Click OK.
Note To copy a border or designer frame, you must include the entire border or frame in the range you selected.

{button ,AL(`H_COPYING_FORMATS_DETAILS',1)} See details
{button ,AL(`H_COPYING_CELL_COMMENTS_STEPS;H_COPYING_AND_MOVING_OVER;H_COPYING_USING

_THE_CLIPBOARD_STEPS;H_USING_FAST_FORMAT_TO_STYLE_A_RANGE_STEPS;',0)} See related topics



Details: Copying styles
Copying styles from one sheet to another by grouping
You can group sheets together to apply the styles of one sheet to other sheets, and to style the group of sheets at the
same time. 

Related SmartIcons

Copies a range's styles to other ranges

Pastes a range's styles, except borders

{button ,AL(`H_COPYING_FORMATS_STEPS',1)} Go to procedure
{button ,AL(`H_COPYING_OVER;H_GROUPING_SHEETS_STEPS;H_USING_FAST_FORMAT_TO_STYLE_A_RA

NGE_STEPS',0)} See related topics



Copying cell comments
You can copy cell comments without copying the data in the cells.
1. Select the range.
2. From the Edit menu, choose Copy.

3. Select the destination range.
Caution 1-2-3 replaces any cell comments in the destination range with the cell comments you copied.

4. From the Edit menu, choose Paste Special.

5. Select "Cell comments" and deselect the options you don't want to paste.
6. Click OK.

{button ,AL(`H_COPYING_CELL_COMMENTS_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_CELL_COMMENT_STEPS;',0)} See related topics



Details: Copying cell comments
You cannot use the 1-2-3 Classic (/C) command to copy cell comments.
You cannot use drag and fill or drag and clear to copy or delete cell comments.

{button ,AL(`H_COPYING_CELL_COMMENTS_STEPS',1)} Go to procedure



Paste Special dialog box
Use this dialog box to choose which properties of the range you want to include (or exclude) when you paste. 

Choose a task
Copying a formula's result
Copying styles
Copying cell comments
Copying column widths and row heights 

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_OVER;',0)} See 
related topics



Copying column widths and row heights
You can copy column widths and row heights to another range with or without copying the contents of the range. 
1. Select the range.
2. From the Edit menu, choose Copy.

3. Select the range to which you want to apply the column widths and row heights.
4. From the Edit menu, choose Paste Special.

5. Select "Column widths and row heights."
6. Click OK.
Note 1-2-3 does not copy column widths or row heights if you have set different sheet defaults for the column width 
and row height on each sheet.

{button ,AL(`H_COPYING_AND_MOVING_OVER;H_COPYING_FORMATS_STEPS',0)} See related topics



Copying to fill a 3D range
You can copy data between sheets in a 3D range. 
1. On the first sheet, select the data you want to copy.
2. Hold down SHIFT and click the tab of the last sheet you want to copy to.

1-2-3 selects a 3D range.
3. In the last sheet, move the mouse pointer over the selected range and click the right mouse button.
4. From the menu, choose Copy Back.
1-2-3 copies data from the selected range in the first sheet to the other sheets included in the 3D range.

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_OVER;H_COPYING_
USING_THE_CLIPBOARD_STEPS;H_COPYING_RIGHT_TO_FILL_A_RANGE_STEPS;H_COPYING_DOWN_T
O_FILL_A_RANGE_STEPS',0)} See related topics



Overview: Copying and moving formulas
You can copy or move formulas to use them in different cells of the same sheet, in different sheets, or in different 
workbook files. You copy or move a formula the same way you copy other data. You can also copy just the result of a 
formula.
When you move a formula or the data it refers to, 1-2-3 makes any necessary changes so that the formula still refers 
to the same data. However, when you copy a formula, you can make the formula refer to the original or different data 
by using relative, absolute, or mixed references to cell addresses in the formula.

Using relative references to adjust cell addresses
When you copy a formula that contains cell addresses, 1-2-3 adjusts the addresses to their new location(s) in the 
sheet. Addresses that adjust when you copy them are called relative references. A relative reference can be an 
address, such as A:B25, or a range name. 
For example, if the formula +A1+A2 is in cell A4 and you copy this formula to B4, the formula in B4 changes to 
+B1+B2. 1-2-3 adjusts the cell addresses in the formula relative to the formula's new location.

 See example

Using absolute references to keep cell addresses unchanged
Sometimes you want a formula to refer to the same cells, no matter where and how many times you copy and paste 
it. To ensure that the formula always refers to the same cells, you change the references to those cells to absolute 
references. An absolute reference always refers to the same cell or range.
To make a relative reference absolute, you add a $ (dollar sign) before the sheet letter or name, column letter, and 
row number. For example: $A:$B$25. To make a range name absolute, enter a $ (dollar sign) before the range name.
For example: $INTEREST.

 See example

Using mixed references to keep part of a cell address unchanged
Sometimes when you copy or move a formula that refers to a cell or range, you want part of the address to stay the 
same and part of the address to adjust. For example, you may want the column letter to stay the same but the row 
number to change. To do this, you create a mixed reference by making part of the address absolute and leaving the 
other part relative. 
For example, the formula $A:B$25 contains a mixed reference. The sheet letter (A) and row number (25) are absolute
references and are preceded by a $. The column letter (B) is a relative reference. If you copy the formula, the sheet 
letter and row number stay the same while the column letter adjusts relative to its new location.

 See example

{button ,AL(`H_COPYING_AND_MOVING_OVER;H_COPYING_A_FORMULA_STEPS;H_COPYING_A_FORMULA
S_RESULT_STEPS;H_MOVING_A_FORMULA_STEPS;',0)} See related topics



Example: Using relative references
Suppose you create a formula that adds the values in column A, and you want to use the same formula to add the 
values in column B. To do this, copy the formula in column A and paste it into column B. 
As shown below, 1-2-3 automatically adjusts the cell addresses in the formula to refer to cells in the formula's new 
location.

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_EXAMPLE_USING_ABSOLUTE_REFERENCES
_EX;H_EXAMPLE_USING_MIXED_REFERENCES_EX',0)} See related topics



Example: Using absolute references
Suppose you're calculating the interest on a series of principal values, and you want to use the same interest rate 
each time. You can make the formula that calculates interest use an absolute reference to the cell containing the 
interest rate. 
When you copy the formula and paste it into other cells, the formula multiplies all of the principal amounts by the 
same interest rate in A2. The copied formulas will still refer to the single cell that contains the interest rate because of 
the absolute reference.

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_EXAMPLE_USING_MIXED_REFERENCES_EX;
H_EXAMPLE_USING_RELATIVE_REFERENCES_EX',0)} See related topics



Example: Using mixed references
Suppose you want to calculate interest on a series of principal values, using three different interest rates. You can 
use the same formula to do all the calculations, as long as it contains mixed references.
In the example below, the formula in B4, +$A4*B$1, uses an absolute reference to the column that contains the 
various principal values, but a relative reference to the row, so that 1-2-3 looks in the same column but moves down a
row each time. 
The formula refers to the interest rate by using an absolute reference to the row that contains the interest rates, but a 
relative column reference, so that 1-2-3 looks in the same row, but moves across a column each time. 

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_EXAMPLE_USING_ABSOLUTE_REFERENCES
_EX;H_EXAMPLE_USING_RELATIVE_REFERENCES_EX',0)} See related topics



Copying a formula
You can copy a formula to use in one or more cells.
1. Select the cell or range that contains the formula(s) you want to copy.
2. (Optional) Edit the formula, if needed, to create relative, absolute, or mixed references to cell addresses. 

Tip When you're editing a formula, you can press F4 to cycle through relative, absolute, and mixed reference 
variations.

3. Choose Edit - Copy.

4. Select the cell or range where you want to paste the formula(s).
5. Choose Edit - Paste.

6. (Optional) Paste the formula(s) into additional cells.
Tip You can also copy a formula using drag and drop.

{button ,AL(`H_COPYING_A_FORMULA_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_A_FORMULAS_RESULT_STEPS;H_

EDITING_A_FORMULA_STEPS;H_COPYING_AND_MOVING_IN_A_SHEET_STEPS;',0)} See related topics



Details: Copying a formula
When you copy formulas, 1-2-3 adjusts any relative and mixed references in the copied formulas. 1-2-3 does not 
adjust absolute references. 

Copying a formula to adjacent cells
Sometimes, you want to copy a formula to adjacent cells. 
Suppose that cell A5 contains the formula @SUM(A1..A3) and you want to copy the formula to the adjacent three 
cells. You can quickly copy the formula in cell A5 to B5..D5 using Edit - Copy Right.
You can also use Edit - Copy Down to copy the contents of the topmost cell in a selected range down to the 
remaining cells in the range. 

Related SmartIcons

Pastes the cell contents

Copies the leftmost column to a range

Copies the topmost row to a range

{button ,AL(`H_COPYING_A_FORMULA_STEPS',1)} Go to procedure
{button ,AL(`H_COPYING_DOWN_TO_FILL_A_RANGE_STEPS;H_COPYING_RIGHT_TO_FILL_A_RANGE_STEP

S;',0)} See related topics



Copying a formula's result
You can copy a formula's result, rather than the formula itself, when you need only the value for further calculations or
when you don't want anyone to see the calculations that produced that value.
1. Select the cell or range that contains the formula(s) whose result(s) you want to copy.
2. Choose Edit - Copy.

3. Select the cell or range where you want to paste the result(s) of the formula(s).
4. Choose Edit - Paste Special.

5. Select "Formulas as values."
6. Click OK.
Tip To convert a formula to its value, double-click the cell containing the formula and press F9 (CALC). After you 
convert a formula to its value, you cannot retrieve the formula.

Related SmartIcons

Pastes formulas as values

{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_A_FORMULA_STEPS',0)} See related
topics



Moving a formula
1. Select the cell or range that contains the formula(s) you want to move.
2. Choose Edit - Cut.

3. Select the cell or range where you want to paste the formula(s).
4. Choose Edit - Paste.

Tip You can also move a formula using drag and drop.

{button ,AL(`H_MOVING_A_FORMULA_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_MOVING_USING_THE_CLIPBOARD_STEPS;H_

COPYING_A_FORMULAS_RESULT_STEPS;H_EDITING_A_FORMULA_STEPS;H_COPYING_AND_MOVING_I
N_A_SHEET_STEPS;',0)} See related topics



Details: Moving a formula
Keep in mind...

• If you move a formula, but not the data it refers to, the references in the formula don't change. 
For example, if you move the formula +A1+B3 from cell C10 to D10, the formula remains +A1+B3.

• If you move the data that a formula refers to, 1-2-3 adjusts the formula.
For example, if cell C10 contains +A1+B3 and you move the contents of cell A1 to cell Q25, the formula in cell 
C10 changes to +Q25+B3.
Note If you move the data to another workbook, 1-2-3 does not adjust the formula.

• If you move a formula and any of the data it refers to, 1-2-3 adjusts all references to that data, including absolute 
references. 
For example, if cell A3 contains the formula +$A$1+A2 and you move the range A1..A3 to B1..B3, the formula in 
cell B3 is +$B$1+B2.

• If you move a formula on top of data referred to by another formula, the other formula evaluates to ERR.
For example, if cell A10 contains the formula +A1 and you move B1 (which contains a formula) to A1, the formula 
in A10 results in ERR.

{button ,AL(`H_MOVING_A_FORMULA_STEPS',1)} Go to procedure
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Overview: Copying and moving 1-2-3 data to other applications
There are several ways to copy or move data from 1-2-3 to another application. You can:

• Use Edit - Copy or Edit - Cut to copy or move 1-2-3 data to the Clipboard so you can use this data in another 
application.

• Use drag and drop to copy data between applications. Both applications must be open and tiled. 
Note You cannot copy or move a sheet to another application, but you can copy or move the data on the sheet.

• Save 1-2-3 files to other application file formats. File - Save As lets you export data by saving it in the file formats 
for other applications such as Excel, dBASE, and Paradox. You can save an entire file or just a selected range of 
data. For more information on the file formats, see Overview: Closing and saving files. 

{button ,AL(`H_COPYING_123_DATA_TO_OTHER_APPLICATIONS_OVER;H_BRINGING_DATA_FROM_OTHER_
APPLICATIONS_INTO_123_STEPS;H_COPYING_DATA_INTO_123_WITH_DRAG_AND_DROP_STEPS;H_OP
ENING_A_TEXT_FILE_STEPS;H_CLOSING_AND_SAVING_FILES_OVER;H_COPYING_AND_MOVING_OVER
;H_COPYING_USING_THE_CLIPBOARD_STEPS;',0)} See related topics



Overview: Using data from other applications in 1-2-3
There are several ways to bring data from another Windows application into 1-2-3. You can: 

• Cut or copy data to the Clipboard in another application and then use Edit - Paste to bring the data into 1-2-3.
• Use drag and drop to copy data between 1-2-3 and other applications. Both applications must be open and tiled. 
• Use File - Open to bring data into 1-2-3. This single command brings in data from 1-2-3 workbook files as well as 

many other file types including Excel, dBASE, Paradox, text files, and HTML. In the File Open dialog box, choose 
Combine to insert data from another file into the current workbook.

• Use File - Open to import data from a text file. You enter the name of the text file, select "Text file" as the file type, 
and designate how to parse the data and what character set to use to interpret it.

{button ,AL(`H_COPYING_AND_MOVING_OVER;H_COPYING_123_DATA_TO_OTHER_APPLICATIONS_OVER;H
_BRINGING_DATA_FROM_OTHER_APPLICATIONS_INTO_123_STEPS;H_COPYING_DATA_INTO_123_WITH
_DRAG_AND_DROP_STEPS;H_COPYING_DATA_FROM_123_WITH_DRAG_AND_DROP_STEPS;H_OPENIN
G_A_TEXT_FILE_STEPS;H_COPYING_USING_THE_CLIPBOARD_STEPS;H_COMBINING_DATA_STEPS;;H_
123_DDE_OVER;H_SHARING_DATA_USING_OLE2_OVER',0)} See related topics



Copying data from 1-2-3 with drag and drop
To copy data from 1-2-3 using drag and drop, the other application must also support drag and drop. Drag and drop 
does not use the Clipboard. 
1. Tile the 1-2-3 window and the window of the destination application so that both are visible.
2. In 1-2-3, select the range or graphic object you want to copy. 
3. Position the mouse pointer on the border of your selection so that the pointer changes to a hand.

4. While holding down the left mouse button, drag the selection to the destination application.
5. Release the mouse button. 

{button ,AL(`H_USING_DATA_FROM_OTHER_APPLICATIONS_IN_123_OVER;H_COPYING_123_DATA_TO_OTH
ER_APPLICATIONS_OVER;H_COPYING_DATA_INTO_123_WITH_DRAG_AND_DROP_STEPS;',0)} See 
related topics



Copying and moving data from other applications into 1-2-3
1-2-3 uses a number of standard Clipboard formats to exchange data between applications via the Clipboard.
Note If you use Edit - Paste Special to copy or move data, you can select which Clipboard format you want to use. 
1. In the source application, select what you want to copy or move.
2. Choose Edit - Copy or Edit - Cut to copy or move your selection to the Clipboard.
3. In 1-2-3, click the sheet where you want to place the top left corner of what you are copying or moving.
4. Choose Edit - Paste.

{button ,AL(`H_BRINGING_DATA_FROM_OTHER_APPLICATIONS_INTO_123_DETAILS',1)} See details
{button ,AL(`H_USING_DATA_FROM_OTHER_APPLICATIONS_IN_123_OVER;H_COPYING_123_DATA_TO_OTH

ER_APPLICATIONS_OVER;H_COPYING_AND_MOVING_OVER;',0)} See related topics



Details: Copying and moving data from other applications into 1-2-3
Copying pictures into 1-2-3
If you copy a picture into 1-2-3 from another application, you can manipulate it the same way you manipulate other 
graphic objects.
For example, you can create or edit a picture with a graphics editor and copy it to the Clipboard. If you paste it into a 
1-2-3 sheet, you can select, move, copy, size, or delete it. If you paste the picture on a graphic object, 1-2-3 places 
the top left corner of the picture over the top left corner of the graphic object. 

{button ,AL(`H_BRINGING_DATA_FROM_OTHER_APPLICATIONS_INTO_123_STEPS',1)} Go to procedure



Copying data into 1-2-3 with drag and drop
To copy data into 1-2-3 using drag and drop, the source application must support drag and drop.
1. Tile the 1-2-3 window and the window of the other application so that both are visible.
2. In the source application, select the data you want to copy.
3. While holding down the left mouse button, drag the selection to its destination in 1-2-3. 
4. Release the mouse button. 
Note If the source application doesn't support drag and drop, use Edit - Copy and Edit - Paste. 

{button ,AL(`H_COPYING_AND_MOVING_OVER;H_USING_DATA_FROM_OTHER_APPLICATIONS_IN_123_OVE
R;H_COPYING_123_DATA_TO_OTHER_APPLICATIONS_OVER;H_BRINGING_DATA_FROM_OTHER_APPLIC
ATIONS_INTO_123_STEPS;',0)} See related topics



Creating custom @functions
You can use LotusScript to create your own @functions and use them just as you would use any of the built-in 1-2-3 
@functions.
1. Choose Create - @Function.
2. Enter a name for the function in the "Name" box. Do not include the @ symbol in the name.
3. Click OK.

1-2-3 displays an empty function in the Script Editor.
4. Enter the statements that you want to execute when 1-2-3 invokes the function.
5. Close the Script Editor when you finish writing the function statements.

{button ,AL(`H_CREATING_CUSTOM_FUNCTIONS_DETAILS',1)} See details
{button ,AL(`H_CREATING_CUSTOM_FUNCTIONS_EX',1)} See example
{button ,AL(`H_FUNC_BASICS;',0)} See related topics



Example: Creating custom @functions
This example creates an @function called @CELSIUS that converts a temperature measured in degrees Fahrenheit 
to its equivalent temperature measured in degrees Celsius.
Enter the following code to create the @CELSIUS function:
Function Celsius(temp As Integer) as Long

Celsius = (temp-32) * 5/9
End Function
Now you can use the @function to convert temperatures. For example: 
@CELSIUS(87) = 31



Details: Creating custom @functions
Other ways to create custom @functions
Choose Edit - Scripts & Macros - Show Script Editor to open the Script Editor and then choose Create - Function from
the main menu in the Script Editor.

Naming custom @functions
Follow the LotusScript function naming conventions when naming custom @functions. Do not use the name of an 
existing @function, macro keyword, or LotusScript keyword. For more information on naming functions, choose Help 
- LotusScript from the main menu in the Script Editor, then search on "Names, construction rules" in the LotusScript 
Help Index.

Specifying arguments for custom @functions
LotusScript lets you specify up to 31 arguments for functions you define. However, if you plan to use a function as a 
custom @function, you can specify only 30 arguments.

Saving custom @functions
To save custom @functions and any other scripts, save the workbook file that contains them.

Using custom @functions
Use a custom @function in the same way you use the @functions that are built into 1-2-3: Simply type the @function 
and its arguments into a cell.
Caution Do not write custom @functions that alter 1-2-3 objects. If the script for a custom @function contains 
statements that alter objects, unexpected results may occur.

{button ,AL(`H_CREATING_CUSTOM_FUNCTIONS_STEPS',1)} Go to procedure



Sorting data
You can sort data in a range in the order you specify.

 Show me a QuickDemo
1. Select the range of data you want to sort.
2. From the Range menu, choose Sort.
3. From the "Available columns" list, select a column to sort by.
4. Click >> or drag the selected column into the "Sort by" list.
5. (Optional) If two or more records have the same entry for the column you selected, add another column to the 

"Sort by" list.
For example, if you are sorting by Last Name, you will probably also want to sort by ID Number.

6. Under Sort order, select an option.
7. (Optional) Select "Header at top" and enter a number or click the arrows to indicate how many rows make up the 

headers.
1-2-3 does not include the header row(s) in the sort.

8. Click OK.

{button ,AL(`H_SORTING_DATA_DETAILS',1)} See details
{button ,AL(`H_SETTING_SORTING_OPTIONS_STEPS;H_CHANGING_INTERNATIONAL_SETTINGS_STEPS;',0)}

See related topics



Details: Sorting data
Choosing a sort order
The Sort dialog box has sort order options.

• Ascending -- Sorts labels in A - Z order and values from smallest to largest.
• Descending -- Sorts labels in Z - A order and values from largest to smallest.

Easy ways to work in the Sort dialog box
• To remove a column from the "Sort by" list, drag it out of the box.
• To move a column from the "Sort by" list back to the "Available columns" list, select the column name and click 

<<.
• To change the position of a column in the "Sort by" list, drag it up or down the list.
• To change the sort order for a column in the "Sort by" list, select the column name and click "Ascending" or 

"Descending" under "Sort order." [A] following a column name means ascending order; [D] means descending 
order. 

When to select headers in the sort range
It is often convenient to include header rows when you select the sort range, especially when selecting a large data 
table by range name. Specifying how many rows deep the headers are in the table ensures that you do not sort the 
column titles along with the data. 

Using the sorting SmartIcons
If the range you want to sort is surrounded by empty cells, you can use the sorting SmartIcons to sort the range 
quickly. Simply click a cell in the column you want to sort on, then click a sorting SmartIcon -- 1-2-3 identifies the 
range, allows for header rows, and sorts the range. 

• To sort the entire range, select a single cell in the column you want to sort on. If you have not sorted the range 
before, 1-2-3 assumes that there is one header row. If you have sorted the range before, 1-2-3 uses the number 
of header rows last specified in the Sort dialog box.

• To sort some of the rows in the range, select the cells in those rows in the column you want to sort on. When you 
select more than one cell, 1-2-3 does not use any header rows.

Sorts labels in A - Z order and values from smallest to largest

Sorts labels in Z - A order and values from largest to smallest
Tip To display the SmartSort icons, see Adding an icon to a set of SmartIcons. 

{button ,AL(`H_SORTING_DATA_STEPS',1)} Go to procedure



Parsing data
You can parse long labels from an imported text file into separate columns of values, dates, times, and labels.
1. Select the range containing the labels you want to parse.
2. From the Range menu, choose Parse.
3. Click Guess Format.

Based on the first label in the range, 1-2-3 guesses the correct format line and puts it in the "Format line" box.
4. (Optional) Edit the format line.
5. In the "Put the results in" box, specify the range or the first cell of the range where you want the parsed data to 

appear.
Caution 1-2-3 writes over any existing data, including hidden data, in the range you specify for the parsed data.

6. (Optional) To clear the format line and start again, click Clear Format.
7. Click OK.

{button ,AL(`H_OPENING_A_TEXT_FILE_STEPS;',0)} See related topics



Transposing data
You can copy data in a range, transposing rows and columns within the same sheet or across sheets and replacing 
formulas with their current values.
1. If the CALC button appears in the status bar, press F9 (CALC) to update formulas in the range you want to 

transpose.
If this range contains formulas linked to data in other workbooks, use Edit - Manage Links to update these 
formulas. 

2. Select the range you want to transpose.
3. From the Range menu, choose Transpose.

4. In the "Put the results in" box, specify the range or the first cell of the range where you want to copy the 
transposed data.
If you are transposing a 3D range, make sure you specify enough sheets in the range to accommodate the 
transposed data.
Caution 1-2-3 writes over any existing data, including hidden data, in the results range.

5. Click OK.
6. (Optional) If you are transposing a 3D range, the Transpose Options dialog box appears. Indicate how you want 

1-2-3 to transpose the data, and click OK.

{button ,AL(`H_TRANSPOSING_DATA_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_OVER;',0)} See related topics



Details: Transposing data
The results of transposing data
You can transpose rows and columns, columns and sheets, and rows and sheets. When you transpose data, 1-2-3 
copies the formats, styles, and protection setting of the selected range.

Transposing rows and columns
When you transpose rows and columns, 1-2-3 copies the selected range and converts rows into columns or columns 
into rows. You can transpose rows and columns within the same sheet or across sheets. The illustration below shows
how 1-2-3 transposes rows and columns within the same sheet.

Transposing columns and sheets
When you transpose columns and sheets, 1-2-3 copies each column (or sheet) in the selected range to the 
corresponding sheet (or column) in the range where you put the results. Each transposed column remains a column 
in the range where you put the results. The illustration below shows how 1-2-3 transposes columns and sheets.

Transposing rows and sheets
When you transpose rows and sheets, 1-2-3 copies each row (or sheet) in the selected range to the corresponding 
sheet (or row) in the range where you put the results. Each transposed row remains a row in the range where you put
the results. The illustration below shows how 1-2-3 transposes rows and sheets.

{button ,AL(`H_TRANSPOSING_DATA_STEPS',1)} Go to procedure



Create Form dialog box
Use the Create Form dialog box to connect with Lotus Approach and create a form for working with    records from a 
1-2-3 database table.
You can use the form to view records in a 1-2-3 database table one at a time, to edit records, and to create new 
records. 

Choose a topic
Creating a database form

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER',0)} See related topics



Creating a database form
1-2-3 works with Lotus Approach to create a form for adding, editing, and viewing records in a 1-2-3 database table. A
form is an Approach view that lets you look at one record at a time. Forms are especially useful for data entry and 
editing records.
1. Move the cell pointer to a cell in the 1-2-3 database table you want to use.
2. From the Create menu, choose Database, and then choose Form.

3. Check that the database table range is correct. If not, enter a different range in the box, or use the range selector 
to specify a range. Be sure to include the field names (column headings).

4. Click OK.
5. (Optional) Use the mouse with the scroll bars or sheet tabs to navigate to a location where you want to put the 

form. The form is an object on top of the sheet so it will not write over your data.
Note If you use the keyboard to navigate, you will end the process without creating a form.

6. Click in the sheet where you want to display the form.
7. When 1-2-3 opens the Approach Form Assistant, use it to specify the form layout and the fields you want in the 

form. 
Tip For more information, click Help in the Form Assistant.

8. Click Done.
1-2-3 creates and activates the form in the sheet. When the form is active, the main menu and status bar contain 
Approach commands and icons, giving you access to Approach and the Approach Help system. 

For more information about working with forms in 1-2-3, see Working with a database form.      

{button ,AL(`H_DB_CREATING_FORMS_DETAILS',1)} See details
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_WORKING_WITH_123_AND_APPROA

CH_OVER;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CR
EATING_QUERY_TABLE_STEPS',0)} See related topics



Details: Creating a database form
When you create a form, 1-2-3 loads a portion of Approach into memory.

Tips
• If you create a form on a sheet other than the one that contains your database table, someone can enter data in 

the form without seeing the database table.
• You can hide the sheet containing the database table to protect it from someone who only needs to use the form.

Getting Help about forms
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a form or when the form 
is active, Approach Help topics appear. Approach Help contains more information about working with forms. 

• If you want to get Help about 1-2-3, click in the sheet outside the form, then choose Help - Help Topics or press 
F1. 

{button ,AL(`H_DB_CREATING_FORMS_STEPS',1)} Go to procedure
{button ,AL(`H_HIDING_SHEETS_STEPS;H_CREATING_A_SHEET_STEPS',0)} See related topics



Working with a database form
A form is an Approach view of a database table that lets you view one record at a time. You can work with a form 
when it is active or inactive, depending on the task you want to perform.

Working with an active form
To activate the form, do one of the following:

• Double-click the form. 
• Click the form to select it, and then choose Form - Edit. 

When the form is active, it has a dashed border, Approach commands and buttons appear on the main menu and 
status bar, and you have access to the Approach Help system.    When the form is active, you can: 

• Enter and edit data in the form, which automatically updates data in the 1-2-3 database table.
• Add new records to the 1-2-3 database table.

Caution 1-2-3 allows up to 512 characters in a field. Approach allows up to 256 characters in a field. If you edit 
data longer than 256 characters using a form, that data will be truncated in your 1-2-3 database table when you 
refresh data in the form.

• Use the Browse commands to find, sort, add, duplicate, hide, and delete records or to navigate through records 
one at a time.

• Size the form by dragging any of the handles on the frame.
• Choose Edit - Open Into Full Window to open the form in an Approach window. When the form is displayed in an 

Approach window, you can use all of the Approach features. For example, you can use Design mode to change 
the way the form looks.

• Choose Help - Help Topics to get additional information on working with active forms in Approach.

Working with an inactive form
To deactivate a form, click in the sheet outside the form.
To select an inactive form, click it.
When a form is inactive and selected, handles appear on its solid frame and 1-2-3 commands appear on the main 
menu and status bar. The Form command lets you work with forms. When the form is inactive and selected, you can:

• Use Form - Object Properties to change the properties of the form. 
• Move the form by dragging it.
• Size the form by dragging any of the handles on the frame.
• Delete the form by pressing DEL.
• Right-click to use the shortcut menu for forms.
• Print the form alone or with other data in the workbook. To print the form, choose File - Print.

Getting Help about forms
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a form or when the form 
is active, Approach Help topics appear. Approach Help contains more information about working with forms. 

• If you want to get Help about 1-2-3, click in the sheet outside the form, then choose Help - Help Topics or press 
F1. 

{button ,AL(`H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CRE
ATING_FORMS_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER',0)} See related topics



Dynamic Crosstab dialog box
Use the Dynamic Crosstab dialog box to connect with Lotus Approach and create a dynamic crosstab from data in a 
1-2-3 database table. 
In a a dynamic crosstab, you can group records by the fields you select. Use a crosstab to summarize and analyze 
data in a 1-2-3 database table. 

Choose a topic
Creating a dynamic crosstab 

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_CREATING_A_DYNAMIC_CROSSTAB_
EX',0)} See related topics



Creating a dynamic crosstab
1-2-3 works with Lotus Approach to create a dynamic crosstab from data in a 1-2-3 database table. Crosstabs let you 
see relationships between different types of data, look for trends, and compile data from a large database into a form 
you can chart.
1. Move the cell pointer to a cell in the 1-2-3 database table you want to use.
2. From the Create menu, choose Database, and then choose Dynamic Crosstab.

3. Check that the database table range is correct. If not, enter a different range in the box, or use the range selector 
to specify a range.

4. Click OK.
5. (Optional) Use the mouse with the scroll bars or sheet tabs to navigate to a location where you want to put the 

dynamic crosstab. The crosstab is an object on top of the sheet, so it will not write over your data.
Note If you use the keyboard to navigate, you will end the process without creating a crosstab. 

6. Click in the sheet where you want to display the dynamic crosstab.
7. When 1-2-3 opens the Crosstab Assistant, use it to set up a crosstab. 

Tip For more information, click Help in the Crosstab Assistant.
8. Click Done.

1-2-3 creates and activates the crosstab in the sheet. When the crosstab is active, the main menu and status bar 
contain Approach commands and icons, giving you access to Approach and the Approach Help system. 

For more information about working with crosstabs in 1-2-3, see Working with a dynamic crosstab.        

{button ,AL(`H_DB_CREATING_A_DYNAMIC_CROSSTAB_DETAILS',1)} See details
{button ,AL(`H_DB_CREATING_A_DYNAMIC_CROSSTAB_EX',1)} See example
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_WORKING_WITH_123_AND_APPROA

CH_OVER;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CR
EATING_QUERY_TABLE_STEPS',0)} See related topics



Details: Creating a dynamic crosstab
Getting Help about crosstabs
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a crosstab or when the 
crosstab is active, Approach Help topics appear. Approach Help contains more information about working with 
crosstabs. 

• If you want to get Help about 1-2-3, click in the sheet outside the crosstab, then choose Help - Help Topics or 
press F1. 

{button ,AL(`H_DB_CREATING_A_DYNAMIC_CROSSTAB_STEPS',1)} Go to procedure



Working with a dynamic crosstab
You can work with a dynamic crosstab when it is active or inactive, depending on the task you want to perform.

Working with an active crosstab
To activate a crosstab, do one of the following:

• Double-click the crosstab.
• Click the crosstab to select it, and then choose Crosstab - Edit. 

When a crosstab is active, it has a dashed border, Approach commands appear on the main menu and status bar, 
and you have access to the Approach Help system. When the crosstab is active, you can: 

• Choose Edit or Browse commands to work with the crosstab
• Choose Help - Help Topics to get additional information on working with active crosstabs in Approach.
• Size the crosstab by dragging any of the handles on the frame.
• Rearrange the fields by dragging the column or row headers from one place to another.
• Group data by dragging a field name in the column or row header area.
• Summarize data in a field by dragging the field into the data area.

You can also choose Edit - Open Into Full Window to open the crosstab in an Approach window. When the crosstab is
displayed in an Approach window, you can use all of the Approach features. For example, you can use Design mode 
to change the way the crosstab looks.

Working with an inactive crosstab
To deactivate a crosstab, click in the sheet outside the crosstab.
To select the inactive crosstab, click it. 
When a crosstab is inactive and selected, handles appear on its solid frame and 1-2-3 commands appear on the 
main menu and status bar. The Crosstab command lets you work with crosstabs. When the crosstab is inactive and 
selected, you can: 

• Use the Crosstab menu to change the properties of the crosstab or refresh the data.
• Refresh the data in the crosstab to reflect any changes to the source database table.
• Move the crosstab by dragging it.
• Size the crosstab by dragging any of the handles on the frame.
• Delete the crosstab by pressing DEL.
• Right-click to use the shortcut menu for crosstabs.
• Print it alone or with other data in the workbook. To print a crosstab, choose File - Print.

Copying crosstab data to cells in a sheet
If you want to use the data in a crosstab in formulas, charts, or maps, you need to copy the crosstab data to cells in a 
sheet.
To copy the data from a crosstab, activate the crosstab, click the gray cell in the upper-left corner of the crosstab to 
select all the data and headings, then choose Edit - Copy. 
To paste the data in a sheet, click the cell where you want the upper-left corner of the data to appear, then choose 
Edit - Paste.

Getting Help about crosstabs
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a crosstab or when the 
crosstab is active, Approach Help topics appear. Approach Help contains more information about working with 
crosstabs. 

• If you want to get Help about 1-2-3, click in the sheet outside the crosstabs, then choose Help - Help Topics or 
press F1. 

{button ,AL(`H_DB_CREATING_A_DYNAMIC_CROSSTAB_EX',1)} See example
{button ,AL(`H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CRE

ATING_A_DYNAMIC_CROSSTAB_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER;H_123_RE
FRESHING_A_DYNAMIC_CROSSTAB_STEPS',0)} See related topics





Example: Creating a dynamic crosstab
A crosstab is a good tool for categorizing and summarizing database records when the data includes at least three 
variables. 
For example, the sheet below contains fields for the names of (1) each sales representative, (2) each product, and (3)
the number of cases sold. The names and products are listed more than once so you can use a crosstab to total the 
data for either one.

The following crosstab shows the total cases sold by product for each sales representative.

{button ,AL(`H_DB_CREATING_A_DYNAMIC_CROSSTAB_STEPS;H_DB_WORKING_WITH_A_DYNAMIC_CROS
STAB_STEPS',0)} See related topics



Refreshing a dynamic crosstab
You can refresh the data in the crosstab whenever data in the source database table changes. 
1. Click the crosstab to select it.
2. From the Crosstab menu, choose Refresh.

1-2-3 recalculates the data in the crosstab to reflect the current data in the source database table.

{button ,AL(`H_DB_WORKING_WITH_A_DYNAMIC_CROSSTAB_STEPS;H_DB_CREATING_A_DYNAMIC_CROS
STAB_STEPS;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_123
_WORKING_WITH_123_AND_APPROACH_OVER;H_DB_WORKING_WITH_DATABASE_TABLES_OVER',0)} 
See related topics



Create Report dialog box
Use the Create Report dialog box to connect with Lotus Approach and create a report using data from a 1-2-3 
database table.
You can use a report to organize, analyze, and present data from many records in a 1-2-3 database table in different 
formats.

Choose a topic
Creating a database report

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_CREATING_A_REPORT_EX',0)} See 
related topics



Creating a database report
1-2-3 works with Lotus Approach to create a report about records in a 1-2-3 database table. Use a report to organize, 
analyze, and present    the data in the database table.    
1. Move the cell pointer to a cell in the 1-2-3 database table you want to use.
2. From the Create menu, choose Database, and then choose Report.

3. Check that the database table range is correct. If not, enter a different range in the box, or use the range selector 
to specify a range.

4. Click OK.
5. (Optional) Use the mouse with the scroll bars or sheet tabs to navigate to a location where you want to put the 

report. The report is an object on top of the sheet, so it will not write over your data.
Note If you use the keyboard to navigate, you will end the process without creating a report.

6. Click in the sheet where you want to display the icon for the report.
7. When 1-2-3 opens the Approach Report Assistant, use it to set up the report. 

Tip For more information, click Help in the Report Assistant.
8. Click Done. 

1-2-3 creates and activates the report.
Note When the report is active, it appears in an Approach window, giving you access to the Approach commands 
and Approach Help system. To return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3. When the report is inactive,
it appears as an icon in the sheet.
For more information about reports in 1-2-3, see Working with a database report. 

{button ,AL(`H_DB_CREATING_A_REPORT_DETAILS',1)} See details
{button ,AL(`H_DB_CREATING_A_REPORT_EX',1)} See example
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_WORKING_WITH_123_AND_APPROA

CH_OVER;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER',0)} See 
related topics



Details: Creating a database report
Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the report are automatically saved. 1-2-3 displays the report as 
an icon in the sheet.

Getting Help about reports
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a report or when the 
report is active, Approach Help topics appear. Approach Help contains more information about working with 
reports. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

{button ,AL(`H_DB_CREATING_A_REPORT_STEPS',1)} Go to procedure



Working with a database report
To work with a report, it must be active. Double-click the report icon in the sheet to activate the report and open Lotus 
Approach.

Working with a report in Approach
In the Design view in Approach, you can:

• Customize the report. 
• Use File - Print Preview to see the report.
• Use File - Print to print the report.

Getting Help about reports
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a report or when the 
report is active, Approach Help topics appear. Approach Help contains more information about working with 
reports. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the report are automatically saved. 1-2-3 displays the report as 
an icon in the sheet.

{button ,AL(`H_DB_CREATING_A_REPORT_EX',1)} See example
{button ,AL(`H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CRE

ATING_A_REPORT_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER',0)} See related topics



Example: Creating a database report    
You can create different kinds of reports to organize, analyze, and present data from many records in a 1-2-3 
database table. 
For example, the sheet below contains fields that include the names of sales representatives, products, and the 
number of cases sold.

The following report shows individual sales by product.

The following summary report shows the total number of cases sold by product.



{button ,AL(`H_DB_CREATING_A_REPORT_STEPS;H_DB_WORKING_WITH_A_REPORT_STEPS;',0)} See 
related topics



Create Mailing Labels dialog box
Use the Create Mailing Labels dialog box to connect with Lotus Approach and create mailing labels from data in a 1-
2-3 database table.
You can create mailing labels in several formats and print the mailing labels on standard or custom mailing label 
forms. 

Choose a topic
Creating mailing labels 

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;',0)} See related topics



Creating mailing labels
1-2-3 works with Lotus Approach to create mailing labels using data in a 1-2-3 database table.
1. Move the cell pointer to a cell in the 1-2-3 database table you want to use.
2. From the Create menu, choose Database, and then choose Mailing Labels.

3. Check that the database table range is correct. If not, enter a different range in the box, or use the range selector 
to specify a range.

4. Click OK.
5. (Optional) Use the mouse with the scroll bars or sheet tabs to navigate to a location where you want to put the 

mailing labels. The mailing labels are an object on top of the sheet so they will not write over your data.
Note If you use the keyboard to navigate, you will end the process without creating mailing labels.

6. Click in the sheet where you want to display the icon for the mailing labels.
7. When 1-2-3 opens the Approach Mailing Label Assistant, use it to set up mailing labels. 

Tip For more information, click Help in the Mailing Label Assistant.
8. Click Done.

1-2-3 creates and activates the mailing labels.
Note When the mailing labels are active, they appear in an Approach window, giving you access to the Approach 
commands and Approach Help system. 
For more information about mailing labels in 1-2-3, see Working with mailing labels. 

{button ,AL(`H_DB_CREATING_MAILING_LABELS_DETAILS',1)} See details
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_WORKING_WITH_123_AND_APPROA

CH_OVER;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER',0)} See 
related topics



Details: Creating mailing labels
Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the mailing labels are automatically saved. 1-2-3 displays the 
mailing labels as an icon in the sheet.

Getting Help about mailing labels
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating mailing labels or when 
the mailing labels are active, Approach Help topics appear. Approach Help contains more information about 
working with mailing labels. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

{button ,AL(`H_DB_CREATING_MAILING_LABELS_STEPS',1)} Go to procedure



Working with mailing labels
To work with mailing labels, they must be active. Double-click the mailing label icon to activate the mailing labels and 
open Approach.

Working with mailing labels
In Approach, you can:

• Use the Browse view to enter, edit, review, and sort mailing labels.
• Use the Design view to customize mailing labels.
• Use File - Print to print mailing labels.

Getting Help about mailing labels
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating mailing labels or when 
the mailing labels are active, Approach Help topics appear. Approach Help contains more information about 
working with mailing labels. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the mailing labels are automatically saved. 1-2-3 displays the 
mailing labels as an icon in the sheet.

{button ,AL(`H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CRE
ATING_MAILING_LABELS_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER',0)} See related 
topics



Create Form Letter dialog box 
Use the Create Form Letter dialog box to connect with Lotus Approach and create a form letter using data in a 1-2-3 
database table.
A form letter combines text you type with names and addresses from 1-2-3 database records. Use a form letter to 
send copies of the same letter to many different people. 

Choose a topic
Creating a form letter 

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;',0)} See related topics



Creating a form letter
1-2-3 works with Lotus Approach to create a form letter that combines text in a letter with names and addresses from 
a 1-2-3 database table.
1. Move the cell pointer to a cell in the 1-2-3 database table you want to use.
2. From the Create menu, choose Database, and then choose Form Letter.

3. Check that the database table range is correct. If not, enter a different range in the box, or use the range selector 
to specify a range.

4. Click OK.
5. (Optional) Use the mouse with the scroll bars or sheet tabs to navigate to a location where you want to put the 

form letter. The form letter is an object on top of the sheet so it will not write over your data.
Note If you use the keyboard to navigate, you will end the process without creating a form letter.

6. Click in the sheet where you want to display the icon for the form letter.
7. When 1-2-3 opens the Approach Form Letter Assistant, use it to set up the form letter. 

Tip For more information, click Help in the Form Letter Assistant.
8. Click Done.

1-2-3 creates and activates the form letter.
Note When the form letter is active, it appears in an Approach window, giving you access to the Approach commands
and Approach Help system. 
For more information about form letters in 1-2-3, see Working with a form letter. 

{button ,AL(`H_DB_CREATING_A_FORM_LETTER_DETAILS',1)} See details
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_WORKING_WITH_123_AND_APPROA

CH_OVER;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER',0)} See 
related topics



Details: Creating a form letter
Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the form letter are automatically saved. 1-2-3 displays the form 
letter as an icon in the sheet.

Getting Help about form letters
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a form letter or when the 
form letter is active, Approach Help topics appear. Approach Help contains more information about working with 
form letters. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

{button ,AL(`H_DB_CREATING_A_FORM_LETTER_STEPS',1)} Go to procedure



Working with a form letter
To work with a form letter, it must be active. Double-click the form letter icon to activate the form letter and open 
Approach.

Working with a form letter
In Approach you can:

• Use the Design view to enter and edit the text and to customize the form letter.
• Use the Browse view to display the letters one at a time.
• Choose File - Print to print the letters.

Getting Help about form letters
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a form letter or when the 
form letter is active, Approach Help topics appear. Approach Help contains more information about working with 
form letters. 

• If you want to get Help about 1-2-3, switch to the 1-2-3 window or choose File - Exit & Return to Lotus 1-2-3, then 
choose Help - Help Topics or press F1.

Returning to 1-2-3
To exit Approach and return to 1-2-3, choose File - Exit & Return to Lotus 1-2-3.
When you close Approach, any changes you made to the form letter are automatically saved. 1-2-3 displays the form 
letter as an icon in the sheet.

{button ,AL(`H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_APPROACH_OBJECT_OVER;H_DB_CRE
ATING_A_FORM_LETTER_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER',0)} See related 
topics



Working with 1-2-3 data in an embedded Approach object
Query tables, forms, crosstabs, reports, form letters, and mailing labels are all Lotus Approach objects embedded in a
1-2-3 workbook. You can use these objects to work with copies of records from a 1-2-3 database table in different 
ways. These objects are linked to data in the database table so that edits to data in one are reflected in the other.

Activating and deactivating the objects
All Approach objects can be activated by double-clicking them. However, depending on the type of Approach object, 
they appear differently in the sheet.

• Query tables, forms, and crosstabs display data in the sheet when they are inactive. When you activate these 
objects, Approach commands appear in the 1-2-3 window. To deactivate the object, you click in the sheet.

• Reports, form letters, and mailing labels appear as icons in the sheet when they are inactive. When you activate 
these objects, they appear in a full Approach window. To deactivate the object, you choose the File - Exit & Return
to Lotus 1-2-3 command.

Editing data using an embedded Approach object 
When you edit data in any embedded Approach object, you are also editing the data in your 1-2-3 database table. 
However, you cannot edit protected cells in 1-2-3, and you cannot change the data type in a field from within the 
embedded object.
Edits you make to data directly in a 1-2-3 database table are displayed in the embedded object when you activate it 
or refresh it. 

Cautions
• Do not edit data in the embedded object that is the result of a formula in 1-2-3 because this will convert the 

formula to a value in the 1-2-3 database table. Edit formulas directly in the 1-2-3 database table.
• 1-2-3 allows up to 512 characters in a field. Approach allows up to 256 characters in a field. If you edit data longer

than 256 characters using an embedded Approach object, that data will be truncated in your 1-2-3 database table 
when you refresh the object.

Adding data to a 1-2-3 database table linked to an embedded object
When you create an embedded Approach object, 1-2-3 assigns a range name to the 1-2-3 database table range you 
selected, if you did not already give the range a name. 

Adding records (rows)
If you use an embedded Approach object, such as a query table or form, to add a record to a 1-2-3 database table, 1-
2-3 automatically expands the named range to include the new record. 
However, if you add records directly in the 1-2-3 database table, you must also expand the size of the named range 
in 1-2-3 to include the new records when the embedded object is not active. Otherwise, the new records may not 
appear in the embedded object.

Adding fields (columns)
You cannot add a field to a 1-2-3 database table or change the data type of a field using an embedded Approach 
object.
If you add a field to the 1-2-3 database table or if you change the data type in a field (for example, from values to 
text), you should recreate the embedded object. Otherwise, the new field may not appear in the embedded object.

{button ,AL(`H_NAMING_A_RANGE_STEPS;H_DB_ADDING_DATABASE_RECORDS_STEPS;H_DB_ADDING_A_
FIELD_IN_A_QUERY_TABLE_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_OVER',0)} See related
topics



Overview: Working with databases
A database is a collection of data organized into tables which consists of fields and records. Each record in a 
database contains the same kind of information. 
For example,

• A city telephone book is a database that contains a record for each person with their name, address, and phone 
number.

• Teachers keep a record for each student that includes the student's name, test scores, and final grades.
• A business database might include records of clients' names, addresses, phone numbers, and information about 

sales and purchases.
• A store inventory database might include the names for each product, stock numbers, prices, manufacturers, and 

so on.

About 1-2-3 database tables

 Show me a QuickDemo
A 1-2-3 database table is a range of data organized in columns and rows. Each column is one field and each row is 
one record. The top row must contain field names -- labels that identify the records entered in each column.

Once you set up a 1-2-3 database table with field names and records, you can quickly access and manipulate large 
amounts of data to get exactly the information you need by using a query table to find, sort, add, and delete records. 

About external database tables
An external database table is a group of related records stored in a file other than a 1-2-3 workbook file. An external 
file can be on a personal computer, a network server, a mainframe, or a CD-ROM.
When you create a query table containing records from an external database table, you can find, sort, analyze, add, 
and delete records from the external database table while working in your 1-2-3 workbook. 

What can you do with a database in 1-2-3?
1-2-3 offers two ways to help you manage and analyze data contained in 1-2-3 or external database tables: 

• The Create - Database commands give you access to the many powerful database features of Lotus Approach. 
1-2-3 and Approach are installed together when you install 1-2-3. Using the Create - Database commands, you 
can access Approach to create query tables, data entry forms, reports, mailing labels, form letters, and dynamic 
crosstabs.    
For more information about using the Create - Database commands, see Overview: Working with 1-2-3 and 
Approach.    

• The Data Query Add-In (DQA) is included in this release of 1-2-3 to give you data query functionality that is 
similar to that in 1-2-3 Release 5. When you load DQA, you can work with query tables created in 1-2-3 Release 
5 or the Query Table Add-In from 1-2-3 97. You can also create new query tables and crosstabs.    
For more information about using DQA, see Overview: Data Query Add-In (DQA). 

{button ,AL(`H_DB_CREATING_A_123_DATABASE_TABLE_STEPS;H_DB_QUERY_TABLES_OVER;H_DB_CREA
TING_QUERY_TABLE_STEPS;H_DB_JOINING_DATABASE_TABLES_STEPS',0)} See related topics





Creating a 1-2-3 database table
A 1-2-3 database table is a range containing data organized by columns (fields) and rows (records). Each row 
contains one record and each column contains one kind of information.

Want the big picture? See Overview: Working with databases. 
1. Enter labels (field names) in adjacent cells across an empty row. 

For field name guidelines, see Details.
2. In the first row under each field name, enter information for the first record. 
3. In the next row, enter another record. 
4. Repeat step 3 for each record you want to enter in the database table.

You do not need to enter records in any particular order because you can sort the records later.
5. (Optional) Name the range that contains the 1-2-3 database table. Make sure the range includes the first row of 

field names.
For more information, see Naming a range. 

{button ,AL(`H_DB_CREATING_A_123_DATABASE_TABLE_DETAILS',1)} See details
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_JOINING_DATABASE_TABLES_STEPS'

,0)} See related topics



Details: Creating a 1-2-3 database table
A 1-2-3 database table must fit on a single sheet and can contain up to 256 fields and 65,535 records.

Guidelines for entering field names
• Use a label for each field name, rather than a number or formula. 
• To enter a field name that begins with a number or other non-alphabetic character, enter a label-prefix character 

first. For example, enter '1998_Salary as a field name.
• Don't use field names that look like cell addresses, such as P12, X24, or EX100. 
• Don't use the same field name twice in the same table. Field names must be unique.
• Don't use any of the following characters in a field name:

, (comma)
. (period)
: (colon)
; (semicolon)
- (hyphen)
# (number sign)
~ (tilde)
! (exclamation point)
spaces
arithmetic operators such as + (plus sign)

Guidelines for entering records
• Don't use a repeating character, such as a hyphen, to separate the row containing field names from the data.
• You can enter text, numbers, @functions, or formulas in each field.
• @Functions and formulas should contain absolute references or range names, rather than relative references. 
• Use consistent formatting and capitalization in each field. 
• If you want to sort and query the table by dates, make sure the dates are entered in a date format.    
• You get more reliable results when you query a database table if all entries in the same field (column) contain the 

same type of data -- for example, all labels rather than a mix of labels and values.

Adding records and fields
You can add records by entering data in rows in the database. You can add fields by entering data in additional 
columns. 

Naming a database table
Assigning a range name to a database table makes it easier to specify the entire table when you want to query it or 
use it with database @functions.
Follow these rules when assigning a range name to a database table:

• The row containing the field names must be the first row of the named range.
• To avoid confusion, don't use a range name that matches any field names in the same table or any other table 

you want to query.
• If you add records or fields to a 1-2-3 database table, you must expand the named range to include the new data.

Formatting a database table
Once you enter information in a database table, you can use the InfoBox to change text attributes, number formats, 
and alignment of the data.

{button ,AL(`H_DB_CREATING_A_123_DATABASE_TABLE_STEPS',1)} Go to procedure



Overview: Working with 1-2-3 and Approach
1-2-3 works with Lotus Approach to help you manage and analyze data contained in a 1-2-3 database table or an 
external database table. 1-2-3 and Approach are installed together when you install 1-2-3.
Using the Create - Database commands in 1-2-3, you can access Approach to create the following Approach views:

• Query tables -- To add, edit, sort, and find records in either a 1-2-3 or an external database table. 

• Forms --    To view every record in a 1-2-3 database table, one record at a time. You can use a form to add and 
edit records.

• Reports -- To organize, analyze, and present data from many records in a 1-2-3 database table. 

• Dynamic crosstabs -- To organize and summarize categories of data from many records in a 1-2-3 database 
table. 

• Mailing labels -- To display information in a 1-2-3 database table in a mailing address format. You can then print 
the addresses on standard or custom mailing labels.

• Form letters -- To combine text in a letter with names and addresses from 1-2-3 database records, so you can 
send copies of the same letter to many different people.

You can also join related database tables to work with more than one database table at a time.

How 1-2-3 and Approach work together
When you use the Create - Database commands to create a query table, form, report, crosstab, form letter, or set of 
mailing labels, 1-2-3 loads a portion of the Approach program into memory and creates the query table or other 
Approach view as an embedded Approach object in the 1-2-3 sheet. 
The embedded object is part of the 1-2-3 workbook file. You can work with the embedded Approach object, such as a 



query table, in three ways:
• As an embedded Approach object, a query table is like other objects in 1-2-3. When you select the query table, 

you can move it, change its properties, copy it, or delete it.
• You can also "activate" an embedded object by double-clicking it. When a query table is active, you see a 

different menu that lets you use 1-2-3 and Lotus Approach together to edit, sort, and query database records.
• Finally, you can open the embedded object in a full Approach window to use all of the powerful features in 

Approach. For example, you can use Approach's Design mode to change the way a form or report looks. 

Another way to work with a database table
1-2-3 offers another way to work with query tables and crosstabs: the Data Query Add-In (DQA), which is similar to 
the query table features in 1-2-3 Release 5. For more information, see Overview: Data Query Add-In (DQA). 

{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_CREATING_A_DYNAMIC_CROSSTAB_
STEPS;H_DB_CREATING_A_FORM_LETTER_STEPS;H_DB_CREATING_A_REPORT_STEPS;H_DB_CREATI
NG_FORMS_STEPS;H_DB_CREATING_MAILING_LABELS_STEPS;H_DB_CREATING_QUERY_TABLE_STEP
S;H_DB_QUERY_TABLES_OVER',0)} See related topics



Overview: Query tables
You create a query table in 1-2-3 to find, sort, and edit the information stored in a 1-2-3 database table or an external 
database table. The query table contains a copy of all the database records from the table you specified. You can use
a query table to:

• Find specific records.
• Bring data from an external database table into 1-2-3.
• Make changes to the source records.

When you create a query table, 1-2-3 loads a portion of Lotus Approach into memory. The query table is an Approach
view of the contents of the database table you queried. It appears as an Approach object embedded in the 1-2-3 
sheet. 

Caution In this release of 1-2-3, the query table writes over existing data in the cells in which you place it. To avoid 
losing data, create a new sheet to hold the query table.

Query tables and database tables are linked
A query table is linked to the database table you queried. Any changes you make to the data in the query table in Edit
mode are automatically made to the source database table. 
Similarly, if records in the source database table change, you can refresh the query table to reflect the current data. 

Query tables can appear in two modes
Initially, the query table is active, or in Edit mode. When you click in the sheet outside the query table, the query table 
switches to Output mode, or becomes inactive. In this release of 1-2-3, when the query table is in Output mode, you 
see the data in the output range. 

Working with a query table in Edit mode
When the query table is in Edit mode, you can perform the following tasks:

• Find and sort records.
• Edit, add, or delete records in the source database table.
• Change the fields that appear in the query table.

Working with a query table in Output mode
When the query table is in Output mode, you can perform the following tasks:

• View the data more easily.
• Style and print the data.
• Use the data in calculations, charts, and maps. 
• Change the query table properties.



For more information, see Working with a query table. 

Getting Help on query tables
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a query table or when the
query table is active, Approach Help topics appear. Approach Help contains more information about working with 
query tables, which are called worksheets in Approach. 

• If you want to get Help about 1-2-3, click in the sheet outside the query table, then choose Help - Help Topics or 
press F1. 

Another way to work with database tables
1-2-3 also offers the Data Query Add-In (DQA), which gives you data query functionality similar to that in 1-2-3 
Release 5. With DQA, you can create query tables and crosstabs, and connect to external database tables. If your 
database needs are simple, your computer doesn't have a large amount of memory or disk space, or you need to 
work with query tables created in 1-2-3 Release 5, you may find that DQA is a useful alternative to the Create - 
Database - Query Table command. For more information, see Overview: Data Query Add-In (DQA). 

{button ,AL(`H_123_CREATING_A_QUERY_TABLE_EX',1)} See example
{button ,AL(`H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_CREATING_QUERY_TABLE_STEPS;H_

DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_WORKING_WITH_123_DATA_IN_AN_EMBEDDED_A
PPROACH_OBJECT_OVER;H_DB_QUERY_DATABASE_RECORDS_STEPS;H_DB_SORTING_DATABASE_R
ECORDS_STEPS;H_DB_ADDING_DATABASE_RECORDS_STEPS;H_DB_DELETING_DATABASE_RECORDS
_STEPS;H_DB_EDITING_DATABASE_RECORDS_STEPS;H_123_WORKING_WITH_123_AND_APPROACH_
OVER;H_DB_QUERY_OUTPUT_TO_RANGE_STEPS',0)} See related topics



Query Table Assistant
Use the Query Table Assistant to create a query table. A query table contains a copy of    the records from a source 
database table either in 1-2-3 or in an external file, and is linked to the source database.
After you create the query table, you can use the Browse commands or the Find Assistant to find and display a 
selected set of records by specifying criteria (conditions) for a query. You can also sort the records in the query table. 
Changes you make to the query table, such as adding, editing, or deleting records, are made in the source database 
table as well.

Choose a task
Creating a query table 

{button ,AL(`H_DB_QUERY_TABLES_OVER',0)} See related topics



Creating a query table
1-2-3 works with Lotus Approach to create a query table in 1-2-3. After you create the query table, you can find 
specific records by using the Browse commands to set the criteria (conditions) for a query. 
Want the big picture? Overview: Query tables. 
To create a query table from a 1-2-3 database table, follow the instructions below. To work with an external database 
table, see Creating a query table from an external database. 
Caution To avoid writing over data, place the query table in a blank sheet. Create the new sheet before you begin.
1. From the Create menu, choose Database, and then choose Query Table.

2. In the Query Table Assistant, select "1-2-3 range." 
3. Enter the range or use the range selector to specify the database table that you want to use as the data source.
4. Enter the range or use the range selector to specify the location for the query table. 

Tip For tips on specifying the location, see Details.
5. Click OK.
6. When the Worksheet Assistant appears, select the fields you want to work with in the query table.

Tip For more information, click Help in the Worksheet Assistant.
7. Click Done.

The query table appears in Edit mode and initially includes all the records from the source database table, 
although you may need to switch to Output mode to view them easily.

8. (Optional) To set criteria to limit the query table to specific records, choose Browse - Find while in Edit mode.
For more information, see Finding specific records in a query table. 

9. To view the data in cells in the sheet, click in the sheet outside the query table to switch to Output mode.

{button ,AL(`H_DB_CREATING_QUERY_TABLE_DETAILS',1)} See details
{button ,AL(`H_123_CREATING_A_QUERY_TABLE_EX',1)} See example
{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_QUERY_

DATABASE_RECORDS_STEPS;H_123_CREATING_A_QUERY_TABLE_FROM_AN_EXTERNAL_DATABASE_S
TEPS',0)} See related topics



Details: Creating a query table
Specifying a 1-2-3 range as the source of the input data
If a single cell in a 1-2-3 database table was selected when you chose Create - Database - Query Table, the Query 
Table Assistant automatically selects the entire table and displays the range name, if you assigned one to the 
database table.
If the 1-2-3 range displayed in the range box is not correct, enter a different range or use the range selector to specify
a range. 
Note If the database table does not already have a range name, 1-2-3 assigns a range name to it when you create a 
query table.

Selecting the location for the new query table
The query table title bar may appear on the bottom of the query table if there is not enough room to display it on top.
To avoid writing over data, place the query table in a blank area of the sheet or in a new sheet you created previously.
To specify the range where you want to display the query table, you can:

• Select a single cell - 1-2-3 uses this as the top left corner of the range and enters all the data in the sheet. 
• Select a range - 1-2-3 enter only the data that fits in this range. If all the data does not fit in the selected range, 

the bottom (if more rows available) or right border (if more columns available) of the query table displays as a 
dashed border. 

You can drag the border to display more of the data.
• Click a sheet tab to put the query table on another sheet.

Note A query table range cannot span more than one sheet. You cannot specify a range in another file as the sheet 
location. Also, if the data retrieved is more than 65,536 rows or 256 columns, 1-2-3 retrieves only 65,536 rows and 
256 columns of data. 

Working with Edit mode and Output mode
When the query table is in Edit mode, Approach commands and buttons appear in the main menu and status bar. The
Browse commands let you find, sort, and edit data. 
In this release of 1-2-3, when you click in the sheet outside the query table, the query table switches to Output mode. 
When the query table is in Output mode, you see the data in the output range. For more information, see Working 
with a query table.
Tip Instead of resizing the query table when it is in Edit mode to view all the data, use Output mode to view the data 
in cells in the sheet. If you resize the query table when it is in Edit mode, 1-2-3 limits the size of the query table when 
it is in Output mode to a fixed range, so that you may not be able to see all the data. If the fixed size prohibits the 
display of records or fields, the query table border appears as a dashed line. To display all the fields and records, 
select the query table in Output mode, choose Query Table - Output Range, then select Variable.

Getting Help about query tables
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a query table or when the
query table is active, Approach Help topics appear. Approach Help contains more information about working with 
query tables, which are called worksheets in Approach. 

• If you want to get Help about 1-2-3, click in the sheet outside the query table, then choose Help - Help Topics or 
press F1. 

{button ,AL(`H_DB_CREATING_QUERY_TABLE_STEPS',1)} Go to procedure



Creating a query table from an external database
1-2-3 works with Lotus Approach to create a query table in 1-2-3. After you create the query table, you can find 
specific records by using the Browse commands to set the criteria (conditions) for a query. 
Want the big picture? Overview: Query tables. 
To create a query table from an external database table, follow the instructions below. To work with a 1-2-3 database 
table, see Creating a query table.    
Caution To avoid writing over data, place the query table in a blank sheet. Create the new sheet before you begin.
1. From the Create menu, choose Database, and then choose Query Table.

2. In the Query Table Assistant, select "External table." 
3. Enter the range or use the range selector to specify the location for the query table. 

Tip For tips on specifying the location, see Details. 
4. Click OK.
5. In the Open dialog box, select the file containing the source database table.
6. Click OK. 

Depending on the type of database you need to access, you may be prompted to enter a password to log into a 
database server.

7. When the Worksheet Assistant appears, select the fields you want to work with in the query table.
Tip For more information, click Help in the Worksheet Assistant.

8. Click Done.
The query table appears in Edit mode and initially includes all the records from the source database table, 
although you may need to switch to Output mode to view them easily.

9. (Optional) To set criteria to limit the query table to specific records, choose Browse - Find while in Edit mode.
For more information, see Finding specific records in a query table. 

10. To view the data in cells in the sheet, click in the sheet outside the query table to switch to Output mode.

{button ,AL(`H_123_CREATING_A_QUERY_TABLE_FROM_AN_EXTERNAL_DATABASE_DETAILS',1)} See details
{button ,AL(`H_123_CREATING_A_QUERY_TABLE_EX',1)} See example
{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_QUERY_

DATABASE_RECORDS_STEPS;;H_123_WORKING_WITH_123_AND_APPROACH_OVER;H_DB_CREATING_
QUERY_TABLE_STEPS;H_123_ODBC_DRIVERS_OVER',0)} See related topics



Details: Creating a query table from an external database
Specifying an external table for the input data
If you choose an external database table for the input data, you will be prompted to specify the file containing the 
database table. In the process of choosing an external database table, you may also need to log in to a database 
server.
See your database administrator for additional information about logging in to your database servers, or see 
Overview: ODBC drivers. 

Working with ODBC drivers
1-2-3 uses ODBC drivers to connect to external database tables. ODBC drivers allow 1-2-3 to read data from and 
send data to an external database.
You need to install and configure ODBC drivers for each database type you want to open. For more information, see 
Overview: ODBC drivers. 

Selecting the location for the new query table
The query table title bar may appear on the bottom of the query table if there is not enough room to display it on top.
To avoid writing over data, place the query table in a blank area of the sheet or in a new sheet you created previously.
To specify the range where you want to display the query table, you can:

• Select a single cell - 1-2-3 uses this as the top left corner of the range and enters all the data in the sheet. 
• Select a range - 1-2-3 enters only the data that fits in this range. If all the data does not fit in the selected range, 

the bottom (if more rows available) or right border (if more columns available) of the query table displays as a 
dashed border.

You can drag the border to display more of the data.
• Click a sheet tab to put the query table on another sheet.

Note A query table range cannot span more than one sheet. You cannot specify a range in another file as the sheet 
location. Also, if the data retrieved is more than 65,536 rows or 256 columns, 1-2-3 retrieves only 65,536 rows and 
256 columns of data. 

Working with Edit mode and Output mode
When the query table is in Edit mode, Approach commands and buttons appear in the main menu and status bar. The
Browse commands let you find, sort, and edit data. 
In this release of 1-2-3, when you click in the sheet outside the query table, the query table switches to Output mode. 
When the query table is in Output mode, you see the data in the output range. For more information, see Working 
with a query table.
Tip Instead of resizing the query table when it is in Edit mode to view all the data, use Output mode to view the data 
in cells in the sheet. If you resize the query table when it is in Edit mode, 1-2-3 limits the size of the query table when 
it is in Output mode to a fixed range, so that you may not be able to see all the data. If the fixed size prohibits the 
display of records or fields, the query table border appears as a dashed line. To display all the fields and records, 
select the query table in Output mode, choose Query Table - Output Range, then select Variable.

Getting Help about query tables
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a query table or when the
query table is active, Approach Help topics appear. Approach Help contains more information about working with 
query tables, which are called worksheets in Approach. 

• If you want to get Help about 1-2-3, click in the sheet outside the query table, then choose Help - Help Topics or 
press F1. 

{button ,AL(`H_123_CREATING_A_QUERY_TABLE_FROM_AN_EXTERNAL_DATABASE_STEPS',1)} Go to 
procedure



Example: Creating a query table
You create a query table in 1-2-3 to work with the information stored in a 1-2-3 database table or an external 
database table. The query table contains a copy of all the database records from the table you specified. 

Working with the Query table in Edit mode
Suppose you work with a database table that contains employee records. You want to create a query table to find all 
the records for employees in department 210. 
Initially, the query table appears in Edit mode. It contains all the records in the database table. 

To find all the records for employees in department 210, you use Browse - Find - Find Assistant to specify the criteria 
"DEPT is exactly equal to 210." 

Viewing the found records in Output mode 
To view the found set of records, you can click in the sheet outside the query table to switch to Output mode. When 
the query table is in Output mode, 1-2-3 displays the data in cells in the sheet.

You can switch back to Edit mode at any time to perform other queries, sort the records, or edit the data.

{button ,AL(`H_123_CREATING_A_QUERY_TABLE_FROM_AN_EXTERNAL_DATABASE_STEPS;H_DB_QUERY_
TABLES_OVER;H_DB_CREATING_QUERY_TABLE_STEPS',0)} See related topics



Working with a query table
In the current release of 1-2-3, query tables can appear in Edit mode or Output mode. You can perform different sorts 
and queries in a query table when it is in Edit mode, but only the most recent results are displayed in the query table 
when it is in Output mode. 

• To find, sort, or edit the records, work with the query table in Edit mode. 
• To print the records, use the data in calculations, or create charts and maps with the data, work with the query 

table in Output mode. You may also find that Output mode makes it is easier to view all the data.
Want the big picture? See Overview: Query tables. 

 See related topics

Working with a query table in Edit mode
When you create a query table, it initially appears in Edit mode. To switch the query table to Edit mode after it has 
become inactive, double-click the query table title bar or select the query table and choose Query Table - Edit.

 
When a query table is active, or in Edit mode, its title bar is blue and displays "Edit," and the Browse command 
appears on the main menu.
When the query table is in Edit mode, you can:

• Use the Browse commands to add, duplicate, delete, and edit records. Because the query table is linked to the 
database table you queried, 1-2-3 automatically makes these changes to the source database table.

• Use the Browse commands to find, sort, hide, and refresh records in the query table.
• Use the Find Assistant to set up criteria (conditions) for a query.
• Size the query table. 
• Rearrange the fields in the query table.
• Choose Edit - Open to Full Window to access much more of Approach's database functionality. For example, you 

can change the data formats, change the query table layout, and join database tables that contain related 
information. You can also use Create - Field Definition to create a calculated field for the query table.
Caution If you use Edit - Open to Full Window to work with a query table, do not use the Script Editor in 
Approach.

Tip Instead of resizing the query table when it is in Edit mode to view all the data, use Output mode to view the data 
in cells in the sheet. If you resize the query table when it is in Edit mode, 1-2-3 limits the size of the query table when 
it is in Output mode to a fixed range, so that you may not be able to see all the data. If the fixed size prohibits the 
display of records or fields, the query table border appears as a dashed line. To display all the fields and records, 
select the query table in Output mode, choose Query Table - Output Range, then select Variable.

 See related topics

Working with a query table in Output mode
To switch the query table to Output mode, click in the sheet outside the query table. 



    
When the query table is inactive, or in Output mode, its title bar is gray and displays "Output," and the query table 
data appears in cells in the sheet. The range that contains the inactive query table is called the output range. 
When the query table is in Output mode, you can:

• View the data more easily because it appears in cells in the sheet.
• Style and print the data.
• Use data in calculations, charts, and maps.
• Use the Query Table commands to change the name and properties of the table, show or hide the name and 

border, specify an output range, and refresh output range data from the source database table.
• Move the query table by dragging the title bar.
• Size the query table. 
• Delete the query table by pressing DEL.

Notes
• You cannot select more than one query table at a time. 
• You cannot group query tables.
• Do not make versions of a query table. Refreshing the query table produces unexpected results in the versions. 
• When you click a cell or select a range inside a query table in Output mode, you are selecting the data in the 

query table range, not the query table. To select all the cells in the query table, right-click the query table frame 
and choose Select Table Range.

• You can also choose Edit - Go To to select a query table if it is out of view or if the frame is turned off.

 See related topics

Editing and styling data in Output mode
You can make changes to and style the data in a query table when it is in Output mode. For example, you can 
change the column widths and number formats. However:

• Changes you make to the query table when it is in Output mode do not affect the data in the query table when it is
in Edit mode or the data in the source database table. 

• Any changes you make to data in Output mode will be lost the next time you refresh the query table. To save the 
results of each sort or find, you can copy the records from the output range to another range in 1-2-3. The copied 
records are no longer linked to the query table and will not change when you change data in the query table.

• Style changes you make to the query table when it is in Output mode do not change when you refresh the query 
table.

Turning off the output range display
If you do not want the data to appear in cells in the sheet when the query table is inactive, you can turn off the display
of the output range. When the output range is turned off, the inactive query table becomes an object that you cannot 
edit instead of going into Output mode. 

Getting Help on query tables
This topic is part of 1-2-3 Help. 

• If you choose Help - Help Topics, click a Help button, or press F1 while you are creating a query table or when the
query table is in Edit mode, Approach Help topics appear. Approach Help contains more information about 
working with query tables, which are called worksheets in Approach. 

• If you want to get Help about 1-2-3, click in the sheet outside the query table, then choose Help - Help Topics or 
press F1. 





Controlling the display of the output range
You can rename a query table and control the display of the output range when the query table is in Output mode. 
You can also turn off the display of the output range if you do not want the data to appear in cells in the sheet when 
the query table is inactive. When the output range is turned off, the inactive query table becomes an embedded 
object that you cannot edit. 
Want the big picture? See Working with a query table.    
1. With the query table in Output mode, click the query table title bar to select it.
2. From the Query Table menu, choose Query Table Properties.

3. To rename the query table, click the Basics tab in the InfoBox, then enter a new name.
4. To display the query table in Output mode without the title bar and borders, click the Basics tab, then deselect 

"Show name and borders."
5. To choose whether to display the output range, click In the Output range tab, then do one of the following:

• Deselect "Show query table results in a range" to show the query results in an inactive query table object 
instead of an output range.    The inactive query table appears without the scroll bars. You cannot make 
changes to an inactive query table object.

• Select "Show query table results in a range" to show the query results in an output range when the query 
table is in Output mode. Any formulas from the source database table are converted to values in the output 
range.

6. Select the size of the output range.
• Variable -- Enters all the records and fields in the sheet, starting in the cell where the top left corner of the 

activated query table appears. If you subsequently change the number of records with a find, the next time 
you view the output range, it will be a different size.

• Fixed -- Limits the size of the output range. 1-2-3 copies only the data that will fit in the selected range.
7. (Optional) If the 1-2-3 range displayed in the range box is not the correct range for the query table, enter a 

different range or use the range selector to specify a range. 
8. (Optional) Move, collapse, or close the InfoBox.
Tip If you resize the query table when it is in Edit mode, 1-2-3 limits the size of the query table when it is in Output 
mode to a fixed range, so that you may not be able to see all the data. If the fixed size prohibits the display of records
or fields, the query table border appears as a dashed line. To display all the fields and records, select the query table 
in Output mode, choose Query Table - Output Range, then select Variable.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS',0)} See related 
topics



Finding specific records in a query table
Use the Approach Find/Sort Assistant to set the criteria (conditions) for finding specific records. When you find 
specific records, the query table hides all the records except the ones that meet the conditions you specified.
Want the big picture? See Overview: Query tables. 
1. Double-click the query table title bar to switch the query table to Edit mode.
2. From the Browse menu, choose Find, and then choose Find Assistant.
3. Under "Type of Find," select one of the following:

• Basic Find -- to find records that meet criteria you specify.
• Find duplicate records -- to find records that have identical entries in the selected field(s).
• Find distinct records -- to find records with unique entries in the selected field(s).
• Find the top or lowest values -- to find a specified number of records with the highest or lowest values.
• Find using Query by Box - to set criteria by dragging criteria in a way similar to 1-2-3 Release 5.

4. Click Next, then specify the conditions for the query.
For information on setting conditions for finding records, click Help while you are in the Find Assistant dialog box.

5. Click Done to display the results in the query table.
6. (Optional) Click in the sheet outside the query table to view the data in Output mode.
Tip To redisplay all the records from the source database table, double-click the query table title bar, and then choose
Browse - Find - Find All.

{button ,AL(`H_DB_QUERY_DATABASE_RECORDS_DETAILS',1)} See details
{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_DELETING_DATABASE_RECORDS_STEPS;H_DB_WORKIN

G_WITH_A_QUERY_TABLE_STEPS',0)} See related topics



Details: Finding specific records in a query table
Tip When the query table is in Edit mode, you can click the Find Assistant button to open the Find Assistant dialog 
box quickly.

Finding records using Query by Box
Query by Box makes it easy to define sophisticated find conditions that require the setting of AND and OR 
precedence. In Query by Box, you define the find conditions by positioning the conditions in boxes in relation to each 
other.
For example, the following conditions define the conditions CITY=Paris AND DEPT=Sales:

You can also connect three or more find conditions with combinations of AND and OR relationships. For example, to 
retrieve the records of employees in either the Paris or the London office who are in the Sales department, you can 
define the find conditions this way.

For more information about Query by Box, click Help in the Find Assistant dialog box.

{button ,AL(`H_DB_QUERY_DATABASE_RECORDS_STEPS',1)} Go to procedure



Sorting records in a query table
You can change the order of the records in a query table by sorting them. Sorting records in the query table does not 
change the order of records in the source database table. 
1. Double-click the query table title bar to switch the query table to Edit mode.
2. Click in the field you want to sort by.
3. From the Browse menu, choose Sort.
4. Do one of the following:

• Choose Ascending or Descending to sort the records by the field you selected.
• Choose Define to do a more complex sort or add summary fields. If you choose Define, you can click Help to 

get additional information on defining a sort and summary fields.
The results are displayed in the query table.

5. (Optional) Click in the sheet outside the query table to view the data in Output mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_REORDERING_FIELDS_IN_A_QUERY_TABLE_STEPS;H_DB
_WORKING_WITH_A_QUERY_TABLE_STEPS',0)} See related topics



Sizing a query table
You can change the size of the query table when it is in Edit mode or Output mode. 

Sizing a query table in Edit mode
• To size the entire query table, drag any of the handles on the border.
• To size the columns in the query table, position the mouse pointer on the column border to the right of the column 

letter and drag the border until the column is the width you want.

Sizing a query table in Output mode 
Dragging the selections handles when the query table is in Output mode adds or removes columns or rows from the 
query table display. To automatically display all the records and fields in the query table when it is in Output mode, 
make sure the Output range display is set to Variable.
1. With the query table in Output mode, click the query table title bar to select it.
2. From the Query Table menu, choose Output Range.
3. In the Output range tab of the InfoBox, select Variable or Fixed. 
4. (Optional) Move, collapse, or close the InfoBox.
5. To size the columns in the query table in Output mode, size the columns of the sheet.

See Sizing columns. 

{button ,AL(`H_123_SIZING_A_QUERY_TABLE_DETAILS',1)} See details
{button ,AL(`H_SIZING_ROWS_STEPS;H_DB_ADDING_A_FIELD_IN_A_QUERY_TABLE_STEPS;H_DB_ADDING_

DATABASE_RECORDS_STEPS;H_DB_COPYING_QUERY_TABLE_STEPS;H_DB_DELETING_AN_OUTPUT_R
ANGE_STEPS;H_DB_MOVING_AND_SIZING_QUERY_TABLE_STEPS;H_DB_QUERY_OUTPUT_TO_RANGE_
STEPS;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS',0)} See related topics



Details: Sizing a query table
Changing the size of the query table in Edit mode changes the size of the query table in Output mode, and vice 
versa.

Size of output range
"Size of output range" lets you select a variable or fixed output range size for the query table in Output mode.

• Variable -- Automatically displays all the records and fields in the sheet, starting in the cell where the top left 
corner of the active query table appears. 
If you subsequently change the number of records with a find, the next time you view the query table in Output 
mode, it will be a different size.

• Fixed -- Limits the size of the query table in Output mode to the range specified in the Output range tab in the 
InfoBox. 
If the 1-2-3 range displayed in the range box is not the correct range for the query table, enter a different range or 
use the range selector to specify a range. 
If all the data does not fit in the range, the bottom (if more records available) or right (if more fields available) 
border of the query table displays as a dashed border.

Note If you manually resize the query table in Edit or Output mode by dragging, the "Size of output range" option 
changes to "Fixed."

Resizing tables over anchor cells
If you drag or paste data into either of the anchor cells for the query table, even if the anchor cell is blank, a message 
appears indicating that you are about to write over an anchor cell. Overwriting an anchor cell disconnects the query 
table from the cells below it and turns off the display of the query table's output range.

{button ,AL(`H_123_SIZING_A_QUERY_TABLE_STEPS',1)} Go to procedure
{button ,AL(`H_DB_QUERY_OUTPUT_TO_RANGE_STEPS',0)} See related topics



Deleting a query table
You can delete a query table when it is in Edit mode or Output mode. When you delete the query table, the data no 
longer appears in the output range. Deleting the query table does not affect data in the source database table. 
1. Select the query table you want to delete.
2. Press DEL.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_AN_OUTPUT_RANGE_STEPS;H_DB_WO
RKING_WITH_A_QUERY_TABLE_STEPS',0)} See related topics



Adding records using a query table
Adding a new record to a query table also adds the record to the source database table. 
1. Double-click the query table title bar to switch the query table to Edit mode.
2. From the Browse menu, choose New Record.

A new blank record is added to the end of both the query table and the source database table.
3. In the query table, type data in each field of the new record. Press TAB or ® to move to the next field.
4. Press ENTER after you have entered data for the entire record to add the new data to the source database table.
5. (Optional) Click in the sheet outside the query table to view the data in Output mode.
Note You can also create and use a form to add records to a 1-2-3 database table.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_DELETING_DATABASE_RECORDS_STEPS;H_DB_CREATIN
G_FORMS_STEPS;H_DB_WORKING_WITH_A_FORM_STEPS;H_DB_WORKING_WITH_A_QUERY_TABLE_S
TEPS;H_DB_REFRESHING_DATA_STEPS',0)} See related topics



Editing records using a query table
Editing a record in a query table also edits that record in the source database table.
Caution Do not edit data in the query table that is the result of a formula in 1-2-3 because this will convert the formula
to a value in your 1-2-3 database table. Edit formulas in the source database table.
1. Double-click the query table title bar to switch the query table to Edit mode.
2. Select the cell containing data you want to change.

Caution 1-2-3 allows up to 512 characters in a field. Approach allows up to 256 characters in a field. If you edit 
data longer than 256 characters using a query table, that data will be truncated in your 1-2-3 database table.

3. Change the data and press ENTER.
Data automatically changes in the source database table.

4. (Optional) Click in the sheet outside the query table to view the data in Output mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_CREATING_FORMS_STEPS;H_DB_WORKING_WITH_A_FO
RM_STEPS;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABL
E_STEPS;H_DB_REFRESHING_DATA_STEPS',0)} See related topics



Deleting records using a query table
Deleting records from a query table also deletes the records from the source database table. For example, you might 
want to delete a record for one person, or you might want to delete all records entered before a specific date.
Caution You cannot undo deleting records.

Deleting selected records
You can select one or more records you want to delete.
1. Double-click the query table title bar to switch the query table to Edit mode.
2. Click the record you want to delete.
3. (Optional) To delete more than one record, click the selection arrow (in the left border) and drag down in the left 

border to select the records you want to delete.

4. From the Browse menu, choose Delete Record.
5. Click Yes to permanently delete the selected records from both the query table and the source database table.

Deleting found records
You can delete all the records found as the result of a query.
1. Double-click the query table title bar to switch the query table to Edit mode.
2. From the Browse menu, choose Find Assistant to set criteria (conditions) and find the records you want to delete.

For more information, click Help while you are in the Assistant dialog box.
3. Check the query table to make sure it contains only the records you want to delete.
4. From the Browse menu, choose Delete Found Set to delete all the records found.
5. Click Yes to permanently delete the found records from the source database table.

After you delete the found records, 1-2-3 refreshes the query table to display all of the remaining records in the 
source database table.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_ADDING_DATABASE_RECORDS_STEPS;H_DB_WORKING_
WITH_A_QUERY_TABLE_STEPS;H_DB_QUERY_DATABASE_RECORDS_STEPS',0)} See related topics



Adding a field in a query table
Adding a field in the query table does not add a field to the source database table, but you may want to add a field in 
a query table if:

• You didn't include all of the fields when you first created the query table.
• You created a calculated field in Lotus Approach and want to add that field to the query table.
• You joined two or more tables and want to add fields from another table.

To add a field to a query table:
1. Double-click the query table to switch the query table to Edit mode.
2. From the Edit menu, choose Add Field. 

The Add Field dialog box displays the name of the database table and the fields that it contains.
3. To add a field from a joined database, select the database table that contains the field you want to add.
4. Drag the field name from the Add Field dialog box to the query table.

For more information on working with fields, click Help while you are in the Add Field dialog box.
5. (Optional) Click in the sheet outside the query table to view the data in Output mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_DELETING_A_FIELD_IN_A_QUERY_TABLE_STEPS;H_DB_R
EORDERING_FIELDS_IN_A_QUERY_TABLE_STEPS;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;',0)
} See related topics



Reordering fields in a query table
Changing the order of the fields in the query table does not affect the source database table. However, these 
changes will appear in the output range when you refresh it.
1. Double-click the query table to switch the query table to Edit mode.
2. Click a field name. 
3. When the mouse pointer changes to a hand, drag the field to a different location.

1-2-3 displays a highlighted line between the columns in the query table as you drag the field to a new location. 
This line indicates where the field will go when you release the mouse button.

4. (Optional) Click in the sheet outside the query table to view the data in Output mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_ADDING_A_FIELD_IN_A_QUERY_TABLE_STEPS;H_DB_DEL
ETING_A_FIELD_IN_A_QUERY_TABLE_STEPS;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;',0)} See 
related topics



Deleting a field in a query table
Deleting a field in the query table does not delete the field in the source database table, but it does delete the field in 
the output range when you refresh it.
1. Double-click the query table to switch the query table to Edit mode.
2. Click the field name you want to delete.
3. Press DEL.
4. (Optional) Click in the sheet outside the query table to view the data in Output mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_REORDERING_FIELDS_IN_A_QUERY_TABLE_STEPS;H_DB
_ADDING_A_FIELD_IN_A_QUERY_TABLE_STEPS;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;',0)} 
See related topics



Moving a query table
You can only move a query table when it is in Output mode. 
Caution To avoid writing over data, do not move a query table over other data in the sheet.
1. With the query table in Output mode, click the query table title bar to select it.
2. Drag the query table title bar to the new location. 

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_123_SIZING
_A_QUERY_TABLE_STEPS',0)} See related topics



Copying a query table
You can create copies of a query table in the same 1-2-3 workbook to perform different queries using records from 
the same source database table. You cannot copy a query table to a different file.
1. With the query table in Output mode, click the query table title bar to select it.
2. From the Edit menu, choose Copy.

3. Click in the sheet where you want to copy the query table.
4. From the Edit menu, choose Paste.

When you copy a query table, 1-2-3 assigns a new name to the table. The copy of the query table is still linked to the 
source database table. You can activate either query table to work with the source database table.
Note If you copy a query table, be aware that changing records in either query table when it is in Edit mode changes 
records in the same source database table. 

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_QUERY_
OUTPUT_TO_RANGE_STEPS;H_DB_WORKING_WITH_AN_OUTPUT_RANGE_STEPS',0)} See related topics



Refreshing data in a query table
A query table is linked to the database table you queried. If you are working with a source database table that you 
share with other users, you can refresh the data in the query table when it is in either Edit mode or Output mode as 
often as you like to ensure that you are working with the most recent data. 
Do one of the following:

• With the query table in Edit mode, choose Browse - Refresh Data. 
• With the query table in Output mode, choose Query Table - Refresh.

• With the query table in Output mode, click the Refresh button in the query table title bar.

Note If the source database table changes while the query table is in Output mode, 1-2-3 automatically refreshes the
data when you switch the query table to Edit mode.
Caution Any changes you make to the query table when it is in Output mode will be lost the next time you refresh the
query table. Always edit the data when the query table is in Edit mode.

{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_WORKIN
G_WITH_AN_OUTPUT_RANGE_STEPS',0)} See related topics



Joining database tables
You can use Lotus Approach to join databases that contain at least one common field. When you join database 
tables, you can include fields and records from two or more database tables in a single query table, provided the 
tables have a common field. 
For example, you might work with two databases that contain different kinds of information about the employees in 
your company. If each database contains a field for employee identification codes, you can join the databases and 
view the data from both in a query table.
Note You can also view joined databases in forms, reports, crosstabs, form letters, and mailing labels.
1. Double-click the query table title bar to switch the query table to Edit mode.
2. From the Edit menu, choose Open Into Full Window to open the query table in Approach.
3. From the Create menu, choose Join.

The name of the source database table and the fields appear in the Join dialog box. 
Tip For more information on joining database tables, click Help when you are in the Join dialog box.

4. Click Open, then open the database table you want to join. 
5. For each field you want to join, click the field in one database and then drag to a field in the other database.

The fields you join must contain the same kind of data, although the field names can be different.
6. (Optional) Click Options to review the insertion and deletion options for this join.
7. Click OK.
8. From the File menu, choose Exit & Return to Lotus 1-2-3.
To add fields from the second database table to the query table, see Adding a field in a query table. 

{button ,AL(`H_DB_JOINING_DATABASE_TABLES_EX',1)} See example
{button ,AL(`H_DB_QUERY_TABLES_OVER;H_DB_WORKING_WITH_A_QUERY_TABLE_STEPS;H_DB_WORKIN

G_WITH_DATABASE_TABLES_OVER;H_123_ODBC_DRIVERS_OVER',0)} See related topics



Example: Joining database tables
You can join database tables to combine records and fields from two or more database tables in a single query table. 

Joining two database tables
For example, you want to join an employee database table named EMPLOYEE with a database table named 
BENEFITS that contains their employee benefits.    
EMPLOYEE

ID     LASTNAME
45324  Kravitz 
32465  Lee
35214  Garcia
24367  Jackson

BENEFITS
ID     HEALTH  PLAN
32465  Yes     Single
24367  Yes     Family
35214  No      None
45324  Yes     Single

Both tables contain the field ID, which holds employee identification numbers. Two database tables can be joined if 
they both have a field that contains the same kind of data, although the field name can be different. 
To join these two tables, create the following join in the Join dialog box:

Now you can add fields from the BENEFITS table to the query table for EMPLOYEE.
ID     LASTNAME  HEALTH  PLAN
24367  Jackson   Yes     Family
32465  Lee       Yes     Single
35214  Garcia    No      None
45324  Kravitz   Yes     Single

Joining more than two database tables
You also have a database table that contains details about the available health plans. 
HEALTHPLANS

PLAN    COST
Single   750
Family  1500
None       0

To join these three tables, create the following join in the Join dialog box:

Now you can include fields from all three databases in the query table.
ID     LASTNAME  HEALTH  PLAN    COST
24367  Jackson   Yes     Family  1500
32465  Lee       Yes     Single   750
35214  Garcia    No      None       0
45324  Kravitz   Yes     Single   750



Overview: ODBC drivers
1-2-3 is fully compatible with the Open Database Connectivity standard (ODBC). 1-2-3 uses 32-bit ODBC drivers to 
connect to external database tables. ODBC drivers allow 1-2-3 to read data from and send data to an external 
database. 
1-2-3 uses ODBC drivers when you:

• Open a database file with the File - Open command.
• Save a range as a database table with the File - Save As command.
• Create a query table from an external database table with the Create - Database - Query Table command. 
• Connect to or create an external database table with the Data Query Add-In (DQA), LotusScript, or macro 

commands.

Installing and configuring ODBC drivers
ODBC drivers must be installed and configured for each data source you want to open. A data source gives the 
location of the data you want to access, such as:

• The directory in which a set of dBASE files are located.
• An SQL Server database and the server where it is located.

1-2-3 installs and configures some ODBC drivers when you install 1-2-3. The table below lists the drivers that are 
available with 1-2-3, whether the driver is installed by default with 1-2-3, and whether you must configure the driver. 
(1-2-3 configures some drivers the first time you use a data source.) 

ODBC
database driver

Installed by
default

Configured
automatically

dBASE Yes Yes
Paradox No Yes
SQL Server 4.x No Yes
SQL Server 6 No No
Sybase No No
Lotus Notes No No
Oracle No No
Informix No No
Text No No

Note Depending on the type of driver you select, you may also need to add the appropriate settings to the 
LOTUS.BCF file in order to use the driver with 1-2-3. The Lotus Installation process automatically enters these 
settings for all the drivers in the table above except the Oracle and Informix drivers, which are available in the Lotus 
Installation process with a customized installation of Lotus Approach.    

Getting Help on ODBC drivers
For more information, see:

• Installing ODBC drivers. 
• Configuring ODBC drivers. 

For information about a specific ODBC driver, look for these Help files in your WIN95\SYSTEM directory. To open the 
Help file, double-click it in the Windows Explorer. (The Help button in the ODBC Administrator also gives information 
about OCBC drivers, although the driver versions may be different from the ones installed with 1-2-3.)

ODBC driver Help file
General information IVDRV09.HLP
dBASE LODBF09.HLP
Paradox LOIDP09.HLP
SQL Server 4.x LOSS09.HLP
SQL Server 6 LOSS609.HLP
Sybase LOSYB09.HLP



Oracle LOOR709.HLP
Informix LOINF509.HLP

LOINF709.HLP
Text LOTXT09.HLP

Note For information about the ODBC driver for Lotus Notes, use Notes to open the NotesSQL.NSF database in 
your WIN95\SYSTEM directory.
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Installing ODBC drivers
1-2-3 comes with Open Database Connectivity standard (ODBC) database drivers that let you work with external 
database tables. Whether these drivers are installed on your computer depends on the choices you made when you 
installed 1-2-3. If you chose Default installation, 1-2-3 installed the dBASE driver. To install other ODBC drivers, you 
must use a customized install.
1-2-3 works with Lotus Approach to create a query table from an external database table. 1-2-3 and Approach are 
installed together when you install 1-2-3. The ODBC drivers are installed with either 1-2-3 or Approach, or both.
Want the big picture? See Overview: ODBC drivers. 
Tip Print this topic so you can refer to these instructions while running Install. (Install requires that you exit from 1-2-3 
if it is open.)
1. Insert the 1-2-3 or SmartSuite Install CD-ROM or first disk in the disk drive.

If you install 1-2-3 over a network, open the directory containing the Install program.
2. From the Start menu, choose Run, type x:\install.exe (where x is the drive containing the Install disk), and click 

OK. 
The installation program begins. Answer all initial questions asked.

3. In the Install Options dialog box, select "Customize features - Manual Install," and then click Next.
4. In the "Select 1-2-3 Features to Customize" dialog box, select 1-2-3 and click Customize.
5. Click the Shared Data Access tab, and select the database type(s) you want to work with.
6. Deselect all other choices from all other tabs and then click OK.
7. In the "Select 1-2-3 Features to Customize" dialog box, select Approach and click Customize.
8. Click the PowerKeys tab, and select the database type(s) you want to work with.
9. Deselect all other choices from all other tabs and then click OK.
10. Click Next to continue, finish answering all other installation questions, and then click Yes to copy your files.
If you need additional Help while installing the files, click Help in the Install dialog boxes.
Note For all ODBC drivers except dBASE, SQL Server 4.x, and Paradox, you need to configure the ODBC drivers to 
create a data source for each database you want to open. For more information, see Configuring ODBC drivers. 

{button ,AL(`H_123_INSTALLING_ODBC_DRIVERS_DETAILS',1)} See details
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Details: Installing ODBC drivers
Finding the driver types
When you install 1-2-3, you also install Lotus Approach. Some of the ODBC drivers are installed by customizing the 
1-2-3 installation and some are installed by customizing the Approach installation.

ODBC driver Installed by 
dBASE 1-2-3
Paradox 1-2-3, Approach
SQL Server 4.x 1-2-3, Approach
SQL Server 6 1-2-3, Approach
Lotus Notes 1-2-3, Approach
Sybase 1-2-3, Approach
Text 1-2-3
Oracle Approach
Informix Approach
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Configuring ODBC drivers 
1-2-3 comes with Open Database Connectivity standard (ODBC) database drivers that let you work with external 
database tables. Before you can work with an external database table, you need to configure it as an available data 
source using the appropriate ODBC driver. You can configure more than one data source that uses the same driver.
The current release of 1-2-3 installs the Intersolv ODBC Data Source Administrator version 2.12 unless you already 
have a later version of ODBC installed on your computer. 
Note 1-2-3 automatically configures the ODBC drivers the first time you connect to a database table in one of the 
following database types:    dBASE, Paradox, and SQL Server 4.x.
Want the big picture? See Overview: ODBC drivers. 
1. In the Windows 95 taskbar, click Start.
2. Choose Settings - Control Panel. 
3. To start the ODBC Data Source Administrator, double-click the 32bit ODBC icon.

You can configure an existing data source or add a new data source. 
Tip Click Help in the ODBC Data Source Administrator at any time for more information. The following instructions
are for Intersolv ODBC version 2.12.    If you have a later version installed (for example, the ODBC Data Source 
Administrator window has tabs), click Help for instructions. 

4. Do one of the following:
• To add and configure a new data source, click Add, select the driver for which you want to set up a data 

source from the list of installed drivers, then click OK.
• To configure an existing data source, select the data source in the User Data Source (Driver) list in the Data 

Source dialog box, then click Setup.
The ODBC Driver Setup dialog box for the driver you selected appears.

5. Specify the required data source information, then click OK.
6. (Optional) To configure the driver so that it is visible to anyone who logs onto the system, click System DSN, 

specify the required information, then click Close.
7. Click Close to write the settings to the ODBC.INI section of the registry. 
Note If a "low memory" error message appears, your system may lack some necessary files. For more information, 
see Details. 

{button ,AL(`H_123_CONFIGURING_ODBC_DRIVERS_DETAILS',1)} See details
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Details: Configuring ODBC drivers
The values you specify in the Setup dialog box become the defaults for your connection to the data source. You can 
change the defaults by configuring your data source again. You can also override the defaults by connecting to the 
data source using a connection string.
Note Depending on the type of driver you select, you may also need to add the appropriate settings to the 
LOTUS.BCF file in order to use the driver with 1-2-3. For example, you must take this step for the Oracle and Informix
drivers; the Lotus Installation process automatically enters these settings for the other drivers available with 1-2-3.

Other files you need to set up external data connections
Once you install the appropriate files (with their corresponding registry entries), you can work with the dBASE IV, 
Paradox, and SQL Server 4.2 and 6.0 sources. 

• To work with the Microsoft SQL Server versions 4.2 and 6.0, you need to have the following files on your system:   
NTWDBLIB.DLL
DBMSSOCN.DLL
DBMSPXN.DLL
DBNMP3.DLL
DBNMPNTW.DLL

• For connections to Sybase System 10 and 11, the client version of Sybase must be installed on your computer.
• To work with Paradox files, Borland Database Engine must be installed on your computer. Borland Database 

Engine comes with Paradox 7, or you can purchase it separately. 
After you complete the setup for your driver, you can access it. If you attempt to access an installed driver without 
completing the setup, you will get the error message "ODBC driver could not be loaded. You may be low on memory 
and need to quit a few applications." Disregard this message (low memory is not the cause), and, instead, make sure 
that all files are installed and that you completed the setup properly.

Data external connection to Lotus Notes
The Lotus Notes ODBC driver will not function with any release of Notes prior to Notes 4.0.    Consequently, trying to 
access any Notes 3.x file will have unpredictable results. For more information, use Notes to open the 
NotesSQL.NSF database in your WIN95\SYSTEM directory.

Using transaction-based ODBC drivers
If you are using any of the transaction-based ODBC drivers that come with 1-2-3 (such as SQL Server 4.2, 6.0, or 
Sybase System 10), make sure Two Phase Commit is enabled for your registered Data Source Name (DSN). If you 
receive a message reporting that SQL_AUTOCOMMIT is false, you need to enable Two Phase Commit for your 
registered DSN. Open the 32bit ODBC icon in the Windows Control Panel and use Setup (Advanced Setup for some 
drivers) to select the Two Phase Commit option. 

Updating data in a transaction-based external database table
When updating data in a transaction-based database such as SQL Server, the records you are updating must contain
unique entries. Note that SQL Server drivers do not use the Float data type to determine uniqueness. If you receive 
an error message reporting that "... no columns are useable for selecting a unique row," you need to include a unique 
field of a data type other than Float in the query table (or output range).
Note To update a transaction-based database using the Data Query Add-In (DQA), macros, or LotusScript, the Allow 
Updates setting must be turned on using the Query - Set Options command, the macro command {QUERY-OPTIONS
"allow updates";"on"} , or the LotusScript statement [queryname].AllowUpdates=True.

Updating external SQL Server or Sybase database tables
You may get a "connection timed out" error message when updating or deleting records in an external SQL Server or 
Sybase database table. The message may appear because the found set is too large, the query criteria are too 
complex, or because of heavy network traffic.
If the found set is large, reduce the size of the found set and try the update again. If the query criteria are complex 
and include 1-2-3 @functions, simplify the criteria and then try updating or deleting again. 
If network traffic is heavy, you can ask your system administrator to change the amount of time that 1-2-3 is set to 
wait for the network to respond before issuing a timeout error. This is controlled by the setting "UpdateTimeout=" in 
the ODBC configuration file for the driver (LOSS609.INI for SQL Server 6.0 and LOSS09.INI for SQL Server 4.2), 
located in the WIN95 or WINNT directory.
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Working with ODBC data sources
1-2-3 and Approach are fully compatible with the Open Database Connectivity standard (ODBC), giving you access to
database tables from the following types of data sources:    dBASE, Paradox, SQL Server 4.x, SQL Server 6, Sybase,
Informix, Oracle, and text.
Want the big picture? See Overview: ODBC drivers. 

Supported data types
1-2-3 supports most data types, or field types, for the data sources listed above. Data types that are not supported by
1-2-3 are converted to a 1-2-3 data type. For example, fields in the ODBC field types Big Int, Tiny Int, Small Int, Real, 
Numeric, Decimal, Integer, Double, and Float are converted to numeric fields.

Restrictions on field names
The maximum length of a field name depends on whether the ODBC driver supports the data type of the field. In the 
following table, ODBC data types are given in parentheses.

Data type (ODBC 
data types)

Driver supports 
data type

Driver does not 
support data type

Text (Char or Var 
Char)

30 or limit of driver (Always supported)

Numeric (Bit Int, 
Tiny Int, Small Int, 
Real, Numeric, 
Decimal, Integer, 
Double, or Float)

30 or limit of driver 30 or limit of driver; 
stored as text

Memo (Long Var 
Char)

30 or limit of driver Field is disabled

Boolean (Bit) 30 or limit of driver (30 or limit of driver)
- 7; stored as text

Date (Date) 30 or limit of driver (30 or limit of driver)
- 6; stored as 
timestamp (if 
supported) or as 
text

Time (Time) 30 or limit of driver (30 or limit of driver)
- 6; stored as 
timestamp (if 
supported) or as 
text

PicturePlus (Long 
Var Binary)

(30 or limit of 
driver) - 6

Field is disabled

If two lengths are given for a field name (such as "30 or limit of driver"), the maximum can only be the shorter of the 
two lengths.
Permitted characters: The first character in a field name must be a letter. After that, the name can have letters and 
whole numbers.
Characters not to use: Spaces and ODBC keywords

Restrictions on field lengths
You must specify a field length for text fields. Other fields are fixed in length or do not require a specified length.
Maximum length of text fields: The limit of the ODBC driver. Most drivers have a limit of 255.

Limits on tables, records, and fields
In an ODBC data source, the size of the table and the number of records in it are limited only by disk space. You can 
have up to 255 tables open at a time.
The limits on record size, fields per record, fields in a sort, and memo and picture fields are determined by the 
database application for the ODBC data source. For more information, consult the documentation for the ODBC 



driver or for the database application.

Getting Help on ODBC data sources
For information about a specific ODBC driver, look for these Help files in your WIN95\SYSTEM directory. To open the 
Help file, double-click it in the Windows Explorer.

ODBC driver Help file
General information IVDRV09.HLP
dBASE LODBF09.HLP
Paradox LOIDP09.HLP
SQL Server 4.x LOSS09.HLP
SQL Server 6 LOSS609.HLP
Sybase LOSYB09.HLP
Oracle LOOR709.HLP
Informix LOINF509.HLP

LOINF709.HLP
Text LOTXT09.HLP
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Overview: 1-2-3 Preferences
1-2-3 preferences are settings that control the display and behavior of all new workbook files and of the current and 
future sessions of 1-2-3. These default settings take effect automatically whenever you start 1-2-3.
You can change the following settings in the 1-2-3 Preferences dialog box:

General 
Lets you set how may recently used files 1-2-3 lists at the bottom of the File menu, the sort order, and how 1-2-3 
interprets and displays dates. You can also change defaults for undo, drag and drop, autoexecute macros, the startup
window size, and some of    1-2-3's automatic features such as SmartFill and SmartLabels.

New Workbook Defaults
Lets you set text format defaults and column and row sizes that 1-2-3 uses for new workbook files created without a 
SmartMaster.Also lets you set the default file type displayed in the Save As dialog box for all new workbooks.

File Locations
Lets you specify paths for workbook files, SmartMaster templates, automatically opened files, and add-in files.

Recalculation
Lets you change the recalculation setting from manual to automatic, the number of recalculation iterations, and the 
recalculation order 1-2-3 uses. These settings are stored in the current workbook.

Classic Keys
Sets which key brings up the 1-2-3 Classic menu and controls the behavior of the TAB and ENTER keys.
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Setting 1-2-3 options 
The settings in the 1-2-3 Preferences dialog box (General tab) control the display and behavior of all new workbook 
files in current and future sessions of 1-2-3. These default settings take effect automatically whenever you start 1-2-3.
For a description of these options, see Details: Setting 1-2-3 options.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the General tab in the dialog box.
3. Change any of the following default settings:

• The number of recently used files listed on the File menu
• The sort order
• How 1-2-3 interprets and displays dates
• Other options

4. Click OK.
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Details: Setting 1-2-3 options
Settings in the 1-2-3 Preferences dialog box (General tab)
Recently used files

• Specifies the number (0 to 10) of recently opened files to display at the bottom of the File menu. 

Sort order
• Sorts words and numbers using the conventions of the country you select in the list. The list of available country 

sort orders depends on what country driver(s) you have installed. If you select "Generic International sorting" 1-2-
3 sorts based on the operating system's regional (country) settings.

Dates
• (Default) Interpret entry of 2-digit years using a sliding window around the system date. This setting specifies how 

1-2-3 interprets a date when you enter it using only 2-digits for the year (dd/mm/yy). When this option is checked, 
1-2-3 uses the default sliding window (currently 80/20) set for Lotus SmartSuite to determine whether a date falls 
in the 20th or 21st century. For more information, see 1-2-3 and the year 2000. 

• Interpret entry of 2-digit years as 20th century (1900-1999) -- This setting overrides the sliding window setting so 
1-2-3 places all dates you enter with 2-digit years in the 20th century.

• Always display 4-digit years in dates -- Displays all dates with 4-digit years (whether you enter 2 or 4 digits for the 
year). When you deselect this option, 1-2-3 displays all dates with 2-digit years. Date formats in the InfoBox and 
status bar automatically change according to this setting. This setting only applies to years you enter as dates.
Note Changing from 2-digit to 4-digit years will make the dates wider, so some dates may display as *** 
(asterisks) until you widen the column. You may also need to adjust print ranges.

Other options 
You can check (turn on) or uncheck (turn off) any of the following 1-2-3 options.

• Show Welcome dialog - Displays this dialog box when you start 1-2-3.
• Show New Workbook dialog -- Displays the New Workbook dialog box when you choose File - New Workbook, so

you can select a SmartMaster. Otherwise, 1-2-3 creates a plain workbook file when you choose File - New 
Workbook.

• Maximize 1-2-3 window on startup 
• Show warning when saving as .WK* file -- Displays a message warning you that saving to an older file format 

(.WK*) can result in the loss of data associated with new 1-2-3 features. For more information, see Details: 
Saving a new workbook.

• Run file Opened scripts, autoexecute macros -- Runs scripts that contain an Opened event, or autoexecute 
macros when you open files that contain these scripts or macros.

• Update links when opening workbooks -- Updates file links automatically when a workbook file is opened. When 
attempting to update an OLE link, if the application is not active, 1-2-3 starts the application. 

• Drag and drop cells and sheets -- Lets you move, copy, clear, and fill cells and sheets using the mouse.
• Confirm overwrite for drag and drop -- Displays a message if dragging and dropping will write over existing data.
• Use SmartFill during data entry -- 1-2-3 will make suggestions for the current cell based on what you typed in 

previous cells and what you started typing. 
• Use SmartLabels. to enter formulas and apply formats -- Determines if 1-2-3 uses the set of SmartLabels like the 

word Total, to perform calculations when you type them in the sheet. 
• Sort numbers before words
• Sort blank cells to bottom
• Beep on error -- Sounds your computer's bell when an error occurs.
• Undo -- Enables Undo so you can cancel your last command or action.
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Setting a default font and colors for new workbooks
Changes to these default settings will not take effect until you create a new workbook.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the New Workbook Defaults tab in the dialog box.
3. Under Text format, select a font, point size, text color, and background color.
4. Click OK.
Note These defaults do not apply to workbooks created using a SmartMaster template. 
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Details: Setting a default font and colors for new workbooks
You can't change the current workbook defaults, but you can change the current sheet defaults by choosing Sheet - 
Sheet Properties.

Using Windows defaults for text and background colors
When you select this option, 1-2-3 uses the text and background colors specified in the Windows Control Panel. For 
more information, see your Windows documentation.
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Setting column and row defaults for new workbooks
Changes to these default settings will not take effect until you create a new workbook.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the New Workbook Defaults tab in the dialog box.
3. To set column width in characters, under Column and row size, click the arrows or enter a number in the "Column 

width" box.
4. To set row height in points, under Column and row size, click the first button under "Row height," then enter a 

number or click the arrows to change the point size.
5. To set row height to the default font size, under Column and row size, select "Fit default font."
6. Click OK.
Note These defaults do not apply to workbooks created using a SmartMaster template. 
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Details: Setting column and row defaults for new workbooks
You can't change the current workbook defaults, but you can change the current sheet defaults by choosing Sheet - 
Sheet Properties.

Setting the column width in characters
1-2-3 sizes columns in whole-character increments from 1 to 240 characters.

The effect of column width on values
When a column is too narrow to display an entire value as formatted, the value appears in Scientific format,  or as a 
line of *** (asterisks). To display the value, you must widen the column to at least one character wider than the width 
of the formatted value.

The effect of column width on labels
If a label is longer than the cell it occupies and the cells to the right are blank, 1-2-3 displays the label across the 
blank cells. If the cells to the right contain data, 1-2-3 displays only the part of the label that fits in the cell where it is 
entered. To see the complete label, you must widen the column or wrap the text in the cell.

Setting the default row height in points
1-2-3 sizes rows in points from 1 to 255 points. When you set the row height to a specific point size, 1-2-3 will use 
that size unless you enter a taller font in the row. 1-2-3 always expands to the tallest font in the row regardless of the 
default row height setting.
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Setting file locations
You can set the default directories for workbooks, SmartMaster templates, automatically opened files, and add-in 
files.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the File Locations tab in the dialog box.
3. Specify directories (folders) for any of the file types listed.
4. To view the directories to choose from, click Browse.
5. Click OK.
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Details: Setting file locations
1-2-3 Preferences dialog box (File Locations tab)

• Workbook files -- Specifies the default directory for opening and saving workbook files. You must specify a 
directory for workbook files.

• SmartMaster templates -- Specifies the directory where 1-2-3 looks for a list of SmartMaster templates.
• Automatically opened files -- Specifies the directory from which 1-2-3 automatically opens workbook and add-in 

files. If you do not specify a directory, 1-2-3 does not automatically open any files.
• Add-ins -- Specifies the default directory for add-in files. When you choose File - Add-Ins, 1-2-3 lists the files that 

are in this directory.
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{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



Setting sorting options
The sorting options determine the order in which 1-2-3 sorts numbers, words, and blank cells.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the General tab in the dialog box.
3. To change the country sort order, select a country from the "Sort order" list.
4. Under Other options, set how 1-2-3 sorts numbers, words and blank cells.
5. Click OK.

{button ,AL(`H_SETTING_SORTING_OPTIONS_DETAILS',1)} See details
{button ,AL(`H_123_PREFERENCES_OVER;H_SETTING_123_OPTIONS_STEPS;H_SETTING_USER_NAME_AN

D_STARTUP_OPTIONS_STEPS;H_CHANGING_INTERNATIONAL_SETTINGS_OVER;',0)} See related topics



Details: Setting sorting options
Sorting blank cells
If you select "Sort blank cells to the bottom," blank cells always sort to the bottom, regardless of the sort order 
(ascending or descending).

Sort order
1-2-3 sorts words and numbers using the conventions of the country you select in the "Sort order" list. The list of 
available country sort orders depends on what country driver(s) you have installed. If you select "Generic 
International" 1-2-3 sorts based on the operating system's regional (country) settings.

Related SmartIcons

Sorts a range in ascending order (A-Z, 1 to 10)

Sorts a range in descending order (Z -A, 10 to 1)

{button ,AL(`H_SETTING_SORTING_OPTIONS_STEPS',1)} Go to procedure
{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



Changing international settings
1-2-3 sorts and displays numbers, currencies, times, and dates based on defaults from regional settings (country 
settings) in the operating system. To change defaults for Windows 95, choose Start - Settings - Control Panel and 
open Regional Settings.

Setting country sort order
1-2-3 uses the operating system's settings to sort if the 1-2-3 setting is "Generic International" in the 1-2-3 
Preferences dialog box (General tab). To override the operating system's sorting defaults, use File - User Setup, 
choose 1-2-3 Preferences, and then select a country instead of    the generic setting.

Setting international date and time defaults
1-2-3 uses the operating system settings for certain date and time formats, called international date and time formats.
These are marked with (System) in the table of available date formats in Details: Entering dates. 

Setting number and currency defaults 
For both Comma and Currency number formats, 1-2-3 uses either parentheses or a minus sign, based on the 
negative number settings from the operating system's regional defaults. 1-2-3 also uses the operating system 
defaults for the decimal, thousands, and argument separator characters.

Macro compatibility and international defaults
Some macros written for previous versions of 1-2-3 may no longer return the proper international settings because of 
changes in the operating system. 

{button ,AL(`H_123_PREFERENCES_OVER;H_SETTING_123_OPTIONS_STEPS;H_SETTING_SORTING_OPTIO
NS_STEPS;H_CHANGING_THE_CURRENCY_SYMBOL_DETAILS;H_SETTING_A_DEFAULT_NUMBER_FOR
MAT_STEPS;',0)} See related topics



Setting TAB and ENTER key behavior
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the Classic Keys tab in the dialog box.
3. Under TAB and ENTER keys, select an option.
4. Click OK.

{button ,AL(`H_SETTING_TAB_AND_ENTER_KEY_BEHAVIOR_DETAILS',1)} See details
{button ,AL(`H_123_PREFERENCES_OVER;H_SETTING_123_OPTIONS_STEPS;',0)} See related topics



Details: Setting TAB and ENTER key behavior
Options: 1-2-3 Preferences dialog box (Classic Keys tab)
You can set how the TAB and ENTER keys work.

• TAB moves right one screen, ENTER confirms -- After you type data in a cell, pressing TAB confirms the cell entry 
and moves the cell pointer right the number of columns currently visible in the sheet. Pressing ENTER confirms 
the entry in the current cell without moving the cell pointer. 

• TAB moves right one cell, ENTER confirms and moves down -- After you type data in a cell, pressing TAB confirms 
the cell entry and moves the cell pointer right to the next cell. Pressing ENTER confirms the cell entry and moves 
the cell pointer down to the next cell.

{button ,AL(`H_SETTING_TAB_AND_ENTER_KEY_BEHAVIOR_STEPS',1)} Go to procedure
{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



Changing the 1-2-3 Classic menu key
You can change the key you use to display the Classic menu. You can also turn off the display of the Classic menu.
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the Classic Keys tab in the dialog box.
3. Do one of the following:

• To change the Classic menu key, select a symbol from the "Display 1-2-3 Classic menu by pressing" list.
• To turn off display of the 1-2-3 Classic menu, deselect "Display 1-2-3 Classic menu by pressing."

4. Click OK.

{button ,AL(`H_DISPLAYING_THE_123_CLASSIC_MENU_DETAILS',1)} See details
{button ,AL(`H_123_PREFERENCES_OVER;H_SETTING_123_OPTIONS_STEPS;',0)} See related topics



Details: Changing the 1-2-3 Classic menu key
When the 1-2-3 Classic menu is turned off, pressing / (slash) or < (less-than symbol) enters the appropriate character
in the current cell; however, you can continue to use your keystroke macros.

Wysiwyg menu commands
You can't use any : (colon) commands to perform tasks in the current version of 1-2-3, except in keystroke macros. If 
you press : (colon) when 1-2-3 is in Ready mode, 1-2-3 enters a colon in the current cell.

{button ,AL(`H_DISPLAYING_THE_123_CLASSIC_MENU_STEPS',1)} Go to procedure
{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



1-2-3 Preferences dialog box (Classic Keys tab)

Use the Classic Keys tab to control how the TAB and ENTER keys work, and to control display of the 1-2-3 Classic 
menu.

Choose a task
Setting   TAB   and   ENTER   key behavior  
Changing the 1-2-3 Classic menu key

{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



1-2-3 Preferences dialog box (General tab)

The settings in the 1-2-3 Preferences dialog box (General tab) control the display and behavior of all new workbook 
files in current and future sessions of 1-2-3. These default settings take effect automatically whenever you start 1-2-3.

Choose a task
Setting 1-2-3 options 
Setting sorting options
Setting options for dates 

{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



1-2-3 Preferences dialog box (New Workbook Defaults tab)
Use the New Workbook Defaults tab to set default font, colors, column width, row height, and the file type for saving 
new files.
These defaults affect only subsequent new workbooks; to change current sheet defaults, select the sheet and choose
Sheet - Sheet Properties.

Choose a task
Setting a default font and colors for new workbooks
Setting column and row defaults for new workbooks
Setting a default 1-2-3 file type 

{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



1-2-3 and the year 2000
When you enter a date using only 2 digits to represent the year (for example, 4/2/05), 1-2-3 needs a way to interpret 
the date as being in either the 20th or the 21st century. By default, this version of 1-2-3 is using an 80/20 sliding 
window to interpret dates when you enter only 2 digits for the year.

What is a sliding window?
A sliding window is a time frame used to interpret dates that you enter with 2-digit years. All 2-digit years fall 
somewhere within a 100 year window that moves forward each year.
The 80/20 sliding window is split at the current year (determined by the system date on your computer) so the window
begins 80 years before the current year and ends 19 years after the current year. 
If the current year is 1999, the following example illustrates how the 80/20 window looks.

In 1999, all dates you enter with 2-digit years from 19 to 99 will equal 1919 to 1999. All dates you enter with years 00 
to 18 will equal 2000 to 2018. To enter a date that falls outside of this window (before 1919 or after 2018), you must 
enter a 4-digit year such as 2022.

Turning off the sliding window in 1-2-3
If you do not want 1-2-3 to use the 80/20 sliding window to interpret dates with 2-digit years, you can turn off this 
feature in the 1-2-3 Preferences dialog box. You can set 1-2-3 to always interpret these dates as being in the 20th 
century. See Setting options for dates. 

Changing the 80/20 sliding window setting
You can change the 80/20 default setting for SmartSuite by changing a setting in the Windows registry. For more 
information, see Lotus SmartSuite and the year 2000. 

Entering and displaying 4-digit years in dates
To make sure you get the results you want, you can enter and display dates with the year as 4 digits in 1-2-3. 
If you enter the year as 4 digits, 1-2-3 will always use the date you entered. If you display dates with the year as 4 
digits, you may need to make some adjustments in the sheet.

• You may need to widen columns that contain dates. If you display 4-digit years in dates (for example, 4/10/1922), 
1-2-3 will display asterisks (***) if the column is not wide enough to display the entire date. 

• You may also need to adjust print ranges to accommodate wider columns.

@Functions and dates
If you enter a 2-digit year in @DATE, 1-2-3 always interprets the year as falling in the 20th century (1900 to 1999).
By default, @functions that include text arguments to specify dates (for example, @DATEVALUE) use the sliding 
window setting to determine the century in which a 2-digit year falls.

Macros and scripts with the year 2000
If years are stored as separate values in a file and macros or scripts interpret the dates as they run, the sliding 
window rules will apply to those values when only 2 digits are stored for the year.

Dates in 1-2-3 97 and 1-2-3 for OS/2 Warp 4 
1-2-3 97 and 1-2-3 for OS/2 Warp 4 use a 49/50 fixed window to interpret dates you enter with 2-digit years. If you 
enter 00-49 for the year in a date, the date falls between the year 2000 and 2049. If you enter 50-99 for the year, the 
date falls between 1950 and 1999.

{button ,AL(`H_123_SETTING_OPTIONS_DATES_STEPS;H_ENTERING_DATES_STEPS;H_FUNC_DATE;H_FUN
C_DATEVALUE;',0)} See related topics





Setting options for dates
The date options let you control how 1-2-3 stores and displays a date if you enter only 2 digits for the year (for 
example, 5/11/08). 1-2-3 uses a sliding window to interpret whether the year falls in the 20th or 21st century. 
For more information, see 1-2-3 and the year 2000. 

To set options for dates,
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.
2. Click the General tab in the dialog box.
3. Under Dates, choose one of the following:

• (Default) Interpret entry of 2-digit years using sliding window around system date
• Interpret entry of 2-digit years as 20th century (1900 - 1999)

4. (Optional) Choose to always display 4-digit years in dates.
5. Click OK.

Notes
• To make sure you get the results you want, you can always enter and display the year as 4 digits. 
• Displaying dates with 4 digits for the year will make dates wider, so some dates may display as *** (asterisks). 

Widen the column to display the date instead of asterisks. You may also need to adjust some print ranges.
• You can display dates in a variety of formats that include 2-digit and 4-digit years. 

{button ,AL(`H_ENTERING_DATES_STEPS;H_FORMATTING_NUMBERS_STEPS;H_123_YEAR_2000_OVER;H_1
23_TROUBLESHOOTING_YEAR_2000_OVER;',0)} See related topics



Setting a default 1-2-3 file type
You can change the default file type 1-2-3 uses when you save a new file. 
1. From the File menu, choose User Setup, and then choose 1-2-3 Preferences.

2. Click the New Workbook Defaults tab in the dialog box.
3. Next to "Save as type:" choose the type of file you want 1-2-3 to use as the default. 
4. Click OK.
When you save a new file, 1-2-3 displays this type of file as the default in the Save As dialog box. 

{button ,AL(`H_123_PREFERENCES_OVER;',0)} See related topics



Workbook Properties dialog box (View tab)

Use the View tab to 
• Set defaults for showing and hiding elements of the workbook
• Set the custom zoom scale for the workbook
• Display a command on the View menu for designing and running ActiveX controls and JavaBeans 

For descriptions of specific settings, see Details: Setting view preferences for workbooks.

Choose a task
Setting view preferences for workbooks.
Setting the custom view scale
Hiding or showing sheet tabs

{button ,AL(`H_HIDING_SHEETS_STEPS;',0)} See related topics



Setting view preferences for workbooks
You can set view preferences for the current workbook and for subsequent new workbooks. For more information on 
specific settings, see Details: Setting view preferences for workbooks.
1. From the View menu, choose Set View Preferences.

2. Under Show in workbook, select the elements of the workbook you want to show; deselect the elements you want
to hide. 

3. To change the color of grid lines, select a color.
4. To display a command on the View menu for working with ActiveX controls and JavaBeans, click "Display menu 

command for designing ActiveX and Java controls."
5. To change the default display size of the sheet, click the arrows or enter a number in the "Custom zoom %" box.
6. (Optional) To specify these settings as the default settings, click Make Default for New Workbooks.

Note Clicking Make Default for New Workbooks does not affect the view settings in other existing workbooks, and
these settings do not apply to new workbooks you create using a SmartMaster template.

7. Click OK. 

{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_WORKBOOKS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_VIEW_SCALE_STEPS;H_SETTING_A_CUSTOM_VIEW_SCALE_STEPS;H_SET

TING_VIEW_PREFERENCES_FOR_A_SHEET_STEPS;H_HIDING_OR_SHOWING_TABS_STEPS;',0)} See 
related topics



Details: Setting view preferences for workbooks
Options: Workbook Properties dialog box (View tab)
Show in workbook

• Sheet frame -- Turns the sheet frame on or off. 
• Charts, maps, and drawings -- Determines whether graphic objects (charts, maps, drawings, text blocks, buttons, 

pictures, and embedded objects) are hidden. Hidden graphic objects do not print.
Note To display but not print graphic objects, use File - Preview & Page Setup (Include tab).

• Formula markers -- Determines whether formula markers are shown in cells containing formulas. 
• Cell comment markers -- Determines whether cell comment markers are displayed in cells containing comments. 
• Version names and borders -- Determines whether version borders and names are displayed. Deselecting this 

option removes any names and borders currently displayed and sets the default option for new versions to not 
display names and borders. You can redisplay the names and borders of individual versioned ranges by using 
Range - Version - Version Properties.

• Datalink table borders -- Displays or hides borders for all datalink tables in the current file.
• Grid lines -- Determines whether grid lines are displayed for all sheets in the current workbook, and sets the color 

of grid lines. The default color for grid lines is 25% gray.
Note Workbook view preferences for the sheet frame, grid lines, and graphic objects can be changed for an 
individual sheet by using Sheet - Sheet Properties (View tab).

• Sheet tabs -- Determines whether sheet tabs and the New Sheet button are displayed in the current workbook. 
• Scroll bars -- Determines whether scroll bars are displayed in the current workbook. 
• Manual page breaks -- Determines whether page breaks you set are displayed in the current workbook. 
• Automatic page breaks -- Determines whether print range borders and page breaks set by 1-2-3 are displayed in 

the current workbook. 
Note Even if page breaks are not displayed, 1-2-3 prints according to the page breaks.

Display menu command for designing ActiveX and Java controls
Displays or hides a command on the View menu for designing and running custom applications using ActiveX 
controls and JavaBeans.

Custom zoom % 
Sets the custom view scale that appears on the Zoom to Custom Level command on the View menu. The default 
custom zoom scale is 87%.

Make Default for New Workbooks 
Saves these settings as the default settings for all new workbooks.

1-2-3 saves these settings when you click OK in the Workbook Properties dialog box.
Note These defaults do not apply to workbooks created using a SmartMaster template. 

{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_WORKBOOKS_STEPS',1)} Go to procedure



Setting view preferences for a sheet
View preferences for a sheet override the corresponding view preferences you set for the workbook using View - Set 
View Preferences.
1. From the Sheet menu, choose Sheet Properties.

2. Click the View tab in the InfoBox.

3. Under Show in sheet, select one or more options.
4. To change the color of grid lines, select a color.
5. (Optional) To reset the view preferences in the selected sheet(s) to the workbook defaults, click Reset To 

Workbook Defaults.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_VIEW_SCALE_STEPS;H_SETTING_A_CUSTOM_VIEW_SCALE_STEPS;H_HIDI

NG_OR_SHOWING_TABS_STEPS;H_SETTING_VIEW_PREFERENCES_FOR_WORKBOOKS_STEPS;',0)} 
See related topics



Details: Setting view preferences for a sheet
Options: Sheet InfoBox (View tab)

• Sheet frame -- Turns the sheet frame on or off. 
• Grid lines -- Determines whether grid lines are displayed in the current sheet, and sets the color of grid lines. The 

default color for grid lines is 25% gray.
• Charts, maps, and drawings -- Determines whether graphic objects (charts, maps, drawings, text blocks, buttons, 

pictures, and embedded objects) are displayed in the sheet. Hidden graphic objects do not print.
Note To display but not print graphic objects, use File - Preview & Page Setup (Include tab).

• Reset To Workbook Defaults -- Returns view preferences for the sheet to the workbook defaults specified with 
View - Set View Preferences (View tab).

Related SmartIcons

 Changes view preferences for the current workbook

{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_A_SHEET_STEPS',1)} Go to procedure



Changing the view scale
When you change the view scale, the display size changes for all sheets in the current workbook. 
1. To change the view to a preset scale, choose View - Zoom to, and then select the percentage.
2. To change to the custom view scale, choose View - Zoom to Custom Level.
Note  To set the custom view scale, use View - Set View Preferences. The default custom view scale is 87%.

{button ,AL(`H_CHANGING_THE_VIEW_SCALE_DETAILS',1)} See details
{button ,AL(`H_SETTING_A_CUSTOM_VIEW_SCALE_STEPS;H_SETTING_VIEW_PREFERENCES_FOR_A_SHE

ET_STEPS;',0)} See related topics



Details: Changing the view scale
Related SmartIcons

Displays the sheet at the custom view size

Displays the sheet at 25% of full size

Displays the sheet at 50% of full size

Displays the sheet at 75% of full size

Displays the sheet at 100% of full size

Displays the sheet at 200% of full size

{button ,AL(`H_CHANGING_THE_VIEW_SCALE_STEPS',1)} Go to procedure



Setting the custom view scale
The custom view scale is the zoom percentage 1-2-3 uses when you choose View - Zoom to Custom Level.
1. From the View menu, choose Set View Preferences.

2. Click the arrows or enter a number in the "Custom zoom %" box.
The default custom view scale is 87%.

3. (Optional) Click Make Default for New Workbooks to make the zoom percentage the default for all workbooks 
created without using a SmartMaster.

4. Click OK.

{button ,AL(`H_CHANGING_THE_VIEW_SCALE_STEPS;H_SETTING_A_CUSTOM_VIEW_SCALE_STEPS;H_SET
TING_VIEW_PREFERENCES_FOR_A_SHEET_STEPS;',0)} See related topics



Overview: Sheet defaults
You can change default settings for sheets using the InfoBox.

To set defaults for more than one sheet at a time, you can select multiple sheets, or group sheets together. 

Setting sheet defaults
You can control the default settings listed below for the selected sheet.

Text styles
Sets font name, size, attribute, and color for text and numbers in the selected sheet.

Alignment
Sets horizontal and vertical alignment for contents of all cells in the selected sheet. You can also set all text to wrap in
cells.

Number format
Sets the display for numbers in the selected sheet. You can select from format categories, such as date, time, and 
currency. You can also promote frequently used formats to the status bar.

Cell colors
Add a pattern, pattern color, background color, and text color to the selected sheet. You can also set negative values 
to display in red.

Basic settings
Sets selected sheet name, tab color, default column width, and default row height; and lets you hide and lock the 
selected sheet.

View preferences
Sets the display of the sheet frame, grid lines, and graphic objects. Lets you reset all settings to the workbook 
defaults. 

Outline settings
Sets the orientation for an outline and the outline frame display for the selected sheet.

Overriding sheet defaults
You can override sheet defaults with local settings by using the status bar or the InfoBox to change font name, size, 
color, alignment, or number format of individual ranges, and the size of individual columns and rows. These local 
settings are saved with the sheet. You can't override view preferences or outline settings.
Tip To switch between setting sheet defaults and styling ranges, use the "Properties for" box in the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_ROW_HEIGHT_FOR_A_SHEET_STEPS;H_GROUPING_SHEETS_STEPS;
H_SETTING_A_DEFAULT_COLUMN_WIDTH_FOR_A_SHEET_STEPS;H_SETTING_A_DEFAULT_FONT_FOR
_A_SHEET_STEPS;H_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS;H_SETTING_A_DEFAULT_TEXT_
ALIGNMENT_STEPS;H_SETTING_DEFAULT_CELL_COLORS_AND_PATTERNS_STEPS;H_SETTING_OUTLI
NE_PROPERTIES_STEPS;H_SETTING_VIEW_PREFERENCES_FOR_A_SHEET_STEPS;',0)} See related 
topics



Setting a default font for a sheet
1. Choose Sheet - Sheet Properties.

2. Click the Text Format tab in the InfoBox.

3. Select a font, point size, attribute, and color.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_FONT_FOR_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_OVERVIEW_SHEET_DEFAULTS_OVER;H_SETTING_A_DEFAULT_TEXT_ALIGNMENT_STEPS;H

_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS;H_SETTING_A_DEFAULT_FONT_FOR_ALL_WORKBO
OKS_STEPS;H_SELECTING_SHEETS_STEPS;H_SETTING_A_DEFAULT_ROW_HEIGHT_FOR_A_SHEET_ST
EPS;',0)} See related topics



Details: Setting a default font for a sheet
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_A_DEFAULT_FONT_FOR_A_SHEET_STEPS',1)} Go to procedure



Setting a default alignment for a sheet
1. Choose Sheet - Sheet Properties.

2. Click the Alignment tab in the InfoBox.

3. Select a horizontal alignment.
4. Select a vertical alignment.

Note Data appears vertically aligned in a cell only when the row is taller than the cell contents.
5. To wrap text, select "Wrap text in cell."
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_TEXT_ALIGNMENT_DETAILS',1)} See details
{button ,AL(`H_SHEET_DEFAULTS_OVER;H_SETTING_A_DEFAULT_FONT_FOR_A_SHEET_STEPS;H_SELECTI

NG_SHEETS_STEPS;H_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS;',0)} See related topics



Details: Setting a default alignment for a sheet
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_A_DEFAULT_TEXT_ALIGNMENT_STEPS',1)} Go to procedure



Setting a default number format for a sheet
Changing the number format affects only how 1-2-3 displays numbers, not how 1-2-3 stores or calculates with the 
numbers.
1. Choose Sheet - Sheet Properties.

2. Click the Number Format tab in the InfoBox.

3. Select a format category.
4. Select a format from the "Current format" list.
5. (Optional) To promote a number format to the status bar, select "Show in Frequently Used list."
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_NUMBER_FORMAT_DETAILS',1)} See details
{button ,AL(`H_SHEET_DEFAULTS_OVER;H_SETTING_A_DEFAULT_FONT_FOR_A_SHEET_STEPS;H_SETTIN

G_A_DEFAULT_ALIGNMENT_STEPS;H_SELECTING_SHEETS_STEPS;H_CHANGING_THE_CURRENCY_SY
MBOL_STEPS;H_NUMBER_FORMATS_OVER;',0)} See related topics



Details: Setting a default number format for a sheet
Promoting a number format
Selecting "Show in Frequently Used list" promotes a format so that it appears when you click the Number format 
button in the status bar.

Displaying negative values in red
You can display negative values in red, for example, to show a debit. To display negative values in red for a selected 
range, use Range - Range Properties (Lines & Color tab).

Displaying zeros
If you deselect "Display zeros as," cells containing zeros appear blank. To change how zeros are displayed, enter a 
character in the "Display zeros as" box.

Displaying parentheses
Selecting "Parentheses" encloses all numbers in the sheet in parentheses, except numbers formatted as dates, 
times, or text.

Effect of column width on numbers
If you format a number and 1-2-3 fills the cell with *** (asterisks) or displays Scientific format, the column is not wide 
enough to display the number using the format you selected. To display the number, widen the column to one 
character wider than the length of the formatted number.

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS',1)} Go to procedure



Setting default colors and pattern for a sheet
You can set a default pattern, pattern color, background color, and text color.
1. Choose Sheet - Sheet Properties.

2. Click the Lines & Colors tab in the InfoBox.

3. Select a pattern and a pattern color.
4. Select a text color and a background color.
5. (Optional) Select "Negative values in red."
6. (Optional) Select "Use Windows default colors for text and background."
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_DEFAULT_CELL_COLORS_AND_PATTERNS_DETAILS',1)} See details
{button ,AL(`H_SHEET_DEFAULTS_OVER;H_SETTING_A_DEFAULT_TEXT_ALIGNMENT_STEPS;H_SETTING_A

_DEFAULT_NUMBER_FORMAT_STEPS;H_SELECTING_SHEETS_STEPS;H_SETTING_A_DEFAULT_FONT_F
OR_A_SHEET_STEPS;',0)} See related topics



Details: Setting default colors and patterns for a sheet
Selecting pattern and color options
You can change colors and patterns for all cells in a sheet. For more information on these settings, see Details: 
Changing interior color and pattern. 

Displaying negative values in red
You can display negative values in red, for example, to show a debit. To display negative values in red for a selected 
range, use Range - Range Properties (Lines & Color tab).

Using Windows defaults for text and background colors
When you select this option, 1-2-3 uses the text and background colors specified in the Windows Control Panel. For 
more information, see your Windows documentation.

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_DEFAULT_CELL_COLORS_AND_PATTERNS_STEPS',1)} Go to procedure



Setting a default column width for a sheet
1. Choose Sheet - Sheet Properties.

2. Click the Basics tab in the InfoBox.

3. Click the arrows or enter a number in the "Default column width" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_COLUMN_WIDTH_FOR_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_SHEET_DEFAULTS_OVER;H_SELECTING_SHEETS_STEPS;H_SETTING_VIEW_PREFERENCES

_FOR_A_SHEET_STEPS;H_SETTING_COLUMN_AND_ROW_DEFAULTS_FOR_ALL_WORKBOOKS_STEPS;',
0)} See related topics



Details: Setting a default column width for a sheet
Setting the column width in characters
1-2-3 sizes columns in whole-character increments from 1 to 240 characters. 

Effect of column width on values
When a column is too narrow to display an entire value as it is formatted, 1-2-3 fills the cell with *** (asterisks) or 
displays Scientific format instead of the value. To display the value, widen the column to one character wider than the 
length of the value as formatted.

Effect of column width on labels
If a label is longer than the cell it occupies and the cells to the right are blank, 1-2-3 displays the label across the 
blank cells. If the cells to the right contain data, 1-2-3 displays only the part of the label that fits in the cell where it is 
entered. To see the complete label you must widen the column or wrap the text in the cell. The reverse is also true 
when labels are right-aligned.
For more information see Sizing columns and Wrapping data in a cell.

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_A_DEFAULT_COLUMN_WIDTH_FOR_A_SHEET_STEPS',1)} Go to procedure



Setting a default row height for a sheet
1. Choose Sheet - Sheet Properties.

2. Click the Basics tab in the InfoBox.

3. To set the default row height in points, click the arrows or enter a number in the "Default row height" box.
4. To make the default row height fit the default font size, select "Fit default font."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SETTING_A_DEFAULT_ROW_HEIGHT_FOR_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_SHEET_DEFAULTS_OVER;H_SELECTING_SHEETS_STEPS;H_SETTING_VIEW_PREFERENCES

_FOR_A_SHEET_STEPS;H_SETTING_COLUMN_AND_ROW_DEFAULTS_FOR_ALL_WORKBOOKS_STEPS;',
0)} See related topics



Details: Setting a default row height for a sheet
1-2-3 accommodates the largest font entered in a row
As long as all text in a row is the same as, or smaller than, the default sheet row height, the row will remain at the 
default height. If you make any text in the row taller than the default, then the row height expands to accommodate it. 

Default row height and "Fit default font"
When you select "Fit default font," the default row height is based on the size of the default font. If the default font 
size is larger than the default row height setting, then all rows will resize to fit the default font or the largest font 
currently entered in the row. You can override the default row height at any time by sizing the row.

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

{button ,AL(`H_SETTING_A_DEFAULT_ROW_HEIGHT_FOR_A_SHEET_STEPS',1)} Go to procedure



Deleting graphic objects
You can delete drawings such as lines, arrows, rectangles, and ellipses. You can also delete charts, maps, text 
blocks, pictures, buttons, and embedded objects.
1. Select one or more object(s).
2. Choose Edit - Clear.

Tip You can also select the object(s) and press DEL.

{button ,AL(`H_DELETING_OBJECTS_DETAILS',1)} See details
{button ,AL(`H_DELETING_DATA_IN_RANGES_STEPS;H_DELETING_OBJECTS_STEPS;H_USING_DRAGANDC

LEAR_TO_DELETE_DATA_STEPS',0)} See related topics



Details: Deleting graphic objects
When you use Edit - Clear to delete data, 1-2-3 does not place the data on the Clipboard. As a result, you can't paste 
data that you have deleted using Edit - Clear. To restore the data to the same location, immediately use Edit - Undo. 
To clear data and paste it, use Edit - Cut and Edit - Paste.

Troubleshooting
You can't delete a locked graphic object. You can tell if an object is locked by its handles; the handles of a locked 
object are diamond-shaped rather than square. For more information, see Overview: Protecting data.

{button ,AL(`H_DELETING_OBJECTS_STEPS',1)} Go to procedure



Deleting data in ranges
You can delete the contents, styles, cell comments, borders, designer frames, and scripts associated with a range.
1. Select the range, collection, column or row.
2. Choose Edit - Clear.

3. Select the options you want to delete.
4. Click OK.

{button ,AL(`H_DELETING_DATA_IN_RANGES_DETAILS',1)} See details
{button ,AL(`H_DELETING_DATA_IN_RANGES_STEPS;H_DELETING_OBJECTS_STEPS;H_USING_DRAGANDC

LEAR_TO_DELETE_DATA_STEPS',0)} See related topics



Details: Deleting data in ranges
When you use Edit - Clear to delete data, 1-2-3 does not place the data on the Clipboard. As a result, you can't paste 
data that you have deleted using Edit - Clear. To restore the data to the same location, immediately use Edit - Undo. 
To clear data and paste it, use Edit - Cut and Edit - Paste.

Other ways to delete data
Instead of choosing Edit - Clear to delete cell contents, you can select the data, then press DEL. Doing so removes 
only cell contents and leaves styles, scripts, and cell comments intact. To delete a designer frame or range border, 
the range you delete must include the entire frame or border.
Note You can also right-click the cell and choose Clear.

Options for deleting
• Contents -- Deletes only the cell contents, leaving all styles intact.
• Styles and number format -- Leaves the cell contents intact and removes number formats, text attributes, 

alignment, background colors and patterns, and named styles. Also changes unprotected cells to protected.
• Borders and designer frames -- Removes borders, and designer frames if the range includes the whole frame.
• Cell comments -- Deletes cell comments.
• Script -- Deletes any scripts associated with the selected range.

Data you can't clear
You can't use Edit - Clear to delete protected data in a locked file, or a mixed range of protected and unprotected 
data. If you select a range or collection in which some of the data is protected, Edit - Clear will not clear any of the 
data. 

How deleting affects formulas
If you delete a value that a formula refers to, some formulas will results in ERR. Any formulas that depend on this 
invalid formula also result in ERR.

Related SmartIcons

Deletes only the styles from a selected range

Deletes the contents in a selected range and copies them to the Clipboard

Pastes cell contents

Pastes cell styles

Cancels the last command or action

{button ,AL(`H_DELETING_DATA_IN_RANGES_STEPS',1)} Go to procedure



Deleting data by dragging
You can use the mouse to delete data in a selected range, except for the top left cell. Drag and clear deletes the 
contents and styles, but not the cell comments, borders, designer frames, and scripts associated with any cell or 
range.

 Show me a QuickDemo
1. Select the range you want to clear.
2. Position the mouse pointer at the bottom right corner of the range until the pointer displays four arrowheads.

3. Hold down the left mouse button and drag up and to the left to delete data in the range. 
The pointer changes to look like this:

4. Release the mouse button.
5. (Optional) To delete the top left cell of the range, press DEL.

{button ,AL(`H_USING_DRAGANDCLEAR_TO_DELETE_DATA_DETAILS',1)} See details
{button ,AL(`H_DELETING_DATA_IN_RANGES_STEPS;H_DELETING_OBJECTS_STEPS;',0)} See related topics



Details: Deleting data by dragging
When you use drag and clear to delete data, you can't delete the contents of the top left cell of the range. You can 
only use drag and clear to clear ranges; you can't use it to clear a 3D range, a collection, or a graphic object.
To delete the contents in a selected range without clearing the styles, use Edit - Clear or press DEL. 
Note You can also right-click the cell and choose Clear.
Like Edit - Clear, drag and clear doesn't use the Clipboard or clear protected cells. As a result, you can't paste data 
that you have deleted using drag and clear. To restore the data to the same location, immediately use Edit - Undo. To 
clear data and paste it, use Edit - Cut and Edit - Paste.

Related SmartIcons

Lets you choose what to delete from a selected range

Deletes only the styles from a selected range

Deletes the contents in a selected range and copies them to the Clipboard

Pastes cell contents

Pastes cell styles

Cancels the last command or action

{button ,AL(`H_USING_DRAGANDCLEAR_TO_DELETE_DATA_STEPS',1)} Go to procedure



Deleting styles
You can remove the styles from a range without deleting the contents.
1. Select the range, collection, column, or row.
2. Choose Edit - Clear Styles.

1-2-3 removes all styles associated with the range you selected.

{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_DETAILS',1)} See details
{button ,AL(`H_CHANGING_TEXT_FORMAT_STEPS;H_REMOVING_NAMED_STYLES_STEPS;',0)} See related 

topics



Details: Deleting styles
Other ways to delete styles 
Select the range or collection, choose Edit - Clear, and select one or more of these options:
Note You can also right-click the cell and choose Clear.

• Styles and number formats -- Leaves the cell contents intact and removes number formats, text attributes, 
alignment, background colors and patterns, and named styles. Also changes unprotected cells to protected.

• Borders and designer frames -- Removes borders, and designer frames if the range includes the whole frame.

Related SmartIcons

Removes bold, italics, and underlining from the selection

Changes the font, color, and attributes of data in ranges

{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_STEPS',1)} Go to procedure



Choosing a file
Use this dialog box to find and select the file you want.
1. Select the computer, drive, and directory where the file resides.
2. Select the file name from the list.
3. Click OK.

{button ,AL(`H_123_CHOOSE_FILE_DETAILS',1)} See details



Details: Choosing a file
Dialog box options
Look in

Displays the current directory and shows where it fits in the hierarchy on your computer. Below it is a list of the 
directories and files in the selected location. The files listed match the type selected from the "Files of type" list. 
If the file you want resides on a network server or other remote computer, double-click Network Neighborhood, 
then double-click Entire Network to be sure you have access to the file location.

File name
Lets you select a file from the list or enter a path and file name containing a combined total of up to 259 
characters. 

Files of type
Lists the types of files you can open. 

Open
Opens the specified file.

{button ,AL(`H_123_CHOOSE_FILE_STEPS',1)} Go to procedure



Details: Browsing through files
Options: Browse dialog box
Look in

Displays the current directory and shows where it fits in the hierarchy on your computer. Below it is a list of the 
directories and files in the selected location. The files listed match the type selected from the "Files of type" list. 
If the file you want resides on a network server or other remote computer, double-click Network Neighborhood, 
then double-click Entire Network to be sure you have access to the file location. 

File name
Lets you select a file from the list or enter a path and file name containing a combined total of up to 259 
characters. 

Files of type
Lists the types of files you can open. 

Title
Displays the title of the selected SmartMaster. The "Title" box appears in the Browse dialog box only after you 
click More SmartMaster Templates in either the New Workbook dialog box or the Welcome to 1-2-3 dialog box.

Open
Opens the specified file.

{button ,AL(`H_BROWSING_FILES_STEPS',1)} Go to procedure



Browsing through files
Use the Browse dialog box to find and select the file you want.
1. Select the computer, drive, and directory where the file resides.
2. Select the file name from the list.
3. Click Open.

{button ,AL(`H_BROWSING_FILES_DETAILS',1)} See details



Details: Combining data from different files
Types of files you can combine with a workbook
You can combine data, number formats, and style information from these file types with the current workbook:

• dBASE (.DBF)
• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Paradox (.DB)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)

{button ,AL(`H_COMBINING_DATA_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_OPEN_FILE_REF',0)} See related topics



Combining data from different files
When you combine data from a file on disk with data in the current workbook, 1-2-3 changes data in the current sheet
beginning at the current cell. 
1. (Optional) Save the workbook before you combine data with it in case you don't like the results.
2. Select the cell where you want to begin combining data.
3. From the File menu, choose Open.

4. Select the file type of the file containing the data you want to combine.
5. Select the computer, drive, and directory where the file containing the data you want to combine resides.
6. Select the file name from the list.
7. Select "Combine with current workbook."
8. Click Combine.

If you selected a workbook file, specify the options for combining data in the Combine 1-2-3 File dialog box. 
If you selected a text file, specify the text file format in the Text File Options dialog box. 

{button ,AL(`H_COMBINING_DATA_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_IMPORTING_A_PICTURE_STEPS;H_OPTIONS_OP

EN_FILE_REF;H_SPECIFYING_A_FILE_OVER',0)} See related topics



Overview: Creating and opening files
When you start 1-2-3, the Welcome to 1-2-3 dialog box lets you choose whether to create a new workbook file or 
open an existing file. Once you're working in 1-2-3, you use File - New Workbook to create a new workbook file and 
File - Open to open existing files.
Note If you don't want to see the Welcome to 1-2-3 dialog box each time you start 1-2-3, use File - User Setup - 1-2-
3 Preferences (General tab) to turn it off.

Creating new files
1-2-3 files are called workbooks. Each workbook contains one or more sheets in which you can enter, calculate, and 
analyze data. When you create a new workbook, you can either start with a blank workbook to build a spreadsheet 
from scratch or select a SmartMaster template to streamline your work.

 See related topics

Using SmartMaster templates
1-2-3 comes with a variety of SmartMaster templates for common business and financial tasks such as creating 
budgets, expense reports, sales plans, and so on. Each template has built-in formulas, scripts, and formatting to give 
you a quick start on creating effective spreadsheets.

You can also customize existing SmartMaster templates or create your own SmartMaster templates.

 See related topics

Working with existing files
The default file type in the current release of 1-2-3 is .123. You can open these file types:

• dBASE (.DBF)
• HTML File (.HTM*)
• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Microsoft Excel (.XLS, .XLT, .XLW)
• Paradox (.DB)
• Quattro Pro (.WQ1, .WB1, .WB2)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)

In addition, you can combine data or graphics from these file types with the current workbook:
• ANSI Metafile (.CGM)
• Bitmap (.BMP)
• dBASE (.DBF)
• GIF Image (.GIF)
• JPEG Image (.JPG, .JPEG)
• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Lotus 1-2-3 PIC (.PIC)
• Paradox (.DB)



• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)
• Windows Metafile (.WMF)

You can open and view more than one file at the same time. However, you can work in only one file at a time.
Use the Window menu commands to arrange open files or to create extra windows to view different parts of the same
file.

 See related topics



Creating a blank workbook
When you create a new workbook, 1-2-3 places it in a window and puts the cell pointer in cell A1.
1. From the File menu, choose New Workbook.

2. Click Create a Blank Workbook. 
Note To keep a copy of the new workbook on disk, you must save the workbook before you close it or end the 1-2-3 
session. 

{button ,AL(`H_CREATING_A_BLANK_WORKBOOK_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_CREATING_A_WORKBOOK_USING_A_SMARTMA

STER_STEPS;H_SAVING_A_NEW_WORKBOOK_STEPS',0)} See related topics



Details: Creating a blank workbook
Naming new workbooks
1-2-3 supplies a temporary name. The first workbook name is Untitled. 1-2-3 refers to subsequent workbooks as 
Untitled1, Untitled2, and so on. When you save a new workbook, you must enter a file name in the Save As dialog 
box.

Creating blank workbooks quickly
To create workbooks quickly, turn off the New Workbook dialog box. Then, 1-2-3 simply creates a blank workbook 
whenever you choose File - New Workbook. To turn off the New Workbook dialog box, use File - User Setup - 1-2-3 
Preferences (General tab).

Related SmartIcons

Creates a blank workbook without displaying the New Workbook dialog box.

{button ,AL(`H_CREATING_A_BLANK_WORKBOOK_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_123_OPTIONS_STEPS;H_SAVING_A_NEW_WORKBOOK_STEPS',0)} See related 

topics



Creating a SmartMaster template
In addition to using the SmartMaster templates that come with 1-2-3, you can create your own templates by basing 
them on a starter template (SHELL.12M). 
1. From the File menu, choose New Workbook.

2. Double-click "Create your own SmartMaster."
3. Add a title and description. 

Note Assigning a title to the template will let you identify your SmartMaster in the New Workbook dialog box 
during future 1-2-3 sessions. Otherwise, the dialog box lists the template as [No Title].

4. After you have modified the template file, choose File - Save As. 

5. Specify the SmartMaster templates directory as the location where you want to save the template.
Tip If you don't know the directory location, click Cancel, and then choose File - User Setup - 1-2-3 Preferences 
(File Locations tab) to check.

6. Enter a name in the "File name" box.
7. Select "Lotus 1-2-3 9 SmartMaster (12M)" from the "Save as type" list.
8. Click Save.
Note You cannot use File - Save As to create a SmartMaster template for use in 1-2-3 97. To save a file as a 1-2-3 
97 SmartMaster template, first save the file as a Lotus 1-2-3 97 Workbook, and then change the file extension 
from .123 to .12M.

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_CREATING_A_WORKBOOK_USING_A_SMARTMA
STER_STEPS;H_WORKING_WITH_SMARTMASTER_TEMPLATES_OVER',0)} See related topics



Creating a workbook using a SmartMaster
Use SmartMaster templates to streamline tasks such as creating budgets and expense reports.
1. From the File menu, choose New Workbook.

2. Double-click the SmartMaster you want to use. 
3. (Optional) To browse through other directories to find a SmartMaster that is not on the list, click More 

SmartMaster Templates.
Note To keep a copy of the new workbook on disk, you must save the workbook before you close it or end the 1-2-3 
session.

{button ,AL(`H_CREATING_A_WORKBOOK_USING_A_SMARTMASTER_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_CREATING_A_BLANK_WORKBOOK_STEPS;H_SA

VING_A_NEW_WORKBOOK_STEPS;H_WORKING_WITH_SMARTMASTER_TEMPLATES_OVER',0)} See 
related topics



Details: Creating a workbook using a SmartMaster
SmartMaster templates
In the current release of 1-2-3, SmartMaster templates have a .12M file extension and contain scripts. In 1-2-3 
Release 5 for Windows, SmartMaster templates have a .WT4 extension and contain macros.
The New Workbook dialog box lists titles of .12M SmartMaster templates only. To list a .WT4 SmartMaster template 
here, first choose File - Open to open the .WT4 file and then use File - Save As to save it as a .12M SmartMaster 
template. Be sure to save the .12M file in the specified SmartMaster templates directory.
Note Before you create a workbook using a .WT4 template that you saved as a .12M template, make sure that "Run 
file Opened scripts, autoexecute macros" in File - User Setup - 1-2-3 Preferences (General tab) is selected.
You cannot create a workbook using a SmartMaster that's currently open.

Changing the default location for templates
When you install 1-2-3, 1-2-3 puts the SmartMaster templates in the \lotus\smasters\123 directory. If you create a 
workbook by selecting a SmartMaster from a different directory, 1-2-3 makes that directory the default SmartMaster 
directory for the current 1-2-3 session.
To change the default location for SmartMaster templates for subsequent 1-2-3 sessions, use File - User Setup - 1-2-
3 Preferences (File Locations tab).

Naming workbooks
1-2-3 supplies a temporary name. The first workbook name is Untitled. 1-2-3 refers to subsequent workbooks as 
Untitled1, Untitled2, and so on. When you save a new workbook, you must enter a file name in the Save As dialog 
box.

{button ,AL(`H_CREATING_A_WORKBOOK_USING_A_SMARTMASTER_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_FILE_LOCATIONS_STEPS;H_SAVING_A_NEW_WORKBOOK_STEPS',0)} See related 

topics



Importing a picture
You can import a picture stored in a graphics file and add it to the current workbook. 
1. From the File menu, choose Open.

2. Select the type of graphics file you want.
3. Select the computer, drive, and directory where the file resides.
4. Select the file name from the list.
5. Click Combine.
6. Click the place in the sheet where you want to put the top left corner of the picture.
Tip You can also import a picture by copying it to the Clipboard and pasting it in the sheet.

{button ,AL(`H_IMPORTING_A_PICTURE_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_COMBINING_DATA_STEPS;H_OPTIONS_OPEN_FI

LE_REF;H_SPECIFYING_A_FILE_OVER',0)} See related topics



Details: Importing a picture
Types of graphic files you can import
You can import pictures stored in these file types into the current workbook:

• ANSI Metafile (.CGM)
• Bitmap (.BMP)
• GIF Image (.GIF)
• JPEG Image (.JPG, .JPEG)
• Lotus 1-2-3 PIC (.PIC)
• Windows Metafile (.WMF)

Sizing pictures
An imported picture retains the dimensions stored in the original graphics file.
You can drag a handle to change the size of a picture. However, sizing may distort the proportions of the picture. The 
size information in the original graphics file does not change when you size the picture in the sheet.
Tip If you change a picture's size and then don't like the result, select the picture and then choose Drawing - Restore 
to Original Size.

Attaching a LotusScript Click event to a picture
You can attach a LotusScript Click event to a picture. When you click the picture, 1-2-3 runs the script that is attached
to the picture. To attach a Click event to a picture, use File - Open to import the picture into the workbook. Then open 
the Script Editor, select the name of the picture from the "Object" list, and enter the script. For more information about
LotusScript, see Overview: Using LotusScript or 1-2-3: Click event. 

Attaching a hyperlink to a picture
You can also attach a hyperlink to a picture, and choose whether you want the hyperlink to jump to a location on the 
Internet, to another file, or to a range or object in the current workbook. For more information, see Creating a 
hyperlink. 

{button ,AL(`H_IMPORTING_A_PICTURE_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_OPEN_FILE_REF',0)} See related topics



New Workbook dialog box
Use this dialog box to create either a new workbook or a SmartMaster template.

Choose a task
Creating a blank workbook 
Creating a workbook using a SmartMaster 
Creating a SmartMaster template

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_WORKING_WITH_SMARTMASTER_TEMPLATES_
OVER',0)} See related topics



Details: Opening an existing file
Types of files you can open
You can open these file types in 1-2-3:

• dBASE (.DBF)
• HTML File (.HTM*)
• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Microsoft Excel (.XLS, .XLT, .XLW)
• Paradox (.DB)
• Quattro Pro (.WQ1, .WB1, .WB2)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)

Depending on your computer's available memory, you can have up to 256 sheets open at once. 

Opening multiple files
You can select up to 32 files at a time to open in the Open dialog box. The files must be located in the same directory.

Running Opened events and autoexecute macros
1-2-3 runs all Opened events and autoexecute macros when you simultaneously open multiple workbooks that 
contain them.
If a workbook contains both an Opened event and an autoexecute macro, it is recommended that you either convert 
the autoexecute macro to an Opened-event script, or embed the macro in the Opened-event script. 
If you don't want 1-2-3 to automatically run Opened events and autoexecute macros when you open workbooks that 
contain them, use File - User Setup - 1-2-3 Preferences (General tab) to turn off "Run file Opened scripts, 
autoexecute macros."

Recalculation settings and formulas
When you open a workbook, 1-2-3 uses the recalculation settings stored in that workbook for all active workbooks. 
These settings remain in effect until you either open another workbook that has different recalculation settings or end 
the 1-2-3 session.
If you open a workbook in which recalculation is set to Automatic, 1-2-3 automatically updates formulas in that 
workbook whenever you change the data they refer to. 
If recalculation is set to Manual in the workbook, 1-2-3 recalculates formulas only when you press F9 (CALC) or click 
the Calc button in the status bar.
The recalculation settings apply only to formulas that refer to data in active workbooks. To update formulas that link to
files on disk, use Edit - Manage Links.

Updating links
When you open a workbook that contains links either to other workbooks or to other Windows applications, 1-2-3 
automatically updates the links. If you don't want 1-2-3 to update the links, use File - 1-2-3 Preferences (General tab) 
to turn off "Update links when opening workbooks."

Opening HTML files
You can open HTML files that contain table data inside <table> and <pre> tags. 1-2-3 treats the file as a new 
workbook and assigns a temporary name. The first workbook name is Untitled. 1-2-3 refers to subsequent workbooks
as Untitled1, Untitled2, and so on. A hyperlink to the source file appears at the top of the sheet, with the table data 
below.

Opening Excel files
If you open an Excel file that contains untranslatable functions or links to other Excel files, 1-2-3 records the 
information in a log file.

Opening a read-only or reserved file
When you open either a read-only file or a file for which someone else has the reservation, 1-2-3 displays "(Read 
Only)" in front of the file name in the title bar. 
If the file attribute is set to read-only by the operating system, you cannot save changes to the file under its current 
name. To save any changes to the file, you must save it under a different file name.
If you open a read-only copy of a file either by selecting "Open as read only" in the Open dialog box or by opening a 



file without its reservation, you can subsequently get the reservation (if it is available) and then save changes to the 
file under its current name. 

Opening a file automatically when you start 1-2-3
There are several ways you can make 1-2-3 always open a particular file each time you start 1-2-3:

• Use File - User Setup - 1-2-3 Preferences (File Locations tab) to specify a directory from which you want 1-2-3 to 
automatically open files. 
If you created a file called AUTO123.WK4 for use in 1-2-3 Release 5 for Windows and want to continue opening 
the file automatically each time you start the current release of 1-2-3, put AUTO123.WK4 in the above specified 
directory. 

Include the path and file name in the command line used to run 1-2-3. For example:
C:\LOTUS\123\PROGRAMS\123W.EXE C:\LOTUS\123\MYFILE.123

• Include the -w parameter and the path and file name in the command line used to run 1-2-3. For example:
C:\LOTUS\123\PROGRAMS\123W.EXE -W C:\LOTUS\123\MYFILE.123
If the file name contains either spaces or dashes, put single or double quotation marks around the path and file 
name. For example: C:\LOTUS\123\PROGRAMS\123W.EXE -W "C:\LOTUS\123\MY FILE.123"

Related SmartIcons

Opens a file from the Internet.

{button ,AL(`H_OPENING_AN_EXISTING_FILE_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_STEPS;H_OPTIONS_OPEN_FILE_REF;H_CREATING_

AN_AUTOEXECUTE_MACRO_STEPS;H_WORKING_WITH_123_FILES_OVER;H_123_WORKING_WITH_DOS
_FILES_OVER;H_123_WORKING_WITH_OS2_FILES_OVER;H_WORKING_WITH_DBASE_FILES_OVER;H_W
ORKING_WITH_DBASE_AND_PARADOX_FILES_OVER;H_WORKING_WITH_EXCEL_FILES_OVER;H_WORK
ING_WITH_QUATTRO_PRO_FILES_OVER;H_123_OPENED_EVENT_MEMDEF;H_USING_A_FILE_RESERVA
TION_OVER;H_GETTING_A_FILE_RESERVATION_STEPS;H_123_WORKING_WITH_HTML_FILES_OVER;H_
123_OPENING_AN_HTML_FILE_STEPS',0)} See related topics



Opening an existing file
1. From the File menu, choose Open.

2. Select the type of file you want.
3. Select the computer, drive, and directory where the file resides.
4. Select the file name from the list.
5. Click Open.

If you selected a password-protected file, enter the password in the Password dialog box. 
If someone else is using the workbook you selected and has the reservation, or if you selected a file that's set to 
read-only, 1-2-3 asks whether you want to open the file with read-only access.

For a description of the options in the Open dialog box, see Options.
Tip You can also open a file that you used recently by choosing it from the bottom of the File menu.

{button ,AL(`H_OPENING_AN_EXISTING_FILE_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_PREVENTING_OTHERS_FROM_OPENING_A_WO

RKBOOK_STEPS;H_SPECIFYING_A_FILE_OVER;H_USING_A_FILE_RESERVATION_OVER;H_123_OPENIN
G_A_DOCUMENT_FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS;H_123_OPENING_A_DOCUMENT
_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS',0)} See related topics



Details: Opening a recently used file
Listing recently used files
You can show 0-10 file names at the bottom of the File menu using File - User Setup - 1-2-3 Preferences (General 
tab). 

Opening text files
When you choose a text file from the bottom of the File menu, 1-2-3 opens the file using the formatting options that 
you last specified in the Text File Options dialog box. To open the text file using different options, choose File - Open. 

Opening a read-only file
When you open a read-only file, 1-2-3 displays "(Read Only)" in front of the file name in the title bar. To save any 
changes to the file, you must save the file under a different file name.

Related SmartIcons

Opens an existing file

Opens a file from the Internet

{button ,AL(`H_OPENING_A_RECENTLY_USED_FILE_STEPS',1)} Go to procedure
{button ,AL(`H_OPENING_A_TEXT_FILE_STEPS;H_SETTING_123_OPTIONS_STEPS',0)} See related topics



Opening a recently used file
1-2-3 gives you easy access to recently used files by listing them at the bottom of the File menu.
1. Choose File.
2. Choose a file from the list at the bottom of the menu.

If you selected a password-protected file, enter the password in the Password dialog box. 
If someone else is using the workbook you selected and has the reservation, or if you selected a file that's set to 
read-only, 1-2-3 asks whether you want to open the file with read-only access.

{button ,AL(`H_OPENING_A_RECENTLY_USED_FILE_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_PREVENTING_OTHERS_FROM_OPENING_A_WO

RKBOOK_STEPS;H_USING_A_FILE_RESERVATION_OVER;',0)} See related topics



Details: Opening a text file
Naming text files
When you open a text file, 1-2-3 treats the file as a new workbook and assigns a temporary name. The first workbook
name is Untitled. 1-2-3 refers to subsequent workbooks as Untitled1, Untitled2, and so on. When you save the file, 
you must enter a file name in the Save As dialog box. If you want to retain the file as a text file, you must also select 
"Text" as the file type. 

{button ,AL(`H_OPENING_A_TEXT_FILE_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_OPEN_FILE_REF',0)} See related topics



Opening a text file
When you open a text file, you can choose how to format the data that you bring into the sheet or let 1-2-3 
automatically parse the data into columns for you.
1. From the File menu, choose Open.

 
2. Select "Text" as the file type.
3. Select the computer, drive, and directory where the file resides.
4. Select the file name from the list.
5. Click Open.
6. Specify the text file format. 

{button ,AL(`H_OPENING_A_TEXT_FILE_DETAILS',1)} See details
{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_OPTIONS_OPEN_FILE_REF;H_SPECIFYING_A_FI

LE_OVER',0)} See related topics



Open dialog box
Use this dialog box to open different types of files or to combine data from a file on disk with the current workbook. 

Choose a task
Opening an existing file 
Opening a text file 
Combining data from different files 
Importing a picture
Opening a workbook from a Web server on the Internet 
Opening a workbook from an FTP server on the Internet 
Opening a Notes file attachment from within 1-2-3 

For a description of the options in this dialog box, see Options.

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_123_OPEN_FROM_NOTES_DB_OVER',0)} See 
related topics



Options: Open dialog box

Look in
Displays the current directory and shows where it fits in the hierarchy on your computer. Below it is a list of 
directories and files in the selected location. The files listed match the type selected in the "Files of type" list.

File name
Lets you select a file from the list or enter a path and file name containing a combined total of up to 259 
characters. 

Files of type
Lists the types of files you can open or combine with the current workbook.

Description
Displays a description of the file contents. Only 1-2-3 workbooks (.123, .WK4, .WT4) and SmartMaster templates 
(.12M) can display a description. 
To add a file description, use File - Workbook Properties (General tab), or File - Save As.

Open as read only
Opens a copy of the selected file that you can read but not modify. 
When you open a read-only file, 1-2-3 displays "(Read Only)" in front of the file name in the title bar. 

Combine with current workbook
Imports data from a file on disk into the current workbook.

Open
Opens the specified file. When you select "Combine with current workbook," the button name changes to 
Combine and lets you import data from the specified file into the current workbook. 

Lotus Notes
Opens a file attachment stored in a document in a Lotus Notes database. 

Internet
Opens a workbook from either an FTP server or a Web server on the Internet. 



Details: Specifying options for combining 1-2-3 data
Options: Combine 1-2-3 File dialog box
Combine

• Entire workbook -- Combines all of the data from the selected workbook on disk with the current workbook.
• Range -- Combines a specified range of data from the selected workbook on disk with the current workbook.

Note Combining formulas that refer to a row, column, or sheet outside the boundary of the specified range may 
produce unexpected results.

Values from the file
• Replace current values -- Copies specified data from a workbook on disk into the current workbook, beginning at 

the current cell and writing over existing data. Blank cells from the workbook on disk will not replace data in 
corresponding cells in the current workbook.

• Add to current values -- Adds numeric data from a workbook on disk to values or blank cells in the current 
workbook, beginning at the current cell. This option adds numeric data to other numeric data only. 

• Subtract from current values -- Subtracts numeric data in a workbook on disk from values or blank cells in the 
current workbook, beginning at the current cell. This option subtracts numeric data from other numeric data only. 

Guidelines for adding and subtracting values
You can add numeric data to or subtract numeric data from other numeric data only. When the incoming value will 
overlay a label or formula in the current workbook, 1-2-3 discards the incoming value and retains the label or formula.
Do not add or subtract date or time numbers because the results will not be meaningful.
If you subtract a positive number from a blank cell, the result is a negative number because a blank cell evaluates to 
zero.

{button ,AL(`H_SETTING_OPTIONS_FOR_COMBINING_123_DATA_STEPS',1)} Go to procedure



Specifying options for combining 1-2-3 data
Use the options in the Combine 1-2-3 File dialog box to control how you combine data from a workbook on disk with 
the current workbook.
1. Under Combine, select an option.
2. Under Values from the file, select an option.
3. Click OK.

If you are adding data from a password-protected workbook, enter the password in the Password dialog box.

{button ,AL(`H_SETTING_OPTIONS_FOR_COMBINING_123_DATA_DETAILS',1)} See details
{button ,AL(`H_COMBINING_DATA_STEPS;H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_STEP

S;',0)} See related topics



Specifying a text file format
Use the Text File Options dialog box to format text files that you bring into 1-2-3.
1. Specify a parsing option.
2. Select a character set.
3. Click OK.

{button ,AL(`H_SETTING_TEXT_FILE_OPTIONS_DETAILS',1)} See details
{button ,AL(`H_COMBINING_DATA_STEPS;H_OPENING_A_TEXT_FILE_STEPS',0)} See related topics



Details: Specifying a text file format
Options: Text File Options dialog box
Parsing options

• Start a new column at each [separator] -- Lets you specify the type of separator you want 1-2-3 to use for 
breaking the data from the text file into columns in the sheet. If you don't see the character you want in the list, or 
if you want to use a separator that consists of more than one character, select "Other character(s)" and then enter
from 1 to 3 characters in the box that appears.

• Automatically parse based on file layout -- Breaks the data from a non-delimited text file into columns in the sheet 
based on the space between vertically aligned data in the text file.

• Put everything in one column -- Puts all the data from the text file into a single column in the sheet.
Character set 

Specifies the character set you want 1-2-3 to use for interpreting data in the text file. Each character set 
represents a different national language. Unless you're either opening a text file that was created in a different 
country or using a different operating system, the default character set should be appropriate.

{button ,AL(`H_SETTING_TEXT_FILE_OPTIONS_STEPS',1)} Go to procedure



Specifying a file
When you use a 1-2-3 command that requires you to specify a file, you must specify the file's path and name. You 
can do this several ways:

• Use "Look in" to list available directories and files in selected locations and then double-click the file you want 
from the list.

• Enter the path and file name in the "File name" box.
• Use the "File name" box in combination with the "Look in" box.

If you don't specify a path for a file, 1-2-3 looks for the file in the current directory.

The file path
The file path consists of the drive and directory where the file is located. The file name is the unique name and 
extension assigned to the file. For example, in the following file specification:
C:\REPORTS\JANUARY SUMMARY.123
C:\REPORTS is the path. It identifies C: as the drive and REPORTS as the directory where the file named JANUARY 
SUMMARY.123 is located. The .123 file extension identifies the file type.
If the file you're specifying is in a directory that's under another directory, the path includes both directory names. For 
example, in the following file specification:
C:\REPORTS\MONTHLY SALES\JANUARY SUMMARY.123
MONTHLY SALES is a directory under the REPORTS directory.
A backslash (\) must separate the drive, directory, and file name. 

Using wildcard characters to list files
You can see a list of files with similar names or extensions by including the wildcard characters * (asterisk) and ? 
(question mark) in the file name that you enter in the "File name" box. 

Asterisk (*)
The * wildcard character represents any number of consecutive characters in a file name or extension. 
For example, to list all files with the characters MARCH9 (such as MARCH9.123, MARCH9.WK4, and MARCH96. 
WK3), you enter MARCH9*.* in the "File name" box and press ENTER. 
To list all files that begin with B and have the extension .CGM, you enter B*.cgm and press ENTER. 
To list all files in a folder, you enter *.* and press ENTER.

Question mark (?)
The ? wildcard character represents any single character in a file name or extension. 
For example, to list all .123 files that begin with SALES followed by two characters, you enter SALES??.123 in the 
"File name" box and press ENTER.

{button ,AL(`H_OPTIONS_OPEN_FILE_REF;H_OPENING_AN_EXISTING_FILE_STEPS;H_COMBINING_DATA_S
TEPS;H_IMPORTING_A_PICTURE_STEPS;H_OPENING_A_TEXT_FILE_STEPS',0)} See related topics



Working with SmartMaster templates
SmartMaster™ templates give you a quick start for creating useful, attractive spreadsheets. Each template is 
designed to help you perform a different task. 

Exploring SmartMaster templates
Some SmartMaster templates contain sample data that you can look over and then replace with your own data. Built-
in buttons let you print or mail the data.
You can use 1-2-3 SmartMaster templates to:

• Amortize a loan
• Calculate loan payments
• Create a personal budget
• Create a purchase order
• Create a territory sales plan
• Create an expense report
• Create an invoice
• Fill out a time sheet
• Create your own SmartMaster

To see Help about particular parts of a SmartMaster, click the Help button in the SmartMaster:

To clear the Help, click it or click the Help button again.

Customizing and creating SmartMaster templates
To customize an existing SmartMaster template, just make the changes you want and then save the file. If you want 
to keep the original SmartMaster unchanged, use File - Save As to save the customized template as a new .12M file 
with a different name. 
You can also create your own templates, based on SHELL.12M, a starter template that comes with 1-2-3.
Before you save the SmartMaster, be sure to add a title and description to make it easy to identify in the future. Then 
you can share the template with your workgroup.

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_CREATING_A_SMARTMASTER_TEMPLATE_STEP
S;H_CREATING_A_WORKBOOK_USING_A_SMARTMASTER_STEPS;H_EDITING_THE_FILE_DESCRIPTION
_STEPS;',0)} See related topics



1-2-3 as an Active Document server
Active Document is an extension of OLE technology. In this release, 1-2-3 is an Active Document server which means
you can open a 1-2-3 workbook from within Active Document container applications such as Notes 4.6, Word Pro 
Release 9, Microsoft Internet Explorer, and Microsoft Office Binder.
For example, if you choose File - Open from Microsoft Internet Explorer and choose a 1-2-3 file, the file opens in the 
Internet Explorer window, or if you click a link to a 1-2-3 file, that file opens in the browser window.

What happens when you open a 1-2-3 workbook in this way?
You can work with data, print, and save your work.

• The 1-2-3 workbook opens inside the container's window.
• The space in the window between the container's icon bar and the container's status bar belongs to 1-2-3. 

• 1-2-3 displays a SmartIcons bar below the container's icon bar.
• 1-2-3 displays a status bar above the container's status bar.
• 1-2-3 displays the workbook in the window.

• 1-2-3 shares the menu with the container, so the commands you see will be different depending on the container.
• File menu commands are controlled by the container, but some 1-2-3 commands, such as Save, Save As, 

Page Setup, Print, and Workbook properties may be available.
• Window menu commands are controlled by the container.
• Help menu commands are controlled by the container, but 1-2-3 adds a Help menu to the bottom of the 

container's menu so you can still access Help for 1-2-3.

SmartIcons give you access to 1-2-3 commands
The Active Document icon set provides access to some of the 1-2-3 commands that will not appear on the container's
menu. You can use these icons to do the following tasks.

1 Customize 1-2-3 behavior
2 Combine file with current workbook
3 Save a range to a file
4 Print
5 Undo last command or action
6 Cut to Clipboard
7 Copy to Clipboard
8 Paste Clipboard contents

{button ,AL(`;H_123_DOCOBJ_COMBINE_STEPS;H_123_DOCOBJ_EXTRACT_STEPS;H_123_DOCOBJ_PRINT_
DIALOG_BOX_STEPS',0)} See related topics



Print dialog box
Use this dialog box to print your work.

Choose a task
Printing a workbook    
Printing the current sheet    
Printing a range    

For a description of the options in the Print dialog box, see Options. 



Options: Print dialog box

Printer
• If you installed more than one printer, you can select a different printer from the "Print to" list. If you need to install 

a printer, see the documentation for your operating system.
• Properties -- Lets you change properties for the current printer. The properties you can change depend on the 

type of printer you have installed. 
• Print to file -- Saves data from a 1-2-3 workbook to a .PRN file so you can print it at another time. If you print to a 

file, you will need to specify a name for the file and a folder in which to save the file. 
Note The .PRN file contains information specific to the printer driver that you are using with 1-2-3. When you print
the file, use the same type of printer you were using with 1-2-3 when you created the file. 

Pages
Lets you specify how many pages you want to print and how to number the pages.

Copies
Lets you specify how many copies you want to print and if you want to collate them.

Print
Lets you specify what you want to print.

Page Setup
Opens the Page Setup dialog box where you can change settings for margins, page layout, headers, footers, and 
specify which elements of the sheet you want to print.



Printing the current sheet
1. Move the cell pointer to the sheet you want to print.
2. Click the Print icon in the 1-2-3 icon bar.

3. Under Printer, select the printer you want to use.
4. Under Print, select "Current sheet."
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them.
7. (Optional) Click Page Setup to change settings for margins, page layout, headers, and footers, and to specify 

which elements of the sheet you want to print. 
8. Click Print.
1-2-3 automatically paginates what you are printing based on how many complete columns and rows will fit on the 
current page. 
Tip If the pages do not automatically break where you want, you can add page breaks using the InfoBox. From the 
Range menu, choose Range - Properties and click the Basics tab. Select "Break page at column" to insert a vertical 
page break in the column to the left of the selected cell. Select "Break page at row" to insert a horizontal page break 
in the row above the selected cell.

{button ,AL(`;H_123_DOCOBJ_OPTIONS_PRINT_DIALOG_BOX_OVER',0)} See related topics



Printing a workbook
If you print a workbook that contains more than one sheet, you can control whether 1-2-3 prints each sheet on a new 
page or prints the data from multiple sheets consecutively on the same page.
1. Click the Print icon in the 1-2-3 icon bar.

2. Under Printer, select the printer you want to use.
3. Under Print, select "Entire workbook."
4. To print sheets on separate pages, select "On separate pages," or deselect this option to print the sheets 

consecutively on the same page.
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them. 
7. (Optional) Click Page Setup to change settings for margins, page layout, headers, and footers, and to specify 

which elements of the sheet you want to print.    
8. Click Print.

{button ,AL(`;H_123_DOCOBJ_OPTIONS_PRINT_DIALOG_BOX_OVER',0)} See related topics



Printing a range
You can print a range, a collection of ranges, or a 3D range.    
Note When you print a collection of ranges or a 3D range, you can control whether 1-2-3 prints the ranges on 
separate pages or consecutively on the same page.
1. Click the Print icon in the 1-2-3 icon bar.

2. Under Printer, select the printer you want to use.
3. Under Print, select "Selected Range" and enter the range(s) you want to print or use the range selector to select 

the range.
4. If you are printing a collection or a 3D range, select "On separate pages" to print the ranges or sheets on 

separate pages or deselect this option to print them consecutively on the same page.
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them.
7. (Optional) Click Page Setup to change settings for margins, page layout, headers, and footers, and to specify 

which elements of the sheet you want to print.
8. Click Print.
1-2-3 automatically paginates what you are printing based on how many complete columns and rows will fit on the 
current page. 
Tip If the pages do not automatically break where you want, you can add page breaks using the InfoBox. From the 
Range menu, choose Range - Properties and click the Basics tab. Select "Break page at column" to insert a vertical 
page break in the column to the left of the selected cell. Select "Break page at row" to insert a horizontal page break 
in the row above the selected cell.

{button ,AL(`;H_123_DOCOBJ_OPTIONS_PRINT_DIALOG_BOX_OVER',0)} See related topics



Page Setup dialog box (Margins & Fit tab)
Use these settings to specify margins, page orientation, centering, and the paper size. You can also size data to fit on
the printed page.

Margins
Enter a measurement for the left, right, top, or bottom print margins.

• If the minimum margins for your printer are larger than what you entered, 1-2-3 automatically adjusts the margins.
• The top and bottom margins together cannot exceed the height of the page. The right and left margins together 

cannot exceed the width of the page.
• You can set the unit of measurement for margins in the Windows control panel. To display these settings, click the

Start button, choose Settings - Control Panel, and then open Regional Settings.

Orientation
Select portrait or landscape mode, depending on how your data is arranged.

• Landscape -- Prints sideways 
• Portrait -- Prints upright 

Tip Use landscape mode when your sheet is wider than a standard page. If you are printing many columns of 
data, landscape printing may help you fit all the columns on a single page.

Center
Select one or both options. Selecting both options centers the data in both directions. 

Page
Choose how you want to scale your work for the printed page.
When printing data

• Actual -- Prints the selection in the size it appears on the screen
• Fit all to page -- Fits all the data on a single printed page
• Fit rows to page -- Shrinks all the rows of data to fit on a single printed page
• Fit columns to page -- Shrinks all the columns of data to fit on a single printed page
• Custom -- Shrinks or enlarges the printed data by a percentage you enter. You can enter a percentage from 15 to 

1000. For example, enter 75 to shrink the selection to 75% of its original size.
When printing an object such as a chart or map without sheet data 

• Actual -- Same as above
• Fill page -- Enlarges the object to fill the page
• Fill page, but keep proportions -- Enlarges the object with the same proportions
• Custom -- Same as above

Paper
Choose from the paper sizes supported by the current printer.



Page Setup dialog box (Headers & Footers tab)
A header is text printed at the top of each page below the top margin. A footer is text printed at the bottom of each 
page above the bottom margin. 
Use these settings to add headers, footers, and repeating titles on each printed page. 

Object
Select the placement for header and footer    text -- Left, Center, and Right. You can enter different text for each 
location.

Fonts
Click Fonts to change properties for header and footer text. You can change the font, size, color, and attributes.

Text
Type header and footer text (up to 255 characters per header or footer) in the Text box and press TAB.
You can combine text with one or more of the following symbols to add specific information in headers and footers. 
For example, you can type Page # (pound sign) to print Page 1, Page 2, Page 3, and so on as a header or footer.

To enter Type 
The date of printing @ (at sign)
The time of printing + (plus sign)
Consecutive page numbers # (pound sign)
The total number of pages % (percent sign)
The file name ^ (caret)
The contents of a cell \ (backslash) followed by a 

cell address or range name

Header and Footer height
By default, 1-2-3 uses the largest font in the header or footer to determine how much space the header or footer 
needs at the top or bottom of the page. To change this setting, deselect "Fit largest font" and enter a number for the 
height of the header and footer.

Print as titles on each page
Titles can clarify data in your printed sheet by providing the same headings in the first row and left column of each 
printed page. Data in the columns will print along the left edge of each page, and data in the rows will print along the 
top edge of each page.
Under Rows and Columns -- Enter a range for "Rows," "Columns," or both, or use the range selector to select the 
range(s). 
Note You need to specify only one cell from each column or row for the titles. Although you can select as many 
contiguous columns and rows as you like for titles, it is practical to set only a few columns and rows so your data will 
fit on the page.

{button ,AL(`;H_123_DOCOBJ_TIPS_HEADERS_AND_FOOTERS_OVER',0)} See related topics



Tips for headers and footers
• You can enter up to 255 characters for each part of a header or footer. 
• When you type text for a header or footer, press TAB to confirm your entry.
• To prevent the segments of a header or footer from overlapping: 

• Press ENTER to start a new line and display the text on more than one line
• Delete some of the text or enter the text in a different location.

• You can set the unit of measurement for headers and footers in the Windows control panel. To display these 
settings, click the Start button, choose Settings - Control Panel, and then open Regional Settings.

• To print @ (at sign), + (plus sign), # (pound sign), % (percent sign), ^ (caret), or \ (backslash) in a header or 
footer, enter an ' (apostrophe) immediately before the character.    For example, enter '# to print #.

• If you use @ (at sign) or + (plus sign) to enter the date or time, 1-2-3 updates the date and time using the system 
date each time you print. If you do not want the date and time to change each time you print, you can just type 
them in.

• When you use \ (backslash) followed by a cell address or range name to specify header or footer text, 1-2-3 uses 
the contents of the first cell of the range only. You cannot combine the contents of a cell with any other text, 
symbols, numbers, or letters in a header or footer. 

• You cannot use a | (vertical bar) character in a header or footer.
• 1-2-3 cannot print headers and footers that are larger than the printable area on the page.



Page Setup dialog box (Include Tab)
From the Include tab, you can select the elements you want to print with your data.

Show
You can include the following elements when you print your work:

• Sheet data (default is on)
• Charts, maps, drawings, and table frames (default is on) 
• Cell comments
• Formulas
• Sheet grid lines
• Sheet row and column frames    

Named print styles
To retrieve a named print style saved in an .AL3 file from an earlier release of 1-2-3, click Retrieve, and specify the 
name of the .AL3 file you want to use. When you retrieve a named print style, 1-2-3 applies the settings to the current
file.



Combining data from different files
When you open a 1-2-3 workbook as an Active document object, you can add data to the workbook from a file on 
disk. When you combine the data with the current workbook, 1-2-3 enters the data in the current sheet beginning at 
the current cell. 
1. Select the cell where you want to begin combining data.
2. In the 1-2-3 icon set, click the icon that combines a file with the current workbook.

3. Select the type of file containing the data you want to combine.
4. Select the computer, drive, and directory for the file containing the data you want to combine.
5. Select the file name from the list.
6. Click Combine.

• If you selected a workbook file, specify the options for combining data in the Combine 1-2-3 File dialog box. 
• If you selected a text file, specify the text file format in the Text File Options dialog box. 



Saving a range as a new file 
When you open a 1-2-3 workbook as an Active document object, you can extract cell data from the current workbook 
by saving a range as a separate file. 
1. Select the range that contains the data you want to extract.
2. In the 1-2-3 icon set, click the icon that saves a range to a file.

3. Enter a name in the "File name" box.
Note You must enter a different file name than that of the current workbook. 

4. (Optional) Select a different file format from the "Save as type" list.
5. Click Save.
6. If you save the data in a 1-2-3 file, the Save Selected Range dialog box appears. Select "Keep formulas" or 

"Convert formulas to values," and click OK.
For a description of the options in the Save As dialog box, see Options.



Changing the password for a locked workbook
To change the password you use to prevent others from changing workbook contents, you first unlock the workbook 
and then relock it with a new password.
1. Make sure the cell pointer is in the workbook for which you want to change the password.
2. From the File menu, choose Workbook Properties.

3. Click the Security tab in the dialog box.
4. Deselect "Lock workbook."
5. Enter the current password in the Password dialog box.
6. After you return to the Workbook Properties dialog box, reselect "Lock workbook."
7. Set a new password in the Set Password dialog box.
8. After you return to the Workbook Properties dialog box, click OK.

{button ,AL(`H_PROTECTING_DATA_OVER',0)} See related topics



Changing the reservation setting
If you don't want the workbook reservation to go automatically to the first person who opens the workbook, you can 
change the reservation setting.
1. From the File menu, choose Workbook Properties.

2. Click the Security tab in the dialog box.
3. Deselect "Always get reservation when opening workbook," and click OK.

{button ,AL(`H_CHANGING_THE_FILE_RESERVATION_SETTING_DETAILS',1)} See details
{button ,AL(`H_USING_A_FILE_RESERVATION_OVER;H_PROTECTING_DATA_OVER',0)} See related topics



Details: Changing the reservation setting
When you open a workbook, 1-2-3 takes different actions depending on the reservation setting and whether the 
reservation is available:

• If "Always get reservation when opening workbook" is turned on and the reservation is available, 1-2-3 gives you 
the reservation when you open the workbook, allowing you to save changes to the workbook. 

• If "Always get reservation when opening workbook" is turned on but the reservation is unavailable, 1-2-3 asks 
whether you want to open a read-only copy of the workbook without its reservation. 

• If "Always get reservation when opening workbook" is turned off, 1-2-3 opens the workbook without its 
reservation, regardless of the workbook's reservation status. To make changes to the workbook, you must first 
use File - Get Reservation to try to get the reservation while the workbook is current. If someone else already has 
the reservation, that person must release it before you can get it.

{button ,AL(`H_CHANGING_THE_FILE_RESERVATION_SETTING_STEPS',1)} Go to procedure



Changing the password for a protected workbook
To change the password you use to prevent others from opening a workbook or SmartMaster template, you open the 
file, assign a new password, and resave the file.
1. Make sure the cell pointer is in the file for which you want to change the password.
2. From the File menu, choose Save As.

3. Click Password.
4. Set a new password in the Set Password dialog box.
5. After you return to the Save As dialog box, click Save.
6. When 1-2-3 says that the file already exists, click Replace to replace the existing file with the current file. 
Note Only people who know the password can open the file and change its password.

{button ,AL(`H_PROTECTING_DATA_OVER;H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_STE
PS;H_DELETING_A_PASSWORD_STEPS;H_OPTIONS_SAVE_AS_REF',0)} See related topics



Removing restrictions on opening a workbook
If you don't need to prevent others from opening a password-protected workbook or SmartMaster template, you can 
remove the password.
1. Make sure the cell pointer is in the file for which you want to remove the password.
2. From the File menu, choose Save As.

3. Click Password.
4. After 1-2-3 displays the Set Password dialog box, check that the "Password" and "Verify password" boxes are 

blank and click OK.
5. After you return to the Save As dialog box, click Save.
6. When 1-2-3 says that the file already exists, click Replace to replace the existing file with the current file. 
Note Only people who know the password can open the file and remove its password.

{button ,AL(`H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_STEPS;H_OPTIONS_SAVE_AS_REF
;H_PROTECTING_DATA_OVER;H_CHANGING_THE_PASSWORD_FOR_A_PROTECTED_WORKBOOK_STE
PS',0)} See related topics



Getting a workbook reservation
By default, the reservation goes to the first person who opens a workbook. If the default reservation setting has been 
changed, you need to get the reservation while the workbook is current.
To get the reservation for the current workbook, choose File - Get Reservation.
1-2-3 gives you the reservation if it's available. 

{button ,AL(`H_GETTING_A_FILE_RESERVATION_DETAILS',1)} See details
{button ,AL(`H_RELEASING_A_FILE_RESERVATION_STEPS;H_USING_A_FILE_RESERVATION_OVER;H_PROT

ECTING_DATA_OVER;H_CHANGING_THE_FILE_RESERVATION_SETTING_STEPS',0)} See related topics



Details: Getting a workbook reservation
Opening a workbook with its reservation
By default, 1-2-3 gives the workbook reservation to the first person who opens the workbook. You need to use File - 
Get Reservation only if "Always get reservation when opening workbook" is turned off. To see the reservation setting 
for the current workbook, choose File - Workbook Properties (Security tab).
If you try to open a workbook and someone else already has the reservation, 1-2-3 asks whether you want to open a 
read-only copy of the workbook. The other person who has the reservation must release it before you can get it. 

Opening a workbook without its reservation
If you just want to look at a workbook and don't need to make changes to it, you can open the workbook without its 
reservation. Choose File - Open and select "Open as read only" in the Open dialog box. If you find that you need to 
make changes to the workbook, use File - Get Reservation to try to get the reservation.

{button ,AL(`H_GETTING_A_FILE_RESERVATION_STEPS',1)} Go to procedure
{button ,AL(`H_OPENING_AN_EXISTING_FILE_STEPS',0)} See related topics



Entering a password
1. Enter the previously assigned password in the "Enter password" box.

Note You must use the exact combination of uppercase and lowercase characters that were used to create the 
password.

2. Click OK.

{button ,AL(`H_UNLOCKING_A_WORKBOOK_STEPS;H_OPENING_AN_EXISTING_FILE_STEPS;H_OPENING_A
_RECENTLY_USED_FILE_STEPS',0)} See related topics



Locking sheet contents
Locking a sheet prevents other people from entering or editing data in the sheet, except in cells that you specifically 
left unprotected.
1. (Optional) Leave cells unprotected in any ranges or versioned ranges where you want to allow changes to cell 

contents.
2. Make sure the cell pointer is in the sheet you want to lock.
3. From the Sheet menu, choose Sheet Properties.

4. Click the Basics tab in the InfoBox.

5. Select "Lock contents of protected cells in this sheet."
6. (Optional) Move, collapse, or close the InfoBox.
Note If the current sheet belongs to a set of grouped sheets, locking that sheet locks the other sheets in the group. 

{button ,AL(`H_LOCKING_SHEET_CONTENTS_DETAILS',1)} See details
{button ,AL(`H_MAKING_PART_OF_A_SHEET_OR_WORKBOOK_UNPROTECTED_STEPS;H_PROTECTING_DA

TA_OVER;H_UNLOCKING_A_SHEET_STEPS;H_PROTECTING_UNPROTECTED_CELLS_IN_A_LOCKED_SH
EET_STEPS;H_GROUPING_SHEETS_STEPS;H_CHANGING_VERSION_PROPERTIES_STEPS',0)} See 
related topics



Details: Locking sheet contents
After you lock the sheet, the status bar displays PR when you select a protected cell and U when you select an 
unprotected cell. 

How locking a sheet differs from locking a workbook
When you lock a sheet, 1-2-3 locks only the contents of the cells in the sheet that you have not previously left 
unprotected. Because you don't use a password to lock a sheet, anyone can unlock the sheet and change its cell 
contents.
Locking a workbook prevents changes to its contents, styles, and structure, while locking a sheet only prevents 
changes to its contents. Because you use a password to lock the workbook, only people who know the password can
make changes to the workbook.

Tasks you can't perform in a locked sheet
When the current sheet is locked, you can't:

• Change cell contents or comments, except in unprotected cells
• Display unprotected, protected, or hidden versions, except those for which cells are left unprotected
• Insert or delete columns or rows

{button ,AL(`H_LOCKING_SHEET_CONTENTS_STEPS',1)} Go to procedure
{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_STEPS',0)} See related topics



Locking workbook contents
When you lock a workbook's contents with a password, other people can open the workbook. However, unless they 
know the password, they can't modify the workbook, except in ranges that you specifically left unprotected.
1. (Optional) Leave unprotected any ranges and versions in which you want to allow changes to cell contents. 
2. From the File menu, choose Workbook Properties.

3. Click the Security tab in the dialog box.
4. Select "Lock workbook."
5. Set the password in the Set Password dialog box.
6. After you return to the Workbook Properties dialog box, click OK.

{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_DETAILS',1)} See details
{button ,AL(`H_PROTECTING_DATA_OVER;H_MAKING_PART_OF_A_SHEET_OR_WORKBOOK_UNPROTECTE

D_STEPS;H_CHANGING_A_LOCKED_WORKBOOK_PASSWORD_STEPS;H_UNLOCKING_A_WORKBOOK_S
TEPS;H_PROTECTING_UNPROTECTED_CELLS_IN_A_LOCKED_WORKBOOK_STEPS;H_CHANGING_VERS
ION_PROPERTIES_STEPS',0)} See related topics



Details: Locking workbook contents
You can lock the contents of either a workbook (.123, .WK4, .WK3, .WT4) or a SmartMaster template (.12M) with a 
password.
Locking a workbook with a password is different from saving a workbook with a password:

• When you use File - Workbook Properties to lock a workbook with a password, other people can open the 
workbook. However, unless they know the password, they can't make changes to the contents of the workbook. 

• When you use File - Save As to save a workbook with a password, only people who know the password can 
open, print, or view the workbook.

After you lock the workbook, the status bar displays PR when you select a protected cell and U when you select an 
unprotected cell. 

Tasks you can't perform in a locked workbook
When a workbook is locked, you can't:

• Change cell contents or comments, except in unprotected cells
• Display hidden versions, change protected versions, or change unprotected versions, except those for which cells

are left unprotected
• Display hidden version groups or change protected version groups
• Show hidden columns, rows, or sheets
• Insert or delete columns, rows, or sheets
• Copy or move sheets
• Change column width or row height
• Change page breaks
• Freeze or clear sheet titles
• Change number format, style, or alignment
• Name or rename sheets
• Name or rename ranges
• Group or ungroup sheets
• Change outline settings
• Add or change charts, maps, graphic objects, DQA query tables, datalink tables, or Web tables
• Add hyperlinks 
• Change protection or workbook reservation settings

Working with versions
When you create a version, you select the protection setting that you want in either the New Version dialog box or the
Range InfoBox (Version tab). The version protection setting takes effect after you lock the workbook.
For information about version protection settings, see Options: New Version dialog box and Range InfoBox. 

{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_STEPS',1)} Go to procedure
{button ,AL(`H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_STEPS;',0)} See related topics



Details: Leaving part of a workbook or sheet unprotected
Which cells are protected and unprotected?
The status bar displays U when you select an unprotected cell. After you lock the workbook or sheet, the status bar 
displays PR when you select a protected cell and U when you select an unprotected cell. 

{button ,AL(`H_MAKING_PART_OF_A_SHEET_OR_WORKBOOK_UNPROTECTED_STEPS',1)} Go to procedure



Leaving part of a workbook or sheet unprotected
Before you lock a workbook or sheet, you can leave specified ranges unprotected to allow changes to their data.
1. Select the ranges or collections where you want to allow changes to data.
2. From the Range menu, choose Range Properties.

3. Click the Security tab in the InfoBox.

4. Deselect "Protect cell contents from changes."
5. (Optional) Move, collapse, or close the InfoBox.
6. Do one of the following:

• Lock the workbook.
• Lock the sheet.

{button ,AL(`H_MAKING_PART_OF_A_SHEET_OR_WORKBOOK_UNPROTECTED_DETAILS',1)} See details
{button ,AL(`H_LOCKING_SHEET_CONTENTS_STEPS;H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_PROT

ECTING_DATA_OVER;',0)} See related topics



Preventing others from opening a workbook
When you assign a password to a workbook or SmartMaster template, only people who know the password can 
open, print, or view the file.
1. Make sure the cell pointer is in the file you want to prevent others from opening.
2. From the File menu, choose Save As.

3. Enter a name in the "File name" box.
4. Click Password.
5. Set a password in the Set Password dialog box. 
6. After you return to the Save As dialog box, click Save.

{button ,AL(`H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_DETAILS',1)} See details
{button ,AL(`H_DELETING_A_PASSWORD_STEPS;H_PROTECTING_DATA_OVER;H_NAMING_A_FILE_OVER;H

_OPTIONS_SAVE_AS_REF;H_CHANGING_THE_PASSWORD_FOR_A_PROTECTED_WORKBOOK_STEPS',0
)} See related topics



Details: Preventing others from opening a workbook
You can save either a workbook (.123, .WK4, .WK3, .WK1, .WT4) or a SmartMaster template (.12M) with a password.
Saving a workbook or SmartMaster template with a password is different from locking a workbook with a password:

• When you use File - Save As to save a workbook or SmartMaster template with a password, only people who 
know the password can open, print, or view the file.

• When you use File - Workbook Properties to lock a workbook with a password, other people can open the 
workbook. However, unless they know the password, they can't make changes to the contents of the workbook. 

When the password doesn't work
Anyone who knows the password that was assigned to a workbook or SmartMaster template can change or remove 
the password. If you're unable to open a password-protected workbook or SmartMaster template, check to see if 
someone else who knew the original password has changed it.

{button ,AL(`H_PREVENTING_OTHERS_FROM_OPENING_A_WORKBOOK_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_SAVE_AS_REF',0)} See related topics



Overview: Protecting data
Sometimes your workbooks contain data you don't want other people to change or even see. For example, you may 
want to prevent others from changing a set of formulas, or limit who can open a workbook that contains confidential 
financial data. In 1-2-3, you can choose the level of security you want. 

Preventing others from opening a workbook
You can limit access to a workbook or SmartMaster template completely by saving it with a password. Only those 
people who know the password can open, print, or view the file. 
For example, you could create a SmartMaster template that calculates annual raises for the employees in your 
organization. To keep the financial data in the file confidential, you save the template with a password. Only 
managers who know the password would be able to see the file contents. 
Note If you copy or rename a file that has a password, you must know the password to open the copy or renamed 
file.

 See related topics

Locking workbook contents to prevent changes
Locking a workbook prevents changes to protected ranges, versions, and version groups; charts, maps, and graphic 
objects; DQA query tables, Web tables, and datalink tables; styles; and row, column, and sheet settings. 
When you lock a workbook, other people can still open it. However, unless they know the password, they can't 
change any data in the workbook except in ranges that you specifically left unprotected before locking the workbook.
For example, you could create a workbook to calculate sales information. While you want other people to add their 
data, you don't want them to change your formulas or formatting. To prevent others from making unwanted changes, 
you can deselect protection for the ranges where you want them to enter their data, and then lock the workbook.

 See related topics

Locking individual sheets and objects
If you don't want to lock an entire workbook, you can lock individual sheets and objects such as charts and graphics. 
Before locking a sheet, you can leave unprotected any ranges in which you want to allow changes. Locking the sheet 
protects the entire sheet from changes to range contents except in ranges for which you deselected protection. 
Locking individual objects such as charts and graphics protects them (but not the underlying sheet) from change. 
Because you don't use a password to lock individual sheets and objects, anyone can unlock them. Protecting data in 
this way is meant only to prevent accidental changes. 

 See related topics

Using reservations to prevent conflicting changes
Each workbook has a reservation. If you share the workbook with other people on a network, 1-2-3 uses the 
reservation to control access to the workbook. By default, the reservation always goes to the first person who opens 
the workbook. 
Before you can change a workbook over a network, you must get the reservation. Although the person who has the 
reservation is the only one who can make changes to the workbook, other people can view, copy, or print the 
workbook at the same time. 

 See related topics



Protecting unprotected ranges in a locked sheet
1. Unlock the sheet.

Note Collapse or move the InfoBox, but do not close it.
2. Select the unprotected range or collection you want to protect.
3. Click the Security tab in the InfoBox.

4. Select "Protect cell contents from changes."
5. Lock the sheet.

{button ,AL(`H_LOCKING_SHEET_CONTENTS_STEPS;H_PROTECTING_DATA_OVER;H_UNLOCKING_A_SHEE
T_STEPS',0)} See related topics



Protecting unprotected ranges in a locked workbook
1. Unlock the workbook.
2. Select the unprotected range or collection you want to protect.
3. From the Range menu, choose Range Properties.

4. Click the Security tab in the InfoBox.

5. Select "Protect cell contents from changes."
6. (Optional) Move, collapse, or close the InfoBox.
7. Lock the workbook.

{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_PROTECTING_DATA_OVER',0)} See related 
topics



Releasing a workbook reservation
Before you release the reservation, make sure you save any changes you made to the workbook.
To release the workbook reservation, choose File - Release Reservation.
Note 1-2-3 automatically releases the reservation when you either close the workbook or end the 1-2-3 session.

{button ,AL(`H_PROTECTING_DATA_OVER;H_GETTING_A_FILE_RESERVATION_STEPS;H_USING_A_FILE_RE
SERVATION_OVER;H_CHANGING_THE_FILE_RESERVATION_SETTING_STEPS',0)} See related topics



Details: Setting a password
Using password protection
You can assign a password using File - Save As or File - Workbook Properties (Security tab).

• If you use File - Save As to save a workbook or SmartMaster template with a password, you must know the 
password to open, print, or view the file.

• If you use File - Workbook Properties (Security tab) to lock a workbook's contents with a password, you must 
know the password to make changes to the workbook or to unlock it. 

If you don't use the password-protected file often, write down its password and keep it in a safe place.

{button ,AL(`H_SET_PASSWORD_STEPS',1)} Go to procedure



Setting a password
1-2-3 is case-sensitive, so you must remember the exact combination of uppercase and lowercase characters.
1. Enter a password of up to 15 characters in the "Password" box.
2. Reenter the password in the "Verify password" box. 
3. Click OK.

{button ,AL(`H_SET_PASSWORD_DETAILS',1)} See details
{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_PREVENTING_OTHERS_FROM_OPENING_A_W

ORKBOOK_STEPS',0)} See related topics



Unlocking a sheet
You must unlock a sheet before you can make changes to protected ranges in the sheet.
1. Make sure the cell pointer is in the sheet you want to unlock.
2. From the Sheet menu, choose Sheet Properties.

3. Click the Basics tab in the InfoBox.

4. Deselect "Lock contents of protected cells in this sheet."
5. (Optional) Move, collapse, or close the InfoBox.
Note If the current sheet belongs to a set of grouped sheets, unlocking that sheet unlocks the other sheets in the 
group. 

{button ,AL(`H_PROTECTING_DATA_OVER;H_LOCKING_SHEET_CONTENTS_STEPS;H_GROUPING_SHEETS_
STEPS',0)} See related topics



Unlocking a workbook
If you decide that it's OK for others to make changes to workbook contents, you can unlock the workbook. You must 
know the password to unlock the workbook.
1. Make sure the cell pointer is in the workbook you want to unlock.
2. From the File menu, choose Workbook Properties.

3. Click the Security tab in the dialog box.
4. Deselect "Lock workbook."
5. Enter the password in the Password dialog box. 
6. After you return to the Workbook Properties dialog box, click OK.
Once you unlock a workbook, 1-2-3 deletes the password. If you decide to relock the workbook, you must reassign a 
password.

{button ,AL(`H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_PROTECTING_DATA_OVER',0)} See related 
topics



Overview: Using a workbook reservation
Workbook reservations let you control how you share workbooks on a network or in another multi-user environment, 
and help ensure that people don't inadvertently write over each other's work.
The workbook's reservation status changes depending on whether someone has the reservation. If no one has the 
reservation, it's available. It someone has the reservation, it's unavailable. Only one person at a time can have the 
reservation for a workbook.

Saving changes to a workbook
In a multi-user environment, you need the reservation to save changes to a workbook. When you have the 
reservation, you are the only person who can save changes to the workbook. Other people can open, print, view, or 
copy the workbook while you're using it, but they can't change the workbook as long as you have the reservation.

Opening a workbook without the reservation
When you try to open a workbook and someone else has the workbook's reservation, 1-2-3 asks whether you want to
open a copy of the workbook with read-only access. When you open a read-only copy, you see "(Read Only)" before 
the workbook name in the title bar. You can use the workbook, but you can't save changes to the workbook under its 
current name.
After you open a workbook with read-only access, you can try to get its reservation using File - Get Reservation. If 
someone saved changes to the workbook since you opened the read-only copy, 1-2-3 displays a warning. You can do
the following:

• To retain changes that you made to the data, use File - Save As to save the workbook under a different name.
• To see the most up-to-date version of the workbook, close the current workbook and then reopen it.

Getting the reservation
The reservation setting determines how you get the workbook reservation. By default, the reservation automatically 
goes to the first person who opens the workbook. 
You can change the reservation setting so that no one automatically gets the reservation. Then, to get the 
reservation, you must use File - Get Reservation while the workbook is current. 

Releasing the reservation
1-2-3 releases the workbook reservation when you do any of the following:

• Choose File - Release Reservation while the workbook is current.
• Close the workbook.
• End the 1-2-3 session.

Events that affect the reservation
If a power outage or server failure temporarily severs your connection to the file server, some network software may 
reconnect you to the workbook automatically. However, be aware that 1-2-3 might not display the read-only indicator 
in the title bar, even if you have lost the reservation. To see if you still have the reservation, try to save the workbook.
You can assign read-only status to a workbook by changing its properties in the operating system. Once you do so, 
you can't get the workbook's reservation in 1-2-3, even if no one else has the reservation.    

{button ,AL(`H_GETTING_A_FILE_RESERVATION_STEPS;H_RELEASING_A_FILE_RESERVATION_STEPS;H_C
HANGING_THE_FILE_RESERVATION_SETTING_STEPS;H_PROTECTING_DATA_OVER',0)} See related 
topics



Workbook Properties dialog box (Security tab)

Use the Security tab to protect workbook data from accidental change and to control how you share workbooks in a 
multi-user environment.

Choose a task
Locking workbook contents
Unlocking a workbook
Changing the password for a locked workbook
Changing the reservation setting

{button ,AL(`H_PROTECTING_DATA_OVER;H_USING_A_FILE_RESERVATION_OVER',0)} See related topics



Overview: Closing and saving files
The data that you enter in a file is temporary until you save the file on disk. As you update files during a 1-2-3 
session, it's a good idea to save your work frequently to prevent accidental data loss (for example, in case your 
computer loses power).

Saving files in different formats
You can save files in these formats:

• dBASE (.DBF)
• Lotus 1-2-3 9 Workbook (.123)
• Lotus 1-2-3 97 Workbook (.123)
• Lotus 1-2-3 OS/2 Warp 4 Workbook (.123)
• Lotus 1-2-3 (.WK4, .WK3, .WK1)
• Lotus 1-2-3 9 SmartMaster (.12M)
• Microsoft Excel 97 Workbook (.XLS)
• Microsoft Excel 5/95 Workbook (.XLS)
• Microsoft Excel 4 Worksheet (.XLS)
• Paradox (.DB)
• Text (.TXT)

Extracting data
You can extract cell data from a 1-2-3 workbook file by saving a range to a new file. For example, if you have a large 
workbook and want to create a smaller workbook using part of the original data, you can select the range you want 
and then save it as a separate file. 
You can save a range of cell data in these file formats:

• dBASE (.DBF)
• Lotus 1-2-3 9 Workbook (.123)
• Lotus 1-2-3 97 Workbook (.123)
• Lotus 1-2-3 OS/2 Warp 4 Workbook (.123)
• Lotus 1-2-3 (.WK4, .WK3, .WK1)
• Lotus 1-2-3 9 SmartMaster (.12M)
• Paradox (.DB)
• Text (.TXT)

Preventing others from opening a file
You can save a workbook or SmartMaster template with a password to prevent other people from opening, printing, 
or viewing it.

{button ,AL(`H_CLOSING_A_FILE_STEPS;H_SAVING_A_NEW_WORKBOOK_STEPS;H_SAVING_AN_EXISTING_
FILE_STEPS;H_SAVING_A_RANGE_TO_A_FILE_STEPS;H_PREVENTING_OTHERS_FROM_OPENING_A_W
ORKBOOK_STEPS;H_SAVING_A_DOCUMENT_TO_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_WOR
KING_WITH_EXCEL_FILES_OVER;H_WORKING_WITH_123_FILES_OVER;H_123_WORKING_WITH_DOS_FI
LES_OVER;H_WORKING_WITH_DBASE_AND_PARADOX_FILES_OVER;H_123_SETTING_A_DEFAULT_FILE
_TYPE_STEPS',0)} See related topics



Closing a file
To save memory and keep the workspace uncluttered, close files that you're not using. 1-2-3 removes the files from 
memory but doesn't delete them from disk.
1. Make sure the cell pointer is in the file you want to close.
2. From the File menu, choose Close.

If the file has never been saved or has changed since the last time you saved it, 1-2-3 asks whether you want to save
the changes. Click Yes, No, or Cancel. 
If the file has never been saved and you click Yes, 1-2-3 displays the Save As dialog box so that you can name and 
save the file. 

Note If you worked with features that are new in the current release of 1-2-3 and want to retain that data, you 
must save the file containing that data using the file type for the current release.

If the file you close is the last active file, 1-2-3 displays an empty workspace.

{button ,AL(`H_CLOSING_AND_SAVING_FILES_OVER;H_SAVING_A_NEW_WORKBOOK_STEPS;H_SAVING_AN
_EXISTING_FILE_STEPS',0)} See related topics



Saving a new workbook
The data that you enter in a workbook is temporary until you save it. 
1. Make sure the cell pointer is in the workbook you want to save.
2. From the File menu, choose Save As.

3. Enter a name in the "File name" box. 
4. (Optional) Select a different file format from the "Save as type" list.

Note If you included an extension in the file name that doesn't match the selected file type, the extension 
overrides the file type.

5. Click Save.
If you entered a file name that already exists in the specified location, 1-2-3 asks whether to replace the data in 
the existing file with the data in the current file, save the existing file as a backup file, or cancel saving the current 
file.

For a description of the options in the Save As dialog box, see Options.

{button ,AL(`H_SAVING_A_NEW_WORKBOOK_DETAILS',1)} See details
{button ,AL(`H_CLOSING_AND_SAVING_FILES_OVER;H_SAVING_AN_EXISTING_FILE_STEPS',0)} See related 

topics



Details: Saving a new workbook
Naming a file
1-2-3 assigns a temporary name to each workbook that you create. The first file name is Untitled, the next is 
Untitled1, the next is Untitled2, and so on. When you save a new workbook, you must enter a file name in the Save 
As dialog box.
The path and file name can contain a combined total of up to 259 characters. You can use any combination of letters, 
numbers, - (hyphens), spaces, _ (underscores), and . (periods) in a file name. You can also use both uppercase and 
lowercase letters; 1-2-3 retains whatever casing you use. 

Specifying a file format
1-2-3 automatically uses Lotus 1-2-3 9 Workbook (.123) as the default format for all new files unless you specify a 
different valid file extension or file type. To change the default format for new files, use File - User Setup - 1-2-3 
Preferences (New Workbook Defaults tab). 
When you save data as a file type that 1-2-3 recognizes, 1-2-3 adds the file extension for you if you don't specify it as
part of the file name. The extension begins with a period, contains up to three characters, and is based on the file 
type. 
1-2-3 recognizes the file types and extensions listed below.

File type Extension Format
dBASE (DBF)  .DBF dBASE
Lotus 1-2-3 9 
Workbook (123)

 .123 1-2-3 Release 9

Lotus 1-2-3 97 
Workbook (123)

 .123 1-2-3 97 Edition for 
Windows 95

Lotus 1-2-3 OS/2 
Warp 4 Workbook 
(123)

 .123 1-2-3 for OS/2 Warp 4

Lotus 1-2-3 (WK4)  .WK4 1-2-3 Releases 4 and 5 
for Windows

Lotus 1-2-3 (WK3)  .WK3 1-2-3 for Windows 
Release 1
1-2-3 for DOS Releases 3
and 4

Lotus 1-2-3 (WK1)  .WK1 1-2-3 for DOS Release 2
Lotus 1-2-3 9 
SmartMaster (12M)

 .12M 1-2-3 Release 9

(not shown in the 
"Save as type" list)

 .WT4 1-2-3 Release 5 for 
Windows

Microsoft Excel 97 
Workbook (XLS)

 .XLS Excel Release 97

Microsoft Excel 
5/95 Workbook 
(XLS)

 .XLS Excel Version 5.0 and 
Release 95

Microsoft Excel 4 
Worksheet (XLS)

 .XLS Excel Version 4.0

Paradox (DB)  .DB Paradox
Text (TXT)  .TXT Text file

If you include an extension with the file name, 1-2-3 tries to identify the appropriate file type based on the specified 
extension. If 1-2-3 doesn't recognize the file extension, it adds an extension based on the selected file type. 
For example, if you enter SALES.WK4 as the file name, 1-2-3 selects "Lotus 1-2-3 (WK4)" as the file type. However, 
if you enter SALES.ABC as the file name and select "Microsoft Excel 97 Workbook (XLS)" as the file type, 1-2-3 
saves the file in Excel format as SALES.ABC.XLS. 

Saving data as different 1-2-3 file types



The current release of 1-2-3 contains features that are not available in previous releases of 1-2-3. To preserve this 
information, you must save the workbook and specify the file type for the current release.
For example, the current release of 1-2-3 supports 65,536 rows, whereas previous 1-2-3 releases support 8,192 
rows. If you enter data below row 8192 and then try to save the data as a 1-2-3 97 .123 workbook, 1-2-3 prompts you
to save using the file type for the current release. 
To save the file as a 1-2-3 97 .123 workbook, you must delete all data below row 8192 and all formulas that reference
cells below row 8192. If you specified a range in a dialog box that retains the range setting and the range references 
data below row 8192, you must reset the range in the dialog box so that it references data above row 8192.
If you use a new feature such as a web table above row 8192, and then save the file as a 1-2-3 97 .123 workbook, 1-
2-3 saves the file but warns you that the data associated with the new feature was not retained. You can preserve the
data by saving the file again and specifying the file format for the current release. 
To save a file that contains a new 1-2-3 9 script event as a 1-2-3 97 .123 workbook, do the following. First delete the 
script event, and then save the workbook using the file type for the currrent release. Then close the workbook, reopen
it, and save it as a 1-2-3 97 .123 workbook.
If you try to save a workbook as a .WK4, .WK3, .WK1, or .WT4 file, 1-2-3 warns you that information may be lost. Do 
one of the following:

• To save the workbook in the selected format, click OK. 
• To save the workbook using the file type for the current release, click Cancel and then choose File - Save As.

If you don't want to see this warning each time you save a workbook in an earlier 1-2-3 file format, use File - 1-2-3 
Preferences (General tab) to turn it off.
If you save a workbook as a 1-2-3 Release 5 for Windows SmartMaster template (.WT4) file, 1-2-3 appends a .WT4 
extension to the file name but treats the template as a standard workbook. You cannot use File - New Workbook to 
create a new workbook based on a .WT4 file. The New Workbook dialog box lists titles of .12M SmartMaster 
templates only.

Saving data as an Excel file
When you save data as an Excel file, 1-2-3 preserves the cell data but does not retain other features such as charts, 
maps, and graphic objects. If the workbook contains any @functions that can't be translated or links to other files, 1-
2-3 records the information in a log file. 
If the file contains data below row 16384, you cannot save the file as an Excel 5/95 or Excel 4 workbook; when you 
choose File - Save As, specify a file type that allows data below row 16384, such as Microsoft Excel 97 Workbook or 
Lotus 1-2-3 9 Workbook.

Saving data as a text file 
When you save data as a text file, 1-2-3 saves text and numbers in cells only. If a cell contains a formula, 1-2-3 saves
the formula result in the text file. 
You cannot save range names, styles, or versions (except for those currently displayed in the sheet). In addition, 
objects that appear on top of cells, such as charts, maps, or other graphic objects are not retained. 
When you save data as a text file, numbers or text that don't fit in the specified column width may be lost. For best 
results, use a monospace font such as Courier and check that the columns are wide enough to display the data in the
sheet. 1-2-3 adds spaces before or after the data in the resulting text file to align the columns of data. 

{button ,AL(`H_SAVING_A_NEW_WORKBOOK_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_SAVE_AS_REF;H_WORKING_WITH_123_FILES_OVER;H_123_WORKING_WITH_DOS

_FILES_OVER;H_123_WORKING_WITH_OS2_FILES_OVER;H_WORKING_WITH_EXCEL_FILES_OVER;H_W
ORKING_WITH_DBASE_FILES_OVER;H_WORKING_WITH_DBASE_AND_PARADOX_FILES_OVER;H_123_S
ETTING_A_DEFAULT_FILE_TYPE_STEPS',0)} See related topics



Saving an existing file
If you make changes to an existing file, you must save the file to make the changes permanent.
1. Make sure the cell pointer is in the file you want to save.
2. From the File menu, choose Save.

Tip To save a copy of the file under a different name, choose File - Save As and then enter a new name in the "File 
name" box.

{button ,AL(`H_SAVING_AN_EXISTING_FILE_DETAILS',1)} See details
{button ,AL(`H_CLOSING_AND_SAVING_FILES_OVER;H_SAVING_A_NEW_WORKBOOK_STEPS',0)} See related

topics



Details: Saving an existing file
Saving files from previous 1-2-3 releases
If you worked with features that are new in the current release of 1-2-3 and want to retain that data, you must use File
- Save As and specify the file type for the current release.
For example, the current release of 1-2-3 supports 65,536 rows, whereas previous 1-2-3 releases support 8,192 
rows. You can open a 1-2-3 97 .123 workbook in the current release, and then enter data below row 8192. However, 
when you choose File - Save, 1-2-3 prompts you to save the workbook using the file type for the current release. 
To save the 1-2-3 97 .123 workbook, you must delete all data below row 8192 and all formulas that reference cells 
below row 8192. If you specified a range in a dialog box that retains the range setting and the range references data 
below row 8192, you must reset the range in the dialog box so that it references data above row 8192.
If you use a new feature such as a Web query above row 8192 in a 1-2-3 97 .123 workbook, and then save the 
workbook, 1-2-3 saves the workbook but warns you that the data associated with the new feature was not retained. 
You can preserve the data by saving the file again and specifying the file format for the current release. 
To save a 1-2-3 97 .123 workbook that contains a new 1-2-3 Release 9 script event, do the following. First delete the 
script event, and then save the workbook using the file type for the currrent release. Then close the workbook, reopen
it, and choose File - Save As to save it as a 1-2-3 97 .123 file.
When you save a 1-2-3 Release 5 for Windows SmartMaster template (.WT4) file, 1-2-3 saves the template with 
its .WT4 file extension but treats the template as a standard workbook. You cannot use File - New Workbook to 
create a new workbook based on a .WT4 file. The New Workbook dialog box lists titles of .12M SmartMaster 
templates only.
When you save a .WK4, .WK3, .WK1, or .WT4 file, 1-2-3 warns you that information in the file may be lost if you save
the file in its original format. To ensure that the information is not lost, you must save the file using the file format for 
the current release.
Do one of the following:

• To save the data in the selected format, click OK. 
• To save the data using the file type for the current release, click Cancel and then choose File - Save As.

If you don't want to see this warning each time you save a workbook in an earlier 1-2-3 file format, use File - 1-2-3 
Preferences (General tab) to turn it off.

Saving Excel files
When you save an Excel file, 1-2-3 preserves the cell data but does not retain other features you may have added in 
1-2-3 such as charts, maps, and graphic objects. If the file contains any @functions that can't be translated or links to
other files, 1-2-3 records the information in a log file.
To save changes to an Excel .XLW bound workbook file in 1-2-3, you must save the file either as an Excel .XLS file or
as one of the 1-2-3 file types. 
You can open an Excel 5/95 or Excel 4 workbook in 1-2-3, and then enter data below row 16384. However, you 
cannot save the file in its current format. Use File - Save As to save the file using a file type that allows data below 
row 16384.

{button ,AL(`H_SAVING_AN_EXISTING_FILE_STEPS',1)} Go to procedure
{button ,AL(`H_WORKING_WITH_123_FILES_OVER;H_WORKING_WITH_EXCEL_FILES_OVER;H_WORKING_W

ITH_DBASE_FILES_OVER;H_WORKING_WITH_DBASE_AND_PARADOX_FILES_OVER;H_123_WORKING_
WITH_DOS_FILES_OVER',0)} See related topics



Saving a range as a new file
You can extract cell data from the current workbook by saving a range as a separate file.
1. Select the range that contains the data you want to extract.
2. From the File menu, choose Save As.

3. Enter a name in the "File name" box.
Note You must enter a different file name than that of the current workbook. 

4. (Optional) Select a different file format from the "Save as type" list.
5. Select "Save selected range only."
6. Click Save.

If you specified a 1-2-3 file type, the Save Selected Range dialog box appears. Select "Keep formulas" or 
"Convert formulas to values," and click OK.

For a description of the options in the Save As dialog box, see Options.

{button ,AL(`H_SAVING_A_RANGE_TO_A_FILE_DETAILS',1)} See details
{button ,AL(`H_CLOSING_AND_SAVING_FILES_OVER;H_123_CONVERTING_A_RANGE_TO_AN_HTML_TABLE

_STEPS;H_123_CONVERTING_A_RANGE_SHEET_OR_WORKBOOK_TO_A_WEB_GRAPHIC_STEPS',0)} 
See related topics



Details: Saving a range as a new file
Saving ranges in different formats
You can save a range of cell data in these file formats:

• dBASE (.DBF)
• Lotus 1-2-3 9 Workbook (.123)
• Lotus 1-2-3 97 Workbook (.123)
• Lotus 1-2-3 OS/2 Warp 4 Workbook (.123)
• Lotus 1-2-3 (.WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 9 SmartMaster (.12M)
• Paradox (.DB)
• Text (.TXT)

1-2-3 does not save any graphic objects, charts, maps, or embedded objects in the selected range. If the range 
includes any query tables, Web tables, or datalink tables, 1-2-3 retains the table data in the cells but the table borders
and links are lost. 
When you save a range as a .WK3 or .WK1 workbook, 1-2-3 saves only the cell data, number format and alignment 
settings, and range names.
You cannot create a .WK1 workbook by saving a range from an active workbook that contains multiple sheets. 
You cannot save a range in either a locked workbook or a locked sheet to a different file. 

Preserving cell comments and scripts
If you save a range that contains cells with either attached cell comments or scripts, you must save the range as 
either a .123 workbook or a .12M SmartMaster template to retain the comments and scripts. If you save the range as 
a different file type, the data will be lost. 

Preserving range names
When you save a range as a 1-2-3 workbook or SmartMaster template, 1-2-3 retains only those range names that 
refer to ranges completely within the selected range. If a range name refers to a range that either overlaps or is 
outside the selected range, 1-2-3 converts the range name to the appropriate range address, relative to the top left 
cell of the selected range.

Saving a range that contains formulas
When you save a range that contains formulas, follow these guidelines:

• Be sure to include all the data referred to by the formulas. If the formulas reference a range name, be sure to 
include the entire named range. 

• Do not save a range of data that contains formulas that reference 3D ranges to a workbook that contains fewer 
sheets than are in the 3D range.

• If the formulas reference data below row 8192, be sure to save the range using the file type for the current 
release. 

Saving a range of data that contains formulas that reference cells in rows, columns, or sheets outside the selected 
range may produce unexpected results.
If you want to save a range of data that contains formula values and the Calc button appears in the status bar, press 
F9 (CALC) to update the results of the formulas before you save the range.

Saving a range as a dBASE or Paradox file
When you save a range as a dBASE (.DBF) or Paradox (.DB) file, you must select the range containing the database 
table you want to save. 1-2-3 saves only the data in the selected range. No styles, formats, graphic objects, charts, 
maps, or embedded objects are saved.

{button ,AL(`H_SAVING_A_RANGE_TO_A_FILE_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_SAVE_AS_REF',0)} See related topics



Save As/Save Copy As dialog box
Use this dialog box to specify options for saving data.
If you're editing a 1-2-3 Workbook object that's embedded in another application, the Save As command changes to 
Save Copy As. You can use this command to save a copy of the workbook as any supported file type.

Choose a task
Saving a new workbook
Saving a range as a new file
Preventing others from opening a workbook
Removing restrictions on opening a workbook
Saving a workbook to an FTP server on the Internet
Saving a file to a Notes database

For a description of the options in this dialog box, see Options.

{button ,AL(`H_CLOSING_AND_SAVING_FILES_OVER;H_WORKING_WITH_123_FILES_OVER;H_WORKING_WI
TH_EXCEL_FILES_OVERH_WORKING_WITH_DBASE_FILES_OVER;H_WORKING_WITH_DBASE_AND_PAR
ADOX_FILES_OVER;H_123_SAVE_TO_NOTES_DB_OVER',0)} See related topics



Options: Save As/Save Copy As dialog box

Save in
Displays the current directory and shows where it fits in the hierarchy on your computer. Below it is a list of 
directories and files in the selected location. The files listed match the type selected in the "Save as type" list.

File name
Lets you enter a path and file name containing a combined total of up to 259 characters. You can use any 
combination of letters, numbers, - (hyphens), spaces, _ (underscores), and . (periods) in a file name. 1-2-3 retains
uppercase and lowercase characters. 
If you include a file extension that 1-2-3 recognizes and the extension doesn't match the file type selected in the 
"Save as type" list, the file extension overrides the selected file type. If you include a file extension that 1-2-3 
doesn't recognize, 1-2-3 adds an extension based on the selected file type.

Save as type
Lists the formats in which you can save the current file. 
1-2-3 automatically uses Lotus 1-2-3 9 Workbook (.123) as the default format for all new files unless you specify a
different valid file extension or file type in the dialog box. To change the default format for new files, use File - 
User Setup - 1-2-3 Preferences (New Workbook Defaults tab).

Description
Lets you enter text (up to 256 characters) to describe the file contents.
If the file is a workbook, the text that you enter in the "Description" box appears when you select the file in the 
Welcome to 1-2-3 dialog box or Open dialog box. 
If the file is a SmartMaster template, the text that you enter in the "Description" box appears when you select the 
file in the Welcome to 1-2-3 dialog box or New Workbook dialog box. 
You can also view the description on the General tab in the Workbook Properties dialog box.
Note You can only specify a description for 1-2-3 workbooks (.123, .WK4, .WT4) and SmartMaster templates 
(.12M). If you enter a description and save the file as any other file type, the description is not saved.

Save selected range only
Lets you extract data from the current file and save it as a separate file in these formats: 1-2-3 Workbook 
(.123, .WK4, .WK3, .WK1, .WT4), 1-2-3 SmartMaster (.12M), Text (.TXT), dBASE (.DBF), and Paradox (.DB). If 
you didn't select the range before choosing File - Save As, you can click the text box and then enter the range 
address. As an alternative, click the range selector to temporarily remove the dialog box and then select the 
range.

Password
Lets you assign a password to the current workbook or SmartMaster template. Only users who know the 
password can open, print, or view the protected file. 
You can only assign a password to a 1-2-3 workbook file (.123, .WK4, .WK3, .WK1, .WT4) or SmartMaster 
template (.12M).

Lotus Notes
Saves the current file as an attachment to a document in a Lotus Notes database.

Internet
Saves the current file on the Internet.



Saving changes
Choose a task

Closing a file 
Ending 1-2-3 



Saving a dBASE or Paradox file
1. Make sure the cell pointer is in the file you want to save.
2. From the File menu, choose Save As.

3. Enter a name in the "File name" box. 
4. Select "dBASE (DBF)" or "Paradox (DB)" as the file type.

Note If you included an extension in the file name that doesn't match the selected file type, the extension 
overrides the file type.

5. Click Save.
If you entered a file name that already exists in the specified location, 1-2-3 prompts you for more information.

6. Choose one of the following options:
OK -- Replaces the data in the existing file on disk with the data in the current file.
Cancel -- Returns you to 1-2-3 without saving the file.

For a description of the options in the Save As dialog box, see Options. 

{button ,AL(`H_WORKING_WITH_DBASE_AND_PARADOX_FILES_OVER',0)} See related topics



Adding a title and description
You can add a title and descriptive text to workbook files (.123, .WK4, .WT4) and SmartMaster templates (.12M). 
1. Make sure the file you want is the current workbook.
2. From the File menu, choose Workbook Properties.

3. Click the General tab in the Workbook Properties dialog box.
4. Enter a title in the "Title" box.
5. Enter comments in the "Description" box.

If needed, press ENTER to start a new line.
6. Click OK.

{button ,AL(`H_OPTIONS_WORK_PROP_TABGENERAL_REF',0)} See related topics



Options: Workbook Properties dialog box (General tab)

File name
Shows the name of the current workbook file or SmartMaster template.

Location
Shows where the current workbook file or SmartMaster template is stored.

Title
Lets you assign titles to workbook files (.123, .WK4, .WT4) and SmartMaster templates (.12M). The title is 
separate from the file name which appears in the title bar of the sheet window. 
Workbook titles are visible only on the General tab in the Workbook Properties dialog box. You see SmartMaster 
template titles when you view the list of available templates in the Welcome to 1-2-3 dialog box or New Workbook 
dialog box. 

Subject
Lets you exchange information between 1-2-3 and Lotus Notes. Notes then uses the information in the "Subject" 
field of a Notes document.

Keywords
Helps identify the workbook file and can supply categories to a Notes form. If you plan to use the keywords with 
Notes/FX, separate them with a , (comma).

Revision history
Lets you keep track of changes made to the file.

Description
Lets you enter text (up to 256 characters) to identify the file contents.
If the file is a workbook, the text that you enter in the "Description" box appears when you select the file in the 
Welcome to 1-2-3 dialog box or Open dialog box.
If the file is a SmartMaster template, you see the description when you select the template file in the Welcome to 
1-2-3 dialog box or New Workbook dialog box. 
You can also view and edit the description in the Save As dialog box.
Note You can only specify a description for 1-2-3 workbooks (.123, .WK4, .WT4) and SmartMaster templates 
(.12M). If you enter a description and save the file as any other file type, the description is not saved.



Tracking changes in a workbook
You can add notes about changes made to a workbook. 1-2-3 also records other information, including who last 
edited the workbook and when, and total number of revisions.
1. Make sure the file you want is the current workbook.
2. Choose File - Workbook Properties.

3. Click the General tab in the Workbook Properties dialog box.
4. Enter comments in the "Revision history" box.

If needed, press ENTER to start a new line.
5. (Optional) To see information 1-2-3 records about the workbook, click the Statistics tab in the Workbook 

Properties dialog box.
6. Click OK.

{button ,AL(`H_OPTIONS_WORK_PROP_TABGENERAL_REF',0)} See related topics



Viewing workbook file statistics
You can display information about a workbook such as size, number of sheets, when it was created and last modified,
and recalculation settings.
1. Make sure the file you want is the current workbook.
2. From the File menu, choose Workbook Properties.

3. Click the Statistics tab in the Workbook Properties dialog box.
4. After you finish viewing the information, click OK.

{button ,AL(`H_VIEWING_FILE_STATISTICS_DETAILS',1)} See details
{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_STEPS',0)} See related topics



Details: Viewing workbook statistics
You can't edit the information displayed on the Statistics tab in the Workbook Properties dialog box.
To add information such as a description of the file contents or notes about revisions, use File - Workbook Properties 
(General tab).

{button ,AL(`H_VIEWING_FILE_STATISTICS_STEPS',1)} Go to procedure
{button ,AL(`H_EDITING_THE_FILE_DESCRIPTION_STEPS;H_TRACKING_CHANGES_IN_A_FILE_STEPS',0)} 

See related topics



Workbook Properties dialog box (General tab)

 
Use the General tab in the Workbook Properties dialog box to identify files, track changes, and transfer data between 
1-2-3 and Lotus Notes using Notes/FX.

Choose a task
Adding a title and description 
Tracking changes in a workbook 
Adding Notes/FX fields to a Notes form 

For a description of the options in this dialog box, see Options. 

{button ,AL(`H_EXCHANGING_DATA_BETWEEN_123_AND_NOTES_OVER',0)} See related topics



Ways to perform tasks
In 1-2-3 there are often several ways to perform a task. These include: 

• Choosing a menu command 
• Clicking one of the SmartIcons
• Using the InfoBox
• Using the status bar
• Using a keyboard shortcut 

For example, there are several ways to make cell contents bold. You must first click the cell to select it, and then you 
can use any one of these methods to perform the task:

• Click one of the SmartIcons

• In the Range InfoBox, use the Text Format tab

• In the status bar, click the Bold button

• On the keyboard, press CTRL+B

Using the menu or the SmartIcons 
You can always choose a menu command, but if the equivalent icon is showing, clicking the icon is faster than 
choosing a menu command. 

Using the InfoBox or the status bar
You can use the status bar to make single changes. However, if you want to make several changes at once or you 
want to format a workbook, using the InfoBox is easier. Changes you make using the InfoBox or the status bar 
happen instantly, so you can easily try out different options.

Using the mouse or the keyboard
In most cases, 1-2-3 allows you to use either the mouse or the keyboard to complete a task. There are, however, 
some cases in which you must use the mouse, such as using drag and drop to move or copy data.

Using shortcut menus
Click the right mouse button on any object, or while editing a cell, to display the shortcut menu.

{button ,AL(`H_USING_MENUS_OVER;H_USING_THE_INFOBOX_STEPS;H_USING_THE_STATUS_BAR_OVER;
H_SHORTCUT_KEYS_OVER;H_FUNCTION_KEYS_OVER;H_STYLE_KEYS_OVER;H_USING_SMARTICONS_
OVER',0)} See related topics



Undoing a command
You can often undo a command or other action by performing Undo immediately after the command or action. For 
example, you can undo the effects of editing a cell or moving data.
To undo an action, choose Undo from the Edit menu.

Note If Undo is turned off, you cannot undo a command or action. To turn Undo on or off, choose User Setup from 
the File menu, then choose 1-2-3 Preferences (General tab). 
You cannot undo some commands and actions. See details.

{button ,AL(`H_UNDOING_A_COMMAND_DETAILS',1)} See details
{button ,AL(`H_CANCELING_A_COMMAND_STEPS;',0)} See related topics



Details: Undoing a command
How Undo works in 1-2-3
If you changed several settings in a dialog box, choosing Edit - Undo will undo all of the changes.
If you changed several settings in the InfoBox, choosing Edit - Undo will undo the most recent change.

Some tasks cannot be undone
Commands and actions that cannot be undone include:

• Individual edits while editing cell contents
• Moving or copying sheets
• Creating a Web table or a query table
• Printing 
• Saving a file
• Running a macro
• Running a script
• Copying data to the Clipboard
• Recalculating formulas by pressing F9 (CALC) or using Edit - Manage Links 
• Moving the cell pointer
• Using Edit - Undo or CTRL+Z 

Some tasks clear the Undo buffer
After you do any of the following tasks, you cannot undo any previous actions:

• Printing 
• Saving a file
• Running a macro
• Running a script

{button ,AL(`H_UNDOING_A_COMMAND_STEPS',1)} Go to procedure



Canceling a command
At any point, while you are making a menu choice or using a dialog box, you can cancel the command. When you 
cancel a command, 1-2-3 closes the dialog box or menu without completing the command.
To cancel a command from a menu, move the mouse pointer off of the menu or press ESC.
To cancel a command from a dialog box, click Cancel, press ESC, or click the close icon

in the upper right corner of the title bar.
Note If a dialog box has a Done button instead of a Cancel button, you cannot cancel the command.    However, you 
may be able to undo it.

{button ,AL(`H_UNDOING_A_COMMAND_STEPS;',0)} See related topics



Overview: Data Query Add-In (DQA)
The Data Query Add-In (DQA) offers data query functionality that is similar to that in 1-2-3 Release 5. When you load 
the add-in, you will be able to open 1-2-3 Release 5 files that contain query tables and work with them much as you 
did in 1-2-3 Release 5. You can also create new DQA query tables.
Once you load the Data Query Add-In into memory, the Query command appears on the main menu each time you 
start 1-2-3 until you unload the add-in. For more information about add-ins, see Overview: Add-ins. 

What you can do with DQA
DQA lets you query and manipulate data in database tables. Specifically, you can:

• Create a DQA query table, which contains the records you extract from a 1-2-3 database table or an external 
database table.

• Find records in a 1-2-3 or external database table that meet criteria you specify.
• Add new records to a database table.
• Delete records from a database table that meet criteria you specify.
• Create a cross tabulation table, or crosstab, to see relationships between different kinds of data.
• Create a new table in an external database.
• Send commands to an external database.

Caution You cannot use Edit - Undo to reverse actions taken with DQA, including changes that you make to data in 
the database table. 

What is a DQA query table?
A DQA query table contains a copy of selected records from a source database table. 

You create a query table to find specific records. The query table lets you summarize and perform calculations on the 
selected database data without interfering with the original records. However, because the query table is linked to the 
database table, you can use the query table to edit the records or delete records from the database table.    

Working with query tables from previous releases of 1-2-3
When you load the Data Query Add-In, you can work with 1-2-3 Release 5 files that contain query tables. You can 
also work with 1-2-3 97 files that contain query tables created with the Query Table Add-In. In files of this type, each 
query table appears as a simple range with a border around it, but you can select and work with it as a query table.

Other ways to work with database tables
For other powerful ways to work with database tables, 1-2-3 works with Lotus Approach to help you manage and 



analyze data contained in a 1-2-3 or an external database. 1-2-3 and Approach are installed together when you install
1-2-3. When you use the Create - Database commands in 1-2-3, you can access Approach to create query tables, 
forms, reports, dynamic crosstabs, mailing labels, and form letters. 
For more information, see Overview: Working with 1-2-3 and Approach.      

{button ,AL(`H_123_LOADING_THE_DATA_QUERY_ADDIN_STEPS;H_123_GETTING_READY_TO_CREATE_A_D
QA_QUERY_TABLE_STEPS;H_123_SELECTING_A_DQA_QUERY_TABLE_STEPS;H_QUDT_STEPS;H_TDCE
_STEPS;H_123_DQA_CROSSTABS_OVER;;H_DB_WORKING_WITH_DATABASE_TABLES_OVER',0)} See 
related topics



Loading the Data Query Add-In (DQA)
To use the Data Query Add-In (DQA) to work with database tables, you have to load it into memory. After you load 
DQA, it will be loaded into memory each time you start 1-2-3 until you unload it.    
Want the big picture?    See Overview: Data Query Add-In (DQA). 
1. From the File menu, choose Add-Ins, and then choose Manage Add-Ins.

The Manage Add-Ins dialog box lists the add-in files that are registered with 1-2-3.
Tip If DQAUI.12A does not appear in the Manage Add-Ins list, click Register, select DQAUI.12A, then click Open. 
The Register Add-Ins dialog box lists the add-in files that 1-2-3 stores in the ADDINS directory.    

2. Click DQAUI.12A to mark it for loading.
3. Click Done.
The Query menu appears on the 1-2-3 main menu. Now, each time you start 1-2-3, the Query menu will be available.
Note For the Data Query Add-In to work, the "Run file Opened scripts, autoexec macros" option must be selected on 
the General panel in the 1-2-3 Preferences dialog box. By default, this option is selected. To make sure this option is 
selected, choose File - User Setup - 1-2-3 Preferences. 

{button ,AL(`H_123_UNLOADING_THE_DATA_QUERY_ADDIN_STEPS;H_ADDINS_OVER;',0)} See related topics



Unloading the Data Query Add-In (DQA)
After you load the Data Query Add-In, DQA is loaded into memory and the Query menu is available each time you 
start 1-2-3. You must unload DQA to run 1-2-3 without the add-in.
1. From the File menu, choose Add-Ins, and then choose Manage Add-Ins.

The Manage Add-Ins dialog box lists all registered add-ins. Add-ins marked for loading have a check mark next to
them.

2. Click DQAUI.12A to remove the check mark.
3. Click Done.
Note When you unload DQA, existing query tables remain in the sheet as unnamed ranges, but they are no longer 
linked to the source database table(s). If you reload DQA, 1-2-3 recognizes the ranges containing previously defined 
query tables as query tables and restores the links.

{button ,AL(`H_123_LOADING_THE_DATA_QUERY_ADDIN_STEPS;H_ADDINS_OVER;H_TD_OVER',0)} See 
related topics



Working with the Data Query Add-In (DQA)
The Data Query Add-In (DQA) is included in this release of 1-2-3 to give you data query functionality that is similar to 
that in 1-2-3 Release 5. When you load DQA, you can work with query tables created in 1-2-3 Release 5 or the Query
Table Add-In from 1-2-3 97. You can also create new query tables and crosstabs.    
Want the big picture?  See Overview: Data Query Add-In (DQA). 

Loading the Data Query Add-In
If the Query command does not appear on the main menu, you need to load DQA. See Loading the Data Query Add-
In. 

Creating a DQA query table
With a DQA query table, you can analyze data from a 1-2-3 database table or an external database table. The query 
table is linked to the source database table so that you can get updated information from and send changes to the 
source data. You can also change the way the query table is set up to look at different subsets of the data or to look 
at the data differently. DQA query tables are saved with the workbook.
For more information, see Creating a DQA query table. 

Selecting a DQA query table
Before you can work with a query table, you need to use Query - Select Query Table to select it. For more 
information, see Selecting a DQA query table. 

Changing the data in a DQA query table
You can change the data that appears in the query table in a number of ways:

• To change which records appear, see Changing the criteria for a DQA query table. 
• To determine which fields appear, see Changing the fields in a DQA query table. 
• To add a computed column to the query table, see Adding a computed column to a DQA query table. 
• To show aggregate summaries in a query table, see Creating aggregate summaries in a DQA query table. 
• To display the unique records from the database table, see Showing unique records in a DQA query table. 
• To retrieve records from a different database table using the same criteria, see Selecting a different database 

table. 
• To update the query table to reflect any changes to criteria, options, aggregate, field names, or sort order, see 

Refreshing a DQA query table. 
• To include data from a related database table in the query table, see Joining database tables with DQA. 

Changing the appearance of a DQA query table
You can change the way in which the data appears in the query table.

• To put records in an order you specify, see Sorting a DQA query table.    
• To change a field name, see Showing an alias field name in a DQA query table. 
• To rename a query table, see Renaming a DQA query table. 
• To delete a query table, see Deleting a DQA query table. 

Using the query table to modify records in the source database table
With DQA, you can make changes to the data in the query table, then update the source database table to reflect 
these changes. 

• To permanently delete records in the source database table, see Deleting records with DQA.
• To add new records to the source database table, see Appending records with DQA. 
• To change the records in the source database table to reflect changes you have made to the records in the query 

table, see Updating a database table with DQA. 

Connecting to external database tables
You can use DQA to connect with, query, and manipulate data in external database tables.

• To connect with an external database table so that you can work with its records, see Connecting to an external 
database table with DQA. 

• To set up a new table in an external database, see Creating an external database table with DQA. 
• To send SQL commands to an external database table, see Sending SQL commands with DQA. 



Working with DQA crosstabs
You can create a cross-tabulation table, or crosstab, to see the relationship between different kinds of data. For more 
information about creating crosstabs, see Overview: DQA Crosstabs. 

{button ,AL(`H_123_DQA_CROSSTABS_OVER;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_123_CO
MPARING_THE_DATA_QUERY_ADDIN_DQA_TO_123_RELEASE_5_OVER;H_123_WORKING_WITH_123_AN
D_APPROACH_OVER',0)} See related topics



Comparing the Data Query Add-In (DQA) with 1-2-3 Release 5
How the Data Query Add-In differs from 1-2-3 Release 5
The Data Query Add-In (DQA) shares many features of the query table commands and options in 1-2-3 Release 5. 
However, there are some significant differences, which are described in the sections below. The differences are 
organized by dialog box. 

Set Criteria dialog box
To open the Set Criteria dialog box, choose Query - Set Criteria.
In the DQA Set Criteria dialog box, the Clear button removes the entire criteria statement. You cannot clear one 
statement at a time, as you could in 1-2-3 Release 5, nor can you drag statements to change their logical operators. 
However, you can edit the criteria formula directly in the box, as long as you follow the syntax for 1-2-3 formulas. 
To limit the number of records, choose Query - Set Options. (In 1-2-3 Release 5, you set the limit for records in the 
Set Criteria dialog box.)                                                                            
After you have set criteria, the "Field" and "Value" lists in the Set Criteria dialog box are unavailable until you click And
or Or, or clear the criteria. The "Value" list will read "Sample Data" until you select a field in the "Field" list. 

Choose Fields dialog box
To open the Choose Fields dialog box, choose Query - Choose Fields.
To assign an alias to a field name, click Show Field As. When you assign an alias, the alias appears in the query 
table. (In 1-2-3 Release 5, you assign an alias name with Query - Show Field As.)
To clear all fields, hold down SHIFT and click the first and last field names to select all the fields in the "Selected fields"
list, and then click Clear. (In 1-2-3 Release 5, there is a Clear All button.)

Sort dialog box
To open the Sort dialog box, choose Query - Sort.
The Reset button resets all sorts and closes the dialog box. (In 1-2-3 Release 5, Reset does not close the dialog 
box).

Aggregate dialog box
To open the Aggregate dialog box, choose Query - Aggregate. 
The Reset button resets all aggregates for the current query and closes the dialog box. (In 1-2-3 Release 5, Reset 
does not close the dialog box). 

Query Name dialog box
To open the Query Name dialog box, choose Query - Name. 
In DQA, to rename a query table, select the name of the query table you want to change in the "Existing query table" 
box and type a new name in the "Query name" box. 
In 1-2-3 Release 5, you can rename only the selected query table.

Set Options dialog box
To open the Set Options dialog box, choose Query - Set Options. 
In the Set Options dialog box, you can set the limit for the number of records displayed in the query table. In 1-2-3 
Release 5, the "Limit records" check box is in the Set Criteria dialog box. 
In DQA, you can also set the record limit when you create a query table, in the New Query Assistant dialog box. 

Show SQL dialog box
To open the Show SQL dialog box, choose Query - Show SQL.
If you want to copy just a portion of an SQL statement, highlight the portion you want to copy and press CTRL+C to 
copy the string to the Clipboard. Click Cancel, and then press CTRL+V to paste the string. If you highlight a portion of 
the SQL statement in the Show SQL dialog box, then click the Copy button, you copy the entire string. (In 1-2-3 
Release 5, you can only copy the entire string.)

Join dialog box
To open the Join dialog box, choose Query - Join.
Note In DQA, you must type the join criteria and operators in the Join dialog box. You can create a query with 
multiple joins. However, when you choose Query - Join again, the Join dialog box will display only the first two join 
statements. To see the complete join criteria, choose Query - Show SQL. If you need to make a change, you will 
need to retype the statements for additional joins. 



Updating a database table
In 1-2-3 Release 5, you choose Query - Update Database Table to update a database table. In DQA, you choose 
Query - Set Options. For more information, see Updating a database table with DQA. 

{button ,AL(`H_RELEASE_5_COMMAND_EQUIVALENTS_OVER;H_TD_OVER',0)} See related topics



Creating a DQA query table
This task consists of the following parts:    

 Creating a DQA query table
 Selecting the database table to query
 (Optional) Choosing fields for the DQA query table 
 (Optional) Setting criteria to select the records 
 Adding the DQA query table to the sheet

Creating a DQA query table
A query table created with the Data Query Add-In (DQA) lets you work with copies of records from a 1-2-3 database 
table or an external database table.    You can analyze, organize, and print data, as well as add, delete, and edit 
records in the source database table. 

Getting ready to create a DQA query table
Creating a DQA query table is a five-step process, including the steps you must take before you create the query 
table.
1. Before you create a DQA query table, you must load the Data Query Add-In. If the Query command does not 

appear on the main menu, DQA is not loaded. 
For more information, see Loading the Data Query Add-In. 

2. Locate the database table you want to work with.    
For more information about 1-2-3 database tables, see Creating a 1-2-3 database table. 

3. If you want to work with data from outside 1-2-3, connect to the external database table. 
Tip Take note of the table's name when you connect to it because you need to type it when you create the query 
table.
For more information about connecting to an external database table, see Connecting to an external database 
table with DQA. 

4. Decide where you want to place the query table. 
Tip To avoid writing over any data, create a new sheet to hold the query table.

{button ,AL(`H_TD_OVER;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_QN_STEPS;H_123_DELETIN
G_A_DQA_QUERY_TABLE_STEPS;H_QJ_STEPS',0)} See related topics



Creating a DQA query table
This task consists of the following parts:    

 Creating a DQA query table
 Selecting the database table to query
 (Optional) Choosing fields for the DQA query table 
 (Optional) Setting criteria to select the records 
 Adding the DQA query table to the sheet

Selecting the database table to query
You can use the Data Query Add-In (DQA) to create a DQA query table that lets you work with records from a 1-2-3 
database table or an external database table. The table you use is the source database table for the query table.
1. If you haven't already, complete part 1 of this task. 
2. From the Query menu, choose New Query.
3. To select the database table you want to query, do one of the following:

• To query an unnamed 1-2-3 database table, use the range selector to select the range that contains the table.
• To query a 1-2-3 database table contained in a named range, type the range name or use the range selector, 

then use the navigator to select the name of the table you want to query. 
• To query an external database table, type the name you assigned to the table when you connected to it.

4. (Optional) Enter a name for the query table following the standard naming conventions. 
Note If you do not enter a name, 1-2-3 supplies a default name for the query table.

{button ,AL(`H_TD_OVER;H_DB_CREATING_A_123_DATABASE_TABLE_STEPS;H_DB_WORKING_WITH_DATA
BASE_TABLES_OVER',0)} See related topics



Creating a DQA query table
This task consists of the following parts:    

 Creating a DQA query table
 Selecting the database table to query
 (Optional) Choosing fields for the DQA query table 
 (Optional) Setting criteria to select the records 
 Adding the DQA query table to the sheet 

Choosing fields for the DQA query table
Choosing fields for the DQA query table is an optional step.    If you do not choose fields, the Data Query Add-In 
(DQA) includes all the fields in the source database table in the order in which they appear in that table. The Choose 
Fields button lets you choose fields to exclude and lets you change the order in which fields appear in the DQA query 
table.
1. If you haven't already, complete parts 1 and 2 of this task.
2. In the New Query Assistant, click Choose Fields.

The "Selected fields" box lists all of the fields that will appear in the query table, in the order in which they will 
appear.

3. To remove a field, select it in the "Selected fields" box and click Clear.
4. To change the position of a field in the query table, select it in the "Selected fields" box, and then click the up or 

down arrow until the field is in the position you want.
5. Click OK to return to the New Query Assistant dialog box.
Note Changes you make to the fields in the Choose Fields dialog box do not affect the source database table. After 
you create the query table, you can add fields that you excluded using Choose Fields.

{button ,AL(`H_TD_OVER',0)} See related topics



Creating a DQA query table
This task consists of the following parts:    

 Creating a DQA query table
 Selecting the database table to query
 (Optional) Choosing fields for the DQA query table 
 (Optional) Setting criteria to select the records
 Adding the DQA query table to the sheet 

Setting criteria to select the records
Setting the criteria to select which records from the source database table will appear in the DQA query table is an 
optional step. If you do not set criteria, DQA includes all the records in the source table, up to the number of records 
specified by the limit number in the New Query Assistant.
If you know that you will only need to work with certain records, you can select them here. After you create the DQA 
query table, you can change the criteria to show different records.
1. If you haven't already, complete parts 1, 2, and (optionally) part 3 of this task.
2. In the New Query Assistant dialog box, click Set Criteria.
3. Specify the criteria you want the records in the table to meet.

For example, if you want the records of everyone in the Sales department, the criterion is DEPT="Sales", where 
DEPT is the field, = is the operator, and Sales is the value.
a.      Select the field from the "Field" box.
b.      Select the operator.
c.      Specify the value in the "Value" box.

You can select a displayed value or enter a label, value, or formula.
Tip For more information about writing criteria statements, see Details: Setting criteria to select the records.    

4. To further limit the records to find, click And and repeat step 3.
5. To expand the number of records to find, click Or and repeat step 3.
6. To change the criteria, do one of the following:

• Click Clear to delete all the criteria and start again.
• Edit the criteria by typing in the "Criteria statement" box. For example, you may need to add parentheses ( ) to

group the criteria properly.
7. Click OK to return to the New Query Assistant dialog box.

{button ,AL(`H_QSC_DETAILS',1)} See details
{button ,AL(`H_TD_OVER;H_QBB1_STEPS;H_123_LISTING_SAMPLE_VALUES_FOR_DQA_CRITERIA_STEPS',0

)} See related topics



Details: Setting criteria to select the records
You can specify more than one criterion to select records from a database table to display in a query table. 
Tip To indicate the logical NOT, use the operator <> or one of the other operators to describe the criteria.

Criteria related by AND
Connect two or more criteria with And when you want to retrieve only those records for which all the criteria are true. 
For example, if you want to retrieve records of employees who work in the Boston office and who are in the Sales 
department, there are two criteria:
CITY="Atlanta"
DEPT="SALES"
The criteria statement is represented as:
CITY="Atlanta"#AND#DEPT="Sales"

Criteria related by OR
Connect two or more criteria with Or when you want to retrieve records for which at least one of the conditions is true.
For example, if you want to retrieve records of employees who work either in the Boston or the Atlanta office, there 
are two criteria, and each record must fulfill one condition, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
CITY="Boston"#OR#CITY="Atlanta"

Multiple criteria
You can connect three or more criteria with combinations of And and Or relationships. 
For example, if you want to retrieve the records of employees in either the Boston or the Atlanta office who are in the 
Sales department, there are three conditions. All records must meet the criterion:
DEPT=SALES
In addition, each record must fulfill one of the following criteria, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
DEPT="Sales"#AND#(CITY="Boston"#OR#CITY="Atlanta")
Note When combining more than two criteria, you must type the parentheses ( ) in the "Criteria statement" box to 
group the criteria. If you do not enter parentheses, DQA adds them when you click OK. Sometimes, this may produce
unexpected results.

Specifying criteria with decimal points
Because of the way floating point numbers are stored, when you select a floating point value from the Value box, 1-2-
3 may not display any records that meet the criteria. You can create two criteria to indicate a range of acceptable 
values. For example, to find matches for the criteria LENGTH=0.666666666666, you specify the criteria 
LENGTH>0.65#AND#LENGTH<0.67.

How the Data Query Add-In Differs from 1-2-3 Release 5
In the DQA Set Criteria dialog box, the Clear button removes the entire criteria statement. You cannot clear one 
statement at a time, as you could in 1-2-3 Release 5, nor can you drag statements to change their logical operators. 
However, you can edit the criteria formula directly in the box, as long as you follow the syntax for 1-2-3 formulas. 

{button ,AL(`H_QSC_STEPS',1)} Go to procedure



Creating a DQA query table
This task consists of the following parts:

 Creating a DQA query table
 Selecting the database table to query
 (Optional) Choosing fields for the DQA query table 
 (Optional) Setting criteria to select the records 
 Adding the DQA query table to the sheet 

Adding the DQA query table to the sheet
When you query a 1-2-3 database table, the Data Query Add-In (DQA) includes all the records that meet the criteria 
(up to 65,535). When you query an external table, 1-2-3 limits the number of records in the query table to the first 15 
that meet the criteria you specify unless you specify a larger number. 
1. If you haven't already, complete parts 1, 2, and (optionally) parts 3 and 4 of this task.
2. Enter the cell address for the upper-left corner of the location for the new query table, or use the range selector to

select the cell. To limit the number of records, select a range that includes the number of rows in which you want 
the query table to appear.
Caution The DQA query table writes over any existing data in the range, including data in hidden columns or 
rows. To avoid writing over any data, put the DQA query table in a blank area of a sheet.

3. (Optional) Specify the maximum number of records to appear in the query table in the "Limit records" box.
4. Click OK.

1-2-3 creates the DQA query table and adds it to the sheet; it appears as a range with a border around it.

{button ,AL(`H_123_ADDING_THE_DQA_QUERY_TABLE_TO_THE_SHEET_DETAILS',1)} See details
{button ,AL(`H_TD_OVER;H_QN_STEPS;H_123_DELETING_A_DQA_QUERY_TABLE_STEPS;H_QJ_STEPS',0)} 

See related topics



Details: Adding the DQA query table to the sheet
The DQA query table cannot overlap the database table.

Limiting the number of records
If you specify the top left cell of a range, the query table will contain as many fields and records as will fit in the 
worksheet.
If you specify a range, 1-2-3 displays only the records that fit in that range. For example, if you specify a range that is 
ten rows long, 1-2-3 displays the first ten records in the order in which they appear in the database table.

Changing the number of records in the DQA query table
To display a larger or smaller number of records after you create the DQA query table, choose Query - Set Options 
and change the "Limit records" option.

Moving a DQA query table
After you create a DQA query table, you can move it to another location in the workbook using Edit - Cut and Edit - 
Paste. To select the query table before you move it, use Query - Select Query Table. 

{button ,AL(`H_123_ADDING_THE_DQA_QUERY_TABLE_TO_THE_SHEET_STEPS',1)} Go to procedure



Selecting a DQA query table
Before you can use the Query commands to work with a DQA query table, you must select it. A selected query table 
has a blue, double-line border, and its name appears in the selection indicator. 
To select a DQA query table, do one of the following:

• From the Query menu, choose Select Query Table, then select the query table name in the list and click OK. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

• Choose the Query menu command you want to use. The Select Query Table dialog box appears so you can 
select the query table you want to work with from the list. 

• Click the top left cell of the query table before you choose the Query menu command you want to use.
Note If you want to copy data from the query table to another range in the workbook so you can format it, you can 
use the mouse or keyboard to select the range containing the data.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_SELECTI
NG_A_RANGE_STEPS',0)} See related topics



Changing the fields in a DQA query table
You can add fields to a DQA query table after you create it. You can also remove fields and change the position of 
fields.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Choose Fields.
The "Selected fields" box lists all of the fields in the query table in the order in which they appear.

3. To add a field, click Add, select the field(s) you want to add from the "Available fields" box, then click OK.
Tip CTRL+click to select more than one field name. SHIFT+click to select contiguous field names. 

4. To remove a field, select the field in the "Selected fields" box, then click Clear.
5. To change the position of a field in the query table, select it in the "Selected fields" box, and then click the up or 

down arrow until the field is in the position you want.
6. Click OK.
Note Changes you make to the query table with Query - Choose Fields do not affect the source database table.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_QCFF_ST
EPS;H_QSFA_STEPS;H_123_CHANGING_A_COMPUTED_COLUMN_IN_A_DQA_QUERY_TABLE_STEPS',0)} 
See related topics



Showing an alias field name in a DQA query table
You can change the field name that displays in a DQA query table. For example, you can display the field name 
PROD as Product, or for a computed column SALES*.05, you can show the field name BONUS. To do so, you give 
the field name an alias.
Note Showing an alias field name changes the field name in the query table but not in the source database table. 
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Choose Fields.
The "Selected fields" box lists all of the fields in the query table in the order in which they appear.

3. Select the field name you want to change in the "Selected fields" list.
4. Click Show Field As.
5. Enter the new field name in the "Show as" box.
6. Click OK to return to the Choose Fields dialog box.
7. Click OK.
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Adding a computed column to a DQA query table
You can add a computed column to a DQA query table to show the results of a formula for each row of the query 
table. For example to determine a five percent bonus for all employees, the formula is SALARY * .05.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Choose Fields.
3. Select the field that you want to include in the computed column formula.
4. Click Formula.
5. Enter the formula in the "Enter formula" box.

Note A valid formula contains the name of a field in the database table and cannot include any of the following 
@functions: @@, @CELL, @COLS, @HLOOKUP, @INDEX, @INFO, @IRR, @N, @NPV, @ROWS, @S, 
@SHEETS, @STD, @STDS, @VAR, @VARS, @VLOOKUP, and the database @functions. 

6. (Optional) Enter a name for the computed field in the "Show field as" box.
For example, you might want to rename the field BONUS. 1-2-3 displays the formula as the field name if you do 
not enter a name.

7. Do one of the following:
• To add the computed column to the DQA query table, click Insert.
• To replace the selected field with the computed column, click Replace.

The formula appears in the "Selected fields" list in the Choose Fields dialog box.
8. Click OK.
Tip To remove a computed column, choose Query - Choose Fields and click Clear or choose Query - Choose Fields 
and click Formula, then click Delete Formula. 
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Changing a computed column in a DQA query table
You can edit the formula for a computed column in a DQA query table created with the Data Query Add-In (DQA).
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Choose Fields.
3. Select the computed column that you want to change in the "Selected fields" list.
4. Click Formula.
5. Edit the formula in the "Enter Formula" box.

Note A valid formula contains the name of a field in the database table and cannot include any of the following 
@functions: @@, @CELL, @COLS, @HLOOKUP, @INDEX, @INFO, @IRR, @N, @NPV, @ROWS, @S, 
@SHEETS, @STD, @STDS, @VAR, @VARS, @VLOOKUP, and the database @functions. 

6. (Optional) Enter a name for the computed field in the "Show field as" box.
7. Click Replace.

The new formula appears in the "Selected fields" list.
8. Click OK.
Tip To remove a computed column, choose Query - Choose Fields and click Clear or choose Query - Choose Fields 
and click Formula, then click Delete Formula.
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Changing the criteria for a DQA query table
After you create a DQA query table with the Data Query Add-In, you can change the criteria that the records in the 
source database table must meet in order to appear in a query table. Because the query table is linked to the source 
database table, you can change the criteria as often as you want to view different subsets of the records.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Criteria.
3. To change the criteria, do one of the following:

• Click Clear to delete all the criteria and start again, then follow the steps below.
• Click And or Or to add a criterion, then follow the steps below.
• Edit the criteria by typing in the "Criteria statement" box, then skip to step 8. 

4. Specify the criteria you want the records in the table to meet.
For example, if you want the records of everyone in the Sales department, the criterion is DEPT=Sales, where 
DEPT is the field, = is the operator, and Sales is the value.
a.      Select the field from the "Field" box.
b.      Select the operator from the "Operator" box.
c.      Specify the value in the "Value" box.

You can select a displayed value or enter a label, value, or formula.
Tip For more information about writing criteria statements, see Details: Changing the criteria for a DQA query 
table. 

5. To further limit the records to find, click And and repeat step 4.
6. To expand the number of records to find, click Or and repeat step 4.
7. (Optional) Edit the criteria by typing in the "Criteria statement" box. For example, you may need to add 

parentheses ( ) to group the criteria properly.
Tip To test the criteria statement before closing the dialog box, click Refresh Now.

8. Click OK.
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Details: Changing the criteria for a DQA query table
You can specify more than one criterion to select records from a database table to display in a query table. 
Tip To indicate the logical NOT, use the operator <> or one of the other operators to describe the criteria.

Criteria related by AND
Connect two or more criteria with And when you want to retrieve only those records for which all the criteria are true. 
For example, if you want to retrieve records of employees who work in the Boston office and who are in the Sales 
department, there are two criteria:
CITY="Atlanta"
DEPT="SALES"
The criteria statement is represented as:
CITY="Atlanta"#AND#DEPT="Sales"

Criteria related by OR
Connect two or more criteria with Or when you want to retrieve records for which at least one of the conditions is true.
For example, if you want to retrieve records of employees who work either in the Boston or the Atlanta office, there 
are two criteria, and each record must fulfill one condition, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
CITY="Boston"#OR#CITY="Atlanta"

Multiple criteria
You can connect three or more criteria with combinations of And and Or relationships. 
For example, if you want to retrieve the records of employees in either the Boston or the Atlanta office who are in the 
Sales department, there are three conditions. All records must meet the criterion:
DEPT=SALES
In addition, each record must fulfill one of the following criteria, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
DEPT="Sales"#AND#(CITY="Boston"#OR#CITY="Atlanta")
Note When combining more than two criteria, you must type the parentheses ( ) in the "Criteria statement" box to 
group the criteria. If you do not enter parentheses, DQA adds them when you click OK. Sometimes, this may produce
unexpected results.

Specifying criteria with decimal points
Because of the way floating point numbers are stored, when you select a floating point value from the Value box, 1-2-
3 may not display any records that meet the criteria. You can create two criteria to indicate a range of acceptable 
values. For example, to find matches for the criteria LENGTH=0.666666666666, you specify the criteria 
LENGTH>0.65#AND#LENGTH<0.67.

How the Data Query Add-In Differs from 1-2-3 Release 5
In the DQA Set Criteria dialog box, the Clear button removes the entire criteria statement. You cannot clear one 
statement at a time, as you could in 1-2-3 Release 5, nor can you drag statements to change their logical operators. 
However, you can edit the criteria formula directly in the box, as long as you follow the syntax for 1-2-3 formulas. 
To limit the number of records, choose Query - Set Options. (In 1-2-3 Release 5, you set the limit for records in the 
Set Criteria dialog box.)    
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Listing sample values for DQA criteria
When you specify criteria for a DQA query table, the Data Query Add-In (DQA) offers a list of sample values from the 
source database table in the Value list. For very large database tables or tables on network servers, performance 
may be improved by turning off this option.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Options.
3. Do one of the following:

• Select "Show sample values in filter" to list unique values for each field in the Set Criteria dialog box.
• Deselect "Show sample values in filter" to turn this option off.

4. Click OK.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;;H_QBB1_S
TEPS',0)} See related topics



Sorting a DQA query table
You can sort the records in a DQA query table in the order you specify.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Sort.
3. Select the name of the field you want to sort by from the "Sort by" list.
4. Select an option.

• Ascending sorts A - Z, and smallest to largest values.
• Descending sorts Z - A, and largest to smallest values.

5. Click Add Key.
6. (Optional) To specify additional sort keys, repeat steps 3, 4, and 5.

Note Select the field for the primary sort key first, then select additional keys. For example, if the Last_Name field
is the first sort key, select the First_Name field as the second sort key.

7. Click OK.
Tip To clear all sort keys and return the query table to its original sort order, click Reset.

{button ,AL(`H_QS_DETAILS',1)} See details
{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_123_SHO

WING_UNIQUE_RECORDS_IN_A_DQA_QUERY_TABLE_STEPS;H_QBB1_STEPS',0)} See related topics



Details: Sorting a DQA query table
About the default sort order
The default order in which 1-2-3 sorts different types of labels is determined by the sort order specified when you 
installed 1-2-3. 
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Selecting a different database table
You can apply the criteria, sort settings, selected columns, and aggregates of a selected query table to a different 
database table if both tables contain all the same fields. The query table will then contain data from the second 
database table. 
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Database Table.
3. Use the range selector to select the range that contains the database table you want to switch to. 

Tip To switch to an external database table, type the name you assigned to the external table when you 
connected to it.

4. Click OK.
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Showing unique records in a DQA query table
You can identify the unique records in a source database table and display them in a DQA query table. A record is 
unique when no other record in the database table matches it exactly. 
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Options.
3. Select "Show unique records only."
4. Click OK.
Note To return the query table to its state before you identified the unique records, choose Query - Set Options, then 
deselect "Show unique records only."
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Limiting the records in a DQA query table
After you create a DQA query table, you set or change the maximum number of records the query table can include. 
For example, if you specify 25, 1-2-3 displays the first 25 records in the order in which they appear in the database 
table.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Options.
3. Select "Limit records" and specify the maximum number of records for the query table in the "Limit records" box.
4. Click OK.
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Updating a database table with DQA
When you update a database table, any changes you have made to the records in a DQA query table are applied to 
the corresponding records in the source database table. 
Caution Do not make your changes to the records in the query table until after you turn on the "Allow updates to 
database table" option. This step causes 1-2-3 to refresh the query table with current copies of the records in the 
source database table.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Set Options.
3. Select "Allow updates to database table."

Note Deselect "Show unique records only," if necessary. You cannot update the database table when the query 
table displays unique records.

4. Click OK to close the dialog box.
1-2-3 reminds you that you have turned on the "Allow updates to database table" option, so you should either 
continue with the updating process or turn off the option.

5. Click OK to close the message dialog box.
1-2-3 refreshes the records in the query table so that you can work with a current copy of the records from the 
source database table.

6. Edit the records in the query table. 
7. From the Query menu, choose Set Options.
8. If the Select Query Table dialog box appears, select the name of the query table you want to work with, then click 

OK. 
9. In the Set Options dialog box, click Update.

1-2-3 posts the changes you made to records in the query table to the database table and turns off the "Allow 
updates to database table" option.

Note If you decide not to send your changes to the source database table, choose Query - Set Options, then turn off 
the "Allow updates to database table" option. 
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Details: Updating a database table with DQA
You cannot update a database table if the DQA query table is joined to more than one database table.

Preventing updates to a database table
Deselecting the "Allow updates to database table" option disables the Update button, preventing you from 
inadvertantly changing the records in the source database table to match the ones in the DQA query table. 
Caution This setting cannot prevent records from being appended or deleted with the Query - Append Records or 
Query - Delete Records commands.
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Appending records with DQA
You can use the Data Query Add-In (DQA) to add new records to a database table. You do not have to create a DQA 
query table to append records.
1. If you want to append records to an external database table, connect to the table. For more information, see 

Connecting to an external database table with DQA. 
2. In a row in a sheet, enter all the field names that appear in the database table.
3. In the rows directly beneath the field names, enter the records you want to add to the database table.    
4. From the Query menu, choose Append Records.

Tip If the Query command does not appear on the main menu, reload DQA. For more information, see Loading 
the Data Query Add-In. 

5. Use the range selector to select the range that contains the field names and records you want to add to the table.
6. Use the range selector to select the 1-2-3 database table to which you are appending the records, or type the 

name you assigned to an external database table when you connected to it. 
7. Click OK.

1-2-3 appends the records to the bottom of the database table. 
Note You can append records to the source database table even if the "Allow updates to database table" option is 
turned off in the Set Options dialog box.
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Deleting records with DQA
You can use the Data Query Add-In (DQA) to delete records that meet criteria you specify from a 1-2-3 database 
table or an external database table. You can delete records from a source database table with or without using a DQA
query table.
Caution Records you delete using Query - Delete Records are permanently deleted from the source database table. 
The "Allow updates to database table" option in the Set Options dialog box does not prevent records from being 
deleted.
1. From the Query menu, choose Delete Records.

Tip If the Query command does not appear on the main menu, reload DQA. For more information, see Loading 
the Data Query Add-In. 

2. Use the range selector to select the database table from which you want to delete records, or type the name you 
assigned an external database table when you connected to it.

3. Specify the criteria for the records you want to delete.
For example, if you want the records of a client whose status is "Inactive," the criterion is STATUS="Inactive".
a.      Select the field from the "Field" box.
b.      Select the operator from the "Operator" box.
c.      Specify the value in the "Value" box.

You can select a displayed value or enter a label, value, or formula.
Tip For more information about writing criteria statements, see Details: Deleting records with DQA.    

4. To further limit the records to find, click And and repeat step 3.
5. To expand the number of records to find, click Or and repeat step 3.
6. To change the criteria, do one of the following:

• Click Clear to delete all the criteria and start again.
• Edit the criteria by typing in the "Criteria statement" box. For example, you may need to add parentheses ( ) to

group the criteria properly.
7. Click OK.

1-2-3 deletes the records that meet the criteria from the database table you selected.
Tip If you want to see the records you are choosing to delete before you delete them from a database table, create a 
query table for the database table and use Query - Set Criteria to select the records you want to delete. If you are 
satisfied that these are the records you want to delete, select the query table, choose Query - Delete Records, and 
then click Yes.
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Details: Deleting records with DQA
If you use a query table to select the records you want to delete from a database table, you can specify more than 
one criterion to select the records. 
Tip To indicate the logical NOT, use the operator <> or one of the other operators to describe the criteria.

Criteria related by AND
Connect two or more criteria with And when you want to retrieve only those records for which all the criteria are true. 
For example, if you want to retrieve records of employees who work in the Boston office and who are in the Sales 
department, there are two criteria:
CITY="Atlanta"
DEPT="SALES"
The criteria statement is represented as:
CITY="Atlanta"#AND#DEPT="Sales"

Criteria related by OR
Connect two or more criteria with Or when you want to retrieve records for which at least one of the conditions is true.
For example, if you want to retrieve records of employees who work either in the Boston or the Atlanta office, there 
are two criteria, and each record must fulfill one condition, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
CITY="Boston"#OR#CITY="Atlanta"

Multiple criteria
You can connect three or more criteria with combinations of And and Or relationships. 
For example, if you want to retrieve the records of employees in either the Boston or the Atlanta office who are in the 
Sales department, there are three conditions. All records must meet the criterion:
DEPT=SALES
In addition, each record must fulfill one of the following criteria, but not both:
CITY=BOSTON
CITY=ATLANTA
The criteria statement is represented as:
DEPT="Sales"#AND#(CITY="Boston"#OR#CITY="Atlanta")
Note When combining more than two criteria, you must type the parentheses ( ) in the "Criteria statement" box to 
group the criteria. If you do not enter parentheses, DQA adds them when you click OK. Sometimes, this may produce
unexpected results.

Specifying criteria with decimal points
Because of the way floating point numbers are stored, when you select a floating point value from the Value box, 1-2-
3 may not display any records that meet the criteria. You can create two criteria to indicate a range of acceptable 
values. For example, to find matches for the criteria LENGTH=0.666666666666, you specify the criteria 
LENGTH>0.65#AND#LENGTH<0.67.
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Refreshing a DQA query table
You refresh a DQA query table to update records in the query table to reflect changes made to the data in the source 
database table. Refreshing a query table also applies changes made to the query table options, criteria, aggregates, 
or field names.
Tip If you want to update the query table automatically each time you make changes to query table settings, such as 
criteria and changes to fields, choose Query - Set Options, then select "Auto-refresh."    For very large database 
tables or tables on network servers, performance may be improved by turning off, or deselecting, this option. 
Changes from the source database table can only be applied with the steps below.
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Refresh Now.
Note You cannot refresh a DQA query table when the "Allow updates to database table" option is turned on. To turn 
this option off, choose Query - Set Options.
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Creating aggregate summaries in a DQA query table
You can summarize the data in a DQA query table by creating aggregate calculations. For example, you can 
calculate the total sales by salesperson, by month of sale, or by account. You can also find averages, maximums, 
minimums, and the number of records in a group.
For an example of aggregate summaries, see Details: Creating aggregate summaries in a DQA query table. 
Note Before you create aggregate rows in a query table, remove any computed columns and fields that you do not 
need for the calculation. For example, if the query table contains the fields Name, Month, and Sales, and you want to 
see the total sales per person, delete the field Month. For information about removing fields, see Changing the fields 
in a DQA query table. 
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Aggregate.
3. Select the field that contains the values you want to use in the calculation or the data that you want to count. 
4. Select the calculation you want to perform.
5. (Optional) Enter a name for the aggregate field in the "Show as" box.

1-2-3 replaces the field name with the @function formula in the query table if you do not enter a name.
6. Click OK.
Note To return the query table to its state before you created the aggregate rows, choose Query - Aggregate, then 
click Reset.
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Details: Creating aggregate summaries in a DQA query table
What are aggregate summaries?
Suppose you are working with the following query table.
A: --- A ------ B ----- C ----
1    Name     Month    Sales  
2    Mintz     May     2800   
3    Smith     May     2100  
4    Smith     June    1400  
5    Mintz     June    1500  
6    Smith     June    1600  
You want to see the total sales per salesperson. First, you remove the field Month. If you do not, the results of the 
aggregate will be the total sales per salesperson per month.
When you choose Query - Aggregate, then select the field Sales and the calculation Sum, the query table displays 
the total sales per salesperson.
A: --- A ----- B ---
1    Name    Sales  
2    Mintz    4300  
3    Smith    5100  
About the aggregate calculations you can perform
The calculations you can perform when creating aggregate summaries are based on the @functions listed below. For
more information about the calculations, see @Functions A-Z.

Select To @Function
Sum Add the values @SUM
Average Find the average 

value
@AVG

Count Count the nonblank 
cells

@COUNT

Minimum Find the smallest 
value

@MIN

Maximum Find the largest value @MAX
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Renaming a DQA query table
You can change the name assigned to the DQA query table. 
1. From the Query menu, choose Select Query Table to select the name of the DQA query table you want to work 

with, if necessary. 
Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. From the Query menu, choose Name.
3. In the "Query name" box, enter the new name for the query table following the standard naming conventions. 

Note The new name cannot duplicate the name of any other query table in the workbook and should not 
duplicate any range name in the workbook.

4. Click OK.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_QSDT_ST
EPS;H_DELETING_RANGE_NAMES_STEPS;H_123_DELETING_A_DQA_QUERY_TABLE_STEPS',0)} See 
related topics



Deleting a DQA query table
When you are finished working with a DQA query table, you can delete it. Deleting a DQA query table does not delete
records from the source database table. 
1. From the Query menu, choose Select Query Table.

Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. Select the query table you want to delete in the list.
3. Click Delete. 

1-2-3 deletes the DQA query table from the workbook.
4. Click OK.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_DELETIN
G_RANGE_NAMES_STEPS;H_QN_STEPS;H_123_SELECTING_A_DQA_QUERY_TABLE_STEPS',0)} See 
related topics



Joining database tables with DQA
You can include fields and records from two or more database tables in a single DQA query table by joining the 
database tables, provided the tables have a common field. For example, if you store employee addresses in one 
database table and their benefits in another, and both tables include an employee identification number field, you can
combine these tables in a DQA query table.
1. Before joining database tables, you must do the following:

• If the Query command does not appear on the main menu, reload DQA. For more information, see Loading 
the Data Query Add-In.

• If you want to join one or more 1-2-3 database tables, assign a range name to each one.
• If you are joining one or more external database tables, you must connect to the database table(s) before 

joining. For more information, see Connecting to an external database table with DQA. 
2. Create a query table for each database table you want to join. For more information, see Creating a DQA query 

table. 
3. From the Query menu, choose Join.
4. Select the name of the DQA query table in which you want to view data from the joined database tables, then 

click OK. 
5. Enter a join statement in the "Join criteria" box. The statement should equate a field in one database table with a 

field in another, such as BENEFITS.ID=EMPLOYEE.ID
Note To specify a 1-2-3 database table, use the range name. To specify an external database table, use the 
name you assigned to the external table when you connected to it.

6. Click OK.
1-2-3 adds all the fields from the joined database table to the one you selected in step 4. You can add or remove 
fields for this query table the way you would a query table that is linked to a single source database table. You can
also set criteria for any field that is not from an external database table.

{button ,AL(`H_QJ_DETAILS',1)} See details
{button ,AL(`H_QJ_EX',1)} See example
{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_TDCE_ST

EPS;H_QCFA_STEPS',0)} See related topics



Details: Joining database tables with DQA
Writing the join criteria to join two database tables
In DQA, you type the join criteria and operators in the Join dialog box using the following rules: 

• Two database tables can be joined if they both have a field that contains the same kind of data, although the field 
name can be different. 

• To specify a field in a 1-2-3 database table, use the range name for the range containing the table, followed by a 
period (.), then the field name. The named range must include the field names and the records.

• To specify an external database table, use the name you assigned to the external table when you connected to it, 
followed by a period (.), then the field name.

• When joining three or more database tables, you combine join statements for pairs of database tables. Enclose 
each pairing in parentheses ( ). All the database tables do not need to have the same field in common.

The following are examples of join statements:
PAYROLL.ID=EMPLOYEE.ID
INVENTORY.PRODUCT_ID=SALES.ITEM
(EMPLOYEE.ID=BENEFITS.ID)#AND#(BENEFITS.PLAN=HEALTH.PLAN)
Notes
When a DQA query table contains information from joined database tables:

• You cannot send any changes you may make to the data in the query table to the source database tables. You 
can only update the original records from a DQA query table that is linked to a single source database table.

• You cannot set criteria based on fields from an external database table.

{button ,AL(`H_QJ_STEPS',1)} Go to procedure



Example: Joining database tables with DQA
You can join database tables to combine records and fields from two or more database tables in a single DQA query 
table. 

Joining two database tables
For example, you want to join an employee database table named EMPLOYEE with a database table named 
BENEFITS that contains their employee benefits.    
EMPLOYEE

ID     LASTNAME
45324  Kravitz 
32465  Lee
35214  Garcia
24367  Jackson

BENEFITS
ID     HEALTH  PLAN
32465  Yes     Single
24367  Yes     Family
35214  No      None
45324  Yes     Single

Both tables contain the field ID, which holds employee identification numbers. The following query table results from 
this join criteria statement:
EMPLOYEE.ID=BENEFITS.ID 

EMPLOYEE.ID LASTNAME  BENEFITS.ID  HEALTH  PLAN
24367       Jackson   24367        Yes     Family
32465       Lee       32465        Yes     Single
35214       Garcia    35214        No      None
45324       Kravitz   45324        Yes     Single

1-2-3 automatically includes all the fields from the joined database table. The range name identifies the common 
fields. You can remove and rename fields to show the data you want.

Joining more than two database tables
You also have a database table that contains details about the available health plans. 
HEALTH

PLAN    COST
Single   750
Family  1500
None       0

The following query table combines information from all three database tables. The duplicate fields have been 
removed, and it uses this join criteria statement:
(EMPLOYEE.ID=BENEFITS.ID)#AND#(BENEFITS.PLAN=HEALTH.PLAN)

ID     LASTNAME  HEALTH  PLAN     COST
24367  Jackson   Yes     Family   1500
32465  Lee       Yes     Single    750
35214  Garcia    No      None        0
45324  Kravitz   Yes     Single    750



Connecting to an external database table with DQA
When you use the Data Query Add-In (DQA) to connect to an external database table, you can use Query commands
and database @functions to analyze, add to, or change data in the table while you work in 1-2-3.  
Note Depending on the ODBC driver you select and how it is configured, 1-2-3 may prompt you for a user ID and 
password. If so, enter the user ID and password and click OK. If you do not need a user ID or password to connect to
the driver, choose OK.
1. If the Query command does not appear on the main menu, reload DQA. For more information, see Loading the 

Data Query Add-In. 
2. From the Query menu, choose External Tables, and then choose Connect to External.

If you know the names of the driver, the external database, and the external table, you can combine steps 3 
through 5 by entering all of these names, separated by spaces in the text box. 
For example, enter DBASE_IV C:\LOTUS\123\SAMPLE EMPLOYEE to use the dBASE IV driver, a database or 
directory named C:\LOTUS\123\SAMPLE, and a table named EMPLOYEE.

3. Specify the driver and click Continue.
If the list box does not display the name of a driver you want to use, use the Install program to install the driver. 

4. Specify the external database or directory and click Continue.
If 1-2-3 can locate the external database, it displays the database table names in the list box. If 1-2-3 does not 
display the name of the external database you want to use, type it in the text box. 

5. Specify the external database table and choose Continue.
6. In the "Refer to as" box, enter a name for the table using the standard naming conventions. 

This is the name you use in 1-2-3 to refer to this table in Query commands and database @functions. Do not 
duplicate a name that already exists as a named range in the workbook.    

7. Click OK.
1-2-3 establishes the connection to the database table. Although the name you assigned will not appear in any 
lists of range names in 1-2-3, you can type the external table name in Query commands and database 
@functions.

{button ,AL(`H_TDCE_DETAILS',1)} See details
{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_TDD_STE

PS;H_QJ_STEPS;H_TDCT_STEPS;H_TDSC_STEPS',0)} See related topics



Details: Connecting to an external database table with DQA
Working with ODBC drivers
1-2-3 uses ODBC drivers to connect to external database tables. ODBC drivers allow 1-2-3 to read data from and 
send data to an external database.
You need to install and configure ODBC drivers for each database type you want to open. 

• Use the 1-2-3 Install program to install the ODBC drivers that come with this release of 1-2-3. 
• To configure the ODBC drivers and create a data source for each database type you want to open, see 

Configuring ODBC drivers. 

Updating data in a transaction-based external database table
When updating data in a transaction-based database such as SQL Server, the records you are updating must contain
unique entries. Note that SQL Server drivers do not use the Float data type to determine uniqueness. If you receive 
an error message reporting that "... no columns are useable for selecting a unique row," you need to include a unique 
field of a data type other than Float in the query table.

Updating external SQL Server or Sybase database tables
You may get a "connection timed out" error message when updating or deleting records in an external SQL Server or 
Sybase database table. The message may appear because the found set is too large, the query criteria are too 
complex, or because of heavy network traffic.
If the found set is large, reduce the size of the found set and try the update again. If the query criteria are complex 
and include 1-2-3 @functions, simplify the criteria and then try updating or deleting again. 
If network traffic is heavy, you can ask your system administrator to change the amount of time that 1-2-3 is set to 
wait for the network to respond before issuing a timeout error. This is controlled by the setting "UpdateTimeout=" in 
the ODBC configuration file for the driver (LOSS609.INI for SQL Server 6.0 and LOSS09.INI for SQL Server 4.2), 
located in the WIN95 or WINNT directory.

Other ways to work with external database tables
The 1-2-3 Classic menu contains additional commands for using 1-2-3 with external database tables. 

{button ,AL(`H_TDCE_STEPS',1)} Go to procedure



Disconnecting from an external database table
When you are finished working with an external database table, you can disconnect from it to end all data exchange 
between 1-2-3 and the external table. 
After you disconnect from an external database table, any queries or database @functions that refer to the table may 
result in errors. 1-2-3 will not update these queries or @functions until you connect to the table again using Query - 
External Tables - Connect to External with the same name to refer to the table.
1. From the Query menu, choose External Tables, and then choose Disconnect.

Tip If the Query command does not appear on the main menu, reload DQA. For more information, see Loading 
the Data Query Add-In. 

2. Select the name of the external database table.
3. Click OK.

1-2-3 disconnects from the database table you specified.

{button ,AL(`H_TD_OVER;H_TDCE_STEPS;',0)} See related topics



Creating an external database table with DQA
You can set up the structure for a new table in an external database table by modeling it on an existing 1-2-3 
database table, DQA query table, or external table. 
Note Depending on the ODBC driver you select and how it is configured, 1-2-3 may prompt you for a driver or 
database user ID and password. If so, enter the user ID and password and click OK. If you do not need a user ID and
password to connect to the driver, click OK.
1. From the Query menu, choose External Tables, then choose Create Table.

Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. Specify the driver and click Continue.
If the list box does not display the name of a driver you want to use, see Configuring ODBC drivers. 

3. Specify the external database or directory and click Continue.
If 1-2-3 can locate the external database, it displays the name in the list box. If 1-2-3 does not display the name of
the external database you want to use, type it in the text box. 

4. Replace the words "[New Table]" with a name for the new database table file, then click Continue.
5. Use the range selector to select the range, the range containing the DQA query table, or the external table name 

that contains the model table.
6. Do one of the following:

• To copy the records in the model table to the new external database table, select "Insert records from model 
table." 

• To create only the field name structure for the external database table without adding records, deselect "Insert
records from model table." 

7. Click OK.
Note 1-2-3 creates a new external table in the external database. To work with the data in the new table, choose 
Query - External Tables - Connect to External to connect to the new external database table. Then, for example, you 
can choose Query - New Query to create a query table or choose Query - Append Records to add records to the 
table. 

{button ,AL(`H_TDCT_DETAILS',1)} See details
{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_TDSC_ST

EPS;H_QSS_STEPS;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_TDAR_STEPS',0)} See related 
topics



Details: Creating an external database table with DQA
Working with ODBC drivers
1-2-3 uses ODBC drivers to connect to external database tables. ODBC drivers allow 1-2-3 to read data from and 
send data to an external database.
You need to install and configure ODBC drivers for each database type you want to open. 

• Use the 1-2-3 Install program to install the ODBC drivers that come with this release of 1-2-3. 
• To configure the ODBC drivers and create a data source for each database type you want to open, see 

Configuring ODBC drivers. 

{button ,AL(`H_TDCT_STEPS',1)} Go to procedure



Sending SQL commands with DQA
Depending on the driver you are using, you may be able to send driver-specific commands, called SQL commands, 
directly to the ODBC driver or external database table, and show the results in a range in the workbook. SQL 
commands may be instructions for criteria, the fields to include, and other instructions similar to those you can specify
for a DQA query table with the Query commands.
Tip Use the Query commands to create a DQA query table with the requirements you need, then choose Query - 
Show SQL, and click Copy to generate the SQL command string to use in the procedure described below.
1. Connect to the database table you want to work with. For more information, see Connecting to an external 

database table with DQA. 
2. From the Query menu, choose External Tables, and then choose Send SQL.

Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

3. Select the name of the external database table you want to work with. 
4. Use the range selector to select the location for the results of the SQL command.

To limit the size of the resulting table, specify a range. To bring in as many fields and records as will fit in the 
sheet, select only the cell you want to be the upper-left corner of the table.

5. Select "SQL string."
Tip If you have saved a frequently-used SQL command in a cell, select    "From range," specify the range 
address, and skip step 6.

6. In the "SQL string" box, do one of the following:
• Type the SQL command.
• If you have copied the string from the Show SQL dialog box, click in the "SQL string" box, then press CTRL+V 

to paste the command string.
7. Click OK.

1-2-3 processes the command and copies the selected records from the external table to the range you specified.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_QSS_STE
PS;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;',0)} See related topics



Generating SQL command equivalents
You can display the SQL command equivalent for the criteria and other settings used to create a DQA query table. 
You can then copy the SQL statement to the Clipboard, then send the copied SQL statement to an external database 
table using the Query - External Tables - Send SQL command or the {SEND-SQL} macro command.
1. From the Query menu, choose Show SQL.

Tip If the Query command does not appear on the main menu, load DQA. For more information, see Loading the 
Data Query Add-In. 

2. Select the name of the query table you want to work with.
3. Click OK. 

The Show SQL dialog box displays the SQL command equivalent for the selected query table.
4. Click Copy to copy the SQL statement to the Clipboard.

Tip To copy just a portion of an SQL statement, highlight the portion you want to copy and press CTRL+C to copy 
the string to the Clipboard, then click Cancel.

5. Do one of the following:
• To send the command to an external database table, choose Query - External Tables - Send SQL, click in the 

"SQL string" box and press CTRL+V to paste the string, then make other selections as necessary.
• To save the string in a cell for future use, click a cell in the sheet, then press CTRL+V to paste it in the cell.

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_TDSC_ST
EPS;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_QBB1_STEPS;H_QCFA_STEPS',0)} See related 
topics



Creating a DQA crosstab
This task consists of the following parts:    

 Overview: Creating DQA crosstabs
 Selecting the data for a DQA crosstab
 Selecting the headings for a DQA crosstab 
 Selecting the data options for a DQA crosstab 

Overview: Creating DQA crosstabs
You can create a crosstab, or cross-tabulation table, to summarize information in a database table. Crosstabs are 
particularly useful for showing relationships between two fields in a database table.
For example, the following portion of a database table contains information about dictionary orders. Your company 
sells dictionaries in two formats -- CD-ROM and traditional books -- to homes, businesses, and universities. 

The following crosstab, created from the entire database table, summarizes the total number of orders for each 
format by each type of customer.

Tip Creating a crosstab is often a good way to put information from a database table in a form that you can chart.
You do not have to create a query table to create a crosstab unless you are creating a crosstab based on an external 
database table. 

{button ,AL(`H_QA_STEPS;H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEP
S;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_TDCE_STEPS;H_QJ_STEPS',0)} See related topics



Creating a DQA crosstab
This task consists of the following parts:    

 Overview: Creating DQA crosstabs
 Selecting the data for a DQA crosstab
 Selecting the headings for a DQA crosstab 
 Selecting the data options for a DQA crosstab 

Selecting the data for a DQA crosstab
You can create a crosstab from a 1-2-3 database table or an external database table. 
1. If the Query command does not appear on the main menu, reload DQA. For more information, see Loading the 

Data Query Add-In. 
2. From the Query menu, choose Crosstab.
3. Use the range selector to select the range that contains the database table, or type the name you assigned to an 

external database table when you connected to it.
Note The range must contain the row of field names and at least three columns and two rows. 

4. Click Continue.
The Crosstab Heading Options dialog box appears.

{button ,AL(`H_QA_STEPS;H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEP
S;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_TDCE_STEPS;H_QJ_STEPS',0)} See related topics



Creating a DQA crosstab
This task consists of the following parts:    

 Overview: DQA crosstabs

 Selecting the data for a DQA crosstab

 Selecting headings for a DQA crosstab

 Selecting the data options for a DQA crosstab 

Selecting headings for a DQA crosstab
In the Crosstab Heading Options dialog box, you select the fields that you want to use as column and row headings 
to form the crosstab's grid.
1. If you have not already, complete part 2 of this task.
2. From the "Row headings" box, select the field that contains the labels you want to use as row headings. 
3. From the "Column headings" box, select the field that contains the labels you want use as column headings.
4. Click Continue.

The Crosstab Data Options dialog box appears.

{button ,AL(`H_QA_STEPS;H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEP
S;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_TDCE_STEPS;H_QJ_STEPS',0)} See related topics



Creating a DQA crosstab
This task consists of the following parts:    

 Overview: DQA crosstabs

 Selecting the data for a DQA crosstab

 Selecting the headings for a DQA crosstab 

 Selecting data options for a DQA crosstab
Selecting data options for a DQA crosstab
In the Crosstab Data Options dialog box , you select the field that contains the values for the crosstab to summarize.
1. If you have not already done so, complete parts 2 and 3 of this task.
2. Select the field whose values you want summarized in the cells of the crosstab table.
3. Select the calculation method.
4. Click OK.

1-2-3 creates the crosstab table and places the table in a new sheet. 1-2-3 inserts the new sheet after the current 
sheet.

{button ,AL(`H_123_SELECTING_DATA_OPTIONS_FOR_A_DQA_CROSSTAB_DETAILS',1)} See details
{button ,AL(`H_QA_STEPS;H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEP

S;H_DB_WORKING_WITH_DATABASE_TABLES_OVER;H_TDCE_STEPS;H_QJ_STEPS',0)} See related topics



Details: Selecting data options for a DQA crosstab
Ways to calculate
The table below describes the calculation options available for a DQA crosstab. For more information about the 
calculation, see @Functions A-Z .

Select To @Function
Sum Add the values @SUM
Average Find the average 

value
@AVG

Count Count the nonblank 
cells

@COUNT

Minimum Find the smallest 
value

@MIN

Maximum Find the largest value @MAX
Pure Count Count the cells that 

contain values
@PURECOUNT

STD Calculate the 
population standard 
deviation

@STD

STDS Calculate the sample 
standard deviation

@STDS

VAR Calculate the 
population variance

@VAR

VARS Calculate the sample 
variance

@VARS

{button ,AL(`H_123_SELECTING_DATA_OPTIONS_FOR_A_DQA_CROSSTAB_STEPS',1)} Go to procedure



Set Criteria dialog box
Use this dialog box to set the criteria that selects records from a database table to appear in a DQA query table.

Choose a task
Setting criteria to select the records 
Changing the criteria for a DQA query table 

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS',0)} See 
related topics



Choose Fields dialog box
Use this dialog box to choose the fields that appear in the columns of a DQA query table.

Choose a task
Choosing fields for the DQA query table 
Changing the fields in a DQA query table 
Adding a computed column to a DQA query table 
Changing a computed column in a DQA query table
Showing an alias field name in a DQA query table 

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS',0)} See 
related topics



Set Options dialog box
Use this dialog box to the update the source database table, show unique records in a DQA query table, and set DQA
query table options.

Choose a task
Updating a database table with DQA 
Showing unique records in a DQA query table 
Listing sample values for DQA criteria 
Refreshing a DQA query table 
Limiting the records in a DQA query table 

{button ,AL(`H_TD_OVER;H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS',0)} See 
related topics



Formula dialog box
Use this dialog box to specify the formula for a computed column in a DQA query table.

Choose a task
Adding a computed column to a DQA query table 
Changing a computed column in a DQA query table 



Overview: Working with graphic objects
Graphic objects include charts, maps, pictures, buttons for running scripts and macros, lines, arrows, text blocks, and 
shapes, such as rectangles, ellipses, and polygons. 
You can use lines, arrows, text blocks, and shapes to enhance your data and create great-looking presentations. You 
can also bring pictures into 1-2-3.

Manipulating graphic objects
After you select a graphic object, you can use many techniques to manipulate it. You can perform simple 
manipulations, such as moving and sizing graphic objects.
1-2-3 also provides commands for more advanced manipulations, such as rotating, flipping, and layering graphic 
objects. You can also group graphic objects to manipulate them as a single object.

Styling graphic objects
You can style graphic objects for a variety of visual effects, as shown in the illustration below.

For more information, see Styling graphic objects.

{button ,AL(`H_BRINGING_A_PICTURE_INTO_123_STEPS;H_CREATING_A_FREEHAND_DRAWING_STEPS;H_
CREATING_A_LINE_ARC_OR_ARROW_STEPS;H_CREATING_A_POLYLINE_OR_POLYGON_STEPS;H_CRE
ATING_A_RECTANGLE_OR_ELLIPSE_STEPS;H_CREATING_A_TEXT_BLOCK_STEPS;H_SIZING_GRAPHIC
S_STEPS;H_NAMING_A_GRAPHIC_STEPS;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OB
JECTS_OVER;H_GROUPING_GRAPHICS_STEPS;H_SHUFFLING_GRAPHICS_STEPS;H_123_ALIGNING_GR
APHIC_OBJECTS_TO_SHEET_GRID_LINES_STEPS;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS;H_FINDI
NG_RANGES_AND_OTHER_OBJECTS_STEPS;',0)} See related topics



Styling graphic objects
Using the InfoBox, you can style graphic objects in many different ways. To see the array of styling choices, right-click
the object, choose the Properties command, and click the Lines & Color tab in the InfoBox.
You can:

• Style a line or the border of a shape to make it dashed or dotted.

• Add an arrowhead to a line, polyline, or arc. 

• Add designer frames around rectangular shapes, charts, maps, and parts of objects, such as chart titles.

• Change the interior pattern or color of graphic objects.

{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_THE_INFOBOX_OVER;H_WORKING_W
ITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_CH
ANGING_GRAPHICS_BORDERS_STEPS;H_CHANGING_LINE_STYLES_STEPS;H_CHANGING_INTERIOR_C
OLOR_AND_PATTERN_STEPS;H_USING_DESIGNER_FRAMES_STEPS;',0)} See related topics



Creating a line, arc, or arrow
Use lines, arrows, and arcs to point out and emphasize important data.
1. From the Create menu, choose Drawing.
2. Choose Line, Arrow, or Arc.
3. Move the mouse pointer where you want to start drawing the line, arrow, or arc.
4. Drag across the sheet.
5. Release the mouse button.
Tip To draw horizontal, vertical, or 45-degree lines and arrows, or quarter-circle arcs, SHIFT+drag.

{button ,AL(`H_CREATING_A_LINE_ARC_OR_ARROW_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_STEPS;H_CREATING_A_POLYLINE_OR_POLYGON_STE

PS;H_CREATING_A_RECTANGLE_OR_ELLIPSE_STEPS;H_NAMING_A_GRAPHIC_STEPS;H_SIZING_GRAP
HICS_STEPS;H_STYLING_GRAPHICS_OVER;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY
_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;',0)} See related topics



Details: Creating a line, arc, or arrow
You can drag a line, arc, or arrow to any size or angle. When you draw an arrow, the arrowhead appears at the end 
where you stop dragging.

Changing the arrowheads
To change the direction an arrow points or to create a double-headed arrow, right-click the arrow, choose the 
Properties command, click the Lines & Color tab in the InfoBox, then select an option from the Arrowhead list.

Related SmartIcons

Draws a line

Draws an arc

Draws a forward-pointing arrow

Draws a double-headed arrow

{button ,AL(`H_CREATING_A_LINE_ARC_OR_ARROW_STEPS',1)} Go to procedure



Creating a rectangle or ellipse
Use rectangles, rounded rectangles, squares, ellipses, and circles to emphasize data or to create designs such as 
logos.
1. From the Create menu, choose Drawing.
2. Choose Rectangle, Rounded Rectangle, or Ellipse.
3. Move the mouse pointer where you want to start drawing the shape.
4. Drag until the shape is the size you want.

Tip To draw a square instead of a rectangle or to draw a circle instead of an ellipse, SHIFT+drag.
5. Release the mouse button.

{button ,AL(`H_CREATING_A_RECTANGLE_OR_ELLIPSE_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_STEPS;H_CREATING_A_LINE_ARC_OR_ARROW_STEPS

;H_CREATING_A_POLYLINE_OR_POLYGON_STEPS;H_NAMING_A_GRAPHIC_STEPS;H_STYLING_GRAPHI
CS_OVER;H_SIZING_GRAPHICS_STEPS;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF
_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_123_ALIGNING_GRAPHIC_OBJECTS_TO_THE_GRI
D_STEPS',0)} See related topics



Details: Creating a rectangle or ellipse
Changing rectangles and squares
You can select "Rounded corners" on the Lines & Colors tab in the InfoBox to change the corners of selected 
rectangles and squares.

Related SmartIcons

Draws a rectangle or square

Draws a rounded rectangle

Draws an ellipse or circle

{button ,AL(`H_CREATING_A_RECTANGLE_OR_ELLIPSE_STEPS',1)} Go to procedure



Creating a polyline or polygon
Polylines and polygons are shapes consisting of any number of straight or freehand lines. As shown in the illustration 
below, a polyline is an open shape, and a polygon is closed.

1. From the Create menu, choose Drawing.
2. Choose Polyline or Polygon.
3. Move the mouse pointer where you want to start drawing the first line.
4. Do one of the following: 

• Drag to draw a straight line.
• CTRL+drag to draw a freehand line.
• SHIFT+drag to draw a horizontal, vertical, or 45-degree line segment.

5. Release the mouse button to end the line.
6. Repeat steps 3 through 5 to draw more line segments.

Tip If you start drawing a line and want to erase it and start again, press ESC.
7. To finish, double-click.

Note For a polygon, 1-2-3 automatically connects the last line you drew to the first. 

{button ,AL(`H_CREATING_A_POLYLINE_OR_POLYGON_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_STEPS;H_CREATING_A_LINE_ARC_OR_ARROW_STEPS

;H_CREATING_A_RECTANGLE_OR_ELLIPSE_STEPS;H_NAMING_A_GRAPHIC_STEPS;H_STYLING_GRAPH
ICS_OVER;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_F
OR_OBJECTS_OVER;H_RESHAPING_A_POLYLINE_POLYGON_OR_FREEHAND_DRAWING_STEPS;H_123_
ALIGNING_GRAPHIC_OBJECTS_TO_THE_GRID_STEPS;',0)} See related topics



Details: Creating a polyline or polygon
You can combine straight lines and freehand lines to create polyline or polygon drawings.

Related SmartIcons

Draws a polyline

Draws a polygon

{button ,AL(`H_CREATING_A_POLYLINE_OR_POLYGON_STEPS',1)} Go to procedure



Creating a freehand drawing
1. From the Create menu, choose Drawing, and then choose Freehand.

2. Move the mouse pointer where you want to start the freehand drawing.
3. Drag to draw the shape you want.
4. Release the mouse button.

{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_LINE_ARC_OR_ARROW_STEPS;H_CREATING_A_POLYLINE_OR_POLYGON_ST

EPS;H_NAMING_A_GRAPHIC_STEPS;H_STYLING_GRAPHICS_OVER;H_WORKING_WITH_GRAPHICS_OV
ER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_RESHAPING_A_POLYL
INE_POLYGON_OR_FREEHAND_DRAWING_STEPS;',0)} See related topics



Details: Creating a freehand drawing
You can create many individual freehand lines or shapes and then group them to create a complex freehand drawing.

{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_STEPS',1)} Go to procedure
{button ,AL(`H_GROUPING_GRAPHICS_STEPS;',0)} See related topics



Creating a text block
You can use text blocks to point out important data.

 Show me a QuickDemo
1. From the Create menu, choose Text.

2. Move the mouse pointer where you want the text block to appear.
3. Click to create a default-sized text block, or drag until the text block is the size you want.
4. Release the mouse button.
5. Enter text by typing or by pasting it from the Clipboard.

Tip To paste text from the Clipboard into a text block, press CTRL+V rather than choosing Edit - Paste.
6. When you finish entering text, click a cell in the sheet.

{button ,AL(`H_CREATING_A_TEXT_BLOCK_DETAILS',1)} See details
{button ,AL(`H_EDITING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_C

HANGING_TEXT_FORMAT_STEPS;H_SIZING_GRAPHICS_STEPS;H_STYLING_GRAPHICS_OVER;H_WORK
ING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVE
R;H_123_ALIGNING_GRAPHIC_OBJECTS_TO_THE_GRID_STEPS;',0)} See related topics



Details: Creating a text block
If you cannot see all the text in a text block, change the size of the text block or change the font size of the text.
To start a new line in a text block, press ENTER.

{button ,AL(`H_CREATING_A_TEXT_BLOCK_STEPS',1)} Go to procedure
{button ,AL(`H_CHANGING_TEXT_FORMAT_STEPS;H_SIZING_GRAPHICS_STEPS;',0)} See related topics



Naming a graphic object
Naming graphic objects makes it easier to find them using Edit - Go To. 1-2-3 assigns a default name, such as "Line 
1," to every graphic object, but you can use the InfoBox to change the name. 
1. Select the graphic object or group of graphic objects you want to name.
2. Right-click the selection and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Enter a name in the "Object name" box, according to the naming conventions.
Object is the type of graphic object selected; for example, "Line."

5. (Optional) Move, collapse, or close the InfoBox.
Note The name of the graphic object appears in the selection indicator. when the object is selected.

{button ,AL(`H_NAMING_A_GRAPHIC_DETAILS',1)} See details
{button ,AL(`H_NAMING_CONVENTIONS_OVER;H_STYLING_GRAPHICS_OVER;H_WORKING_WITH_GRAPHIC

S_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_FINDING_RANG
ES_AND_OTHER_OBJECTS_STEPS;H_THE_INFOBOX_OVER;H_GROUPING_GRAPHICS_STEPS;',0)} See 
related topics



Details: Naming a graphic object
Do not assign the same name to two graphic objects in the same workbook.
By default, 1-2-3 names the first line you create Line 1, the next line Line 2, and so on. As you create each type of 
graphic object, the number in the default name for the object increases.
The name of a graphic object is not a caption for the object and does not appear with the object in the sheet.

{button ,AL(`H_NAMING_A_GRAPHIC_STEPS',1)} Go to procedure



Bringing a picture into 1-2-3
You can bring a picture from another application into 1-2-3. For example, you can create or edit a picture in Microsoft 
Paint and bring it into a 1-2-3 sheet.
In this release of 1-2-3, you can attach a LotusScript Click event to a picture to automate a task when you click the 
picture.
1. From the Create menu, choose Drawing, and then choose Picture.

2. From the "Look in" list, select the drive and folder containing the picture file.
3. (Optional) Select the file type of the picture in the "Files of type" list.
4. Select the picture file you want from the "File name" list.
5. Click Open.
6. Click the place in the sheet where you want to put the top left corner of the picture.
Tip You can also bring a picture into 1-2-3 by copying it to the Clipboard and pasting it in the sheet.

{button ,AL(`H_BRINGING_A_PICTURE_INTO_123_DETAILS',1)} See details
{button ,AL(`H_123_RESTORING_A_PICTURE_TO_ITS_ORIGINAL_SIZE_STEPS;H_STYLING_GRAPHICS_OVE

R;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJ
ECTS_OVER;H_123_ALIGNING_GRAPHIC_OBJECTS_TO_THE_GRID_STEPS;',0)} See related topics



Details: Bringing a picture into 1-2-3
Types of pictures you can bring into 1-2-3
The types of pictures you can bring into 1-2-3 are the following:

• Bitmap (.BMP)
• Windows metafile (.WMF)
• 1-2-3 picture (.PIC)
• ANSI metafile (.CGM)
• GIF image (.GIF)
• JPEG image (.JPG, .JPEG)

Sizing pictures
When you bring a picture into a sheet, 1-2-3 sizes the picture according to the dimensions specified in the original 
graphics file. The size information in the original picture file does not change when you resize the picture in the sheet.
You can drag a handle to change the size of a picture; however, sizing the picture may distort its original proportions. 
To restore the picture to its original size, select it and choose Drawing - Restore to Original Size.

Attaching a LotusScript Click event to a picture
You can attach a LotusScript Click event to a picture. When you click the picture, 1-2-3 runs the script that is attached
to the picture. To attach a Click event to a picture, use the Create - Drawing - Picture command to bring the picture 
into the workbook. Then open the Script Editor, select the name of the picture from the "Object" list, and enter the 
script. For more information about LotusScript, see Overview: Using LotusScript or 123: Click Event. 

Attaching a hyperlink to a picture
You can also attach a hyperlink to a picture, and choose whether you want the hyperlink to jump to a location on the 
Internet, to another file, or to a range or object in the current workbook. For more information, see Creating a 
hyperlink.    

{button ,AL(`H_BRINGING_A_PICTURE_INTO_123_STEPS',1)} Go to procedure
{button ,AL(`H_SIZING_GRAPHICS_STEPS;',0)} See related topics



Restoring a picture to its original size
If you resized a picture after bringing it into 1-2-3, you can easily restore it to its original size.
1. Select the picture.
2. From the Drawing menu, choose Restore to original size.

{button ,AL(`H_123_RESTORING_A_PICTURE_TO_ITS_ORIGINAL_SIZE_DETAILS',1)} See details
{button ,AL(`H_STYLING_GRAPHICS_OVER;H_WORKING_WITH_GRAPHICS_OVER;H_SIZING_GRAPHICS_ST

EPS;H_BRINGING_A_PICTURE_INTO_123_STEPS;',0)} See related topics



Details: Restoring a picture to its original size
Sizing pictures
When you bring a picture into a sheet, 1-2-3 sizes the picture according to the dimensions specified in the original 
graphics file. The size information in the the original picture file does not change when you resize the picture in the 
sheet.

{button ,AL(`H_123_RESTORING_A_PICTURE_TO_ITS_ORIGINAL_SIZE_STEPS',1)} Go to procedure



Fastening graphic objects to cells
You can change how a graphic object is fastened to the cells behind it.
1. Select one or more graphic objects.
2. Right-click the graphic object(s) and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Under Fasten to cells, select an option.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FASTENING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_STYLING_GRAPHICS_OVER;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_

SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_THE_INFOBOX_OVER;H_LOCKING_OR_UNLOCKING
_GRAPHICS_STEPS;H_GROUPING_GRAPHICS_STEPS;H_123_ALIGNING_GRAPHIC_OBJECTS_TO_THE_
GRID_STEPS',0)} See related topics



Details: Fastening graphic objects to cells
Options for fastening graphic objects
The "Fasten to cells" options determine how 1-2-3 fastens a graphic object to the cells behind the object.

• Top-left and bottom-right -- The graphic object changes size and position when you move, size, or hide the cells 
behind it.

• Top-left only -- The graphic object moves but stays the same size when you move, size, or hide the cells behind it.
• Not fastened -- The graphic object is detached from the underlying cells; it doesn't move or change size when you

move, size, or hide the cells behind it.

How 1-2-3 fastens graphic objects
When you create a graphic object, it fastens by default to the cells behind its top left and bottom right corners. An 
object fastened in this way can move and change size with the cells behind it.
For example, when you create a rectangle, it fastens to the cells behind its top left and bottom right corners. It can 
move and change size when you insert or delete cells, columns, and rows; or when you change column widths and 
row heights.

Sizing a graphic object does not change the way it was fastened.

{button ,AL(`H_FASTENING_GRAPHICS_STEPS',1)} Go to procedure



Flipping graphic objects
You can flip most graphic objects horizontally or vertically.
1. Select one or more graphic objects.
2. Right-click the selected object(s) and choose Flip Left-Right or Flip Top-Bottom.
Note You cannot flip charts, maps, embedded objects, buttons, pictures, or text blocks.

{button ,AL(`H_FLIPPING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_SHUFFLING_GRAPHICS_STEPS;H_ROTATING_GRAPHICS_STEPS;H_RESHAPING_A_POLYLIN

E_POLYGON_OR_FREEHAND_DRAWING_STEPS;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMM
ARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;',0)} See related topics



Details: Flipping graphic objects
Flipping more than one graphic object
If you select more than one graphic object to flip, 1-2-3 flips the entire selection as a group. Any locked graphic 
objects in the group do not flip. 

Related SmartIcons

Flips a graphic object horizontally left to right

Flips a graphic object vertically top to bottom

{button ,AL(`H_FLIPPING_GRAPHICS_STEPS',1)} Go to procedure



Grouping graphic objects
You can group graphic objects to manipulate and style them as a group rather than individually. Graphic objects stay 
grouped until you ungroup them.
1. Select the graphic objects you want to group.
2. Right-click the objects and choose the Group command.

{button ,AL(`H_GROUPING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_UNGROUPING_GRAPHICS_STEPS;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMAR

Y_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_SHUFFLING_GRAPHICS_STEPS;',0)} See 
related topics



Details: Grouping graphic objects
Before you group graphic objects, each object has its own set of handles, as shown below.

After you group graphic objects, the group has one set of handles, as shown below.

Related SmartIcons

Groups the selected graphic objects

Ungroups the selected graphic objects

Selects several graphic objects

{button ,AL(`H_GROUPING_GRAPHICS_STEPS',1)} Go to procedure



Hiding or redisplaying graphic objects
You can use the InfoBox to hide or redisplay selected graphic objects in the current workbook.
1. Select one or more graphic objects.

Note To select hidden graphic objects, use Edit - Go To.
2. Right-click the graphic object(s) and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Under Misc, select or deselect "Hide."
5. (Optional) Move, collapse, or close the InfoBox.
Note To hide all graphic objects or redisplay all hidden graphic objects in the current workbook, use File - Workbook 
Properties (View tab).

{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_LOCKING_OR_U
NLOCKING_GRAPHICS_STEPS;H_WORKING_WITH_GRAPHICS_OVER;H_FINDING_RANGES_AND_OTHE
R_OBJECTS_STEPS;H_THE_INFOBOX_OVER;H_NAMING_A_GRAPHIC_STEPS;',0)} See related topics



Locking or unlocking graphic objects
Locked graphic objects cannot be moved, sized, deleted, styled, or manipulated.
1. Select one or more graphic objects.
2. Right-click the graphic object(s) and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Under Misc, select or deselect "Lock."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_LOCKING_OR_UNLOCKING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_HIDING_OR_REDISPLAYING_GRAPHICS_STEPS;H_WORKING_WITH_GRAPHICS_OVER;H_QUI

CK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_THE_INFOBOX_OVER;',0)} See 
related topics



Details: Locking or unlocking graphic objects
When you select a locked graphic object, its handles are diamond-shaped rather than square.

Locked charts and maps change if the data they refer to changes.

Keeping a graphic object locked
Locking a graphic object prevents accidental changes, but it does not prevent you or others from unlocking the 
graphic object.
To prevent others from unlocking a graphic object, you can lock the workbook so that you or others must enter a 
password to make changes to the workbook. For more information, see Locking workbook contents. 

{button ,AL(`H_LOCKING_OR_UNLOCKING_GRAPHICS_STEPS',1)} Go to procedure



Moving graphic objects
You can drag graphic objects to move them.
1. Select one or more graphic objects.
2. Drag the graphic object(s) by any part except the handles.

Tip CTRL+drag to copy a graphic object and move the copy.
3. Release the mouse button.
Note You cannot move a locked graphic object.

{button ,AL(`H_MOVING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_SIZING_GRAPHICS_STEPS;H_FLIPPING_GRAPHICS_STEPS;H_ROTATING_GRAPHICS_STEPS;

H_SHUFFLING_GRAPHICS_STEPS;H_LOCKING_OR_UNLOCKING_GRAPHICS_STEPS;H_WORKING_WITH
_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_COPY
ING_AND_MOVING_OVER;',0)} See related topics



Details: Moving graphic objects
Moving several graphic objects at once
If you select more than one graphic object, you can move them all by dragging one.

Moving transparent shapes
When moving a transparent rectangle or other shape, drag it by the border, not by the interior.

{button ,AL(`H_MOVING_GRAPHICS_STEPS',1)} Go to procedure
{button ,AL(`H_COPYING_AND_MOVING_OVER;H_COPYING_AND_MOVING_IN_A_SHEET_STEPS;H_COPYIN

G_AND_MOVING_TO_ANOTHER_SHEET_STEPS;H_COPYING_AND_MOVING_TO_A_NEW_SHEET_STEPS;
',0)} See related topics



Reshaping a polyline, polygon, or freehand drawing
You can reshape a polyline, polygon, or freehand drawing by displaying the points and moving them.
1. Select the polyline, polygon, or freehand drawing.
2. Right-click the object and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Under Misc, select "Show points."
5. Drag the points to change the shape of the object.
6. (Optional) Move, collapse, or close the InfoBox.
Note You cannot reshape a locked polyline, polygon, or freehand drawing.

{button ,AL(`H_RESHAPING_A_POLYLINE_POLYGON_OR_FREEHAND_DRAWING_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_FREEHAND_DRAWING_STEPS;H_CREATING_A_POLYLINE_OR_POLYGON_STE

PS;H_WORKING_WITH_GRAPHICS_OVER;H_THE_INFOBOX_OVER;H_LOCKING_OR_UNLOCKING_GRAP
HICS_STEPS;H_123_ALIGNING_GRAPHIC_OBJECTS_TO_THE_GRID_STEPS',0)} See related topics



Details: Reshaping a polyline, polygon, or freehand drawing
You can move the points in a polyline, polygon, or freehand drawing, but you cannot add new points or delete existing
ones.

{button ,AL(`H_RESHAPING_A_POLYLINE_POLYGON_OR_FREEHAND_DRAWING_STEPS',1)} Go to procedure



Aligning graphic objects to the grid
You can use the sheet grid lines as guides for placing, aligning, and sizing one or more graphic objects. 

Aligning a graphic object when you create it
When you align an object as you create it, its edges snap to the grid lines of the cells you drag over.    
1. Choose the command from the Create menu or click the icon for the object you want to create.
2. Move the mouse pointer where you want to place one of the corners.
3. Do one of the following:

• To create an object that fills a single cell, SHIFT+CTRL+click the cell.
• To align all four edges to grid lines, SHIFT+CTRL+drag in the direction that you want to draw the object.
• To place one corner in the middle of a cell and align the opposite corner to grid lines, begin to drag in the 

middle of the cell, then press SHIFT+CTRL and continue to drag in the direction that you want to draw the 
object.

4. Release the mouse button and keys when the object is the size you want.

Aligning a graphic object when you resize it
When you SHIFT+CTRL+drag to resize an object, only the borders you are changing snap to the grid lines.
1. Select the graphic object.
2. SHIFT+CTRL+drag a handle in the direction you want to size the object.
3. Release the mouse button and keys when the object is the size you want.
Note You cannot use this method to draw or resize lines or arrows, draw freehand drawings, or align squares or 
circles that you create with SHIFT+drag.

{button ,AL(`H_SIZING_GRAPHICS_STEPS;H_BRINGING_A_PICTURE_INTO_123_STEPS;H_CREATING_A_CHA
RT_IN_123_STEPS;H_CREATING_A_MAP_STEPS;H_CREATING_A_RECTANGLE_OR_ELLIPSE_STEPS;H_C
REATING_A_POLYLINE_OR_POLYGON_STEPS;H_CREATING_A_TEXT_BLOCK_STEPS;',0)} See related 
topics



Rotating graphic objects
1. Select one or more graphic objects.
2. Right-click the graphic object(s) and choose the Properties command.
3. Click the Basics tab in the InfoBox.

4. Specify the degree of rotation in the "Rotation" box.
5. (Optional) Move, collapse, or close the InfoBox.
Note You cannot rotate embedded or locked graphic objects, charts, maps, buttons, pictures, or text blocks.

{button ,AL(`H_ROTATING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FO

R_OBJECTS_OVER;H_THE_INFOBOX_OVER;H_FLIPPING_GRAPHICS_STEPS;H_MOVING_GRAPHICS_ST
EPS;H_SHUFFLING_GRAPHICS_STEPS;',0)} See related topics



Details: Rotating graphic objects
Rotating several graphic objects at once
If you select more than one graphic object and rotate them, the objects rotate as a group around the center of the 
group.

{button ,AL(`H_ROTATING_GRAPHICS_STEPS',1)} Go to procedure



Layering graphic objects
When graphic objects overlap, you can change the way they are layered by shuffling objects to the front or back.
1. Select one or more graphic objects.
2. Right-click the object(s) and choose Bring to Front or Send to Back.

{button ,AL(`H_SHUFFLING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_MOVING_GRAPHICS_STEPS;H_FLIPPING_GRAPHICS_STEPS;H_ROTATING_GRAPHICS_STEP

S;H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJ
ECTS_OVER;',0)} See related topics



Details: Layering graphic objects
The illustration below shows what happens when you shuffle graphic objects that overlap, bringing one graphic object
to the front.

You cannot shuffle parts of maps or charts, such as titles, legends, notes, and axes.

Related SmartIcons

Brings the selected graphic object to the front of the stack

Sends the selected graphic object to the back of the stack

{button ,AL(`H_SHUFFLING_GRAPHICS_STEPS',1)} Go to procedure



Sizing graphic objects
1. Select one or more graphic objects.
2. Drag a handle in the direction you want to size the object.

Tip To maintain original proportions, SHIFT+drag a corner handle. To align the object to sheet grid lines, 
SHIFT+CTRL+drag a handle.

3. Release the mouse button when the object is the size you want.

{button ,AL(`H_SIZING_GRAPHICS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FO

R_OBJECTS_OVER;H_123_RESTORING_A_PICTURE_TO_ITS_ORIGINAL_SIZE_STEPS;H_123_ALIGNING_
GRAPHIC_OBJECTS_TO_THE_GRID_STEPS',0)} See related topics



Details: Sizing graphic objects
You drag different handles to size a graphic object the way you want. 

Restoring the size of a graphic object
While dragging to size a graphic object, you can restore it to its original size by pressing ESC.
After releasing the mouse button, you can restore a graphic object to its original size by immediately choosing Edit - 
Undo.

Sizing several graphic objects at once
If you select more than one graphic object to size, you can size them all by dragging a handle of one.

{button ,AL(`H_SIZING_GRAPHICS_STEPS',1)} Go to procedure



Ungrouping graphic objects
You can ungroup graphic objects to manipulate them individually.
1. Select one or more groups of graphic objects.
2. Right-click the selected group(s) and choose the Ungroup command.

Related SmartIcons

Ungroups the selected group(s)

Groups the selected graphic objects

{button ,AL(`H_WORKING_WITH_GRAPHICS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FO
R_OBJECTS_OVER;H_GROUPING_GRAPHICS_STEPS;',0)} See related topics



Overview: ActiveX controls and JavaBeans in 1-2-3
ActiveX controls and JavaBeans are types of OLE controls. Once you embed these controls in a workbook, you can 
name them and program them using LotusScript to create customized applications in 1-2-3. 
This release of 1-2-3 provides support for a limited set of ActiveX controls and JavaBeans including controls from 
Microsoft Visual Basic 5.0 and beans from ProtoView Development's JSuite.

About ActiveX controls
ActiveX controls are components that provide a specific service a developer can use in a customized application. You
can embed ActiveX controls in a workbook and then attach scripts to the controls to create customized applications. 
ActiveX controls have the file extension .OCX.

About JavaBeans
JavaBeans are self contained objects, similar to ActiveX controls, that can be used with other beans to create 
applications. Like ActiveX controls, you can embed JavaBeans in a workbook and then attach scripts to them. 

Scripting ActiveX controls and JavaBeans
Some controls have the ability to generate events such as MouseOver when you pass the mouse over the control, or 
Click when you click the control. Once you embed a control or a bean and name it, 1-2-3 displays the control and its 
events in the Script Editor. You can write a script for any event displayed in the Script Editor.
Other controls do not generate events because they are designed to function independently. For example, you might 
find a control that lets you play movies or sounds but does not generate any events for you to script.

{button ,AL(`H_123_BEFORE_YOU_BEGIN_DESIGNING_CONTROLS_STEPS;H_123_INSTALLING_THE_JAVA_R
UNTIME_ENVIRONMENT_STEPS;',0)} See related topics



Using ActiveX controls and JavaBeans in 1-2-3
This task consists of the following parts:

 Before you begin designing controls

 Embedding ActiveX controls and JavaBeans in a workbook

 Setting the properties for a control 

 Writing scripts and testing controls 

Before you begin designing controls
If you are an application developer who is creating custom applications in 1-2-3 using ActiveX controls or JavaBeans, 
you need to know about Design and Run modes.
Design and Run modes provide a convenient way to design and test your applications.

• In Design mode, you can set the properties of a control and attach scripts to it. You can also move, size, copy, 
and delete a control.

• In Run mode, you can run a control to see how it works.
Initially, the menu command for switching between Design and Run modes is hidden, and 1-2-3 is always in Run 
mode. You should display the menu command so you can switch between these modes when you are scripting and 
testing the controls.

To display the Design and Run mode command
1. From the View menu, choose Set View Preferences.
2. Select the option to display the Design and Run command on the View menu.

3. (Optional) If you want Design and Run commands to appear on the View menu in every new file you open, click 
Make Default for New Workbooks.

4. Click OK.
1-2-3 adds a Design/Run toggle command to the end of the View menu. You use these commands to work with the 
controls as you add them to a workbook.
Tip Add the following icon to your 1-2-3 icon set so you can quickly toggle between Design and Run modes.

{button ,AL(`H_123_BEFORE_YOU_BEGIN_DESIGNING_CONTROLS_DETAILS',1)} See details
{button ,AL(`H_123_ACTIVEX_AND_JAVA_CONTROLS_OVER',0)} See related topics



Details: Before you begin designing controls
Design and Run modes allow you to switch between designing and testing a spreadsheet application which includes 
embedded ActiveX controls and JavaBeans.

About Design mode
Design mode is a development environment in which you can work with the control by manipulating properties and 
assigning actions.
In Design mode, you can

• Select, copy, move, and size a control
• Change a control's properties
• Write and attach scripts to a control

When you select a control, 1-2-3 displays the name of the control on the context menu, and also displays the 
SmartIcons and status bar controls for working with OLE objects.
Mouse actions in Design mode:

• Single click on a control selects it
• Double-click on a control with events opens the Script Editor to the default event
• Right-mouse click on a control displays the control's menu 

About Run mode
You use Run mode to see how the controls work.
In Run mode 

• All controls are activated
• Controls can get focus, but you cannot select or change a control
• The right mouse menu for any control is determined by the control

{button ,AL(`H_123_BEFORE_YOU_BEGIN_DESIGNING_CONTROLS_STEPS',1)} Go to procedure



Using ActiveX controls and JavaBeans in 1-2-3
This task consists of the following parts:

 Before you begin designing controls 

 Embedding ActiveX controls and JavaBeans in a workbook

 Setting the properties for a control 

 Writing scripts and testing controls

Embedding ActiveX controls and JavaBeans in a workbook
You can embed ActiveX controls and JavaBeans in a 1-2-3 workbook to create customized applications for other 
users. Before you can embed JavaBeans in a 1-2-3 workbook, you must install the Java Runtime Environment. See 
Installing the Java Runtime Environnment. 
1. From the Create menu, choose Object. 
2. Under Create new, select Control or JavaBean.

Note If JavaBean appears dimmed, you need to install the Java Runtime Environment (JRE).
3. From the "Object type" list, select the type of control that you want to create. 
4. Click OK.
5. Click the sheet where you want the top left corner of the control to appear. 
1-2-3 embeds the control in the sheet. When you select the control, 1-2-3 adds the control's name to the menu so 
you can work with the control. When 1-2-3 is in Design mode, you can use the control's menu to change the 
properties and other settings. 

{button ,AL(`H_123_ACTIVEX_AND_JAVA_CONTROLS_OVER;H_123_INSTALLING_THE_JAVA_RUNTIME_ENVI
RONMENT_STEPS',0)} See related topics



Using ActiveX controls and JavaBeans in 1-2-3
This task consists of the following parts:

 Before you begin designing controls 

 Embedding ActiveX controls and JavaBeans in a workbook

 Setting the properties for a control

 Writing scripts and testing controls

Setting the properties for a control
The Object - Properties command opens the InfoBox where you can set some basic properties for the control. Some 
controls, however, also have control-specific properties that you can set using a dialog box that comes with that 
control.
1. From the View menu, choose Design controls to put 1-2-3 in Design mode.

Note If you do not see this command on the View menu, you need to enable Design and Run modes. See Before
you begin designing controls.    

2. Right-click the control to display the menu for the control. 
Depending on the control, you may see two Properties commands,

3. Choose Object - Properties to open the InfoBox.
4. On the Basics tab, enter a name that you will also use in scripts.
5. (Optional) Move, collapse, or close the InfoBox.
6. Some controls also have a dialog box where you can set properties. Right-click the control again and choose 

Properties to open the dialog box for that control.
7. Review and change any of the properties.

{button ,AL(`H_123_ACTIVEX_AND_JAVA_CONTROLS_OVER;H_USING_THE_INFOBOX_STEPS',0)} See related 
topics



Using ActiveX controls and JavaBeans in 1-2-3
This task consists of the following parts:

 Before you begin designing controls    

 Embedding ActiveX controls and JavaBeans in a workbook

 Setting properties of a control 

 Writing scripts and testing controls 

Writing scripts and testing controls
You use the Script Editor to write scripts for each control.
1. From the View menu, choose Design Controls to put 1-2-3 in Design mode.

Note If you do not see this command on the View menu, you need to enable Design and Run modes. See Before
you begin designing controls.

2. Click the control.
3. From the Edit menu, choose Scripts & Macros and then choose Show Script Editor.
4. Use the Script Editor to write the scripts for each control. 

For more information on using the Script Editor, choose Help from the Script Editor menu. 
5. When you are ready to test the controls, choose View - Run Controls to put 1-2-3 in Run mode.
6. Test the controls.
7. When you have finished writing and debugging scripts for the application, you can hide the Design/Run menu so 

a user cannot change the controls. Choose View - View Preferences and deselect the option for this menu. 

8. Save the file.
When someone else opens the file, 1-2-3 is in Run mode by default.

{button ,AL(`H_INSTALLING_123_SCRIPT_HELP_STEPS;H_LOTUSSCRIPT_INDEX_TOPIC_OVER;H_123_ACTIV
EX_AND_JAVA_CONTROLS_OVER',0)} See related topics



Installing the Java Runtime Environment (JRE)
You must install the Java Runtime Environment (JRE) before you can embed JavaBeans in a 1-2-3 workbook. 
Caution Do not    install the Winsock2.dll when you install the Java Runtime Environment if you use Lotus Notes.You 
can run JavaBeans without installing this file.
1. Using Windows Explorer, locate the \EXTRA\JRE folder on the SmartSuite CD-ROM or on the server from which 

you installed 1-2-3 or SmartSuite.
Note When you put the SmartSuite CD in the drive, it pops up an AutoRun window. You can click Extras to open 
the Extra folder and then click the JRE folder.

2. Double-click the file named jre116.exe.
This file installs the Java Runtime Environment.

3. Follow the install instructions.



Overview: Editing data
Edit an entry when you want to change data or replace it entirely. 

Where you edit data
You can edit a cell entry either in the cell or in the contents box by double-clicking the cell or clicking the contents box
when the cell is selected. When you edit in the contents box, (as shown below) the cancel and confirm buttons 
appear.

Data you can edit
You can edit:

• Cell contents
• Text in text blocks and cell comments
• Legends, labels, titles, and notes in charts
• Legends and titles in maps

Editing dates
When you edit dates, 1-2-3 uses the date setting for 2-digit years you selected in the 1-2-3 Preferences dialog box. 
The default setting is "Interpret entry of 2-digit years using sliding window around system date." For example, you can
change a date such as 2/1/05 to 2/2/05, and 1-2-3 interprets the year as 2005. 
For more information, see 1-2-3 and the year 2000.

Finding and replacing data
Choose Edit - Find and Replace to search through the workbook or sheet to find and replace characters. You can find
and replace values as well as labels.

Checking spelling
Choose Edit - Check Spelling to correct misspelled words and check for duplicate words, such as "the the" in cells, 
charts, and text blocks.

{button ,AL(`H_EDITING_A_CELL_COMMENT_STEPS;H_EDITING_DATA_IN_A_CELL_STEPS;H_EDITING_DATA
_IN_TEXT_BLOCKS_STEPS;H_ENTERING_DATA_OVER;H_MODIFYING_MAPS_OVER;H_CHECKING_SPEL
LING_STEPS;H_FINDING_DATA_OVER;H_CREATING_A_CHART_IN_123_OVER;',0)} See related topics



Editing data in a cell
1. Double-click the cell you want to edit.
2. Edit the entry.
3. Press ENTER.
Tip To replace an entry entirely, select the cell, type the new entry, and press ENTER.

{button ,AL(`H_EDITING_DATA_IN_A_CELL_DETAILS',1)} See details
{button ,AL(`H_EDITING_DATA_OVER;H_ENTERING_DATA_OVER;',0)} See related topics



Details: Editing data in a cell
To Press
Delete characters to the 
left of the insertion point

BACKSPACE

Delete characters to the 
right of the insertion point

DEL

Scroll through the cell 
contents

HOME, END, ®, or ¬

Other ways to edit data in a cell
• Select the cell and press F2 (EDIT), edit the entry, then press ENTER. 
• Select the cell to edit, click the contents box at the point where you want to begin editing, edit the entry, then click 

the Confirm button. 

Note You can right-click the cell to cut, copy, paste, or clear data in a cell.

Canceling editing
To cancel the edits you're making, press ESC. Pressing ESC abandons the edit and restores the text that was in the 
cell before you started editing.
Note Once you begin an edit in a cell, you cannot switch to editing in the contents box. Once you begin an edit in the 
contents box, you cannot switch to editing in a cell. 

{button ,AL(`H_EDITING_DATA_IN_A_CELL_STEPS',1)} Go to procedure
{button ,AL(`H_EDITING_KEYS_OVER;',0)} See related topics



Editing data in text blocks
1. Double-click the text block.
2. Edit the text.
3. When you finish editing, click outside the text block.

{button ,AL(`H_EDITING_DATA_IN_TEXT_BLOCKS_DETAILS',1)} See details
{button ,AL(`H_EDITING_DATA_OVER;H_CREATING_A_TEXT_BLOCK_STEPS;',0)} See related topics



Details: Editing data in text blocks
To Press
Delete characters to the left 
of the insertion point

BACKSPACE

Delete characters to the 
right of the insertion point

DEL

Scroll through the text block 
contents

HOME, END, PG UP, PG DN, , ¯, ®, or ¬

Styling text blocks
You can apply only one font, color, and alignment to all the text in a text block. You can change the border, 
background color, and pattern of a text block. Use Drawing - Drawing Properties to style text blocks.

Locked text blocks
If the text block is locked, its handles are diamond-shaped. To unlock the text block so you can edit it, select it and 
use Drawing - Drawing Properties (Basics tab).
Locked

Unlocked

{button ,AL(`H_EDITING_DATA_IN_TEXT_BLOCKS_STEPS',1)} Go to procedure



Editing a cell comment
1. Click the cell containing the cell comment.
2. Choose Range - Cell Comment.

3. (Optional) Click Name and Date Stamp.
4. Edit the cell comment.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_EDITING_A_CELL_COMMENT_DETAILS',1)} See details
{button ,AL(`H_EDITING_DATA_OVER;H_CREATING_A_CELL_COMMENT_STEPS;H_123_PRINTING_CELL_CO

MMENTS_AND_FORMULAS_STEPS;',0)} See related topics



Details: Editing a cell comment
You cannot style the text in a cell comment.

Using the Name and Date Stamp button
Clicking Name and Date Stamp on the Cell Comment tab in the InfoBox inserts your user name and the date and 
time at the top of the cell comment. 

Related SmartIcons

Sets cell comment marker display as well as other view preferences for the current workbook

{button ,AL(`H_EDITING_A_CELL_COMMENT_STEPS',1)} Go to procedure



Overview: Entering data
You build a spreadsheet by entering data, such as numbers, text, dates, times, and formulas. 

Where you enter data
You can enter data in either the cell or the contents box. If you enter data in the contents box, the Cancel and Confirm
buttons appear. You can enter up to 512 characters.

While you enter data
While you enter data in a cell, you can't perform other tasks until you cancel or confirm the entry. To continue, you 
must either cancel or confirm the entry.

Confirming an entry
When you confirm an entry, 1-2-3 stores the data in the cell. You confirm an entry by doing any of the following:

• Pressing ENTER

• Pressing , ¯, ®, ¬, or clicking outside the cell
• Clicking the Confirm button if you're entering in the contents box

Canceling an entry
When you cancel an entry, 1-2-3 abandons the entry, leaving the cell blank (or filled with the previous contents). 
While entering data, you can cancel an entry by doing one of the following:

• Pressing ESC

• Clicking the Cancel button if you're entering in the contents box

About text entries
Text entries are called labels. Labels can contain letters, numbers, or a combination of letters and numbers. 

Entering numbers as labels
If the first character you enter is a number, 1-2-3 assumes that you are entering a value you want to use in 
calculations. 1-2-3 treats any entry that combines letters with numbers as a label.
If you want to enter numbers as a label, you must start your entry with a label-prefix character. Label-prefix characters
indicate that you are entering a label; they also set alignment for the cell or repeat the label.

Label-prefix character Effect
' (apostrophe) Left alignment
" (quotation mark) Right alignment
^ (caret) Center alignment
\ (backslash) Repeats label in the cell

Entering addresses
When you enter a street address, 1-2-3 automatically inserts a label-prefix character. For example, if you enter 10 
Main Street, and then press ENTER, 1-2-3 treats the entry as a label. 

About numeric entries



Numeric entries are called values. Values can be numbers, formulas, or @functions. Formulas calculate or combine 
numbers and text. @Functions are built-in formulas that calculate with numbers and text.

How 1-2-3 formats numbers
When you enter numbers, 1-2-3 formats them automatically as Comma, Percent, or Scientific depending on the 
symbols you use. For example, if you enter 37%, 1-2-3 formats the number in Percent format. If you enter 27,322, 1-
2-3 formats the number in Comma format. If you enter a plain number, such as 3700 or 37.50, 1-2-3 enters the 
number using the default format (initially General format). In addition, 1-2-3 will automatically format numbers you 
enter using standard date and time formats, or one of the formats on the Frequently Used list in the status bar.
If you format a number and 1-2-3 fills the cell with *** (asterisks), the column is not wide enough to display the 
number using the format you selected. 

Entering dates and times
You can enter a date or time, for example, 04/19/48 or 11:10 PM, as either a label or a value. When you enter dates 
or times as labels, remember to enter a label-prefix character first, if the date or time begins with a number. 
You can use dates and times entered as values in calculations. For example, you can calculate the number of days in
between two dates or quickly change the appearance of a date from 4/9/48 to 09-Apr-48. You can also use 
@functions such as @DATE and @TIME to enter dates and times and calculate with them.
1-2-3 stores date and time values as date and time numbers, but displays them in the format you specify. 1-2-3 
automatically formats dates entered as Apr-48, 09-Apr, 09-Apr-48, or 04/09/48. 1-2-3 also automatically formats times
entered in any of the standard time formats except hh.mm (hour.minutes).

Entering dates and the year 2000
1-2-3 is year 2000 ready. You can enter dates with either a 2-digit (for example, 4/2/15) or 4-digit year (for example, 
4/2/2015). For more information, see 1-2-3 and the year 2000. You can also control how 1-2-3 stores and displays a 
date. For information, see Setting options for dates.

Notes
• To make sure you get the results you want, you can always enter and display the year as 4 digits. 
• You can display dates in a variety of formats that include 2-digit and 4-digit years. 
• Displaying dates with 4 digits for the year will make dates wider, so some dates may display as *** (asterisks). 

Widen the column to display the date instead of asterisks. You may also need to adjust some print ranges.

{button ,AL(`H_CREATING_A_CELL_COMMENT_STEPS;H_EDITING_DATA_OVER;H_ENTERING_DATES_STEP
S;H_ENTERING_NUMBERS_STEPS;H_ENTERING_TEXT_STEPS;H_ENTERING_TIMES_STEPS;H_123_SET
TING_OPTIONS_DATES_STEPS',0)} See related topics



Entering numbers
1. Click the cell where you want to enter the number.
2. Type the number.
3. Press ENTER to confirm.
Tip To enter a number as currency or a percentage, include the currency symbol or the % sign (for example, type 
$200 or 95%). 

{button ,AL(`H_ENTERING_NUMBERS_DETAILS',1)} See details
{button ,AL(`H_ENTERING_AN_ATFUNCTION_STEPS;H_ENTERING_A_FORMULA_STEPS;H_ENTERING_DATA

_OVERH_FORMATTING_NUMBERS_STEPS;H_ENTERING_DATES_STEPS;H_ENTERING_TIMES_STEPS;H
_EDITING_DATA_IN_A_CELL_STEPS;',0)} See related topics



Details: Entering numbers
If you make a mistake
If you make a typing mistake while entering, press BACKSPACE or press ESC to abandon the entry. Press F2 (EDIT) to 
edit the entry.

Range of numbers valid in 1-2-3
You can enter and calculate with any numbers from -1.79769313486231E308 to 1.79769313486231E308. 1-2-
3 can display any number within this range, including zero. 

Displaying large numbers in 1-2-3
If you enter a number with more than 15 decimals, 1-2-3 rounds it to 15 decimals. If a number appears in the form 
nE+n, or a number with decimal places appears rounded, or if 1-2-3 displays *** (asterisks) in the cell, it means the 
entry is too long to fit in the column. 
1-2-3 stores the entire entry (up to 15 decimal places) but can't display it. You can see the number by widening the 
column. For information on changing column width, see Sizing columns.

Formatting numbers
You can enter a number one way (for example, as a percentage) and then change the format to display it a different 
way (for example, as currency). Changing the format changes how 1-2-3 displays the number, but does not change 
how 1-2-3 stores or calculates with the number. Use Range - Range Properties (Number Format tab) to change the 
number format.

Related SmartIcons

Cancels the last command or action

Formats values as a percent with two decimal places

Formats values with the default currency format

Formats values with the thousands separator and no decimal places

{button ,AL(`H_ENTERING_NUMBERS_STEPS',1)} Go to procedure
{button ,AL(`H_NUMBER_FORMATS_OVER;H_FORMATTING_NUMBERS_STEPS;',0)} See related topics



Entering text
A text entry is called a label.
1. Click the cell where you want to enter the text.
2. Type the text.
3. Press ENTER to confirm.

{button ,AL(`H_ENTERING_TEXT_DETAILS',1)} See details
{button ,AL(`H_EDITING_DATA_IN_A_CELL_STEPS;H_ENTERING_DATA_OVER',0)} See related topics



Details: Entering text
If you make a mistake
If you make a typing mistake while entering, press BACKSPACE or press ESC to abandon the entry. Press F2 (EDIT) to 
edit the entry.

Displaying a label that is longer than the cell
If you enter a label that is longer than the cell, and the cells to the right of the label are blank, 1-2-3 displays the part 
of the label that overlaps those cells. If the cell to the right contains data, 1-2-3 displays as much of the label as 
possible. To see the entire label, widen the column. For information on changing column width, see Sizing columns.

Related SmartIcons

Cancels the last command or action

{button ,AL(`H_ENTERING_TEXT_STEPS',1)} Go to procedure
{button ,AL(`H_EDITING_KEYS_OVER;H_EDITING_DATA_IN_A_CELL_STEPS;H_WRAPPING_DATA_IN_A_CELL

_STEPS;',0)} See related topics



Entering dates
1. Click the cell where you want to enter the date.
2. Type the date in one of the following formats:

• MM/DD/YY; for example, 4/10/56 or 04/10/56
• DD-MMM-YY; for example, 10-Apr-56
• MM/DD/YYYY; for example, 4/10/2010

Note You can now enter dates with either a 2-digit (for example, 4/2/15) or 4-digit year (for example, 4/2/2015). 
For more information, see 1-2-3 and the year 2000. You can also control how 1-2-3 stores and displays a date. 
For information, see Setting options for dates.

3. Press ENTER to confirm.
Note If 1-2-3 displays *** (asterisks) in the cell, the column is not wide enough to display the date.

{button ,AL(`H_ENTERING_DATES_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATA_OVER;H_EDITING_DATA_IN_A_CELL_STEPS;H_ENTERING_TIMES_STEPS;H

_ENTERING_NUMBERS_STEPS;H_123_SETTING_OPTIONS_DATES_STEPS',0)} See related topics



Details: Entering dates
Valid dates in 1-2-3
1-2-3 can display dates between 01/01/1900 and 12/31/9999. Any dates outside this range display as (***) asterisks. 

What date formats does 1-2-3 automatically recognize?
1-2-3 accepts any date formats you promote to the Frequently Used list on the status bar, plus the following formats:

• DD-MMM-YY; for example, 10-Apr-56
• DD-MMM; for example, 10-Apr
• MMM-YY; for example, Apr-56
• MM/DD/YY; for example, 04/10/56

To promote a date format to the status bar, use Range - Range Properties (Number Format tab). 
If you use the format 10-Apr, 1-2-3 displays the date as entered and stores the date using the current year. If you use 
the format Apr-98, 1-2-3 displays the date as entered and stores the date using the first day of the month.
If you enter a date in DD-MMM format, 1-2-3 assumes the current year. But, if you enter the date without the year and
with the "/," for example in the format 4/10, 1-2-3 interprets your entry as a fraction, performs the calculation, and 
displays the result. To avoid unexpected year interpretations, you should enter the year.
Note You can change the settings in 1-2-3 to display dates with either 2-digit or 4-digit years. For example, you can 
display the date as 4/10/56 or as 4/10/1956. Use File - User Setup - 1-2-3 Preferences (General tab) to change these
date settings. For more information, see Details: Setting 1-2-3 options.

Date formats
1-2-3 uses the operating system settings for certain date formats, called international date formats. These are marked
with (System) in the table of available date formats below. International date formats may differ depending on what is 
selected in the operating system's regional (country) settings.

Date format name 1234.56 appears as:
12/31/96       (System) 05/18/03
12/31            (System) 05/18
31-Dec-96 18-May-03
31-Dec 18-May
Dec-96 May-03
December-96 May-03
December 31, 1996 May 18, 1903
Tuesday Monday
Tuesday, December 31, 1996 Monday, May 18, 

1903
Tue, Dec 31, 1996 Mon, May 18, 1903
1996/12/31 1903/05/18
96/12/31 03/05/18
96/12 03/05
96.12.31 03.05.18
12.31 05.18 
12/31/96 10:59:59 PM     (System) 05/18/03 01:26:24 

PM
12/31 10:59 PM              (System) 05/18 01:26 PM
1996-12-31 (ISO) 1903-05-18
1996-12-31-23:59:59 (ISO) 1903-05-18-13:26:24

{button ,AL(`H_ENTERING_DATES_STEPS',1)} Go to procedure
{button ,AL(`H_PROMOTING_A_NUMBER_FORMAT_STEPS;H_FORMATTING_NUMBERS_STEPS;H_NUMBER_

FORMATS_OVER;',0)} See related topics





Entering times
1. Click the cell where you want to enter the time.
2. Type the time in one of the following formats:

• HH:MM AM or PM; for example 05:57 PM
• HH:MM:SS; for example 17:57:00

3. Press ENTER to confirm.
Note  If a number in a cell remains displayed as 00:00 or 12:00 AM, it indicates an invalid value, for example, a time 
greater than 23:59:59.

{button ,AL(`H_ENTERING_TIMES_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATA_OVER;H_ENTERING_DATES_STEPS;H_EDITING_DATA_IN_A_CELL_STEPS;

H_ENTERING_NUMBERS_STEPS;',0)} See related topics



Details: Entering times
Valid times in 1-2-3
1-2-3 displays times between 12 AM (midnight, 00:00:00) and one second before midnight (23:59:59.) Numbers you 
enter outside this range will display as either 12:00 AM or 00:00 in the current time format.

What time formats does 1-2-3 automatically recognize?
1-2-3 accepts any time formats you promote to the Frequently Used list on the status bar, plus the following formats:

• HH:MM:SS AM; for example, 11:04:22 PM
• HH:MM AM; for example, 11:04 PM
• HH:MM:SS; for example, 23:04:22
• HH:MM; for example, 23:04

To promote a time format to the status bar, use Range - Range Properties (Number Format tab).

Time formats
1-2-3 uses the operating system settings for certain time formats, called international time formats. These are marked
with (System) in the table of available time formats below. International time formats may differ depending on what is 
selected in the operating system's regional (country) settings.

Time format name 1234.56 appears as:
10:59:59 PM    (System) 01:26:24 PM
10:59 PM        (System) 01:26 PM
11:59:59 PM 01:26:24 PM
1:59:59 PM 1:26:24 PM
11:59 PM 01:26 PM
1:59 PM 1:26 PM
23:59:59 13:26:24
3:59:59 13:26:24
23:59 13:26
3:59 13:26
23:59:59 (ISO) 13:26:24

{button ,AL(`H_ENTERING_TIMES_STEPS',1)} Go to procedure
{button ,AL(`H_PROMOTING_A_NUMBER_FORMAT_STEPS;H_FORMATTING_NUMBERS_STEPS;H_NUMBER_

FORMATS_OVER;',0)} See related topics



Creating a cell comment
You can use a cell comment to annotate data, formulas, and @functions in cells.

 Show me a QuickDemo
1. Click the cell.
2. Choose Range - Cell Comment.

3. (Optional) Click Name and Date Stamp.
4. Enter the comment text.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CREATING_A_CELL_COMMENT_DETAILS',1)} See details
{button ,AL(`H_ENTERING_DATA_OVER;H_123_PRINTING_CELL_COMMENTS_AND_FORMULAS_STEPS;',0)} 

See related topics



Details: Creating a cell comment
1-2-3 displays a small marker in the top left corner of a cell containing a comment.
You can enter up to 1024 characters in a cell comment.

Turning off cell comment markers
Use View - Set View Preferences to turn off the display of cell comment markers for the workbook.

Deleting a cell comment
Use Edit - Clear to delete a cell comment, or display the comment and delete the text. 
Note If you leave blank characters in a cell comment, then the cell comment marker will still display.

Related SmartIcons

Sets cell comment marker display and other view preferences for the current workbook 

{button ,AL(`H_CREATING_A_CELL_COMMENT_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_A_SHEET_STEPS',0)} See related topics



Working with Excel files
You can open .XLS, .XLT, and .XLW files from these Microsoft Excel releases in the current release of 1-2-3:

• Versions 2.1, 3.0, 4.0, 5.0
• Releases 95 and 97

1-2-3 lets you open .XLT files only if they are worksheets or workbooks, and .XLW files only if they are Excel Version 
4.0 bound workbook files.
You can save 1-2-3 files as .XLS files for use in these Excel releases:

• Versions 4.0 and 5.0
• Releases 95 and 97

You cannot save files in .XLW or .XLT format. 
Note If you use /File Save to save a 1-2-3 file as an Excel file, 1-2-3 automatically saves the file in Excel Release 97 
format. To save the file in a different Excel file format, choose Save As from the File menu.

Sharing password-protected files
If an Excel file is protected with a password, you must remove the password in Excel before you can open the file in 
1-2-3. 
When you save a password-protected 1-2-3 file as an .XLS file, the Excel file is not password-protected.

Sharing data between Excel and 1-2-3
When you open an Excel file in 1-2-3 or save a 1-2-3 file in Excel format, 1-2-3 preserves as much of the original data
as possible. However, not all types of information can be translated or retained. 1-2-3 creates a translation log file that
lists all data that could not be translated for use in 1-2-3 or Excel. The log file also lists file links and other data that 
require editing in either 1-2-3 or Excel. 

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_THE_EXCEL_LOG_FILE_OVER;H_TRANSLATING_
EXCEL_FILES_OVER;H_TRANSLATING_EXCEL_FILES_FUNCTIONS_OVER',0)} See related topics



Translating Excel files

Opening files from Excel Versions 2.1 and 3.0
When you open an Excel Version 2.1 or 3.0 file in 1-2-3, 1-2-3 retains only values and text. Formula and function 
results are converted to the last value saved in Excel before translation. No formatting or styles are retained. In 
addition, the following information is not translated:

• Solutions created with Solver and Goal Seek, unless the Goal or Solution is kept
• Custom functions, formats, menus, dialog boxes, buttons, and icons
• Macro functions
• Custom functions created with Excel add-ins, macros, or VBA
• Worksheet views
• Outlining

Opening files from later Excel releases
When you open an Excel Version 4.0 or later file in 1-2-3, 1-2-3 preserves as much of the original data as possible 
but does not translate the following information:

• Custom functions and formats
• OLE links
• Hyperlinks
• Outlining
• Embedded charts and other graphics
• Web queries

1-2-3 translates the data in the sheet but does not retain the Web query structure. 
1-2-3 does not translate these Excel file types:

• Add-in macro (.XLA) files
• Chart (.XLC) files
• Macro (.XLM) files
• Special DLL (.XLL) files

Saving 1-2-3 files for use in Excel
Similarly, when you save a 1-2-3 file as an Excel file type, 1-2-3 preserves as much data and formatting as possible. 
The following information is not retained:

• Charts, maps, and other graphics
• Approach forms, reports, crosstabs, reports, and mailing labels, and other embedded data
• Query table, Web table, and hyperlink connections

Information about untranslated data appears in the translation log file.

Cell notes
1-2-3 does not translate cell notes in Excel Release 97 files. Cell notes in prior release Excel files are converted to 
cell comments. To make cell comment markers visible in 1-2-3, choose View - Set View Preferences.
When you save a 1-2-3 file that contains cell comments as an Excel 4 .XLS file, the cell comments are retained. 1-2-3
does not translate cell comments when you save the file that contains them as an Excel 95 or 97 file. 

Characters
When you open an Excel file in 1-2-3, 1-2-3 converts ANSI characters to their LMBCS equivalent. 1-2-3 retains only 
ANSI characters created with the CHAR function and a value argument. If the CHAR function uses a formula result or
cell reference as its argument, the log file lists the ANSI character in a message. You should determine the LMBCS 
equivalent and then modify the formula to produce the correct code. Use the 1-2-3 @CODE function to identify the 
appropriate LMBCS code. 
When you save a 1-2-3 file as an Excel file, 1-2-3 converts LMBCS characters to their ANSI equivalent.

Data tables



If you open an Excel file containing data tables, 1-2-3 puts @<<XL>>TABLE(ARGUMENTS); VALUE in each cell of 
each table. VALUE is the last calculated value saved in Excel before translation. To recreate the data tables in 1-2-3, 
use Range - Analyze - What-if Table.

Date calculation
Excel lets you set the starting date from which all dates are calculated to either January 1, 1900 or January 1, 1904, 
while 1-2-3 uses only January 1, 1900. If you open an Excel file that uses 1904, 1-2-3 records it in the log file and 
assumes the dates start from January 1, 1900.

DDE links
If an Excel file contains DDE links, 1-2-3 converts the array formula that created the link to 
@DATALINK("Application," "Filename," "!Range"). 1-2-3 puts the @function in the top left corner of each range that 
contains a DDE link. If the links provide data to the file from another Windows application, the translated file won't 
reflect changes to the original data unless the other application is installed on the same computer where you're 
running 1-2-3, and the linked file is open in the other application.

File links
If an Excel file that you open in 1-2-3 contains links to other Excel files, the log file lists the linked files with drive, path,
file name, and .XLS extension. You must open each of the linked files in 1-2-3 and save them in their original 
locations as .123, .WK4, or .WK3 files. Then you can edit the links to reference these files and use Edit - Manage 
Links in 1-2-3 to update all the file links.
If a 1-2-3 file that you save in Excel format contains links to other .123 files, 1-2-3 records information about the links 
in the log file and does not translate them. To use the untranslated file links in Excel, you must open each of the 
linked .123 files and save them in their original locations as .XLS files. Then change the .123 extension on the 
untranslated file links to .XLS. Use Edit - Links in Excel to refresh the links.
If a .123 file that you're saving as an Excel file contains links to .WK3 or .WK4 files, 1-2-3 translates the links. Use the
Edit - Links command in Excel to refresh the links to the correct drive and path.

Formulas
1-2-3 and Excel use almost identical arithmetic and logical operators, except for the intersection operator in Excel, 
which 1-2-3 translates as @<<XL>>ISECT(RANGE1,RANGE2). 
1-2-3 and Excel calculate using a slightly different order of precedence. Results are identical except when you use 
exponentiation and negation in the same formula. Excel carries out exponentiation after negation, while 1-2-3 carries 
it out before negation. The difference is noticeable in an equation such as -2^2, which evaluates to 4 in Excel ((-2)^2) 
and to -4 in 1-2-3 (-(2^2)). If an .XLS file contains such formulas, 1-2-3 puts parentheses around the values to 
produce the same result as Excel.
Formulas that concatenate text may produce different results in the two programs because Excel concatenates text 
before comparisons, while 1-2-3 concatenates it after comparisons.
1-2-3 translates the error value #N/A to NA. 1-2-3 translates #VALUE!, #REF!, #NAME?, #NUM!, #DIV/O!, and 
#NULL! to ERR. 

Functions
When you open an Excel file in 1-2-3, 1-2-3 converts Excel functions to the equivalent 1-2-3 @function when 
available. Similarly, when you save a 1-2-3 file as an Excel file type, 1-2-3 translates @functions to the equivalent 
function in Excel. 
If an Excel function or a 1-2-3 @function cannot be translated, 1-2-3 records information about the function name, 
value and cell address in the log file. 
For more detailed information, see Translating functions in Excel files and Excel function equivalents in 1-2-3. 

Print settings
1-2-3 translates Excel print areas that are defined as single, contiguous ranges, and retains header and footer 
settings that it supports, such as date and file name. 
The Excel page numbering feature "Page n of n" (for example, Page 2 of 5) is translated when you open an Excel file 
in 1-2-3. 1-2-3 converts Excel header and footer formatting codes to 1-2-3 codes as listed below:

Excel code 1-2-3 code
&& &



&# %
&A ^
&B b and end-of-format sequence
&C |Text|
&D @
&F ^
&I i and end-of-format sequence
&L Text|
&N no equivalent available
&P #
&R ||Text
&T +

3D ranges
Excel Version 4.0 does not support 3D ranges. When you save a 1-2-3 file as an Excel 4 .XLS file, any named 3D 
range in the 1-2-3 file appears in Excel as a named 2D range on each sheet matching the sheets in the original 3D 
range.
For example, suppose you have a 1-2-3 file containing a 3D range, A:A1..C:B5, named Hats. If you save this file as 
an Excel 4 file, sheet A in the Excel file will have a range A:A1..A:B5, named Hats; sheet B will have a range, 
B:A1..B:B5, named Hats; and sheet C will have a range, C:A1..C:B5, named Hats.
Formulas that reference the named 3D range in 1-2-3 refer in Excel to each of the named 2D ranges.
Formula references to 3D ranges evaluate to #ERR! in Excel. To avoid problems, edit the file in 1-2-3 before you 
open it in Excel. Move any ranges referenced by formulas so that the data is either completely in one sheet or the 
other.

Rows
If a 1-2-3 file contains data beyond row 8192, you can save it as an Excel 97 .XLS file. You cannot save the file as an 
Excel 4 or 95 .XLS file.

Sheet and range names
Sheet names in Excel bound workbook files can contain hyphens. 1-2-3 sheet names cannot contain hyphens. When 
you open an Excel bound workbook file in 1-2-3, sheet names containing hyphens are translated to the appropriate 
sheet letter according to the position of the sheet in the file.
Range names in 1-2-3 can contain spaces; range names in Excel cannot. When you open a 1-2-3 file that was saved 
as an Excel file, Excel prompts you to replace spaces in range names with another accepted character, such as an _ 
(underscore).
Excel lets you assign the same range name in different sheets in a file, whereas in 1-2-3, each range name in a file 
must be unique. If you open an Excel file that uses the same range name in different sheets, 1-2-3 retains the first 
occurrence of the range name and appends an incremented suffix to subsequent occurrences. For example, if the 
Excel file has a range named SALARY in more than one sheet, 1-2-3 leaves the first occurrence of the range name 
as is and changes the subsequent occurrences to SALARY1, SALARY2, and so on. 

{button ,AL(`H_THE_EXCEL_LOG_FILE_OVER;H_WORKING_WITH_EXCEL_FILES_OVER;H_TRANSLATING_EX
CEL_FILES_FORMATTING_OVER;',0)} See related topics



Translating functions in Excel files
Many Excel functions have equivalents in 1-2-3. For information on how Excel functions map to 1-2-3 @functions, 
see Excel function equivalents in 1-2-3.

Using Excel functions in 1-2-3
When you open an Excel file in 1-2-3, 1-2-3 translates the Excel functions to the equivalent 1-2-3 @function. For 
example, 1-2-3 converts MEDIAN to @MEDIAN. In some cases, 1-2-3 translates different Excel functions to the 
same 1-2-3 @function but changes the arguments. 
1-2-3 lists information in a log file about any Excel functions that could not be translated. Excel functions that have no 
equivalent in 1-2-3 display in the 1-2-3 sheet like this:
@<<XL>>FUNCTION NAME(ARGUMENTS); CURRENT VALUE
User-defined or third-party functions that have no equivalent in 1-2-3 display in the 1-2-3 sheet like this:
@<<XLUSERFN>>FUNCTION NAME(ARGUMENTS); CURRENT VALUE
In both cases, these functions evaluate to ERR. If you move to the cell that contains an untranslated function, double-
click or press F2 to edit the cell, and then press RETURN, 1-2-3 converts the cell contents to a text string until you 
replace it with a valid 1-2-3 formula.

Using 1-2-3 @functions in Excel
When you save a 1-2-3 file as an Excel file, 1-2-3 saves the @functions as equivalent Excel functions when possible.
In some cases, 1-2-3 may translate the same @function to different Excel functions depending on the arguments 
specified in the @function.
If the file contains any 1-2-3 @functions that have no equivalent in Excel, 1-2-3 lists the @function name, value, and 
cell address in a translation log file. 1-2-3 @functions that have no equivalent in Excel display in the Excel worksheet 
as a label:
@FUNCTION NAME(ARGUMENTS); CURRENT VALUE

Using untranslated functions
If you open an Excel file in 1-2-3 and then save that file again as an Excel file, the functions that did not translate in 1-
2-3 must be translated again in Excel.
For example, suppose an Excel file contains the function NOMINAL(5.3543%,4). When you open the Excel file in 1-2-
3, this function is not translated. It appears in the sheet as @<<XL>>NOMINAL(5.3543%,4);0.0525 and evaluates to 
ERR.
If you save the 1-2-3 file containing this untranslated function as an Excel file, the function is not translated back to its
original form in Excel. The log file lists the location of the function, along with the message "Cannot translate 
@Function," and the current value of the @function.
To use untranslated Excel and 1-2-3 functions, you can:

• Write an add-in function using LotusScript (in 1-2-3), VBA (in Excel), or an add-in development application
• Build a formula that recreates the untranslated function
• Use the current value

If you use the equivalent 1-2-3 @functions in new calculations, you must adjust any dependent formulas to reflect the
way these @functions work in 1-2-3. Cells containing untranslatable functions evaluate to ERR in 1-2-3. If the 
untranslated Excel function is supported by an add-in that you can use with 1-2-3, it evaluates correctly when you 
load the add-in.
If a user-defined function was an Excel 4.0 or later macro or VBA macro, you can copy the function as text into the 1-
2-3 Script Editor and use it in LotusScript. After you edit the function as needed for use in 1-2-3, the function 
evaluates when the translated Excel file is open in 1-2-3.

Array functions
1-2-3 translates Excel functions that use an array of arguments specified inside curly braces {}. However, 1-2-3 does 
not translate Excel functions that return an array. In such cases, 1-2-3 writes the array values in empty cells and then 
uses the written values to calculate the function. 

Functions that return an ANSI character
For Excel functions that return an ANSI character, 1-2-3 annotates the cell containing the translated function. 1-2-3 
adds a semicolon after the function, followed by the value of the function as it appears in Excel. 1-2-3 retains ANSI 



characters only when created with the CHAR function and a value argument. 
For example, if A1 contains =CHAR(181), A1 displays µ in Excel and 1-2-3. However, if A1 contains =CHAR(A2) and 
A2 contains the value 181, when you open the file containing this function in 1-2-3, 1-2-3 translates the function to 
@CHAR(A2);µ. The cell containing the function displays Á, the LMBCS equivalent of 181. You can use @CODE in 1-
2-3 to find the appropriate LMBCS code. 

DB
If you open an Excel file that contains the Excel function =DB(cost,salvage,life,period,month), 1-2-3 puts 
@<<XL>>DB(cost,salvage,life,period,month);VALUE in each cell that holds this function, since the 1-2-3 function 
@DB takes only four arguments. If any of the cells contain the Excel function =DB(cost,salvage,life,period), 1-2-3 
translates this function, but, since 1-2-3 uses a slightly different algorithm, the result is more accurate than that of 
Excel.

FIND, MATCH, FASTMATCH, and WEEKDAY
1-2-3 translates the Excel functions FIND, MATCH, FASTMATCH, and WEEKDAY to equivalent 1-2-3 @functions but
alters the results to return the same values as Excel. For example, 1-2-3 translates WEEKDAY to @WEEKDAY but 
increases the result by a factor of 2 because Excel uses 1 to 7 for Sunday through Saturday, while 1-2-3 uses 0 to 6 
for Monday through Sunday.
Some Excel functions use different value arguments than the equivalent 1-2-3 @functions. For example, in Excel, 
MATCH can take 0, 1, or -1 as an optional argument, while in 1-2-3 @MATCH can take 0, 1, or 2. In such cases, 1-2-
3 translates the Excel function and converts its arguments to produce the same result as Excel.
In cases where the value argument in Excel is the result of a formula or cell reference, 1-2-3 converts the argument to
the 1-2-3 equivalent and does not retain the formula or cell reference. To translate such functions correctly, make 
sure you recalculate the Excel file before saving it in Excel, and then open it in 1-2-3.

FIXED
When you open an Excel file in 1-2-3, FIXED translates to @STRING; when you save a 1-2-3 file as an Excel file, 
@STRING translates to FIXED. Some unexpected results, not reported in the log file, can occur during translation of 
these functions.
1-2-3 lets you specify up to 116 decimal places for the n argument in @STRING; Excel allows up to 127 decimal 
places. If the number of decimal places specified in FIXED is greater than 116, this function results in ERR when you 
open the Excel file in 1-2-3.
If the n argument in the @STRING function is negative, the number returned by @STRING is formatted as scientific 
notation in 1-2-3. In Excel, if the decimals argument for FIXED is negative, the number returned appears rounded to 
the left of the decimal point. When you open an Excel file in 1-2-3, this number appears formatted as scientific 
notation.
To format a number returned by FIXED with commas, set the no_commas argument to FALSE. When you open the 
Excel file in 1-2-3, the number appears without commas, even though no_commas was set to FALSE. The argument 
n+1000 in @STRING indicates Comma format. This argument causes the FIXED function to appear as #VALUE! 
when you open the file in Excel. The argument n+10000 in @STRING indicates General format. This argument also 
causes the FIXED function to appear as #VALUE! when you open the file in Excel.

INTERCEPT
1-2-3 translates INTERCEPT to @REGRESSION. 1-2-3 assumes the x- and y-range values are in columns and that 
the y-range contains the same number of rows as the x-range. If the x- or y-range data is in rows, @REGRESSION 
evaluates to ERR. To display the correct result, transpose the x- and y-range data to appear in columns instead of 
rows.

MINVERSE and MMULT
1-2-3 doesn't have equivalent @functions for MINVERSE or MMULT. Instead, use the Range - Analyze - Invert 
Matrix, or Range - Analyze - Multiply Matrix, command.

{button ,AL(`H_TRANSLATING_EXCEL_FILES_OVER',0)} See related topics



Excel function equivalents in 1-2-3
The table below lists Excel functions and their equivalents in the current release of 1-2-3. In some cases, 1-2-3 does 
not have an equivalent @function but provides comparable functionality through menu commands or logical 
operators. 
For more detailed information on sharing files that contain functions with Excel, see Translating functions in Excel 
files. 

Excel function 1-2-3 @function
ABS @ABS
ACOS @ACOS
ACOSH @ACOSH
ACCRINT @ACCRUED 
ACCRINTM No equivalent
ADDRESS No equivalent
AMORDEGRC No equivalent
AMORLINC No equivalent
AND #AND#
AREAS No equivalent
ASIN @ASIN 
ASINH @ASINH 
ATAN @ATAN 
ATAN2 @ATAN2 
ATANH @ATANH 
AVEDEV @AVEDEV 
AVERAGE @PUREAVG 
AVERAGEA No equivalent
BASE No equivalent
BESSELI @BESSELI 
BESSELJ @BESSELJ 
BESSELK @BESSELK 
BESSELY @BESSELY 
BETADIST No equivalent
BETAINV No equivalent
BIN2DEC @BIN2DEC 
BIN2HEX @BIN2HEX 
BIN2OCT @BIN2OCT 
BINOMDIST @BINOMIAL 
CALL No equivalent
CEILING @ROUNDM 
CELL @CELL 
CHAR @CHAR 
CHIDIST @CHIDIST 
CHIINV @CHIDIST
CHITEST No equivalent
CHOOSE @CHOOSE 
CLEAN @CLEAN 
CODE @CODE 



COLUMN @COLUMN 
COLUMNS @COLS 
COMBIN @COMBIN 
COMPLEX No equivalent
CONCATENATE No equivalent
CONFIDENCE @CONFIDENCE 
CONVERT @CONVERT 
CORREL @CORREL 
COS @COS 
COSH @COSH 
COUNT @PURECOUNT 
COUNTA @COUNT 
COUNTBLANK @COUNTBLANK 
COUNTIF @COUNTIF 
COUPDAYBS @COUPDAYBS 
COUPDAYS @COUPDAYS 
COUPDAYSNC @COUPDAYSNC    
COUPNCD @COUPNCD 
COUPNUM @COUPNUM 
COUPPCD @COUPPCD 
COVAR @COV 
CRITBINOM @CRITBINOMIAL 
CROSSTAB No equivalent
CUMIPMT @IPAYMT 
CUMPRINC @PPAYMT 
DATE @DATE 
DATEVALUE @DATEVALUE 
DAVERAGE @DAVG 
DAY @DAY 
DAYS360 @DAYS360 

@DAYS 
DB @DB 
DCOUNT @DPURECOUNT 
DCOUNTA @DCOUNT 
DDB @DDB 
DEC2BIN @DEC2BIN 
DEC2HEX @DEC2HEX 
DEC2OCT @DEC2OCT 
DEGREES @RADTODEG 
DELTA No equivalent
DEVSQ @DEVSQ 
DGET @DGET 
DISC @DISC 
DMAX @DMAX 
DMIN @DMIN 



DOLLAR No equivalent
DOLLARDE @FRAC2DEC 
DOLLARFR @DEC2FRAC 
DPRODUCT No equivalent
DSTDEV @DSTDS 
DSTDEVP @DSTD 
DSUM @DSUM 
DURATION @DURATION 
DVAR @DVARS 
DVARP @DVAR 
EDATE @NEXTMONTH 
EFFECT No equivalent
EOMONTH @NEXTMONTH
ERF @ERF 
ERFC @ERFC 
ERROR.TYPE No equivalent
EVEN @EVEN 
EXACT @EXACT 
EXP @EXP 
EXPONDIST @EXPONDIST 
FACT @FACT 
FACTDOUBLE No equivalent
FALSE @FALSE 
FASTMATCH @MATCH 
FDIST @FDIST 
FIND @FIND 
FINV @FDIST
FISHER @FISHER 
FISHERINV @FISHERINV 
FIXED @STRING 
FLOOR @ROUNDM 
FORECAST @FORECAST 
FREQUENCY No equivalent
FTEST @FTEST 
FV @FVAL 
FVSCHEDULE No equivalent
GAMMADIST No equivalent
GAMMAINV No equivalent
GAMMALN @GAMMALN 
GCD No equivalent
GEOMEAN @GEOMEAN 
GESTEP No equivalent
GETPIVOTDATA No equivalent
GROWTH No equivalent
HARMEAN @HARMEAN 



HEX2BIN @HEX2BIN 
HEX2DEC @HEX2DEC 
HEX2OCT @HEX2OCT 
HLOOKUP @HLOOKUP 
HOUR @HOUR 
HYPERLINK No equivalent
HYPGEOMDIST @HYPGEOMDIST 
IF @IF 
IMABS No equivalent
IMAGINARY No equivalent
IMARGUMENT No equivalent
IMCONJUGATE No equivalent
IMCOS No equivalent
IMDIV No equivalent
IMEXP No equivalent
IMLN No equivalent
IMLOG2 No equivalent
IMLOG10 No equivalent
IMPOWER No equivalent
IMPRODUCT No equivalent
IMREAL No equivalent
IMSIN No equivalent
IMSQRT No equivalent
IMSUB No equivalent
IMSUM No equivalent
INDEX @INDEX 
INDIRECT @@ 
INFO @INFO 
INT @ROUNDDOWN 
INTERCEPT @REGRESSION 
INTRATE @INTRATE 
IPMT @IPAYMT 
IRR @IRR 
ISBLANK @ISEMPTY 
ISERR @ISERR 
ISERROR @ISERR
ISEVEN No equivalent
ISLOGICAL No equivalent
ISNA @ISNA 
ISNONTEXT No equivalent
ISNUMBER @ISNUMBER 
ISODD No equivalent
ISREF @ISRANGE 
ISTEXT @ISSTRING 
KURT @KURTOSIS 



LARGE @LARGE 
LCM No equivalent
LEFT @LEFT 
LEN @LENGTH 
LINEST No equivalent
LN @LN 
LOG No equivalent
LOG10 @LOG 
LOGEST No equivalent
LOGINV @LOGINV 
LOGNORMDIST @LOGNORMDIST 
LOOKUP No equivalent
LOWER @LOWER 
MATCH @MATCH 
MAX @PUREMAX 
MAXA No equivalent
MDETERM No equivalent
MDURATION @MDURATION 
MEDIAN @MEDIAN 
MID @MID 
MIN @PUREMIN 
MINA No equivalent
MINUTE @MINUTE
MINVERSE No equivalent; see Inverting a 

matrix 
MIRR @MIRR
MMULT No equivalent; see Multiplying 

matrixes 
MOD @MOD 
MODE @MODE 
MONTH @MONTH 
MROUND @ROUNDM 
MULTINOMIAL No equivalent
N @N 
NA @NA 
NEGBINOMDIST @NEGBINOMDIST 
NETWORKDAYS @NETWORKDAYS 
NOMINAL No equivalent
NORMDIST @NORMAL 
NORMINV @NORMAL
NORMSDIST @NORMAL
NORMSINV @NORMSINV 
NOT #NOT#
NOW @NOW 
NPER @NPER
NPV @NPV 



OCT2BIN @OCT2BIN 
OCT2DEC @OCT2DEC 
OCT2HEX @OCT2HEX 
ODD @ODD 
ODDFPRICE No equivalent
ODDFYIELD No equivalent
ODDLPRICE No equivalent
ODDLYIELD No equivalent
OFFSET No equivalent
OR #OR#
PEARSON @CORREL 
PERCENTILE @PERCENTILE 
PERCENTRANK @PRANK 
PERMUT @PERMUT 
PI @PI 
PMT @PAYMT 
POISSON @POISSON 
POWER No equivalent
PPMT @PPAYMT 
PRICE @PRICE 
PRICEDISC @PRICEDISC 
PRICEMAT @PRICEMAT 
PROB @PROB 
PRODUCT @PRODUCT 
PROPER @PROPER 
PV @PVAL 
QUARTILE @QUARTILE
QUOTIENT @QUOTIENT 
RADIANS @DEGTORAD 
RAND @RAND 
RANDBETWEEN @RANDBETWEEN 
RANK @RANK 
RATE @IRATE 
RECEIVED @RECEIVED 
REGISTER.ID No equivalent
REPLACE @REPLACE 
REPT @REPEAT 
RIGHT @RIGHT 
ROMAN No equivalent
ROUND @ROUND 
ROUNDDOWN @ROUNDDOWN 
ROUNDUP @ROUNDUP 
ROW @ROW 
ROWS @ROWS 
RSQ @RSQ 



SEARCH No equivalent
SECOND @SECOND 
SERIESSUM @SERIESSUM 
SIGN @SIGN 
SIN @SIN 
SINH @SINH 
SKEW @SKEWNESS 
SLN @SLN 
SLOPE No equivalent
SMALL @SMALL 
SQLREQUEST No equivalent
SQRT @SQRT 
SQRTPI @SQRTPI 
STANDARDIZE @STANDARDIZE 
STDEV @PURESTDS 
STDEVA No equivalent
STDEVP @PURESTD 
STDEVPA No equivalent
STEYX @STEYX 
SUBSTITUTE No equivalent
SUBTOTAL No equivalent
SUM @SUM 
SUMIF @SUMIF 
SUMPRODUCT @SUMPRODUCT 
SUMSQ @SUMSQ 
SUMX2MY2 @SUMX2MY2 
SUMX2PY2 @SUMX2PY2 
SUMXMY2 @SUMXMY2 
SYD @SYD 
T No equivalent
TAN @TAN 
TANH @TANH 
TBILLEQ @TBILLEQ 
TBILLPRICE @TBILLPRICE 
TBILLYIELD @TBILLYIELD 
TDIST @TDIST 
TEXT @STRING 
TIME @TIME 
TIMEVALUE @TIMEVALUE 
TINV @TDIST 
TODAY @TODAY 
TRANSPOSE No equivalent; see 

Transposing data    
TREND No equivalent 
TRIM @TRIM 
TRIMMEAN @TRIMMEAN 



TRUE @TRUE 
TRUNC @TRUNC 
TTEST @TTEST 
TYPE No equivalent
UPPER @UPPER 
VALUE @VALUE 
VAR @PUREVARS 
VARA No equivalent
VARP @PUREVAR 
VARPA No equivalent
VDB @VDB 
VLOOKUP @VLOOKUP 
WEEKDAY @WEEKDAY 
WEIBULL @WEIBULL 
WORKDAY @WORKDAY 
XIRR No equivalent
XNPV No equivalent
YEAR @YEAR 
YEARFRAC @YEARFRAC 
YIELD @YIELD 
YIELDDISC @YIELDDISC 
YIELDMAT @YIELDMAT 
ZTEST @ZTEST 

{button ,AL(`H_TRANSLATING_EXCEL_FILES_OVER;',0)} See related topics



Translating formatting information in Excel files
When you open a file from Excel Version 2.1 or 3.0 in 1-2-3, no formatting or styles are retained. 1-2-3 translates 
formatting information in files created in Excel Version 4.0 or later as described below.    

Border and pattern settings
When you open an Excel file in 1-2-3 or save a 1-2-3 file in Excel format, 1-2-3 converts interior patterns and border 
styles to the closest available equivalent.

Color settings
When you open an Excel file in 1-2-3, the colors are translated as closely as possible to the 240 colors available in 1-
2-3.
When you save a 1-2-3 file in Excel Version 4.0 format, the colors are translated as closely as possible to the 16 
standard default colors supported in that release. When you save a 1-2-3 file in Excel Version 5.0 or later format, 1-2-
3 translates colors as closely as possible to the 56 colors available in Excel.

Column and row sizes
1-2-3 supports column widths of 0 to 240 characters and converts column widths of 241 through 255 to 240 
characters.
1-2-3 supports row heights of 0 to 255 points and converts row heights of 256 through 409 to 255 points.

Fonts
If the fonts used in the Excel file aren't available, 1-2-3 substitutes the closest available equivalents. The status bar 
displays the name of the original font used in the selected cell.

Number formats
1-2-3 translates standard number formats to the closest available equivalent. If a file contains custom number 
formats, 1-2-3 converts them to the closest equivalent number format but doesn't preserve other custom formatting, 
such as individual characters or text.
If you assigned a custom color to negative values, 1-2-3 displays them in red. Other colors assigned with custom 
number formats are not translated. 

{button ,AL(`H_TRANSLATING_EXCEL_FILES_OVER;',0)} See related topics



Excel Chart commands
The table below lists Chart commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Chart - Chart Type Chart - Chart Type
Chart - Source Data Choose Chart - Chart 

Properties and click the 
Ranges tab. Or, choose Chart 
- Chart Series.

Chart - Chart Options From the Chart menu, choose 
the chart part you want to 
change.

Chart - Location There is no equivalent.
Chart - Add Data From the Chart menu, choose 

Ranges. Select the part and 
subpart to which you want to 
add a range. Then respecify 
the entire range, including the 
data you want to add.

Chart - Add Trendline For XY charts only, choose 
Chart - Series. Click the Series
trend tab.

Chart - 3-D View Create a 3D pie or doughnut 
chart. Choose Chart - Pie or 
Chart Doughnut. Click the 3D 
tab.



Excel Data commands
The table below lists Data commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Data - Sort Range - Sort
Data - Filter - AutoFilter There is no equivalent.
Data - Filter - Show All There is no equivalent.
Data - Filter - Advanced Filter Choose Create - Database - 

Query Table. Use the Find 
Assistant to specify a query 
(find).

Data - Form There is no equivalent.
Data - Subtotals File - User Setup - 

SmartLabels Setup.
Data - Validation There is no equivalent.
Data - Table Range - Analyze - What-If 

Table
Data - Text to Columns Range - Parse
Data - Consolidate There is no equivalent.
Data - Group and Outline - Hide 
Detail

Sheet - Outline - Collapse

Data - Group and Outline - Show 
Detail

Sheet - Outline - Expand

Data - Group and Outline - Group Sheet - Outline - Demote
Data - Group and Outline - 
Ungroup

Sheet - Outline - Promote

Data - Group and Outline - Auto 
Outline

There is no equivalent.

Data - Group and Outline - Clear 
Outline

Sheet - Outline - Clear Outline

Data - Group and Outline - 
Settings

Choose Sheet - Sheet 
Properties. Click the Outline 
tab.

Data - Pivot Table Report There is no equivalent.
Data - Get External Data - Run 
Web Query

File - Internet - Get Data from 
Web

Data - Get External Data - Run 
Database Query

Create - Database - Query 
Table

Data - Get External Data - Create 
New Query

Create - Database - Query 
Table

Data - Get External Data - Edit 
Query

Create - Database - Query 
Table

Data - Get External Data - Data 
Range Properties

There is no equivalent.

Data - Get External Data - 
Parameters

There is no equivalent.

Data - Refresh Data Query Table - Refresh



Excel Draw commands
The table below lists Draw commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Draw - Group Drawing - Group
Draw - Ungroup Drawing - Ungroup
Draw - Regroup There is no equivalent.
Draw - Order - Bring to Front Drawing - Bring to Front
Draw - Order - Send to Back Drawing - Send to Back
Draw - Order - Bring Forward There is no equivalent.
Draw - Order - Send Backward There is no equivalent.
Draw - Snap - To Grid Choose Drawing - Drawing 

Properties. Click the Basics 
tab and under Fasten to cells, 
select an option.

Draw - Snap - To Shape There is no equivalent.
Draw - Nudge There is no equivalent.
Draw - Align or Distribute There is no equivalent.
Draw - Rotate or Flip - Free 
Rotate

There is no equivalent.

Draw - Rotate or Flip - Rotate Left Choose Drawing - Drawing 
Properties. Click the Basics 
tab and specify the degree of 
rotation in the "Rotation" box.

Draw - Rotate or Flip - Rotate 
Right

Choose Drawing - Drawing 
Properties. Click the Basics 
tab and specify the degree of 
rotation in the "Rotation" box.

Draw - Rotate or Flip - Flip 
Horizontal

Drawing - Flip Left-Right

Draw - Rotate or Flip - Flip 
Vertical

Drawing - Flip Top-Bottom

Draw - Reroute Connectors There is no equivalent. 
Draw - Edit Points There is no equivalent.
Draw - Change AutoShape There is no equivalent.
Draw - Set AutoShape Defaults There is no equivalent.



Excel Edit commands
The table below lists Edit commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Edit - Undo Edit - Undo
Edit - Repeat There is no equivalent.
Edit - Cut Edit - Cut
Edit - Copy Edit - Copy
Edit - Paste Edit - Paste
Edit    - Paste Special Edit - Paste Special
Edit    - Paste As Hyperlink There is no equivalent.
Edit - Fill - Down Edit - Copy Down
Edit - Fill - Right Edit - Copy Right
Edit - Fill - Up There is no equivalent.
Edit - Fill - Left There is no equivalent.
Edit - Fill - Across Worksheets Select a multiple-sheet range, 

then right click the selection on
the last sheet in the range, 
and choose Copy Back.

Edit - Fill - Series Range - Fill
Edit - Fill - Justify There is no equivalent.
Edit - Clear - All Choose Edit - Clear. Select 

what you want to delete.
Edit - Clear - Formats Edit - Clear Styles
Edit - Clear - Contents Edit - Clear
Edit - Clear - Comments Edit - Clear
Edit - Delete Range - Delete 
Edit - Delete Sheet Sheet - Delete Sheet
Edit - Move or Copy Sheet Sheet - Move or Copy Sheet
Edit - Find Edit - Find & Replace
Edit - Replace Edit - Find & Replace
Edit - Go To Edit - Go To
Edit - Links Edit - Manage Links
Edit - Object - Edit From the <object name> 

menu, choose Edit.
Edit - Object - Open From the <object name> 

menu, choose Open.
Edit - Object - Convert There is no equivalent.



Excel File commands
The table below lists File commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
File - New File - New Workbook
File - Open File - Open
File - Close File - Close
File - Save File - Save
File - Save As File - Save As
File - Save As HTML File - Internet - Convert to 

Web Pages
File - Save Workspace There is no equivalent.
File - Page Setup File - Preview & Page Setup
File - Print Area - Set Print Area Select the range you want to 

print. Under the File menu, 
choose Print and specify 
"Selected Range."

File - Print Area - Clear Print Area There is no equivalent.
File - Print Preview File - Preview & Page Setup
File - Print File - Print
File - Send To - Mail Recipient File - TeamMail
File - Send To - Routing Recipient File - TeamMail
File - Send To - Exchange Folder File - TeamMail
File - Properties File - Workbook Properties
File - Exit File - Exit



Excel Format commands
The table below lists Format commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Format - Cells Range - Range Properties.
Format - Selected Chart Area Chart - Chart Properties
Format - AutoShape Drawing - Drawing Properties
Format - Picture Drawing - Drawing Properties
Format - Object <object name> - <object> 

Properties
Format - Row - Height Choose Range - Range 

Properties. Click the Basics 
tab and specify the height.

Format - Row - AutoFit Choose Range - Range 
Properties. Click the Basics 
tab and select "Fit largest 
font."

Format - Row - Hide Choose Range - Range 
Properties. Click the Basics 
tab and select "Hide row." 

Format    - Row - Unhide Select a range that spans the 
row you want to display. 
Choose Range - Range 
Properties. Click the Basics 
tab and deselect "Hide row." 

Format - Column - Width Choose Range - Range 
Properties. Click the Basics 
tab and specify the width.

Format - Column - AutoFit 
Selection

Choose Range - Range 
Properties. Click the Basics 
tab and click the icon beside 
the Width box.

Format - Column - Hide Choose Range - Range 
Properties. Click the Basics 
tab and select "Hide column." 

Format - Column - Unhide Select a range that spans the 
column you want to display. 
Choose Range - Range 
Properties. Click the Basics 
tab and deselect "Hide 
column." 

Format - Column - Standard 
Width

Choose Range - Range 
Properties. Click the Basics 
tab and select "Default width." 

Format - Sheet - Rename Choose Sheet - Sheet 
Properties. Type a name in the
"Sheet name" box.

Format - Sheet - Hide Sheet - Hide
Format - Sheet - Unhide Sheet - Unhide
Format - Sheet - Background There is no equivalent.
Format - AutoFormat Choose Range - Range 

Properties. Click the Named 
Style tab and then click the 
Style Gallery button.



Format - Conditional Formatting There is no equivalent.
Format - Style Choose Range - Range 

Properties. Click the Named 
Style tab.



Excel Help commands
The table below lists Help commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Help - Microsoft Excel Help Help - Ask the Expert
Help - Contents and Index Help - Help Topics
Help - What's This There is no equivalent.
Help - Microsoft on the Web Help - Lotus Internet Support
Help - Lotus 1-2-3 Help Help - Microsoft Excel Menu 

Finder
Help - About Microsoft Excel Help - About 1-2-3



Excel Insert commands
The table below lists Insert commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Insert - Cells Range - Insert
Insert - Rows Range - Insert
Insert - Columns Range - Insert
Insert - Worksheet Create - Sheet
Insert - Chart Create - Chart
Insert - Page Break Edit - Page Break
Insert - Function Create - @Function
Insert - Name - Define Range - Name
Insert - Name - Paste There is no equivalent.
Insert - Name - Create Range - Name
Insert - Name - Apply There is no equivalent.
Insert - Name - Label Range - Name
Insert - Comment Range - Cell Comment
Insert - Picture - Clip Art Choose Create - Drawing - 

Picture. Select the picture file.
Insert - Picture - From File Choose Create - Drawing - 

Picture. Select the picture file.
Insert - Picture - AutoShapes Choose Create - Drawing. 

Select the shape you want to 
insert.

Insert - Picture - Organization 
Chart

There is no equivalent.

Insert - Picture - WordArt There is no equivalent.
Insert - Map Create - Map
Insert - Object Create - Object
Insert - Hyperlink Create - Hyperlink



Excel Map commands
The table below lists Map commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Map - Features There is no equivalent.
Map - Add Feature There is no equivalent.
Map - Save Map Template There is no equivalent.
Map - Delete Map Template There is no equivalent.
Map - Refresh Map - Redraw
Map - Open Custom Pin Map There is no equivalent.
Map - Close Custom Pin Map There is no equivalent.
Map - Delete Custom Pin Map There is no equivalent.



Excel Tools commands
The table below lists Tools commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Tools - Spelling Edit - Check Spelling
Tools - AutoCorrect There is no equivalent.
Tools - Look Up Reference There is no equivalent.
Tools - Share Workbook There is no equivalent.
Tools - Track Changes There is no equivalent.
Tools - Merge Workbooks Choose File - Open. Select the

file you want to merge into the 
current workbook. Select 
"Combine with current 
workbook," and click Combine.

Tools - Protection - Protect Sheet Choose Sheet - Sheet 
Properties. Click the Basics 
tab and select "Lock contents 
of protected cells in this 
sheet."

Tools - Protection - Protect 
Workbook

Choose File - Workbook 
Properties. Click the Security 
tab and select "Lock 
workbook."

Tools - Protection - Protect and 
Share Workbook

Choose File - Workbook 
Properties. Click the Security 
tab and select "Always get 
reservation when opening 
workbook."

Tools - Goal Seek Range - Analyze - Backsolver
Tools - Scenarios Range - Version - New Version
Tools - Auditing There is no equivalent.
Tools - Macro - Macros Edit - Scripts & Macros
Tools - Macro - Record New 
Macro

Edit - Scripts & Macros

Tools - Macro - Visual Basic 
Editor 

There is no equivalent.

Tools - Add-Ins File - Add-Ins - Manage Add-
Ins

Tools - Customize File - User Setup - SmartIcons
Setup

Tools - Options File - Workbook Properties or 
File - User Setup - 1-2-3 
Preferences

Tools - Wizard There is no equivalent.



Excel View commands
The table below lists View commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
View - Normal There is no equivalent.
View - Page Break Preview There is no equivalent.
View - Toolbars - Standard File - User Setup - SmartIcons

Setup. From the "Bar name" 
list, select Universal.

View - Toolbars - Formatting File - User Setup - SmartIcons
Setup. From the "Bar name" 
list, select Formatting.

View - Toolbars - Chart File - User Setup - SmartIcons
Setup. From the "Bar name" 
list, select Chart.

View - Toolbars - Control Toolbox There is no equivalent.
View - Toolbars - Drawing File - User Setup - SmartIcons

Setup. From the "Bar name" 
list, select Draw.

View - Toolbars - Exit Design 
Mode

There is no equivalent.

View - Toolbars - External Data File - User Setup - SmartIcons
Setup. From the "Bar name" 
list, select Query Table.

View - Toolbars - Forms There is no equivalent.
View - Toolbars - Picture There is no equivalent.
View - Toolbars - PivotTable There is no equivalent.
View - Toolbars - Reviewing There is no equivalent.
View - Toolbars - Visual Basic There is no equivalent.
View - Toolbars - Web File - User Setup - SmartIcons

Setup. From the "Bar name" 
list, select Internet Tools.

View - Toolbars - WordArt There is no equivalent.
View - Toolbars - Customize File - User Setup - SmartIcons

Setup.
View - Formula Bar View - Hide/Show Edit Line
View - Status Bar View - Hide/Show Status Bar
View - Header and Footer Choose File - Preview & Page 

Setup. Click the Headers & 
Footers tab.

View - Comments View - Set View Preferences
View - Custom Views There is no equivalent.
View - Full Screen There is no equivalent.
View - Zoom View - Zoom to



Excel Window commands
The table below lists Window commands in Excel 97 and their closest equivalents in the current release of 1-2-3. 

Excel command 1-2-3 equivalent
Window - New Window Window - New Window
Window - Arrange Window - Tile Left-Right, Tile 

Top-Bottom, or Cascade
Window - Hide There is no equivalent.
Window - Split View - Split
Window - Freeze Panes View - Split or Titles



Microsoft Excel command equivalents in 1-2-3
The topics below list commands in Excel 97 and their closest equivalents in the current release of 1-2-3. In some 
cases, 1-2-3 does not have an equivalent command but provides comparable functionality.
Excel File commands 
Excel Edit commands 
Excel View commands 
Excel Insert commands 
Excel Format commands 
Excel Tools commands 
Excel Data commands 
Excel Window commands 
Excel Help commands 
Excel Chart commands 
Excel Map commands 
Excel Draw commands 

{button ,AL(`H_123_EXCEL_FUNC_EQUIV_REF;H_TRANSLATING_EXCEL_FILES_OVER',0)} See related topics



The Excel log file
When you open an Excel file in 1-2-3 or save a 1-2-3 file as an Excel file type, 1-2-3 preserves as much of the original
data as possible. If the file that you're opening or saving contains any untranslatable information or links to other files,
1-2-3 records the information in a log file. You can view the log file at any time using a word processing program such
as Word Pro.
For example, if you open DATA.XLS in 1-2-3 and the file contains a function that has no equivalent in 1-2-3, 1-2-3 
creates a log file called DATA.LOG that contains information about the untranslated function. 1-2-3 saves the log file 
in the same folder as DATA.XLS.
If you open a file that resides in a write-protected directory and has an untranslatable formula, 1-2-3 tries to save the 
log file in either the 1-2-3 default directory or the system TEMP directory. If either folder is full or write-protected, 1-2-3
stops the translation.
If the folder where 1-2-3 puts the log file already contains a log file with the same name, the new log file replaces the 
previous one.
Similarly, if you save a 1-2-3 file as an Excel file type, and the file contains @functions that have no equivalents in 
Excel, or untranslated links to other 1-2-3 files, 1-2-3 creates a log file and saves it in the default workbook files 
location. The log file has the same name as the 1-2-3 file, with a .LOG extension. 
You must edit untranslated Excel functions and formulas to use them in 1-2-3. Likewise, you must edit untranslated 1-
2-3 @functions to use them in Excel.

{button ,AL(`H_TRANSLATING_EXCEL_FILES_OVER;H_VIEWING_THE_EXCEL_LOG_FILE_OVER;H_WORKING
_WITH_EXCEL_FILES_OVER;H_VIEWING_THE_EXCEL_LOG_FILE_STEPS;',0)} See related topics



Using the Microsoft Excel Menu Finder
The Microsoft Excel Menu Finder is a modeless window that always stays on top, like the Help window, which means 
it can stay open while you read the equivalent command and perform the instructions in 1-2-3. 
You can also move the Microsoft Excel Menu Finder around on your desktop so it is out of the way. The Microsoft 
Excel Menu Finder minimizes when most dialog boxes are displayed, and you can maximize it by clicking the 
Microsoft Excel Menu Finder button on the taskbar at the bottom of your screen.
The menus and menu items in the Excel Menu Finder reflect the current context. For example, if you select a chart in 
1-2-3, you will see the Chart menu instead of the Data menu when you display the Microsoft Excel Menu Finder. 
For some Excel commands there is not a corresponding object in 1-2-3, so the Microsoft Excel Menu Finder displays 
the text: "There is no equivalent." The Microsoft Excel objects that are not available in 1-2-3 include cell comments, 
WordArt objects, Organizational chart objects, and pivot tables.

To display equivalent commands
1. Choose the Microsoft Excel menu and menu item. 

The menu finder displays the equivalent command in Lotus 1-2-3.
2. Follow the instructions.

{button ,AL(`H_123_EXCEL_FUNC_EQUIV_REF;H_CREATING_AND_OPENING_FILES_OVER;H_WORKING_WIT
H_EXCEL_FILES_OVER',0)} See related topics



Viewing the Excel log file
When you open an Excel file in 1-2-3, or save a 1-2-3 file in Excel format, 1-2-3 displays a message in a dialog box 
and records any information it could not translate in a separate log file.

When opening Excel files in 1-2-3
To view the log file, click Explain.
To view the translated Excel file, click OK.

When saving 1-2-3 files in Excel format
To view the log file, click Explain.

{button ,AL(`H_THE_EXCEL_LOG_FILE_OVER;H_TRANSLATING_EXCEL_FILES_OVER;H_WORKING_WITH_EX
CEL_FILES_OVER;',0)} See related topics



Inside the Expert
The Expert answers your questions about how to perform different tasks in 1-2-3. When you use the Expert, you can 
describe what you want to do in your own words, without worrying about using the right terminology.

How does the Expert work?
The Expert understands many terms and synonyms, so you can phrase the same question in different ways and the 
Expert will know what you're looking for. When you ask a question, the Expert:

• Identifies the Help topics associated with the task you want to accomplish.
• Lists possible answers in order of relevance.

After you select the answer you want, the Help window displays the steps needed to complete the task.
The Expert can help you find topics that explain how to perform various tasks in 1-2-3. To look up other types of Help,
such as reference information on @functions or LotusScript, or general overviews, use either the Help Contents or 
Index.

{button ,AL(`H_123_USING_EXPERT_STEPS;H_LEARN123_OVER;H_LEARN123_HELP_OVER',0)} See related 
topics



Sending the Expert log file to Lotus
The Expert records the questions you ask in one or more log files. By sending these files to Lotus, you can help us 
continue improving the Expert.
1. When you see the Expert Log dialog box, do one of the following (without closing the dialog box or 1-2-3):

• Open your electronic mail application, and then continue to step 2.
• If you don't have access to e-mail, copy the log files from the specified directory to a floppy disk and send the 

disk to: 1-2-3 User Assistance, Lotus Development Corp., 1 Rogers Street, Cambridge, MA    02142. Then skip
to step 7.

2. Create a mail message.
3. In the "To" box, type expert@lotus.com
4. In the "Subject" box, type 1-2-3 expert feedback
5. Locate the log files in the specified directory and then attach them to the mail message. 
6. Send the message.
7. In the Expert Log dialog box, select "Files have been sent."
8. (Optional) To delete all log files and turn off recording, select "Quit logging my questions and don't show this 

message again." 
9. Click OK.

{button ,AL(`H_123_USING_EXPERT_STEPS;H_123_ASK_THE_EXPERT_OVER',0)} See related topics



Using the Expert to get help
You can ask the Expert a question in your own words to find out how to perform a task.
1. From the Help menu, choose Ask the Expert, or click the Expert button in the status bar.

The Expert displays a list of tasks that varies, depending on what you have selected in the sheet.
2. If you don't see the task you want, type a question in the "Ask the Expert" box.
3. Click Ask.

The Expert replaces the list above the question box with the Help topics that answer your question.
4. If there are more than six answers, click More or Back to view the rest of the list. 
5. Click the Help topic that you want to see.
6. (Optional) To redisplay the list of answers that the Expert found, click the Expert button in the status bar.

Tip A check mark beside a topic lets you know you've already seen that topic.
7. (Optional) To ask a different question, click in the question box and then type the question.

{button ,AL(`H_123_USING_EXPERT_DETAILS',1)} See details
{button ,AL(`H_123_ASK_THE_EXPERT_OVER',0)} See related topics



Details: Using the Expert to get help
Help for the task at hand
The Expert is context-sensitive. That means that the Expert checks to see what you have selected in the sheet and 
then displays a list of tasks that might relate to what you're doing. For example, if you select a range, the Expert lists 
Help topics related to working in the sheet. If you select a chart, the Expert lists topics that explain how to work with 
charts.

Suggestions for asking questions
When you ask the Expert questions, follow these guidelines:

• Ask task-oriented questions.
Tip You don't need to include "How do I" when you enter a question. 

• Make your questions direct and concise. The clearer the question, the easier it is for the Expert to find the answer.
Type a few words (instead of just one word) to tell the Expert what you want to do. This makes it easier for the 
Expert to narrow down the list of possible answers.      

• Enter only necessary information. Extra information can cause the Expert to find the wrong answer or no answer.
• Ask only one question at a time.
• Check your spelling before asking a question.
• If the Expert can't find an answer, rephrase your question or ask about a related task.

For example, to find out how to set page breaks in a workbook, just type "set page break" and then click Ask. The 
Expert lists the appropriate Help topic and you can continue working. 

Keeping the Expert open
You can keep the Expert open while you work in 1-2-3. Just drag the Expert window by its top edge to a new location,
and then release the mouse button. To close the Expert, click Done.

{button ,AL(`H_123_USING_EXPERT_STEPS',1)} Go to procedure



Choosing the type of Help you want
When you choose Help Topics from the Help menu, you can specify how you want to access Help. 

When to use the Expert
The Expert gives you a quick and easy way to get task-oriented Help by asking questions using your own words. Just
tell the Expert what you want to do and then select the topic you want from a list of possible answers.

When to use Help Topics
If you want to access both task-oriented and reference Help, or see the overall Help structure at a glance, or if you 
just can't think of how to word a question, you can explore Help by browsing the Contents and Index.
Tip If you want 1-2-3 to display the regular Help window whenever you choose Help - Help Topics, select "Don't show
this message again."

{button ,AL(`H_123_USING_EXPERT_STEPS;H_123_ASK_THE_EXPERT_OVER;H_LEARN123_HELP_OVER',0)} 
See related topics



Overview: Filling ranges
1-2-3 automatically fills a range of cells with numbers, dates, times, or text. 

Filling a range with values
You can automatically fill a range with a sequence of numbers, dates, or times by choosing Range - Fill and 
specifying the first value in the sequence, the last value, and the interval between each value. For example, you can 
fill a range with numbers between 0 and 100, counting by tens (0, 10, 20, 30,...90, 100).

Filling by example
Get a head start on filling a range by entering a value in the top left cell of the range. For example, if you're filling a 
range with dates, enter the first date in the top left cell of the range. 1-2-3 uses the date as a start value for the 
sequence, and fills the range with the date format you used. If you enter a sequence of values in the first two cells of 
a range, 1-2-3 can also determine the increment.

Filling a range with text
To fill a range with text, 1-2-3 must recognize the text sequence. 1-2-3 uses SmartFill lists to store lists of data. Some 
SmartFill lists, such as months of the year and days of the week, are included with 1-2-3. 

SmartFill
You can use drag and fill to fill numbers and text. Automatic SmartFill suggests an entry as you start to type, based 
on what you type and the data surrounding the cell. For example:
The SmartFill list is Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday. You type "Monday" in a cell, 
then move to a cell immediately to the right or below. As soon as you type "T", 1-2-3 fills "uesday" into the cell.
If you type "T" into a cell immediately to the right or below a cell that contains the word Wednesday, 1-2-3 fills in 
"hursday" according to the order of words in the SmartFill list.

Creating SmartFill lists
You can create your own SmartFill lists so that 1-2-3 recognizes them as well. For example, you can create a 
SmartFill list that includes all the cities where your organization has offices. You can then automatically fill a range 
with your custom SmartFill list.
If you create a custom SmartFill list, you can select "Fill using same capitalization as list" in the SmartFill Setup dialog
box. 

Formatting SmartFill ranges
When you use SmartFill, 1-2-3 applies the styles from the example cell after you press ENTER. For example, if you 
type Monday in the first cell, press ENTER, and move to the next cell, type "T," and then press ENTER, you see 
Tuesday is formatted the same way Monday was formatted.

Accepting or rejecting SmartFill suggestions
You can accept a SmartFill suggestion by pressing ENTER or clicking outside of the cell. You can reject a SmartFill 
suggestion by continuing to type what you want, by pressing ESC, or by pressing DEL to delete the highlighted portion
of the cell contents. 
If 1-2-3 cannot find a match for the characters you type, the cell contents are replaced with the next character(s) you 
type.

Turning off SmartFill
You can turn off the automatic suggestions that SmartFill provides by choosing File - User Setup - 1-2-3 Preferences 
and deselecting "Use SmartFill during data entry."

{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS
;H_FILLING_A_RANGE_WITH_DATES_STEPS;H_FILLING_A_RANGE_WITH_NUMBERS_STEPS;H_FILLING_
A_RANGE_WITH_TEXT_STEPS;H_FILLING_A_RANGE_WITH_TIMES_STEPS',0)} See related topics



Fill dialog box
Use this dialog box to choose fill options for the selected range. 

Choose a task
Filling a range with numbers
Filling a range with text
Filling a range with dates 
Filling a range with times

{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_Filling_Ranges_OVER;H_FILLING_A_RANGE_USIN
G_DRAGANDFILL_STEPS;',0)} See related topics



Filling a range with numbers
You can fill a range with a sequence of numbers.
1. Select the range to fill.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns, rows, and sheets.
2. Choose Range - Fill.
3. In the "Fill using" list, select "Numbers."
4. Enter the start value, the increment, and the stop value.
5. Click OK.

{button ,AL(`H_FILLING_A_RANGE_WITH_NUMBERS_DETAILS',1)} See details
{button ,AL(`H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_DATES_STEP

S;H_FILLING_A_RANGE_WITH_NUMBERS_STEPS;H_FILLING_A_RANGE_WITH_TEXT_STEPS;H_FILLING_
A_RANGE_WITH_TIMES_STEPS;H_FILLING_RANGES_OVER;',0)} See related topics



Details: Filling a range with numbers
Entering the first number in the sequence
You can enter integers, for example 43, 67, 2, or numbers with decimal amounts, for example 2.5, 34.75, 33.2.

Entering an increment
The increment is the amount between the numbers in the sequence. The default is 1. You can enter integers or 
numbers with decimal amounts.

Entering the last number in the sequence
You can enter integers or numbers with decimal amounts. If you don't enter a stop value, 1-2-3 fills the entire range 
with the sequence of numbers up to the default stop value of 32767. If you enter a negative increment value, you 
must specify a stop value that is less than the start value.

Filling a range by example
If the top left cell of the fill range contains a number, 1-2-3 enters the number as the start value if you select "Fill by 
example" in the "Fill using" list. If the first two cells of the range contain numbers in a sequence, 1-2-3 determines the 
increment value from the sequence. 1-2-3 also copies the number format and any other styles from the example cells
into the fill range.

Entering a formula or cell reference
For the start, stop, and increment values, you can enter either a formula or the name or address of a cell containing 
the value you want to use.

How 1-2-3 fills the range
1-2-3 fills the cells in the range from top to bottom in a column and from left to right. If you specify a multiple-sheet fill 
range, 1-2-3 fills the range in the first sheet, continues the sequence on the second sheet, and so on until 1-2-3 
reaches the stop value or the end of the range.

{button ,AL(`H_FILLING_A_RANGE_WITH_NUMBERS_STEPS',1)} Go to procedure



Filling a range with text
You can fill a range with a sequence of text, called a SmartFill list. 
1. Enter the first item from the SmartFill list in the top left cell of the range.
2. Select the range to fill.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns, rows, and sheets.
3. Choose Range - Fill.
4. In the "Fill using" list, select "Fill by example."
5. Click OK.

{button ,AL(`H_FILLING_A_RANGE_WITH_TEXT_DETAILS',1)} See details
{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS

;H_FILLING_A_RANGE_WITH_DATES_STEPS;H_FILLING_A_RANGE_WITH_NUMBERS_STEPS;H_FILLING_
A_RANGE_WITH_TEXT_STEPS;H_FILLING_A_RANGE_WITH_TIMES_STEPS;H_FILLING_RANGES_OVER;',
0)} See related topics



Details: Filling a range with text
1-2-3 uses SmartFill lists to store lists of text you can use to fill ranges.

SmartFill lists that 1-2-3 recognizes
1-2-3 recognizes common sequences of data, including: 

• Days of the week 
• Directions (North, South, East, West)
• Months of the year
• Letters of the alphabet
• Quarters of the year (Q1, Q2, Q3, Q4)

In addition, 1-2-3 will recognize as a sequence any text you enter that begins or ends with a number. For example, if 
you enter Store 1 in a cell, 1-2-3 will fill the range with Store 2, Store 3, and so on.
1-2-3 also recognizes custom SmartFill lists you create using File - User Setup - SmartFill Setup.

{button ,AL(`H_FILLING_A_RANGE_WITH_TEXT_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_A_CUSTOM_FILL_LIST_STEPS',0)} See related topics



Filling a range with dates
You can fill a range with a sequence of dates.

 Show me a QuickDemo
1. Select the range to fill.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns, rows, and sheets.
2. Choose Range - Fill.
3. In the "Fill using" list, select "Dates."
4. Select an lnterval.
5. Enter the start date and the increment.
6. (Optional) Enter the stop date.
7. Click OK.

{button ,AL(`H_FILLING_A_RANGE_WITH_DATES_DETAILS',1)} See details
{button ,AL(`H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_DATES_STEP

S;H_FILLING_A_RANGE_WITH_NUMBERS_STEPS;H_FILLING_A_RANGE_WITH_TEXT_STEPS;H_FILLING_
A_RANGE_WITH_TIMES_STEPS;H_FILLING_RANGES_OVER;',0)} See related topics



Details: Filling a range with dates
Entering the start date
If you are filling a blank range, you must enter the start date. You can enter the start date in the following formats:

• 17-Jul-96
• 17-Jul or 7/17

If you enter the date in one of these formats, 1-2-3 assumes the current year and stores the date as 17-Jul-96. 
• Jul-96

Use the format Jul-96 only for intervals of Quarter, Month, or Year. 1-2-3 stores the date using the first day of the 
month.

• 07/17/96
The start date can be any date from January 1, 1900 through December 31, 9999.
Note 1-2-3 uses the defaults set with File - User Setup - 1-2-3 Preferences (General tab) to determine how to store 
and display dates. For more information, see Setting options for dates.

Filling by example
If the top left cell in the range contains a date, 1-2-3 enters that date as the start date if you select "Fill by example" in
the "Fill using" list. If the first two cells of the range contain dates in a sequence, 1-2-3 determines the increment 
value from the sequence. 1-2-3 also copies the date format and any other styles from the example cells into the fill 
range.

Entering the interval and increment
The interval specifies the type of date you want; the increment is the amount between the dates in the sequence. For 
example, to fill a range with dates two weeks apart, select week as the interval and enter 2 as the increment.

Entering a formula or cell reference
For the start, stop, and increment values, you can enter either a formula or the name or address of a cell containing 
the value you want to use.

How 1-2-3 fills the range
1-2-3 fills the cells in the range from top to bottom in a column and from left to right. If you specify a multiple-sheet fill 
range, 1-2-3 fills the range in the first sheet, continues the sequence on the second sheet, and so on until 1-2-3 
reaches the stop value or the end of the range.

{button ,AL(`H_FILLING_A_RANGE_WITH_DATES_STEPS',1)} Go to procedure



Filling a range with times
You can fill a range with a sequence of times.
1. Select the range to fill.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns, rows, and sheets.
2. Choose Range - Fill.
3. In the "Fill using" list, select "Times."
4. Select an interval.
5. Enter the start time and the increment.
6. (Optional) Enter the stop time.
7. Click OK.

{button ,AL(`H_FILLING_A_RANGE_WITH_TIMES_DETAILS',1)} See details
{button ,AL(`H_FILLING_RANGES_OVER;H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS;H_FILLING_A_

RANGE_WITH_DATES_STEPS;H_FILLING_A_RANGE_WITH_NUMBERS_STEPS;H_FILLING_A_RANGE_WIT
H_TEXT_STEPS;H_FILLING_A_RANGE_WITH_TIMES_STEPS',0)} See related topics



Details: Filling a range with times
Entering the start time
If you are filling a blank range, you must enter the first time in the sequence. You can enter the start time in the 
following formats:

• 10:45:34 PM
• 10:45 PM
• 22:45:34
• 22:45

The start time can be any time from 00:00:00 to 23:59:59. By default, 1-2-3 displays times in the fill range in the 
format 23:59. 

Filling by example
If the top left cell in the range contains a time, 1-2-3 enters that time as the start time if you select "Fill by example" in 
the "Fill using" list. If the range contains times in a sequence, 1-2-3 determines the increment value from the 
sequence. 1-2-3 also copies the Time format and any other styles from the example cells into the fill range.

Including the last time in the sequence
To be sure the last time you want appears in the fill range, specify a stop value greater than the last time you want to 
include in the fill range, by an amount equal to the increment value.

Entering the interval and increment
The interval specifies the type of time unit you want; the increment is the amount between the times in the sequence. 
For example, to fill a range with times two minutes apart, select minute as the interval and enter 2 as the increment.

Entering a formula or cell reference
For the start, stop, and increment values, you can enter either a formula or the name or address of a cell containing 
the value you want to use.

How 1-2-3 fills the range
1-2-3 fills the cells in the range from top to bottom in a column and from left to right. If you specify a multiple-sheet fill 
range, 1-2-3 fills the range in the first sheet, continues the sequence on the second sheet, and so on until 1-2-3 
reaches the stop value or the end of the range.

{button ,AL(`H_FILLING_A_RANGE_WITH_TIMES_STEPS',1)} Go to procedure



Overview: Creating custom SmartFill lists
Automatic SmartFill suggests an entry as you start to type, based on what you type and the data surrounding the cell.
You can create custom SmartFill lists to speed up data entry and make it easier to enter data that you use repeatedly.
You can use your SmartFill lists in any workbook.

Creating your own SmartFill lists
You can use SmartFill lists to fill ranges and to name a series of sheets. SmartFill lists can contain up to 100 items. 
For example, suppose you frequently enter the following list of cities in your sheets:

New York
Los Angeles
London
Brussels
Tokyo
Seoul
Singapore

You can create a SmartFill list so that when any city in the list is in the first cell of the range to fill, 1-2-3 automatically 
enters the other cities, in the order they appear in the list. For example, if New York is in the first cell of the range, 1-2-
3 enters Los Angeles, London, and so on.

If Seoul is in the first cell in the range, 1-2-3 enters Singapore, New York, Los Angeles, and so on. In the same way, 
you can use this SmartFill list to enter a series of sheet names.

{button ,AL(`H_CREATING_A_CUSTOM_FILL_LIST_STEPS;H_FILLING_RANGES_OVER;H_FILLING_A_RANGE_
USING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_TEXT_STEPS;H_MODIFYING_A_CUSTOM_FIL
L_LIST_STEPS',0)} See related topics



Creating a custom SmartFill list
You can create a custom SmartFill list containing data you enter repeatedly.
1. From the File menu, choose User Setup, and then choose SmartFill Setup.

2. Click New List.
3. Type a name for the new list and click OK.
4. Click Add Items.
5. (Optional) To add items to the new list by retrieving the values from a range, use the range selector to specify the 

range, and then click Get Items from Range.
6. Type an item in the box and press ENTER. 
7. Repeat step 6 for each item you want to add to the list.
8. Click OK to return to the SmartFill Setup dialog box.
9. (Optional) Select "Fill using same capitalization as list." 
10. Click Done.

{button ,AL(`H_CREATING_A_CUSTOM_FILL_LIST_DETAILS',1)} See details
{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_FILLING_RANGES_OVER;H_FILLING_A_RANGE_U

SING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_TEXT_STEPS;H_MODIFYING_A_CUSTOM_FILL
_LIST_STEPS',0)} See related topics



Details: Creating a custom SmartFill list
Naming the SmartFill list
Each SmartFill list is identified by a unique name. If you have more than one SmartFill list with similar data, name 
each list with a unique name so that you can identify it. For example, if one list contains European cities, you might 
name it CITYEUR, while you name the list of cities in the United States CITYUS. SmartFill list names can contain up 
to 64 characters.

Entering items in a SmartFill list
Each item in a SmartFill list can contain up to 64 characters. Items can contain spaces, letters, and numbers. An item 
from a SmartFill list is always entered in your sheet as a label.
If you use Get Items from Range to add items, 1-2-3 adds labels from the range, but not values. If there are already 
items in the list, the items retrieved from the range are added to the bottom of the list.

Capitalization in the SmartFill list
If you want 1-2-3 to use the exact combination of uppercase and lowercase letters you enter in the SmartFill list, 
select "Fill using same capitalization as list." Otherwise, 1-2-3 will use the capitalization from the data you enter in the
range.

{button ,AL(`H_CREATING_A_CUSTOM_FILL_LIST_STEPS',1)} Go to procedure



Adding items to a SmartFill list
Use the Add Items dialog box to enter one or more items for a SmartFill List. 

Adding items to a list
Type each item in the box on its own line. Press ENTER to add a new line. You can add up to 100 items for each list.

Get Items from Range
Click to use data from a range for SmartFill items. 1-2-3 fills the items in the box, separated by line spaces. If there 
are already items in the list, the items retrieved from the range are added to the bottom of the list. This button is not 
available if there are no workbooks open. 
If you use Get Items from Range to add items, 1-2-3 adds labels from the range, but not values.
Note Items are truncated at 64 characters.
You can edit the items in the list after you retrieve them from the range.

Range
Click the range selector and select the cell or range you want to include in the list. The "Range" box is not available if 
no workbooks are open.

{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_Filling_Ranges_OVER',0)} See related topics



Modifying a custom SmartFill list
You can add, delete, or rearrange the items in a custom SmartFill list.
1. From the File menu, choose User Setup, and then choose SmartFill Setup.

2. From the "List name" box, select the list you want to change.
3. To add an item to the list, click Add Items, enter the new item(s), then click OK.
4. To remove an item from the list, highlight the item and click Delete Item.
5. To change the order of the items, drag an item to a different part of the list.
6. To delete the list, click Delete List.
7. Click Done.

{button ,AL(`H_MODIFYING_A_CUSTOM_FILL_LIST_DETAILS',1)} See details
{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_CREATING_A_CUSTOM_FILL_LIST_STEPS;H_FILLI

NG_RANGES_OVER;H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_T
EXT_STEPS;H_MODIFYING_A_CUSTOM_FILL_LIST_STEPS',0)} See related topics



Details: Modifying a custom SmartFill list
To edit an item in a SmartFill list, you must delete the original item and add a new item.
You can also rearrange items in the list by selecting an item and clicking the arrow buttons.

{button ,AL(`H_MODIFYING_A_CUSTOM_FILL_LIST_STEPS',1)} Go to procedure



Filling a range by dragging
You can use the mouse to fill a range with a sequence of data. 1-2-3 fills the range based on the data already entered
in the range.

 Show me a QuickDemo
1. Select the cell or range containing the data you want to base the sequence on.
2. Position the mouse pointer at the bottom right corner of the cell or range until the pointer displays four 

arrowheads.

3. Drag to select the range to fill.
4. Release the mouse button.

{button ,AL(`H_FILLING_A_RANGE_USING_DRAGANDFILL_DETAILS',1)} See details
{button ,AL(`H_FILLING_RANGES_OVER;H_CREATING_CUSTOM_FILL_LISTS_OVER;H_FILLING_A_RANGE_U

SING_DRAGANDFILL_STEPS;H_FILLING_A_RANGE_WITH_DATES_STEPS;H_FILLING_A_RANGE_WITH_N
UMBERS_STEPS;H_FILLING_A_RANGE_WITH_TEXT_STEPS;H_FILLING_A_RANGE_WITH_TIMES_STEPS',
0)} See related topics



Details: Filling a range by dragging
How 1-2-3 determines how to fill the range
You must enter the data you want 1-2-3 to use as the basis for filling the range in the top left corner of the range. You 
can enter numbers, dates, and times, or text that is part of a SmartFill list.
When you select the cell or range, 1-2-3 examines the data in the range to determine how to fill the range. For 
example, you can select a cell that contains the word January, and then drag to fill a range with February, March, 
April, and so on.
If you want 1-2-3 to recognize a sequence, enter data in the first two cells of the range. For example, if you enter 
January and March, 1-2-3 will fill the range with every other month - January, March, May, July, and so on.

Dragging based on your selection
If you select one cell, then drag, you can drag both down and right. If you select a range of more than one cell, you 
can drag in only one direction.

Filling a 3D range
To fill a 3D range, use Range - Fill. You can't use drag and fill on a 3D range.

Troubleshooting
If 1-2-3 doesn't recognize a relationship between the data in the first two cells of the range (for example, Monday, 
February) it fills a range by copying data from the first two cells.

{button ,AL(`H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS',1)} Go to procedure



SmartFill Setup dialog box
Use this dialog box to name, add, modify, and view the entries in current SmartFill lists, and to control the 
capitalization and order of the entries.

Choose a task
Creating a custom SmartFill list
Modifying a custom SmartFill list

{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_Filling_Ranges_OVER',0)} See related topics



Overview: Finding data
1-2-3 gives you several ways to locate data in a 1-2-3 workbook.

Using the selection indicator and the navigator
The selection indicator displays your current selection. It displays the address or name of a range and the name of 
other types of objects. For example, if you select an unnamed range, the range address appears in the selection 
indicator; if you select a chart, the chart name appears.

Click the navigator to see the list of range names in the current workbook. You can use the navigator to:
• Go to and select a named range (when 1-2-3 is in Ready mode)
• Insert a range name into a formula or @function

Going to and selecting ranges and graphic objects
Using Edit - Go To, you can find and select ranges and other objects in the current workbook or in other active 
workbooks. See Finding ranges and graphic objects. 
Tip Edit - Go To is a quick way to select data or an object in another sheet or to navigate to a part of the sheet that is 
not visible. 

Finding and replacing sheet entries
Use Edit - Find & Replace to find or replace labels or values in the sheet. 1-2-3 can search the selected range, 
current sheet, current workbook, or all active workbooks. Objects such as text blocks and maps are included in the 
search, but 1-2-3 will not search in hidden sheets, rows, or columns.

{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_STEPS;H_FINDING_RANGES_AND_OTHER
_OBJECTS_STEPS;H_FINDING_TEXT_OR_NUMBERS_STEPS;H_USING_THE_NAVIGATOR_TO_FIND_NAM
ED_RANGES_STEPS',0)} See related topics



Finding text or numbers
1-2-3 can search the selected range, current sheet, current workbook, or all active workbooks to find labels and 
values. 1-2-3 looks in cells, ranges, maps, and text blocks.
1. From the Edit menu, choose Find & Replace.

2. Enter the characters you want to find in the "Find" box.
For numbers, don't include formatting. For example, enter 67, not 67%.

3. (Optional) In the "Look in," "Include," and "Match" boxes, specify where to look and what to include.
4. Click Find.

1-2-3 highlights the first occurrence of the characters.
5. (Optional) To go to the next occurrence, click Find again.
6. Click Done.

{button ,AL(`H_FINDING_TEXT_OR_NUMBERS_DETAILS',1)} See details
{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_STEPS;H_FINDING_RANGES_AND_OTHER

_OBJECTS_STEPS;H_USING_THE_NAVIGATOR_TO_FIND_NAMED_RANGES_STEPS;H_FINDING_DATA_O
VER;',0)} See related topics



Details: Finding text or numbers
You can enter up to 512 characters to search for. 1-2-3 doesn't look in hidden rows, columns or sheets.

Looking in a selected range
If you choose "Selected range" from the "Look in" list, the "Range" box appears so you can specify a range. Type the 

name or address of the range, or click the range selector and select the range.

You can also select the range before you choose Edit - Find & Replace.

Options for "Match"
• Case -- Looks for characters using the exact combination of uppercase and lowercase letters you enter in the 

"Find" box.
• Accent -- Looks for accented characters. Select this option if you don't want 1-2-3 to find é, è, and ë when you 

search for e. If you don't select this option, 1-2-3 ignores accents. 

Options for "Include"
• Labels -- Searches for characters entered as text.
• Numbers -- Searches for numbers; does not include formula results.
• Formulas -- Searches the characters in formulas.

Redefining a search
At any time, you can click Redefine to change the search characters and start again.

Related SmartIcons

Goes to and selects a range or graphic object 

{button ,AL(`H_FINDING_TEXT_OR_NUMBERS_STEPS',1)} Go to procedure



Finding ranges and graphic objects
You can find and select the following things in a 1-2-3 workbook: a chart, a datalink table, a drawn object, a map, a 
Notes/FX field, an OLE object, a query table, a range, a sheet, a versioned range, and a Web table.
1. From the Edit menu, choose Go To.

2. Select the type of object you want to go to.
3. (Optional) To look in another active workbook, select the workbook from the "In workbook" list.
4. Select the range, sheet, or graphic object you want from the "Names" list.
5. Click OK.
1-2-3 goes to and selects the range or object you chose.

{button ,AL(`H_FINDING_RANGES_AND_OTHER_OBJECTS_DETAILS',1)} See details
{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_STEPS;H_FINDING_TEXT_OR_NUMBERS_

STEPS;H_USING_THE_NAVIGATOR_TO_FIND_NAMED_RANGES_STEPS;H_FINDING_DATA_OVER',0)} See 
related topics



Details: Finding ranges and graphic objects
Looking in a different workbook
By default, 1-2-3 looks in the current workbook for the range or object you select. If you select a different workbook, 
1-2-3 lists all of the ranges and objects in that workbook.

Specifying a range address
If you select a range as the type of object you want to go to, you can enter a range address in the box above the list.

{button ,AL(`H_FINDING_RANGES_AND_OTHER_OBJECTS_STEPS',1)} Go to procedure



Finding and replacing text or numbers
1-2-3 can search the selected    range, current sheet, current workbook, or all active workbooks to find and replace 
labels and values. 1-2-3 looks in cells, ranges, maps, and text blocks.
1. From the Edit menu, choose Find & Replace.

2. Enter the characters you want to find in the "Find" box.
3. Enter the new characters in the "Replace with" box.
4. (Optional) In the "Look in," "Include," and "Match" boxes, specify where to look and what to include.
5. Click Find.

1-2-3 highlights the first occurrence of the characters.
6. Click Replace.

1-2-3 replaces the characters and moves to the next occurrence.
7. (Optional) To replace the next occurrence of the characters, click Replace again.
8. Click Done.

{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_DETAILS',1)} See details
{button ,AL(`H_FINDING_RANGES_AND_OTHER_OBJECTS_STEPS;H_USING_THE_NAVIGATOR_TO_FIND_NA

MED_RANGES_STEPS;H_FINDING_DATA_OVER;H_FINDING_TEXT_OR_NUMBERS_STEPS;',0)} See related
topics



Details: Finding and replacing text or numbers
You can enter up to 512 characters to search for. 1-2-3 doesn't look in hidden rows, columns, or sheets.

Replacing selected occurrences of the search characters
You can view each occurrence of the characters individually and determine whether to replace them. 

• Replace -- Replaces the highlighted characters and finds the next occurrence.
• Find -- Skips to the next occurrence without replacing. 
• Replace All -- Replaces all remaining occurrences of the characters in the range, sheet, workbook,    or all 

workbooks (according to what is selected in the "Look in" list).

Looking in a selected range
If you choose "Selected range" from the "Look in" list, the "Range" box appears so you can specify a range. Type the 

name or address of the range, or click the range selector and select the range.

You can also select the range before you choose Edit - Find & Replace.

Options for "Match"
• Case -- Looks for characters using the exact combination of uppercase and lowercase letters you enter in the 

"Find" box.
• Accent -- Looks for accented characters. Select this option if you don't want 1-2-3 to find é, è, and ë when you 

search for e. If you don't select this option, 1-2-3 ignores accents. 

Options for "Include"
• Labels -- Searches for characters entered as text.
• Numbers -- Searches for numbers; does not include formula results.
• Formulas -- Searches the characters in formulas.

Redefining a search
At any time, you can click Redefine to change the search characters and start again.

Related SmartIcons

Goes to and selects a range or graphic object 

{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_STEPS',1)} Go to procedure



Using the navigator to find named ranges
The navigator lists all named ranges in the current workbook. 
1. Click the navigator.

2. Select the named range from the list.
1-2-3 goes to and selects the range, placing the cell pointer in the top left cell.

{button ,AL(`H_FINDING_AND_REPLACING_TEXT_OR_NUMBERS_STEPS;H_FINDING_RANGES_AND_OTHER
_OBJECTS_STEPS;H_FINDING_TEXT_OR_NUMBERS_STEPS;H_FINDING_DATA_OVER;',0)} See related 
topics



Find and Replace dialog box
Use this dialog box to find or to find and replace text or numbers.

Choose a task
Finding text or numbers
Finding and replacing text or numbers

{button ,AL(`H_FINDING_DATA_OVER;',0)} See related topics



Details: Adding an item to the @function menu
Positioning @functions on the menu
When you click >> to add an @function, 1-2-3 adds the @function below the item selected in the "Current menu" list. 
If nothing is selected in the "Current menu" list, 1-2-3 adds the @function to the end of the list.
When you drag an @function to the "Current menu" list, the placement of the @function depends on the location of 
the mouse pointer when you release the mouse button:

• If the pointer is over the top half of an @function, 1-2-3 adds the new @function above that item.
• If the pointer is over the bottom half of an @function, 1-2-3 adds the new @function below that item. 

Adding separators
You can add lines to the @function menu to separate and group @functions. To add a separator below an @function,
select the @function in the "Current menu" list and then click Separator. 

When the @function selector isn't available
If the edit line is hidden, you don't see the @function selector. To display the edit line and @function selector, choose 
View - Show Edit Line. 
If no workbooks are open, the @function selector is grayed out. 

{button ,AL(`H_ADDING_AN_ATFUNCTION_STEPS',1)} Go to procedure



Adding an item to the @function menu
For easy access, you can add the @functions you use most often to the @function menu. 
1. Click the @function selector. 

 
2. Choose List All. 
3. Click Menu >>.
4. (Optional) To narrow down the list of @functions, select a category from the "Category" list.
5. From the "@Functions" list, select the @function you want to add.
6. Click >>.

Tip You can also drag the @function into the "Current menu" list.
7. (Optional) To add other @functions, repeat steps 5 and 6.
8. Click OK.

{button ,AL(`H_ADDING_AN_ATFUNCTION_DETAILS',1)} See details
{button ,AL(`H_REMOVING_AN_ATFUNCTION_STEPS;H_FUNC_BASICS;H_ENTERING_AN_ATFUNCTION_STE

PS;H_REARRANGING_ATFUNCTION_MENU_STEPS',0)} See related topics



Rearranging items on the @function menu
If you don't like the order of the items on the @function menu, you can rearrange them.
1. Click the @function selector. 

 
2. Choose List All. 
3. Click Menu >>.
4. Select the @function or separator you want to move in the "Current menu" list.
5. Drag the item to a new location in the "Current menu" list.
6. (Optional) To move other items, repeat steps 4 and 5.
7. Click OK.

{button ,AL(`H_REARRANGING_ATFUNCTION_MENU_DETAILS',1)} See details
{button ,AL(`H_ADDING_AN_ATFUNCTION_STEPS;H_REMOVING_AN_ATFUNCTION_STEPS;H_FUNC_BASICS'

,0)} See related topics



Details: Rearranging items on the @function menu
Positioning items on the menu
When you drag an @function or separator in the "Current menu" list, the placement of the item depends on the 
location of the mouse pointer when you release the mouse button:

• If the pointer is over the top half of an @function, 1-2-3 places the item above the @function.
• If the pointer is over the bottom half of an @function, 1-2-3 places the item below the @function.

{button ,AL(`H_REARRANGING_ATFUNCTION_MENU_STEPS',1)} Go to procedure



Removing an item from the @function menu
If you remove an @function from the @function menu, you can still select the @function from the full list by clicking 
the @function selector.
1. Click the @function selector.

 
2. Choose List All.
3. Click Menu >>.
4. From the "Current menu" list, select the @function you want to remove.
5. Click <<.

Tip You can also drag the @function out of the "Current menu" list.
6. (Optional) To remove other @functions, repeat steps 4 and 5.
7. Click OK.

{button ,AL(`H_REMOVING_AN_ATFUNCTION_DETAILS',1)} See details
{button ,AL(`H_ADDING_AN_ATFUNCTION_STEPS;H_FUNC_BASICS;H_REARRANGING_ATFUNCTION_MENU_

STEPS',0)} See related topics



Details: Removing an item from the @function menu
Removing separators
To remove a separator, select the separator in the "Current menu" list and then click <<. 
You can also remove a separator by dragging. Simply move the mouse pointer to the separator and then drag it out 
of the "Current menu" list.

When the @function selector isn't available
If the edit line is hidden, you don't see the @function selector. To display the edit line and @function selector, choose 
View - Show Edit Line. 
If no workbooks are open, the @function selector is grayed out. 

{button ,AL(`H_REMOVING_AN_ATFUNCTION_STEPS',1)} Go to procedure



1-2-3 database table
A range containing data organized in rows and columns. Each row contains one record, and each column (field) 
contains one kind of information. For example, in an employee database table that contains the fields Last_Name, 
First_Name, and so on, each record contains information about one employee.
A 1-2-3 database table must fit on a single sheet, and can contain up to 256 fields and 65,535 records.



absolute reference
In a formula, a reference to a cell that does not change when you copy the formula. An absolute reference always 
refers to the same cell or range.
To create an absolute cell reference, enter a $ (dollar sign) before the sheet letter, column letter, and row number ($A:
$A$4) when you write the formula. To create an absolute range name, enter a $ (dollar sign) before the range name 
($INTEREST). 
For example, if you copy the formula +$A$1*B10 entered in cell C10 to C11 and C12, the formula changes to +
$A$1*B11 and +$A$1*B12. The absolute reference ($A$1) does not change.



active area
The area bounded by cell A1 and the lowest and rightmost nonblank cell in the current sheet. Press END HOME to find
this cell. The size of the active area affects the amount of memory a sheet requires.



active window
The window in which you are working. Only one window can be active at a time.
You can identify the active window by the presence of color in its title bar. Click the title bar to make a window active.



active workbook
An open workbook.



add-in
A special program, created by Lotus and other software developers, that you can use with 1-2-3 to extend its 
capabilities.



alignment
The position of data in a cell, range, or text block; for example, centered, right-aligned, and so on.
To control alignment, use the Alignment tab in the InfoBox:

You can also use the Alignment button in the status bar.



ANSI (American National Standards Institute)
A set of character codes used by the operating system. The ANSI character set contains 256 character codes. The 
first 128 ANSI characters (0-127) are the same as the ASCII (American Standard Code for Information Interchange) 
character set. The first 32 ANSI characters (0-31) are non-printing control characters, and display as substitute 
characters. 



argument separator
A single character, such as a , (comma), ; (semicolon), or . (period), that separates one argument from another in an 
@function or macro command, and one range from another in some commands.
You can specify any character as the argument separator using your operating system's regional (country) settings.



argument
Text, value, location, or condition that you provide for an @function or macro command. For example, in the formula 
@SUM(A1..A10), the argument is A1..A10. In the macro {BRANCH TOTALS}, the argument is the range name 
TOTALS.



ASCII (American Standard Code for Information Interchange)
A standard set of character codes many computers and devices use to create text. LMBCS (Lotus Multibyte 
Character Set) and ANSI (American National Standards Institute) include the ASCII character set.



backslash macro
A macro name that consists of a \ (backslash) followed by a single letter; for example \d.



blank cell
A cell that contains no letters, numbers, spaces, or label-prefix character.



branch
A transfer of macro control to another macro routine. Unlike subroutine calls, branches do not return control to the 
original macro.



byte pointer
A place marker that moves by bytes in a text file and indicates the current position. 1-2-3 uses the byte pointer in 
some of the file-manipulation macro commands.



cell address
The location of a cell, identified by the sheet letter, column letter, and row number; for example, A:A2.



cell comment marker
Shows that a cell contains a cell comment by displaying a marker in the top left corner.



cell pointer
The rectangular outline in the sheet that marks the current cell. If a multi-cell range is selected, the current cell 
appears in reverse color.



cell
The basic unit of a 1-2-3 sheet. The intersection of a column and a row forms a cell. You enter and store data in a 
cell.



circular reference
A formula that refers to itself, either directly or indirectly. For example, a circular reference occurs if you enter the 
formula +B1+1 in cell B1.
When a formula contains a circular reference, 1-2-3 displays the Circular reference button in the status bar. To locate 
the circular reference, click the button; 1-2-3 moves the cell pointer to the first cell containing a circular reference.



Clipboard format
One of a number of standard formats used for the exchange of data between applications via the Clipboard.
1-2-3 can read and write these Clipboard formats except where noted:

• Bitmap
• Device Independent Bitmap
• Lotus Chart
• Lotus 1-2-3 9 Workbook (write only)
• Picture
• Rich Text Format (write only)
• Text
• WK1
• WK3

Note 1-2-3 supports DDE using the Text, WK1, and WK3 Clipboard formats.



Clipboard
A storage area the operating system uses to temporarily store data when you use Edit - Cut or Edit - Copy. Use Edit - 
Paste, Edit - Paste Special, and Edit - Paste Link to paste the Clipboard contents into 1-2-3 or another application.



collection

Two or more ranges, selected at the same time, so that your next action affects all the ranges in the collection at 
once. A collection can include ranges in different sheets of the same file.
The address of a collection consists of the addresses of all of the ranges in the collection separated by semicolons.
A collection can also contain two or more objects of the same type, such as charts or other graphic objects. A 
collection cannot contain objects of different types. For example, a collection cannot contain both ranges and charts.



Comma format
Displays numbers with thousands separators and up to 15 decimal places. Comma format is the same as Currency 
format without the currency symbol.



Control menu

Displays commands for manipulating windows and the InfoBox.
To open the control menu, click the icon in the left corner of the title bar.



criteria
The conditions that you want records to meet when querying a database table. For example, to select all sales 
greater than $25,000, specify the criterion as SALES>25000.
When working with a query table that is an Approach embedded object, you set criteria by using the Approach Find 
Assistant with 1-2-3. After you create a query table, you can select the type of find (query) you want to perform and 
specify the find conditions (criteria).
When working with a DQA query table created with the Data Query Add-In, you set criteria to select records when you
create the query table. You can also use Query - Set Criteria to change the criteria after you create the query table.
You also specify criteria when working with @functions, LotusScript, and macros.



Currency format
Displays numbers with a currency symbol, thousands separators, and up to 15 decimal places; for example, 
$21,330.40. You can format different cells in the same workbook as different types of currency. For example, you can 
format one cell as US dollar and another as French franc.
To format cells as currency, use the Number Format tab in the InfoBox:



current cell
The cell in the sheet that contains the cell pointer. The next selection, entry, or edit affects the current cell. The 
address of the current cell appears in the selection indicator in the edit line.



current directory
The directory that 1-2-3 automatically uses during a session to save, open, or list files.
The current directory is initially set to the default directory specified with File - User Setup - 1-2-3 Preferences (File 
Locations tab). If you specify a different directory during a 1-2-3 session with the File - Open or File - Save As 
commands, it takes precedence over the default directory during that session.



current selection
The highlighted cell, range, collection, or object that the next command will affect.

When you select a graphic object, a query table, a datalink table, or a Web table, handles -- the small boxes on the 
edges of the selection -- appear around it.



current workbook
The workbook that contains either the cell pointer or a selected object.



database
A file containing one or more database tables. A 1-2-3 database table is a range containing data organized in rows 
and columns. A 1-2-3 database table consists of records (rows of data) whose parts are identified by labeled fields 
(columns).



Date format
The way 1-2-3 displays a date number. To apply a date format to a number in a range or a chart, use the Number 
Format tab in the InfoBox.
You can also use the status bar to apply a date format to a range.

1-2-3 automatically formats data as a date if you enter it using a format 1-2-3 recognizes. 1-2-3 automatically formats 
dates entered as Dec-63, 04-Dec, 04-Dec-63, or 12/04/63, plus dates entered in any format you promote to the 
Frequently Used list.



date number 
A number from 1 through 2,958,465 that 1-2-3 assigns in sequence to each date from January 1, 1900, through 
December 31, 9999. For example, the date number for July 21, 1991, is 33440.
Note In @functions that use dates for arguments, you should always specify a 4-digit year in the date to make sure 
you get the results you want -- for example, 12/31/2005. If you specify a 2-digit year, 1-2-3 uses the date setting in the
1-2-3 Preferences dialog box to determine whether the year refers to the 20th or the 21st century. 
If you enter a value that looks like a date, for example, 12/31/96 or 31-Dec, 1-2-3 enters the date as you typed it in 
the cell; the corresponding date number is stored in the cell. 
You can use date numbers in calculations. 



default directory
The directory that 1-2-3 automatically uses for files when you start 1-2-3. Initially, 1-2-3 uses the directory specified in 
the Install program, but you can specify a different default directory with File - User Setup - 1-2-3 Preferences (File 
Locations tab).



default font
The font 1-2-3 uses for all data in a workbook, except for data in cells you explicitly style with another font. To change 
the default font, use File - User Setup - 1-2-3 Preferences (New Workbook Defaults tab).
Initially, the fonts listed in the 1-2-3 Preferences dialog box depend on the fonts available on the default printer you 
specified through the operating system. If you select a different printer in 1-2-3, the fonts listed reflect the fonts 
available on the selected printer.



default setting
The initial settings 1-2-3 uses for viewing, printing, and working in workbooks. You can change certain default settings
for entire sheets or workbooks using View - Set View Preferences, File - User Setup - 1-2-3 Preferences, or Sheet - 
Sheet Properties.



delimited text file
A file in ASCII format that contains rows of data with delimiters. A delimiter is a , (comma), space, : (colon), or ; 
(semicolon) entered between numbers and labels in each row. Each row must end with a carriage return.
All labels must be enclosed in quotation marks. For example, the following line is from a delimited text file:

"Stolper","Boston",1400,1300,2800
Use File - Open to bring data in a delimited text file into a 1-2-3 sheet. 1-2-3 separates the data into columns in the 
sheet according to the delimiters.



destination range 
The range in a workbook that receives data from:

• Another range, when you use Edit - Paste or Edit - Paste Special.
• Another application, when you use Edit - Paste Link or Edit - Paste Special.



drag
To press the mouse button and hold it while moving the mouse.



edit line
The line below the menu in the 1-2-3 window.

Item Function

Selection indicator Shows the address or name of the current
selection.

Navigator Lets you go to and select a named range.

@Function selector Lets you insert an @function in a cell.

Cancel and Confirm
buttons

Cancel or confirm an entry. These buttons
appear only when you enter or edit data in
the contents box.

Contents box Displays the entry you are typing or 
editing, or the contents of the current cell.

To hide the edit line, choose Hide Edit Line from the View menu. To redisplay the edit line, choose Show Edit Line 
from the View menu.



empty string
A cell that contains a label-prefix character but no text. The cell looks blank, but 1-2-3 will not return the value ERR 
when you use it as an argument in a text @function, with the exception of the @CHAR and @CODE functions.



ERR
A special value that either 1-2-3 generates to indicate an error in a formula or you generate with @ERR.
ERR can ripple through formulas: any formula that refers to a cell that contains ERR results in ERR, and any other 
formula that depends on that formula also results in ERR. When you correct the formula that contains ERR, the 
results of dependent formulas also become correct.
The label ERR is not equivalent to the value ERR.



extension
At the end of a file name, typically a . (period) followed by three characters. The characters allowed and the maximum
length of the extension depends on the operating system you are using. 
An extension usually indicates the file type. For example, a file with the extension .TXT is a text file. Sometimes, 
different file types use the same extension. For example, when you save a new workbook in 1-2-3 Release 9, 1-2-3 
97, and 1-2-3 for OS/2 Warp 4, each file has the same extension (.123).
When you save a new 1-2-3 workbook file, 1-2-3 automatically adds the extension .123. You can override this 
extension by specifying a different extension when you save the workbook. 
To change the default file type that 1-2-3 uses when you save a new file, use File - User Setup - 1-2-3 Preferences 
(New Workbook Defaults tab).



external database table
A table in an external database that contains a group of related information. External databases are stored in files that
are not 1-2-3 files, such as Notes, Oracle, SQL Server, Paradox, dBASE IV, Informix, ODBC, and text files.



field name
A label in the first row of a database or query table that identifies the contents of a field. For example, an employee 
database may contain the field names First Name, Last Name, and Employee Number.
In database @functions, the argument field can be one of the following:

• The field name enclosed in " " (quotation marks)
• An offset number that indicates the position of the field (column) in the database table
• The address of a cell that contains a field name in quotation marks, or an offset number



field
A labeled column in a database or query table that contains the same kind of information for each record. For 
example, an employee database table may contain fields labeled Name, Department, and Salary.



file reference
A file name and extension, with or without a path, enclosed in << >> (double angle brackets); for example, 
<<SALES.123>>@SUM(A10..B22). Use a file reference in formulas and commands to refer to data in a workbook 
other than the current workbook.



Fixed format
A number format that displays numbers with up to 15 decimal places, a minus sign for negatives, and a leading zero 
for decimal values.



flow of control
The direction in which control passes from one set of macro instructions to another during macro execution. Some 
macro commands that govern the flow of control are {BRANCH}, {DEFINE}, {FOR}, and {RETURN}.



format file
A file in which some releases of 1-2-3 store style information associated with a workbook.

Format file 
type

Release

.FM3 1-2-3 for Windows Releases 1 and 1.1
Wysiwyg in 1-2-3 for DOS Release 3.1 
or later

.FMT Impress in 1-2-3 for DOS Releases 2.3 
and 2.4



formula marker
Shows that a cell contains a formula by displaying a marker in the bottom left corner.



General format
Displays numbers up to 15 decimal places, with a minus sign for negatives, no thousands separators, and no trailing 
zeros to the right of the decimal point.



graphic object
An item, such as a chart, arrow, or shape that you can select, move, size, and style independently of the cells behind 
it. Graphic objects include drawings created with the Create - Drawing commands, text blocks, buttons, charts and 
chart parts, maps and map parts, embedded objects, and pictures brought from another application into 1-2-3.



handle
One of the small boxes that appears on the edge of a selected graphic object, query table, datalink table, or Web 
table. Use handles to size the object.



if-then-else
In a macro, conditional processing that directs the flow of control according to whether a specified condition is true or 
false.



input cell
A cell in which 1-2-3 temporarily stores values while it performs calculations for creating a what-if table.



input range
In database @functions, the argument input is the range that contains the database table(s); input can be the 
address or name of a range that contains the database table(s), or the name of the external database table(s), but it 
cannot be a 3D range.



label-prefix character
The first character in a label entry. It defines the entry as a label and sets the alignment for the cell. 1-2-3 does not 
display the label-prefix character in the cell but does display it in the contents box when you select a cell that contains
a label.
Type a label-prefix character to enter a label that begins with a number or one of these characters:

+  =     - \ #
< $  ( / @

Label-prefix character Effect
' (apostrophe) Left-aligns labels (default)
" (quotation mark) Right-aligns labels
^ (caret) Centers labels
\ (backslash) Repeats one or more 

characters across a cell

Use the Alignment tab in the InfoBox to change alignment.



Label format
Displays new entries as labels by automatically adding a label-prefix character that corresponds to the default 
alignment set with Sheet - Sheet Properties. Displays existing numbers with no thousands separators and a minus 
sign for negatives.



label
Any cell entry that begins with a letter or label-prefix character.
When you complete a cell entry that starts with a letter, 1-2-3 automatically inserts the default label-prefix character 
(an apostrophe) at the beginning of the entry. 1-2-3 does not display the label-prefix character in the cell, but does 
display it in the contents box when you select a cell that contains a label.



LICS (Lotus International Character Set)
The 256 codes (0 through 255) that Symphony®, 1-2-3 for DOS Release 2, and 1-2-3 for OS/2 Release 2 use to 
display, store, and print characters. LICS codes 32 through 127 are equivalent to ASCII and LMBCS codes 32 
through 127.



link
A connection between two applications or two 1-2-3 workbook files that lets the applications or workbooks share data.
You can use Object Linking and Embedding (OLE) and Dynamic Data Exchange (DDE) to create links between 1-2-3
and other applications.
To create a link between 1-2-3 workbook files, use file references in formulas or Edit - Paste Link.



LMBCS (Lotus Multibyte Character Set)
The character set that 1-2-3 uses to store characters. It includes all the characters contained in LICS, ASCII, and 
most other international character sets. If the operating system cannot represent a LMBCS character, a substitute 
character appears.



locked sheet
A sheet that was locked using Sheet - Sheet Properties (Basics tab). Locking a sheet prevents changes to contents of
protected cells.



locked workbook
A workbook file that was locked using File - Workbook Properties (Security tab). Locking a workbook prevents 
changes to protected cell contents, styles, sheet and range names, versions, charts, maps, drawings, embedded 
objects (including Approach query tables), DQA query tables, datalink tables, and Web tables. It also prevents 
changes to protection and workbook reservation settings.



logical formula
A formula that evaluates a condition as true or false by using a logical operator or a logical @function. The result of a 
logical formula is 1 for true or 0 for false.
For example, the formula +A2>8 returns 1 (true) when the value in A2 is greater than 8; it returns 0 (false) when the 
value in A2 is 8 or less.



long label
A label that exceeds the column width. If the cell to the right is blank, a long label extends into the next column. If the 
cell to the right is not blank, 1-2-3 displays as much of the label as possible.
1-2-3 stores the entire label in the cell. To see the entire label, widen the column, double-click the cell, or move the 
cell pointer to the cell and look at the label in the contents box.



loop
A set of macro instructions that executes repeatedly. You can use the macro commands {FOR} and {BRANCH} to 
create a loop in a macro.



panes
A display of two or four parts of a sheet in the same window. Use View - Split to divide a window into panes and to 
synchronize or unsynchronize scrolling in the panes. Use View - Clear Split to clear panes.



1-2-3 workbook object
A 1-2-3 workbook that is embedded in another application file, such as a Word Pro document.
To edit a 1-2-3 workbook object embedded in another application file, double-click the object.



map legend
Explains the meaning of the colors and patterns in a map. Values used as legend labels either exactly match values 
in the range of map data, or they represent the upper limit of the values contained in the bin. Use Map - Color Bins or 
Map - Pattern Bins to change the labels, the colors and patterns, and the values used to create bins.



pin character
A symbol, such as , or label, such as "World Headquarters" that you can add to your map just as you might write 
annotations or stick pins on a paper map.
To create a pin character, enter the following in the range of map data:

• A symbol or label
• The latitude and longitude to locate the pin character in the map

Tip To find the latitude and longitude, right-click the spot on the map.
• (Optional) the color of the pin character



sheet tab

The tab appears above the sheet. Initially, workbooks have a single tab with the letter A for the first sheet. To insert 
additional sheets, use Create - Sheet or click the New Sheet button.
To enter a sheet name, double-click the tab, type the name, and press ENTER. To turn sheet tabs on and off, choose 
Set View Preferences (View tab) from the View menu. 



mouse pointer
The symbol that indicates the location of the mouse on the screen as you move around the sheet. The pointer is 
usually shaped like an arrow, but can change depending on the task. For example, when you change the size of a 
window, the pointer becomes a black two-headed arrow. A sampling of pointers is shown below.

      Standard pointer

      Drag and drop

      Change the width of a column or margin

      Change the height of a row or margin

      Change the height and width of an object

      Select a range

      Edit text

      Drag and fill

      Fast format



nested subroutine
In a macro, a subroutine that is called from within another subroutine. If 1-2-3 encounters a subroutine call while 
executing a subroutine, it transfers control to the subroutine specified in the subroutine call, performs the instructions 
there, returns to the first subroutine, finishes the instructions there, and finally returns to the main macro.



record
A one-row collection of information about one item in a database table. The first row of a database table contains field
names, which identify the data in records; all other rows contain records.



operator
A symbol in a formula that indicates the relationship between two values or the type of operation to be performed. 1-
2-3 uses arithmetic, logical, and text operators.

Arithmetic operators
+ addition
* multiplication
^ exponentiation
- subtraction
/ division

Logical operators
= equal to
< less than
> greater than
<> not equal to
<= less than or equal to
>= greater than or equal 

to
#AN
D#

AND

#NO
T#

NOT

#OR
#

OR

Text operator
& ampersand



text block
A graphic object, shaped as a rectangle or square, that contains text. Text blocks, like other graphic objects, can be 
moved, copied, and sized. You can also edit, align, and change the font of the text in a text block.
Choose Create - Text to create a text block. Select the text block and use Drawing - Drawing Properties to change the
appearance of a text block.



text formula
A formula that uses text in quotation marks and the text operator & (ampersand) in its calculations. For example, the 
formula +"Ms."&" Smith" combines the two words and a space between them to display the label Ms. Smith (be sure 
to include a space inside one of the pairs of quotation marks).



value
An entry that is a number, a formula, or an @function. 1-2-3 changes the mode to Value if you begin an entry with a 
number or one of the following symbols:

+          =          -          @          0          (          #          $ (or current currency symbol)



point size
In reference to fonts, a point is a unit of measurement that determines the height of a character. A point is 
approximately 1/72 of an inch.



scroll bar

The bar that appears at the right or bottom of a window or list box when the contents exceed the size of the window 
or list box. To scroll within a window or list box, click the scroll arrows or drag the scroll box. To turn the scroll bars in 
Workbook windows on and off, use View - Set View Preferences.



server
During linking or embedding, the application that provides data to, or receives instructions from, another application 
(the container). For example, when you link to 1-2-3 data from a Word Pro document, 1-2-3 is a server application.
1-2-3 supports OLE as both a container application and a server application. 



text file
A file on disk in ASCII format. Use File - Save As and specify the file type “Text (TXT)” to create a text file in 1-2-3. 
Use File - Open to read data from a text file into 1-2-3.



relative reference
In a formula, a reference to a cell or a range that changes when you copy the formula. A relative reference refers to 
the location of the data in relation to the formula. A relative reference can be an address or range name.
For example, if the formula +A1+A2 is in cell A4 and you copy this formula to B4, the formula changes to +B1+B2. A1 
and A2 are relative references, which means that they refer to the values entered in cells two and three rows above 
the formula. After you copy the formula, the relative references still refer to the cells two and three rows above the 
formula.
If you do not want a cell or range address to change when you copy a formula, use an absolute reference.



query table
A Lotus Approach object embedded in a 1-2-3 workbook. A query table contains a copy of the records from a source 
database table in either 1-2-3 or an external table, and is linked to the source database.
You create a query table in 1-2-3 to work with records from a database table. Once you create a query table in 1-2-3, 
you can manipulate records from the source database table. You can also send the results to an output range in 1-2-3
where you can format the data for printing, and use the data in calculations or to create charts and maps.



OLE (Object Linking and Embedding)
A method for linking data between applications or embedding data (called objects) created with one application into 
files created with another application. 
A link is a connection between two applications that lets the applications share data.
An embedded object is an object created in one application but stored in a file in another application (the container 
application). The embedded object becomes part of the file in which it is embedded and is not linked to another file.
Use Edit - Paste Link, Edit - Paste Special, or Create - Object to create a link or embed an object in a 1-2-3 
workbook.



sheet letter

The letter in the top left corner of the sheet that identifies each sheet in a workbook.
A 1-2-3 workbook can contain up to 256 sheets, with letters from A (for the first sheet) through IV (for the 256th 
sheet). In the cell address, the sheet letter is followed by a colon (A:) to distinguish it from the column letter (A).
To select all the cells in a sheet, click the sheet letter.



wildcard character
The * (asterisk) or the ? (question mark) used in file names, criteria, and @functions.

* Represents any number of sequential characters
? Represents a single character

In file names, for example, *.123 lists all files with a .123 extension; *.wk? lists all files with extensions that begin 
with .wk, such as .WK4, .WK1, and .WK3. In criteria, B* matches all entries that begin with B. The criteria B??? 
matches all entries that begin with B and contain three other characters.



sort
To arrange data in a range in a particular order, determined by the contents of one or more columns or fields. Use 
Range - Sort to sort data in ascending (A through Z, 0 through 9) or descending (Z through A, 9 through 0) order.
To change the sort order, use File - User Setup - 1-2-3 Preferences (General tab).



macro
A set of instructions, called macro commands, that automate a 1-2-3 task. You can use a macro to enter data or to 
perform a series of 1-2-3 commands to style sheets or workbooks, guide users through specific applications, 
calculate complex formulas with variable data, extract records from a database table, and so on.



path
The drive, directory, and subdirectories in which you save and open a file. In C:\1996\BUDGET.123, the path for the 
file BUDGET.123 is C:\1996. A backslash (\) must separate the path and the file name.



Scientific format
Displays numbers in scientific (exponential) notation, with up to 15 decimal places and an exponent of up to 3 digits. 
For example, the number 123 displays as 1.23E+002 in Scientific format.



tilde (~)
The keyboard character that represents ENTER in macros.



nonblank cell
A cell that contains a label-prefix character, letters, numbers, or spaces. A nonblank cell can appear to be blank if it 
has only a label-prefix character or spaces in it.



time number
A decimal from 0.000000 through 0.999988 that 1-2-3 assigns in sequence to each moment in the 24 hours from 
midnight through 11:59:59 PM.
If you enter a value that looks like a time, for example 05:57 PM or 17:57:00, 1-2-3 enters the time as you typed it in 
the cell; the corresponding time number is stored in the cell.
Use a time @function to enter a time number in a sheet. You can display a time number in a variety of time formats.



map data bin
A group of values in a set of map data. When the map data contains more than 6 values, 1-2-3 groups the values in 6
bins and displays each bin as a color in the map. If you have two sets of map data, 1-2-3 creates pattern bins as well 
as color bins.
In this map, 1-2-3 groups the sales data for 15 countries into 6 bins.

The legend labels indicate the upper limit of data in that bin. For example, each country that falls into the red bin has 
sales less than or equal to 4,200.



3D range
A range that spans two or more contiguous sheets and includes the same cells in those sheets. 

To select a 3D range, select the range in the first sheet you want to include; then, hold down SHIFT and click the tab 
of the last sheet you want to include.



undefined range name
A range name that is not assigned to a range. Formulas that contain undefined range names evaluate to ERR.



range
A single cell, a rectangular block of adjoining cells, an entire sheet, or an entire workbook. A range is represented as 
the addresses of its top left and bottom right cells, separated by two periods, for example, A:B2..A:C3.

A 3D range spans two or more contiguous sheets; for example, A:B1..B:B5.



version
Versions are sets of different data for the same named range. Each version has a name. 1-2-3 keeps track of the 
date and time the version was created or modified, and the name of the person who created or modified it. You can 
also assign styles to a version and attach a descriptive comment.



subroutine
A discrete set of macro instructions that runs from within the macro. When the main macro calls the subroutine, 
control passes to the subroutine. After 1-2-3 completes the instructions in the subroutine, control returns to the main 
macro.



number format
The way 1-2-3 displays numbers on the screen. A number may look different from the actual value entered in the cell,
depending on the number format. For example, the entry 25.451 may appear as $25.45, 2545%, or 25.5.



NA
A special value that either 1-2-3 or you generate to indicate that a value needed to complete a formula is not 
available. @NA returns the value NA.
NA can ripple through formulas: when formulas result in NA, other formulas that depend on them also result in NA. 
This ripple-through effect also means that when you provide the previously unavailable value to a formula that 
contains NA, the results of the dependent formulas also become correct.
The label NA is not equivalent to the value NA.



sheet frame
The border on the left and top of the sheet that contains the sheet letter, row numbers, and column letters.

Click the sheet letter, column letter, or row number to select the entire sheet, column, or row.
Use View - Set View Preferences (View tab) to hide or show the sheet frame.



scrolling
Moving horizontally or vertically through a sheet or a list box, or moving the cell pointer from one sheet to another. To 
scroll within a sheet or list box, click the scroll arrows, drag the scroll box, or use the pointer-movement keys. When 
you scroll within a sheet, the view of the current sheet moves, not the cell pointer.



range name
A name that identifies a range and that can be used in commands and formulas instead of the range address. The 
formula @AVG(GRADES) is easier to understand than @AVG(C4..C29) because the range name GRADES tells you 
what kind of values the range contains.
You can name a range by selecting the range and choosing Range - Name. Click the navigator to see a list of range 
names in the current workbook. When the range is selected in the workbook, the range name appears in the 
selection indicator.



Time format
The way 1-2-3 displays a time number. To apply a time format to a number in a range or chart, use the Number 
Format tab in the InfoBox.
You can also use the status bar to apply a time format to a range.
1-2-3 automatically formats data as a time if you enter it using a format 1-2-3 recognizes. 1-2-3 automatically 
recognizes data entered as 05:57:00 PM, 05:57 PM, 17:57:00, or 17:57, as well as data entered in any format you 
promote to the Frequently Used list.



printer driver
A software program that controls how 1-2-3 communicates with your printer. 1-2-3 uses the printer drivers supplied by
the operating system.



yes/no argument
Text that specifies whether to turn a setting on or off. You can use on, true, or yes to turn a setting on; you can use 
off, false, or no to turn a setting off.
Enter the argument as text enclosed in " " (quotation marks), a text formula, or the address or name of a cell that 
contains a label or a formula that results in a label.



macro keyword
The first word in a macro command. The macro keyword tells 1-2-3 what action to perform. For example, in the 
macro {BRANCH TOTALS}, the keyword is BRANCH.



recalculation
Re-evaluation of formulas in active workbooks using the current cell values.



Percent format
Displays numbers as percentages (the number multiplied by 100) with a percent sign and up to 15 decimal places.



pointer-movement keys
Keys that control the movement of the cell pointer, menu pointer, and insertion point. These keys include , ¯, ®, ¬, 
PG UP, PG DN, and HOME, and can be combined with CTRL and END to move around sheets in the same workbook 
and in other active workbooks.



SmartMaster
Templates for business and financial tasks. Each SmartMaster contains sample data and instructions that show you 
how the template works. Enter your own data and use the built-in SmartMaster charting and printing features for 
quick results.
You can create your own SmartMaster templates by saving a workbook as a .12M file.



map code
Text that 1-2-3 recognizes as a geographic region in a map, such as a state, province, or country. Depending on the 
map type, map codes can be full names or abbreviations. 
1-2-3 uses predefined map codes to associate each row of data with a single geographic region in the map. In the 
Region Check dialog box, you can link custom map codes to codes that 1-2-3 recognizes.



named style
Styles, copied from a single cell, that you can apply to other ranges in a sheet. A named style can include number 
format, font, point size, underlining, bold, italics, borders, colors, pattern, and alignment.
Use Range - Range Properties (Named Style tab) to create a named style.



range address
The location of a range in a workbook. A range address consists of the addresses of the top left and bottom right 
cells, separated by two periods; for example, A:B2..A:C3.



map overlay
Another map added to an existing map to increase the geographic area displayed. For example, you can add the 
world map overlay to a map of Europe. You cannot link sheet data to an overlay. 



pattern
A style, such as cross-hatched lines, that you can use to distinguish a range, drawing, map region, or data series in a 
bar, area, mixed, doughnut, or pie chart. You can also apply a color to a pattern. After selecting a range, drawing, 
map, or chart, use the Lines & Colors tab in the InfoBox to apply a pattern and pattern color.



SmartIcons

Buttons (icons) in the 1-2-3 window that you click to perform commands.
Choose File - User Setup - SmartIcons Setup to change a set of SmartIcons or to create custom SmartIcons that run 
your scripts or macros.
Choose View - Hide SmartIcons or View - Show SmartIcons to hide or show the SmartIcons.



named print styles
Print options, such as margins, headers, and footers, that you name and save with File - Preview & Page Setup 
(Named Style tab). When you save print styles, you can use them again.
Named print styles are stored in the workbook file. You can copy print styles among active workbooks.



mixed reference
In a formula, a reference to a cell in which parts of the referenced address are absolute and parts are relative. 
Absolute references in a formula refer to the same cells no matter where you copy or move the formula. To make a 
reference absolute, precede it with a $ (dollar sign). Relative references in a formula adjust relative to their new 
location when you copy or move the formula.
For example, the formula +A:$C4 contains a mixed reference. The column letter (C) is an absolute reference and is 
preceded by a $. The sheet letter (A) and the row number (4) are relative references. If you copy the formula, the 
column letter stays the same while the sheet letter and row number adjust relative to their new location.



Formula format
Displays formulas written out, rather than as their computed values.



offset number
The number that corresponds to the position of a specified row, column, sheet, character, list item, or byte; used in 
some @functions and macros. The first offset number is 0, the second 1, the third 2, and so on.
In a database @function, the field argument can be the offset number for a field in the database table. For example, if
the field SALES is in the fifth column of the database table, the offset number for that field is 4.



text argument
In a macro command or @function, text enclosed in " " (quotation marks), a text formula, or the address or name of a 
cell that contains a label or a formula that results in a label.
Note In @functions that use text arguments for dates, you should always specify a 4-digit year to make sure you get 
the results you want -- for example, "12/31/2005." If you specify a 2-digit year, 1-2-3 uses the date setting in the 1-2-3
Preferences dialog box to determine whether the year refers to the 20th or the 21st century. 



radian
The unit 1-2-3 uses to measure an angle, equal to approximately 57 degrees, 17 minutes. Used in mathematical 
@functions such as @TAN and @COS.



styles
Enhancements applied to the current selection. Styles include bold, italics, underlining, frames, border or line width 
and style, colors, patterns, alignment, font, point size, and number formats. You can use the InfoBox or the status bar 
to apply a wide range of styles.



version group
A named group of one or more versions. Each version in a version group must be associated with a different named 
range.
In previous releases of 1-2-3, version groups were called scenarios.



numeric formula
A formula that calculates numeric values using one or more of the arithmetic operators:

+          -          *          /          ^
For example, the numeric formula +H16*2 multiplies the value in cell H16 by 2.



NotesFlow form
A form designed in Lotus Notes that can contain an embedded object such as a 1-2-3 workbook.



password
A password can contain up to 15 uppercase and lowercase characters. 1-2-3 passwords are case-sensitive, so you 
must remember the exact combination of uppercase and lowercase characters you use when you create the 
password.



argument placeholder
Words that indicate the arguments needed to fill in an @function or macro command. To use the @function or macro 
command, you must replace the placeholder with the actual argument.
For example, in the @function @MIN(list), list is inserted in the @function by 1-2-3. You replace list with the name or 
address of the range for which you want to find the minimum value.



workflow application
An application that reflects and facilitates how people work together as a group. Workflow applications can automate 
and streamline the process of performing routine tasks.



flow control window
The window that appears when you open a routed workbook. The flow control window's title bar says TeamMail or 
TeamReview, depending on whether a workbook or a range was sent.
The flow control window stays open while you work in 1-2-3 and lets you control the flow of the routed workbook; for 
example, returning the workbook to the originator or sending it to the next person on the route list.



day-count basis
A convention for counting the number of days in a month and a year. Some calendar and financial @functions offer a 
choice of the following bases in order to simplify calculations:

Day-count basis 1-2-3 counts
actual/actual The actual number of days in a month 

and in the year
30/360 30 days in every month, and 360 days 

in the year, calculated according to the
standards of the U.S. securities 
industry

European 30/360 30 days in every month, and 360 days 
in the year

actual/360 The actual number of days in every 
month, and 360 days in the year

actual/365 The actual number of days in every 
month, and 365 days in the year



To move, collapse, or close the InfoBox



workbook
A 1-2-3 file, with one of the following file extensions: .123, .WK1, .WK3, .WK4. SmartMaster templates (.12M 
and .WT4) are also workbooks.
A workbook can be embedded as a 1-2-3 workbook object in another application that uses OLE.



DQA query table
A table created with the Data Query Add-In (DQA) that contains a copy of the records from a source database table in
either 1-2-3 or an external table. A DQA query table is linked to the source database. 
You create a DQA query table in 1-2-3 to work with records from a database table. Once you create a query table in 
1-2-3, you can manipulate records from the source database table. You can analyze, organize, and print data, create 
charts and maps from the data, and use the data in calculations.
The Data Query Add-In is a special file that provides data query functionality similar to that in 1-2-3 Release 5. To 
load the Data Query Add-In, choose File - Add-Ins - Manage Add-Ins. After DQA is loaded, the Query command 
appears on the main menu. 
You can also use macro commands to create and work with DQA query tables.



ALT tag
An HTML tag that allows you to specify an alternate string of text if the image cannot be displayed by the browser. 
This tag is an attribute for the IMG tag that inserts an image into a Web page. 



anchor cell
The top left or bottom right cell of a named range used by a Web table, a query table, or a datalink table.



container application
An application that supports OLE technology so that you can embed or link to objects in the application's files. For 
example, if you use Freelance Graphics to create a logo and then embed the logo in a 1-2-3 workbook, 1-2-3 is a 
container application.
1-2-3 supports OLE as both a container application and a server application. 



datalink table
Data stored in the sheet and linked through OLE to a different server application. 1-2-3 creates a datalink table when 
the server application provides data in Text, .WK3, or .WK1 format. A datalink table can include text and numbers. 



DDE (Dynamic Data Exchange)
A protocol used to share data between applications. 
You can use DDE to create links between two files created in applications that support DDE. The server (source) file 
contains the original data, and the client (destination) file contains the linked data.
To update DDE links, both applications must be active. 



embedded object
Data or a graphic object that is created by one application (the server) but stored in another application's file (the 
container). Once embedded, the object becomes part of the file in which it is stored and is not linked to data outside 
of that file. 
You can copy, move, delete, and edit embedded objects.



firewall
A collection of hardware and software components that filters incoming and outgoing network traffic to create a 
secure environment.



FTP (File Transfer Protocol)
A protocol used to transfer files from one computer to another. FTP also refers to the actual application that moves 
files using the FTP protocol.
1-2-3 can open and save files on FTP servers.



SQL command
A command in the Structured Query Language (SQL) that sends instructions to an external database table that 
understands SQL.



crosstab
A table that cross-tabulates the information in two fields in a database table. 
For example, the crosstab table below uses data from a database table that contains orders for dictionaries. The 
crosstab table summarizes the total number of orders for each dictionary format, by each type of customer.



HTML (Hypertext Markup Language)
The language used to write and format Web pages. HTML is a subset of the International Organization of Standards 
(ISO) Standard Generalized Markup Language (SGML).
1-2-3 can open files written and saved in HTML format.



HTML table
A structure defined using the Hypertext Markup Language (HTML) that contains rows, columns, and cells. HTML 
tables support a limited amount of formatting.
You can save a range as an HTML table using File - Internet - Convert to Web Pages.



HTML tag
An HTML (Hypertext Markup Language) tag is a markup tag with coded instructions that define the structure of an 
HTML document. All HTML tags are enclosed in <> (angle brackets). A typical HTML tag looks like this: 
</table> 
text
</table>
When opening an HTML file, 1-2-3 looks for two HTML tags, <table> and <pre>:

• The <table> tag marks the beginning and end of a table. 
• The <pre> tag preserves the formatting and spacing of text as typed in the source code, and displays the text in a

monospace font, different from the standard browser text.



HTTP (Hypertext Transfer Protocol)
A protocol used to transfer files from one computer to another. A Web server is also known as an HTTP server. 
1-2-3 can open files on HTTP (Web) servers.



hyperlink
A cross-reference or connection to information in a different location. You can use hyperlinks to jump to a Web site on
the Internet, to other files, and to ranges and objects in the current workbook.
To attach a hyperlink to a cell, button, or picture, use Create - Hyperlink.



insertion point
The vertical line that indicates where the next character you enter will appear.



Internet
A group of networks that are connected to one another and span the world. The Internet gives users access to 
services such as e-mail, file transfer, and the World Wide Web.



intranet
A computer network with restricted access that resides behind a firewall, with no connection to the Internet or a proxy 
server. Companies use intranets to share information internally that they do not want made available to non-
employees.



Net-It print driver
When you convert ranges, sheets, or workbooks to the jDoc format, 1-2-3 uses the current print settings to "print" to 
the Net-It print driver. (This print driver is installed with 1-2-3 unless you choose not to install it.)



Preview window
A window that shows how the selected data will look when printed. 
When you open the Preview window using File - Preview & Page Setup, 1-2-3 displays the current workbook in a 
window on the left and the Preview window on the right. 1-2-3 also opens the InfoBox so you can change print and 
page settings and view the results immediately.



proxy server
A server that sits between a client application, such as a Web browser, and a host server. A proxy server intercepts all
requests to the host server to see if it can fulfill the requests itself. If not, it forwards the request to the host server. 
Proxy servers are used primarily to save time and to verify and authorize access.



Script
A sequence of one or more LotusScript statements. A script can be a complete application or part of an application.



Script Debugger
A window in which you can set, clear, disable, and enable breakpoints and step through scripts to locate the source of
problems that may occur while a script is running.



Script Editor
A window in which you can write and edit scripts, check script syntax, and set breakpoints for debugging scripts. The 
Script Editor initially displays a script associated with the selected object.



SmartFill list
A sequence of data that can be used to fill a range or name a series of sheets.
1-2-3 comes with predefined SmartFill lists such as months and days of the week. For example, when you select a 
cell that contains the word January and then use drag and fill, 1-2-3 automatically enters February, March, and so on.
To create and manage your own SmartFill lists, choose File - User Setup - SmartFill Setup.



SmartLabel
Text that is associated with a formula. When you type a SmartLabel in a cell, 1-2-3 applies the formula to a range. 
1-2-3 comes with predefined SmartLabels that let you perform different calculations. For example, you can type the 
word Total in a cell to calculate the sum for a list of values. You can use other predefined SmartLabels such as 
Average, Median, and Standard Deviation.
Choose File - User Setup - SmartLabels Setup to create new SmartLabels using the formula you want. You can also 
specify synonyms for SmartLabels and assign a particular number format to the result. 



URL (Uniform Resource Locator)
The address of a Web site -- for example, www.lotus.com.



Web table
A table of data that you import from a specified Web address into 1-2-3. A Web table contains a copy of the data from 
the Web page and stays linked to the source location.
Once you create a Web table, you can choose when to refresh the data in the table and set other options that control 
the size and appearance of the Web table.



Web browser
A tool or software program that lets you access information on the World Wide Web. Personal Web Navigator, 
Netscape Navigator, and Internet Explorer are Web browsers.



jDoc format
A high-fidelity representation of a selected range, sheet, or workbook that retains its original formatting. A range, 
sheet, or workbook converted to the jDoc (print snapshot) format looks identical to what your printed output would 
look like.



Web page
A document that you view in a Web browser. Although you might need to scroll through a Web page to see its entire 
contents, or print the Web page out on more than one piece of paper, a Web page is a single online page. 
A Web site comprises one or more Web pages.



World Wide Web
A hypertext-based system for finding and accessing Internet resources. Also referred to as WWW and the Web. 
To access the Web, you use a Web browser which lets you read documents (Web pages) stored on the Web. Web 
pages generally contain hypertext links to information on other Web servers.



detail row or detail column
Contains entries subordinate to a higher level summary row or column -- for example, monthly figures subordinate to 
a yearly total.



format line
Indicates how you want to parse the long labels in a selected range. The format line can contain the following 
symbols:

Symbol Description
L Represents the beginning of a label block.
V Represents the beginning of a value block.
D Represents the beginning of a date block.
T Represents the beginning of a time block.
S 1-2-3 does not parse the data block below the S; to 

enter this symbol, edit the format line.
> Represents any character in a data block after the 

first character.
* Represents a blank space that can become part of 

a data block if the block requires extra characters.
| The vertical bar label-prefix character appears at 

the beginning of the format line in the contents box 
after you parse the data.



backup file
A copy of a file on disk. When you create a backup file, 1-2-3 assigns the extension .BAK to the existing file on disk 
and saves the file in memory with the specified file extension (for example .123 or .WK4). If an associated format file 
(.FM3) exists, 1-2-3 assigns the extension .FMB to the existing file on disk.
Note You cannot create a backup file for a dBASE (.DBF) or Paradox (.DB) file.



InfoBox
A window that shows the selected object's current properties, such as colors, text attributes, and other settings. If you
select a different object, the settings in the InfoBox change to reflect the properties of the new selection. 
You use the InfoBox to change the properties of an object or any of its parts; for example, an entire sheet, or a range 
in the sheet.
The selected object reflects the changes immediately. You can make many changes to one object or several objects 
without closing the InfoBox. To undo the most recent change, choose Undo from the Edit menu.



in-place editing
Editing an embedded object without leaving the application in which it is embedded. Rather, the menu changes to 
show commands from the server application. 



navigator

Click the navigator to see the list of named ranges in the current workbook. Use the navigator when you want to go to
and select a named range, enter a range name in a formula, or specify a range name in a dialog box.



outline frame
Shows the structure of demoted rows and columns in a sheet, and contains buttons for collapsing and expanding the 
outline.



out-of-place editing
Editing an embedded object by opening the server application. 



range selector

You can select a range from within a dialog box or the InfoBox by clicking the range selector button. When you click 
the button, 1-2-3 hides the dialog box or the InfoBox so that you can select the range. After you select the range, the 
dialog box or InfoBox reappears, with the range address entered.



To select an entire column or row
Click the column letter or row number.
To include consecutive columns or rows in the selection, hold down SHIFT and click the column letters or row 
numbers.
To include non-consecutive columns or rows, hold down CTRL and click the column letters or row numbers.



To select a graphic object
To select a button, hold down SHIFT and click the button.
To select all other types of graphic objects, click the object. 
To select multiple objects, hold down SHIFT and click each object.



To select a range
Click a cell in one corner of the range, and drag to highlight the rest of the range.



To select a range or collection
To select a range, click a cell in one corner of the range, and drag to highlight the rest of the range.

To select a collection, select the first range, then hold down CTRL and select the other ranges.



To select a range, collection, column, or row 
To select a range, click a cell in one corner of the range, and drag to highlight the rest of the range.
To select a collection, select the first range, then hold down CTRL and select the other ranges.
To select an entire column or row, click the column letter or row number.



To select a range or graphic object 
To select a range, click a cell in one corner of the range, and drag to highlight the rest of the range.
To select a button, hold down SHIFT and click the button. To select all other types of graphic objects, click the object.
To select more than one range or graphic object, hold down CTRL while selecting the additional ranges or objects.
Note You can't select a mixture of ranges and objects.



To select a sheet tab
To select the tab of Do this
The current sheet Click the tab.
A range of contiguous 
sheets

Make the first sheet in the range 
the current sheet, click the tab, 
then press SHIFT and click the tab 
of the last sheet in the range.

A collection of sheets Make the first sheet in the 
collection the current sheet, click 
the tab, then press CTRL and click 
the tab of each sheet in the 
collection.



To select text
Select the cell or range that contains the text.
Click the text block, map title, map legend, chart title, legend label, or axis label. SHIFT+click a button.



summary row or summary column
Contains high-level entries that summarize lower level entries -- for example, the yearly total for a range of monthly 
figures, or a section title in a sheet with several subsections.



Basic properties for datalink tables

Use the Basics tab to rename the selected datalink table and view information about it. You can also turn the table 
border on or off. 

Choose a task
Naming a graphic object 
Hiding and showing datalink table borders 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_123_WORKING_WITH_DATALINK_T
ABLES_OVER',0)} See related topics



Range properties for datalink tables

Use the Range tab to change the size of a datalink table and its location in the sheet.

Choose a task
Sizing a datalink table    

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_123_WORKING_WITH_DATALINK_T
ABLES_OVER',0)} See related topics



Basic properties for Web tables

Use the Basics tab to rename a Web table, edit the Web site address, and change the display properties.

Choose a task
Changing a Web table name and source URL

{button ,AL(`H_USING_THE_INFOBOX_STEPS;H_THE_INFOBOX_OVER',0)} See related topics



Range properties for Web tables

Use the Range tab to change the size of a Web table and its location in the sheet.

Choose a task
Sizing a Web table
Moving a Web table

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS',0)} See related topics



Refresh properties for Web tables

Use the Refresh tab to set options for updating the data in a Web table.

Choose a task
Selecting refresh options for a Web table 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS',0)} See related topics



Details: Changing group or collection properties
When the selected objects are the same type
If the objects in the group or collection are all the same object type -- for example, all rectangles -- the InfoBox 
displays options for changing the properties of the selected object type. 
For example, if you select a collection that consists of two rectangles, the InfoBox displays the Lines & Colors tab and
the Basics tab. 

When the selected objects are different types
If the objects in the group or collection are different types, the InfoBox displays options for changing the properties of 
all the selected object types. 
For example, if you select a set of grouped objects that consists of a rectangle and a text block, the InfoBox displays 
the Text Format, Alignment, Lines & Colors, and Basics tabs. When you change a property, 1-2-3 changes only those 
objects in the selection that have that property.

{button ,AL(`H_CHANGING_GROUP_OR_COLLECTION_PROPERTIES_STEPS',1)} Go to procedure



Changing group or collection properties
1. Select the group or collection you want to change.
2. Right-click the selection, and then choose the Properties command.

3. Click the tabs in the InfoBox to find the properties you want to change.
4. Change one or more properties.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_GROUP_OR_COLLECTION_PROPERTIES_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_CHANGING_GRAPHICS_BORDERS_STEPS;H_

CHANGING_INTERIOR_COLOR_AND_PATTERN_STEPS;H_CHANGING_LINE_STYLES_STEPS;H_CHANGIN
G_TEXT_FORMAT_STEPS;H_FASTENING_GRAPHICS_STEPS;H_HIDING_OR_REDISPLAYING_GRAPHICS_
STEPS;H_LOCKING_OR_UNLOCKING_GRAPHICS_STEPS;H_ROTATING_GRAPHICS_STEPS;H_ROTATING
_DATA_STEPS;H_THE_INFOBOX_OVER;H_USING_DESIGNER_FRAMES_STEPS;H_STYLING_GRAPHICS_
OVER;H_USING_THE_INFOBOX_STEPS',0)} See related topics



Basic properties for arcs

Use the Basics tab to rename and set options for fastening, hiding, locking, and rotating the selected arc. 

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Rotating graphic objects 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for buttons

Use the Basics tab to rename the selected button and change its text. You can also set options for fastening, hiding, 
and locking the button.

Choose a task
Naming a graphic object 
Details: Creating a script button
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for charts

Use the Basics tab to rename and set options for fastening, hiding, and locking the selected chart.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for ellipses

Use the Basics tab to rename and set options for fastening, hiding, locking, and rotating the selected ellipse.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for ellipses, polygons, and map elements

Use the Lines & Colors tab to change the color, pattern, and border of the selected object.

Choose a task
Changing interior color and pattern 
Changing graphic object borders

{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_THE_INFOBOX_OVER;H_USING_THE_
INFOBOX_STEPS;',0)} See related topics



Basic properties for freehand drawings

Use the Basics tab to rename and set options for fastening, hiding, locking, reshaping, and rotating the selected 
freehand drawing.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Reshaping a polyline, polygon, or freehand drawing 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Number format properties for ranges

Use the Number Format tab to change how 1-2-3 displays values in cells. For easy access, you can also add the 
number formats you use most frequently to the status bar. 

Choose a task
Formatting numbers 
Formatting numbers as currency 
Changing the currency symbol
Adding a number format to the Frequently Used list 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_NUMBER_FORMATS_OVER',0)} See
related topics



Text format properties for graphic objects and ranges

Use the Text Format tab to set the font, point size, attribute(s), and color for text in the selected object or range.

Choose a task
Changing text styles

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for lines and arrows

Use the Basics tab to rename and set options for fastening, hiding, locking, and rotating the selected object.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for lines and arrows

Use the Lines & Colors tab to change the line style, color, and width of the selected object. You can also add or 
remove arrowheads.

Choose a task
Changing line styles 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_CHANGING_BORDERS_LINES_AN
D_COLORS_OVER;',0)} See related topics



Basic properties for map legends

Use the Basics tab to show or hide some or all of the selected legend, and to change the position of the legend in 
relation to the plot area.

Choose a task
Changing map legend position

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Basic properties for map plot areas

Use the Basics tab to change the placement and size of the selected plot area. You can also rotate the plot area, 
zoom in for a closer look or zoom out to see more of the map, and see latitude and longitude readings for the center 
of the plot area.

Choose a task
Changing the plot area of a map 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Basic properties for map titles

Use the Basics tab to show or hide the selected map title, change the placement of the title, and edit the text in the 
title.

Choose a task
Changing a map title

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Basic properties for maps

Use the Basics tab to rename the selected map and tell 1-2-3 when to redraw the map. You can also set options for 
fastening, hiding, and locking the map.

Choose a task
Naming a map 
Redrawing maps 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Color properties for maps

Use the Colors tab to select different colors used for mapped data, to change the bin values associated with each 
color in the selected map, and to change the legend labels. 

Choose a task
Changing bin colors or patterns
Changing bin definitions for colors or patterns
Changing map legend labels

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Overlay properties for maps

Use the Overlays tab to superimpose additional maps on top of the selected map.

Choose a task
Overlaying additional map areas 
Removing an overlay from a map 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Pattern properties for maps

Use the Patterns tab to select different patterns used for mapped data, to change the bin values associated with each
pattern in the selected map, and to change the legend labels. 

Choose a task
Changing bin colors or patterns
Changing bin definitions for colors or patterns
Changing map legend labels

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MODIFYING_MAPS_OVER',0)} See 
related topics



Range properties for maps

Use the Ranges tab to use different data ranges in the selected map, or to add pin characters to the map.

Choose a task
Changing map range assignments 
Adding pin characters to a map 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_MAPS_OVER',0)} See related topics



Basic properties for OLE objects

Use the Basics tab to rename the selected OLE object and view information about it. You can also set options for 
fastening, hiding, and locking the object. 

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for pictures

Use the Basics tab to rename and set options for fastening, hiding, and locking the selected picture.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for polygons

Use the Basics tab to rename and set options for fastening, hiding, locking, reshaping, and rotating the selected 
polygon.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Reshaping a polyline, polygon, or freehand drawing 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Basic properties for polylines

Use the Basics tab to rename and set options for fastening, hiding, locking, reshaping, and rotating the selected 
polyline.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Reshaping a polyline, polygon, or freehand drawing 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for arcs, freehand drawings, and polylines

Use the Lines & Colors tab to change the color, pattern, and line style of the selected object.

Choose a task
Changing interior color and pattern 
Changing line styles

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_CHANGING_BORDERS_LINES_AN
D_COLORS_OVER',0)} See related topics



Header and footer properties

Use the Headers & Footers tab to add headers, footers, and repeating titles on each printed page.

Choose a task
Adding headers and footers 
Printing titles on each page 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_PRINT_AND_PAGE_PROPERTIES_
OVER',0)} See related topics



Include properties for printing

Use the Include tab to change the data selected to print and to update the Preview window when the print selection 
changes.

Choose a task
Changing the print selection 
Updating the Preview window 
Printing graphic objects, charts, tables, and maps 
Printing cell comments and formulas 
Printing sheet grid lines and frames 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Layout properties for printing

Use the Layout tab to specify margins, orientation, and centering, and to size data to the printed page.

Choose a task
Changing print margins 
Changing page orientation 
Centering data on the printed page
Fitting your work on the printed page 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_PRINT_AND_PAGE_PROPERTIES_
OVER',0)} See related topics



Named style properties for printing

Use the Named Style tab to customize print and page settings that you can use when printing.

Choose a task
Creating a named print style 
Applying a named print style 
Redefining a named print style 
Resetting a named print style 
Retrieving a print style from an earlier release of 1-2-3 
Renaming a print style 
Deleting a named print style 
Copying a named print style from another file 

{button ,AL(`H_NS_PRINT_OVER;H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related 
topics



Printer properties

Use the Printer tab to select a paper size and to view the name of the currently selected printer. You can also change 
the selected printer and its properties, as well as select the pages to print and how to number them.

Choose a task
Changing the paper size 
Numbering printed pages 
Selecting a printer 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Text format properties for printing

Use the Text Format tab to set the font, point size, attribute(s), and color for text in headers and footers, cell 
comments, formulas, and scripts.

Choose a task
Changing font properties for headers and footers 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_PRINT_AND_PAGE_PROPERTIES_
OVER',0)} See related topics



Basic properties for query tables

Use the Basics tab to rename and set options for fastening, hiding, and locking the selected query table. 
Note The options for fastening and hiding the query table are available only if the output range is turned off in the 
Output Range tab.

Choose a task when the query table has an output range
Naming a graphic object
Controlling the display of the output range
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_DB_QUERY_TABLES_OVER;H_DB_
WORKING_WITH_A_QUERY_TABLE_STEPS',0)} See related topics



Output range properties for query tables

Use the Output range tab to specify the range where you want 1-2-3 to put the query results.

Choose a task
Controlling the display of the output range

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_DB_QUERY_TABLES_OVER',0)} See
related topics



Alignment properties for ranges

Use the Alignment tab to change the alignment of cell contents in the selected range.

Choose a task
Aligning data in cells 
Spanning text across columns 
Wrapping data in a cell 
Rotating data 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_ALIGNMENT_OVER',0)} See related 
topics



Basic properties for ranges

Use the Basics tab to create a range name, mark a range as a Notes/FX field, and set column and row properties.

Choose a task
Naming a range using the InfoBox
Setting up named ranges to exchange data with Notes 
Sizing columns using the InfoBox 
Sizing rows using the InfoBox 
Hiding columns or rows using the InfoBox 
Displaying hidden columns or rows using the InfoBox 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_PRINT_ADDING_A_PAGE_BREAK_
STEPS',0)} See related topics



Cell comment properties for ranges

Use the Cell Comment tab to annotate cell contents.

Choose a task
Creating a cell comment 
Editing a cell comment 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for ranges

Use the Lines & Colors tab to add or change the color, pattern, border, and frame for the selected range. 

Choose a task
Changing interior color and pattern 
Changing range borders 
Adding designer frames 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_CHANGING_BORDERS_LINES_AN
D_COLORS_OVER',0)} See related topics



Named style properties for ranges

Use the Named Style tab to work with groups of settings which you can use to format cells.

Choose a task
Creating a named style
Applying a named style
Removing a named style from cells
Resetting a cell's styles to a named style
Redefining a named style
Renaming a named style
Deleting a named style
Using style templates

{button ,AL(`H_NAMED_STYLES_OVER;H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See 
related topics



Security properties for ranges

Use the Security tab to hide or protect cell contents in the selected range.

Choose a task
Hiding cell contents 
Leaving part of a workbook or sheet unprotected 
Protecting unprotected ranges in a locked workbook 
Protecting unprotected ranges in a locked sheet 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_LOCKING_SHEET_CONTENTS_STE
PS;H_LOCKING_WORKBOOK_CONTENTS_STEPS',0)} See related topics



Version properties for ranges

Use the Version tab to rename a version, change its comment, and select display, style, and protection properties.

Choose a task
Changing version properties

For a description of the options on this tab, see Options. 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_WORKING_WITH_VERSIONS_OVE
R',0)} See related topics



Basic properties for rectangles

Use the Basics tab to rename and set options for fastening, hiding, locking, and rotating the selected rectangle.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 
Rotating graphic objects

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for rectangular objects

Use the Lines & Colors tab to add or change the color, pattern, border, and frame for the selected object.

Choose a task
Changing interior color and pattern 
Changing graphic object borders
Adding designer frames 

{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_THE_INFOBOX_OVER;H_USING_THE_
INFOBOX_STEPS;',0)} See related topics



Alignment properties for sheets

Use the Alignment tab to change the default alignment of cell contents in the selected sheet(s).

Choose a task
Setting a default alignment for a sheet

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_ALIGNMENT_OVER;',0)} See related 
topics



Basic properties for sheets

Use the Basics tab to change the sheet name and tab color, set the default column and row sizes, hide the selected 
sheet, and protect cell contents in the sheet.

Choose a task
Naming a sheet using the InfoBox 
Changing sheet tab color
Setting a default column width for a sheet 
Setting a default row height for a sheet 
Details: Hiding sheets 
Locking sheet contents 
Unlocking a sheet 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Line and color properties for sheets

Use the Lines & Colors tab to change the color and pattern defaults for all cells in the selected sheet(s). 

Choose a task
Setting default colors and pattern for a sheet 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Number format properties for sheets

Use the Number Format tab to change the default display of values in the selected sheet. 

Choose a task
Setting a default number format for a sheet
Changing the currency symbol

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;H_NUMBER_FORMATS_OVER',0)} See
related topics



Outline properties for sheets

Use the Outline tab to change the settings when you outline sheet data. 

Choose a task
Showing and hiding the outline frame
Specifying how summary data relates to detail data

{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',
0)} See related topics



Text format properties for sheets

Use the Text Format tab to change the default font, point size, attribute(s), and color of cell contents in the selected 
sheet.

Choose a task
Setting a default font for a sheet 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Alignment properties for text blocks

Use the Alignment tab to change the alignment of text in the selected text block.

Choose a task
Aligning data in text blocks
Rotating data

{button ,AL(`H_ALIGNMENT_OVER;H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related 
topics



Basic properties for text blocks

Use the Basics tab to rename and set options for fastening, hiding, and locking the selected text block.

Choose a task
Naming a graphic object 
Fastening graphic objects to cells
Hiding or redisplaying graphic objects 
Locking or unlocking graphic objects 

{button ,AL(`H_THE_INFOBOX_OVER;H_USING_THE_INFOBOX_STEPS;',0)} See related topics



Dialog box keys
Use these keys to move around and select options in the dialog box, and to close the dialog box.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To
, ¯, ®, or ¬ Move within a list, text box, or group of option 

buttons.
ALT+ a letter Select the option or command with the 

underlined letter that you press.
ALT+F4 Close the dialog box without completing the 

command.
CTRL+BREAK Cancel the current 1-2-3 command or 

operation and close the dialog box.
ENTER Complete the command and close the dialog 

box.
ESC Close the dialog box without completing the 

command.
SHIFT+TAB Move backwards to the previous option, from 

bottom to top and right to left.
SPACEBAR Select the option or operate the button that is 

current in a dialog box.
TAB Move forward to the next option, from left to 

right and top to bottom.

Keys to select items in a drop-down box or list box
Press To
a letter Move to the first item that starts with that letter in 

a drop-down box or list box.
ALT+¯
ALT+

Open or close a drop-down box.

HOME
END

Select the first or last item in a drop-down box or 
list box.

PG UP
PG DN

Move to the top or bottom item in the list of items 
currently visible in a drop-down box or list box, 
and select the item.

{button ,AL(`H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_OVER;
H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SE
LECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KE
YS_OVER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;',0)} See related topics



Editing keys
You can use these keys to move around, select, and change the entry in a cell when 1-2-3 is in Edit mode, or when 
you are in a text box. If 1-2-3 is in another mode, press F2 (EDIT) to get into Edit mode.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Keys to change an entry
Press To
BACKSPACE Erase the highlighted selection or the character 

to the left of the insertion point.
DEL
DELETE

Erase the highlighted selection or the character 
to the right of the insertion point.

INSERT
INS

Switch between inserting characters and typing 
over existing characters at the insertion point.

Keys to move the insertion point
Press To
CTRL+¬
CTRL+®

Move the insertion point left to the beginning of 
the entry or right to the end of the entry.

HOME
END

Move the insertion point to the first or last 
character in the entry.

¬
®

Move the insertion point one character to the left 
or right.

Keys to select characters in an entry
Press To
SHIFT+¬
SHIFT+®

Extend the highlight to the left or right of the 
insertion point.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;
H_SELECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIA
L_KEYS_OVER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_EDITING_DATA_OVER;',0)} See related
topics



Function keys
These keys perform special operations when used alone or in combination with ALT, CTRL, and SHIFT.
Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and then 
release both keys.
Note F2, F3, F4, F5, F6, F8, and F9 perform different actions when the Script Editor or the Script Debugger is active. 
For more information about these keys, see Script editing and debugging keys.

Press To
F1 (HELP) Display a Help topic. 
F2 (EDIT) Switch into Edit mode. If the cell is blank,

toggle between Edit and Ready modes. 
If the cell contains a label, toggle 
between Edit and Label modes.

F3 (NAME) List range names or database table 
names in any active workbook, 
@functions, or macros, depending on 
the current task.
F3 does not display lists in the InfoBox 
or with the Classic menu.

F4 Change the cell references in a formula 
from absolute to mixed to relative, when 
you enter or edit a formula.
In Ready mode, anchor the cell pointer 
so you can select a range.

F5 (GOTO) Move the cell pointer to a range, named 
range, sheet, chart, map, drawing, query
table, version, OLE embedded object,    
Notes/FX field, Web table, or datalink 
table.
Equivalent to Edit - Go To and CTRL+G.

F6 (PANE) Move the cell pointer clockwise to the 
next pane of the active window.

F7 (QUERY) Perform a query on the selected query 
table. 

F8 Repeat the last Range - Analyze - What-
if Table command.

F9 (CALC) In Ready mode, recalculate formulas.
Replace the formula with its current 
value when entering or editing a formula.

F10 (MENU) Activate the menu bar.
ALT+F1 (COMPOSE) Enter characters in cells that you cannot 

enter directly from the keyboard. For 
example, to enter the character £ (British
pound sterling symbol), press ALT+F1 
(COMPOSE) and type L=. You can also 
use the Windows Character Map to enter
these characters, if available.

ALT+F3 (RUN) Display the Run Scripts & Macros dialog 
box, showing a list of the macros in the 
active files.
Equivalent to Edit - Scripts & Macros -    
Run.

ALT+F4 Close the 1-2-3 window and any active 
dialog boxes or InfoBox. 1-2-3 asks if    



you want to save any unsaved 
workbooks. Equivalent to File - Exit.
Close the Help window or a dialog box.

CTRL+F2 Display the Check Spelling dialog box.
Equivalent to Edit - Check Spelling.

CTRL+F4 Close the active window if dialog boxes 
and the InfoBox are closed. 1-2-3 asks if 
you want to save any unsaved 
workbooks.
Equivalent to File - Close.

CTRL+F6 Display the next workbook window, when
more than one workbook is open.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OV
ER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H
_SELECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL
_KEYS_OVER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;',0)} See related topics



Help keys
You can use these keys in 1-2-3 Help.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To
ALT+F4
ESC

Close the Help window.

ALT+SPACEBAR Open the Control menu for the Help 
window.

CTRL+C Copy text of a Help topic onto the 
Clipboard so you can paste it into a 
workbook or another Windows application.

CTRL+HOME
CTRL+END
HOME
END

Scroll to the beginning or the end of the 
Help topic.

PG UP
PG DN

Scroll up or down one screen in the Help 
topic.

¯
Scroll up or down one line at a time in the 
Help topic.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SELECTION_KEYS_
OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_OVER;H_STY
LE_KEYS_OVER;H_EDITING_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_LEARN123_HELP_OVER;',0)} See 
related topics



InfoBox keys
Use these keys to move around and select options in the InfoBox, and to close the InfoBox.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To
ALT+F4 Complete all commands and property 

changes and close the InfoBox.
ALT+SPACEBAR Open the Control menu for the InfoBox. The 

Control menu contains commands to move, 
collapse, restore, close, and get help on the 
InfoBox.

SHIFT+TAB Move backwards to the previous option,    
bottom to top, right to left.

TAB Move forward to the next option, from left to 
right and top to bottom.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SELECTION_KEYS_
OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_OVER;H_STY
LE_KEYS_OVER;H_EDITING_KEYS_OVER;H_HELP_KEYS_OVER;H_USING_THE_INFOBOX_STEPS;',0)} 
See related topics



Keyboard shortcuts
Use these keys to execute commands.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To Equivalent to
ALT+ENTER Open the InfoBox for the

selected object.
<object> - <object>
Properties

ALT+F3 Open the Run Scripts & 
Macros dialog box.

Edit - Scripts & 
Macros - Run

CTRL+ a letter Run a macro. Edit - Scripts & 
Macros - Run

CTRL+C
CTRL+INS

Copy selected data and 
related styles to the 
Clipboard. 

Edit - Copy

CTRL+F Display the Find & 
Replace dialog box.

Edit - Find & 
Replace

CTRL+GRAY PLUS Display the Insert dialog
box.
Insert a row or column 
without displaying the 
dialog box when a row 
or column is selected.

Range - Insert

CTRL+GRAY MINUS Display the Delete 
dialog box.
Delete a row or column 
without displaying the 
dialog box when a row 
or column is selected.

Range - Delete

CTRL+G Display the Go To dialog
box.

Edit - Go To

CTRL+O Display the Open dialog 
box.

File - Open

CTRL+P Display the Print dialog 
box.

File - Print

CTRL+S Save the current file. File - Save
CTRL+V
SHIFT+INS

Paste data and related 
styles from the 
Clipboard.

Edit - Paste

CTRL+X
SHIFT+DEL
SHIFT+DELETE

Cut selected data and 
related styles to the 
Clipboard.

Edit - Cut

CTRL+Z Reverse the effect of the
most recently executed 
command or action that 
you can undo.

Edit - Undo

DELETE
DEL
CTRL+DELETE
CTRL+DEL

Delete the contents of 
the selected cells, or 
delete the selected 
graphic objects, without 
using the Clipboard.

Edit - Clear

ENTER Paste the data and 
related styles from the 
Clipboard when you 
select a location and 

Edit - Paste



press ENTER 
immediately after 
choosing Edit - Cut or 
Edit - Copy.
Activate the selected 
OLE embedded object.

ESC End the function in 
progress, or cancel a 
drag operation.
Deactivate a selected 
OLE embedded object. 
(For some embedded 
objects, ESC might have
a different function. In 
these cases, use 
SHIFT+ESC instead.)

Cancel
Close

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OV
ER;H_FUNCTION_KEYS_OVER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_A
ND_MACRO_KEYS_OVER;H_SELECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SPECIAL_
KEYS_OVER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_WAYS_TO_PERFORM_TASKS_OVER;',0
)} See related topics



Pointer-movement keys
Use these keys to move the cell pointer around the sheet.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. Key names separated by a space indicate that you press the first key and release it, and then
press the second key and release it.

Press To

¯
Move the cell pointer up or down one row.

¬
®

Move the cell pointer left or right one column.

CTRL+¬
CTRL+®

Move the cell pointer left or right the number 
of columns currently visible in the window.

ENTER Move the cell pointer down one row or leave it
in the current cell, depending on the setting in
File - User Setup - 1-2-3 Preferences (Classic
Keys tab).

END HOME Move the cell pointer to the lower right corner 
of the sheet's active area.

END ¬
END ®

Move the cell pointer left or right in the current
row to the next cell that contains data and is 
next to a blank cell.

END 
END ¯

Move the cell pointer up or down in the 
current column to the next cell that contains 
data and is next to a blank cell.

HOME Move the cell pointer to cell A1 in the current 
sheet.
Move the cell pointer to the top left cell in the 
sheet if you hide A1 or freeze it with View - 
Freeze Titles.

PG UP
PG DN

Move the cell pointer up or down the number 
of rows currently visible in the window.

SHIFT+ENTER Move the cell pointer up one row or leave it in 
the current cell, depending on the setting in 
File - User Setup - 1-2-3 Preferences (Classic
Keys tab).

TAB
SHIFT+TAB

Move the cell pointer right or left one column 
or one screen, depending on the setting in 
File - User Setup - 1-2-3 Preferences (Classic
Keys tab).

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OV
ER;H_FUNCTION_KEYS_OVER;H_HELP_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SELECTI
ON_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_O
VER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;',0)} See related topics



Script editing and debugging keys
Use these keys when you are using the Script Editor or Script Debugger.
Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and then 
release both keys. 
Note F2, F3, F4, F5, F6, F8, and F9 perform different actions when you are working with ranges and graphic objects.
For more information about these keys, see Function keys.

Press To Equivalent to
F2 Compile the script 

module for the 
specified object.

Script - Check Scripts

F3 Create a subroutine in 
the Script Editor.

Create - Sub

F4 Activate the Script or 
Debugger Browser.

View - Browser

F5 Run the current 
subroutine.
Continue to debug a 
script.

Script - Run Current 
Sub
Debug - Continue 
Execution

F6 Switch panes. View - Switch Panes
F8 Execute the current 

line.
Debug - Step

F9 Set or clear a 
breakpoint in the 
selected line(s).

Script - Set/Clear 
Breakpoint
Debug - Set/Clear 
Breakpoint

CTRL+H Find the next instance 
of the text specified in 
the Find & Replace 
dialog box.

Edit - Find Next

CTRL+F8 Complete current 
procedure, then stop.

Debug - Step Exit

CTRL+PG UP
CTRL+PG DN

Display the previous or
next script.

View - Previous Script
View - Next Script

SHIFT+F2 Compile the script 
module for all scripted 
objects in the specified
document.

Script - Check All 
Scripts

SHIFT+F3 Create a new function. Create - Function
SHIFT+F5 Stop executing the 

script.
Debug - Stop 
Execution

SHIFT+F8 Execute the next 
procedure without 
stopping inside called 
procedures.

Debug - Step Over

SHIFT+F9 Enable or disable a 
breakpoint.

Script - 
Enable/Disable 
Breakpoint
Debug - 
Enable/Disable 
Breakpoint

SPACEBAR
CTRL+SPACEBAR

Execute the next 
procedure when 
debugging a macro.

Debug - Step



{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SELECTION_KEYS_OVER;H_SHEET_
NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_OVER;H_STYLE_KEYS_OVER;
H_INFOBOX_KEYS_OVER;H_LOTUSSCRIPT_INDEX_TOPIC_OVER;',0)} See related topics



Selection keys
You can use these keys to select or resize a range or collection, or to move the cell pointer within a selected range.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Keys to select cells
Press To
CTRL+SHIFT+HOME Select all cells from the current cell to cell 

A:A1.
CTRL+SHIFT+¬
CTRL+SHIFT+®

Select cells from the current cell left or 
right to the last column currently visible.

SHIFT+HOME Select all cells from the current cell to A1.
F4 Anchor the range. Use pointer-movement 

keys to extend the range.

Keys to resize the current selection
Press To
CTRL+SHIFT+PG 
UP
CTRL+SHIFT+PG 
DN

Extend the selection to the next or 
previous sheet.

SHIFT+
SHIFT+¯

Resize the selection up or down one row.

SHIFT+¬
SHIFT+®

Resize the selection left or right one 
column.

SHIFT+PG UP
SHIFT+PG DN

Resize the selection up or down the 
number of rows currently visible.

Keys to move within the current selection
Press To
ENTER Move the cell pointer through the range, 

top to bottom, left to right. When the cell 
pointer reaches the bottom right cell in the
range, it returns to the top left cell in the 
range, or moves to the top left cell in the 
next range in the collection.

CTRL+ENTER
CTRL+SHIFT+ENTER

Move the cell pointer to the first cell of the 
next or previous range of a collection, 
respectively.

SHIFT+ENTER Move the cell pointer through the range, 
bottom to top, right to left. When the cell 
pointer reaches the top left cell in the 
range, it returns to the bottom right cell in 
the range, or moves to the bottom right 
cell in the next range in the collection.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OV
ER;H_FUNCTION_KEYS_OVER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_A
ND_MACRO_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_
KEYS_OVER;H_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_SELECTING_SHEET_AREAS_OVER;H_
SELECTING_OBJECTS_OVER;',0)} See related topics





Sheet navigation keys
Use these keys to move the cell pointer between sheets in the current workbook.
Note In key combinations, when the key names are separated by a plus sign (+), hold down the first key, press the 
second key, and then release both keys. When the key names are separated by a space, press the first key and 
release it, and then press the second key and release it.

Press To
CTRL+HOME Move the cell pointer to cell A:A1 in the 

current workbook.
Move the cell pointer to the top left cell in 
the first sheet of the current workbook if you
hide A:A1 or freeze it with View - Titles.

CTRL+PG UP
CTRL+PG DN

Move the cell pointer to the last active cell in
the previous or next sheet.

END 
CTRL+HOME

Move the cell pointer to the bottom right 
corner of the active area in the last 
nonblank sheet in the current workbook.

END CTRL+PG 
UP
END CTRL+PG 
DN

Move backward to the last sheet or forward 
to the next sheet that contains data in the 
cell corresponding to the current cell and is 
next to a blank cell.
Move to the corresponding cell in the first or
last sheet, respectively, if all cells are blank.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OV
ER;H_FUNCTION_KEYS_OVER;H_HELP_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SELECTI
ON_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_OVER;H_STYLE_KEYS_OVER;H_POINT
ERMOVEMENT_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_SHEETS_OVER;',0)} See related topics



Special keys
These keys perform special functions, such as providing access to other open applications.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To
ALT Activate the menu bar. You can then 

choose a menu command by pressing 
the underlined letter of the command 
name.
Perform special operations when used 
in combination with the function keys.

ALT+ESC Make the next application window 
active.

ALT+ - (hyphen) Open the Control menu for the active 
window.

ALT+ number keypad Enter an extended character when you
press ALT+ a 3-digit number on the 
keypad. For example, to enter the 
character Ñ, press ALT+165. You can 
also use the Windows Character Map 
to enter these characters, when 
available.

ALT+SHIFT+ESC
ALT+SHIFT+TAB

Make the previous open application 
window active.

ALT+SPACEBAR Open the Control menu for the 1-2-3 
window, the Help window, dialog 
boxes, and InfoBox.

ESC Cancel a dialog box without completing
the command.
Cancel the current entry in the current 
cell or the contents box.
Return to the previous menu.
Close the Help window.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;
H_SELECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_STYLE_
KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_INFOBOX_KEYS_OVER;',0)} See related topics



Style keys
These keys change the styles applied to data in a range.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. 

Press To
CTRL+B Change the data in the current selection to bold.

Remove the bold if data is already bold.
CTRL+E Center data in cells.
CTRL+I Italicize data in the current selection.

Remove the italics if data is already italics.
CTRL+L Align data with the left edge of the cells.
CTRL+N Remove bold, italics, and underlines from data in 

the current selection.
CTRL+R Align data with the right edge of the cells.
CTRL+U Underline data in the current selection.

Remove the underline if data is already 
underlined.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_WORKBOOK_NAVIGATION_KEYS_OVER;H_FUNCTION_KEYS_O
VER;H_HELP_KEYS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;
H_SELECTION_KEYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIA
L_KEYS_OVER;H_EDITING_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_STYLING_A_SHEET_OVER;',0)} See
related topics



Workbook navigation keys
Use these keys to move between active workbooks.
The order in which the cell pointer moves between active workbooks, expressed in the terms first, last, next, and 
previous in the following definitions, depends on which workbook is active when you open a workbook, and the order 
in which you open the workbooks.
Note Key names separated by a plus sign (+) indicate that you hold down the first key, press the second key, and 
then release both keys. Key names separated by a space indicate that you press the first key and release it, and then
press the second key and release it.

Press To
CTRL+END HOME
CTRL+END END

Switch to the first or last workbook window 
opened.

CTRL+F6
CTRL+TAB
ALT+ESC

Switch to the next workbook window.

CTRL+PG UP
CTRL+PG DN

Move the cell pointer to the cell you last 
highlighted in the next or previous sheet of 
the workbook.

CTRL+SHIFT+F6
CTRL+SHIFT+TAB

Switch to the previous workbook window.

{button ,AL(`H_DIALOG_BOX_KEYS_OVER;H_EDITING_KEYS_OVER;H_FUNCTION_KEYS_OVER;H_HELP_KE
YS_OVER;H_POINTERMOVEMENT_KEYS_OVER;H_SCRIPT_AND_MACRO_KEYS_OVER;H_SELECTION_K
EYS_OVER;H_SHEET_NAVIGATION_KEYS_OVER;H_SHORTCUT_KEYS_OVER;H_SPECIAL_KEYS_OVER;H
_STYLE_KEYS_OVER;H_INFOBOX_KEYS_OVER;H_SHEETS_OVER;',0)} See related topics



Learning 1-2-3
For many tasks in 1-2-3, you won't need any help. Simply reading the menus, clicking buttons, and responding to 
instructions in dialog boxes and the InfoBox will enable you to complete your work successfully.    
When you do need help, 1-2-3 provides the following resources: 

• Ask the Expert lets you ask a task-oriented question in your own words and then displays a list of possible 
answers.
See Using the Expert to get help.

• Help includes overviews, procedures, examples, and reference topics on 1-2-3 features.
See Getting Help with 1-2-3

• Help Contents contains information on the top 10 tasks in 1-2-3.

• QuickDemos in Help show you how to perform some common 1-2-3 tasks.
See Using QuickDemos.

• "Did you know...?" is a Help topic that lists useful features and tips. 
See Did you know...?.

• The printed documentation highlights new 1-2-3 features.

{button ,AL(`H_LEARN123_PRINTING_HELP_STEPS;H_LEARN123_LATE_BREAKING_NEWS_ABOUT_123_OVE
R;H_LEARN123_EXAMPLES_IN_HELP_OVER;H_UNDOING_A_COMMAND_STEPS;H_CANCELING_A_COM
MAND_STEPS;H_WAYS_TO_PERFORM_TASKS_OVER;H_GETTING_HELP_ON_A_MENU_COMMAND_STE
PS',0)} See related topics



Using QuickDemos
Each of the Help topics listed below contains a QuickDemo. When you run a QuickDemo, 1-2-3 opens a sample file 
and shows you how to perform a particular task, using the data in the sample file. Most QuickDemos step you 
through a basic procedure; some QuickDemos introduce you to more complex tasks and concepts. 
At the end of the QuickDemo, the sample file closes and you return to your workbook at the point you left off, with the 
Help window open, so you can perform the steps yourself. 
To start a QuickDemo, just click the icon shown below whenever you see it in a Help topic. 

 

QuickDemos in 1-2-3 Help 
You can see QuickDemos of the tasks listed below. 

Using the InfoBox
Using the InfoBox

Entering, editing, and calculating data
Filling a range by dragging
Filling a range with dates
Deleting data by dragging
Creating a cell comment
Summing a range automatically

Copying and moving data
Copying down to fill a range
Copying right to fill a range
Moving a sheet using drag and drop

Naming sheets and ranges
Naming a sheet
Naming a range
Naming a range using adjacent labels

Changing columns and rows
Sizing columns 
Fitting the widest column entry
Hiding columns
Sizing rows
Freezing columns and rows as titles

Ordering and outlining data
Sorting data 
Outlining data in 1-2-3
Demoting rows and columns to create an outline
Collapsing an outline to show less detail
Expanding an outline to show more detail

Working with versions and version groups
Creating a version
Displaying a version
Creating a version group

Working with graphic objects
Creating a text block
Creating a map

Working with data queries
Working with 1-2-3 database tables 

Changing print properties 
Adding headers and footers
Changing print margins



{button ,AL(`H_LEARN123_OVER;H_LEARN123_HELP_OVER;H_LEARN123_EXAMPLES_IN_HELP_OVER',0)} 
See related topics



Getting Help with 1-2-3

What's in Help?
Help contains overviews, procedures, technical details, examples, and QuickDemos that can teach you about using 
1-2-3. Help also contains reference information on all @functions and LotusScript commands.
When you find the information you need in Help, you can print it or you can leave the Help window open when you 
work. The Help window stays on top of the 1-2-3 window so you can follow a procedure as you perform the task in 1-
2-3.

If you don't know where to start
From the Help menu, choose Help Topics. Initially, 1-2-3 displays a dialog box that lets you choose the type of Help 
you want:

• Help topics lets you browse the Help Contents or Index to find information.
• The Expert lets you ask a question using your own words, and then select the topic you want from a list of 

possible answers.
After you click Help Topics, you see a dialog box with three tabs. 

• Click Contents to see Help topics organized by books. Double-click a book to see the list of topics in each book. 
Double-click a topic to read it.

• Click Index to display a list of index entries. Each entry is associated with one or more Help topics. Type the first 
letters of the word you are looking for or scroll down the index to see all of the entries. Double-click an entry to 
display Help.    

• Click Find to do a full-text search of Help topics. The first time you use Find, Windows creates a file that contains 
all of the words in Help. Using Find, you can locate any word or phrase contained in a Help topic.

Getting Help on your current task
• Using Ask the Expert -- To ask a question in your own words, select the object you are working on, and then click 

the Expert button in the status bar.

• Using a dialog box -- Click Help or press F1 (HELP).

• Using the InfoBox -- Click the Help question mark button or press F1 (HELP).

• Highlighting a menu command -- Press F1 (HELP) to see a summary of commands on that menu.
• On SmartIcons or tabs in the InfoBox -- Hold the mouse pointer over an icon or tab to display a short description.

• Entering an @function -- In a blank cell, type @ and press F3 (NAME) to display a list of @functions. Highlight an 
@function and press F1 (HELP). 

• Working in the Script Editor or Script Debugger -- Use the Help menu. 



Navigating within Help
When the Help window is open, you can move from one Help topic to another to display additional information.

• Click green text with a dotted underline to view a definition in a pop-up window. 
Pop-up example 

• Click green text with a solid underline to jump to another Help topic. 
Jump example 

• Click the Go Back button to display previously read Help topics. 

• The following buttons appear at the end of many Help topics. Click a button to see additional information.

Windows Help commands
Windows includes some additional Help features. Click the right mouse button anywhere in a Help window to display 
the following Help commands. 

Lotus Customer Support services
If you aren't able to find the answer to your question in Help, the printed documentation, or the README file, please 
contact the support service that is most appropriate to your needs.
For information on the services offered, see Support in the Help Index.

{button ,AL(`H_GETTING_HELP_ON_AN_ATFUNCTION_STEPS;H_LEARN123_CONVENTIONS_OVER;H_LEARN
123_PRINTING_HELP_STEPS;H_GETTING_HELP_ON_A_MENU_COMMAND_STEPS;H_MACRO_KEYWORD
S_DIALOG_BOX_CS;H_LEARN123_OVER;H_LEARN123_LATE_BREAKING_NEWS_ABOUT_123_OVER;H_L
EARN123_EXAMPLES_IN_HELP_OVER;H_123_LSCOMMON_USING_LOTUSSCRIPT_HELP_OVER;H_123_U
SING_EXPERT_STEPS;H_HELP_KEYS_OVER',0)} See related topics



Printing Help information
You can print one topic or a book of Help topics:

• To print the topic you are reading, click Print. 
• To print all the topics in a book from Help Contents, select the book and click Print.
• To print a pop-up in Help, right-click the pop-up window and choose Print Topic.

{button ,AL(`H_LEARN123_HELP_OVER;H_LEARN123_OVER',0)} See related topics



Conventions used in Help
• Some commands appear in hyphenated form in Help procedures.

For example, when you see File - User Setup - 1-2-3 Preferences in a procedure, you should choose File from 
the main menu, then choose User Setup and then 1-2-3 Preferences from the cascade menu.

• SmartIcons in a procedure indicate that you can either use the command or click the icon in 1-2-3.
• Click green text with a dotted underline to view a definition in a pop-up window. 

Pop-up example 
• Click green text with a solid underline to jump to another Help topic. 

Jump example 
• You see bold text in the following instances:

Caution -- Introduces information essential to the safety of your data and software.
Note -- Introduces additional technical information about a command or procedure.
Tip -- Provides additional useful information.

• Function keys appear in all capitals and are followed by the 1-2-3 key name. For example, F1 (HELP).
• Key names separated by a + (plus sign) indicate that you hold down the first key, press the second key, and then 

release both keys. For example, CTRL+C.
• Key names separated by a space indicate that you press the first key and release it before pressing the second 

key. For example, END HOME.
• The following buttons appear at the end of many Help topics. Click a button to see additional information.

• [ ] (brackets) enclose optional arguments in @functions and macro commands; for example, [password]. 
Arguments appear in italics.



Did you know...?
This list of tips can help you work more efficiently in 1-2-3.

Working in 1-2-3 
• Commands on the menu change, depending on what you have selected.

For example, when you select a cell, 1-2-3 displays Range on the menu. If you select a rectangle or an arrow, 
Drawing replaces Range on the menu. When you select a Map or a Chart, you see menus for those objects.

• You can undo many commands in 1-2-3 by using Edit - Undo.

• Press ESC to:
• Cancel a dialog box without completing the command
• Cancel the current entry in the current cell or the edit line
• Return to a previous menu
• Close the Help window or the Expert window

• Click the Expert button in the status bar to ask the Expert how to perform different tasks in 1-2-3.

• You can drag the pop-up Expert window off the status bar and leave it open while you work in 1-2-3.
• Press F1 (HELP) to display the Help window at any time.
• You can leave the Help window open as you complete your work.

Using the mouse
• SmartIcons are buttons that represent mouse shortcuts for 1-2-3 actions and commands. If you see an icon in a 

Help topic that isn't displayed in your set of SmartIcons, you can add the icon using File - User Setup - 
SmartIcons Setup.

• To display a description of an icon or a tab in the InfoBox, hold the mouse pointer over the icon or tab.

• The mouse pointer changes shape, depending on the task.
• You can click the right mouse button over an object or while editing a cell to display the shortcut menu.

Working with windows and files
• When you create a new workbook, you can use a SmartMaster template to get a head start on your work.
• You can move a window by dragging the title bar.
• If you have more than one file open, you can use the Window command to navigate between the open files.

Using the InfoBox to change properties
• Remember that you must select any cell, range, or object before you can change its properties.
• To open the InfoBox for a cell or range, use Range - Range Properties. To open the InfoBox for most other 

objects, double-click the object.
• As you select options in the InfoBox, changes appear immediately in 1-2-3. 
• You can leave the InfoBox open as you work. The InfoBox stays on top of your sheet as you select other objects.



• To collapse the InfoBox and display only its title bar, double-click the title bar. Double-click the title bar again to 
restore the InfoBox to its full size. 

{button ,AL(`H_LEARN123_OVER;H_UNDOING_A_COMMAND_STEPS;H_CANCELING_A_COMMAND_STEPS;H
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Late breaking news about 1-2-3
The README.WRI file contains notes for upgraders and network administrators, and information received after the 
Help and the documentation were completed. The Install program copies the README.WRI file to your 1-2-3 
directory.
To open the README.WRI file:
1. Click the Start button.
2. Click Programs.
3. Click Lotus SmartSuite (or the folder where you installed 1-2-3).
4. Click Lotus User Assistance.
5. Double-click 1-2-3 Product Updates.



Finding examples in 1-2-3 Help
There are three types of examples in 1-2-3 Help:

• Examples that illustrate 1-2-3 features
• @Function examples 
• LotusScript examples

To find examples in Help:
1. Click the Help Index tab.
2. Type example.

3. Under Examples in the list, double-click the example you want to see. 



Pop-up example
This is a definition in a pop-up window.
To close this window, click anywhere.



Jump example
You just jumped to this Help topic.
To return to the topic you were reading, click the Go Back button.



Overview: Sharing data using OLE
Object Linking and Embedding (OLE) lets you share data (also called objects) across applications. You can either link
or embed objects.

• A link is a connection through which data created and stored in a source file is displayed in another file. Linked 
data can automatically update to reflect changes made in the source file. 

• An embedded object is data created in one application (the server) but stored in a file in another application (the 
container). Once embedded, the data becomes part of the file in which it is stored. Embedded data is not linked to
data outside of the container's file and only changes if you edit it.

When should you use links?
Use links when:

• You need to share data between applications. 
• You expect the shared data to change. 
• You need to update the shared data when the original data changes. 

For example, suppose you need to use data from an Approach file in a 1-2-3 workbook and the data changes weekly.
You can create automatic links in the 1-2-3 workbook to the data in the Approach file so that whenever you open the 
1-2-3 workbook, it automatically displays the latest Approach data.
For more information, see What is an OLE link? 
Note You cannot create an OLE link between two 1-2-3 workbooks, but you can link workbooks by using Edit - Paste 
Link or using formulas. See Referring to other workbook files in formulas. 

When should you use embedded objects?
Use embedded objects when:

• You do not need the data to be linked to a source file.
• You want to store data from another application within one file.
• You may want to edit the data.

For example, if you create a diagram in Freelance Graphics, you can embed it in a 1-2-3 workbook. When you want 
to edit the diagram, you can double-click it.
For more information, see What is an embedded object?

{button ,AL(`H_LINKING_FROM_123_TO_ANOTHER_APPLICATION_STEPS;H_CREATING_AN_EMBEDDED_OB
JECT_STEPS;',0)} See related topics



What is an OLE link?
A link is a connection through which data created and stored in a source file is displayed in another file. Linked data 
can automatically update to reflect changes made to the data in the source file. 

You can create links to a wide range of objects, including text, drawings, and charts, as well as Notes documents, 
views, or databases. 
For example, suppose you want to use text from a Word Pro file in a 1-2-3 file and the text changes weekly. You can 
create automatic links to the Word Pro file so that whenever you open the 1-2-3 file, it automatically displays the 
latest text from the Word Pro file.

What does an OLE link look like?
In 1-2-3, linked data can appear in two ways:

• As data in a graphic object or as an icon indicating the server application -- These objects are displayed on top of 
the sheet.

• As a datalink table -- Data in a datalink table is entered directly in the sheet.
The link's appearance can vary, depending on how you created the link and on the server application's OLE support.

How do you create an OLE link?
1-2-3 provides several ways to create OLE links. You choose a method based on how much you want to control the 
link process.

• If you copy data to the Clipboard in the other application and then use Edit - Paste Link in 1-2-3, 1-2-3 chooses 
the link format for you.
Note If the default format of the data on the Clipboard is Text, .WK1, or .WK3, 1-2-3 creates a datalink table in the
sheet.

• If you copy data to the Clipboard in the other application and then use Edit - Paste Special in 1-2-3, you can 
choose the format and appearance of the linked data. 

• To create a link to an entire file, use Create - Object and select the file and the link option.
• 1-2-3 also supports dragging to create a link. If the other application supports it, you may be able to drag the 

selection to or from the application to create a link. 

What can you do with an OLE link?
• You can move, copy, or delete linked data just as you would a range or a graphic object.
• You can double-click most links to activate the server application so that you can change the source data.
• You can use Edit - Manage Links to view information about all the links in a workbook, edit, update, and break 

links . For example, you can edit a link so that it refers to a different piece of data in the source file or change how 
often you want to update linked data. 

• If the data is in a datalink table, you can also format the data directly in the sheet. When 1-2-3 updates the link, 
the datalink table retains the formatting.

Note To edit linked OLE objects, you must have the server application installed on your computer.

OLE links in files from 1-2-3 97
If you open a 1-2-3 97 file that contains OLE links created with @DATALINK, 1-2-3 retains the links but converts them
to datalink tables.
For more information, see

Working with datalink tables    
Working with 1-2-3 for Windows files    
Working with 1-2-3 for OS/2 files 
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Creating an OLE link in 1-2-3
When you create an OLE link, you can let 1-2-3 choose the link format based on the data on the Clipboard, or you 
can choose the format yourself. Depending on the type of data you are linking, 1-2-3 will either create a linked object 
or a datalink table.
1. Open the source file in the other application, select the data you want to link, and copy it to the Clipboard.
2. Open the 1-2-3 workbook and select a location where you want to put the linked data. 

• If you select one cell, 1-2-3 uses that cell as a starting point to enter the linked data.
• If you select a range, 1-2-3 limits the linked data to that range.

Caution If the format of the data on the Clipboard is Text, .WK1, or .WK3, 1-2-3 will enter linked data in the sheet 
as a datalink table. To avoid writing over existing data, select a cell or range in a blank area of the sheet. 

3. Do one of the following:
• To create a link quickly and let 1-2-3 choose the link format, choose Edit - Paste Link. 

1-2-3 selects an appropriate format, creates the link, and displays the linked data.
• To choose the format yourself, continue to step 4.

4. From the Edit menu, choose Paste Special.
5. Select "Paste link to source."
6. Select a format from the "As" box.

Note To display the link as an icon representing the server application, select "Display as icon." To select a 
different icon, click Change Icon, select another icon, and click OK. 

7. Click OK.
1-2-3 creates the link in the workbook using the format you selected. If the format of the data on the Clipboard is Text,
.WK1, or .WK3, 1-2-3 creates a datalink table and enters the linked data directly in the sheet. 

{button ,AL(`H_LINKING_FROM_123_TO_ANOTHER_APPLICATION_DETAILS',1)} See details
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Details: Creating an OLE link in 1-2-3
Creating a Notes link
You can create a link from 1-2-3 to a Notes 4.1 (or higher) document, view, or database. In Notes, use Edit - Copy As 
Link. Then, in 1-2-3, choose Edit - Paste Special, select "Paste link to source," and select "Notes Link" as the link 
type. 

Other ways to create a linked object
You can also use Create - Object, and select the "Create an object from a file" and the "Link to file" options to create 
a link.

Restrictions
• To create a link in 1-2-3, the server application must support OLE linking.
• If Edit - Paste Link is not available, make sure you have saved the file in the server application.
• Most server applications need to be open while creating links using the Clipboard. If you want, you can minimize 

the application's window to an icon. 
• You cannot paste a link when the Clipboard is empty, or when the top left corner of the current selection is in a 

protected range. 
• 1-2-3 cannot create OLE links to itself. That is, you cannot create links to 1-2-3 charts, maps, drawings, or 

embedded objects. If the Clipboard contains a 1-2-3 chart, map, drawing, or embedded object, the "Paste link to 
source" option is unavailable. 

{button ,AL(`H_LINKING_FROM_123_TO_ANOTHER_APPLICATION_STEPS',1)} Go to procedure



Working with datalink tables
When you create an OLE link from data on the Clipboard that is in Text, .WK1, or .WK3 format, 1-2-3 creates a 
datalink table in the sheet. Depending on the OLE server, the data may be text, numbers, or both. You can use this 
data to perform calculations or build formulas.

What can you do with a datalink table?
You can select and format the data in a datalink table.

• To select a datalink table, you can select the table border, select the entire table range, or right-click the border 
and choose Select Table Range.

• You can format data in a datalink table just like you format other data in the sheet. 1-2-3 will keep the formats 
when the link is updated. 

You can copy and move a datalink table.
• To copy the data and the link with a datalink table, you must select the table border or the entire table range first. 

Otherwise, you copy only the data.
• You can move a datalink table using drag and drop or Edit - Cut and Edit - Paste.

Sizing a datalink table
When you create a datalink table, 1-2-3 determines the size of the table based on how you selected the range when 
you created the table.

• If you selected one cell, 1-2-3 sets the table size to "Variable" and enters all the linked data in the sheet.
• If you selected a range larger than one cell, 1-2-3 sets the table size to "Fixed" and enters only the data that will fit

in the selected range.
However, you can resize the table at any time using the mouse or the InfoBox. See Sizing a datalink table. 
Note When you resize a datalink table, 1-2-3 also updates the link.

Hiding the datalink table border
By default, a datalink table has a border, but you can hide it. When you turn off the border, be aware that the datalink 
table looks like any other data in the sheet. See Hiding and showing datalink table borders.    
Tip To find and select a datalink table when you've hidden the borders, use Edit - Go To and select Datalink.

Updating a datalink table
By default, a datalink table is set to update automatically, but you can specify if you want updates to be automatic or 
manual. As with other OLE links, you can use Edit - Manage Links to change the update setting. See Changing a 
link's update mode. 
Tip To update the link quickly, right-click the border and choose Update Now.

Cautions
• Do not overlap a datalink table with other data because the other data will be lost.
• Do not create a datalink table in a versioned range. When the link is updated, the datalink table writes over the 

data in the current version.
• If you combine or extract a range containing a datalink table, 1-2-3 combines or extracts the data but not the link.



Hiding and showing datalink table borders
By default, 1-2-3 displays a border around a datalink table. If you hide the border, be aware that a datalink table 
without a border looks like any other data in the sheet.

Tip To find and select a datalink table when you've hidden the border, use Edit - Go To.

Hiding or showing borders for all datalink tables in a workbook
1. From the View menu, choose Set View Preferences.
2. Under Show in workbook, either select "Datalink table borders" to display them, or deselect "Datalink table 

borders" to hide them. 
3. (Optional) To use this setting for all new workbooks, click the button, "Make Default for New Workbooks."
4. Click OK.

Hiding or showing the border for one datalink table
1. Right-click any cell in a datalink table.
2. From the menu, choose Show Table Border or Hide Table Border.

Other ways to hide or show borders for a datalink tables
Select the datalink table, click the right mouse button, and choose the Properties command to open the InfoBox. On 
the Basics tab, select or deselect "Show border."

{button ,AL(`H_123_WORKING_WITH_DATALINK_TABLES_OVER',0)} See related topics



Sizing a datalink table
Initially, 1-2-3 determines the size of a datalink table by how you selected the range when you created the table. 
However, you can resize the table at any time.
When you resize a datalink table, 1-2-3 also updates the link.
Caution Do not overlap a datalink table with other data because the other data will be lost.

Sizing a datalink table by dragging
When you resize a datalink table by dragging, 1-2-3 limits the data it displays to the range you specified and sets the 
table range to a fixed size. 
1. Click the border to select the datalink table.
2. Drag any of the selection handles on the border to size the table.

Sizing a datalink table using the InfoBox
When you resize a datalink table using the InfoBox, you can also set the table range to be a fixed or variable size.
1. Right-click the datalink table border.
2. From the menu, choose Properties to open the InfoBox.
3. Click the Range tab.

4. In the "Datalink table range" box, specify a range.
Caution  To avoid writing over existing data, select a cell or range in a blank area of the sheet.

5. Under "Size of range," select "Variable" or "Fixed." 
• Variable -- Shows all the linked data in a datalink table starting at the top left cell of the table range.
• Fixed -- Restricts the size of the datalink table to the range you specified.

6. (Optional) Move, collapse, or close the InfoBox.
If you selected Variable, 1-2-3 displays all the data in datalink table. If you selected Fixed, 1-2-3 displays data only
in the range you selected.

{button ,AL(`H_123_SIZING_A_DATALINK_TABLE_DETAILS',1)} See details
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Details: Sizing a datalink table
Do not overlap different kinds of tables when you size them
If you move a datalink table on an anchor cell of a Web table or a    query table, 1-2-3 displays a message indicating 
that the link will be broken. If you click OK, 1-2-3 removes the frame and breaks the link to the source.
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Using drag and drop to create an OLE link
You can create an OLE link from 1-2-3 to another application (or vice versa) using drag and drop, provided the other 
application supports this feature.
1. Tile the 1-2-3 window and the window of the other application so that both are visible.
2. Make the 1-2-3 workbook that contains the original data the active window. Make sure you have named and 

saved the 1-2-3 file.
3. Select the range in 1-2-3 you want to link. You can include graphic objects in the range. 
4. Position the mouse pointer on the border of your selection so that the mouse pointer changes to a hand. 

5. Hold down both CTRL and SHIFT, and drag the object to the other application.
6. Release the mouse button when you reach the destination, then release CTRL and SHIFT.
Note To drag and drop from another application into 1-2-3, use this procedure, but select the data in the server 
application and drag it to 1-2-3. Check the other application's documentation to find out what keys to use while 
dragging. 

{button ,AL(`H_CREATING_A_LINK_USING_DRAG_AND_DROP_DETAILS',1)} See details
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Details: Using drag and drop to create an OLE link
Troubleshooting
If you have trouble using drag and drop to create a link: 

• Check that the source file is named and saved. In many cases, the server application's file must also be named 
and saved. 

• Copy the data to the Clipboard, choose Edit - Paste Special, and select "Paste link to source."

Controlling the link format
When you create a link using drag and drop, the container application chooses the link format. If you want more 
control over the type of link, copy the data and use Edit - Paste Special.

Using drag and drop between 1-2-3 workbooks
If you drag and drop data between 1-2-3 workbook files, 1-2-3 creates a file link, not an OLE link. A file link is a 
formula that contains a reference to the range in the source file. See Referring to other workbook files in formulas. 
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Creating a linked object from a file
You can create an OLE link to an entire file. The linked object updates when the source file changes. 
1. From the Create menu, choose Object.

2. Under Create new, select "Object from a file."
3. Enter the path and file name, or click Browse to select from the available directories, and then click Open.
4. Select "Link to file."

Note To display the object as an icon, select "Display as icon." To select a different icon, click Change Icon, select
another icon, and click OK. 

5. Click OK.
6. Click the sheet where you want the top left corner of the object to appear. 

The server application determines the size and position of the object.

{button ,AL(`H_CREATING_A_LINKED_OBJECT_FROM_A_FILE_DETAILS',1)} See details
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Details: Creating a linked object from a file
1-2-3 cannot create OLE links to itself. That is, you cannot create links to 1-2-3 charts, maps, drawings, or embedded
objects.

Editing the source file
You can double-click a linked object to edit the source file. Linked objects are always edited out of place.
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Breaking links
You can break a link if you no longer want the linked data connected to its source. A broken link no longer updates 
the data.
1. From the Edit menu, choose Manage Links. 

2. Select the type of link from the "Link type" list.
3. Select the links to break.
4. Click Break Link.
5. Confirm your choice, and then click Done. 
If you break a link to an object, in most cases the linked object becomes a picture.
If you break a link to a datalink table, 1-2-3 removes the border and leaves just the data.
If you break a DDE link, 1-2-3 removes the @DATALINK formula and leaves just the data.
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Changing a link's update mode
When you create a DDE or OLE link, 1-2-3 sets the update mode to automatic. Automatic update mode ensures that 
your data is always current.
Note You may want to use manual update mode to improve system performance when you have many links in a file 
or when the links contain a large amount of data. Manual update mode lets you update the links when you want 
rather than every time you make a change. 

To change a link's update mode
1. From the Edit menu, choose Manage Links. 

2. Select the type of link from the "Link type" list.
3. Select the link. 
4. Select "Automatic" or "Manual." 
5. Click Done. 

{button ,AL(`H_CHANGING_A_LINKS_UPDATE_MODE_DETAILS',1)} See details
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Details: Changing a link's update mode
Automatic updating
When the update mode for a link is set to automatic, 1-2-3 updates links as follows: 

• If the source file and the file containing the links are both open, automatic links are updated whenever the data in 
the source file changes.

• If the source file is not open when you open the file containing the link, automatic OLE links are updated only if 
the 1-2-3 workbook option, "Update links when opening workbooks," is selected in the 1-2-3 Preferences dialog 
box (General tab). This option is off by default but you can change it by choosing File - User Setup, and then 1-2-
3 Preferences.
Note DDE only updates links in a file if the source file is open or if AutoStartTimeOut is set and 1-2-3 is able to 
launch the source application and load the file. For more information, see 1-2-3 as a DDE Client. 

Manual updating
When the update mode for a link is set to manual:

• 1-2-3 updates manual links only when you choose Edit - Manage Links and click Update Now or Update All Now. 
• 1-2-3 does not update manual links when you open the file that contains links, even if the 1-2-3 workbook option 

for updating links is selected.

{button ,AL(`H_CHANGING_A_LINKS_UPDATE_MODE_STEPS',1)} Go to procedure



Editing links
When you edit a link, you can either edit the source data or link to a different source file.

Editing the source data for an OLE link
To edit the source data for an OLE link in 1-2-3, you must have the server application installed on your computer. In 
1-2-3, OLE links are always edited out of place.
Note You cannot open the source file for a DDE link in this way.
1. From the Edit menu, choose Manage Links.

2. Select OLE or Data from the "Link type" list. 
3. Select the link.
4. Click Open Source.

1-2-3 opens the source file in the server application.
5. Make changes in the source file.

When you have finished editing, you can save and close the source file and exit the server application. 

Linking to a different source file
With OLE and DDE links, you can link to a different source. 
1. From the Edit menu, choose Manage Links.

2. Select OLE, Data, or DDE from the "Link type" list. 
3. Select the link.
4. Click Edit Link and specify a different path, file name, or item.
5. Click OK to return to the Manage Links dialog box. 
When you link to a different source file, 1-2-3 creates a new link and sets the update mode to automatic.

{button ,AL(`H_EDITING_LINKS_DETAILS',1)} See details
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Details: Editing links
Editing DDE links 
With DDE links, you can edit the arguments of an @DATALINK formula. The syntax is as follows:
@DATALINK (app-name;topic-name;item-name;[format];[max-rows];[max-cols];[max-sheets])
For more information, see @DATALINK.
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Updating links
You can update OLE, DDE, and file links.
Note If the source file for the link has moved, you cannot update the link until you identify the source's new location. 
Use Edit - Manage Links and click Edit Link to modify the link so it matches the source's new location.
1. If you are updating DDE links, open the source file.

Note You do not need to open the source file to update OLE links. 
2. From the Edit menu, choose Manage Links. 
3. Select the type of link from the "Link type" list.
4. If you selected OLE, Data, or DDE links, do one of the following:

• To update some links, select the links and click Update Now.
• To update all links, click Update All Now.

5. If you selected 1-2-3 file links, click Update All Now.
6. Click Done.

{button ,AL(`H_UPDATING_LINKS_DETAILS',1)} See details
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Details: Updating links
Updating DDE links
DDE only updates links in a file if the source file is open or if AutoStartTimeOut is set and 1-2-3 is able to launch the 
source application and load the file. For more information, see 1-2-3 as a DDE Client. 

Recalculating file links
Recalculation settings apply only to formulas that refer to data in active workbooks. These settings do not affect 
formulas that link to data in workbooks on disk. 

Automatically updating file links
1-2-3 automatically updates all file links when you open a workbook that refers to other active workbooks if 
Recalculation is set to automatic in the workbook that you open. For more information, see Setting recalculation 
defaults. 

{button ,AL(`H_UPDATING_LINKS_STEPS',1)} Go to procedure



Manage Links dialog box
Use this dialog box to edit, update, and break existing links, and to view information about each link.
When you highlight each link, 1-2-3 displays information about the Source, Type, and Update mode. If you highlight a 
link for a datalink table, 1-2-3 also displays the range address for the datalink table.

Choose a task
Updating links
Editing links
Changing a link's update mode
Breaking links 
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What is an embedded object?
An embedded object is an object created in one application (a server application) but stored in a file in another 
application (the container application). The embedded object is not linked to another file.
For example, if you want to include text from a Word Pro document in a 1-2-3 workbook, you can embed the Word 
Pro document in the 1-2-3 workbook. When you need to change the text, you just double-click the embedded Word 
Pro document.

What does an embedded object look like?
In 1-2-3 an embedded object may look like a graphic object or may look like the icon of the server application, 
depending on how you created it.

How do you embed an object?
If both applications support OLE, you can embed objects by using Edit - Paste Special or Create - Object. 

• Use Edit - Paste Special to embed an object that you either copied or cut from another application.
• Use Create - Object to embed a new object from scratch or embed data from an existing file.

What can you do with embedded objects?
When you select the object, it displays selection handles, and the 1-2-3 menu changes to include a menu for the 
embedded object. 
For example, when you select an embedded Word Pro document, 1-2-3 adds "Document" to the 1-2-3 menu so you 
can edit it or perform other actions.

• You can copy, cut, move, or delete embedded objects like other graphic objects.
• You can edit embedded objects in one of the following ways: 

• If the server application supports in-place editing, you can double-click the embedded object to edit it right in 
1-2-3. The 1-2-3 menu changes to include commands from the server application.

• If the server application does not support in-place editing, the server application opens when you double-click 
the object and you edit the object in the server application. 

Note To edit embedded OLE objects, you must have the server application installed on your computer.
• You can embed a file from some applications like Freelance Graphics and Screen Cam, and then run a 

presentation or a movie by double-clicking the embedded file.

{button ,AL(`H_SHARING_DATA_USING_OLE2_OVER;H_CREATING_AN_EMBEDDED_OBJECT_STEPS;H_EMB
EDDING_AN_EXISTING_OBJECT_STEPS;H_EDITING_AN_EMBEDDED_OBJECT_STEPS;H_USING_DRAG_
AND_DROP_TO_EMBED_AN_OBJECT_STEPS;H_DRAGGING_A_RANGE_TO_THE_DESKTOP_STEPS;',0)} 
See related topics



Creating an embedded object
You can create an object in one application but embed (store) the object in a 1-2-3 workbook. For example, you can 
embed a Word Pro document in a 1-2-3 workbook. 

To create an embedded object
1. From the Create menu, choose Object. 

2. Under Create new, select "Object."
3. From the "Object type" list, select the type of object that you want to create. 

Note To display the object as an icon representing the other application, select "Display as icon." To select a 
different icon, click Change Icon, select another icon, and click OK. 

4. Click OK. 
5. Click the sheet where you want the top left corner of the object to appear. 

• If the server application supports in-place editing, an object is created and activated, and the server 
application's menus, icons, and toolbars appear in the 1-2-3 window.

• If the server application does not support in-place editing, 1-2-3 opens the server application.
6. Use the server application's menus, icons, and toolbars to edit the object.
7. When you finish, do one of the following:

• If you created the object from within 1-2-3, click anywhere in the sheet to deactivate the embedded object. 
• If you created the object in the server application, exit the application to return to 1-2-3.

1-2-3 displays the embedded object in the sheet.

{button ,AL(`H_CREATING_AN_EMBEDDED_OBJECT_DETAILS',1)} See details
{button ,AL(`H_EMBEDDED_OBJECTS_OVER;H_EMBEDDING_AN_EXISTING_OBJECT_STEPS;H_EDITING_AN

_EMBEDDED_OBJECT_STEPS;H_USING_DRAG_AND_DROP_TO_EMBED_AN_OBJECT_STEPS;H_DRAGGI
NG_A_RANGE_TO_THE_DESKTOP_STEPS;H_SHARING_DATA_USING_OLE2_OVER',0)} See related topics



Details: Creating an embedded object
Editing an embedded object displayed as an icon
If you display the embedded object as an icon, you must edit it out of place. See Editing an embedded object for 
information. 

Placing the embedded object on the sheet
Instead of clicking the sheet to have 1-2-3 place and size the embedded object, you can determine the size and 
position of the embedded object by dragging a box in the sheet. 

{button ,AL(`H_CREATING_AN_EMBEDDED_OBJECT_STEPS',1)} Go to procedure



Using drag and drop to embed an object
You can embed an object from another application into 1-2-3 (and vice versa) provided the other application supports 
this feature. 
1. Open 1-2-3 and the server application and tile the windows so that both are visible.
2. Click the title bar of the server application to make it the active window. 
3. Select the data that you want to embed. 
4. Position the mouse pointer on the border of your selection.
5. Drag the selection to its destination in 1-2-3.
6. Release the mouse button when you reach the destination.

Notes
• You may need to use CTRL with the mouse to drag and drop data outside the server application.
• To drag and drop from 1-2-3 to another application, use this procedure, but select the data in 1-2-3 and drag it to 

the other application.
• If you have trouble using drag and drop to embed an object, copy the data to the Clipboard and use Edit - Paste 

Special. 

{button ,AL(`H_EMBEDDED_OBJECTS_OVER;H_CREATING_AN_EMBEDDED_OBJECT_STEPS;H_EMBEDDING
_AN_EXISTING_OBJECT_STEPS;H_EDITING_AN_EMBEDDED_OBJECT_STEPS;H_DRAGGING_A_RANGE_
TO_THE_DESKTOP_STEPS;H_SHARING_DATA_USING_OLE2_OVER',0)} See related topics



Creating an embedded object from existing data
There are two ways to embed existing data into a 1-2-3 workbook. Use the first procedure to embed an object that 
you copied or cut from another application. Use the second to embed an entire file.

Embedding an object using the Clipboard
1. In the server application, copy or cut the data you want to embed.
2. In 1-2-3, select a location for the embedded object. 
3. From the Edit menu, choose Paste Special.

4. Select "Paste."
5. In the "As" list, select the type of object you want to embed. 

Generally, you should select the first object in the list, which is the server application's native format.
Note To display the embedded object as an icon, select "Display as icon." To select a different icon, click Change 
Icon, select another icon, and click OK. 

6. Click OK.
You see the embedded object in 1-2-3, which appears as an object or as an icon representing the server 
application.

Embedding an object from a file
1. In 1-2-3, choose Create - Object.

2. Under Create new, select "Object from a file."
3. Enter the path and file name, or click Browse to select from the available directories.

Note To display the embedded object as an icon, select "Display as icon." To select a different icon, click Change 
Icon, select another icon, and click OK. 

4. Click OK.
5. Click the sheet where you want the top left corner of the object to appear. 

You see the embedded object in 1-2-3, which appears as an object or as an icon representing the server 
application.

{button ,AL(`H_EMBEDDING_AN_EXISTING_OBJECT_DETAILS',1)} See details
{button ,AL(`H_EMBEDDED_OBJECTS_OVER;H_CREATING_AN_EMBEDDED_OBJECT_STEPS;H_USING_DRA

G_AND_DROP_TO_EMBED_AN_OBJECT_STEPS;H_EDITING_AN_EMBEDDED_OBJECT_STEPS;H_SHARIN
G_DATA_USING_OLE2_OVER;',0)} See related topics



Details: Creating an embedded object from existing data
Placing the embedded object on the sheet
Instead of clicking the sheet to have 1-2-3 place and size the embedded object, you can determine the size and 
position of the object by dragging a box in the sheet. 

Linking to a file
You can create an object linked to an entire file by selecting "Object to file" in the Create Object dialog box. For more 
information, see Creating a linked object from a file. 

{button ,AL(`H_EMBEDDING_AN_EXISTING_OBJECT_STEPS',1)} Go to procedure



Editing an embedded object
You can edit an embedded object in place if the server application supports in-place editing, or out of place if it does 
not. 
1. Double-click the object you want to edit.
2. Edit the object using the menus, icons, and toolbars of the server application. 
3. If you are editing in place, click in the sheet outside the object to complete your edits.
4. If you are editing out of place, you can return to 1-2-3 by choosing one of the following commands.

Note These menu commands may not all be available or may differ slightly in different applications.
• File - Exit & Return closes the source file and the server application and returns to 1-2-3.
• File - Close closes the source file and returns to 1-2-3 while leaving the server application open to make it 

faster to edit other embedded objects.
• File - Update sends the updated data back to 1-2-3 and the source file remains open.

{button ,AL(`H_EDITING_AN_EMBEDDED_OBJECT_DETAILS',1)} See details
{button ,AL(`H_EMBEDDED_OBJECTS_OVER;H_CREATING_AN_EMBEDDED_OBJECT_STEPS;H_USING_DRA

G_AND_DROP_TO_EMBED_AN_OBJECT_STEPS;H_EMBEDDING_AN_EXISTING_OBJECT_STEPS;H_DRA
GGING_A_RANGE_TO_THE_DESKTOP_STEPS;',0)} See related topics



Details: Editing an embedded object
Other ways to begin editing an embedded object
To edit an object in place: 

• Select it and press ENTER.
• Select it, choose the object's name from the 1-2-3 menu (for example, "Document" for a Word Pro embedded 

object), and then choose Edit. 
Note If the embedded object looks like an application's icon, you cannot edit in place.

To edit an object out of place: 
• Select it and press CTRL+ENTER. 
• Select it, choose the object's name from the 1-2-3 menu (for example, "Document" for a Word Pro embedded 

object), and then choose Open. 
Tip You might want to edit out-of-place when you need to print just the data in the embedded object. To edit out-
of-place from 1-2-3, right-click the embedded object and choose Open.

What happens during in-place editing
Even if an application supports most OLE features, it may not support in-place editing. Consult the server 
application's documentation for more information. 
Applications that support in-place editing allow you to edit embedded objects without leaving the container 
application. When you select an embedded object that can be edited in place, the following happens: 

• The commands (except for the File and Window commands), icons, toolbars, and so on, change to that of the 
server application. 

• Icons and toolbars from the server application appear inside the container application's window. 

What happens during out-of-place editing
Applications that do not support in-place editing of embedded objects allow you to edit them in the server application. 
When you edit an object out of place, the following happens:

• The selected object opens in a new window of the server application. 
• In the container application, the object is shaded.
• The object changes as you edit it. In some applications, there is a short delay.

{button ,AL(`H_EDITING_AN_EMBEDDED_OBJECT_STEPS',1)} Go to procedure



Dragging a range to the desktop
You can drag a 1-2-3 range to the desktop to create a scrap, which is an embedded 1-2-3 object with the desktop as 
its container. This data is not linked to the original file.
1. Size the 1-2-3 window so that the desktop is visible.
2. Select a range. 
3. Position the mouse pointer on the border of the range so that the pointer changes to a hand. 

4. Drag the range to the desktop. 
The object appears as an icon with a name beginning with "Workbook Scrap" and followed by characters taken from 
the first row of the cells you selected in 1-2-3. You can double-click the icon to open the 1-2-3 workbook containing 
the data.    

{button ,AL(`H_EMBEDDED_OBJECTS_OVER;H_CREATING_AN_EMBEDDED_OBJECT_STEPS;H_USING_DRA
G_AND_DROP_TO_EMBED_AN_OBJECT_STEPS;H_EMBEDDING_AN_EXISTING_OBJECT_STEPS;',0)} See 
related topics



Overview: Sharing data using DDE
DDE (Dynamic Data Exchange) is a protocol that lets you share data between applications. You use DDE to create 
links between two files created in applications that support DDE. The server (source) file contains the original data 
and the client (destination) file contains the linked data.
This release of 1-2-3 supports DDE links in files from previous versions of 1-2-3 and applications that are only DDE 
enabled.

Why use DDE links in 1-2-3?
Although most applications now use OLE to share data, you may need to link to applications that do not support OLE.
You may also need to work with files from previous versions of 1-2-3 that contain DDE links.
Use DDE links when

• You need to share data with an application that only supports DDE.
• You expect the shared data to change.
• You need to update the shared data when the source data changes.

How to create DDE links in 1-2-3
You can open a file from a previous release of 1-2-3 that already contains DDE links or you can manually create DDE
links.
To manually create DDE links, you can use @DATALINK, or you can use DDE macros and script commands.
Note You cannot use the Edit - Paste Link or Edit - Paste Special commands to create DDE links in this version of 1-
2-3.

What does a DDE link look like?
A DDE link looks like data in the sheet, but the top left cell of the linked range contains an @DATALINK formula. You 
can see this formula if you edit the cell.

What can you do with linked data?
• You can move, copy, or delete a link just as you would a range or a graphic object.
• You can view, edit, update, and break links using Edit - Manage Links. For example, you can edit a link so that it 

refers to a different piece of data in the server application or change a link from automatic to manual. 

DDE and previous releases of 1-2-3
If you open a file containing DDE links from a previous release of 1-2-3, 1-2-3 retains the DDE links but changes how 
the links are implemented.

• In 1-2-3 Release 5, DDE links were implemented using @DDELINK.
• In the current release (1-2-3 Release 9), DDE links are implemented using @DATALINK.

If you open a .WK4 file containing @DDELINK in the current release of 1-2-3, 1-2-3 converts the formula to 
@DATALINK and maintains the DDE link.
For more information, see 

Working with 1-2-3 for Windows files 
Working with 1-2-3 for OS/2 files

{button ,AL(`;H_123_AS_A_DDE_CLIENT_OVER;H_123_AS_A_DDE_SERVER_OVER;H_123_CREATING_DDE_L
INKS_STEPS;H_123_DDE_AND_OLE_MACRO_COMMANDS_REF',0)} See related topics



Creating DDE links
In this version of 1-2-3 you can manually create a DDE link. 

To manually create a DDE link
• Enter an @DATALINK function with appropriate arguments in the sheet.

For more information, see @DATALINK. 
• Use the DDE and LINK macro commands.

For more information, see Help on macro commands. 
• Use the DDE script commands.

For more information, look up "DDELink class" in 1-2-3 LotusScript A-Z.    

Notes
In this version of 1-2-3, you cannot use the Edit - Paste Link or Edit - Paste Special commands to create DDE links.
You cannot create DDE links between 1-2-3 workbooks, but you can create formula links.

{button ,AL(`H_123_AS_A_DDE_CLIENT_OVER;H_123_AS_A_DDE_SERVER_OVER;H_123_DDE_AND_OLE_M
ACRO_COMMANDS_REF;H_123_DDE_OVER;H_REFERRING_TO_OTHER_FILES_IN_FORMULAS_STEPS',0
)} See related topics



1-2-3 as a DDE client
1-2-3 supports DDE as a client application. The following technical information about 1-2-3 client support may be of 
interest if you are an advanced DDE user.

Clipboard formats
1-2-3 supports the following Clipboard formats as a client: Text, .WK1, and .WK3.

DDE control settings
The following settings control how 1-2-3 works as a DDE client. These settings are stored in the registry and are 
accessible using LotusScript. For more information, see Overview: Using LotusScript. 

Setting Description
AutoStartTimeOut Whether to automatically launch the 

server application when creating a 
linkH_GLLIN or updating an inactive link 
if there is no response to the DDE-Initiate
message. Default setting: 15000 
(automatically launch the server, wait up 
to 15 seconds for startup to finish)

ExecTimeOut Time in milliseconds to wait for the server
application to answer a DDE-Execute 
message. Default setting: 30000

AdviseTimeOut Time in milliseconds to wait for the server
application to answer a DDE-StartAdvise 
message. Default setting: 10000

PokeTimeOut Time in milliseconds to wait for the server
application to answer a DDE-Poke 
message. Default setting: 10000

ReqTimeOut Time in milliseconds to wait for the server
application to answer a DDE-Request 
message. Default setting: 10000

TermTimeOut Time in milliseconds to wait for the server
application to answer a DDE-Terminate 
message. Default setting: 15000

How AutoStartTimeOut works
1-2-3 concatenates the application name with the topic name and attempts to launch the application. The following 
two things must be true for this to work:

• The application's name must match the .EXE file name.
• The directory containing the application's .EXE file must be in the path.

{button ,AL(`H_123_AS_A_DDE_SERVER_OVER;H_123_GLOSSARY_OF_DDE_TERMS_OVER;H_123_DDE_OV
ER',0)} See related topics



1-2-3 as a DDE server
1-2-3 supports DDE as a server application. The following technical information about 1-2-3 server support may be of
interest if you are an advanced DDE user.

Clipboard formats
1-2-3 supports the following Clipboard formats as a server: Text, .WK3, and .WK1.

The System topic
1-2-3 supports a special topic called System, which provides a context for items of information that may be of general
interest to other applications. The System items that 1-2-3 supports are listed below.
1-2-3 responds to a request for any of these items in tab-delimited text format. Each string ends with carriage-return 
and linefeed characters, for example, \r\n.
The system topic contains the following items.

Item Return Value
SysItems A list of all System topic items supported 

by 1-2-3.
Topics A list of all 1-2-3 DDE topics, including all

files in memory plus the System topic.
Formats A list of formats: Text, .WK3, and .WK1. 

This list does not distinguish between 
formats that can be only copied or only 
pasted and formats that can be both 
copied and pasted.

Selection The address of the currently selected 
range or the name of the currently 
selected object. If no range or object is 
selected, this is the current cell pointer 
location, preceded by the current file 
name.

RangeNames A list of named ranges in the current 
(active) file. Tab characters separate 
each range, and CRLF characters 
precede each new file name.

Status The current state of 1-2-3, either "Ready"
or "Busy."

DDE execute strings
The format for execute strings sent to 1-2-3 is

[run(command-string)]
where command-string is any 1-2-3 command, including macros.
For example,

This string Executes a 
[run(/dfa1..c10~~~~)] 1-2-3 Classic menu command
[run({EDIT-COPY a1..c10})] 1-2-3 macro command
[run({pasteit})] Macro named pasteit

Note This release of 1-2-3 no longer supports strings that reference the WYSIWYG menu commands.

DDE control settings in the registry
The ServerOff setting controls whether 1-2-3 will respond as a DDE server. The default setting is FALSE (server 
support is on).
The ServerName setting lets you change the DDE application name. The 1-2-3 default DDE application name is 
"123W."



{button ,AL(`H_123_GLOSSARY_OF_DDE_TERMS_OVER;H_123_DDE_OVER;H_123_AS_A_DDE_CLIENT_OVE
R',0)} See related topics



Glossary of DDE terms
Application The name of the server application for a 

DDE link, for example, Word Pro.
Automatic link A link that automatically updates data in 

the client application when the data in 
the server application changes.

Client The application that requests data from 
or sends instructions to be carried out by 
a server application.

Clipboard format One of a number of standard formats for 
the exchange of data between 
applications, for example, Text format.

DDE Dynamic Data Exchange, a standard for 
data exchange between applications.

Item The specific region or piece of data for a 
link, for example, a Word Pro bookmark.

Link A connection between data in one 
application (the server) and another 
application (the client).

Manual link A link that does not automatically update 
data in the client application when the 
data in the server application changes.

Server The application that provides data to or 
receives instructions from a client 
application.

Topic Either the name of the file in the server 
application or a special topic supported 
by the server application, for example, 
"SALES.WK4" or "System."



Installing Help on LotusScript
Help on LotusScript is not automatically installed when you install 1-2-3. To install the LotusScript Help files, you must
use a customized install.
Tip Print this topic so you can refer to these instructions while running Install. (Install requires that you exit from 1-2-3 
if it is open.)
1. Insert the 1-2-3 or SmartSuite Install CD-ROM or first disk in the disk drive.

If you install 1-2-3 over a network, open the directory containing the Install program.
2. Choose Start - Run, type x:\install.exe (where x is the drive containing the Install disk), and click OK. 

The installation program begins. Answer all initial questions asked.
3. In the Install Options dialog box, select "Customize features - Manual install," and then click Next.
4. In the "Select 1-2-3 Features to Customize" dialog box, select 1-2-3 and click Customize.
5. Click the Help and Samples tab, and select "1-2-3 LotusScript Help."
6. Deselect all other choices from all other tabs and then click OK.
7. In the "Select 1-2-3 Features to Customize" dialog box, select Approach and click Customize.
8. Deselect all choices from all tabs and then click OK.

Note Deselecting Approach options prevents you from installing or reinstalling Approach program files.
9. Click Next to continue, finish answering all other installation questions, and then click Yes to copy your files.
If you need additional Help while installing the files, click Help in the Install dialog boxes.



Overview: Using LotusScript
LotusScript is a structured programming language that lets you automate tasks in 1-2-3, as well as customize Lotus 
products and work with them more effectively. 
Because LotusScript uses the same development environment as other SmartSuite applications and Lotus Notes, 
you can create, debug, and run scripts in 1-2-3 and across other applications such as Freelance Graphics, Word Pro,
and Lotus Notes. LotusScript is compatible with Visual Basic. 

Accessing LotusScript Help
Help on LotusScript is not automatically installed by the Install program. To install the LotusScript Help files, you must
use a customized install. For details, see Installing Help on LotusScript.
Once you install LotusScript Help, you can click the topics below for more information:
LotusScript Index
1-2-3 LotusScript A - Z
1-2-3 Classes
1-2-3 Events
1-2-3 Methods
1-2-3 Properties
Chart Classes
Chart Methods
Chart Properties



Details: Recording a script
Actions you cannot record
1-2-3 does not record any of the following:

• Macro commands
• Keystrokes and mouse actions you perform in the Script Editor, Script Debugger, or Dialog Editor
• Keystrokes and mouse actions you perform while a script is running

Using relative ranges
1-2-3 uses absolute range addresses when it records scripts. You can change these to relative ranges in the 
recorded script by using the Range method.

Naming scripts
You must specify a name for the script in the "Script name" box. If you do not specify a name for the script, you 
cannot continue.
The name you give a script must be a valid LotusScript subroutine name.

Using the recording controls
When you click Record in the Record Script dialog box, 1-2-3 displays recording controls you can use to stop, pause, 
and restart recording.
Click the red Stop button to stop recording and display the Script Editor. 

Click the yellow Pause button to temporarily stop recording. To resume recording, click the Pause button again.

You can move the recording controls by dragging them.

Storing recorded scripts
You can store the recorded script in any active workbook. Select an active workbook from the list under "Record 
script into." 

Related SmartIcons

Stops recording

Runs a script

Displays the Script Editor

{button ,AL(`H_123_RECORDING_A_SCRIPT_STEPS',1)} Go to procedure



Recording a script
You can record keystrokes and mouse actions into a script.
1. Choose Edit - Scripts & Macros - Record Script.

2. Type a name in the "Script name" box.
3. Select a workbook in which to store the recorded script.
4. Click Record.
5. Perform the task you want to record.
6. To stop recording and display the recorded script in the Script Editor, choose Edit - Scripts & Macros - Stop 

Recording.

{button ,AL(`H_123_RECORDING_A_SCRIPT_DETAILS',1)} See details
{button ,AL(`H_123_TURNING_RECORDING_OFF_STEPS;H_123_RUNNING_A_SCRIPT_STEPS;',0)} See related

topics



Running a script
Follow these steps to run a script from the Run Scripts & Macros dialog box.
1. Choose Edit - Scripts & Macros - Run.

2. Select the "Script" option.
3. Select the name of a script to run from the "Script name" list.
4. If the script you want to run is not listed, select the name of another active file from the "From" box.
5. Click Run.

{button ,AL(`H_123_RUNNING_A_SCRIPT_DETAILS',1)} See details
{button ,AL(`H_RUNNING_A_MACRO_STEPS;H_123_RUNNING_A_SCRIPT_STEPS;H_123_SETTING_GLOBAL_

OPTIONS_STEPS;H_123_RECORDING_A_SCRIPT_STEPS;',0)} See related topics



Details: Running a script
Other ways to run a script
To attach a script to the Actions menu, or to assign a script to a keyboard shortcut, choose Edit - Scripts & Macros - 
Global Script Options.
To run a script that is attached to the Actions menu, choose Actions and then choose the name of the script you want 
to run. 
To run a script from a keyboard shortcut, press the keyboard shortcut assigned to the script. For example, to run a 
script named Int_Rates that has been assigned to the keyboard shortcut CTRL+I, press CTRL+I.

Using 1-2-3 while a script is running
While a script is running, you can't do anything else in 1-2-3 unless the script contains a Yield statement.

Related SmartIcons

Records a script

Stops recording a script

Displays the Script Editor

{button ,AL(`H_123_RUNNING_A_SCRIPT_STEPS',1)} Go to procedure
{button ,AL(`H_123_CREATING_A_BUTTON_STEPS;LSAZ_YIELD_FUNCTION_AND_STATEMENT;H_123_SETTI

NG_GLOBAL_SCRIPT_OPTIONS_STEPS',0)} See related topics



Setting global script options
You can make it easier for users to run a script by attaching it to the Actions menu or to a keyboard shortcut.
1. Choose Edit - Scripts & Macros - Global Script Options.
2. Select the name of a script to run from the "Scripts" list.
3. If the script you want to edit is not listed, select the name of another active file from the "Edit options for script 

from" list.
4. Click "Edit Options."
5. To attach the script to the Actions menu, enter the name of the command you want to run the script in the "Menu 

command on Actions menu" box.
6. (Optional) Enter a description of the script in the "Help text for menu command" box.
7. To assign the script to a keyboard shortcut, enter a letter in the "Ctrl+" box.
8. Click OK.

{button ,AL(`H_123_SETTING_GLOBAL_SCRIPT_OPTIONS_DETAILS',1)} See details
{button ,AL(`H_ACTIONS_MENU_REF;H_123_RUNNING_A_SCRIPT_STEPS',0)} See related topics



Details: Setting global script options
Assigning scripts to the Actions menu
Keep the following in mind when you attach scripts to the Actions menu:

• A script appears on the Actions menu only when the workbook it is stored in is in memory.
• When you highlight the command in the Actions menu, the corresponding Help text appears in the title bar.
• You can attach only Subs that have no parameters to the Actions menu.
• If you delete a script in the Script Editor, 1-2-3 automatically removes the entry from the Actions menu and deletes

the keyboard shortcut assigned to it.
• If you make any changes to a script in the Script Editor, 1-2-3 checks to see if it is still valid for Actions menu 

assignment. If the script is invalid, 1-2-3 automatically removes the entry from the Actions menu.
For example if you add parameters to a global sub that appears on the Actions menu, 1-2-3 automatically 
removes the sub from the Actions menu.

Assigning scripts to keyboard shortcuts
Keep the following in mind when you attach scripts to keyboard shortcuts::

• 1-2-3 stores keyboard shortcuts with the workbook their corresponding scripts are stored in. Keyboard shortcuts 
are enabled only when the workbook they are stored in is the current workbook.

• Keyboard shortcuts you assign to scripts take precedence over built-in 1-2-3 keyboard shortcuts. For example, in 
1-2-3, Ctrl+X is the keyboard shortcut that cuts the current selection to the Clipboard. However, if you assign a 
script to Ctrl+X, pressing Ctrl+X runs the script instead of cutting the current selection.

• You can only specify letters as shortcut keys. Do not use numbers, spaces, or punctuation characters.
• If you try to assign a script to a keyboard shortcut that is already assigned to a macro or another script, 1-2-3 

displays a message that lets you cancel or continue the assignment.
• If you choose to continue, and the keyboard shortcut is already assigned to a macro, the keyboard shortcut 

takes precedence over the backslash macro name. When you press the keyboard shortcut, 1-2-3 runs the 
script, not the macro.

• If the keyboard shortcut is already assigned to a script, do not assign it to another script. Unexpected results 
may occur when you press a keyboard shortcut that is assigned to more than one script.

Assigning scripts to both menus and keyboard shortcuts
You can assign a script to both the Actions menu and a keyboard shortcut.

{button ,AL(`H_123_SETTING_GLOBAL_SCRIPT_OPTIONS_STEPS',1)} Go to procedure



Details: Turning recording off
Other ways to turn recording off
If the Script Editor is open, you can turn recording off by choosing Script - Stop Recording from the Script Editor main 
menu.

Related SmartIcons

Records a script
{bmlsstartq.bmp} Turns recording off

{button ,AL(`H_123_TURNING_RECORDING_OFF_STEPS',1)} Go to procedure



Turning recording off
To turn recording off when you finish performing the task you want to record choose Edit - Script & Macros - Stop 
Recording.

{button ,AL(`H_123_TURNING_RECORDING_OFF_DETAILS',1)} See details
{button ,AL(`H_123_RECORDING_A_SCRIPT_STEPS',0)} See related topics



Overview: Info components
Info components store information about the current 1-2-3 session.
For example, Worksheet-Background-Color info component stores the number that identifies the color of the current 
worksheet.

Types of info components
There are three types of info component values: Number, Text, and Range.

• For Number, use a numeric formula, or the range name or address of a cell that contains a number or numeric 
formula.

• For Text, use any text enclosed in " " (quotation marks), a text formula, or the range name or address of a cell that
contains a label or text formula.
For some Text info components, you can specify any text. In this case, you want 1-2-3 to use the text literally, that 
is, exactly as you specify it.
For other Text info components, you must use specific text. For example, the Print-Grid-Lines Info component 
specifies whether to print grid lines. The value of Print-Grid-Lines can be yes or no.

• For Range, use a range name or address, or any formula that evaluates to a range name or address.

Using info components
• In some macro commands, when you omit an optional argument, 1-2-3 uses the current value of an info 

component in place of the omitted argument.
For example, if you omit the range argument in {SORT}, 1-2-3 sorts the data in the range specified by the Data-
Sort-Range info component.

• You can set an info component to a particular value by using the {SET} macro command.
For example, {SET "worksheet-format";"currency"} sets the default number format to Currency.
Note Changing an info Component value does not cause 1-2-3 to recalculate, even if you set recalculation to 
Automatic.

• You can find out the value of an info component by using @INFO.
For example, @INFO("setup-undo") returns YES if Edit - Undo is on or NO if Edit - Undo is off.

{button ,AL(`H_M_INFO_FILE;H_M_INFO_MAPS;H_M_INFO_PRINT;H_M_INFO_PRINTER;H_M_INFO_SORT;H_
M_INFO_US;H_M_INFO_WIN;H_M_INFO_SWD;H_M_INFO_OBSOLETE_OVER',0)} See related topics



File info components
Store information about a document.

Component name Type Definition
Document-Comments Text Comments about the file, up to 256 

characters
Document-Keywords Text File keywords, up to 256 characters
Document-Revisions Text Notes about file revisions, up to 512 

characters
Document-Subject Text Subject of the file, up to 256 

characters
Document-Title Text Title of the file, up to 256 characters
File-Reserve-Automatically manual, 

automatic
Whether to ask for the file reservation 
automatically when opening a file, or 
to ask for it manually

{button ,AL(`H_M_INFO_OBSOLETE_OVER;H_M_INFO_C',0)} See related topics



Mapping info components
Store information about automatic or manual redrawing of maps.

Component name Type Definition
Map-Draw automatic, manual Whether to redraw maps automatically 

when data in the data range changes or 
to redraw them manually

{button ,AL(`H_M_INFO_OBSOLETE_OVER;H_M_INFO_C',0)} See related topics



Print info components
Store information about print settings. The info components for printing correspond to the arguments of the {PRINT} 
macro command.

Component name Type Definition
Print-Beginning-Page-Number Number Page number with which to start 

numbering in headers and footer
Print-Centered horizontal, 

vertical, both, 
clear

Centers a print range on the page

Print-Drawn-Objects no, yes Whether to print charts and other 
graphic objects

Print-Fit-Page no, yes Whether to shrink what you print to 
fit a single page

Print-Footer-Center-Text Text Center text in footer
Print-Footer-Left-Text Text Left text in footer
Print-Footer-Right-Text Text Right text in footer
Print-Grid-Lines no, yes Whether to print grid lines
Print-Header-Center-Text Text Center text in header
Print-Header-Left-Text Text Left text in header
Print-Header-Right-Text Text Right text in header
Print-Margin-Bottom Number Bottom margin height, in inches
Print-Margin-Left Number Left margin width, in inches
Print-Margin-Right Number Right margin width, in inches
Print-Margin-Top Number Top margin height, in inches
Print-Orientation landscape, 

portrait
Whether to print in portrait or 
landscape mode

Print-Range Range or 
Collection

Range or collection to print

Print-Size actual, fit-all, fit-
columns, fit-
rows, fill-page, 
fill-page-in-
proportion

What type of print compression, if 
any, to use

Print-Size-Manual Number Manually specifies a print 
compression percentage

Print-Titles-Clear columns, rows Clears row or column titles
Print-Titles-Column-Range Range Range that contains column titles
Print-Titles-Row-Range Range Range that contains row titles
Print-Worksheet-Frame no, yes Whether to print the sheet frame

{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



Printer Setup info components
Store information about a printer's properties.

Component name Type Definition
Printer-Setup-Bins Text Default paper bin from 

the Paper Source box 
in your printer's 
Properties dialog box

Printer-Setup-Copies Number Number of copies to 
print

Printer-Setup-Name Text Name of a printer
Printer-Setup-Paperlength Number The paper length, in 

either inches or 
millimeters; overrides 
Printer-Setup-
Papersize

Printer-Setup-Paperwidth Number The paper width, in 
either inches or 
millimeters; overrides 
Printer-Setup-
Papersize

Printer-Setup-Papersize Text Paper size from the 
Paper Size list in your 
printer's Properties 
dialog box

Printer-Setup-Quality high, medium, 
low, draft

Print resolution

{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



Sort info components
Store information about a database sort. The info components for sorting correspond to the arguments of the {SORT}
and {SORT-KEY-DEFINE} macro commands.

Component name Type Definition
Data-Sort-Direction[n] descend, 

ascend
Direction in which to sort the data 
according to Data-Sort-Key[n]

Data-Sort-Key[n] Range Contains nth sort key
Data-Sort-Range Range Contains data you want to sort

Note n is a value from 1 through 255 that specifies a sort key or sort direction.

{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



User Setup info components
Store information about settings that affect the display and behavior of 1-2-3 in the current and future sessions. 

Component name Type Definition
Setup-Autoexec no, yes Whether to run 

autoexecute 
macros (\0 
macros)

Setup-Beep no, yes Whether to beep 
on error

Setup-Drag-And-Drop no, yes Whether to use 
drag and drop

Setup-File-Link-Update manual, 
automatic

Whether to update
file links manually 
or automatically

Setup-International-Currency-Default Text Default currency 
format

Setup-International-Currency-Position prefix, suffix Whether the 
currency symbol 
appears before or 
after the number

Setup-International-Currency-Symbol Text Text for the 
currency symbol

Setup-International-Negative-Values parentheses, 
minus-sign

Whether negative 
numbers appear in
parentheses or 
with a minus sign

Setup-International-Text country, 
international

Sets the character 
translation table 
that 1-2-3 uses 
when combining 
and creating text 
files

Setup-International-WK1 LICS, ASCII Sets the way 1-2-3
reads and saves 
characters in 1-2-3
for DOS Release 2
files

Setup-Recalculate manual, 
automatic

How 1-2-3 
recalculates 
formulas

Setup-Recalculate-Iterations Number Number of 
recalculation 
iterations (from 1 
through 50)

Setup-Recalculate-Order natural, 
columns, rows

Formula 
recalculation order

Setup-Recent-Files-Number Number Number of recent 
files to show in the
File menu (from 0 
through 5)

Setup-Skip-Smartmasters no, yes Whether to display
the New File 
dialog box when 
starting 1-2-3

Setup-Skip-Welcome no, yes Whether to display
the Welcome 



dialog box when 
starting 1-2-3

Setup-Undo no, yes Whether to enable
Undo

Setup-Worksheet-Directory Text Sets the default 
directory 

{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



Window info components
Store information about view preferences and various mouse actions.

Component name Type Definition
Window-Custom-Zoom Number Sets the percent for 

View Zoom to Custom 
Level for the current file

Window-Display-Drawn-Objects no, yes Whether to display 
charts and other graphic
objects in the current 
file

Window-Display-Edit-Line no, yes Whether to display the 
edit line in 1-2-3

Window-Display-Frame no, yes Whether to display the 
sheet frame in the 
current file

Window-Display-Grid-Lines no, yes Whether to display grid 
lines in the current file

Window-Display-Page-Breaks no, yes Whether to display page
breaks in the current file

Window-Display-Scroll-Bars no, yes Whether to display 
scroll bars in the current
file

Window-Display-SmartIcons no, yes Whether to display 
SmartIcons in 1-2-3

Window-Display-Status-Bar no, yes Whether to display the 
status bar in 1-2-3

Window-Display-Tabs no, yes Whether to display 
sheet tabs in the current
file

Window-Height Number Sets the height of the 
current window, in 
pixels

Window-Split clear, horizontal, 
vertical

How to split the current 
window

Window-Split-Height Number Sets the height of the 
current pane, in pixels

Window-Split-Synchronize no, yes Whether to synchronize 
scrolling in panes

Window-Split-Width Number Sets the width of the 
current pane, in pixels

Window-Width Number Sets the width of the 
current window, in 
pixels

Window-X-Position Number Sets the horizontal 
position, in pixels, 
measured from the left 
side of the 1-2-3 
window to the left side 
of the current window

Window-Y-Position Number Sets the vertical 
position, in pixels, 
measured from the top 
of the 1-2-3 window to 
the top of the current 
window



{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



Worksheet Defaults info components
Store information about default settings.

Component name Type Definition
Worksheet-Align-Text left, right, center How to align data in a 

cell horizontally
Worksheet-Background-Color Number Default cell background

color (0 through 255)
Worksheet-Column-Width Number Default column width
Worksheet-Display- Windows-Defaults no, yes Controls whether 1-2-3 

uses Windows default 
colors for display; this 
setting has no effect on
your print colors, which 
always come from the 
sheet's text and 
background colors

Worksheet-Font Text Default typeface
Worksheet-Font-Size Number Default point size
Worksheet-Format comma, 

currency, fixed, 
general, label, 
percent, 
scientific, text, 
date-short-
international, 
date-long-
international, 
dd-mmm, dd-
mmm-yy, mmm-
yy, hh:mm 
am/pm, 
hh:mm:ss 
am/pm, time-
long-
international, 
time-short-
international

Default number format

Worksheet-Format-Color- Negatives no, yes Whether to display 
negative numbers in 
red

Worksheet-Format-Decimals Number Default number of 
decimal places

Worksheet-Format-Display-Zeros show, blank Whether to display 
zeros in cells that 
contain the number 0 
or formulas that 
evaluate to 0

Worksheet-Format-Parentheses no, yes Whether to enclose all 
new values in 
parentheses

Worksheet-Format-Zero-Text Text Label to display in 
place of zeros in cells 
that contain the number
0 or formulas that 
evaluate to 0

Worksheet-Grid-Color Number Default grid-line color 



(0 through 255)
Worksheet-Group-Sheets no, yes Whether to turn Group 

mode on or off for the 
current file

Worksheet-Row-Height Number Default row height
Worksheet-Tab-Color Number Color of the tab for the 

current sheet
Worksheet-Text-Color Number Default text color (0 

through 255)

Note Setting the default text or background color for the current sheet also sets the Worksheet-Display-Windows-
Defaults component to "no".
If you want to write a macro that displays the Windows default colors, but prints in another color, set the Worksheet-
Format-Text and Worksheet-Format-Background components first, and then set the Worksheet-Display-Windows-
Defaults component to "yes".

{button ,AL(`H_M_INFO_C;H_M_INFO_OBSOLETE_OVER',0)} See related topics



What's different in info components
Some info components work differently in the current release of 1-2-3 than in previous releases of 1-2-3, as described
below.

Read-only info components
The following info components are read-only in the current release of 1-2-3. You can use them with @INFO to obtain 
information about a 1-2-3 session, but you cannot use them with the {SET} command to change settings. Using these
info components with the {SET} command has no effect in the current release.

Setup-International-Currency-Default
Setup-International-Currency-Position
Setup-International-Currency-Symbol
Setup-International-Negative-Values

Obsolete info components
The following info components are not supported in the current release of 1-2-3. Using these info components with 
@INFO causes the @INFO formula to evaluate to NA. Using these info components with the {SET} command has no
effect in the current release.

Setup-Autoformat
Setup-Autosave
Setup-Autosave-Interval
Setup-International-Currency-Display
Setup-International-Date
Setup-International-Separators
Setup-International-Time
Window-Display-Frame-Type

{button ,AL(`H_M_INFO_C',0)} See related topics



Presenting data in a map
This task consists of the following parts:    

 Introducing maps in 1-2-3

 Setting up map data 

 Creating a map 

 Modifying a map 

Introducing maps in 1-2-3
You can use a map in 1-2-3 to present data about recognizable geographic regions such as states or countries in a 
form that's visually interesting and easy to understand. For example, you can use a map to display sales information 
for each country in the world. 
The map below uses color to indicate each country's level of sales. It also uses patterns to identify the sales office 
related to the country.    

How 1-2-3 maps the data
First, 1-2-3 checks the region names or codes in the map data range to determine which map to use. 

Showing data with colors and patterns
Next, 1-2-3 evaluates the data to determine how to color or pattern the map. 1-2-3 maps the first range of data with 
up to six colors. If there is a second data range, this range appears as up to six patterns applied to the same map 
regions. Color and pattern ranges may contain either values or labels.    

More than six values are grouped in bins
When a data range contains more than six values, the map groups the data into six categories, called bins, and 
shows each bin with a separate color or pattern on the map.

Pin characters mark locations
You can include a third set of data to mark one or more locations in the map region with a symbol, like P, or a label, 
like "World Headquarters." These symbols or labels are called pin characters.



Additional information
For additional information about map data and mapping software, contact:

ESRI
380 New York Street
Redlands, CA 92373-8100
1-800-GIS-XPRT (1-800-447-9778)
1-909-793-2853 extension 1235
www.esri.com

{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example
{button ,AL(`H_NAMING_A_MAP_STEPS;H_REDRAWING_MAPS_STEPS;',0)} See related topics



Presenting data in a map
This task consists of the following parts:    

 Introducing maps in 1-2-3

 Setting up map data 

 Creating a map 

 Modifying a map 

Setting up map data
You specify the data you want to map in columns. Each column can contain only one kind of data: region names or 
map codes, values or labels, or pin character information (symbol or label, latitude, longitude, or color values).
1. Enter the region names or map codes    in the leftmost column.
2. Enter the data to be mapped with color for each region name or code in the second column.
3. Enter the data to be mapped with patterns for each region name or code in the third column.
4. Enter the pin character, latitude, longitude, and (optionally) color in subsequent columns.

Note It is usually easier to add pin characters to a map after you create it because you can point to the map to 
determine the latitude and longitude.

{button ,AL(`H_SETTING_UP_MAP_DATA_DETAILS',1)} See details
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example
{button ,AL(`H_123_DETERMINING_LATITUDE_AND_LONGITUDE_STEPS;H_ADDING_PIN_CHARACTERS_TO_

A_MAP_STEPS;H_CHANGING_RANGE_ASSIGNMENTS_STEPS;H_CHANGING_COLOR_AND_PATTERN_BI
N_VALUES_STEPS;H_CHANGING_THE_TITLE_STEPS;H_CHANGING_THE_LEGEND_LABELS_STEPS',0)} 
See related topics



Details: Setting up map data
Entering map codes
The left column of the selected range must contain the region name or map code for each location. For example, you 
can use either the region name "Massachusetts" or the map code "MA" to represent that U.S. state; similarly, you can
use either the region name "Tokyo" or the map code "13" to represent that Japanese prefecture. 1-2-3 uses these 
region names and map codes to link regions in the map to rows of data in the range.

Entering data for each region
It's best to place the data you want to map in the column(s) immediately to the right of the map codes. This data can 
be labels or values.
The way 1-2-3 maps the data depends on the type of data and the number of different entries in the range:

• If the color or pattern range contains labels, each label corresponds to a different color or pattern on the map. 1-2-
3 can display colors or patterns for up to six different labels.

• If the color or pattern data range contains six or fewer different values, each value corresponds to a color on the 
map.

• If the color or pattern data range contains more than six different values, 1-2-3 groups the values into six 
categories, called bins, and shows each bin with a separate color or pattern on the map.

Entering pin characters
Pin characters can highlight particular locations or areas of a map. Because you must specify the latitude and 
longitude at which you want the pin character to appear, it is easier to add the pin characters after you create the 
map. If you know the coordinates, you can specify pin characters before you create the map. A pin character can be 
either either a label or a graphic symbol. 

{button ,AL(`H_SETTING_UP_MAP_DATA_STEPS',1)} Go to procedure
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example



Presenting data in a map
This task consists of the following parts:    

 Introducing maps in 1-2-3

 Setting up map data 

 Creating a map 

 Modifying a map 

Creating a map
Before you can create a map, you should set up data in a range containing at least two columns.

 Show me a QuickDemo
1. If you have not yet done so, complete part 2 of this task.
2. Select the range containing the map data, or select a single cell within the range.

Do not include column headings in the range you select.
3. From the Create menu, choose Map.

4. Click the sheet where you want the top left corner of the map to appear.
If 1-2-3 cannot determine what type of map to use, the Map Types dialog box appears. Select a map type and 
click OK.
If 1-2-3 cannot identify a region you specified, the Region Check dialog box appears so you can check the 
unrecognized region name against the official 1-2-3 list of names and codes. 

Tip Right-click the map to display the shortcut menu for working with maps. For example, once you create a map, 
you can learn the name and map code of a specific region by right-clicking the region in the map.

{button ,AL(`H_CREATING_A_MAP_DETAILS',1)} See details
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example
{button ,AL(`H_ADDING_PIN_CHARACTERS_TO_A_MAP_STEPS;H_CHANGING_RANGE_ASSIGNMENTS_STE

PS;H_CHANGING_COLOR_AND_PATTERN_BIN_VALUES_STEPS;H_CHANGING_THE_TITLE_STEPS;H_CH
ANGING_THE_LEGEND_LABELS_STEPS',0)} See related topics



Details: Creating a map
Specifying the map location
You can click a single cell to position the map in the sheet, or click and drag a rectangle.

• If you click a single cell, 1-2-3 creates a default-sized map. The upper left corner of the map appears in the cell 
you clicked.

• If you click and drag, 1-2-3 displays a bounding box that lets you position and size the map. The map appears 
when you release the mouse button, and the bounding box becomes the map frame. The map plot area is sized 
within the frame as large as possible, while maintaining the proper aspect ratio for the map and allowing space for
the title and legend. 
Tip To align the map frame to the sheet grid lines, SHIFT+CTRL+drag to size the map.

Changing how 1-2-3 links data to the map
You can change the way that 1-2-3 links data to the map by using the Ranges tab in the InfoBox for maps. For 
example, you can display the range currently shown with colors with patterns instead. For more information, see 
Changing map range assignments. 
To change the way 1-2-3 defines the bins, use the Colors or Patterns tab in the InfoBox for maps. See Changing bin 
definitions for colors or patterns. 

{button ,AL(`H_CREATING_A_MAP_STEPS',1)} Go to procedure
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example



Example: Setting up map data and creating a map
A map lets you relate data in a range to recognizable geographic regions such as states or countries.

Specifying the map data
Suppose you want to illustrate sales figures in Canada for Caleb's Canoes. 

• List the Canadian provinces in which the canoes are sold in column A.
• List the amounts sold in those provinces in column B. 
• List the region to which each office belongs in column C. 
• Specify pin character information in columns D, E, F, and G to locate the corporate headquarters office and the 

office that sold the most canoes. (You can also add the pin characters after you create the map.)

Creating the map
Once you have entered the data, you can create the map.

Interpreting the map
The map reflects the data you entered:

• Provinces (column A) -- Because you entered only Canadian provinces, 1-2-3 shows a map of Canada and 
distinguishes its provinces.

• Sales (column B) -- This data is represented in the map by color. 1-2-3 grouped the data into six categories, 
called bins, and then colored each country according to bin. For example, every province that sold 6,000 or fewer 
canoes is colored red.

• Area (column C) -- This data is represented in the map by pattern. For example, 1-2-3 shows all provinces 
belonging to the Western office with straight vertical lines.

• Flag and Location (columns D-G) -- The pin characters you specify in column D appear in the locations you 
specify in columns E and F. You can determine the color of the pin character by entering a value in column G.

In addition to the data you enter, 1-2-3 provides some additional information to help you interpret the map:
• Title -- 1-2-3 assigns a default title to the map. You can easily change this title to be more meaningful to you.



• Legend -- The legend explains the colors and patterns that appear in the map. You can change the colors, 
patterns, and legend labels.

{button ,AL(`H_123_DETERMINING_LATITUDE_AND_LONGITUDE_STEPS;H_ADDING_PIN_CHARACTERS_TO_
A_MAP_STEPS;H_CHECKING_MAP_REGIONS_STEPS',0)} See related topics



Checking unrecognized region names
If 1-2-3 cannot find a match for a region name or map code in the data range, the Region Check dialog box displays 
the unrecognized name or code and its cell address. This dialog box can appear when you are creating a map or 
when you change the data for an existing map.
You can change the unrecognized region name to one that 1-2-3 recognizes, add the name or code as a custom 
name, or not include the unrecognized region in the map.
1. In the "Region list type" list, select the kind of list you want to work with (Names, Codes, or Custom Names).
2. In the "Known map region" list, select the recognized name or code that corresponds to the unrecognized label in 

the map data range.
3. Select either "Replace in cell with" or "Add as Custom Name for."
4. Click OK to implement your choice, or click Skip or Skip All if you don't want to include the unrecognized region in 

the map.
Tip If you are unsure of the correct region name, skip it and create the map. Then you can right-click the region in
the map to see the region name in the shortcut menu. When you enter the correct region name in the data range, 
1-2-3 automatically adds the data to the map.

1-2-3 repeats this procedure until all unknown labels in the map data range have been replaced, skipped, or defined 
as custom names.
Note If you decide not to create the map, click Cancel.

{button ,AL(`H_CHECKING_MAP_REGIONS_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_MAP_STEPS;H_SETTING_UP_MAP_DATA_STEPS;H_DELETING_OBJECTS_STE

PS',0)} See related topics



Details: Checking unrecognized region names
Recognizing standard region names or codes
When you choose Map - Create, 1-2-3 reads each label in the leftmost column of the map data range and compares 
it to the list of region names, codes, and custom names for the map type. When it encounters a name or code it does 
not recognize, 1-2-3 displays the Region Check dialog box and lists the first unknown map region in "Unknown map 
region."

Options: Region Check dialog box
Using Map -- Specifies the type of map being created. Either 1-2-3 automatically determined the map type based on 
the region names or codes you entered, or you selected the map type on the Map Types dialog box.
Checking -- Specifies the cell address of the region name or code that 1-2-3 could not recognize.
Unknown map region -- Specifies the region name or code that 1-2-3 could not recognize.
Replace in cell with -- Replaces the label in the map data range with the item you selected from the "Known map 
region" list.
Add as Custom Name for -- Defines the label in the map data range as an acceptable substitute for the item you 
selected from the "Known map region" list. This option is useful when the name of a country has changed.
Known map region -- Lists the region names, region codes, or custom names that 1-2-3 recognizes for the specified 
map type.
Region list type -- Lets you select the type of list you want to work with:

• "Names" lists conventional geopolitical names of map regions, like India and Finland.
• "Codes" lists map codes.
• "Custom Names" lists labels that you previously defined as acceptable substitutes for the recognized names or 

codes of regions in this map type. For example, you may prefer to use the name Nippon instead of Japan. When 
you link a custom name to a recognized name or code, 1-2-3 enters the substitute in the list of custom names for 
the map type and recognizes the substitute when you use it again.

{button ,AL(`H_CHECKING_MAP_REGIONS_STEPS',1)} Go to procedure



Adding pin characters to a map
You can include pin characters in maps to highlight locations or add more meaning to the map.
Want the big picture? See Presenting data in a map. 

Adding pin characters after you create the map
1. Enter a symbol or label for the pin character in the column to the right of the map data.
2. Enter the latitude and longitude in the next two columns.

Tip See Determining latitude and longitude.
3. (Optional) Enter the value for the color in the next column.
4. Select the map to which you want to add the pin characters.
5. From the Map menu, choose Ranges.

6. Enter the three-column range that includes the pin character information in the "Pin characters, latitude and 
longitude" box, or use the range selector to specify the range.

Adding pin characters before you create the map
1. Set up the range that includes the pin character, latitude, and longitude for the map.
2. Select this data when you create the map.

{button ,AL(`H_ADDING_PIN_CHARACTERS_TO_A_MAP_DETAILS',1)} See details
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example
{button ,AL(`H_CREATING_A_MAP_STEPS;H_MODIFYING_MAPS_OVER;H_SETTING_UP_MAP_DATA_STEPS;

H_CHANGING_RANGE_ASSIGNMENTS_STEPS',0)} See related topics



Details: Adding pin characters to a map
Specifying the pin character
Good sources of symbols to use for pin characters are the Wingdings or ZapfDingbats fonts. You can see the symbol 
in the available font in the Windows Character Map. To add a character to the 1-2-3 sheet, copy the character from 
the Character Map to the Clipboard, paste it into a cell, and apply the appropriate font.

Specifying the pin character color
Use numbers 0 through 239 to specify the pin character color. If you don't specify a color, the pin character will be 
black.

{button ,AL(`H_ADDING_PIN_CHARACTERS_TO_A_MAP_STEPS',1)} Go to procedure
{button ,AL(`H_RANGE_OF_MAP_DATA_EX',1)} See example



Determining latitude and longitude
You can determine the latitude and longitude of the location for a pin character by pointing to the map.
1. Select the map to which you want to add a pin character.
2. Right-click on the location for the pin character.

The region name, code, and map coordinates appear in the shortcut menu.
3. From the shortcut menu, choose Copy Coordinates.
4. Click the cell where you want to paste the latitude. 
5. From the Edit menu, choose Paste.
Tip You can determine the latitude and longitude quickly by pointing to a location in the map and pressing the right 
mouse button. The latitude, longitude, region name and appear in the 1-2-3 title bar. As you move the mouse, 1-2-3 
updates the information in the title bar to show the current location.

What do negative coordinates mean?
The latitude coordinate is negative if the region you clicked is south of the equator. The longitude coordinate is 
negative if the region is west of the Greenwich meridian and east of the International Date Line.
For example, both coordinates are negative for locations in Chile. Both coordinates are positive for locations in 
Poland. For locations in Australia, however, the latitude is negative but the longitude is positive, since Australia is east
of the Greenwich meridian and west of the International Date Line.

{button ,AL(`H_ADDING_PIN_CHARACTERS_TO_A_MAP_STEPS;H_MAPS_OVER;H_CHANGING_RANGE_ASSI
GNMENTS_STEPS',0)} See related topics



Presenting data in a map
This task consists of the following parts:

 Introducing maps in 1-2-3

 Setting up map data 

 Creating a map 

 Modifying a map 

Modifying a map
Once a map has been created, you can change it in many ways. In a map of the world, you may want to show Asia 
alone, or add Hawaii and Alaska to a map of the United States. You can also control colors and patterns, bin 
definitions, and other map characteristics.
Note Each time you make a change to a map or its data ranges, 1-2-3 automatically redraws the map, which can 
take time. To control how often 1-2-3 redraws a map, see Redrawing maps. 

Changing the map content
You can change the map content in many ways. You can:

• Flag specific locations.    See Adding pin characters to a map. 
• Display a smaller or larger area of the map. See Zooming in or out of a map. 
• Focus on the area containing your data. See Choosing the center of a map.    
• Show other states or countries. See Overlaying additional map areas. 
• Change the way the map groups values in bins. See Changing bin definitions for colors or patterns.    
• Add, delete, or change map data ranges. See Changing map range assignments.    

Changing the map appearance
You can also control aspects of the map's appearance. You can:

• Give the map a meaningful title. See Changing a map title.    
• Change the legend position, or hide the legend. See Changing map legend position.      
• Change the legend label text.    See Changing map legend labels.      
• Change the colors or patterns.    See Changing bin colors or patterns. 
• Control the map dimensions, zoom percentage, and rotatation. See Changing the plot area of a map. 

Styling a map
Like other types of graphic objects, you can also change the text, borders, and fill characteristics of the map 
components, such as the title and map frame, using the Text Format tab and the Lines & Colors tab in the InfoBox.

You can also resize a map, group a map with another map, or print a map.    See Overview: Working with graphic 
objects.

{button ,AL(`H_NAMING_A_MAP_STEPS;;H_REDRAWING_MAPS_STEPS;H_REMOVING_AN_OVERLAY_STEPS
;H_CHANGING_TEXT_FORMAT_STEPS;H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_GROUP
ING_GRAPHICS_STEPS;H_HIDING_OR_REDISPLAYING_GRAPHICS_STEPS;H_LOCKING_OR_UNLOCKING
_GRAPHICS_STEPS',0)} See related topics



Naming a map
The default name of the map, for example, "Map 1," appears in the selection indicator. You can change the name to 
be more meaningful to you and to help you find the map using Edit - Go To.
1. Select the map for which you want to change the name.
2. From the Map menu, choose Map Properties.

3. Click the Basics tab in the InfoBox.

The default map name appears.
4. Enter a new name.

Note When you rename a map, you must use the same naming conventions as for naming a range. The only 
exception to these conventions is that a map name can be up to 64 characters long.

5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_MODIFYING_MAPS_OVER;H_CHANGING_THE_TITLE_STEPS',0)} See related topics



Changing map range assignments
You can change the range specified for region names or codes, colors, patterns, or pin characters.
Want the big picture? See Presenting data in a map. 
1. Select the map for which you want to change the range assignments.
2. From the Map menu, choose Ranges.

3. Enter the range you want to assign in the appropriate option box in the InfoBox, or use the range selector to 
specify the range.
If 1-2-3 cannot identify a region you specified, the Region Check dialog box appears so you can check the 
unrecognized region name against the official 1-2-3 list of names and codes.

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_RANGE_ASSIGNMENTS_DETAILS',1)} See details
{button ,AL(`H_SETTING_UP_MAP_DATA_STEPS;H_ADDING_PIN_CHARACTERS_TO_A_MAP_STEPS;H_CHAN

GING_THE_TITLE_STEPS;H_CHANGING_THE_LEGEND_LABELS_STEPS;H_CHANGING_THE_DATA_COLO
RS_STEPS;H_MODIFYING_MAPS_OVER',0)} See related topics



Details: Changing map range assignments
Ranges that have already been specified are shown. If a range is blank, that type of data is not used in the map.

Options: InfoBox for maps (Ranges tab)
Map region names or codes -- Displays the data range currently specified for the region names or codes.
Data to map with colors -- Displays the data range currently specified to be mapped with colors.
Data to map with patterns -- Displays the data range currently specified to be mapped with patterns.
Pin characters, latitude and longitude -- Displays the data range currently specified for the pin characters. This range 
must be at least three columns wide.

{button ,AL(`H_CHANGING_RANGE_ASSIGNMENTS_STEPS',1)} Go to procedure



Changing the plot area of a map
The plot area of a map is the map itself. By default, 1-2-3 centers the plot area in the map frame. You can drag the 
plot area to any position or size within the map borders.
You can change the map plot's rotation, zoom percentage, and centering using the InfoBox.
1. Select the map for which you want to change the plot area.
2. From the Map menu, choose Plot.

3. Specify the options you want to change in the InfoBox.
4. (Optional) Move, collapse, or close the InfoBox.
Note To restore the map plot to its original view, select the map, then use Map - Reset to Original View.

{button ,AL(`H_CHANGING_THE_PLOT_AREA_DETAILS',1)} See details
{button ,AL(`H_CHANGING_THE_VIEW_SCALE_OF_MAPS_STEPS;H_ADDING_AN_OVERLAY_STEPS;H_123_C

HOOSING_THE_CENTER_OF_A_MAP_STEPS;H_MODIFYING_MAPS_OVER;H_REDRAWING_MAPS_STEPS
;H_123_CHANGING_LEGEND_POSITION_STEPS',0)} See related topics



Details: Changing the plot area of a map
You can control a variety of the map plot's characteristics in the Basics tab of the InfoBox. For example, if your data 
appears in one area of the map, you can recenter the map on that area and zoom in on it.

Maintain correct map dimensions
Maintain correct map dimensions -- Determines whether 1-2-3 automatically maintains the correct dimensions, or 
aspect ratio, of the map, even when you change the plot area. If you do not select this option, the dimensions may be
distorted if you change the plot area. To redisplay a map with distorted dimensions correctly, select this option 
(default).
Caution Map - Reset to Original View does not restore the map to its original state after you turn off    "Maintain 
correct map dimensions."

Plot position and size
• "Default settings" is selected until you move or resize the plot.    Select this setting to return to the default position 

and size.
• "Custom settings" is selected when the plot area has been moved or resized.

Rotation
Lets you specify the number of degrees by which to rotate the map. For example, to rotate the map by 90°, enter 90.

Zoom %
Lets you specify the percentage to zoom in on the plot area.    See also Zooming in or out of a map.

Center
Determines the latitude and longitude for the center of the plot area. To recenter the map plot using the mouse, see 
Choosing the center of a map. 

Related SmartIcons

 Decrease the display size of the map by 50% (zoom out)

 Increase the display size of the map by 100% (zoom in)

{button ,AL(`H_CHANGING_THE_PLOT_AREA_STEPS',1)} Go to procedure



Choosing the center of a map
If your data appears in one geographic area on the map, you may want to center that area in the map plot.
1. Select the map for which you want to change the plot area.
2. Point to the place in the map that you want to appear in the center.
3. Right-click the mouse on the place on the map that you want in the center.
4. From the shortcut menu, choose Recenter.
Tip It is often useful to recenter the map before you zoom in on it. For more information, see Zooming in or out of a 
map. 

{button ,AL(`H_CHANGING_THE_VIEW_SCALE_OF_MAPS_STEPS;H_CHANGING_THE_PLOT_AREA_STEPS;H
_MODIFYING_MAPS_OVER',0)} See related topics



Zooming in or out of a map
You can enlarge the map to view a portion of it in more detail, or shrink the map to see more of it or to make room for 
an overlay.

Zooming in
To take a closer look at a portion of the map, choose Map - Zoom In to increase the display size of the map by 100%.

Tip To zoom in with the mouse, CTRL+drag to draw a rectangle around the area of the map you want to enlarge.

Zooming out
To see more of the map, choose Map - Zoom Out to decrease the display size of the map by 50%.

Restoring the map to its original state
To display the map as it was when it was created, choose Map - Restore to original size.

Note To specify how much you want to increase or decrease the display size of the map, use the Zoom % option on 
the InfoBox for plots (Basics tab).

{button ,AL(`H_MODIFYING_MAPS_OVER;H_123_CHOOSING_THE_CENTER_OF_A_MAP_STEPS;H_CHANGIN
G_THE_PLOT_AREA_STEPS;H_CHANGING_THE_PLOT_AREA_DETAILS',0)} See related topics



Redrawing maps
When you make a change to the data in a map data range, 1-2-3 automatically redraws the map. You can specify 
whether to redraw each map automatically or manually.

Redrawing maps automatically
1. Select the map that you want automatically redrawn.
2. From the Map menu, choose Map Properties.

3. Make sure "Redraw map automatically when data changes" is selected (the default setting) in the InfoBox.
Each time you change the data for this map, it is automatically redrawn.

Redrawing maps manually
1. Select the map and choose Map - Map Properties.
2. Make sure "Redraw map automatically when data changes" is not selected.
3. (Optional) Move, collapse, or close the InfoBox.
4. Change the appropriate data in the map range.
5. Select the map.
6. From the Map menu, choose Redraw.

{button ,AL(`H_REDRAWING_MAPS_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_MAPS_OVER',0)} See related topics



Details: Redrawing maps
Lessening the time needed to redraw maps
Maps are complex images that require the detailed drawing of many visual elements and sensitivity to changes in 
sheet data. Rendering a map that looks good and represents your data accurately can take time.
When you make changes to the data linked to maps, keep the following points in mind:

• Turning off "Redraw map automatically when the data changes" lets you decide when 1-2-3 can redraw a map.
• When "Redraw map automatically when the data changes" is turned on, 1-2-3 redraws a map after each change 

you make to the map data. If you need to make several changes to the data, first turn off the automatic redraw 
option. After you make all the changes, choose Map - Redraw, and 1-2-3 redraws the map once to reflect all the 
changes.

• If you have more than one map linked to the same set of data and "Redraw map automatically when the data 
changes" is on, 1-2-3 must redraw each map whenever you change the data. Once again, by turning off this 
option, you can reduce the interruption caused by the redrawing of maps.

Redrawing maps in 1-2-3 Release 5 files
When you open a 1-2-3 Release 5 workbook that contains maps set to manual redraw, each map is marked for 
manual redraw.

{button ,AL(`H_REDRAWING_MAPS_STEPS',1)} Go to procedure



Changing a map title
You can change the text and position of the map title or hide the title.
1. Select the map for which you want to change the title.
2. From the Map menu, choose Title.

The specified title is shown in the InfoBox.
Tip You can also double-click the title and edit the text.

3. Change the specified title, or add another line to the title.
4. Change the position of the title, or hide it by deselecting "Show title."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_TITLE_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_MAPS_OVER;H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_CHANGI

NG_TEXT_FORMAT_STEPS',0)} See related topics



Details: Changing a map title
Specifying a new title in the sheet
You can also specify that the contents of a cell be the new title for the map by selecting "Cell" on the Basics tab of the
InfoBox for map titles. Then enter the cell coordinates, or use the range selector    to specify the coordinates that 
contain the title.

Seeing the entire title
When you enter a new map title, you overwrite the old. Depending on the length of the new title and the size of the 
map, you may need to also change the point size of the title text. Use the Text Format tab in the InfoBox to set title 
text point size.

{button ,AL(`H_CHANGING_THE_TITLE_STEPS',1)} Go to procedure



Changing bin definitions for colors or patterns
You can change the values included in each bin that represents a map color or pattern. By default, the upper limit of 
each bin is computed from the map data range. For example, you may want the bins to use round numbers for the 
upper limits, such as 10,000 and 20,000. 
You can also specify that each bin represents an exact value instead of a range of values, and you can use fewer 
than six bins.
Want the big picture? See Presenting data in a map. 
1. Select the map for which you want to change the bin values.
2. From the Map menu, choose Color Bins or Pattern Bins.

The bin values for the currently specified colors or patterns are shown in the InfoBox.
3. Select "Manual" or "From range" from the "Values" list.
4. Change the specified bin values, or change the range that determines the bin values.
5. To use fewer than six bins, delete the values from one or more "Values" box.
6. Choose an option from the "Put in bins by" list.
7. (Optional) Move, collapse, or close the InfoBox.
Tip To return to six upper-limit bins, select "Computed" from the "Values" list.

{button ,AL(`H_CHANGING_COLOR_AND_PATTERN_BIN_VALUES_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_MAPS_OVER;H_CHANGING_THE_DATA_COLORS_STEPS;H_CHANGING_THE_LE

GEND_LABELS_STEPS;H_CHANGING_RANGE_ASSIGNMENTS_STEPS',0)} See related topics



Details: Changing bin definitions for colors or patterns
You can change the bin values for the map's colors and patterns by changing the values already specified or by 
specifying a different range to determine the bin values.

How 1-2-3 assigns bin values
By default, 1-2-3 assigns bin values based on the number and types of data items that need to be mapped. 1-2-3 can
create up to six color bins and six pattern bins. You can map either values or labels to either colors or patterns.

Number of items Type Bins
6 or fewer Values One bin for each exact value
More than 6 Values Groups into bins by upper limit
6 or fewer Labels One bin for each label
More than 6 Labels Bins created only for first six 

unique labels

Changing the specified bin values
To change a bin value that has already been specified, select "Manual" from the "Values" list, and enter the new bin 
value in the box next to the bin you want to change.

Changing the range that determines the bin values
To change a range in the sheet that determines the bin values, select "From Range" from the "Values" list. Then, 
enter the range in the "Values range" box at the bottom of the same column, or use the range selector to specify the 
range.

Using upper limits or exact matches to define bins
If you select "Manual" or "From Range" from the "Values" list, you can select an option from the "Put in bins by" list:

• "Upper limit" -- For each bin, the value in the "Value" box is the upper limit of a range of values. Map regions with 
values that are less than or equal to the bin value but greater than the previous bin value display the bin's color or
pattern. 

• "Exact value" -- For each bin, only the map regions with values that exactly match the value in the bin's "Value" 
box display the bin's color or pattern.

How 1-2-3    formats numbers
1-2-3 applies the number format of the first cell in the color range to the color bin values, and the format of the first 
cell in the pattern range to the pattern bin values.

{button ,AL(`H_CHANGING_COLOR_AND_PATTERN_BIN_VALUES_STEPS',1)} Go to procedure



Changing map legend labels
You can change the text of each legend label. When the color or pattern range contains more than six values, the 
default legend label is the value used to define the upper limit of a bin.
1. Select the map for which you want to change the legend labels.
2. From the Map menu, choose Color Bins or Pattern Bins.

The legend labels currently specified for each bin are shown in the right-hand column of the InfoBox.
3. Select "Manual" or "From range" from the "Legend labels" list.
4. Change the specified legend label, or change the range that determines the legend label.

{button ,AL(`H_CHANGING_THE_LEGEND_LABELS_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_MAPS_OVER;H_CHANGING_COLOR_AND_PATTERN_BIN_VALUES_STEPS;H_CH

ANGING_RANGE_ASSIGNMENTS_STEPS;H_123_CHANGING_LEGEND_POSITION_STEPS',0)} See related 
topics



Details: Changing map legend labels
You can change legend labels by changing the labels already specified, or by specifying a range that determines the 
labels.

Changing a specified legend label
To change a legend label that has already been specified, select "Manual" from the "Legend labels" list and enter the 
new label in the box that refers to the bin you want to change.

Specifying a range that determines the legend labels
To specify a range in the sheet that determines the legend labels, select "From Range" from the "Legend labels" list. 
Then, enter the range in the "Legends range" box at the bottom of the same column, or use the range selector to 
specify the range.

{button ,AL(`H_CHANGING_THE_LEGEND_LABELS_STEPS',1)} Go to procedure



Changing map legend position
You can change where and how the legend appears. 
1. Select the map for which you want to change the legend position.
2. From the Map menu, choose Legend.

3. To hide the color and/or the pattern legend, select the appropriate check box in the InfoBox.
4. To display the legend on top of the map plot, select "Place inside plot area."
5. To change the position of the legend, select one of the Position buttons. 
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_MODIFYING_MAPS_OVER;H_CHANGING_THE_LEGEND_LABELS_STEPS;H_CHANGING_THE_
PLOT_AREA_STEPS',0)} See related topics



Changing bin colors or patterns
You can change the colors or patterns used to map different data by selecting new colors or patterns, or by specifying
a range in the sheet.
1. Select the map for which you want to change the colors or patterns.
2. From the Map menu, choose Color Bins or Pattern Bins.

The colors or patterns currently specified for each bin are shown in the left-hand column of the InfoBox.
3. Select "Manual" or "From range" from the "Colors" or "Patterns" list.
4. Change the specified colors or patterns, or change the range that determines the colors or patterns.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_THE_DATA_COLORS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_COLOR_AND_PATTERN_BIN_VALUES_STEPS;H_MODIFYING_MAPS_OVER',0)} 

See related topics



Details: Changing bin colors or patterns
Changing a specified color or pattern
To change a color that is already specified, select "Manual" from the "Colors" list, click the bin color you want to 
change, and select a new color from the pop-up palette.
To change a pattern that is already specified, select "Manual" from the "Patterns" list, click the bin pattern you want to
change, and select a new pattern.

Specifying the range that determines a color or pattern
To specify a range in the sheet that determines the colors, select "From Range" from the "Colors" list. Then, enter the 
range in the "Colors range" box at the bottom of the same column, or use the range selector to specify the range. 
This range must contain values that correspond to the color palette. Valid values for this range are 0 through 239.
To specify a range in the sheet that determines the patterns, select "From Range" from the "Patterns" list. Then, enter
the range in the "Patterns range" box at the bottom of the same column, or use the range selector to specify the 
range. Valid values for this range are 0 through 6.

{button ,AL(`H_CHANGING_THE_DATA_COLORS_STEPS',1)} Go to procedure



Overlaying additional map areas
You can add an overlay to a map to provide a broader context or more detail to the presentation of the sheet data 
you're mapping. For example, to show Canada and Mexico in a map of the United States, you overlay a map of the 
world, then zoom in or out as necessary.
Want the big picture? See Presenting data in a map. 
1. Select the map to which you want to add an overlay.
2. From the Map menu, choose Overlays.

3. Click Add in the Overlays panel of the InfoBox.
The Add Overlay dialog box appears, showing all installed map files.

4. Click the name of the overlay you want to add.
5. Click Open.

1-2-3 adds the selected overlay to the map and lists the name of the overlay in the InfoBox. 
Tip Zoom in or out of the map to show as much of the original map and overlay as you want.

6. (Optional) Move, collapse, or close the InfoBox when you have added all the appropriate overlays.

{button ,AL(`H_ADDING_AN_OVERLAY_DETAILS',1)} See details
{button ,AL(`H_MODIFYING_MAPS_OVER;H_REMOVING_AN_OVERLAY_STEPS;H_CHANGING_THE_VIEW_SC

ALE_OF_MAPS_STEPS;H_123_CHOOSING_THE_CENTER_OF_A_MAP_STEPS',0)} See related topics



Details: Overlaying additional map areas
Seeing the overlays
You can add several overlays to a map. Depending on the geographic position of the countries in the overlay in 
relation to the countries in the original map, the overlay countries may not appear in the plot area. To see the entire 
map and overlay, you might have to choose Map - Zoom Out.

Related SmartIcons

Decrease the display size of the map by 50% (zoom out)

Increase the display size of the map by 100% (zoom in)

{button ,AL(`H_ADDING_AN_OVERLAY_STEPS',1)} Go to procedure
{button ,AL(`H_CHANGING_THE_VIEW_SCALE_OF_MAPS_STEPS',0)} See related topics



Removing an overlay from a map
You can remove an overlay that is added to a map.
1. Select the map from which you want to remove an overlay.
2. From the Map menu, choose Overlays.

A list of overlays that have been added to the current map is displayed in the InfoBox.
3. Click the name of the overlay you want to remove.
4. Click Remove.

{button ,AL(`H_ADDING_AN_OVERLAY_STEPS;H_MODIFYING_MAPS_OVER',0)} See related topics



1-2-3 menus
Click a menu name below to see descriptions of each command on that menu.

File 
Open, save, print, and close files; manage add-ins, defaults, and SmartIcons; access Internet, and team features.

Edit 
Rearrange data and objects, manage links, and create and edit scripts.

View  
Control the display settings for the sheet, workbook, and 1-2-3.

Create 
Create sheets, graphic objects, and @functions; embed data from other applications.

Sheet 
Work with sheets and outlines.

Window 
Control how 1-2-3 displays windows.

Help 
Open 1-2-3 Help; access Lotus Support on the Internet.

The Context menu
The context menu changes depending on what you have selected or what you are doing. 

Actions 
List NotesFlow and Script commands that relate to an object embedded in 1-2-3 when you publish a Notes action to 
that object.

Chart 
Set data ranges, change chart types, and enhance charts.

Drawing 
Work with, arrange, and script drawn objects.

Map 
Work with maps.

<Name of control > 
Work with ActiveX and JavaBean controls.

<OLE object > 
Work with and arrange embedded OLE objects.

Preview 
Zoom in or out, or manipulate the preview window.

Query 
Create and work with DQA query tables. This menu appears after you load the Data Query Add-In.

Query Table 



Work with query tables.

Range 
Work with and analyze ranges of data.

Web Table 
Work with Web tables.

{button ,AL(`;H_CANCELING_A_COMMAND_STEPS;H_UNDOING_A_COMMAND_STEPS;H_GETTING_HELP_O
N_A_MENU_COMMAND_STEPS;H_WAYS_TO_PERFORM_TASKS_OVER',0)} See related topics



Actions menu

NotesFlow command 0 - n
Use NotesFlow commands that relate to a 1-2-3 embedded object. These commands are run from Notes.

Promoted Script commands...
List of LotusScript subroutines promoted to the menu in the Global Script Options dialog box.



Chart menu

Chart Type
Choose a chart type.

Chart Style >
• Apply

Apply a chart style.
• Create

Create a chart style.
• Set Default Chart

Set a default chart type and style.
• Change Path

Specify a Chart Style directory.

<Chart object> Properties
View and modify properties of the selected chart or portion of a chart.

Title
View and modify title properties.

Legend
View and modify legend properties.

Axes & Grids >
• X-Axis & Grids

View and modify x-axis and grid properties.
• Y-Axis & Grids

View and modify y-axis and grid properties.
• 2nd Y-Axis & Grids

View and modify second y-axis and grid properties. This command appears only when the selected chart includes
a second y-axis.

• Z-Axis & Grids
View and modify z-axis and grid properties. This command appears only when the selected chart includes a z-
axis.

Series
View and modify series properties.

Series Labels
View and modify series labels properties.

Plot
View and modify plot properties.

Note
View and modify note properties.

Table
View and modify table properties.

Ranges
View and modify the ranges on which the chart is based.



Bring to Front
Put the selected chart(s) in front of all other objects.

Send to Back
Put the selected chart(s) behind all other objects.



Create menu

Sheet
Add one or more sheets to the current workbook.

Chart
Create a chart using the selected range.

Map
Create a map using the selected range.

Database >
• Query Table

Create a Lotus Approach query table by extracting records from a database table.
• Form

Create a Lotus Approach form.
• Report

Create a Lotus Approach report.
• Dynamic Crosstab

Create a Lotus Approach dynamic crosstab.
• Mailing Labels

Create Lotus Approach mailing labels.
• Form Letter

Create a Lotus Approach form letter.

Text
Create a text block.

Button
Create a button to run a script or macro.

Drawing >
• Line

Draw a line.
• Polyline

Draw a segmented line.
• Arrow

Draw an arrow.
• Rectangle

Draw a rectangle or square.
• Rounded Rectangle

Draw a rounded rectangle or square.
• Arc

Draw an arc.
• Ellipse

Draw an ellipse or circle.
• Polygon

Draw a polygon.
• Freehand

Draw freehand.



• Picture
Add a picture.

@Function
Create a custom @function.

Hyperlink
Create or edit hyperlinks.

Object
Embed data from another application in 1-2-3.



Drawing menu

Drawing Properties
View and modify drawn object properties.

Bring to Front
Put the selected object(s) in front of all others.

Send to Back
Put the selected object(s) behind all others.

Group
Group the selected objects.

Ungroup
Ungroup the selected group.

Flip Left-Right
Flip the selected object(s) horizontally.

Flip Top-Bottom
Flip the selected object(s) vertically.

Reset to Original Size
Show the selected picture in its original size.    This menu choice appears only when a picture is selected.



Edit menu

Undo
Reverse the effect of the most recently executed command or action.

Cut
Delete data and related styles from the sheet and place them on the Clipboard.

Copy
Copy data and related styles from the sheet to the Clipboard.

Paste
Paste the contents of the Clipboard to the sheet.

Clear
Delete the contents, formatting, borders, cell comments, or scripts from the selected range or object without using the
Clipboard.

Clear Styles
Delete formatting from a cell or range.

Paste Special
Controls how 1-2-3 pastes and formats data from the Clipboard into the sheet.

Paste Link
Paste data on the Clipboard into the sheet as a formula, file link, or OLE link.

Copy Down
Copy the contents of the top row in the selection to fill the entire selection.

Copy Right
Copy the contents of the leftmost column in the selection to fill the entire selection.

Page Break
Create or delete vertical or horizontal page breaks.

Go To
Go to and select an item.

Find & Replace
Find or replace specified characters in labels and formulas.

Check Spelling
Find and correct misspelled or duplicate words.

Manage Links
Update 1-2-3 file links, or maintain DDE and OLE links.

Scripts & Macros >
• Run

Run or debug a script or macro.
• Record Script/Stop Recording

Create a script by recording keystrokes and mouse actions; if you are recording a script, stop recording and show
the Script Editor.

• Show Script Editor



Edit a script.
• Show Dialog Editor

Show the dialog editor.
• Global Script Options

Add a script to the Actions menu, or assign it to a quick key.



File menu

New Workbook
Create a new workbook.

Open
Open an existing workbook.

Close/Close & Return to <application>
Close the current file or active window, or close a 1-2-3 worksheet object embedded in another application file and 
return to that other application.

Save/Update <file name>
Save the current workbook. Update appears only when the current document is embedded in another application; it 
updates the current document in the file in which it is embedded.

Save As
Save a workbook with a name you specify or save part of this workbook; assign a password to files.

Add-Ins >
• Manage Add-Ins

Load, unload, or register an add-in.
• Create Add-In

Create an add-in.

TeamMail
Create a mail message or route this workbook using your mail system.

TeamReview
Distribute workbook for review; read and write comments; end the review session.

TeamConsolidate >
• Merge Versions

Combine versions and version groups from team members.
• Share Sheets using Notes

Distribute workbook sheets to team members and consolidate their updates using Lotus Notes.

Internet >
• Convert to Web Pages

Save a range as an HTML table or print snapshot on the Web.
• Get Data from Web

Bring a table of data from the Web into 1-2-3.
• Refresh Web Data

Refresh Web data.
• Setup

Set options for connecting to the Internet.

Get/Release Reservation
Get or release the reservation for the current workbook.

Print
Print a range or ranges of data, or change the page layout.

Preview & Page Setup



Preview the print selection, and set headers, footers, and page orientation.

Workbook Properties
View and modify properties for the current workbook.

User Setup >
• 1-2-3 Preferences

Customize the behavior of 1-2-3.
• SmartIcons Setup

Move and modify sets of SmartIcons, and create SmartIcons.
• SmartFill Setup

Create and maintain custom lists.
• SmartLabel Setup

Create and maintain SmartLabels.

Exit 1-2-3/Exit 1-2-3 & Return to <file name>
End the 1-2-3 session.

<List of most recently used files>
Open an existing file.



Help menu

Help Topics
Display the online Help window's Contents, Index, and Find tabs.

Ask the Expert
Display the Expert.

QuickDemos
Display a list of QuickDemos.

Lotus Internet Support
• Lotus Home Page

Go to the Lotus home page on the Internet.
• Lotus Customer Support

Go to the Lotus customer support page on the Internet.
• Lotus FTP Site

Go to the Lotus FTP site on the Internet.

Microsoft Excel Menu Finder>
Open the Microsoft Excel Menu Finder.

Year 2000
Display Help topics about the year 2000.

About 1-2-3
Display release and copyright information.



Map menu

<Map object> Properties
View and modify properties of the selected map or portion of a map.

Ranges
Set or change the properties of the range assignments.

Color Bins
Set or change the properties of the color bins.

Pattern Bins
Set or change the properties of the pattern bins.

Title
Set or change the properties of the title.

Legend
Set or change the properties of the legend.

Overlays
Add or remove overlays.

Plot
Set or change the properties of the plot area.

Zoom In
Increase the display size of the map by 100%.

Zoom Out
Decrease the display size of the map by 50%.

Reset to Original View
Display the map in its original size.

Redraw
Redraw selected maps.

Bring to Front
Put the selected map(s) in front of all other objects.

Send to Back
Put the selected map(s) behind all other objects.



Preview menu

Preview & Page Setup Properties
View and modify preview and page setup properties.

Previous Page
Show the previous page of the print selection in the Preview window.

Next Page
Show the next page of the print selection in the Preview window.

One Page View
Show one page of the print selection in the Preview window.

Two Page View
Show two facing pages of the print selection in the Preview window.

Four Page View
Show four pages of the print selection in the Preview window.

Nine Page View
Show nine pages of the print selection in the Preview window.

Hide/Show Margins
Hide or show margins in the Preview window.



Query menu
The Query menu appears after you load the Data Query Add-in (DQA).

Select Query Table
Go to and select an existing DQA query table.

New Query
Create a DQA query table by extracting records from a database table.

Set Criteria
Set criteria to determine which records appear in a DQA query table.

Choose Fields 
Select and arrange fields in a DQA query table; create a computed column.

Sort
Sort records in a DQA query table.

Aggregate
Calculate values using groups of records in a DQA query table.

Name 
Rename a DQA query table.

Set Options
Update the source database table; set update and refresh options, unique records, and maximum records for a DQA 
query table.

Show SQL
Show the SQL command equivalent for the selected DQA query table.

Set Database Table
Select a different source database table for the current DQA query table.

Join
Query multiple database tables that have a common field.

Refresh Now
Update the records in a DQA query table with changes in the source database table.

External Tables >
• Connect to External

Connect to an external database table.
• Disconnect from External

Disconnect from an external database table.
• Send SQL

Send an SQL command to an external database table.
• Create table

Create an external database table.



Query Table menu

Query Table Properties
View and modify query table properties.

Edit
Switch to Edit mode to find, sort, and edit records.

Refresh
Update records in a query table.

Output Range
Specify or change the output range.



Range menu

Range Properties
View and modify range properties.

Insert/Insert Columns/Insert Rows
Insert blank cells, columns, or rows.

Delete/Delete Columns/Delete Rows
Delete cells, columns, or rows.

Name
Create and delete range names.

Version >
• Version Properties

View and modify version properties.
• New Version

Create a new version of the selected range.
• Display Version

List versions in the current workbook, and select a version to display.
• Delete Version

Delete a version from the workbook.
• Version Groups

Create, edit, show, and delete groups of versions.
• Report

Report on selected versions and their effects on formula results.

Fill
Enter values, dates, times, or a custom sequence in a range.

Sort
Sort data in a range in ascending or descending order.

Analyze >
• What-if Table

Create a table showing the results of changing variables in formulas.
• Backsolver

Work backwards from a formula result to find values for variables.
• Distribution

Create a frequency distribution of the values in a range.
• Regression

Perform multiple linear regression analysis.
• Invert Matrix

Invert a square matrix.
• Multiply Matrix

Multiply two ranges as matrixes.

Cell Comment
Add or modify a cell comment.



Transpose
Copy a range, transposing the layout of the data.

Parse
Convert a column of long labels into one or more columns of data.

Fast Format
Apply the current range's formatting to other ranges.



Sheet menu

Sheet Properties
View and modify sheet properties.

Move or Copy Sheet
Move or copy the selected sheet.

Delete Sheet
Delete the selected sheets.

Outline >
• Demote/Demote Columns/Demote Rows

Demote selected columns or rows down one outline level.
• Promote/Promote Columns/Promote Rows

Promote selected columns or rows up one outline level.
• Expand/Expand Columns/Expand Rows

Expand columns or rows in the selected range.
• Collapse/Collapse Columns/Collapse Rows

Collapse columns or rows in the selected range.
• Clear Outline

Clear outlines for the entire sheet.

Hide
Hide the selected sheet(s).

Unhide
Show hidden sheet(s).

Group Sheets/Clear Sheet Group
Group sheets, or ungroup all grouped sheets.



View menu

Zoom to Custom Level (xx%)
Reset the display of cells to the default (not shown in Preview mode).

Zoom to >
(These commands do not appear in Preview mode.)

• 25%
Display the sheet at 25% of full size.

• 50%
Display the sheet at 50% of full size.

• 75%
Display the sheet at 75% of full size.

• 100%
Display the sheet at 100% of full size.

• 200%
Display the sheet at 200% of full size.

Hide/Show SmartIcons
Hide or show SmartIcons.

Hide/Show Internet Tools
Hide or show the Internet SmartIcons.

Hide/Show Status Bar
Hide or show the status bar.

Hide/Show Edit Line
Hide or show the edit line.

Titles
Freeze columns and rows as sheet titles, or unfreeze the sheet titles.

Split/Clear Split
Split the window into two or four panes, or restore a split window to one pane.

Synchronize Split/Unsynchronize Split
Scroll the panes of a split window together or independently (appears only when the window is split).

Set View Preferences
View or modify the properties of the current workbook.

Design/Run controls
Switch between Design and Run mode for controls.
Note This menu command appears only if the setting in View Preferences is enabled.



Web Table menu

Web Table Properties
View and modify Web table properties.

Refresh Now
Update data from the Web.

Break Connection to Web
Break the link to the URL.



Window menu

New Window
Create a new window for the current workbook.

Tile Left-Right
Size and arrange open windows side by side.

Tile Top-Bottom
Size and arrange open windows top to bottom.

Cascade
Size and stack open windows diagonally.

<List of open windows>
See a list of windows open in 1-2-3.

More Windows...
See a complete list of windows open in 1-2-3, if you have more than nine windows open.



<Name of    control> menu
This menu displays the name of the selected ActiveX or JavaBean control.

Object Properties
View and modify control properties.

Edit
Apply command to the <name of control> object.

<Name of control> Properties
Note This command appears on the menu only if the object supports it.

Bring to Front
Put the selected object(s) in front of all others.

Send to Back
Put the selected object(s) behind all others.

Group
Group the selected objects.

Ungroup
Ungroup the selected group.



<OLE object> menu
This menu displays the name of the selected OLE object.

<OLE object> Properties
View and modify object properties.

<Verb 0 - n>
Use one or more registered verbs for the embedded object.

Edit
Edit the embedded object.

Open
Open the embedded object.

Bring to Front
Put the selected object(s) in front of all other objects.

Send to Back
Put the selected object(s) behind all other objects.

Group
Group the selected objects.

Ungroup
Ungroup the selected group.



Moving using the Clipboard
The Clipboard is useful when you want to move data to more than one location.
Note You cannot move a sheet using the Clipboard. See Moving a sheet. 
1. Select what you want to move.
2. From the Edit menu, choose Cut.

1-2-3 places a copy of your selection on the Clipboard and deletes your original selection.
3. Select the destination for the data.

Caution If you're moving a range, 1-2-3 writes over any existing data in the destination range, including data in 
hidden columns, rows, or sheets. 

4. From the Edit menu, choose Paste.

Note If you're moving a formula, 1-2-3 keeps relative references the same only the first time you paste. In 
subsequent pastes, 1-2-3 adjusts the relative references to the new location.

{button ,AL(`H_MOVING_USING_THE_CLIPBOARD_DETAILS',1)} See details
{button ,AL(`H_COPYING_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_IN_A_SHEET_STEP

S;H_COPYING_AND_MOVING_OVER;H_COPYING_USING_THE_CLIPBOARD_STEPS;H_123_S98_MOVING
_A_SHEET_STEPS',0)} See related topics



Details: Moving using the Clipboard
Shortcut for pasting data
You can select the destination and press ENTER to paste the data. Pressing ENTER works only once after each cut or 
copy. If you choose a command or run a macro or script before pressing ENTER, the ENTER key will not paste the 
data.

Selecting the destination
If you cut a range, the destination must be a range. If you cut a graphic object, the destination can be a range or 
graphic object.

How moving ranges affects attached scripts
To move a script attached to a range, you must move the top left or bottom right corner of the scripted range. 1-2-3 
only moves a script attached to a cell or range if you move it within a workbook using drag and drop or Edit - Cut and 
Edit - Paste.
To edit scripts and move them between workbooks, use the Integrated Development Environment (IDE). See 
Overview: Using LotusScript for more information.

About the destination range
You need to select only one cell of the destination range. 1-2-3 treats that cell as the top left cell of the destination 
and will paste all the data in its original size and layout. 1-2-3 pastes all the data, regardless of the size of the 
destination range. 
If you copy a single cell into a destination range that is larger than one cell, 1-2-3 repeats the data until the 
destination range is full. However, If you cut a single cell and the destination range is larger than one cell, 1-2-3 does 
not repeat the data to fill the rest of the destination range. 

Pasting text into a text block
To paste text into a text block, double-click the text block and use CTRL+V instead of Edit - Paste. 

Related SmartIcons

Pastes the properties you specify

Pastes a 1-2-3 file link or an OLE link

{button ,AL(`H_MOVING_USING_THE_CLIPBOARD_STEPS',1)} Go to procedure



Move or Copy Sheet dialog box
Use this dialog box to move or copy entire sheets.

Choose a task
Moving a sheet 
Copying a sheet 



Moving a sheet
There are two ways to move a sheet within a 1-2-3 workbook.
Note You can move only one sheet at a time, and you cannot move sheets between workbooks.

Using the mouse to move a sheet (drag and drop)

 Show me a QuickDemo
1. Move the mouse pointer to the edge of the tab for the sheet you want to move.
2. The mouse pointer changes to a hand.

      
3. Drag the sheet to a new location.

4. When the triangle is in the correct location, release the mouse button.

1-2-3 moves the sheet, the data, and associated range names to the new location.
Tip To move a sheet to a location that is not visible in the window, drag the sheet over the sheet scroll buttons.

Using the menu to move a sheet
1. From the Sheet menu, choose Move or Copy Sheet.
2. Choose "Move."
3. In the "Sheet" box on the left, select the sheet you want to move.

1-2-3 lists all sheets except hidden sheets. You cannot move hidden sheets.
4. Choose "Before" or "After."
5. In the "Sheet" box on the right, select where you want to move the sheet.
6. Click OK.
1-2-3 moves the sheet, the data, and associated range names to the new location.

{button ,AL(`H_123_S98_MOVING_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_123_COPYING_A_SHEET_STEPS;H_COPYING_AND_MOVING_OVER;H_COPYING_AND_MOVI

NG_FORMULAS_OVER',0)} See related topics



Details: Moving a sheet
What happens to formulas?
Formulas adjust just as they do when you move them within a sheet. For more information on moving formulas, see 
Overview: Copying and moving formulas. 

What happens to scripts?
1-2-3 moves scripts attached to graphic objects and ranges with the sheet, as long as the ranges are not 3D ranges. 

How 1-2-3 names a sheet when you move it
If you move a sheet with a letter name like A, B, or C, 1-2-3 assigns a letter to the sheet that is appropriate for its 
position within other sheets. For example, suppose you move sheet D in front of sheet B, the sheet letters adjust to 
their new positions.    Sheet D becomes B, sheet B becomes C, and sheet C becomes D.
If you move a sheet with an assigned name like Expenses, that name does not change.

Moving a sheet that is part of a 3D version
A 3D version is a version that contains a range spanning two or more contiguous sheets.

• You can move a sheet into the middle of a 3D version.
• You cannot move or rearrange sheets that are part of a 3D version.

Moving a sheet into grouped sheets
If you move a sheet into a set of grouped sheets, the sheet you moved will lose its formatting and use the formats of 
the grouped sheets.

Turning drag and drop on and off
If drag and drop is turned off, the mouse pointer will not change to a hand when you try to drag and drop a sheet. To 
turn drag and drop back on, choose File - User Setup - 1-2-3 Preferences (General tab) and select "Drag and drop 
cells and sheets.".

Notes
• You cannot move a sheet if the workbook is locked.
• You cannot move a sheet if the Preview window is open.

{button ,AL(`H_123_S98_MOVING_A_SHEET_STEPS',1)} Go to procedure



Overview: Range names
You can name a range and use the range name in place of the range address. Range names are easy to remember 
and convenient to use in dialog boxes, the InfoBox, scripts, macros, formulas, and @functions.

Ways to use range names
Use range names to identify and select important ranges, and to make formulas easier to write and understand.

Finding and selecting ranges with range names
Using the navigator is an easy way to find and select a named range. Click the navigator to display a list of all named 
ranges in the current workbook. Then, click a range name in the list to find and select the range. When the range is 
selected in the workbook, the range name appears in the selection indicator.

Writing and editing formulas with range names
When you are entering or editing a formula or @function, you can add a range name to the formula by clicking the 
navigator and selecting the name. In addition, when you name a range, 1-2-3 substitutes the range name for the 
address in any existing formulas that reference the range.

Specifying ranges with range names
Using F3 (NAME) is an easy way to insert a range name in a dialog box. When the insertion point is in a field that 
requires a range address or name, press F3 (NAME) to display a dialog box that lists named ranges in all active 
workbooks. To insert the range name, just select it from the list, and click OK. You can also click the range selector in 
a dialog box or the InfoBox, then click the navigator button to display a list of range names.

Range names and versions
You also use range names when creating versions. Only a named range can have versions.

{button ,AL(`H_DELETING_RANGE_NAMES_STEPS;H_USING_THE_NAVIGATOR_TO_FIND_NAMED_RANGES_
STEPS;H_NAMING_A_RANGE_STEPS;H_NAMING_A_RANGE_USING_ADJACENT_LABELS_STEPS;H_NAMI
NG_A_RANGE_USING_THE_INFOBOX_STEPS;H_NAMING_CONVENTIONS_OVER;H_WORKING_WITH_VE
RSIONS_OVER',0)} See related topics



Naming a range
Naming a range makes it easier to find, select, and use in formulas. Use range names in place of range addresses 
when you need to specify a range.
Want the big picture?    See Overview: Range names    

 Show me a QuickDemo
1. Select the range you want to name.
2. From the Range menu, choose Name.
3. Enter a range name in the "Name" box according to the naming conventions.
4. (Optional) To name another range, click Add, use the range selector to select the range, and then repeat step 3.
5. Click OK.

{button ,AL(`H_NAMING_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_NAMING_A_RANGE_USING_THE_INFOBOX_STEPS;H_DELETING_RANGE_NAMES_STEPS;H_

SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS;H_NAMING_A_RANGE_USING_ADJACENT_LABEL
S_STEPS;',0)} See related topics



Details: Naming a range
Multiple names for the same range
You can give a range more than one name. If you give a range an additional name, formulas that contain the range 
will use the range name that comes first alphabetically. 
If the range you selected has more than one name, the name that is first alphabetically appears in the InfoBox.
The number of range names that you create in a workbook is limited only by the amount of available memory.

Tips for using range names
You cannot use the same name for more than one range in the same workbook. 
You can use the navigator to display a list of all named ranges in the current workbook. To find and select a named 
range in the current workbook, just click the navigator and select the name from the list. When the range is selected 
in the workbook, the range name appears in the selection indicator.

When you are editing a formula, you can add a range name to the formula by clicking the navigator and selecting the 
name you want from the list of range names in the current workbook.
Using F3 (NAME) is an easy way to insert a range name in a dialog box. When your insertion point is in a field that 
requires a range address or name, press F3 (NAME) to display a dialog box that lists named ranges in all active 
workbooks. To insert the range name, just select it from the list, and click OK.

Range names in formulas
After you name a range, 1-2-3 substitutes the range name for the address in any existing formulas that reference the 
range.

Saving range names with a workbook
When you save a workbook, 1-2-3 saves the range names with the workbook.

{button ,AL(`H_NAMING_A_RANGE_STEPS',1)} Go to procedure
{button ,AL(`H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;H_USING_FORMULAS_OVER;H_USING_THE

_NAVIGATOR_TO_FIND_NAMED_RANGES_STEPS',0)} See related topics



Naming a range using adjacent labels
A convenient method for naming one or more single-cell ranges is to use labels in adjacent cells. The labels identify 
the cells in the sheet and you avoid typing errors.
Want the big picture?    See Overview: Range names    

 Show me a QuickDemo
1. Select the range containing the labels you want to use as range names.

2. From the Range menu, choose Name.
3. Select an option from the "For cells" list.
4. Click Use Labels.
5. Click Done.

{button ,AL(`H_NAMING_A_RANGE_USING_ADJACENT_LABELS_DETAILS',1)} See details
{button ,AL(`H_NAMING_A_RANGE_USING_THE_INFOBOX_STEPS;H_DELETING_RANGE_NAMES_STEPS;H_

NAMING_A_RANGE_STEPS;H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS',0)} See related 
topics



Details: Naming a range using adjacent labels
Options for adjacent labels
The options in the "For cells" list indicate which single-cell ranges you want to name using adjacent labels.

• To the right -- Names single-cell ranges to the right of the labels. For example, labels in column A name adjacent 
cells in column B.

• To the left -- Names single-cell ranges to the left of the labels. For example, labels in column B name adjacent 
cells in column A.

• Above -- Names single-cell ranges above the labels. For example, labels in row 2 name adjacent cells in row 1.
• Below -- Names single-cell ranges below the labels. For example, labels in row 1 name adjacent cells in row 2.

Naming conventions for labels
The labels that you enter to use as range names must follow the naming conventions.

Tips for using range names
You can use the navigator to display a list of all named ranges in the current workbook. To find and select a named 
range in the current workbook, just click the navigator and select the name from the list. When the range is selected 
in the workbook, the range name appears in the selection indicator.

When you are editing a formula, you can add a range name to the formula by clicking the navigator and selecting the 
name.
Using F3 (NAME) is an easy way to insert a range name in a dialog box. When your insertion point is in a field that 
requires a range address or name, press F3 (NAME) to display a dialog box that lists named ranges in all active 
workbooks. To insert the range name, just select it from the list, and click OK.

Range names in formulas
After you name a range, 1-2-3 substitutes the range name for the address in any existing formulas that reference the 
range.

Saving range names with a workbook
When you save a workbook, 1-2-3 saves the range names with the workbook.

{button ,AL(`H_NAMING_A_RANGE_USING_ADJACENT_LABELS_STEPS',1)} Go to procedure
{button ,AL(`H_USING_FORMULAS_OVER;H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;',0)} See related

topics



Naming a range using the InfoBox
You can name the selected range in the InfoBox instead of using Range - Name. 
Want the big picture?    See Overview: Range names    
1. Select the range you want to name.
2. From the Range menu, choose Range Properties.
3. Click the Basics tab in the InfoBox.

4. Enter a range name in the "Range name" box according to the naming conventions.
5. (Optional) Move, collapse, or close the InfoBox.
Note When a named range is selected, its name appears in the Basics panel of the InfoBox.

{button ,AL(`H_NAMING_A_RANGE_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_NAMING_A_RANGE_STEPS;H_DELETING_RANGE_NAMES_STEPS;H_NAMING_A_RANGE_USI

NG_ADJACENT_LABELS_STEPS;H_USING_THE_INFOBOX_STEPS;H_THE_INFOBOX_OVER',0)} See 
related topics



Details: Naming a range using the InfoBox
Multiple names for the same range
You can give a range more than one name. If you give a range an additional name, formulas that contain the range 
will use the range name that comes first alphabetically.
If the range you selected has more than one name, the name that is first alphabetically appears in the InfoBox.
The number of range names that you create in a workbook is limited only by the amount of available memory.

Tips for using range names
You cannot use the same name for more than one range in the same workbook.
You can use the navigator to display a list of all named ranges in the current workbook. To find and select a named 
range in the current workbook, just click the navigator and select the name from the list. When the range is selected 
in the workbook, the range name appears in the selection indicator.

When you are editing a formula, you can add a range name to the formula by clicking the navigator and selecting the 
name.
Using F3 (NAME) is an easy way to insert a range name in a dialog box. When your insertion point is in a field that 
requires a range address or name, press F3 (NAME) to display a dialog box that lists named ranges in all active 
workbooks. To insert the range name, just select it from the list, and click OK.

Range names in formulas
After you name a range, 1-2-3 substitutes the range name for the address in any existing formulas that reference the 
range.

Saving range names with a workbook
When you save a workbook, 1-2-3 saves the range names with the workbook.

{button ,AL(`H_NAMING_A_RANGE_USING_THE_INFOBOX_STEPS',1)} Go to procedure
{button ,AL(`H_USING_THE_NAVIGATOR_TO_FIND_NAMED_RANGES_STEPS;H_USING_FORMULAS_OVER;H

_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;',0)} See related topics



Deleting range names
You can delete any range name in the current workbook, leaving the data in the range unchanged.
1. From the Range menu, choose Name.
2. To delete individual range names, select a name in the "Existing named ranges" box and click Delete.
3. To delete all range names in the current workbook, click Delete All.

Caution After clicking Delete or Delete All, you cannot restore the deleted range names in the Name dialog box. 
To restore deleted range names, use Edit - Undo immediately after closing the dialog box.

4. Click OK.

{button ,AL(`H_DELETING_RANGE_NAMES_DETAILS',1)} See details
{button ,AL(`H_NAMING_A_RANGE_STEPS;H_RANGE_NAMES_OVER;',0)} See related topics



Details: Deleting range names
Other ways to delete range names
You can also use the InfoBox to delete a range name. Select the range whose name you want to delete and choose 
Range - Range Properties; then click the Basics tab and delete the name in the "Range name" box.

How deleting range names affects formulas
If you delete a range name used in a formula, 1-2-3 replaces the range name with the associated range address.
For example, if SALES is the name of B14..H14, and you delete the name SALES, 1-2-3 changes @SUM(SALES) to 
@SUM(B14..H14).

How deleting range names affects versions
A named range can have one or more versions, and only named ranges can have versions. You cannot delete the 
range name of a range that has versions. You must delete all the versions before deleting the range name.

{button ,AL(`H_DELETING_RANGE_NAMES_STEPS',1)} Go to procedure
{button ,AL(`H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;H_USING_FORMULAS_OVER;H_WORKING_

WITH_VERSIONS_OVER;',0)} See related topics



Naming conventions
Use the following conventions when naming ranges, sheets, Web tables, query tables, and graphic objects, such as 
drawings, charts, and maps.

Name length
Names for ranges and sheets can be up to 15 characters long. Names for graphic objects can be up to 64 characters 
long.

Case-sensitivity in names
1-2-3 is not case-sensitive for names. For example, if you enter "myrange" as a range name, 1-2-3 displays the name
as MYRANGE and considers myrange and MYRANGE as the same name.

Character restrictions
Names for all objects, including sheets and ranges, can contain spaces. However, do not start a name with a space 
or an ! (exclamation point). Also, do not include any of the following:

, (comma) + (plus sign) < (less than)
; (semicolon) - (minus sign) > (greater than)
. (period) * (asterisk) @ (at sign)
? (question mark) / (slash) # (pound sign)
& (ampersand) { (left curly brace)

Naming restrictions
• Do not create names that look like cell addresses, such as Q2 or FY98, or names that begin with numbers, such 

as 20DEC.
• Do not use any of the following as range names: @function names; keyboard key names, such as HOME; macro 

command keywords, such as BEEP; LotusScript commands or keywords. 

{button ,AL(`H_NAMING_A_RANGE_STEPS;H_NAMING_A_SHEET_STEPS;H_NAMING_A_RANGE_USING_ADJ
ACENT_LABELS_STEPS;H_NAMING_A_RANGE_USING_THE_INFOBOX_STEPS;',0)} See related topics



Name dialog box
Use this dialog box to create and delete range names.

Choose a task
Naming a range 
Naming a range using adjacent labels 
Deleting range names 
Selecting a range from a dialog box    



New features in 1-2-3
Lotus® 1-2-3® Release 9 gives you new ways to simplify your work and collaborate with colleagues across 
workgroups, applications, and the Internet. 
For more information, click any topic below:

      Productivity and ease of use
      1-2-3 and the year 2000
      New @functions
      Internet features
      Team computing
      Sharing data using DDE and OLE
      1-2-3 as an Active Document server 
      Programmability
      Compatibility



Compatibility
Upgraders from previous releases of 1-2-3 can use familiar menu commands and macros to perform tasks while 
learning to use new features in 1-2-3. 1-2-3 also provides enhanced compatibility with a range of file types.

1-2-3 Classic
1-2-3 Classic lets you use the 1-2-3 for DOS Release 3.1 menu to perform tasks so you can remain productive while 
you learn to use 1-2-3 in the Windows environment. To use 1-2-3 Classic, just press / (slash) from the current sheet. 
If you don't want to use 1-2-3 for DOS menu commands, you can turn off 1-2-3 Classic.

1-2-3 macros
While LotusScript offers a newer way to automate tasks and develop custom applications, you can continue to use 
existing 1-2-3 macros and macro applications from previous releases of 1-2-3 for DOS and 1-2-3 for Windows. 
For information on macro commands and their LotusScript equivalents, see Overview: Release 5 macro command 
equivalents and Overview: Release 5 info component equivalents.

File formats
1-2-3 saves new files as .123 files, a file type that contains both data and formatting. The file format for SmartMaster 
files is .12M.
You can now open these file types in 1-2-3:

• dBASE (.DBF)
• HTML File (.HTM*)
• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Microsoft Excel (.XLS, .XLT, .XLW)
• Paradox (.DB)
• Quattro Pro (.WQ1, .WB1, .WB2)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)

You can also combine graphics from these file types with the current workbook:
• ANSI Metafile (.CGM)
• Bitmap (.BMP)
• GIF Image (.GIF)
• JPEG Image (.JPG, .JPEG)
• Lotus 1-2-3 PIC (.PIC)
• Windows Metafile (.WMF)

When you save a new file, 1-2-3 automatically uses Lotus 1-2-3 9 Workbook (.123) as the default format. To change 
the default to a different 1-2-3 file type, use File - User Setup - 1-2-3 Preferences (New Workbook Defaults tab).
You can save 1-2-3 files in these file formats:

• dBASE (.DBF)
• Lotus 1-2-3 9 Workbook (.123)
• Lotus 1-2-3 97 Workbook (.123)
• Lotus 1-2-3 OS/2 Warp 4 Workbook (.123)
• Lotus 1-2-3 (.WK4, .WK3, .WK1)
• Lotus 1-2-3 9 SmartMaster (.12M)
• Microsoft Excel 97 Workbook (.XLS)
• Microsoft Excel 5/95 Workbook (.XLS)
• Microsoft Excel 4 Worksheet (.XLS)
• Paradox (.DB)
• Text (.TXT)

Excel compatibility



1-2-3 provides improved support for opening and saving files in different Excel formats, including the ability to open 
and save Excel 97 files containing 65,536 rows. In addition, 1-2-3 has over 50 new @function equivalents for Excel 
functions that make it easier to share files between 1-2-3 and Excel. 
The new Microsoft Excel Menu Finder helps Excel users quickly identify 1-2-3 command equivalents for Excel 
commands. 

Solver
Solver is available as a 1-2-3 add-in. This add-in, which replaces previous versions of Lotus Solver, is a "what if" 
analysis tool that finds the best possible allocation of resources to minimize costs or maximize profits. Solver finds 
answers to problems you define, using either constraint formulas or a formula cell to be minimized or maximized. 
Solver handles problems with up to 200 decision variables. You can use Solver to:

• Schedule employees to better meet customer demands
• Manage cash flow to earn more interest
• Make capital budgeting decisions for different projects within your organization
• Develop an inventory ordering policy

You can still use the following 1-2-3 Solver macro commands:
• {SOLVER-ANSWER}
• {SOLVER-DEFINE}
• {SOLVER-REPORT}

You can install a trial version of Solver, available from both the 1-2-3 Customer Support Web site and the Frontline 
Systems Web site. For more information about Solver, contact:

Frontline Systems, Inc.
PO Box 4288
Incline Village, NV 89450
Tel:          (702) 831-0300
Fax:        (702) 831-0314
Web:      http://www.frontsys.com
E-mail:    info@frontsys.com

{button ,AL(`H_123_CLASSIC_OVER;H_MACRO_COMPATIBILITY_OVER;H_WORKING_WITH_123_FILES_OVER
;H_WORKING_WITH_DBASE_FILES_OVER;H_WORKING_WITH_DBASE_AND_PARADOX_FILES_OVER;H_
WORKING_WITH_EXCEL_FILES_OVER;H_WORKING_WITH_QUATTRO_PRO_FILES_OVER;H_123_WORKI
NG_WITH_DOS_FILES_OVER;H_123_WORKING_WITH_OS2_FILES_OVER;H_123_USING_THE_EXCEL_ME
NU_FINDER_STEPS;H_123_NEW_FUNCTIONS_OVER',0)} See related topics



Internet features
New features let you open and save HTML files, publish your data on the Web, bring data from a Web site into 1-2-3, 
and create hyperlinks.
Some of the features described below are new in 1-2-3 Release 9. Other features were available in 1-2-3 97 but will 
be new to you if you're upgrading from an earlier version of 1-2-3. 

Opening and saving HTML files
Now you can open Lotus eSuite™ spreadsheet files and other HTML files, and combine JPEG and GIF image files 
into a sheet. 
You can also publish 1-2-3 ranges, sheets, and workbooks to the World Wide Web in two formats -- either as HTML 
tables that can be reopened in 1-2-3 or opened in eSuite spreadsheet, or as high fidelity Web pages that look just like
printed output. 

 See related topics

Getting data from the Web
You can also bring data from a Web page on either the Internet or an intranet into a Web table on the sheet. Once 
you create a Web table, 1-2-3 maintains the connection to the source URL. You can change the table's name, Web 
address, display settings, and size, and tell 1-2-3 when and how often to refresh the data from the Web.

 See related topics

Hyperlinks
Hyperlinks let you jump to a location on the Internet, to other files, and to ranges and objects in the current workbook.
You can attach a hyperlink to a cell, button, or picture in 1-2-3.

 See related topics

Easy access to Web sites
When you use the 1-2-3 set of Internet SmartIcons, you can access the Lotus home page, Lotus customer support 
page, Lotus FTP server, and the Yahoo search engine with one click. 
You can open files from the Web and FTP servers, and save workbook files to FTP servers. To simplify access, 1-2-3 
maintains a list of the most recently used FTP and HTTP server addresses.
1-2-3 supports popular Web browsers, including Netscape, Microsoft Internet Explorer, and the Personal Web 
Navigator.

 See related topics

{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_CONVERTING_A_RANGE_SH
EET_OR_WORKBOOK_TO_A_WEB_GRAPHIC_STEPS;H_123_CONVERTING_A_RANGE_SHEET_OR_WOR
KBOOK_TO_A_WEB_GRAPHIC_STEPS',0)} See related topics



New @functions
1-2-3 includes over 50 new engineering, financial, statistical, and other @functions. Click the @function selector to 
see a list of all the 1-2-3 and custom @functions available.

You can also create your own @functions using LotusScript.

 See related topics
The following @functions are new in 1-2-3 Release 9.

Calendar
@YEARFRAC 

Database
@COUNTIF 
@SUMIF 

Engineering
@BIN2DEC 
@BIN2HEX 
@BIN2OCT 
@CONVERT 
@DEC2BIN 
@DEC2HEX 
@DEC2OCT 
@HEX2BIN 
@HEX2DEC 
@HEX2OCT 
@OCT2BIN 
@OCT2DEC 
@OCT2HEX 
@RADIX    

Financial
@COUPDAYBS 
@COUPDAYS 
@COUPDAYSNC 
@COUPNCD 
@COUPNUM 
@COUPPCD 
@DEC2FRAC 
@DISC 
@FRAC2DEC 
@INTRATE 
@PRICEDISC 
@PRICEMAT 
@RECEIVED 
@TBILLEQ 
@TBILLPRICE 
@TBILLYIELD 



@YIELDDISC 
@YIELDMAT 

Information
@COLUMN 
@ROW 
@SHEET 

Mathematical
@RANDBETWEEN 

Statistical
@CONFIDENCE 
@COUNTBLANK 
@EXPONDIST 
@FISHER 
@FISHERINV 
@HYPGEOMDIST 
@LOGINV 
@LOGNORMDIST 
@MODE 
@NEGBINOMDIST 
@NORMSINV 
@PROB 
@RSQ 
@STANDARDIZE 
@STEYX 
@SUMX2MY2 
@SUMX2PY2 
@TRIMMEAN 
@WEIBULL 

{button ,AL(`H_PROGRAMMABILITY_OVER;H_FUNC_BASICS',0)} See related topics



Overview: Installing additional language versions of 1-2-3
You can access 1-2-3 in multiple languages. 
The first language you install becomes your default language. To add a second or third language version of 1-2-3, 
you must run the Install program again. Install informs you that you already have an existing copy of the product in a 
different language and preserves the directory structure of the default language. 
Install adds icons for the additional languages to the Start menu. These icons are identified by the two-character ISO 
language tag. For example, the icon for the French version of 1-2-3 is labeled Lotus 1-2-3 - FR. 



Productivity and ease of use
New or improved features make 1-2-3 more intuitive and easy to use and let you focus on working more effectively. 
Some of the features described below are new in 1-2-3 Release 9. Other features were available in 1-2-3 97 but will 
be new to you if you're upgrading from an earlier version of 1-2-3. 

Shared Lotus user interface
1-2-3 has the same menu structure as other Lotus applications such as Word Pro, Approach, and Freelance 
Graphics. Other shared features include SmartIcons®, the status bar, and the InfoBox. The consistent user interface 
lets you transfer your knowledge from one Lotus product to another and reduce the time needed to get up and 
running.

Context-sensitive menus
Context-sensitive menus are new to you if you're upgrading from an earlier version of 1-2-3 than 1-2-3 97. The 1-2-3 
main menu changes depending on the type of object you're working with, so the commands you need are always at 
hand. 

 See related topics

InfoBox
The InfoBox is also new in 1-2-3 97. Use the InfoBox to view and change properties for any object in 1-2-3 without 
interrupting your work to open or close a dialog box. You see all changes that you make in the InfoBox as you make 
them. You can leave the InfoBox open while you work, or collapse it to view more of your workspace.

 See related topics

Entering data
Each sheet now contains 65,536 rows. 
When you enter a 2-digit year, 1-2-3 uses a sliding window to determine whether the year falls in the 20th or 21st 
century. If you turn off the sliding window, 1-2-3 assumes any 2-digit years that you enter are in the 20th century. 
New in 1-2-3 97, cell comments let you annotate data in the sheet. When you add cell comments, 1-2-3 automatically
adds a date/time stamp so you can track the comments of multiple contributors.

 See related topics

SmartLabels
Use handy new SmartLabels to perform calculations quickly without entering a formula or @function. For example, 
you can type SUBTOTAL or AVERAGE and let 1-2-3 calculate the result for you. You can also assign different 
number formats to SmartLabels and create your own custom SmartLabels.

 See related topics

SmartFill and smarter formatting
Filling a range with a sequence of text, dates, or times is quicker and easier with SmartFill. Now when you fill a range 
by example, 1-2-3 anticipates what you want and enters suggested text for you. For example, if you enter 'February' 
in a cell and then type 'M' in the next cell, 1-2-3 automatically adds 'arch' and waits for you to accept the entry or type 
different text. 
1-2-3 also formats formula results based on the data used in the formula. For example, if you sum a range of data 
that has a particular number format, 1-2-3 applies the same number format to the result. 1-2-3 also formats the 
results of most financial @functions using your local currency setting. 

 See related topics

Copying and moving
Use the mouse to copy and move sheets by dragging the sheet tab. Or choose Move or Copy Sheet from the Sheet 
menu.
You can also copy column widths and row heights, with or without the data in the selected cells.



 See related topics

Outlining
New in 1-2-3 97, outlining lets you control how you view summary and detail data in the sheet. You can collapse or 
expand groups of rows and columns to view or print just the data you want.

 See related topics

Print preview
Dynamic print preview, introduced in 1-2-3 97, lets you check your work before you print it, make whatever 
adjustments are necessary, and see the effects of those changes immediately. 
New enhancements let you create multi-line headers and footers, set header and footer height, and print multiple 
sheets or ranges on one page or separate pages. You can also adjust margins directly by dragging them with the 
mouse, and choose whether to display or hide them. To add or remove page breaks, use the new Page Break 
command on the Edit menu.

 See related topics

Working with databases
The current release of 1-2-3 gives you two different ways to work with databases. 
1-2-3 and Approach® are installed together so you can tap into Approach's powerful database features from within 1-
2-3. Use 1-2-3 with Approach to create and work with data query tables, dynamic crosstabs, data entry forms, mailing
labels, and reports. You can use query tables to find or sort records extracted from a larger database, and 
dynamically rearrange data in a 1-2-3 range by dragging and dropping field names from one location to another.
The Data Query Add-In (DQA) provides functionality very similar to that of 1-2-3 for Windows Release 5. Once you 
load the add-in, you can work with query tables created in either 1-2-3 for Windows Release 5 or the 1-2-3 97 Query 
Table Add-In.

 See related topics

Aligning drawn objects
You can align charts, maps, and other graphic objects by making their edges snap to the grid lines in the sheet. 

 See related topics

Help
New Help features include the Expert and the Microsoft Excel Menu Finder. 
The Expert helps you find out how to perform different tasks in 1-2-3. Just tell the Expert what you want to do, and 
then select the Help topic you want from a list of possible answers. 
The Microsoft Excel Menu Finder makes it easy for Excel users to work in 1-2-3. Simply choose an Excel command 
to display the name of the equivalent 1-2-3 command.
Several additional Help features are new to you if you're upgrading from an earlier version of 1-2-3 than 1-2-3 97. 
These include a book-like table of contents and index, full-text search, and animated QuickDemos that show you how
to perform various tasks in 1-2-3.
Try using bubble help as a handy way to explore the 1-2-3 workspace. Just rest the pointer over different SmartIcons 
to see a pop-up description. Or rest the pointer over the various tabs in the InfoBox to find out what types of tasks you
can perform.

 See related topics

Lotus Assistants
Lotus Assistants, also available in 1-2-3 97, give you step-by-step instructions for performing complex tasks such as 
creating charts, maps, and query tables, for working with 1-2-3 data in Lotus Approach, and for managing multiple 
versions of data.



ViaVoice in 1-2-3
This release of Lotus 1-2-3 includes a seamlessly integrated, custom version of IBM ViaVoice™ software. With voice-
activated 1-2-3 SmartMasters and ViaVoice, you can enter data into 1-2-3 spreadsheets by dictation. You can obtain 
these voice-activated SmartMasters on the Web at www.lotus.com/smartsuiteupdates or by contacting Lotus Support.



Programmability
1-2-3 offers new ways to automate your work, streamline tasks, and develop custom applications.
Some of the features described below are new in 1-2-3 Release 9. Other features were available in 1-2-3 97 but will 
be new to you if you're upgrading from an earlier version of 1-2-3. 

LotusScript
If you're upgrading from a 1-2-3 release prior to 1-2-3 97, LotusScript® is new to you. This object-oriented 
programming language lets you automate your work in 1-2-3 and other Lotus products, create custom applications, 
and integrate data from other Windows applications. You can use LotusScript for a wide variety of tasks, from 
performing simple commands to developing complex cross-product applications. 
Because 1-2-3 provides the same development environment as other Lotus applications, it's easier to create, debug, 
and run programming applications. LotusScript is compatible with Visual Basic.
This release of 1-2-3 includes additional LotusScript support for new features. Also, you can now attach Click events 
to pictures and ranges.

 See related topics

ActiveX and JavaBean controls
Application developers can embed ActiveX and JavaBean controls in a 1-2-3 workbook and attach scripts to them to 
create custom spreadsheet applications. ActiveX controls include user interface elements such as buttons, check 
boxes, and text boxes. JavaBeans are self-contained objects that are similar to controls. 
A special command on the View menu lets you switch between Design and Run modes when you create and test the 
controls. 

 See related topics

Macros
If you're upgrading from a previous release of 1-2-3, you can continue to use familiar 1-2-3 macro commands to 
perform tasks and automate procedures.    

 See related topics

Actions menu
New in 1-2-3 97, the 1-2-3 Actions menu lets you quickly add custom menu commands to the 1-2-3 menu. This menu
appears in a 1-2-3 embedded object when you publish a Notes action. Commands in this menu can include 
NotesFlow commands and prompted Script commands.

 See related topics



Sharing data using DDE and OLE
1-2-3 Release 9 supports Dynamic Data Exchange (DDE) and can be used as an Active Document server. 
Object Linking and Embedding (OLE) was available in 1-2-3 97 but may be new to you if you're upgrading from an 
earlier version of 1-2-3. 1-2-3 Release 9 lets you create a new type of OLE link called a datalink table which stores 
the linked data directly in the sheet. 

DDE
1-2-3 lets you create and use DDE links to data in other Windows applications that are DDE servers. In addition, you 
can use DDE macros and LotusScript commands. You can also open files containing DDE links that were created in 
previous versions of 1-2-3.

1-2-3 as an Active Document server
You can open and work with 1-2-3 files directly from inside Active Document containers such as Microsoft Internet 
Explorer. For example, when you choose Open from the Internet Explorer File menu and select a .123 file, 1-2-3 
opens in the Explorer window and displays the specified file. You can use the 1-2-3 menu, SmartIcons, and status bar
to work with the file and save your changes as you normally do in 1-2-3.

Full OLE support
Full OLE support makes it easier to edit embedded objects from other applications because the 1-2-3 main menu 
switches to reflect the commands you need. For example, when you edit an embedded Freelance Graphics® object 
in 1-2-3, the 1-2-3 main menu integrates the Freelance® menus so you can continue to work in 1-2-3. In addition, 
embedded objects reflect your changes immediately, so you don't need to explicitly update them.
Similarly, when you edit an embedded 1-2-3 object in another application that supports OLE, that application's menu 
changes to display 1-2-3 commands. For example, if you edit an embedded 1-2-3 object in Word Pro, you can 
choose 1-2-3 commands directly in Word Pro.

Datalink tables
When you create an OLE link using Clipboard data in Text, .WK1, or .WK3 format, 1-2-3 creates a datalink table and 
enters the linked data directly in the sheet. Datalink tables can include text and numbers. 
You can copy and move the datalink table, format the linked data, use it to perform calculations, and choose when to 
update the link. 

OLE automation
OLE automation capabilities let you develop cross-product scripts that can interact with and control products and their
objects from outside. In other words, you can program other products to automate repetitive tasks. 
You can use other products that support OLE automation to externally access and manipulate 1-2-3 and objects in it. 
For example, you can create a script in a Notes document that uses OLE automation to perform calculations in 1-2-3 
and then bring the data back into Notes.
It's just as easy to use 1-2-3 to control other products using OLE automation. For example, you can use 1-2-3 to 
access Word Pro and Freelance Graphics, and then bring the text and graphics back into 1-2-3 where you can 
consolidate them with your data for a monthly report.

{button ,AL(`H_SHARING_DATA_USING_OLE2_OVER;H_123_DDE_OVER;H_123_AS_ACTIVE_DOC_SERVER_
OVER;H_123_WORKING_WITH_DATALINK_TABLES_OVER',0)} See related topics



Team computing
Team computing features help you communicate, collaborate, and coordinate with others in your organization to work
together more effectively.
If you're upgrading from a 1-2-3 release earlier than 1-2-3 97, the team computing features described below will be 
new to you.

TeamMail
TeamMail™ provides enhanced electronic mail support that lets you distribute data to co-workers -- from a message 
to an entire 1-2-3 workbook. You can send data to a group of people simultaneously, or route the data sequentially 
from one individual to the next in a mailing list. After reviewing the data, individuals can incorporate their updates and 
comments before routing the data to the next recipient. You can also save and reuse mailing lists for subsequent 
routing.

TeamReview
Like TeamMail, TeamReview™ lets you distribute a range of data to your co-workers simultaneously or individually. 
When you have received changes and comments from the recipients, you can replace the original data with the new, 
or merge the changes into the source as range versions.

TeamConsolidate
TeamConsolidate™ facilitates group collaboration by tapping into the power of Lotus Notes®. You can split a 1-2-3 
workbook into individual sheets, and then save the sheets as separate documents in a Notes™ database. After team 
members view and update the information, you can consolidate their changes by recombining the separate 
documents into a single workbook.
TeamConsolidate also lets you merge separate versions of data when you share 1-2-3 workbooks. You can create a 
master copy of the workbook, and then distribute copies to your co-workers. After they enter versions in their copies 
of the original workbook, you can use TeamConsolidate to merge their updates back into the original file.

NotesFlow
NotesFlow™ lets you develop custom workflow applications using Notes Release 4.1 or higher and Object Linking 
and Embedding (OLE).
You create a NotesFlow form in Notes and associate menu commands with the form. Each command runs a 
particular script that you specify. When you use the form to work with an embedded 1-2-3 object, the NotesFlow 
commands appear on the Actions menu in both Notes and 1-2-3. When you choose a NotesFlow command in 1-2-3, 
the command runs the appropriate script.

Version Manager
1-2-3 comes with Version Manager™ enhancements that simplify creating, updating, and viewing multiple sets of 
data in the same range. It's also easier to work with groups of selected versions to analyze the effects of various 
scenarios.

{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_TEAMMAIL_OVER;H_TEAMREVIEW_OVER;H_SHARE_S
HEETS_USING_NOTES_OVER;H_SHARING_VERSIONS_WITH_A_TEAM_OVER',0)} See related topics



1-2-3 @Function Help is not available
Help on @functions is not currently installed. For information, see Installing Help on individual @functions.    



1-2-3 Macro Help is not available
Help on macros is not currently installed. For information, see Installing Help on macro commands.    



1-2-3 LotusScript Help is not available
Help on LotusScript is not currently installed. For information, see Installing Help on LotusScript. 



Help is not available
The Help topic you selected is not available. Click Go Back to see the previously displayed Help topic, or click Help 
Topics and then select a different Help topic.



Help is not available
The topic you selected is in a Help file that is not available. 
To install additional Help files, run the Install program, select the Customize features - Manual install option, and 
specify the Help file(s) you want to install.



Macro Help is not available
The topic you selected is in a Help file that is not installed by the Install program. 
If you have the 1-2-3 Release 9 or SmartSuite CD-ROM, you can install macro Help from there. If not, you can 
download macro Help from the World Wide Web or order a copy from Lotus Customer Support. For more information,
see Installing Help on macro commands. 



Overview: Selecting graphic objects
To work with a graphic object, you must first select it. After you select the object, you can move it, copy it, delete it, or 
change its properties. 
When you select an object, its menu appears in the main menu. For example, if you select a chart, the Chart menu 
appears.

Graphic objects you can select
You can select any of the following objects:

• Buttons (attached to macros or scripts) 
• Charts and chart parts
• Embedded objects
• Lines, arrows, and shapes (such as rectangles, ellipses, and polygons)
• Maps and map parts
• Text blocks
• Pictures

The appearance of a selected object
When you select an object, handles appear around it. The name of the object appears in the selection indicator.

Selecting more than one object
You can select more than one object to move or style them together. Hold down SHIFT as you select each object.

Selecting an object by its name
You can use Edit - Go To to find and select a graphic object in any active file. 

{button ,AL(`H_FINDING_RANGES_AND_OTHER_OBJECTS_STEPS;H_QUICK_SUMMARY_OF_SELECTION_TE
CHNIQUES_FOR_OBJECTS_OVER;H_SELECTING_WORKSHEET_AREAS_OVER;',0)} See related topics



Selecting graphic objects
To work with a graphic object, you must first select it. The table below describes how to select various objects.

To select Do this
Button SHIFT+click the button.
Chart Click the border of the chart. 
Chart part Click the part of the chart you want.
Embedded object Click the embedded object.
Collection of objects Click the first object, then SHIFT+click the others.
Line or arrow Click the line or arrow.
Map Click the border of the map.
Map part Click the part of the map you want.
Picture Click the picture.
Shape Click the border of the shape or a line in the shape.
Text block Click the text block.

To remove an object from a selection, SHIFT+click the object.

Selecting objects that are not visible at the same time
Objects do not all have to be visible simultaneously to select them. You can select objects in different parts of the 
same sheet by selecting the first object, then holding down SHIFT while you use the mouse to navigate to and select 
the next one(s).

Related SmartIcons

Selects several objects

Groups selected objects

Ungroups selected objects

Brings selected objects to the front

Sends selected objects to the back

{button ,AL(`H_SELECTING_OBJECTS_OVER;',0)} See related topics



1-2-3 and FastSite
Once you add a 1-2-3® file to a FastSite site, you still can make changes to the Web conversion format and to a 
subset of the Web conversion options you've already selected for the file in 1-2-3.
You can publish 1-2-3 files as HTML pages or as jDoc documents. If you publish a file as an HTML page, FastSite 
retains the formulas in the file, and the file can be read back into 1-2-3. If you publish a file as a jDoc document, 
FastSite uses the jDoc technology to create a compact, cross-platform, high-fidelity replica of a file that retains its 
original formatting.

Changing the conversion format
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the 1-2-3 file.
2. Select Properties.
3. Under Conversion format, select "HTML pages," "jDoc document," or "File Defaults."
Note For more information on 1-2-3 file defaults, see the 1-2-3 Help.

Changing Web publishing options
1. In the site hierarchy, which is the left pane of the FastSite desktop, right-click the 1-2-3 file.
2. Select Properties.
3. Click 1-2-3 Publishing Options.
4. Under Conversion format, select one of the following options:

• "HTML pages" if you want to publish a selected range
• "jDoc" if you want to publish the whole workbook, a selected sheet, or a selected range
• "File defaults" if you want to keep the publishing options you set in 1-2-3

Tip If you want to publish an unnamed range, publish the range first in 1-2-3 and save the file. When you change 
Web publishing options in FastSite, choose "File defaults."
5. Click OK.

Supported file types
You can include the following types of 1-2-3 files in a FastSite site:

File type File extension
1-2-3 97 and later  .123
1-2-3 Release 4  .WK4
1-2-3 Release 3  .WK3
1-2-3 Release 1  .WK1

{button ,AL(`H_123_WHAT_IS_ODYSSEY_OVER',0)} See related topics



FastSite and the other SmartSuite applications
FastSite, the newest member of Lotus SmartSuite®, is designed for users who want to contribute information to a 
Web site. You can use FastSite even if you're not a Webmaster and you don't need to know HTML.
FastSite lets you do the following:

• Create and manage Web sites.
• Post existing SmartSuite® documents to the Web without having to copy and reformat them.
• Use ready-made Web SmartMaster looks to give your site a cohesive and professional look.
• Seamlessly update your information once it's on the Web.

Once you create a Web site, you can post it to any Web server. For example, you can post the Web site to a 
Domino™ server where FastSite takes advantage of the Domino search technology. 

Using FastSite
To use FastSite, from the Start menu, choose Programs - Lotus SmartSuite - FastSite. Then on the Choose Task tab, 
click "Create a new site." FastSite guides you through the steps for creating a site.

FastSite and SmartSuite files
When you include SmartSuite files in a FastSite site, FastSite provides Web publishing information about each file -- 
or a subset of it, depending on the application -- that you can change without leaving FastSite. For more information, 
see 1-2-3 and FastSite.



Overview: Creating an outline
Outlining lets you expand and collapse areas of a sheet to see and print different levels of detail. You can create an 
outline with up to eight levels of rows and columns. 

Benefits of outlining
Outlining is useful for viewing and printing summary reports. Often, spreadsheet summary data -- such as a total for 
the 12 months of a year -- is hard to find, and requires a lot of scrolling. Outlining makes it easy to hide rows and 
columns of details so that you can see summary data. When you need to see the details, you can expand the outline.

 Show me a QuickDemo

Creating an outline
Creating an outline requires three general steps. 
1. Before outlining a range of data, plan the outline by analyzing the levels and layout of the data in the range. 

Identify the hierarchy of summary and detail data. Determine which rows and columns contain the highest level of
summary data, which contain the next highest level of summary data, and so on, down to the detail data.
The example below shows an outline of a range containing sales data by quarter. The highest level columns are A
(Regions) and F (1998 Totals). In the outline, 1998 Total is the summary column. Columns B through E, showing 
quarterly data, are detail columns. Row 8 is the summary row, and rows 4 through 7, containing regional data, are
detail rows. 

2. Next, determine where summary data is in relation to its detail data. Are summary rows above or below related 
detail rows? Are summary columns to the right or left of detail columns? The answer to these questions will 
determine how you set properties to expand and collapse your outline.
In the example, the summary column (F), is to the right of the detail columns, and the detail rows are above the 
summary row (8). Use Sheet - Sheet Properties (Outline tab) to reflect this orientation. See Specifying how 
summary data relates to detail data.

3. Finally, you are ready to demote the lower level rows or columns to create the levels of your outline. See 
Demoting rows and columns to create an outline. 
With the rows and columns demoted, you can collapse the outline to hide the detail rows and columns, and show 
only the summary data.



{button ,AL(`H_CREATING_AN_OUTLINE_EX',1)} See example
{button ,AL(`H_WORKING_WITH_OUTLINES_OVER;H_DEMOTING_ROWS_AND_COLUMNS_STEPS;H_PROMO

TING_ROWS_AND_COLUMNS_STEPS;H_SETTING_OUTLINE_PROPERTIES_STEPS;H_HIDING_AND_SHO
WING_THE_OUTLINE_FRAME_STEPS;H_COLLAPSING_OUTLINES_STEPS;H_EXPANDING_OUTLINES_ST
EPS;H_CLEARING_OUTLINES_STEPS;',0)} See related topics



Example: Creating an outline
This example shows an outline of a range containing sales data by quarter. The highest level columns are A 
(Regions) and F (1997 Totals). In the outline, 1997 Totals is the summary column. Columns B through E, showing 
quarterly data, are detail columns. Row 8 is the summary row, and rows 4 through 7, containing data by quarter, are 
detail rows. 
The summary column (F) is to the right of the detail columns, and the detail rows are above the summary row (8).

With rows 4 through 7 demoted and collapsed, the outline looks like this: 

With columns B through E demoted and collapsed, the outline looks like this:



Overview: Working with rows and columns in outlines
In general, you can size, insert, delete, move, and copy rows and columns when the outline frame is displayed as you
would any rows and columns in a sheet.

Inserting rows and columns
You can insert rows or columns from within an outline by choosing Range - Insert. 

• When you insert rows from within an outline, the inserted rows are placed at the same level as the row above the 
insertion point. 

• When you insert columns from within an outline, the inserted columns are placed at the same level as the column 
to the left of the insertion point. 

Deleting rows and columns
When you delete a summary row or column, the associated detail rows or columns are promoted to the same outline 
level as the summary row or column you deleted. 

Moving rows or columns
When you move a summary row or column from within an outline, 1-2-3 moves the data and styles, but not the 
outline structure. 

Copying rows or columns
When you copy and paste a row or column of data from within an outline, 1-2-3 copies the data and styles, but not 
the outline structure. 

{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;H_INSERTING_COLUMNS_OR_ROWS_STEPS;H_DELETING_
COLUMNS_OR_ROWS_STEPS;H_COPYING_AND_MOVING_IN_A_SHEET_STEPS;',0)} See related topics



Demoting rows and columns to create an outline
Demote groups of rows, and then columns, to create an outline or change the structure of an existing outline. 

 Show me a QuickDemo
1. Make sure you have specified how summary data relates to detail data.
2. Select the row numbers or column letters for the rows or columns you want to demote. 

Don't include summary rows or summary columns in your selection.
3. Choose Sheet - Outline - Demote Rows, or Sheet - Outline - Demote Columns. 

1-2-3 inserts an outline frame along the left (for demoted rows) or top (for demoted columns) of your sheet. 

{button ,AL(`H_DEMOTING_ROWS_AND_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_PROMOTING_ROWS_AND_COLUMNS_STEPS;H_OUTLINING_SHEET_DATA_OVER;H_EXPANDI

NG_OUTLINES_STEPS;H_COLLAPSING_OUTLINES_STEPS;',0)} See related topics



Details: Demoting rows and columns to create an outline
Selecting rows and columns to demote
You can select the entire row or column, or just a cell in the row or column. To select more than one row or column, 
you can select cells to indicate the range of columns or rows you want to demote. If you select a range of cells or a 
collection of ranges, and then choose Sheet - Outline - Demote, 1-2-3 displays a dialog to allow you to specify 
whether you want to demote rows or columns.

Number of outline levels
You can create up to eight outline levels.

Related SmartIcons

Demotes the selected rows or columns down one outline level

Promotes the selected rows or columns up one outline level

{button ,AL(`H_DEMOTING_ROWS_AND_COLUMNS_STEPS',1)} Go to procedure



Promoting rows and columns
Promote groups of rows and columns to move them up one level in an outline. 
1. Select the demoted row(s) or columns(s) you want to promote. 

Don't include summary rows or columns in your selection. 
2. Choose Sheet - Outline - Promote Rows, or Sheet - Outline - Promote Columns. 

{button ,AL(`H_PROMOTING_ROWS_AND_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;H_DEMOTING_ROWS_AND_COLUMNS_STEPS;H_EXPANDIN

G_OUTLINES_STEPS;H_COLLAPSING_OUTLINES_STEPS;',0)} See related topics



Details: Promoting rows and columns
Selecting rows and columns to promote
You can select the entire row or column, or just a cell in the row or column. To select more than one row or column, 
you can select cells to indicate the range of columns or rows you want to promote. If you select a range of cells or a 
collection of ranges, and then choose Sheet - Outline - Promote, 1-2-3 displays a dialog to allow you to specify 
whether you want to promote rows or columns.

Related SmartIcons

Demotes the selected rows or columns down one outline level

Promotes the selected rows or columns up one outline level

{button ,AL(`H_PROMOTING_ROWS_AND_COLUMNS_STEPS',1)} Go to procedure



Collapsing an outline to show less detail
You can collapse rows or columns to show less detail and to emphasize summary data. 

 Show me a QuickDemo
1. To collapse a single outlined section of the sheet to a particular level, click the minus sign for the level you want to

collapse. 
2. To collapse all outlined sections of the sheet to a particular level, click the outline-level button corresponding to 

that level. 

{button ,AL(`H_COLLAPSING_OUTLINES_DETAILS',1)} See details
{button ,AL(`H_EXPANDING_OUTLINES_STEPS;H_OUTLINING_SHEET_DATA_OVER;H_DEMOTING_ROWS_AN

D_COLUMNS_STEPS;H_PROMOTING_ROWS_AND_COLUMNS_STEPS;',0)} See related topics



Details: Collapsing an outline to show less detail
Using menu commands to collapse an outline
You must use menu commands to collapse an outline if the outline frame is hidden. 
Select a range of entire rows or columns to collapse, and then choose Sheet - Outline - Collapse. Or, select a range 
including at least one cell in each row or column you want to collapse, and then choose Sheet - Outline - Collapse, 
select Rows or Columns, and click OK. 

Using outline-level buttons to collapse and expand an outline
1-2-3 displays outline-level buttons for each level in the outline. The outer buttons collapse the outline and the inner 
buttons expand the outline. For example:

• Clicking the far left outline-level button for rows collapses the entire outline.
• Clicking the far right outline-level button for rows expands the entire outline. 
• If the outline contains more than two levels, you can click a middle outline-level button to collapse or expand the 

outline to the level of detail you want to show. For example, if your outline has four row levels, clicking the third 
outline-level button from the left collapses or expands the outline to the third level.

Effects of collapsing rows and columns
The following conditions are in effect when rows or columns are collapsed.

• You cannot use Edit - Go To to jump to a collapsed range.
• Collapsed rows and columns do not print.
• You can still perform 1-2-3 operations--such as summing a range of cells--on ranges in collapsed rows or 

columns. To perform a command on a range in a collapsed row or column, enter the address or range name in a 
dialog box or select the surrounding rows or columns.

• Formulas containing references to ranges in collapsed rows or columns still work correctly. When creating a 
formula that refers to data in a collapsed row or column, enter the range name or address in the formula instead 
of selecting it.

• You can prevent changes to data in collapsed rows or columns only by protecting the data and locking the sheet 
or workbook.

Related SmartIcons

Expands columns or rows in the selected range

Collapses columns or rows in the selected range

{button ,AL(`H_COLLAPSING_OUTLINES_STEPS',1)} Go to procedure
{button ,AL(`H_HIDING_AND_SHOWING_THE_OUTLINE_FRAME_STEPS',0)} See related topics



Expanding an outline to show more detail
You can expand rows or columns to show more detail.

 Show me a QuickDemo
1. To expand a single outlined section of the sheet to a particular level, click the plus sign for the level you want to 

expand.
2. To expand all outlined sections of the sheet to a particular level, click the outline-level button corresponding to that

level. 

{button ,AL(`H_EXPANDING_OUTLINES_DETAILS',1)} See details
{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;H_COLLAPSING_OUTLINES_STEPS;H_PROMOTING_ROWS_

AND_COLUMNS_STEPS;H_DEMOTING_ROWS_AND_COLUMNS_STEPS;',0)} See related topics



Details: Expanding an outline to show more detail
Using menu commands to expand an outline
You must use menu commands to expand an outline if the outline frame is hidden.
Select the rows or columns on either side of the rows or columns you want to expand, and then choose Sheet - 
Outline - Expand. For example, to expand rows 4 and 5, select rows 3 and 6. 

Using outline-level buttons to collapse and expand an outline
1-2-3 displays outline-level buttons for each level in the outline. The outer buttons collapse the outline and the inner 
buttons expand the outline. For example:

• Clicking the far left outline-level button for rows collapses the entire outline.
• Clicking the far right outline-level button for rows expands the entire outline. 
• If the outline contains more than two levels, you can click a middle outline-level button to collapse or expand the 

outline to the level of detail you want to show. For example, if your outline has four row levels, clicking the third 
outline-level button from the left collapses or expands the outline to the third level.

Related SmartIcons

Expand columns or rows in the selected range

Collapse columns or rows in the selected range

{button ,AL(`H_EXPANDING_OUTLINES_STEPS',1)} Go to procedure



Specifying how summary data relates to detail data
Before you create an outline, you must specify the position of summary rows and columns with respect to detail rows 
and columns. These settings are for the entire sheet. 
1. Choose Sheet - Sheet Properties. 

2. Click the Outline tab. 

3. Under Row outline, select "Show outline frame" and then select: 
• "Above detail" if summary data is in a row above detail data
• "Below detail" if summary data is in a row below detail data

4. Under Column outline, select "Show outline frame" and then select:
• "To the left of detail" if summary data is in a column to the left of detail data
• "To the right of detail" if summary data is in a column to the right of detail data

5. (Optional) Move, collapse, or close the InfoBox. 
Note If you change the orientation for rows in an existing outline, the outline for rows is cleared. If you change the 
orientation for columns, the outline for columns is cleared. 

{button ,AL(`H_SETTING_OUTLINE_PROPERTIES_DETAILS',1)} See details
{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;H_HIDING_AND_SHOWING_THE_OUTLINE_FRAME_STEPS;',

0)} See related topics



Details: Specifying how summary data relates to detail data
Showing the outline frame
Selecting "Show outline frame" under either Row outline or Column outline displays the outline frame. 
Note If you turn off an outline frame and then promote or demote any rows or columns, 1-2-3 redisplays the outline 
frame.

{button ,AL(`H_SETTING_OUTLINE_PROPERTIES_STEPS',1)} Go to procedure



Showing and hiding the outline frame
When you promote or demote rows or columns to create or change an outline, 1-2-3 displays the outline frame. If you
do not want to show the outline frame, you can hide it.
1. Choose Sheet - Sheet Properties.

2. Click the Outline tab.

3. Under Row outline or Column outline, select or deselect "Show outline frame." 
Note If you promote or demote rows or columns when the outline frame is hidden, 1-2-3 shows the frame.

{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;',0)} See related topics



Removing an outline
You can remove an outline in the current sheet. This does not delete any sheet data.
1. Select any cell in the sheet with the outline you want to clear. 
2. Choose Sheet - Outline - Clear Outline. 

The column and row outline frames are no longer displayed and all collapsed rows and columns are expanded. 

{button ,AL(`H_CLEARING_OUTLINES_DETAILS',1)} See details
{button ,AL(`H_OUTLINING_SHEET_DATA_OVER;',0)} See related topics



Details: Removing an outline
Hiding the outline frame
If you don't want to remove the outline, you can hide it using Sheet - Sheet Properties (Outline tab). 
Note You cannot remove the outline frame when it is hidden.

Removing a single outline level
To remove a single outline level, select the columns or rows in the range and choose Sheet - Outline - Promote Rows
or Sheet - Outline - Promote Columns. 

{button ,AL(`H_CLEARING_OUTLINES_STEPS',1)} Go to procedure



Overview: Print and page properties
When you choose File - Preview & Page Setup, 1-2-3 displays the current workbook in a window on the left and the 
Preview window on the right. 1-2-3 also opens the InfoBox so you can easily customize print and page settings as 
you preview your work.
When you change a setting in the InfoBox, 1-2-3 automatically updates the Preview window. 1-2-3 also saves print 
and page settings with the workbook file.
While previewing your work, you can change the following print and page settings:

• Choose what to print, including charts, maps, drawings, the sheet row and column frame, grid lines, formulas, and
cell comments

• Set page numbers
• Change print margins
• Change the page orientation
• Center a selection on the page for printing
• Choose how to fit your work on the page
• Add headers and footers
• Include print titles on each page
• Create and use named print settings
• Change paper size

{button ,AL(`H_NS_PRINT_OVER;H_PRINT_ADDING_HEADERS_AND_FOOTERS_STEPS;H_PRINT_ADDING_TI
TLES_ON_EACH_PAGE_STEPS;H_PRINT_CENTERING_DATA_STEPS;H_PRINT_CHANGE_MARGINS_STEP
S;H_PRINT_CHANGING_PAGE_ORIENTATION_STEPS;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT
_CHOOSING_THE_PAPER_SIZE_STEPS;H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRI
NT_NUMBERING_PAGES_STEPS;H_PRINT_CHANGING_FONTS_HEADERS_FOOTERS_STEPS;H_123_PRI
NTING_CELL_COMMENTS_AND_FORMULAS_STEPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAM
ES_STEPS',0)} See related topics



Changing font properties for headers and footers
You can change the font properties for each segment of a header or footer individually. 
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Text Format tab in the InfoBox.

3. Select the header or footer you want to change from the "Font properties for" list.
4. Select a different font, size, color, and any other attributes you want to change.

Note All the text in the segment will have the same properties.
5. Repeat steps 3 and 4 to change additional header or footer settings.

Tip To edit header or footer text, click Edit Header/Footer.
6. (Optional) Move, collapse, or close the InfoBox.
7. (Optional) Close the Preview window.

Note By default, 1-2-3 uses the largest font in the header or footer to detemine how much space the header or 
footer needs at the top or bottom of the page. To change the space, click the Headers & Footers tab in the 
InfoBox, deselect the "Fit largest font" option, and enter the amount of space. Or you can drag the margin lines 
above and below the header or footer in the Preview window.

{button ,AL(`H_PRINT_ADDING_HEADERS_AND_FOOTERS_STEPS;',0)} See related topics



Changing the print selection
You can change the part of the workbook you want to preview and print with the options in the Preview & Page Setup 
InfoBox or the Print dialog box, or you can make a new selection with the mouse or keyboard in the Workbook 
window.
If a selected range includes data and graphic objects, you can print only the data or graphic objects, charts, or maps 
that appear in the selected range or sheets. 

Using the Include tab to change the print selection
1. If the InfoBox for Preview & Page Setup is not open, do one of the following.

• From the File menu, choose Preview & Page Setup.

• Click the Preview window, then from the Preview menu, choose Preview & Page Setup Properties.

2. Click the Include tab in the InfoBox.

3. Under What to print, select what you want to print.
Note If you want to print a range other than the one listed for "Range," use the mouse or keyboard to select the 
range in the Workbook window or choose File - Print, then select the range. You may need to update the Preview 
window to display the new selection before you can print it. For more information, see Updating the Preview 
window. 

4. If you have a workbook or collection selected, select "On separate pages" to print sheets in a workbook or ranges
in a collection on separate pages or deselect this option to print the data consecutively on the same page.

5. Under Show, select the items you want to print. For example, to print a chart without any of the data in the sheet, 
deselect "Sheet data" and select "Charts, maps, and drawings."

6. (Optional) Move, collapse, or close the InfoBox.
7. (Optional) Close the Preview window.

{button ,AL(`H_PRINT_CHANGING_SELECTION_DETAILS',1)} See details
{button ,AL(`H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_NUMBERING_PAGES_STEP

S;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_123_PRINTING_CELL_COMMENTS_AND_FORMULAS_ST
EPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAMES_STEPS;H_123_PRINTING_WEB_TABLES_STE
PS',0)} See related topics



Details: Changing the print selection
Showing and printing components of a workbook
By default, 1-2-3 prints all data and charts, maps, drawings, and graphic objects that appear in the selected range or 
sheet(s). You can limit what 1-2-3 prints or print additional components, such as grid lines or formulas, by making 
selections in the Show list in the Include panel of the Preview & Page Setup InfoBox. 
In a sheet that contains data, a chart, and a map, for example, you may want to print only the data. To do so, deselect
"Charts, maps, drawings, and table frames" in the Show list.

To print Select
Data entered in cells Sheet data
Charts, maps, drawings, and 
graphic objects such as 
pictures; query tables, 
datalink tables, and Web 
tables with their frames

Charts, maps, drawings, and 
table frames

Cell comments in the print 
selection on a separate page

Cell comments

Formulas contained in the 
print selection on a separate 
page

Formulas

Grid lines in the print 
selection 

Sheet grid lines

Row numbers and column 
letters

Sheet row and column frames

Printing table frames
Whether 1-2-3 prints the frame around a query table, Web table, datalink table, or version range depends on what is 
selected to print.

• If the table or version range is the only workbook component selected under What to Print in the Include panel of 
the InfoBox or under Print in the Print dialog box, 1-2-3 prints the table or version range without the frame.

• If the table or version range is part of a larger range or an entire sheet that is selected to print, 1-2-3 prints the 
table or version range with the frame, unless "Charts, maps, drawings, and table frames" is deselected in the 
Show list in the Include panel. 

{button ,AL(`H_PRINT_CHANGING_SELECTION_STEPS',1)} Go to procedure



Updating the Preview window
If you select a different part of the workbook to print and preview, the Preview window may need to be updated to 
show the new selection. 
For example, if you use the mouse or keyboard in the workbook window to select a new range to print while the 
Preview window is open, the Preview window and the "What to print" section of the Preview & Page Setup InfoBox do
not automatically show the new selection.
1. To open the Preview & Page Setup InfoBox, click the Preview window, then from the Preview menu, choose 

Preview & Page Setup Properties.

2. Click the Include tab in the Preview & Page Setup InfoBox.

Under "Current selection" 1-2-3 shows the currently selected range, collection, or object.
3. To preview the selection listed under "Current selection," click Update Preview.
Note When you use the "What to print" settings on the Include tab or the Print dialog box to change the print 
selection, or if you choose File - Preview & Page Setup, 1-2-3 automatically updates the Preview window. 

{button ,AL(`;H_PRINT_PREVIEW_YOUR_WORK_STEPS;H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_CHA
NGING_SELECTION_STEPS',0)} See related topics



Numbering printed pages
You can print all pages or you can specify which pages to print and how to number them. 
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Headers & Footers tab in the InfoBox.

3. From the "Text of" list, select the header or footer in which you want to print the page number.
4. Click in the text box.
5. Click the page number icon.

1-2-3 enters a # (pound sign) in the box.
Tip To identify each icon, hold the mouse pointer over an icon until you see a short description.

6. Click the Printer tab in the InfoBox.

7. Under Pages, select one of the following:
• All pages -- Prints all pages
• Pages From and To -- Prints from the first to the last page you specify

8. In "Start page numbering with," enter the number for the first page you print.
9. (Optional) Move, collapse, or close the InfoBox.
10. (Optional) Close the Preview window.

{button ,AL(`H_PRINT_NUMBERING_PAGES_DETAILS',1)} See details
{button ,AL(`H_PRINT_ADDING_HEADERS_AND_FOOTERS_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVE

R',0)} See related topics



Details: Numbering printed pages
If you select All pages, 1-2-3 begins numbering pages with 1 unless you specify a different starting number. However,
you can also customize how 1-2-3 numbers the pages. 

Example
Suppose you are previewing a 10-page document. You made some changes to data on pages 4, 5, and 6, and you 
want to reprint just those three pages. To print pages 4, 5, and 6 with the correct page numbers, you can specify the 
following print settings:

• Pages from 4
• Pages to 6
• Start page numbering with 4

Related SmartIcons

Displays the Print dialog box

Prints the current selection

Closes the active window

{button ,AL(`H_PRINT_NUMBERING_PAGES_STEPS',1)} Go to procedure



Changing print margins
The margins appear as dashed lines in the Preview window. You can change the top, bottom, left, and right print 
margins using the InfoBox, or you can drag the margin lines in the Preview window. If you add a header or footer, 
additional dashed lines indicate the header or footer area.
Note The margin lines appear only when the Preview window shows a single page.

 Show me a QuickDemo

Changing print margins in the InfoBox
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Layout tab in the InfoBox.

3. Under Margins, enter a measurement for the left, right, top, or bottom print margins.
4. (Optional) Move, collapse, or close the InfoBox.
5. (Optional) Close the Preview window.

Dragging print margins in the Preview window
1. In the Preview window, position the mouse pointer over the margin line that you want to change so that the 

pointer changes shape.
2. Drag the margin line.

As you drag, an indicator box appears displaying the margin size.

3. Release the mouse button.

{button ,AL(`H_PRINT_CHANGE_MARGINS_DETAILS',1)} See details
{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER',0)} See related topics



Details: Changing print margins
Displaying margin lines in the Preview window
By default, 1-2-3 displays dashed lines in the Preview window to show the margins. To turn off the margin lines, make
sure the Preview window is active, then from the Preview menu, choose Hide Margins. To turn on the display of 
margin lines, from the Preview menu, choose Show Margins. 

 Show/Hide margin, header, and footer lines

Tips
• If the minimum margins for your printer are larger than what you entered, 1-2-3 automatically adjusts the margins.
• The top and bottom margins together cannot exceed the height of the page. The right and left margins together 

cannot exceed the width of the page.
• You can set the unit of measurement for margins in the Windows control panel. To display these settings, click the

Start button, choose Settings - Control Panel, and then open Regional Settings.

{button ,AL(`H_PRINT_CHANGE_MARGINS_STEPS',1)} Go to procedure



Changing page orientation
You can print your work in portrait or landscape mode. 
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Layout tab in the InfoBox.

3. Under Orientation, click an icon to select one of the following:

• Landscape -- Prints sideways
• Portrait -- Prints upright

Tip Use landscape mode when your sheet is wider than a standard page. If you are printing many columns of 
data, landscape printing may help you fit all the columns on a single page.

4. (Optional) Move, collapse, or close the InfoBox.
5. (Optional) Close the Preview window.
Tip You can also use the status bar to change the page orientation.

Related SmartIcons

Prints sideways in landscape mode

Prints upright in portrait mode

Closes the active window

{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_CENTERING_DATA_STEPS;H_PRINT_FITTI
NG_YOUR_WORK_ON_THE_PAGE_STEPS;',0)} See related topics



Centering data on the printed page
Use the InfoBox to center your data on a printed page.
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Layout tab in the InfoBox.

3. Under Center, select one or both options. Selecting both options centers the data in both directions. 
4. (Optional) Move, collapse, or close the InfoBox.
5. (Optional) Close the Preview window.

Related SmartIcons

Centers left to right

Centers top to bottom

Centers in both directions

Closes the active window

{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_CHANGING_PAGE_ORIENTATION_STEPS;H
_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;',0)} See related topics



Fitting your work on the printed page
You can reduce or enlarge the size of printed work to fit on a single page.
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Layout tab in the InfoBox.

3. Under Page fit, select an option.
4. If you selected "Custom," enter a percentage (from 15 to 1000) in the "Percent" box to shrink or enlarge the 

printed data.
5. (Optional) Move, collapse, or close the InfoBox.
6. (Optional) Close the Preview window.
Tip You can also use the status bar to choose how to fit the data on the printed page.

{button ,AL(`H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_DETAILS',1)} See details
{button ,AL(`H_PRINT_CENTERING_DATA_STEPS;H_PRINT_CHANGING_PAGE_ORIENTATION_STEPS',0)} See

related topics



Details: Fitting your work on the printed page
Options: Preview & Page Setup InfoBox (Layout tab)
These options let you choose how to scale your work for the printed page.
Note If you print an entire workbook that contains more than one sheet or a collection of ranges, you can use the 
Include panel in the InfoBox to control whether 1-2-3 prints each sheet or range on a new page or prints the data from
multiple sheets or ranges consecutively on the same page.

Specifying how to scale selected data for printing
• Actual -- Prints the selection in the size it appears on the screen
• Fit all to page -- Fits all the data on a single printed page
• Fit rows to page -- Shrinks all the rows of data to fit on a single printed page
• Fit columns to page -- Shrinks all the columns of data to fit on a single printed page
• Custom -- Shrinks or enlarges the printed data by a percentage you enter. You can enter a percentage from 15 to 

1000. For example, enter 75 to shrink the selection to 75% of its original size.

Specifying how to scale an object for printing such as a chart or map without sheet data 
• Actual -- Same as above
• Fill page -- Enlarges the object to fill the page
• Fill page, but keep proportions -- Enlarges the object with the same proportions
• Custom -- Same as above

Related SmartIcons

Shrinks columns to fit the printed page

Shrinks rows to fit the printed page

Fits all data to fit the printed page

{button ,AL(`H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS',1)} Go to procedure



Adding headers and footers
A header is text printed below the top margin on each page. A footer is text printed above the bottom margin. A 
header or footer can have three segments: left, center, and right.

 Show me a QuickDemo
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Headers & Footers tab in the InfoBox.

3. Under Headers and footers, select a header or footer segment from the "Text of" list.
4. Do one or both of the following:

• Type text for the header or footer in the box. Press ENTER to begin a new line.
• Click the icons to automatically enter the information represented by each icon.

If you click an icon, 1-2-3 enters a symbol in the InfoBox but displays the actual information in the Preview 
window. The date and time are taken from the computer's internal clock.
Tip To identify each icon, hold the mouse pointer over an icon until you see a short description.

5. Click the Confirm button to show the header or footer in the Preview window.

 
6. Repeat steps 3 through 5 to enter text for other header or footer segments.

Note By default, 1-2-3 uses the largest font in the header or footer to determine how much space the header or 
footer needs at the top or bottom of the page. To change the space, deselect the "Fit largest font" option and enter
the amount of space. Or you can drag the margin lines in the Preview window.

7. To change the font properties of the header or footer, click Font.
8. (Optional) Move, collapse, or close the InfoBox.
9. (Optional) Close the Preview window. 

{button ,AL(`H_PRINT_ADDING_HEADERS_AND_FOOTERS_DETAILS',1)} See details
{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_CHANGING_FONTS_HEADERS_FOOTERS_

STEPS;H_PRINT_NUMBERING_PAGES_STEPS',0)} See related topics



Details: Adding headers and footers
Header and footer symbols
To enter the following information for a header or footer, you can click the icons in the InfoBox or type the following 
symbols in the text boxes under Headers and footers. 

To enter Type 
The date of printing @ (at sign)
The time of printing + (plus sign)
Consecutive page numbers # (pound sign)
The total number of pages % (percent sign)
The file name ^ (caret)
The contents of a cell \ (backslash) followed by a 

cell address or range name

You can combine the date, time, page number, and file name with other header and footer text that you type. For 
example, you can type Page and then enter # (pound sign), or click the page number icon, to print Page 1, Page 2, 
Page 3, and so on.

Header/footer entry Printed header/footer
Page # Page 1, Page 2, and so on
Page # of % Page 1 of 10, page 2 of 10, and 

so on
\A:A1 The text entered in cell A:A1
@ - page # The date followed by "page - " 

and the page number
^ - @ The file name followed by the 

date

Tips
• You can enter up to 255 characters for each part of a header or footer. 
• 1-2-3 cannot print headers and footers that are larger than the printable area on the page.
• To prevent the segments of a header or footer from overlapping, display the text on more than one line by using 

the ENTER key to begin new lines, delete some of the text, or enter the text in a different location.
• You can set the unit of measurement for headers and footers in the Windows control panel. To display these 

settings, click the Start button, choose Settings - Control Panel, and then open Regional Settings.
• If you use @ (at sign) or + (plus sign) to enter the date or time, 1-2-3 updates the date and time each time you 

print. If you do not want the date and time to change each time you print, you can type them in.
• To print @ (at sign), + (plus sign), # (pound sign), % (percent sign), ^ (caret), or \ (backslash) in a header or 

footer, enter an ' (apostrophe) immediately before the character.    For example, enter '# to print #.
• When you use \ followed by a cell address or range name to specify header or footer text,

• You cannot enter any other symbols, numbers, or letters as part of the header or footer. The \ followed by a 
cell address or range name must be used by itself. This is true whether you type the cell address or click the 
icon to enter it for you.

• 1-2-3 uses the contents of the first cell of the range only.

Displaying margin lines in the Preview window
When you add a header or footer, 1-2-3 displays dashed lines in the Preview window to show their margins. To turn 
off all margin lines, make sure the Preview window is active, then from the Preview menu, choose Hide Margins. To 
turn on the display of margin lines, from the Preview menu, choose Show Margins. The margin lines are displayed 
only when the Preview window shows a single page.

 Show/Hide margins

{button ,AL(`H_PRINT_ADDING_HEADERS_AND_FOOTERS_STEPS',1)} Go to procedure





Printing titles on each page
Titles can clarify data in your printed sheet by providing the same headings in the first row and left column of each 
printed page. 
Note Printing titles is similar to freezing columns and row titles with View - Titles. Titles specified in the Preview & 
Page Setup InfoBox are only frozen in the printed output.
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Headers & Footers tab in the InfoBox.

3. Under Print as titles on each page, enter a range for "Rows," "Columns," or both, or use the range selector to 
specify the range(s).
Data in the columns will print along the left edge of each page, and data in the rows will print along the top edge 
of each page.

4. (Optional) Move, collapse, or close the InfoBox.
5. (Optional) Close the Preview window.
Tip To remove titles, highlight the range in "Rows" or "Columns," then press DEL.

{button ,AL(`H_PRINT_ADDING_TITLES_ON_EACH_PAGE_DETAILS',1)} See details
{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAME

S_STEPS',0)} See related topics



Details: Printing titles on each page 
Example 

Size of the titles
You need to specify only one cell from each column or row for the titles. Although you can select as many contiguous 
columns and rows as you like for titles, it is practical to set only a few columns and rows so your data will fit on the 
page.
1-2-3 uses only the number of rows and columns for your titles that correspond to the size of your print range. For 
example, if you select B1..M15 as a print range and column A for column print titles, 1-2-3 prints the contents of 
A1..A15 down the left edge of each page.

Related SmartIcons

Sets columns as print titles

Sets rows as print titles

{button ,AL(`H_PRINT_ADDING_TITLES_ON_EACH_PAGE_STEPS',1)} Go to procedure



Changing the paper size
You can choose from the paper sizes supported by the current printer or you can set a custom paper size.
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
2. Click the Printer tab in the InfoBox.

3. Select a size from the list or select "Custom" if the printer driver supports a custom setting.
If you selected "Custom," specify the height and width of the paper.

4. (Optional) Move, collapse, or close the InfoBox.
5. (Optional) Close the Preview window.

{button ,AL(`H_PRINT_AND_PAGE_PROPERTIES_OVER;',0)} See related topics



Overview: Named print styles
After you have used the InfoBox to customize print and page settings, you can name and save these settings as print 
styles to use any time you print.
Use named print styles to:

• Print different kinds of data using the same print and page settings
• Print the same data in different ways; for example, with and without grid lines
• Create variations of the same settings for different files and kinds of data

1-2-3 saves named print styles with the current workbook and includes all the print and page settings you chose 
except the printer.

Notes
In earlier releases of 1-2-3, this feature was called "named page settings."
You can retrieve settings from .AL3 files, but you can no longer save settings to these files.

{button ,AL(`H_NS_CREATE_STYLES_STEPS;H_NS_MANAGE_STYLES_COPY_FROM_STEPS;H_NS_MANAGE
_STYLES_DELETE_STEPS;H_NS_MANAGE_STYLES_RENAME_STEPS;H_NS_REDEFINE_STYLES_STEPS;
H_NS_RESET_PRINT_STYLES_STEPS;H_NS_RETRIEVE_PRINT_STYLE_FROM_PREVIOUS_123_STEPS;H
_NS_USING_STYLES_STEPS',0)} See related topics



Creating a named print style
After you have used the InfoBox to customize print and page settings, you can name and save these settings with the
current workbook to use anytime you print.
1. From the File menu, choose Preview & Page Setup.

2. Review your work in the Preview window and use the InfoBox to change the print and page settings.
3. Click the Named Style tab in the InfoBox.

4. Click Create Style.
5. Enter a name (up to 64 characters long) for the print style.
6. (Optional) Enter a description for the style.
7. (Optional) Select "Save print selection as part of the style."

If you select this option, 1-2-3 saves the selected range as part of the style. This lets you print the same range 
with the same settings each time.

8. Click OK to save the named print style with the current workbook.
9. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Applying a named print style
You can apply an existing named print style to the current workbook.
1. From the File menu, choose Preview & Page Setup.

2. Click the Named Style tab in the InfoBox.

3. From the "Print style name" list, select the print style you want to apply to the current workbook.
1-2-3 immediately applies the settings for the style you selected to the current workbook, and 1-2-3 will use these 
settings to print until you change them.

4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Redefining a named print style
1. From the File menu, choose Preview & Page Setup.

2. Change the print and page settings you want to redefine.
3. Click the Named Style tab in the InfoBox.

4. Click Redefine Style.
5. Select the name of the print style you want to redefine.

Note If you select Default, the most recent print settings you specified become the default print settings.
6. (Optional) Enter a new description of the style, or edit the current one.
7. (Optional) Select "Save print selection as part of the style."

If you select this option, 1-2-3 saves the selected range as part of the style. This lets you print the same range 
with the same settings each time.

8. Click OK to save the print style with the current settings.
9. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER;H_NS_RESET_PRINT_STYLES_STEPS;',0)} See related topics



Resetting a named print style
If you applied a named print style and then modified print settings in the InfoBox, you can undo the changes by 
resetting the style.
1. From the File menu, choose Preview & Page Setup.

2. Click the Named Style tab in the InfoBox.

3. Click Reset to Style.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER;H_NS_REDEFINE_STYLES_STEPS',0)} See related topics



Retrieving a print style from an earlier release of 1-2-3
You can retrieve named page settings saved in an .AL3 file from an earlier release of 1-2-3.
1. From the File menu, choose Preview & Page Setup.

2. Click the Named Style tab in the InfoBox.

3. Click Retrieve.
4. In the Retrieve Named Settings dialog box, specify the name of the .AL3 file you want to use.
5. Click Open.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Manage Styles dialog box for print styles
Use this dialog box to manage named print styles.

Choose a task
Renaming a print style 
Deleting a named print style 
Copying a named print style from another file 

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Renaming a print style
You can change the name of a print style.
1. From the File menu, choose Preview & Page Setup.

2. Click the Named Style tab in the InfoBox.

3. Click Manage Styles.
4. Select the style you want to rename from the list.
5. Click Rename.
6. In the "To" box, edit the current name or enter a new name (up to 64 characters long).
7. (Optional) Edit the current description of the style, or enter a new one.
8. Click OK to rename the style.
9. When you return to the Manage Styles dialog box, click Done. 
10. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Deleting a named print style
1. From the File menu, choose Preview & Page Setup.

2. Click the Named Style tab in the InfoBox.

3. Click Manage Styles.
4. Select the style you want to delete from the list. 
5. Click Delete.
6. Click Done. 
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Copying a named print style from another file
To copy named print styles between files, both workbook files must be open.
1. Open both workbook files.
2. Switch to the file into which you want to copy the named style, then from the File menu, choose Preview & Page 

Setup.

3. Click the Named Style tab in the InfoBox.

4. Click Manage Styles.
5. Click Copy From.
6. Under Workbook, select the workbook that has the named style you want to copy.
7. Under Print style name, select the style you want to copy.
8. Click Copy to copy the selected named print style into the current workbook.
9. When you return to the Manage Styles dialog box, click Done. 
10. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NS_PRINT_OVER',0)} See related topics



Print dialog box
Use the Print dialog box to print your work.

Choose a task
Previewing your work before printing 
Quick printing 
Printing a workbook 
Printing the current sheet 
Printing a range 
Printing graphic objects, charts, tables, and maps 
Printing to a file 
Selecting a printer 
Changing printer properties 

{button ,AL(`H_PRINT_OVER;H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_AND_PAGE_PROPERTIES_OVE
R',0)} See related topics



Overview: Printing
In 1-2-3, you can print an entire workbook, the current sheet, or any selected range, collection, table, or graphic 
object. You can print your work quickly by using the default settings, or you can enhance your printed work by using 
the InfoBox to customize the print and page settings.

Quick printing
To print the entire workbook or just selected sheets, ranges, or pages quickly, use File - Print. 

For more information, see Quick printing.

Previewing your work before printing
To preview your work before you print and to have greater control over the way the printed page looks, use File - 
Preview & Page Stetup.    

When you open the Preview window, 1-2-3 displays the current workbook in a window on the left, and displays the 
Preview window on the right. 1-2-3 also opens the InfoBox so you can change print and page settings.
For more information, see Previewing your work before printing.

Changing the page setup while you preview
With the tiled Preview and Workbook windows, you can change print settings and immediately preview those 
changes before you print your work.    
For example, you can:

• Include charts, maps, and graphics when you print
• Print cell comments and formulas
• Print with or without grid lines or row and column frames
• Add headers, footers, and titles
• Shrink or enlarge data to fill the page
• Center your data horizontally or vertically
• Change the page orientation 
• Print collections or multiple sheets on one page or separate pages
• Save and reuse customized print and page settings as named print styles
• Change print and page settings as you preview your work

For more information, see Overview: Print and page properties.

Printing the finished product
When you are ready to print your work, you can use either File - Print or the Quick Print icon to print with the current 
page setup settings.

Displays the Print dialog box

Prints now, without displaying the Print dialog box

{button ,AL(`H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_QUICK_STEPS;H_PRINT_A_WORKBOOK_STEPS;
H_PRINT_A_SHEET_STEPS;H_PRINT_A_RANGE_STEPS;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS;H_
PRINT_TO_FILE_STEPS;H_PRINT_ADDING_A_PAGE_BREAK_STEPS;H_PRINT_REMOVING_A_PAGE_BRE
AK_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_123_PRINTING_CELL_COMMENTS_AND_FORM



ULAS_STEPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAMES_STEPS',0)} See related topics



Quick printing
The quickest way to print is to use the default print and page settings.
1. From the File menu, choose Print.

2. Under Printer, select the printer you want to use.
3. Under Print, select what you want to print.

If you want to print a "Selected Range," enter a range in the box, or use the range selector to specify the range.
4. (Optional) Under Pages, select the pages to print and how to number them.
5. (Optional) Under Copies, select the number of copies to print and whether to collate them.
6. Click Print.
Tip To bypass the Print dialog box, use the Quick Print icon to print your selection. This icon appears when the 
Preview window is open. To add this icon to the Universal SmartIcons set, use File - User Setup - SmartIcons Setup. 

{button ,AL(`H_PRINT_QUICK_DETAILS',1)} See details
{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_A_WORKBOOK_STEPS;H_

PRINT_A_SHEET_STEPS;H_PRINT_A_RANGE_STEPS;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS;H_PRI
NT_TO_FILE_STEPS;H_PRINT_PREVIEW_YOUR_WORK_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVE
R',0)} See related topics



Details: Quick printing
Installing a printer
If you need to install a printer, see the documentation for your operating system.

Printing defaults
If you selected only a single cell and you have not saved a print range, 1-2-3 prints the current sheet. By default, 1-2-
3 prints charts, maps, and other graphic objects within your selected print range.

Quick printing tables
To print a Web table, query table, or datalink table quickly, right-click the table's title bar, then choose the Quick-Print 
Table command from the shortcut menu.

{button ,AL(`H_PRINT_QUICK_STEPS',1)} Go to procedure



Printing a workbook
If you print a workbook that contains more than one sheet, you can control whether 1-2-3 prints each sheet on a new 
page or prints the data from multiple sheets consecutively on the same page.
1. From the File menu, choose Print.

2. Under Printer, select the printer you want to use.
3. Under Print, select "Entire workbook."
4. Select "On separate pages" to print sheets on separate pages or deselect this option to print the sheets 

consecutively on the same page.
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them.

Note If you click Preview & Page Setup, you can preview your work and customize print and page settings before
you print. Then you can use the Include tab in the InfoBox to select how much of the workbook to print.

7. Click Print.

{button ,AL(`H_PRINT_A_WORKBOOK_DETAILS',1)} See details
{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_SELECTING_A_PRINTER_S

TEPS;H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_NUMBERING_PAGES_STEPS;H
_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_PREVIEW_YOUR_WORK_STEPS;H_123_PRINTING_S
HEET_GRID_LINES_AND_FRAMES_STEPS',0)} See related topics



Details: Printing a workbook
When you preview or print a workbook, the automatic page breaks appear as gray lines in the sheet. 1-2-3 
automatically paginates what you are printing based on how many complete columns and rows will fit on the current 
page. 
If the pages do not automatically break where you want, you can add page breaks to keep related data together or to 
print certain data on a separate page.

{button ,AL(`H_PRINT_A_WORKBOOK_STEPS',1)} Go to procedure
{button ,AL(`H_PRINT_ADDING_A_PAGE_BREAK_STEPS',0)} See related topics



Printing the current sheet
1. Move the cell pointer to the sheet you want to print.
2. From the File menu, choose Print.

3. Under Printer, select the printer you want to use.
4. Under Print, select "Current sheet."
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them.

Note If you click Preview & Page Setup, you can preview your work and customize print and page settings before
you print. Then you can use the Include tab and the Printer tab in the InfoBox to select how much of the workbook
to print.

7. Click Print.
Tip 1-2-3 automatically paginates what you are printing based on how many complete columns and rows will fit on 
the current page. If the pages do not automatically break where you want, you can add page breaks. 

{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_SELECTING_A_PRINTER_S
TEPS;H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_ADDING_A_PAGE_BREAK_STE
PS;H_PRINT_NUMBERING_PAGES_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_PREVIE
W_YOUR_WORK_STEPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAMES_STEPS',0)} See related 
topics



Printing a range
You can print a range or a collection of ranges.
When you print a collection or 3D range, you can control whether 1-2-3 prints the ranges in the collection or sheets in 
the 3D range on separate pages or consecutively on the same page.
1. From the File menu, choose Print.

2. Under Printer, select the printer you want to use.
3. Under Print, select "Selected Range." Enter the range(s) you want to print or use the range selector to specify the 

range.
4. If you are printing a collection or 3D range, select "On separate pages" to print the ranges or sheets on separate 

pages or deselect this setting to print them consecutively on the same page.
5. (Optional) Under Pages, select the pages to print and how to number them.
6. (Optional) Under Copies, select the number of copies to print and whether to collate them.

Note If you click Preview & Page Setup, you can preview your work and customize print and page settings before
you print. Then you can use the Include tab and Printer tab in the InfoBox to select how much of the workbook to 
print.

7. Click Print.
Tip 1-2-3 automatically paginates what you are printing based on how many complete columns and rows will fit on 
the current page. If the pages do not automatically break where you want, you can add page breaks. 

{button ,AL(`H_PRINT_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_SELECTING_A_PRINTER_S

TEPS;H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_ADDING_A_PAGE_BREAK_STE
PS;H_PRINT_NUMBERING_PAGES_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_PRINT_PREVIE
W_YOUR_WORK_STEPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAMES_STEPS',0)} See related 
topics



Details: Printing a range
Selecting a range

• To select a range before you open the Print dialog box, highlight the range before you choose File - Print. When 
you open the dialog box, the address for the range you highlighted appears in the "Selected Range" box.

• To print using a named range, click in the "Selected range" box. Then click the navigator and select a range name
from the list.

Printing a collection
A collection is a group of noncontiguous cells. 

• To select a collection before you open the Print dialog box, select the first cell or range, hold down CTRL, and 
select additional ranges.

• To specify a collection from the Print dialog box, you can enter each range address separated by a semicolon.

Printing a 3D range
A 3D range is a range that spans more than one sheet. When you print a 3D range, you can choose to print each 
sheet of the range on a separate page or consecutively on the same page. To print each sheet of the range on a 
separate page, click    the "On separate pages" box in the Print dialog box or on the Include panel of the InfoBox for 
Preview & Page Setup. 

{button ,AL(`H_PRINT_A_RANGE_STEPS',1)} Go to procedure



Printing graphic objects, charts, tables, and maps
1-2-3 automatically prints graphic objects, charts, tables, or maps that appear in the selected range(s) or sheet(s). 
You can also print graphic objects, charts, tables, or maps without sheet data.
1. Select the graphic object, chart, table, or map you want to print.
2. From the File menu, choose Print.

3. Under Printer, select the printer you want to use.
Note If you click Preview & Page Setup, you can preview your work and customize print and page settings before
you print. Then you can use the Include tab and Printer tab in the InfoBox to select how much of the workbook to 
print.

4. Click Print.
For information about printing frames with query tables, Web tables, datalink tables, and version ranges, see Details: 
Changing the print selection.    

{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_SELECTING_A_PRINTER_S
TEPS;H_PRINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_NUMBERING_PAGES_STEPS;H
_PRINT_PREVIEW_WINDOW_OVER;H_123_PRINTING_WEB_TABLES_STEPS',0)} See related topics



Printing to a file
You can save data from a 1-2-3 workbook to a .PRN file so you can print it at another time. 
Note  This .PRN file contains information specific to the printer driver that you are using with 1-2-3. When you print 
the file, use the same type of printer you were using with 1-2-3 when you created the file. 
1. (Optional) Select the data you want to print to a file.
2. From the File menu, choose Print.

3. Under Printer, select "Print to file."
4. Under Print, select what you want to print.
5. Click Print.
6. In the Print to File dialog box, specify the following:

• The directory in which to save the file
• A name for the file

7. Click OK to save the data in a file.    
1-2-3 saves the data in a file with a .PRN extension. 
Tip To save your data to a file in a text format, use File - Save As and save the file as a Text (.TXT) file.

{button ,AL(`H_PRINT_OVER;H_PRINT_CHANGING_SELECTION_STEPS;',0)} See related topics



Printing cell comments and formulas
When you print a sheet or range that contains formulas or cell comments, you can print the formulas and cell 
comments on an accompanying page. For example, the following printed formula and cell comment define the 
contents of cell A:D3:

A:D3 @SUM(A3..C3)
A:D3 Total sales for first three quarters.

1. From the File menu, choose Print.

2. Under Print, select what you want to print.
3. Click Preview & Page Setup.
4. In the Preview & Page Setup InfoBox, click the Include tab.

5. To print cell comments on a separate page, select "Cell comments" in the Show list.
6. To print formulas on a separate page, select "Formulas" in the Show list.

Tip To help you identify the cell addresses, include the grid lines and row and column frames with the printed 
data.

7. (Optional) Move, collapse, or close the InfoBox.
8. (Optional) Close the Preview window.
9. From the File menu, choose Print, then click Print.

Note 1-2-3 uses the current settings in the Preview & Page Setup InfoBox when you print. To print subsequent data 
without cell comments or formulas, deselect "Cell comments" or "Formulas" in the Show list.

{button ,AL(`H_CREATING_A_CELL_COMMENT_STEPS;H_123_PRINTING_SHEET_GRID_LINES_AND_FRAME
S_STEPS;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_OVER;H_PRINT_PREVIEW_YOUR_WORK_
STEPS',0)} See related topics



Printing sheet grid lines and frames
You can print sheet grid lines with your data. You can also print the row numbers and column letters, which makes it 
easier to identify cell addresses on the printed output. 
1. From the File menu, choose Print.

2. Under Print, select what you want to print.
3. Click Preview & Page Setup.
4. In the Preview & Page Setup InfoBox, click the Include tab.

5. To print sheet grid lines, select "Sheet grid lines" in the Show list.
6. To print row numbers and column letters, select "Sheet row and column frames" in the Show list.
7. (Optional) Move, collapse, or close the InfoBox.
8. (Optional) Close the Preview window.
9. From the File menu, choose Print, then click Print.

Note 1-2-3 uses the current settings in the Preview & Page Setup InfoBox when you print. To print subsequent data 
without sheet grid lines or frames, deselect "Sheet grid lines" or "Sheet row and column frames" in the Show list.

{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_PRINT_CHANGING_SELECTION_STEP
S;H_PRINT_OVER;H_PRINT_PREVIEW_YOUR_WORK_STEPS;H_123_PRINTING_CELL_COMMENTS_AND_
FORMULAS_STEPS',0)} See related topics



Printing text in the Script Editor
You can print the current script, all scripts for a selected object, or all scripts for the current workbook.
1. From the File menu in the Script Editor window, choose Print Script.

2. Under Printer, select the printer you want to use.
3. Under Pages, specify the pages to print and how you want to number them.
4. Under Print, select what you want to print.
5. (Optional) Under Copies, specify the number of copies you want to print and whether you want to collate them.
6. Click Print.

{button ,AL(`H_LOTUSSCRIPT_INDEX_TOPIC_OVER;H_INSTALLING_123_SCRIPT_HELP_STEPS;H_PRINT_OV
ER;H_PRINT_SELECTING_A_PRINTER_STEPS;H_PRINT_CHANGING_PRINTER_PROPERTIES_STEPS;H_P
RINT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_ADDING_A_PAGE_BREAK_STEPS;H_PRI
NT_NUMBERING_PAGES_STEPS;H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_TO_FILE_STEPS',0)} See
related topics



Overview: The Preview window
When you open the Preview window, 1-2-3 displays the current workbook in a window on the left and the Preview 
window on the right. 1-2-3 also opens the InfoBox so you can change print and page settings.

Changing the page setup while you preview
With the tiled Preview and Worksheet windows, you can change print settings and immediately preview those 
changes before you print your work.
For example, you can see in the Preview window where page breaks will occur. If the pages do not automatically 
break where you want, you can leave the Preview window open while you insert page breaks in the workbook. You 
can also use the InfoBox to tell 1-2-3 to fit all the data on one page.
Tip When you click the Workbook window, the InfoBox displays settings for the workbook. To display the Preview & 
Page Setup settings in the InfoBox, click the Preview window title bar.
Use the Preview window and the InfoBox to add and view headers, footers, and other printing details before you print 
your work. If you make changes to print and page settings or to the selected data while you are previewing your work,
you see the results immediately in the Preview window.
The Preview window is like any other window--you can move it, size it, minimize it, maximize it, and close it. When 
you close it, 1-2-3 restores the Workbook window to its original size and placement.

Navigating in the Preview window
In the Preview window, you can view part of a page or object in great detail or view up to nine pages at once.
Click anywhere in the Preview window to zoom in or out, depending on what you are viewing. If you cannot see all of 
your work, use the horizontal and vertical scroll bars in the Preview window.
You can also use the Preview menu commands or the Print Preview SmartIcons to display one or more pages in the 
Preview window.
Tip Right-click in the Preview window to display the shortcut menu for previewing and printing your work.

Closing the Preview window
When you close the Preview window, the Workbook window returns to its former size. To close the Preview window, 
you can:

• Click the icon in the left corner of the Preview window title bar, then choose Close from the control menu. 
• Click the close button in the right corner of the Preview window title bar.

{button ,AL(`H_PRINT_PREVIEW_KEY_MOUSE_SHORTCUTS_OVER;H_PRINT_PREVIEW_ZOOMING_IN_AND_
OUT_STEPS;H_PRINT_PREVIEW_YOUR_WORK_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_12
3_UPDATING_THE_PREVIEW_WINDOW_STEPS',0)} See related topics



Overview: Keyboard and mouse shortcuts in the Preview window
You can use the keyboard or the mouse in the Preview window to zoom in and out of pages and to navigate between 
pages. 
Tip Right-click in the Preview window to display the shortcut menu for previewing and printing your work.

Keyboard shortcuts
You can view up to nine pages in the Preview window. When you use keyboard shortcuts, 1-2-3 displays different 
amounts of information in the Preview window depending on how many pages you are viewing at the time. Here is a 
quick summary of how you can work with keyboard shortcuts in the Preview window.

Press... While previewing... To do this...
 ¯ 1 page Scroll down within a 

page or view the next 
page

2 - 9 pages Scroll down to view 
the next row of pages

1 page Scroll up within a 
page or view the 
previous page

2 - 9 pages Scroll up to view the 
previous row of pages

PGDN 1 page Scroll down to view 
the next page 

2 - 9 pages Scroll down to view 
the next screen of 
pages

PGUP 1 page Scroll up to view the 
previous page 

2 - 9 pages Scroll up to view the 
previous screen of 
pages

+ (Plus) 1 page Zoom in one level

2 - 9 pages Zoom in to display 
fewer pages

- (Minus) 1 page Zoom out one level

2 - 9 pages Zoom out to display 
more pages

Mouse shortcuts
When you are previewing your print job, you can use the status bar to:

• preview different pages.

• change the page orientation.



• choose how to fit the data on the printed page.

Related SmartIcons

Previews your print selection

Displays the Preview & Page Setup InfoBox

Previews the next page

Previews the previous page

Previews one page 

Previews two pages

Previews four pages

Previews nine pages

Hides/shows margin lines in the Preview window

Displays the Print dialog box

Prints now, without displaying the Print dialog box

Closes the active window

{button ,AL(`;H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_PREVIEW_ZOOMING_IN_AND_OUT_STEPS;',0)} 



See related topics



Previewing your work before printing
The Preview window lets you preview your work while you make formatting changes. Previewing lets you see how 
pages will look with the current print and page settings before you print them. 
1. From the File menu, choose Print.

2. Under Print, select what you want to print.
3. Click Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the 
InfoBox.
Tip Right-click in the Preview window to display the shortcut menu for previewing and printing your work.

4. (Optional) Use the InfoBox to change print and page settings for the current print selection.    For more 
information, see Overview: Print and page properties.
1-2-3 instantly updates the Preview window as you change these settings. You can move, collapse, or close the 
InfoBox.

5. When you are ready to print, click the Quick Print icon.

6. To close the Preview window, do one of the following:
• Click the icon in the left corner of the Preview window title bar, then choose Close from the control menu.
• Click the close button in the right corner of the Preview window title bar.

When you close the Preview window, the Workbook window returns to its former size. 
Note If you click the Workbook window, the InfoBox displays properties for the selection in the sheet. Click the 
Preview window to redisplay the Preview & Page Setup properties in the InfoBox.      

{button ,AL(`H_PRINT_PREVIEW_YOUR_WORK_DETAILS',1)} See details
{button ,AL(`H_PRINT_PREVIEW_WINDOW_OVER;H_PRINT_CHANGING_SELECTION_STEPS;H_PRINT_OVER

;H_PRINT_PREVIEW_KEY_MOUSE_SHORTCUTS_OVER;H_PRINT_PREVIEW_ZOOMING_IN_AND_OUT_ST
EPS;H_USING_THE_INFOBOX_STEPS;H_PRINT_AND_PAGE_PROPERTIES_OVER;H_123_UPDATING_THE
_PREVIEW_WINDOW_STEPS',0)} See related topics



Details: Previewing your work before printing
You can use the Preview commands or the related SmartIcons to display your work in the Preview window and to 
print your work. 

Task Command  Icon
Change print and 
page settings

Preview - Preview & 
Page Setup 
Properties

Display the 
previous page

Preview - Previous 
Page

Display the next 
page

Preview - Next Page

View one page Preview - One Page 
View

View two pages Preview - Two Page 
View

View four pages Preview - Four Page 
View

View nine pages Preview - Nine Page 
View

Show or hide 
margin lines

Preview - Show 
Margins or Preview - 
Hide Margins

Open the Print 
dialog box

File - Print

Open the Preview 
window

File - Preview & 
Page Setup

{button ,AL(`H_PRINT_PREVIEW_YOUR_WORK_STEPS',1)} Go to procedure



Zooming in and out of the Preview window
You can click on data in the Preview window to zoom in or out. 
1. From the File menu, choose Preview & Page Setup.

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the InfoBox.
In the Preview window, the mouse pointer changes to a zoom in or zoom out icon, depending on the current state of 
the Preview display.
2. Click on data in the Preview window to zoom in or out.

If you zoom in, 1-2-3 may not display all of your work in the Preview window. Click the horizontal and vertical 
scroll bars to see more of your work.

3. (Optional) Close the Preview window.
Note Zooming in or out in the Preview window does not affect the size of the printed text. 

{button ,AL(`H_PRINT_PREVIEW_ZOOMING_IN_AND_OUT_DETAILS',1)} See details
{button ,AL(`;H_PRINT_PREVIEW_KEY_MOUSE_SHORTCUTS_OVER;H_PRINT_PREVIEW_WINDOW_OVER',0)}

See related topics



Details: Zooming in and out of the Preview window
If you are previewing a single page or multiple pages, clicking in the Preview window zooms in and out.

• First click -- Zooms into the page
• Second click -- Zooms further into the page
• Third click -- Returns to either a one-page preview or multiple-page preview, depending on where you started

{button ,AL(`H_PRINT_PREVIEW_ZOOMING_IN_AND_OUT_STEPS',1)} Go to procedure



Selecting a printer
If you have installed more than one printer, you can select the printer you want to use.
Note If you need to install a printer, see the documentation for your operating system.

Selecting a printer with the File - Print command
1. From the File menu, choose Print.

2. Under Printer, select a printer from the "Print to" list.
3. Do one of the following:

• Click Print to print your work to the printer you selected.
• Click Done to keep the printer you specified as the default printer and to close the Print dialog box without 

printing.

Selecting a printer from the InfoBox
You can also select a printer from the Preview & Page Setup InfoBox. 
1. In the Preview & Page Setup InfoBox, click the Printer tab.

2. Click Printer.
3. In the Printer dialog box, select a printer from the "Print to" list.
4. Click OK.

{button ,AL(`H_PRINT_CHANGING_PRINTER_PROPERTIES_STEPS;H_PRINT_OVER',0)} See related topics



Changing printer properties
The properties you can change depend on the type of printer you have installed.

Changing printer properties with the File - Print command
1. From the File menu, choose Print. 

2. Under Printer, click Properties.
Note The Properties dialog box is for the current printer only and is part of the operating system.

3. Select the properties you want to use for the current printer. 
4. Click OK to close the Properties dialog box.
5. Do one of the following:

• Click Print to print your work.
• Click Done to accept the properties you selected and close the Print dialog box without printing.

Changing printer properties from the InfoBox
You can also change the printer properties from the Preview & Page Setup InfoBox.
1. In the Preview & Page Setup InfoBox, click the Printer tab.

2. Click Printer.
3. In the Printer dialog box, click Properties.

Note The Properties dialog box is for the current printer only and is part of the operating system.
4. Select the properties you want to use for the current printer. 
5. Click OK to close the Properties dialog box.
6. Click OK to close the Printer dialog box.

{button ,AL(`H_PRINT_SELECTING_A_PRINTER_STEPS;H_PRINT_OVER',0)} See related topics



Adding a page break
When you preview your work before printing, 1-2-3 displays page breaks as bold gray lines in the sheet.
If the pages don't automatically break where you want, you can add page breaks to keep related data together or to 
print certain data on a separate page.
1. From the File menu, choose Preview & Page Setup to see where 1-2-3 displays page breaks. 

1-2-3 displays the current workbook on the left and the Preview window on the right. 1-2-3 also opens the 
InfoBox.

2. Use the Preview window to see each page.
Tip You can use the status bar to display one page at a time.

3. In the sheet, select a cell below the row or to the right of the column where you want to add a page break.
4. From the Edit menu, choose Page Break.
5. Select one or both options:

• Above current row -- Inserts a horizontal page break above the current row.
• Left of current column -- Inserts a vertical page break to the left of the current column.

6. Click OK.
7. (Optional) Close the Preview window.
Note You can also use the Basics tab in the Range InfoBox to insert page breaks. Select "Break page at column" to 
insert a vertical page break in the column to the left of the selected cell. Select "Break page at row" to insert a 
horizontal page break in the row above the selected cell.

{button ,AL(`H_PRINT_ADDING_A_PAGE_BREAK_DETAILS',1)} See details
{button ,AL(`H_PRINT_CHANGE_MARGINS_STEPS;H_PRINT_CHANGING_PAGE_ORIENTATION_STEPS;H_PRI

NT_FITTING_YOUR_WORK_ON_THE_PAGE_STEPS;H_PRINT_REMOVING_A_PAGE_BREAK_STEPS;H_PRI
NT_CHANGING_SELECTION_STEPS;H_PRINT_PREVIEW_KEY_MOUSE_SHORTCUTS_OVER',0)} See 
related topics



Details: Adding a page break
1-2-3 automatically paginates what you are printing based on how many complete columns and rows will fit on the 
current page. Page breaks never occur partway through columns or rows.
If you print a range collection or a workbook that contains more than one sheet, you can use File - Print or the Include
panel in the InfoBox for Preview & Page Setup to control whether 1-2-3 prints each page in the workbook or range in 
the collection on a new page.    

Related SmartIcons

Inserts a horizontal page break

Inserts a vertical page break

{button ,AL(`H_PRINT_ADDING_A_PAGE_BREAK_STEPS',1)} Go to procedure



Removing a page break
1-2-3 displays page breaks as bold gray lines in the sheet. You can remove page breaks that you added to the sheet 
for printing your work. 
Note You cannot remove the automatic page breaks 1-2-3 displays when you preview your work before printing, but 
you can add page breaks to control how 1-2-3 prints your work. 
1. Select a cell directly below or to the right of the gray line.
2. From the Edit menu, choose Page Break.
3. Deselect one or both options:

• Above current row -- Removes the horizontal page break above the current row.
• Left of current column -- Removes the vertical page break to the left of the current column.

4. Click OK.
Tip You can also use the Basics tab in the InfoBox to remove page breaks.    Deselect "Break page at column" to 
remove the vertical page break to the left of the selected cell.    Deselect "Break page at row" to remove the horizontal
page break above the selected cell.

{button ,AL(`H_PRINT_ADDING_A_PAGE_BREAK_STEPS;',0)} See related topics



Overview: Release 5 command equivalents
The following topics list commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

File commands
Edit commands
View commands
Style commands
Tools commands
Range commands
Window commands
Help commands
Chart commands
Query commands
Transcript commands

Note Some Release 5 commands are obsolete and have no equivalent in the current release of 1-2-3. 

{button ,AL(`H_123_CLASSIC_OVER;H_GETTING_HELP_ON_A_MENU_COMMAND_STEPS',0)} See related 
topics





Chart commands
The table below lists Chart commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 5 Current release
Chart - Axis - X-Axis Chart - Axes & Grids - X-Axis 

& Grids
Chart - Axis - Y-Axis Chart - Axes & Grids - Y-Axis 

& Grids
Chart - Axis - 2nd Y-Axis Chart - Axes & Grids - 2nd Y-

Axis & Grids
Chart - Data Labels Chart - Ranges; select Data 

labels in the "Parts" list
Chart - Grids Chart - Axes & Grids - X-Axis 

& Grids
Chart - Axes & Grids - Y-Axis 
& Grids 
Chart - Axes & Grids - 2nd Y-
Axis & Grids
Chart - Axes & Grids - Z-Axis 
& Grids

Chart - Headings Chart - Title
Chart - Note

Chart - Legend Chart - Legend
Chart - Name Chart - Chart Properties 

(Basics tab)
Chart - Numeric Color Chart - Series (Lines & Colors 

tab)
Chart - Ranges Chart - Ranges
Chart - Set Preferred Chart - Chart Style - Set 

Default Chart
Chart - Type Chart - Chart Type
Chart - Use Preferred Chart - Chart Style - Apply



Edit commands
The table below lists Edit commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.
Note In the table, Object refers to the current selected object, such as a chart, a graphic object, or an embedded 
document.

1-2-3 Release 5 Current release
Edit - Arrange - Bring to Front Object - Bring to Front
Edit - Arrange - Fasten to Cells Object - Object Properties 

(Basics tab)
Edit - Arrange - Flip Left-Right Drawing - Flip Left-Right
Edit - Arrange - Flip Top-Bottom Drawing - Flip Top-Bottom
Edit - Arrange - Group Object - Group
Edit - Arrange - Lock Object - Object Properties 

(Basics tab)
Edit - Arrange - Rotate Object - Object Properties 

(Basics tab)
Edit - Arrange - Send to Back Object - Send to Back
Edit - Arrange - Ungroup Object - Ungroup
Edit - Arrange - Unlock Object - Object Properties 

(Basics tab)
Edit - Clear Edit - Clear
Edit - Copy Edit - Copy
Edit - Copy Back Edit - Copy Back (on the right 

mouse menu when a 3D range
is selected)

Edit - Copy Down Edit - Copy Down
Edit - Copy Forward {EDIT-COPYFILL} macro
Edit - Copy Left {EDIT-COPYFILL} macro
Edit - Copy Right Edit - Copy Right
Edit - Copy Up {EDIT-COPYFILL} macro
Edit - Cut Edit - Cut
Edit - Delete Range - Delete

Sheet - Delete Sheet
Edit - Find & Replace Edit - Find & Replace
Edit - Go To Edit - Go To
Edit - Insert Create - SheetRange - Insert
Edit - Insert Object Create - Object
Edit - Links Edit - Manage Links
Edit - Paste Edit - Paste
Edit - Paste Link Edit - Paste Link
Edit - Paste Special Edit - Paste Special
Edit - Undo Edit - Undo



File commands
The table below lists File commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of    1-2-3:

1-2-3 Release 5 Current release
File - Close File - Close
File - Close & Return File - Close & Return to

<application>
File - Doc Info File - Workbook Properties

(General tab)
File - Exit File - Exit 1-2-3
File - Exit & Return File - Exit & Return to

<application>
File - New File - New Workbook
File - Open File - Open
File - Page Setup File - Preview & Page Setup
File - Print File - Print
File - Print Preview File - Preview & Page Setup
File - Printer Setup File - Preview & Page Setup
File - Protect File - Workbook Properties 

(Security tab)
File - Save File - Save
File - Save As File - Save As
File - Save Copy As File - Save Copy As
File - Send Mail File - TeamMail
File - Update File - Update



Help commands
The table below lists Help commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 5 Current release
Help - About 1-2-3 Help - About 1-2-3
Help - Contents Help - Help Topics
Help - For Upgraders Help - Help Topics (Contents tab). 

See What's New? 
Help - Keyboard Help - Help Topics (Index tab). 

Type "keys."
Help - How Do I Help - Help Topics (Contents tab). 

See How Do I?
Help - Search Help - Help Topics (Index tab)
Help - Tutorial No equivalent command
Help - Using Help See Getting Help with 1-2-3. 











Query commands
The table below lists Query commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.
In this release, there are two ways to work with database tables. You can use the Create - Database commands to 
work with database tables in 1-2-3 and Approach, or you can use the Data Query Add-in (DQA).
Note The Data Query Add-in (DQA) is included in this release of 1-2-3 to give you data query functionality that is 
similar to that in 1-2-3 Release 5.
For more information, see Overview: Working with databases. 

1-2-3 Release 5 Current release
Aggregate See Creating a database report. 
Choose Fields See Adding a field in a query table and 

Deleting a field in a query table.
Join See Joining database tables.
Name Query Table - Query Table Properties 

(Basics tab)
Refresh Now Query Table - Refresh
Set Criteria See Finding specific records in a query 

table.
Set Options See Creating a query table.
Set Database Table Supported by DQA.
Show Field As Double-click the query table to activate it, 

double-click the field header, and enter 
the new name.

Show SQL Supported by DQA.
Sort See Sorting records in a query table.
Update Database Table 1-2-3 automatically updates the database 

table when you edit query table records.



Range commands
The table below lists Range commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 5 Current release
Range - Analyze - Backsolver Range - Analyze - Backsolver
Range - Analyze - Distribution Range - Analyze - Distribution
Range - Analyze - Invert Matrix Range - Analyze - Invert 

Matrix
Range - Analyze - Multiply 
Matrix

Range - Analyze - Multiply 
Matrix

Range - Analyze - Regression Range - Analyze - Regression
Range - Analyze - Solver No equivalent command. See 

Compatibility
Range - Analyze - What-if Table Range - Analyze - What-if 

Table
Range - Fill Range - Fill
Range - Fill by Example Range - Fill
Range - Name Range - Name
Range - Parse Range - Parse
Range - Sort Range - Sort
Range - Transpose Range - Transpose
Range - Version Range - Version - New Version

Range - Version - Display 
Version
Range - Version - Delete 
Version
Range - Version - Version 
Groups
Range - Version - Report





Style commands
The table below lists Style commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of    1-2-3.
In the current release, most Style commands are now performed in the InfoBox. For example, to align a range of text 
in Release 5, you used Style - Alignment.    In the current release, you choose Range - Range Properties to open the 
Range InfoBox, click the Alignment tab, and then select the alignment option.
Note In the table, Object refers to the current selection, such as a range, chart, map, or other graphic object.

1-2-3 Release 5 Current release
Style - Alignment Object - Object Properties (Alignment 

tab) and Sheet - Sheet Properties 
(Alignment tab)

Style - Column Width Range - Range Properties (Basics tab)
Style - Fast Format Range - Fast Format
Style - Font & Attributes Object - Object Properties (Text format 

tab) 
Object - Object Properties 
(Text Format tab)

Range - Range Properties (Named 
Styles tab)

Style - Hide Object - Object Properties (Basics tab)
Style - Lines & Color Object - Object Properties (Lines & 

Colors tab) and Sheet - Sheet 
Properties (Lines & Colors tab)

Style - Named Style Range - Range Properties (Named 
Styles tab)

Style - Number Format Range - Range Properties (Number 
Format tab) and Sheet - Sheet 
Properties (Number Format tab)

Style - Page Break Edit - Page Break
Style - Protection Range - Range Properties (Security 

tab) and
Sheet - Sheet Properties (Basics tab)

Style - Row Height Range - Range Properties (Basics tab)
Style - Worksheet Defaults Sheet - Sheet Properties

{button ,AL(`H_USING_THE_INFOBOX_STEPS;H_THE_INFOBOX_OVER',0)} See related topics





Tools commands
The table below lists Tools commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.
In this release, there are two ways to work with database tables. You can use the Create - Database commands to 
work with database tables in 1-2-3 and Approach, or you can use the Data Query Add-in (DQA).
Note The Data Query Add-in (DQA) is included in this release of 1-2-3 to give you data query functionality that is 
similar to that in 1-2-3 Release 5.
For more information, see Overview: Working with databases. 

1-2-3 Release 5 Current release
Tools - Add-in File - Add-Ins
Tools - Audit No longer supported
Tools - Chart Create - Chart
Tools - Database - Append Records See Adding records using a 

query table.
Tools - Database - Connect to 
External

See Creating a query table.

Tools - Database - Create Table Supported by DQA.
Tools - Database - Crosstab Create - Database - Dynamic 

Crosstab
Tools - Database - Delete Records See Deleting records using a 

query table.
Tools - Database - Disconnect When the query table is active, 

choose Open to Full Window, 
choose Open, select the desired 
connection and click Disconnect. 
Refer to Approach Help for more 
information.

Tools - Database - Dynamic 
Crosstab

Create - Database - Dynamic 
Crosstab

Tools - Database - Find Records See Finding specific records in a 
query table.

Tools - Database - Form Create - Database - Form
Tools - Database - Mailing Labels Create - Database - Mailing 

Labels
Tools - Database - New Query Create - Database - Query Table
Tools - Database - Report Create - Database - Report
Tools - Database - Send Command Supported by DQA.
Tools - Draw - Arc Create - Drawing - Arc
Tools - Draw - Arrow Create - Drawing - Arrow
Tools - Draw - Button Create - Button
Tools - Draw - Ellipse Create - Drawing - Ellipse
Tools - Draw - Freehand Create - Drawing - Freehand
Tools - Draw - Line Create - Drawing - Line
Tools - Draw - Polygon Create - Drawing - Polygon
Tools - Draw - Polyline Create - Drawing - Polyline
Tools - Draw - Rectangle Create - Drawing - Rectangle
Tools - Draw - Rounded Rectangle Create - Drawing - Rounded 

Rectangle
Tools - Draw - Text Create - Text



Tools - Macro - Assign to Button Edit - Scripts & Macros - Show 
Script Editor

Tools - Macro - Record Edit - Scripts & Macros - Record 
Script

Tools - Macro - Run Edit - Scripts & Macros - Run
Tools - Macro - Show Transcript No longer supported
Tools - Macro - Single Step Edit - Scripts & Macros - Run
Tools - Macro - Trace Edit - Scripts & Macros - Run
Tools - Map - Colors & Legend Map - Color Bins
Tools - Map - New Map Create - Map
Tools - Map - Patterns & Legend Map - Pattern Bins
Tools - Map - Ranges & Title Map -    Ranges

Map - Title
Tools - Map - Redraw Map - Redraw
Tools - Map - Set Redraw 
Preference

Map - Map Properties (Basics 
tab)

Tools - SmartIcons File - User Setup - SmartIcons 
Setup

Tools - Spell Check Edit - Check Spelling
Tools - User Setup File - User Setup - 1-2-3 

Preferences



Transcript commands
The current release of 1-2-3 does not contain a Transcript window for recording commands and actions. Instead, 
commands and actions are recorded as scripts in the Integrated Development Environment (IDE).
For more information, see Overview: Using LotusScript. 

1-2-3 Release 5 Current release
Make Button Create - Button
Minimize on Run No longer supported
Playback No longer supported
Record Absolute No longer supported
Record Relative No longer supported



View commands
The table below lists View commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 5 Current release
View - Clear Split View - Clear Split
View - Clear Titles View - Titles
View - Custom - nn% View - Zoom to Custom Level 

(xx%)
View - Freeze Titles View - Titles
View - Set View Preferences View - Set View Preferences
View - Split View - Split
View - Zoom In View - Zoom to
View - Zoom Out View - Zoom to



Window commands
The table below lists Window commands in 1-2-3 Release 5 for Windows and their closest equivalents in the current 
release of 1-2-3.

1-2-3 Release 5 Current release
Window - Cascade Window - Cascade
Window - More Windows Window - More Windows
Window - Tile Window - Tile Left-Right

Window - Tile Top-Bottom
Window - <List of open 
windows>

Window - <List of open 
windows>



Chart macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in 
LotusChart. For more information on individual LotusChart properties and methods, search on the property or method
name in the LotusScript Index.    

1-2-3 Release 5 LotusChart
{CHART-ASSIGN-RANGE} DataLink property
{CHART-AXIS-INTERVALS} MajorInterval property

MajorIntervalIsManual 
property
MinorInterval property
MinorIntervalIsManual 
property
SecondYAxis property
XAxis property
YAxis property

{CHART-AXIS-LIMITS} Maximum property
MaximumIsManual property
Minimum property
MinimumIsManual property
SecondYAxis property
XAxis property
YAxis property

{CHART-AXIS-SCALE-TYPE} Scale property
ScaleType property
SecondYAxis property
XAxis property
YAxis property

{CHART-AXIS-TICKS} MajorTickmarks property
MajorTickmarkPlacement 
property
MinorTickmarks property
MinorTickmarkPlacement 
property
SecondYAxis property
TickLabelSkip property
Visible property
XAxis property
YAxis property

{CHART-AXIS-TITLE} SecondYAxis property
Text property
Title property
XAxis property
YAxis property

{CHART-AXIS-UNITS} Exponent property
SecondYAxis property
Scale property
Subtitle property



SubtitleIsManual property
SubtitlePlacement property
Text property
XAxis property
YAxis property

{CHART-COLOR-RANGE} No longer supported
{CHART-DATA-LABELS} Series property

SeriesData property
TextLabels property

{CHART-FOOTNOTE} DataLink property
Lines property
Note property
Placement property
Source property
Text property
Visible property

{CHART-GRID} MajorGridlines property
MinorGridlines property
SecondYAxis property
Visible property
XAxis property
YAxis property

{CHART-LEGEND} DataLink property
Entries property
Legend property
Placement property
Source property
Text property
Visible property

{CHART-NEW} NewChart method
{CHART-PATTERN-RANGE} No longer supported
{CHART-PIE-LABELS} PercentLabels property

PercentLabelPlacement 
property
Placement property
SeriesData property
TextLabels property
TextLabelsPlacement property
ValueLabels property
ValueLabelPlacement property

{CHART-PIE-SLICE-
EXPLOSION}

ExplodePercent property
Pies property
PieSlices property
SliceExplosion property
SliceDirection property

{CHART-RANGE} DataLink property



Series property
Source property
Type property
Use2YAxis property
XAxis property

{CHART-RANGE-DELETE} Series property
Visible property
XAxis property

{CHART-RENAME} Name property
{CHART-SET-PREFERRED} No longer supported
{CHART-TITLE} DataLink property

Lines property
Placement property
Source property
Text property
Title property
Visible property

{CHART-TYPE} Type property
{CHART-USE-PREFERRED} No longer supported



Database macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see see 1-2-3 LotusScript 
A-Z.

1-2-3 Release 5 Current release of 1-2-3
{COMMIT} Commit method
{CROSSTAB} No longer supported
{DATABASE-APPEND} AppendRecords method
{DATABASE-CONNECT} Connect method
{DATABASE-CREATE-
TABLE}

CreateTable method

{DATABASE-DELETE} DeleteRecords method
{DATABASE-DISCONNECT} Disconnect method
{DATABASE-FIND} FindRecords method
{DATABASE-SEND-
COMMAND}

SendCommand method

{QUERY-ADD-FIELD} AddSelectField method
CreateComputedField method

{QUERY-AGGREGATE} FieldAggregateType method
ResetFieldAggregates method

{QUERY-CHOOSE-FIELDS} AllFields property
SelectFields property

{QUERY-COPY-SQL} CopySQLToClipboard method
Paste method
SQL property

{QUERY-CRITERIA} Criteria property
{QUERY-DATABASE-TABLE} BaseSourceTable property
{QUERY-JOIN} Join method
{QUERY-NAME} Name property
{QUERY-NEW} NewQuery method

OutputLocation property
Refresh method

{QUERY-OPTIONS} AllowsUpdates property
AutoRefresh property
ExtractingUniqueRecords 
property
RecordsLimited property
RecordsLimitMax property

{QUERY-REFRESH} Refresh method
{QUERY-REMOVE-FIELD} DeleteComputedField method

RemoveSelectField method
{QUERY-SHOW FIELD} FieldAlias method
{QUERY-SORT} SortData method
{QUERY-SORT-KEY-
DEFINE}

QuerySortDefineKey method

{QUERY-SORT-RESET} SortReset method
{QUERY-UPGRADE} No longer supported



{QUERY-UPDATE} Update method
{ROLLBACK} Rollback method
{SEND-SQL} SendSQL method



Data manipulation macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{APPENDBELOW} No LotusScript equivalent
{APPENDRIGHT} No LotusScript equivalent
{BLANK} Clear method
{CONTENTS} CellDisplay property
{LET} Contents property
{PUT} Contents property
{RECALC} RecalcRange method
{RECALCCOL} RecalcRange method



DDE and OLE macro commands
The 1-2-3 Release 5 for Windows DDE macro commands do not have LotusScript equivalents:
{DDE-ADVISE}
{DDE-CLOSE}
{DDE-EXECUTE}
{DDE-OPEN}
{DDE-POKE}
{DDE-REQUEST}
{DDE-TABLE}
{DDE-UNADVISE}
{DDE-USE}
The tables below list Link and OLE macro commands in 1-2-3 Release 5 for Windows and their LotusScript 
equivalents in the current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-
3 LotusScript A-Z.

Link macro commands
1-2-3 Release 5 Current release of 1-2-3
{LINK-ASSIGN} Target property
{LINK-CREATE} NewDataLink method
{LINK-DEACTIVATE} AutoUpdate property
{LINK-DELETE} BreakLink method
{LINK-REMOVE} Target property
{LINK-TABLE} No longer supported
{LINK-UPDATE} Update method

OLE macro commands
1-2-3 Release 5 Current release of 1-2-3
{EDIT-OBJECT} Verb method
{INSERT-OBJECT} NewObject method
{UPDATE-OBJECT} Save method



Edit macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{DELETE-COLUMNS} DeleteColumns method
{DELETE-ROWS} DeleteRows method
{DELETE-SHEETS} DeleteSheet method
{EDIT-CLEAR} Clear method
{EDIT-COPY} CopyToClipboard method
{EDIT-COPY-FILL} CopyFill method
{EDIT-CUT} Cut method
{EDIT-FIND} Find method

SearchString property
{EDIT-FIND?} No LotusScript equivalent
{EDIT-PASTE} Paste method
{EDIT-PASTE-LINK} NewDataLink method

Paste method
{EDIT-PASTE-SPECIAL} NewDataLink method

Paste method
{EDIT-QUICK-COPY} QuickCopy method
{EDIT-QUICK-MOVE} QuickMove method
{EDIT-REPLACE} Replace method

SearchString property
ReplaceString property

{EDIT-REPLACE-ALL} ReplaceAll method
SearchString property
ReplaceString property

{FILE-UPDATE-LINKS} FileAdminLinksRefresh 
method

{INSERT-COLUMNS} InsertColumns method
{INSERT-ROWS} InsertRows method
{INSERT-SHEETS} NewSheet method



File info component equivalents
The table below lists info components in 1-2-3 Release 5 for 'Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more    information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-
Z.

1-2-3 Release 5 Current release of 1-2-3
DOCUMENT-COMMENTS Description property
DOCUMENT-KEYWORDS Keywords property
DOCUMENT-REVISIONS Revisions property
DOCUMENT-SUBJECT Subject property
DOCUMENT-TITLE Title property
FILE-RESERVE-
AUTOMATICALLY

AlwaysReserve property



File macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{FILE-CLOSE} Close method
{FILE-COMBINE} RangeCombine method
{FILE-EXIT} Quit method
{FILE-EXTRACT} RangeExtract method
{FILE-GET-RESERVATION} ReservationGet method
{FILE-IMPORT} RangeCombineText method
{FILE-NEW} NewDocument method
{FILE-OPEN} OpenDocument method
{FILE-OPEN?} No LotusScript equivalent
{FILE-RELEASE-RESERVATION} ReservationReleased method
{FILE-RETRIEVE} No LotusScript equivalent
{FILE-SAVE} Save method

SaveAs method
{FILE-SAVE-ALL} No LotusScript equivalent
{FILE-SAVE-AS?} No LotusScript equivalent
{FILE-SEAL} Lock method
{FILE-SEAL-NETWORK-RESERVATION} No LotusScript equivalent
{FILE-UNSEAL} Lock method
{PRINT} Copies property

Print method
PrintPagesFrom property
PrintPagesStart property
PrintPagesTo property
PrintWhat property

{PRINT?} No LotusScript equivalent
{PRINT-NAME-ADD} NewNamedPrintSettings 

method
{PRINT-NAME-USE} CurrentPrintSettings property

RetrievePrintSettings method
{PRINT-RESET} CurrentPrintSettings property
{SEND-MAIL} SendMail method
{SEND-RANGE} Send method
{SEND-RANGE-LOGIN} UserLogin method



Flow-of-control macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents. For more 
information on individual LotusScript statements and functions, search on the function or statement name in the 
LotusScript Index.
LotusScript offers the standard capabilities of a structured programming language and the 1-2-3 classes are an 
extension of that language that enables object-oriented application development within 1-2-3 and across other Lotus 
products as well.

1-2-3 Release 5 LotusScript
{-- comment} ' (single quote) comment
{BRANCH} GoSub statement
{DEFINE} Sub statement parameter list
{DISPATCH} GoTo statement
{FOR} For statement
{FORBREAK} Exit statement
{IF} If statement
{LAUNCH} Shell statement
{LOTUS-LAUNCH} No longer supported
{ONERROR} On Error statement
{QUIT} End statement
{RESTART} No LotusScript equivalent
{RETURN} Exit Function statement

Exit Sub statement
{SET} See 1-2-3 Release 5 info 

component equivalents 
{subroutine} Call statement
{SYSTEM} Shell statement



Keystroke equivalents
The table below lists keys and corresponding macros in 1-2-3 Release 5 for Windows and their LotusScript 
equivalents in the current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-
3 LotusScript A-Z.

Release 5 key Release 5 macro Current release
~ (tilde) {~} No LotusScript 

equivalent
{ (open brace) {{} No LotusScript 

equivalent
} (close brace) {}} No LotusScript 

equivalent
/ (slash) or < (less 
than)

/, <, or {MENU} No LotusScript 
equivalent

ALT+F6 (ZOOM) {ZOOM} ZoomIn method
ZoomOut method

BACKSPACE {BACKSPACE} or 
{BS}

No LotusScript 
equivalent

CTRL+END {FILE} No LotusScript 
equivalent

CTRL+END 
CTRL+PG DN

{PREVFILE}, {PF}, or 
{FILE}{PS}

Goto method

CTRL+END 
CTRL+PG UP

{NEXTFILE}, {NF}, or 
{FILE}{NS}

Goto method

CTRL+END END {LASTFILE}, {LF}, or 
{FILE}{END}

Goto method

CTRL+END HOME {FIRSTFILE},{FF}, or 
{FILE}{HOME}

Gotomethod

CTRL+HOME {FIRSTCELL} or {FC} MoveCellPointer 
method

CTRL+LEFT {BACKTAB} or 
{BIGLEFT}

MoveCellPointer 
method

CTRL+PG UP {NEXTSHEET} or 
{NS}

PageForward 
method

CTRL+PG DN {PREVSHEET} or 
{PS}

PageBack method

CTRL+RIGHT {BIGRIGHT} MoveCellPointer 
method

DEL {DELETE} or {DEL} Clear method
DOWN {DOWN} or {D} MoveCellPointer 

method
END {END} No LotusScript 

equivalent
END CTRL+HOME {LASTCELL} or {LC} MoveCellPointer 

method
ESC {ESCAPE} or {ESC} No LotusScript 

equivalent
ESC in 1-2-3 
Classic edit line

{CLEARENTRY} or 
{CE}

No LotusScript 
equivalent

F1 (HELP) {HELP} HelpContents 
method

F2 (EDIT) {EDIT} No LotusScript 
equivalent



F3 (NAME) {NAME} No LotusScript 
equivalent

F4 in Ready mode {ANCHOR} No LotusScript 
equivalent

F4 (ABS) {ABS} No LotusScript 
equivalent

F5 (GOTO) {GOTO} GoTo method
F6 (PANE) {WINDOW} NextSplit method
F7 (QUERY) {QUERY} No LotusScript 

equivalent
F8 (TABLE) {TABLE} No LotusScript 

equivalent
F9 (CALC) {CALC} Calc method
HOME {HOME} MoveCellPointer 

method
INS {INSERT} or {INS} No LotusScript 

equivalent
LEFT {LEFT} or {L} MoveCellPointer 

method
PG DN {PGDN} MoveCellPointer 

method
PG UP {PGUP} MoveCellPointer 

method
RIGHT {RIGHT} or {R} MoveCellPointer 

method
SHIFT+CTRL+LEF
T

{SELECT-BIGLEFT} No LotusScript 
equivalent

SHIFT+CTRL+RIG
HT

{SELECT-BIGRIGHT} No LotusScript 
equivalent

SHIFT+DOWN {SELECT-DOWN} Range method
SHIFT+CTRL+HO
ME

{SELECT-
FIRSTCELL}

No LotusScript 
equivalent

SHIFT+HOME {SELECT-HOME} No LotusScript 
equivalent

END 
SHIFT+CTRL+HO
ME

{SELECT-
LASTCELL}

No LotusScript 
equivalent

SHIFT+LEFT {SELECT-LEFT} Range method
SHIFT+CTRL+PG 
UP

{SELECT-
NEXTSHEET}

Range method

SHIFT+PG DN {SELECT-PGDN} No LotusScript 
equivalent

SHIFT+PG UP {SELECT-PGUP} No LotusScript 
equivalent

SHIFT+CTRL+PG 
DN

{SELECT-
PREVSHEET}

Range method

SHIFT+RIGHT {SELECT-RIGHT} Range method
SHIFT+UP {SELECT-UP} Range method
TAB {TAB} MoveCellPointer 

method
UP {UP} or {U} MoveCellPointer 

method





Macro debug info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
MACRO-STEP MacroStep property
MACRO-TRACE MacroTrace property



Mapping info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
MAP-DRAW AutoRedraw property
MAP-REDRAW RedrawMap method



Navigation macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{CELL-ENTER} Contents property
{EDIT-GOTO} GoTo method
{SCROLL-COLUMNS} MoveOrigin method
{SCROLL-ROWS} MoveOrigin method
{SCROLL-TO-CELL} SetOrigin method
{SCROLL-TO-COLUMN} MoveOrigin method
{SCROLL-TO-OBJECT} GoTo method
{SCROLL-TO-ROW} MoveOrigin method
{SELECT} Select method
{SELECT-ALL} AddToSelection method

Select method
SelectAll method
SelectAllSheets method

{SELECT-APPEND} AddToSelection method
{SELECT-RANGE-
RELATIVE}

Select method

{SELECT-REMOVE} RemoveFromSelection 
method

{SELECT-REPLACE} AddToSelection method
RemoveFromSelection 
method



Printer Setup info component equivalents
The table below lists info components in Release 5 for Windows and their LotusScript equivalents in the current 
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
PRINTER-SETUP-BINS PaperBinName property
PRINTER-SETUP-COPIES Copies property
PRINTER-SETUP-NAME PrinterName property
PRINTER-SETUP-
PAPERLENGTH

PaperHeight property

PRINTER-SETUP-
PAPERWIDTH

PaperWidth property

PRINTER-SETUP-
PAPERSIZE

PaperSizeName property

PRINTER-SETUP-QUALITY PrinterQuality property



Print info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
PRINT-BEGINNING-PAGE-
NUMBER

PrintPagesStart property

PRINT-CENTERED CenterLeftToRight property
CenterTopToBottom property

PRINT-DRAWN-OBJECTS ChartsPicturesAndDrawPrint 
property

PRINT-FIT-PAGE FitToPage property
PRINT-FOOTER-CENTER-
TEXT

FooterCenter property

PRINT-FOOTER-LEFT-TEXT FooterLeft property
PRINT-FOOTER-RIGHT-
TEXT

FooterRight property

PRINT-GRID-LINES GridLinesPrint property
PRINT-HEADER-CENTER-
TEXT

HeaderCenter property

PRINT-HEADER-LEFT-TEXT HeaderLeft property
PRINT-HEADER-RIGHT-
TEXT

HeaderRight property

PRINT-MARGIN-BOTTOM BottomMargin property
PRINT-MARGIN-LEFT LeftMargin property
PRINT-MARGIN-RIGHT RightMargin property
PRINT-MARGIN-TOP TopMargin property
PRINT-ORIENTATION Orientation property
PRINT-RANGE PrintRange property
PRINT-SIZE FitDrawnObjectToPage 

property
FitToPage property

PRINT-SIZE-MANUAL FitToPage property
ScalePercent property

PRINT-TITLES-CLEAR No LotusScript equivalent
PRINT-TITLES-COLUMN-
RANGE

ColumnTitleRange property

PRINT-TITLES-ROW-RANGE RowTitleRange property
PRINT-WORKSHEET-
FRAME

SheetFramePrint property



Range macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{DATA-TABLE-1} WhatIfTable1 method
{DATA-TABLE-2} WhatIfTable2 method
{DATA-TABLE-3} WhatIfTable3 method
{DATA-TABLE-RESET} WhatIfTableReset method
{DISTRIBUTION} Distribution method
{FILL} RangeFill method
{FILL-BY-EXAMPLE} RangeFill method
{MATRIX-INVERT} MatrixInvert method
{MATRIX-MULTIPLY} MatrixMultiply method
{PARSE} DataParse method
{RANGE-NAME-CREATE} CreateRangeName method
{RANGE-NAME-DELETE} DeleteRangeName method
{RANGE-NAME-DELETE-
ALL}

ClearRangeNames method

{RANGE-NAME-LABEL-
CREATE}

CreateRangeNameFromLabel 
method

{RANGE-NAME-TABLE} CreateRangeNameTable 
method

{RANGE-TRANSPOSE} Transpose method
{RANGE-VALUE} RangeValue method
{REGRESSION} Regression method
{SHEET-NAME} SheetName property
{SHEET-NAME-DELETE} SheetName property
{SORT} Sort method
{SORT-KEY-DEFINE} RangeSortDefineKey method
{SORT-RESET} SortResetKeys method



Overview: Release 5 info component equivalents
The following topics list info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.
File info component equivalents
Macro debug info component equivalents
Mapping info component equivalents
Print info component equivalents
Printer Setup info component equivalents
Sort info component equivalents
User Setup info component equivalents
Window info component equivalents
Worksheet Defaults info component equivalents



Overview: Release 5 macro command equivalents
The following topics list macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.
Chart macro commands 
Data manipulation macro commands 
Database macro commands 
DDE and OLE macro commands 
Edit macro commands 
File macro commands 
Flow-of-control macro commands 
Keystroke equivalents 
Navigation macro commands 
Range macro commands 
SmartIcons macro commands 
Solver macro commands 
Style macro commands 
Text file macro commands 
Tools macro commands 
User environment macro commands 
Version Manager macro commands 
Window and screen display macro commands 



SmartIcons macro commands
The table below lists commonly-used SmartIcon macro commands in 1-2-3 Release 5 for Windows and their 
LotusScript equivalents in the current release of 1-2-3. For more information on individual 1-2-3 properties and 
methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{SMARTSUM} SmartSum method
{SORT-ASCENDING} SmartSort method
{SORT-DESCENDING} SmartSort method
{TOGGLE-OUTLINE} No LotusScript equivalent
{TOGGLE-SHADOW} No LotusScript equivalent



Solver macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{BACKSOLVE} Backsolve method
{SOLVER-ANSWER} No LotusScript equivalent
{SOLVER-ANSWER-SAVE} No LotusScript equivalent
{SOLVER-DEFINE} No LotusScript equivalent
{SOLVER-DEFINE?} No LotusScript equivalent
{SOLVER-REPORT} No LotusScript equivalent

Note Macros can be used if the Solver add-in is loaded.



Sort info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
DATA-SORT-DIRECTION[ n] RangeSortDefineKey method
DATA-SORT-KEY[ n] RangeSortDefineKey method
DATA-SORT-RANGE SortRange property



Style macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{COLUMN-WIDTH} ColumnWidth property
{COLUMN-WIDTH-FIT-
WIDEST}

FitWidest method

{COLUMN-WIDTH-RESET} ResetColumnWidth method
{HIDE-COLUMNS} HideColumns method
{HIDE-SHEETS} HideSheets method
{NAMED-STYLE-USE} StyleName property
{PAGE-BREAK-COLUMN} VerticalPageBreak property
{PAGE-BREAK-ROW} HorizontalPageBreak property
{PROTECT} IsProtected property
{UNPROTECT} IsProtected property
{ROW-HEIGHT} RowHeight property
{ROW-HEIGHT-FIT-
LARGEST}

FitTallest method

{SHOW-COLUMNS} UnhideColumns method
{SHOW-SHEETS} ShowSheet method
{STYLE-ALIGN-
HORIZONTAL}

TextHorizontalAlign property

{STYLE-ALIGN-
ORIENTATION}

TextOrientation property

{STYLE-ALIGN-VERTICAL} TextVerticalAlign property
{STYLE-BORDER} BottomBorder property

GridBorder property
HorizontalBorder property
LeftBorder property
OutlineBorder property
RightBorder property
TopBorder property
VerticalBorder property

{STYLE-EDGE} Arrow property
EdgeColor property
EdgeDashStyle property
EdgeLineWidth property

{STYLE-FONT} FontColor property
FontName property

{STYLE-FONT-ALL} Bold property
Italic property
Underline property
DoubleUnderline property
WideUnderline property

{STYLE-FONT-ATTRIBUTES} Bold property
Italic property
Underline property



DoubleUnderline property
WideUnderline property

{STYLE-FONT-RESET} StyleFontReset method
{STYLE-FONT-SIZE} Size property
{STYLE-FRAME} DesignerFrameColor property

DesignerFrameStyle property
{STYLE-GALLERY} SetGalleryStyle method
{STYLE-INTERIOR} BackColor property

Background property
Color property
ColorName property
Font property
FontColor property
NegativesInColor property

{STYLE-LINE} Arrow property
EdgeColor property
EdgeDashStyle property
EdgeLineWidth property

{STYLE-NUMBER-FORMAT} Format method
{STYLE-NUMBER-FORMAT-
RESET}

FormatReset method



Text file macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents. For more 
information on individual LotusScript statements and functions, search on the function or statement name in the 
LotusScript Index.
LotusScript offers the standard capabilities of a structured programming language and the 1-2-3 classes are an 
extension of that language that enables object-oriented application development within 1-2-3 and across other Lotus 
products as well.

1-2-3 Release 5 LotusScript
{CLOSE} Close statement
{FILESIZE} FileLen function
{GETPOS} Seek function
{OPEN} Open statement
{READ} Line Input # statement
{READLN} Line Input # statement
{SETPOS} Seek statement
{WRITE} Print # statement

Write # statement
{WRITELN} Print # statement

Write # statement



Tools macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{ADDIN-INVOKE} No longer supported
{ADDIN-LOAD} LoadAddin method
{ADDIN-REMOVE} UnloadAddin method
{ADDIN-REMOVE-ALL} No longer supported
{AUDIT} No LotusScript equivalent
{MAP-NEW} NewMap method
{MAP-REDRAW} RedrawMap method
{REGISTER} Declare statement
{SMARTICONS-USE} ShowIconBar method
{SPELLCHECK?} No LotusScript equivalent
{UNREGISTER} No longer supported



User environment macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3.

• For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.    
• For more information on individual LotusScript statements and functions, search on the function or statement 

name in the LotusScript Index. 
• For more information about using the LotusScript Dialog Editor, search on "Dialog Editor" in the LotusScript Index.

1-2-3 Release 5 Current release of 1-2-3
{?} Yield statement
{ALERT} MessageBox function
{BEEP} Beep statement
{BREAKOFF} No LotusScript equivalent
{BREAKON} No LotusScript equivalent
{CHOOSE-FILE} Custom dialog boxes created 

with the LotusScript Dialog 
Editor

{CHOOSE-ITEM} Custom dialog boxes created 
with the LotusScript Dialog 
Editor

{CHOOSE-MANY} Custom dialog boxes created 
with the LotusScript Dialog 
Editor

{CHOOSE-ONE} Custom dialog boxes created 
with the LotusScript Dialog 
Editor

{DIALOG} Show method
{DIALOG?} No LotusScript equivalent
{FORM} No longer supported
{FORMBREAK} No longer supported
{GET} GetKey method
{GET-FORMULA} InputBox function
{GET-LABEL} InputBox function
{GET-NUMBER} InputBox function
{GET-RANGE} RangeSelector property
{LOOK} No LotusScript equivalent
{MENUBRANCH} No LotusScript equivalent
{MENUCALL} No LotusScript equivalent
{MENU-COMMAND-ADD} AddItem method
{MENU-COMMAND-
DISABLE}

DisableItem method

{MENU-COMMAND-ENABLE} EnableItem method
{MENU-COMMAND-
REMOVE}

RemoveItem method

{MENU-CREATE} AddMenu method
NewMenuBar method

{MENU-INSERT} AddMenu method
NewMenu method

{MENU-RESET} ResetMenuBar method



{MODELESS-DISMISS} Custom dialog boxes created 
with the LotusScript Dialog 
Editor. Search on "Modeless 
dialog boxes" in the 
LotusScript Index.

{MODELESS-DISPLAY} Custom dialog boxes created 
with the LotusScript Dialog 
Editor. Search on "Modeless 
dialog boxes" in the 
LotusScript Index.

{PLAY} No LotusScript equivalent
{WAIT} No LotusScript equivalent



User Setup info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
SETUP-AUTOEXEC AutoExecMacrosEnabled 

property
SETUP-AUTOFORMAT No longer supported
SETUP-AUTOSAVE No longer supported
SETUP-AUTOSAVE-INTERVAL No longer supported
SETUP-BEEP BeepsOnError property
SETUP-DRAG-AND-DROP DragAndDropEnabled 

property
SETUP-DRAG-AND-DROP-PROMPT ConfirmDragAndDrop property
SETUP-FILE-LINK-UPDATE UpdateLinksOnOpenDoc 

property
SETUP-INTERNATIONAL-CURRENCY-DEFAULT No LotusScript equivalent
SETUP-INTERNATIONAL-CURRENCY-DISPLAY No longer supported
SETUP-INTERNATIONAL-CURRENCY-POSITION No LotusScript equivalent
SETUP-INTERNATIONAL-CURRENCY-SYMBOL No LotusScript equivalent
SETUP-INTERNATIONAL-DATE DateOrder property
SETUP-INTERNATIONAL-NEGATIVE-VALUES DefaultNegCurrencyFormat 

property
SETUP-INTERNATIONAL-SEPARATORS DecimalSeparator property

ThousandsSeparator property
SETUP-INTERNATIONAL-TEXT TextCodePage property
SETUP-INTERNATIONAL-TIME TimeCycle property
SETUP-INTERNATIONAL-WK1 No LotusScript equivalent
SETUP-RECALCULATE CalcMode property
SETUP-RECALCULATE-ITERATIONS CalcIterations property
SETUP-RECALCULATE-ORDER CalcOrder property
SETUP-RECENT-FILES-NUMBER NumberOfMostRecentFiles 

property
SETUP-SKIP-SMARTMASTERS SmartMasterOn property
SETUP-SKIP-WELCOME WelcomeOn property
SETUP-UNDO UndoEnabled property
SETUP-WORKSHEET-DIRECTORY DefaultPath property
DIRECTORY DefaultPath property



Version Manager macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{RANGE-VERSION?} No longer supported
{SCENARIO-ADD-VERSION} AddVersion method
{SCENARIO-CREATE} NewVersionGroup method
{SCENARIO-DELETE} DeleteVersionGroup method
{SCENARIO-INFO} Description property

Share property
{SCENARIO-REMOVE-
VERSION}

RemoveVersion method

{SCENARIO-SHOW} MakeCurrent method
{VERSION-CREATE} NewVersion method
{VERSION-DELETE} DeleteVersion method
{VERSION-INDEX-COPY} No longer supported
{VERSION-INDEX-MERGE} MergeVersions method
{VERSION-INFO} Description property

Share property
StylesRetained property

{VERSION-REPORT} ReportVersion method
{VERSION-SHOW} MakeCurrent method
{VERSION-UPDATE} No longer supported



Window and screen display macro commands
The table below lists macro commands in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the 
current release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
{APP-ADJUST} Move method (windows)

Resize method
Restore method

{APP-STATE} Maximize method
Minimize method
Restore method

{BREAK} No LotusScript equivalent
{FRAMEOFF} ShowSheetFrame property
{FRAMEON} ShowSheetFrame property
{INDICATE} LongPrompt property
{PANELOFF} No LotusScript equivalent
{PANELON} No LotusScript equivalent
{VIEW-ZOOM} ZoomTo method
{WINDOW-ACTIVATE} Activate method
{WINDOW-ADJUST} Move method (windows)

Resize method
Restore method

{WINDOW-ARRANGE} Cascade method
Tile method
TileHorizontal method
TileVertical method

{WINDOW-STATE} Maximize method
Minimize method
Restore method

{WINDOWSOFF} UpdateSheetDisplay property
{WINDOWSON} UpdateSheetDisplay property
{WORKSHEET-TITLES} HorizontalTitle property

VerticalTitle property



Window info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
WINDOW-CUSTOM-ZOOM ZoomScale property
WINDOW-DISPLAY-DRAWN-OBJECTS ShowDrawLayer property
WINDOW-DISPLAY-EDIT-LINE EditLineVisible property
WINDOW-DISPLAY-FRAME ShowSheetFrame property
WINDOW-DISPLAY-FRAME-TYPE No longer supported
WINDOW-DISPLAY-GRID-LINES ShowGridLines property
WINDOW-DISPLAY-PAGE-BREAKS ShowAutomaticPageBreaks 

property
ShowManualPageBreaks 
property

WINDOW-DISPLAY-SCROLL-BARS ShowScrollBars property
WINDOW-DISPLAY-SMARTICONS IconBarsVisible property
WINDOW-DISPLAY-STATUS-BAR StatusBarVisible property
WINDOW-DISPLAY-TABS ShowSheetTabs property
WINDOW-HEIGHT Height property
WINDOW-SPLIT ViewSplitStyle property
WINDOW-SPLIT-HEIGHT No longer supported
WINDOW-SPLIT-SYNCHRONIZE SynchScrolling property
WINDOW-SPLIT-WIDTH No longer supported
WINDOW-WIDTH Width property
WINDOW-X-POSITION Left property
WINDOW-Y-POSITION Top property



Worksheet Defaults info component equivalents
The table below lists info components in 1-2-3 Release 5 for Windows and their LotusScript equivalents in the current
release of 1-2-3. For more information on individual 1-2-3 properties and methods, see 1-2-3 LotusScript A-Z.

1-2-3 Release 5 Current release of 1-2-3
WORKSHEET-ALIGN-TEXT TextHorizontalAlign property
WORKSHEET-BACKGROUND-COLOR Color property
WORKSHEET-COLUMN-WIDTH DefaultColumnWidth property

InitialColWidth property
WORKSHEET-DISPLAY-WINDOWS-DEFAULTS WindowsDefaultsDisplayed 

property
WORKSHEET-FONT DefaultFontName property

FontName property
WORKSHEET-FONT-SIZE DefaultFontSize property
WORKSHEET-FORMAT FormatName property
WORKSHEET-FORMAT-COLOR-NEGATIVES NegativesInColor property
WORKSHEET-FORMAT-DECIMALS FormatDecimals property
WORKSHEET-FORMAT-DISPLAY-ZEROS IsZeroDisplayed property
WORKSHEET-FORMAT-PARENTHESES IsParenthesized property
WORKSHEET-FORMAT-ZERO-TEXT ZeroDisplayAs property
WORKSHEET-GRID-COLOR GridLineColor property
WORKSHEET-GROUP-SHEETS GroupSheets method
WORKSHEET-ROW-HEIGHT DefaultRowHeight property

InitialRowHeight property
WORKSHEET-TAB-COLOR TabColor property
WORKSHEET-TEXT-COLOR ColorName property

DefaultTextColor property
FontColor property



Viewing log files
1-2-3 could not translate some information in the file you opened or saved.

Choose a task
Viewing the Excel log file
Viewing the Quattro Pro log file

{button ,AL(`H_WORKING_WITH_EXCEL_FILES_OVER;H_WORKING_WITH_QUATTRO_PRO_FILES_OVER',0)} 
See related topics



Viewing the Quattro Pro log file
When you open a Quattro Pro file in 1-2-3, not all information is translated or retained. 1-2-3 lists the data that could 
not be translated and saves it in a separate log file.
For example, if you open DATA.WB2 in 1-2-3 and the file contains an @function that has no equivalent in 1-2-3, 1-2-3
creates a log file called DATA.LOG that contains information about the untranslated @function. 1-2-3 saves the log 
file in the same folder that contains DATA.WB2.
If the folder where 1-2-3 puts the log file already contains a log file with the same name, the new log file replaces the 
previous one.
To view the log file, use a word processing program such as Word Pro, or a text editor.

{button ,AL(`H_WORKING_WITH_QUATTRO_PRO_FILES_OVER',0)} See related topics



Working with 1-2-3 for DOS files
You can open and save these 1-2-3 for DOS file types in 1-2-3 Release 9:

• 1-2-3 for DOS Releases 3 and 4 (.WK3)
• 1-2-3 for DOS Release 2 (.WK1)

1-2-3 Release 9 has many features that aren't available in 1-2-3 for DOS. When you save a 1-2-3 Release 9 file as 
a .WK1 or .WK3 file, information associated with new features is either lost or converted to default settings. To 
preserve this information, save the file using the file type for the current release before you save it as a .WK1 or .WK3
file.
Note To save a locked .123 file in .WK1 format, you must first unlock the file using File - Workbook Properties 
(Security tab). To convert a multiple-sheet file to a .WK1 file, use Edit - Copy and Edit - Paste to copy data from the 
multiple-sheet file in memory to a single-sheet file in memory, and then save the single-sheet file as a .WK1 file.
When you save a 1-2-3 Release 9 file as a .WK1 or .WK3 file, the following information is not retained:

• HTML settings for data published to a Web page
• Web table and hyperlink connections
• OLE links and borders for datalink tables
• Settings for multi-line headers and footers, header and footer height, printing collections on separate pages, and 

page numbers greater than 9,999
• LotusScript information
• Outlining
• New windows
• Query tables. 1-2-3 saves query tables as sheet data.
• Graphics and maps, except for charts
• Approach forms, reports, crosstabs, and mailing labels, and other embedded data from other Windows 

applications
• Settings that control the display of the sheet frame, grid lines, page breaks, and charts, and the displayed size of 

cells
• Sheet settings including names, and default text and cell background colors. If you don't delete or reorder the 

sheets in a .WK3 file in 1-2-3 for DOS Release 3 or 4, you see the previous sheet names when you reopen the 
file in 1-2-3 Release 9.

• File information such as title, subject, and description entered in the Workbook Properties dialog box or the Save 
As dialog box

• Information necessary to use File - TeamMail to send ranges of data
• Formula markers
• Cell comments

This additional information is lost when you save a 1-2-3 Release 9 file as a .WK1 file:
• ANSI characters that have no LICS equivalent
• Formula annotations
• Named print settings
• Grouped sheet settings
• The third variable in three-variable what-if tables

Character sets
When you open a .WK1 file, 1-2-3 uses LICS to read characters in the file.

Charts
When you save a .123 file containing charts as a .WK1 or .WK3 file, and then open the file in 1-2-3 for DOS Release 
2 or 3, you'll notice these differences:

• Charts display only the first six data series.
• Grid, radar, mixed, and HLCO charts appear as line charts.
• Doughnut charts are converted to pie charts.



• Mixed charts that combine 3D bars with a 2D line appear as 3D bars with a 3D line.
• 3D charts appear as the corresponding 2D chart type in versions of 1-2-3 for DOS that don't support 3D charts.
• The legend appears below the plot area.
• 1-2-3 converts data series colors and patterns to the closest 1-2-3 for DOS equivalent.
• Fonts may not map to a close equivalent.

If you don't edit the charts in a .WK3 file in 1-2-3 for DOS Release 3 or 4, you see the previous chart settings when 
you reopen the file in 1-2-3 Release 9.
When you create a pie chart in 1-2-3, 1-2-3 assumes that you don't want to plot negative values and omits the 
associated slices. Release 2 for DOS plots the absolute value of negative numbers. To make 1-2-3 pie charts created
in the current release of 1-2-3 consistent with Release 2 for DOS, use @ABS to make the negative numbers positive,
or create formulas to copy the positive value of the numbers to another range. 
To work with named charts created in 1-2-3 for DOS, open the file in the current release. Choose Edit - Go To, select 
"Charts" as the object type, and then select the named chart. 1-2-3 adds the chart to the center of the sheet area 
displayed on the screen. You can drag the chart to where you want it.

Data queries
To use input, output, and criteria ranges saved in a .WK1 or .WK3 file, use the /Data Query commands in 1-2-3 
Classic.
If you plan to share files containing queries with other versions of 1-2-3, you must use input, output, and criteria 
ranges and the /Data commands in 1-2-3 Classic. 

OLE links
If you save a file that contains a datalink table, as a .WK1 or .WK3 file, 1-2-3 retains the data in the cells but the OLE 
link and table border are lost.

DDE links
If you save a file that contains DDE links created with @DATALINK as a .WK1 or .WK3 file, 1-2-3 saves the links as 
add-in @functions that evaluate to NA or ERR. If you don't edit the cells containing the @function, 1-2-3 Release 9 
retains the links when you reopen the file.

Displaying long values
For display only, the current release of 1-2-3 rounds the number of digits in a value to fit in a cell. Release 2 for DOS 
cuts off the digits that don't fit.

File links
In the current release of 1-2-3, when you open a .WK1 file that contains a reference to another file, the file link looks 
like this: @@("<<FILE NAME>>RANGE").
If you open a .WK1 file containing a file link in Release 2.01 for DOS, the formula results in ERR because Release 
2.01 doesn't support file links.

Formulas
1-2-3 lets you use a range name in a formula even if you haven't assigned the name to a range. Formulas that 
contain undefined range names evaluate to ERR until you assign the range name to a range address. 
Formulas that contain more than 240 characters are saved as is. However, if you try to edit such a formula in Release
2 for DOS, 1-2-3 truncates the formula after the 240th character.

@Functions
@Functions that are not available and @functions that have unavailable arguments in 1-2-3 for DOS are treated as 
add-in @functions when you save them in a .WK1 or .WK3 file. Cells that contain these @functions evaluate to NA in 
Release 2 for DOS, and to ERR in Releases 3 and 4. If you don't edit the cells containing these @functions, the 
current release of 1-2-3 restores the original @functions when you reopen the file.
In the current release of 1-2-3, database @functions can take a formula as their last argument, while 1-2-3 for DOS 
supports only a criteria range. If you save database @functions that contain a formula argument in a .WK1 or .WK3 
file, they won't work in 1-2-3 for DOS.
When you open a .WK1 or .WK3 file containing @functions that were created by a 1-2-3 for DOS add-in program, the
@functions evaluate to ERR in the current release. 



In 1-2-3 Release 9, if you enter 2-digit years in @DATE, 1-2-3 always interprets the year as falling in the 20th century 
(1900 to 1999). However, @functions that use text arguments to specify dates (for example, @DATEVALUE) use a 
sliding window setting to determine the century in which a 2-digit year falls. For more information, see 1-2-3 and the 
year 2000.

Hidden cell contents
When you lock a file in 1-2-3, hidden cell contents don't appear in the contents box. In Release 2.01 for DOS, hidden 
cell contents appear in the control panel, even if global protection is turned on.

Number formats
If you format data using either the Euro or ISO Euro currency format, and then save the file as an earlier 1-2-3 file 
type, 1-2-3 converts the currency format to Comma format.
When you save a .123 file that contains multiple currency formats as a .WK1 file, and then open the file in 1-2-3 for 
DOS, 1-2-3 displays the multiple currency formats using the default currency setting specified in the version of 1-2-3 
for DOS in which you opened the file. If you reopen the file in the current release, 1-2-3 doesn't restore the multiple 
currency formats.

Perspective view
If you try to open a file saved in perspective view, 1-2-3 will open the file with the default workbook view.

Print settings
When you open .WK3 or .WK1 files created in 1-2-3 for DOS, the print settings information saved in the 
associated .ALS or .AL3 file cannot be accessed by the current release of 1-2-3. To use print settings that you saved 
in a .WK1 or .WK3 file created in 1-2-3 for DOS, use the /Print commands in 1-2-3 Classic.
The current release of 1-2-3 does not save print settings information in an .ALS or .AL3 file when you save the 
worksheet as a .WK3 or .WK1 file.

Range names
In 1-2-3 Release 9, each sheet contains 65,536 rows. If you open a file created in an earlier 1-2-3 release and the file
contains a range name that looks like a cell address (for example, T35000), formulas that reference the range name 
can produce unexpected results. For detailed information on valid range names, see Naming a range.

Significant digits
Because the current release of 1-2-3 calculates values to 15 significant digits while 1-2-3 for DOS Releases 3 and 4 
calculate to 18 digits, a logical formula comparing two values may produce different results. If needed, use @ROUND
to round the result to 15 significant digits.

Sort keys
1-2-3 lets you create up to 255 sort keys while Release 2 for DOS supports only two sort keys. If you save a .123 file 
containing extra sort keys as a .WK1 file, the extra sort keys are lost.

Styling
When you save a .123 file as a .WK3 file, 1-2-3 saves styles in a format file. 1-2-3 does not create a format file when 
you use File - Save As to save a .WK1 file. All styling information will be converted to the closest default style, or lost.
When you open the file in 1-2-3 for DOS, the data in the file looks different depending on whether WYSIWYG is 
loaded. The current release of 1-2-3: 

• Changes styles not recognized in .WK1 and .WK3 files to 1-2-3 for DOS default styles.
• Uses the first eight fonts on the sheet and converts the rest to their closest equivalents in 1-2-3 for DOS.
• Converts colors, line styles, and line widths to their closest 1-2-3 for DOS equivalent.
• Converts patterns to the closest type of shading.
• Places left-aligned or centered values to the right; aligns data that was evenly spaced in cells or aligned across 

columns to the left.
• Converts number formats that do not exist in Release 2 for DOS to default Release 2 formats.
• Converts frames with a drop shadow to drop shadows, and maps other frames to various border styles.
• Retains the first eight named styles and the first six characters of each named style name. New settings, such as 

number format and alignment, are lost. Ranges formatted with other named styles retain their settings, but the 



named styles can't be applied to other ranges.
• Converts settings created with the Style Gallery to their closest equivalent.

Transposing ranges
When you transpose a range containing formulas in 1-2-3, 1-2-3 copies the formula results rather than the formulas. 
Release 2.01 for DOS copies the formulas rather than their results.

Versions and version groups
If you save a .123 file containing versions and version groups as a .WK1 or .WK3 file, 1-2-3 keeps only the version or 
version group data currently displayed and treats it as sheet data.
To share versions and version groups created in the current release with 1-2-3 Release 4 for DOS, first save the file 
as a .123 file before saving it as a.WK4 file. Then, resave the .WK4 file as a .WK3 file using 1-2-3 Release 5 for 
Windows, or convert it to a .WK3 file using the Translator utility in 1-2-3 Release 4 for DOS. 1-2-3 retains the data but
not the tracking information that tells you who created or modified the data, when, and why. Styles applied to the 
versions are also lost.
All lowercase characters in version and version group names are converted to uppercase in the .WK3 file. To avoid 
breaking any @functions or macro commands that refer to the names, be sure to use uppercase characters only. 
If you want to use the current release of 1-2-3 to work with versions and version groups created in 1-2-3 Relase 4 for 
DOS, you can open the .WK3 file in 1-2-3 Release 5 for Windows and resave it as a .WK4 file, or use the Translator 
utility in 1-2-3 Release 4 for DOS to convert the file to .WK4 format. 
If you open a .WK4 file that contains any versions or version groups with the same name, 1-2-3 renames them with a 
unique name. For example, if the file contains two versions called "BEST CASE" in the same range, 1-2-3 renames 
one "BEST CASE1."
If the ranges that contain the versions exceed 2000 cells, 1-2-3 can't interpret any versions and treats the versions or 
version group data currently displayed as sheet data.

{button ,AL(`H_WORKING_WITH_123_FILES_OVER;H_123_WORKING_WITH_OS2_FILES_OVER;H_OPENING_
AN_EXISTING_FILE_STEPS;H_SAVING_AN_EXISTING_FILE_STEPS;H_SAVING_A_NEW_WORKBOOK_STE
PS',0)} See related topics



Working with 1-2-3 for OS/2 files
You can open and save 1-2-3 for OS/2 Warp™ 4 .123 files in 1-2-3 Release 9.
1-2-3 Release 9 has features that aren't available in 1-2-3 for OS/2 Warp 4. When you save a 1-2-3 Release 9 file as 
a 1-2-3 for OS/2 Warp 4 .123 file, information associated with new features may be lost. To preserve this information, 
save the file using the file type for the current release before you save it as a 1-2-3 for OS/2 Warp 4 .123 file.
When you save a file as a 1-2-3 for OS/2 Warp 4 .123 file, the following information is not retained:

• HTML settings for data published to a Web page
• Web table and hyperlink connections
• OLE links and borders for datalink tables
• Settings for multi-line headers and footers, header and footer height, printing collections on separate pages, and 

page numbers greater than 9,999

Charts
1-2-3 Release 9 lets you create a mixed chart type that combines 3D bars with a 2D line. If you save a file that 
contains this type of chart as a 1-2-3 for OS/2 Warp 4 .123 file, the 2D line setting is lost.

@Functions
@Functions that are not available in 1-2-3 for OS/2® are treated as add-in @functions when you save them in a 1-2-
3 for OS/2 Warp 4 .123 file. Cells that contain these @functions evaluate to ERR when you open a file containing 
them in 1-2-3 for OS/2. If you don't edit the cells containing these @functions and then reopen the file in 1-2-3 
Release 9, the original @functions are restored.
In 1-2-3 Release 9, if you enter 2-digit years in @DATE, 1-2-3 always interprets the year as falling in the 20th century 
(1900 to 1999). However, @functions that use text arguments to specify dates (for example, @DATEVALUE) use a 
sliding window setting to determine the century in which a 2-digit year falls. For more information, see 1-2-3 and the 
year 2000.

OLE links
1-2-3 for OS/2 does not support OLE. If you save a 1-2-3 Release 9 file that contains a datalink table as a 1-2-3 for 
OS/2 .123 file, 1-2-3 retains the data in the cells but the OLE link and table border are lost. 

DDE links
Both 1-2-3 for OS/2 Warp 4 and 1-2-3 Release 9 use @DATALINK to create DDE links. If you want to share files that 
contain DDE links with 1-2-3 for OS/2, you must save the information as a 1-2-3 for OS/2 Warp 4 .123 file.

Number formats
If you format data using either the Euro or ISO Euro currency format, and then save the file as a 1-2-3 for OS/2 Warp 
4 .123 file, 1-2-3 converts the currency format to Comma format.

Range names
In 1-2-3 Release 9, each sheet contains 65,536 rows. If you open a file created in an earlier 1-2-3 release and the file
contains a range name that looks like a cell address (for example, T35000), formulas that reference the range name 
can produce unexpected results. For detailed information on valid range names, see Naming a range.

{button ,AL(`H_WORKING_WITH_123_FILES_OVER;H_123_WORKING_WITH_DOS_FILES_OVER;H_SAVING_A
_NEW_WORKBOOK_STEPS;H_SAVING_AN_EXISTING_FILE_STEPS;H_OPENING_AN_EXISTING_FILE_ST
EPS',0)} See related topics



Working with 1-2-3 for Windows files
You can open and save these 1-2-3 for Windows file types in 1-2-3 Release 9:

• 1-2-3 Release 9 (.123)
• 1-2-3 97 (.123)
• 1-2-3 for Windows Releases 4 and 5 (.WK4)
• 1-2-3 for Windows Release 1 (.WK3)

1-2-3 Release 9 has features that aren't available in earlier 1-2-3 releases. When you save a 1-2-3 Release 9 file as 
an earlier 1-2-3 file type, information associated with new features may be lost. To preserve this information, save the 
file using the file type for the current release before you save it as an earlier file type.
When you save a file as a Lotus 1-2-3 97 .123 file, or as a 1-2-3 .WK3 or .WK4 file, the following information is not 
retained:

• HTML settings for data published to a Web page
• Web table and hyperlink connections
• Settings for multi-line headers and footers, header and footer height, printing collections on separate pages, and 

page numbers greater than 9,999
This additional information is lost when you save a file as a 1-2-3 .WK3 or .WK4 file:

• LotusScript information
• Outlining
• New windows
• OLE links and borders for datalink tables

Duplicate style names
If you open a .WK3 or .WK4 file that contains named styles that have the same name, 1-2-3 appends a number to the
end of the second style name to distinguish between the two.
For example, if the workbook contains a named style called "BoldTotal" and a second named style called "Boldtotal," 
1-2-3 converts both named style names to uppercase and renames the second named style "BOLDTOTAL1."

@Functions
@Functions that are not available and @functions that have unavailable arguments in previous releases of 1-2-3 are 
treated as add-in @functions when you save them in a .WK3 or .WK4 file. Cells that contain these @functions 
evaluate to ERR when you open a file containing them in a previous release. If you don't edit the cells containing 
these @functions and then reopen the file in 1-2-3 Release 9, the original @functions are restored.
@DATALINK works differently in 1-2-3 Release 9 than in 1-2-3 97. In 1-2-3 Release 9, @DATALINK creates a DDE 
link. In 1-2-3 97, @DATALINK creates an OLE link.
In 1-2-3 Release 9, if you enter 2-digit years in @DATE, 1-2-3 always interprets the year as falling in the 20th century 
(1900 to 1999). However, @functions that use text arguments to specify dates (for example, @DATEVALUE) use a 
sliding window setting to determine the century in which a 2-digit year falls. For more information, see 1-2-3 and the 
year 2000.

OLE links
When you open a 1-2-3 97 .123 file that contains @DATALINK in 1-2-3 Release 9, 1-2-3 retains the OLE link and 
replaces @DATALINK with a datalink table. 
When you save a file that contains a datalink table as a 1-2-3 97 .123 file, 1-2-3 uses @DATALINK to retain the OLE 
link. If you save a file that contains a datalink table as a .WK4 file, 1-2-3 retains the data in the cells but the OLE link 
and table border are lost.

DDE links
1-2-3 for Windows Release 5 uses @DDELINK to create a DDE link. When you open a 1-2-3 for Windows Release 
5 .WK4 file that contains @DDELINK, 1-2-3 Release 9 retains the DDE link by replacing @DDELINK with 
@DATALINK. 
When you save a file that contains @DATALINK as a .WK4 file, 1-2-3 replaces @DATALINK with @DDELINK. 

Data queries
1-2-3 Release 9 comes with a Data Query Add-in (DQA) that provides functionality similar to that of 1-2-3 for 



Windows Release 5 and the DQA add-in created for use with 1-2-3 97. 
You can create query tables with DQA and then save them as a 1-2-3 97 .123 file or a .WK4 file. You can also open 
files that contain DQA data queries created in 1-2-3 97 and 1-2-3 Release 5 and work with them in 1-2-3 Release 9.

Macro buttons
If you open a .WK4 file that contains a macro button that was created in 1-2-3 Release 5 for Windows, 1-2-3 updates 
the button by embedding its macro commands in a LotusScript Click event. When you click the button, 1-2-3 
executes the Click event. You can add more LotusScript or macro commands to the Click event. However, if you 
resave the .WK4 file, new LotusScript or macro commands are not saved. To save these new LotusScript or macro 
commands, save the file as a .123 file.
Note  Once you have saved a file containing buttons as a .123 workbook, the original macro text is available only in 
the Click event. Therefore, buttons in .123 files will not work if you later save the file in .WK4 format. To retain the 
original macro text, save files containing buttons as .WK4 files.

Maps and charts
When you open a .WK4 file that contains a map that was created in 1-2-3 Release 5 for Windows, 1-2-3 converts the 
map to a .123 map.
Caution  If you resave the .WK4 file, the map object will be lost. To retain the map, save the file as a .123 file.
1-2-3 Release 9 lets you create a mixed chart type that combines 3D bars with a 2D line. If you save a file that 
contains this type of chart as an earlier 1-2-3 file type, the 2D line setting is lost.
If you save a file that contains a grid chart as a .WK3 or .WK4 file, the grid chart is converted to a line chart. Similarly, 
if the file contains any doughnut charts, they are converted to pie charts. 

Number formats
If you format data using either the new Euro or ISO Euro currency format, and then save the file as an earlier 1-2-3 
file type, 1-2-3 converts the currency format to Comma format.
When you save a 1-2-3 file that contains multiple currency formats as a .WK3 file, and then open the file in 1-2-3 for 
Windows Release 1, 1-2-3 displays the multiple currency formats using the default currency setting specified in 1-2-3 
for Windows Release 1. If you reopen the file in 1-2-3 Release 9, 1-2-3 doesn't restore the multiple currency formats.
You'll see the same result if you open a 1-2-3 file that contains multiple currency formats in 1-2-3 for Windows 
Release 4.0. However, if you don't modify the number formats, 1-2-3 displays the multiple currency formats when you
reopen the file in 1-2-3 Release 9.

Print settings
When you open a .WK4, .WK3, or .WK1 file, you can use the print settings information saved with that file by 
choosing File - Preview & Page Setup (Named Style tab), clicking Retrieve, and selecting the appropriate .AL3 file. 1-
2-3 Release 9 does not save print settings information in an .AL3 file when you save the workbook as a .WK4, .WK3, 
or .WK1 file.

Range names
In 1-2-3 Release 9, each sheet contains 65,536 rows. If you open a file created in an earlier 1-2-3 release and the file
contains a range name that looks like a cell address (for example, T35000), formulas that reference the range name 
can produce unexpected results. For detailed information on valid range names, see Naming a range.

Significant digits
Because 1-2-3 calculates values to 15 significant digits while 1-2-3 Release 5 for Windows calculates to 18 digits, a 
logical formula comparing two values may produce different results. If needed, use @ROUND to round the result to 
15 significant digits.

Versions and version groups
Releases prior to 1-2-3 for Windows Release 4 do not support different sets of data in the same named range. In the 
current release, if you save a .123 file containing versions and version groups as a .WK3 file, 1-2-3 keeps only the 
version or version group data currently displayed and treats it as sheet data.
If you open a .WK4 file that contains any versions or version groups with the same name, 1-2-3 renames them with a 
unique name. For example, if the file contains two versions called "Best Case" in the same range, 1-2-3 renames one
"Best Case1."



{button ,AL(`H_123_WORKING_WITH_DOS_FILES_OVER;H_SAVING_A_NEW_WORKBOOK_STEPS;H_SAVING
_AN_EXISTING_FILE_STEPS;H_OPENING_AN_EXISTING_FILE_STEPS;H_123_WORKING_WITH_OS2_FILE
S_OVER',0)} See related topics



Working with dBASE and Paradox files
In the current release of 1-2-3, you can open dBASE IV (.DBF) and Paradox (.DB) files, and combine data from these
file types on disk into an open workbook. You can also save dBASE IV and Paradox files.
To open and save dBASE IV and Paradox files, you must install ODBC drivers for dBASE IV and Paradox. The 1-2-3 
default is to install the driver for dBASE IV only.

Opening dBASE IV and Paradox files
When opening a dBASE IV or Paradox file, you can either specify the file type and select the file you want, or type the
file name with a .DBF or .DB extension. dBASE IV and Paradox files that you have open in 1-2-3 are not locked and 
can still be accessed or changed by others on your network.
You can insert rows for new records, and columns for new fields, within the range of the original dBASE IV or 
Paradox table. When you save the file, 1-2-3 inserts these new records into the table and creates a new table with a 
new table definition. However, 1-2-3 does not save new records appended at the end of the table, or new fields 
added outside the range of the original table, in the dBASE IV or Paradox file.

Saving dBASE IV and Paradox files
When you save changes to a dBASE IV or Paradox file, 1-2-3 saves only the data in the database table range, 
including data in rows or columns that you added within this range. Nothing outside this range is saved. Styles, 
number formats, charts, and drawn objects are not saved to the dBASE or Paradox file.
When you save a .123 file in .DBF or .DB format, you can save only a selected range containing a valid database 
table. You save the file using File - Save As, and you must select    "Selected range only."    1-2-3 saves only the data 
in the selected range. Styles, number formats, charts, and drawn objects are not saved.
You cannot save a .123 file in .DBF or .DB format with a password or comments. The dBASE IV or Paradox file does 
not maintain any password protection for the .123 file you saved. If you save a .123 file to a dBASE IV or Paradox file 
that has a password, 1-2-3 writes over the password and you have to create a new password for the dBASE IV or 
Paradox file.

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_CLOSING_AND_SAVING_FILES_OVER;H_123_OD
BC_DRIVERS_OVER',0)} See related topics



Working with Quattro Pro files
You can open these Quattro Pro file types in 1-2-3 Release 9:

• .WQ1 files created in Quattro Pro for DOS Versions 1.0 through 4.0 
• .WB1 files created in Quattro Pro Versions 1.0 and 5.0 for Windows
• .WB2 files created in Quattro Pro Version 6.0 for Windows

Note You cannot open .WB3 files created in Quattro Pro Version 7.0 for Windows 95.
1-2-3 treats Quattro Pro template files and macro library files as standard files.
1-2-3 records information about untranslated data in the Quattro Pro log file.

Quattro Pro log file
When you open a Quattro Pro file in 1-2-3, not all information is translated or retained. 1-2-3 lists the data that could 
not be translated and saves it in a separate log file.
For example, if you open DATA.WB2 in 1-2-3 and the file contains an @function that has no equivalent in 1-2-3, 1-2-3
creates a log file called DATA.LOG that contains information about the untranslated @function. 1-2-3 saves the log 
file in the same folder that contains DATA.WB2.
If the folder where 1-2-3 puts the log file already contains a log file with the same name, the new log file replaces the 
previous one.
To view the log file, use a word processing program such as Word Pro, or the Windows 95 WordPad or Notepad 
accessories.

Translation restrictions
When you open a Quattro Pro file in 1-2-3, 1-2-3 translates text, formulas, and values in the file. It also translates 
column widths, tab names, and many @functions. 1-2-3 does not translate:

• Graphic objects, including drawn objects and charts
• Object pages
• Notebook zoom and display settings
• Split views
• File links
• @Functions with no direct equivalent

Password-protected files
To open a Quattro Pro file that has password protection, you must remove the password in Quattro Pro before 
opening the file in 1-2-3.

Formatting
1-2-3 retains number and date formats. 1-2-3 converts other formatting such as alignment, colors, and fonts to the 
current default settings in 1-2-3. 

Range names
1-2-3 translates range names and range name references in .WB1 and .WB2 files. If a Quattro Pro file contains range
names that refer to a single cell, 1-2-3 replaces those range name references with cell addresses.

@Functions
1-2-3 translates many Quattro Pro @functions to the equivalent 1-2-3 @function. If a Quattro Pro @function has no 
equivalent in 1-2-3, 1-2-3 displays the Quattro Pro @function like this:
@<<QP>>FUNCTION NAME(ARGUMENTS); CURRENT VALUE
The current value is the last calculated value saved in Quattro Pro before translation. You must edit untranslated 
Quattro Pro @functions and formulas before you can use them in 1-2-3.
The log file lists untranslated Quattro Pro @functions and includes the cell location, @function name, and current 
value.
To use an untranslated Quattro Pro @function, you can:

• Write an add-in @function using an add-in development application
• Build a formula that recreates the untranslated @function
• Use the current value



Macros
1-2-3 does not translate Quattro Pro macros. You can run some Quattro Pro macro commands that are equivalent to 
1-2-3 macro commands. However, customized macro applications will require rewriting before you can run them in 1-
2-3.

{button ,AL(`H_CREATING_AND_OPENING_FILES_OVER;H_123_VIEWING_THE_QUATTRO_PRO_LOG_FILE_S
TEPS',0)} See related topics



Checking spelling
1-2-3 checks for unknown and duplicate words. 
1. Choose Edit - Check Spelling. 

2. In the "Look in" list, specify where you want 1-2-3 to check for spelling errors. 
3. Click Start. 
4. To correct a word, select a word from the "Alternatives" list, or edit the word in the "Replace with" box, then click 

Replace.
5. To keep the original spelling, click Skip. 
6. Repeat steps 4 and 5 for each unrecognized word. 
7. Click Done. 

{button ,AL(`H_CHECKING_SPELLING_DETAILS',1)} See details
{button ,AL(`;H_CHANGING_SPELL_CHECKING_OPTIONS_STEPS;H_EDITING_THE_SPELLING_DICTIONARY_

STEPS;H_CHANGING_LANGUAGE_OPTIONS_STEPS;H_CREATING_A_USER_DICTIONARY_STEPS;',0)} 
See related topics



Details: Checking spelling
Specifying where 1-2-3 checks for spelling errors
1-2-3 checks spelling in cells, text blocks, and maps.

• Current workbook -- Checks the spelling in all sheets of the current workbook. 
• All workbooks -- Checks all active workbooks.
• Current sheet -- Checks the current sheet. 
• Selected range -- Checks the range you specify. You can select the range before you choose Edit - Check 

Spelling, or you can click the range selector in the dialog box and select the range. 
Note 1-2-3 does not check spelling in cell comments, non-displayed versions, embedded objects, or hidden sheets, 
columns, or rows. If you select a range to check, 1-2-3 doesn't check text blocks and maps in the range. It is not 
recommended to check spelling in query tables, Web tables, or datalink tables because changes will be overwritten 
when you refresh these tables.

Replacing, skipping, and adding words
If 1-2-3 doesn't find a word in the main dictionary or the user dictionary, you can: 

Click To
Replace Correct the spelling of the word
Replace All Correct the spelling of all occurrences of the word
Skip Ignore the word, but stop on the next occurrence
Skip All Ignore all occurrences of the word
Add to Dictionary Add the word as spelled to the user dictionary 

Canceling the spell check
You can click Done at any time to stop checking spelling. 1-2-3 saves all corrections made up to that point. 

{button ,AL(`H_CHECKING_SPELLING_STEPS',1)} Go to procedure



Changing spell checking options
You can specify what kind of words 1-2-3 looks for, and set dictionary options.
1. Choose Edit - Check Spelling. 

2. Click Options. 
3. Under Check for, select an option:

• Repeated words -- Finds words that occur twice in a row, such as "the the".
• Words with numbers -- For example, Quarter1 or 1st.
• Words with initial caps -- For example, Sandra or Madrid.

4. Under Include, select an option:
• User dictionary alternatives -- Displays words from the user dictionary as alternative spellings.
• Macro/@function keywords, punctuation -- Recognizes macro keywords and @function names as correctly 

spelled, and argument separators as acceptable punctuation. 
5. Click OK to return to the Check Spelling dialog box. 

{button ,AL(`H_CHANGING_SPELL_CHECKING_OPTIONS_DETAILS',1)} See details
{button ,AL(`H_EDITING_THE_SPELLING_DICTIONARY_STEPS;H_CHANGING_LANGUAGE_OPTIONS_STEPS;

H_CREATING_A_USER_DICTIONARY_STEPS;',0)} See related topics



Details: Changing spell checking options
When you choose not to check for repeated words, 1-2-3 checks the spelling of the words, but doesn't report 
repeated words as an error.
When you choose not to check for words with numbers or words with initial capitals, 1-2-3 does not check the spelling
of these words.

{button ,AL(`H_CHANGING_SPELL_CHECKING_OPTIONS_STEPS',1)} Go to procedure



Changing to another dictionary
You can select the language and user dictionaries 1-2-3 uses to check spelling. 
1. Choose Edit - Check Spelling.

2. Click Options. 
3. To use a different language dictionary, select a language from the "Language" list.
4. To use a different user dictionary, click Choose User Dictionary, select a file with the extension .UDC, and click 

Open.
Note The default directory for dictionaries is \LOTUS\COMPNENT\SPELL.

5. Click OK to return to the Check Spelling dialog box.

{button ,AL(`H_CHANGING_SPELL_CHECKING_OPTIONS_STEPS;H_EDITING_THE_SPELLING_DICTIONARY_
STEPS;H_CREATING_A_USER_DICTIONARY_STEPS;',0)} See related topics



Editing the user dictionary
The user dictionary contains words that are not in the language dictionary, but that you want 1-2-3 to recognize as 
correctly spelled.
1. Choose Edit - Check Spelling.

2. Click Edit Dictionary.
3. To add a word, enter it in the "New word" box and click Add.
4. To delete a word, select it in the "Current words" list and click Delete.
5. Click Done to return to the Check Spelling dialog box.

{button ,AL(`H_EDITING_THE_SPELLING_DICTIONARY_DETAILS',1)} See details
{button ,AL(`;H_CHECKING_SPELLING_STEPS;H_CHANGING_SPELL_CHECKING_OPTIONS_STEPS;H_CHAN

GING_LANGUAGE_OPTIONS_STEPS;',0)} See related topics



Details: Editing the user dictionary
Words appear in the following order in the "Current words" list: symbols and numbers in ASCII order, words in 
alphabetical order. 

{button ,AL(`H_EDITING_THE_SPELLING_DICTIONARY_STEPS',1)} Go to procedure



Creating a user dictionary
You can create a new user dictionary if you have a set of words that you want 1-2-3 to treat as spelled correctly, such 
as the names of team members or product names. 
1. Choose Edit - Check Spelling. 

2. Click Options.
3. Enter a path and file name in the "User dictionary" box. 

Note The default directory for dictionaries is \LOTUS\COMPNENT\SPELL. The default user dictionary is 
LTSUSER1.UDC.

4. Click OK. 
1-2-3 creates an empty dictionary.

5. (Optional) To add words to the dictionary, click Edit Dictionary.

{button ,AL(`H_EDITING_THE_SPELLING_DICTIONARY_STEPS;H_CHANGING_LANGUAGE_OPTIONS_STEPS;'
,0)} See related topics



Options dialog box
Use this dialog box to change spell checking options, change to another language dictionary, or create a new user 
dictionary. 

Choose a task
Changing spell checking options
Changing to another dictionary
Creating a user dictionary



Creating a blank workbook
Creating a blank workbook is like starting with a clean piece of paper. You enter the data and formulas, and format 
the information yourself.
1. Start 1-2-3.
2. In the Welcome to 1-2-3 dialog box, click Create a Blank Workbook.

{button ,AL(`H_OPENING_AN_EXISTING_SPREADSHEET_STEPS;H_USING_SMARTMASTERS_STEPS;',0)} See
related topics



Ending 1-2-3
When you end a session, 1-2-3 removes all active files from memory but does not delete the files from disk. 
Note  If you are working with file types associated with earlier 1-2-3 releases (for example Lotus 1-2-3 97 .123 or 
Lotus 1-2-3 Release 5 .WK4) and you used features that are new in the current release of 1-2-3, use File - Save to 
save the files individually before ending the 1-2-3 session.
1. From the File menu, choose Exit 1-2-3.

If you have modified one or more active files, 1-2-3 prompts you to save changes to each file before closing the 
file and ending the 1-2-3 session.

2. Choose one of the following options:
• Yes -- Saves changes to the file before ending the session.

If you created a new file, 1-2-3 displays the Save As dialog box so you can enter a name for the new file 
before ending the 1-2-3 session.

• No -- Closes the file without saving changes.
• Cancel -- Returns you to 1-2-3 without saving any active files, but you can save changes later.
• Save All -- Saves all active files that have changed, or updates all embedded 1-2-3 workbooks, and ends the 

1-2-3 session.
Note If you are exiting a 1-2-3 workbook that is embedded in another application file, you return to the other 
application when the 1-2-3 session ends.

{button ,AL(`H_ENDING_123_DETAILS',1)} See details



Details: Ending 1-2-3
Saving changes to all files
If you worked with features that are new in the current release of 1-2-3 and want to retain that data, you must save 
the file containing that data using the file type for the current release.
If you choose Save All to save a mix of files that you created in the current release of 1-2-3 and files that use a file 
type associated with an earlier 1-2-3 release, you may lose data that is not supported in the earlier release. To avoid 
data loss, before you end the 1-2-3 session, save the files that use the earlier 1-2-3 file type and specify the file 
format for the current release of 1-2-3. 

{button ,AL(`H_ENDING_123_STEPS',1)} Go to procedure



Opening an existing workbook
1. Start 1-2-3.
2. In the Welcome to 1-2-3 dialog box, double-click the workbook file you want to open.
3. (Optional) If the file you want to open does not appear in the list, click Browse for More Workbooks.

{button ,AL(`H_CREATING_A_BLANK_SPREADSHEET_STEPS;H_USING_SMARTMASTERS_STEPS;',0)} See 
related topics



Creating a new workbook using a SmartMaster
A 1-2-3 SmartMaster is a template for business and financial tasks. Each SmartMaster gives you a head start for 
creating attractive, useful workbooks. 
For quick results, you can enter your own data and use the built-in buttons to print or mail the data. You can also 
create your own SmartMaster.
1. Start 1-2-3.
2. In the Welcome to 1-2-3 dialog box, click the Create a New Workbook Using a SmartMaster tab.

1-2-3 lists SmartMaster files in the current SmartMaster directory. When you highlight a file, 1-2-3 displays a 
description.

3. (Optional) To browse through other directories to find a SmartMaster that is not on the list, click More 
SmartMaster Templates. 

4. Double-click the SmartMaster you want to use.

{button ,AL(`H_CREATING_A_BLANK_SPREADSHEET_STEPS;H_OPENING_AN_EXISTING_SPREADSHEET_ST
EPS;H_WORKING_WITH_SMARTMASTER_TEMPLATES_OVER;H_CREATING_AND_OPENING_FILES_OVE
R;H_CREATING_A_SMARTMASTER_TEMPLATE_STEPS',0)} See related topics



Overview: Welcome to 1-2-3
The 1-2-3 Welcome dialog box appears when you start 1-2-3. To begin working in 1-2-3, you can do one of the 
following:

• Open an existing workbook. 
• Create a new workbook using a SmartMaster. SmartMaster templates contain calculations, formatting, and 

instructions to generate common business and financial forms.
• Create a blank workbook. 

{button ,AL(`H_CREATING_A_BLANK_SPREADSHEET_STEPS;H_LEARN123_TOUR_OVER;H_OPENING_AN_E
XISTING_SPREADSHEET_STEPS;H_USING_SMARTMASTERS_STEPS;H_ENDING_123_STEPS',0)} See 
related topics



Overview: Using 1-2-3 to analyze data
You can use 1-2-3 to analyze statistics over a period of time. Statistical analysis involves collecting, organizing, and 
interpreting numeric data. With 1-2-3, you can:

• Calculate a frequency distribution to find out how many values in a range fall within certain numeric intervals.
• Perform a regression analysis to determine whether one set of data has any correlation to another set of data.
• Invert and multiply matrixes to solve problems involving probabilities or multiple variables.
• Solve what-if problems that answer questions like "What would happen to my profits if my sales went up 30%?".

{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_STEPS;H_USING_DATA_MATRIXES_OVER;H_U
SING_REGRESSION_ANALYSIS_OVER;H_WHATIF_TABLES_AND_BACKSOLVING_OVER',0)} See related 
topics



Calculating a frequency distribution
You use a frequency distribution to find out how many values in a range fall within certain numeric intervals, called 
bins.
1. Enter the values for the values range.
2. Enter the values for the bin range in ascending order in one column. In each cell of the bin range, enter the upper 

limit for the bin.
Note Leave the column to the right of the bin range blank. 1-2-3 puts the results of the frequency distribution in 
this column and writes over any existing data.

3. Select the values range.
4. Choose Range - Analyze - Distribution.
5. Enter the bin range in the "Bin range" box, or use the range selector to specify the range.
6. Click OK. 

{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_DETAILS',1)} See details
{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_EX',1)} See example
{button ,AL(`H_ANALYZE_DATA_OVER;',0)} See related topics



Details: Calculating a frequency distribution
Setting up the bin range
The bin range contains the numeric intervals within which you want to distribute the values.    The value in each cell in
the bin range is the upper limit for that bin.
Follow these guidelines when you set up this range:

• Put the bin range in a single sheet.
• The intervals don't have to be equal.

Tip If you want to fill a range quickly with even intervals, you can use Range - Fill.
• The intervals must be in ascending order.
• Don't include text or blank cells in the bin range.

Setting up the values range
The values range contains the values you want to count. The values range can be in one or more sheets in a 
workbook file that's either active or on disk. 1-2-3 analyzes only the numeric data in the values range and ignores text
and blank cells. The order of the data doesn't matter.

{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_STEPS',1)} Go to procedure
{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_EX',1)} See example



Example: Calculating a frequency distribution
A frequency distribution counts how many values in a range fall within certain numeric intervals. For example, you 
can use a frequency distribution to count how many of your monthly sales orders are less than or equal to $3000, 
how many are greater than $3000 and less than or equal to $5000, and how many are greater than $5000. 
1-2-3 calculates the frequency distribution using the values range and the bin range.

• The values range contains the values you want to count.
• The bin range contains the numeric intervals within which you want to distribute the values.

1-2-3 puts the results of the frequency distribution in the column to the right of the bin range.

Interpreting the results
When you calculate a frequency distribution, the results show how many values are equal to or less than the bin 
value to the left. If no values fall within a bin, 1-2-3 enters 0 next to the bin.
A frequency distribution always produces one more value than the number of bins. 1-2-3 counts any values that are 
greater than the largest bin value and displays that number in the cell just below and to the right of the largest bin 
value.
In this example, there are:

• Three sales orders equal to or less than $3000 (shown in cell E7).
• Five sales orders between $3000 and $5000 (shown in cell E8).
• Four sales orders greater than $5000 (shown in cell E9).

{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_STEPS',0)} See related topics



Overview: Using regression analysis
Regression analysis determines whether one set of data (one or more independent variables) has any relationship, or
correlation, to another set of data (dependent variable). You can make predictions once you calculate these 
relationships. 1-2-3 performs multiple linear regression analysis, which predicts a value for a single dependent 
variable based on the values of one or more independent variables.
You collect data for a period of time or from multiple sites, so you can perform a regression analysis. You can predict 
future sales (dependent variable) based on the values specified for the key factors (independent variables) if the 
correlation between the key factors and sales is strong enough.

{button ,AL(`H_SETTING_UP_A_REGRESSION_ANALYSIS_EX',1)} See example
{button ,AL(`H_ANALYZE_DATA_OVER;H_PREDICTING_VALUES_STEPS;H_PERFORMING_A_REGRESSION_A

NALYSIS_STEPS',0)} See related topics



Example: Setting up a regression analysis
Regression analysis determines whether one set of data (one or more independent variables) has any relationship to 
another set of data (dependent variable).
For example, suppose you run an ice cream stand at a tourist location, and you want to predict approximately how 
many quarts of ice cream you'll sell the next day. You think that your sales depend on three key factors (the 
independent variables): the number of hours of sunshine, the midday temperature, and the number of buses in a 
nearby parking lot. Since you're assuming that your sales depend on these values, sales is the dependent variable.
You collect data for a six-day period so you can perform a regression analysis. If the correlation between the three 
factors and sales is strong enough, you can predict future sales based on the values for the independent variables.

Setting up the ranges
To set up the data in the sheet correctly, you must:

• Enter the values for the independent variables (the x-range). The x-range can include from 1 to 75 independent 
variables. Put the values for each variable in a separate column. Each column must have the same number of 
rows as the dependent variable, and the columns for the independent variables must all be adjacent.

• Enter the values for the dependent variable (the y-range) in a single column. The y-range containing the values 
for the dependent variable must be in a single column and must contain the same number of rows as the x-range.

• Decide where you want 1-2-3 to put the results (the output range).
In this example, column B contains the y-range (ice cream sales). Columns C, D, and E contain the x-range (hours of 
sunshine, temperature, and number of buses).

{button ,AL(`H_USING_REGRESSION_ANALYSIS_OVER;H_PERFORMING_A_REGRESSION_ANALYSIS_EX;H_
PREDICTING_VALUES_EX;H_PERFORMING_A_REGRESSION_ANALYSIS_STEPS',0)} See related topics



Performing a regression analysis
You can perform a regression analysis to analyze the relationship between several variables.
1. Set up the data in the sheet.
2. Choose Range - Analyze - Regression.
3. In the "X-range" box, enter the range containing the values for the independent variables, or use the range 

selector to specify the range.
4. In the "Y-range" box, specify the range containing the values for the dependent variable.
5. In the "Output range" box, specify the range where you want 1-2-3 to display the results of the regression 

analysis.
You can specify either the entire range or the first cell in the range.
Caution  1-2-3 writes over existing data in the output range, including hidden columns and rows.

6. (Optional) Under Y-intercept, select an option.
7. (Optional) To clear the settings so you can enter different ranges, click Reset.
8. Click OK.
9. (Optional) Use the results to predict values.

{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_DETAILS',1)} See details
{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_EX',1)} See example
{button ,AL(`H_USING_REGRESSION_ANALYSIS_OVER;',0)} See related topics



Details: Performing a regression analysis
Options: Regression dialog box

• X-range of values for the independent variables -- Enter the range that contains the independent variable(s). Each
column in this range must contain the values of one independent variable. This box initially displays the currently 
selected range.

• Y-range of values for the dependent variable -- Enter the range that contains the dependent variable. This range 
must be a single column and must have the same number of rows as the x-range.

• Output range starting at cell -- Enter the range in which you want 1-2-3 to place the results of the regression 
analysis. You can enter the entire range or just the first cell in the range. If you select the entire range, it must be 
at least 9 rows wide and 4 columns deep; you may need to specify more columns, depending on the number of 
independent variables.

• Y-intercept -- Tell 1-2-3 what value to use for the y-intercept. Select "Compute" (the default) if you want 1-2-3 to 
calculate the y-axis intercept when performing the regression. Select "Set to zero" if you want 1-2-3 to use zero 
as the intercept.

Resetting the options to perform a new regression
Click Reset to clear the    X-range, Y-range, and Output range settings, and reset the Y-intercept setting to "Compute" 
when performing the regression.

{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_STEPS',1)} Go to procedure
{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_EX',1)} See example



Example: Performing a regression analysis
When you perform a regression analysis, 1-2-3 analyzes the relationship between the dependent variable and the 
independent variables and enters the results in the output range.

1-2-3 enters statistics in the output range, which tell you about the relationships between the data. 

Note If 1-2-3 displays an R Squared value less than zero, you specified a zero intercept when it was not appropriate. 
Repeat the regression analysis, but select "Compute" under Y-intercept to recalculate the regression and adjust R 
Squared accordingly.
R Squared tells you how closely the independent and dependent variables are correlated, or how much variation in 
the dependent variable can be explained by the combination of the independent variables. The value of R Squared is 
between 0 and 1. The closer the R Squared value is to 1, the more closely the independent variables are related to 
the dependent variable. Since R Squared is close to 1 in this example, a strong correlation exists between ice cream 
sales, the weather, and the number of buses.

{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_STEPS;',0)} See related topics



Predicting values
Once you've proven through regression analysis that a relationship exists between dependent and independent 
variables, you can use the values for the independent variables to predict the values for the dependent variables.
1. Perform a regression analysis.
2. Enter the predicted value for each independent variable in the cell below the column of existing variables.
3. Enter text to identify the forecast.
4. Enter the appropriate formula in a blank cell in the dependent variable column.

Note When you use values from the regression output in formulas, select them when building the formula or copy
them from the output range. Don't type them over or you may get undesired rounding errors. 

The formula result is the predicted value for the dependent variable.

{button ,AL(`H_PREDICTING_VALUES_EX',1)} See example
{button ,AL(`H_PERFORMING_A_REGRESSION_ANALYSIS_STEPS;H_USING_REGRESSION_ANALYSIS_OVER

;',0)} See related topics



Example: Predicting values
Because you've performed a regression analysis, you know there is a relationship between the dependent value (the 
ice cream sales) and the independent variables (the hours of sunshine, the temperature, and the number of buses).    
Now, you can use these independent variables to predict tomorrow's sales.
Suppose the weather forecast says that tomorrow will be cloudy, with only two hours of sunshine and a midday 
temperature of 84 degrees Fahrenheit. You guess that no more than five buses will visit. 

Constructing the formula
The formula you use for the dependent variable refers to the predicted values and the x coefficients in the output 
range of the example.    The formula may look complicated, but it's really only the sum of the following items:

Note When you use values from the regression output in formulas, select them when building the formula or copy 
them from the output range. Don't type them over or you may get undesired rounding errors.

Interpreting the results
The results of the regression predict that you'll sell approximately 187 quarts of ice cream tomorrow (cell B9), if the 
weather and the number of buses are as forecasted.

{button ,AL(`H_COMPUTING_A_FREQUENCY_DISTRIBUTION_EX;H_PERFORMING_A_REGRESSION_ANALYSI
S_EX;H_SETTING_UP_A_REGRESSION_ANALYSIS_EX;H_PREDICTING_VALUES_STEPS',0)} See related 
topics



Overview: Using data matrixes
You can use matrix calculations to solve problems that involve several variables. A 1-2-3 matrix is a multiple-cell 
range that contains a value in each cell. The range can be in one sheet or across sheets (a 3D matrix). Each value 
represents the coefficient for a variable in a formula or a constant in a formula.
Matrix analysis finds the relationship between two or more sets of variables in one or more formulas. You use the 
relationships to determine which combination of values will produce the result you want for the formulas.
You can invert a matrix, multiply matrixes, or do both to analyze simultaneous equations. The matrixes can be in 
active files or on disk.

Inverting a matrix
You can invert a matrix only if it has the same number of rows as columns. When you invert a matrix, the new matrix 
will be the same size as the original. 
Inverting a matrix is more involved than just inverting the numbers in the range. The new matrix is the approximate 
inverse of the original matrix; when you multiply a matrix by its inverse matrix, the result is the identity matrix of the 
same size. The identity matrix must be square, and includes 1 in the top left and bottom right cells; all other cells are 
zero (0).
Note Because the values may be rounded off, zero (0) may not appear in the appropriate cells. Round off these 
values to 15 decimal places to make the zero (0) appear.

Note Some matrixes are mathematically impossible to invert. For some matrixes, especially large matrixes with many
rows and columns, the matrix inversion algorithms would produce less accurate results. 1-2-3 will display a message 
if it cannot invert a matrix.

Multiplying matrixes
To multiply matrixes, the number of columns in the first matrix must equal the number of rows in the second matrix. 
The order in which you multiply the matrixes makes a difference to the results.
The resulting matrix will have the same number of rows as the first matrix and the same number of columns as the 
second matrix. The entry in the nth row and the xth column of the resulting matrix will be calculated from the entries in
the nth row of the first matrix paired with the entries in the xth column of the second matrix.



Note Matrix multiplication algorithms by their nature propagate small errors.    Multiplying an ill-converted matrix (a 
matrix that contains numbers differing greatly in magnitude) or a very large matrix may result in less accurate results.

{button ,AL(`H_USING_DATA_MATRIXES_OVER_EX',1)} See example
{button ,AL(`H_INVERTING_A_MATRIX_STEPS;H_MULTIPLYING_MATRIXES_STEPS;H_ANALYZE_DATA_OVER;

',0)} See related topics



Example: Using data matrixes
Suppose a bank has three main sources of income: business accounts, house loans, and car loans. The bank also 
has a venture capital branch that takes money from the bank's total income to provide loans for start-up businesses.
By setting up this problem as a series of simultaneous equations, you can use matrix analysis to determine what 
percentage each income source contributes to the total venture funds. The following equation represents this 
relationship:

x% * (Business) +    y% * (House) +    z% * (Car) = Total venture funds
x%, y%, and z% are the percentage contributions that each of the income sources makes to the total venture funds. 
These values are what you want to find.
Since you will need to invert the matrix of income sources, the matrix must have the same number of rows as 
columns. Therefore, you will need to use data from three years to solve this problem.
From the equation, you know that the matrix of income sources multiplied by the matrix of percentages equals the 
matrix of venture funds.

[Income sources] * [Percentages] = [Venture funds]
If you multiply the inverse of the income sources matrix by each side of the equation, the result is the matrix of 
percentages that you wanted to find.

where:
M = The income source matrix
P = The percentage matrix
I = The identity matrix
V = The venture funds matrix

Therefore, to solve this problem you need to set up the matrixes of income sources and venture funds, invert the 
matrix of income sources, and multiply the inverted matrix by the matrix of venture funds. 

Set up the matrix of income values
First, set up a matrix of values for total income received from each of the three sources, and a corresponding column 
for the total venture funds received.

Invert the matrix
Next, invert the matrix of income sources in range B4..D6.



Multiply the matrixes
After inverting the matrix, you can find out what percentage each income source contributes to the total venture funds
by multiplying the inverted matrix by the total venture funds received in each of those years. The resulting matrix 
contains the percentage contributions of each income source.

Verifying the results
To verify these results, multiply the percentage matrix by the original income matrix. The venture funds matrix is the 
result. To predict future venture amounts, enter three new values for the income, and then multiply them by the 
percentage matrix.

{button ,AL(`H_INVERTING_A_MATRIX_STEPS;H_MULTIPLYING_MATRIXES_STEPS;H_USING_DATA_MATRIXE
S_OVER;',0)} See related topics



Multiplying matrixes
You can multiply the columns of one matrix by the rows of a second matrix.
1. Select the range containing the first matrix you want to multiply. 
2. Choose Range - Analyze - Multiply Matrix.
3. Enter the range containing the second matrix you want to multiply in the "Second matrix" box, or use the range 

selector to specify the range.
The number of columns in the first matrix must equal the number of rows in the second matrix. Each matrix can 
contain up to 80 columns and 80 rows.

4. Specify the range for the results in the "Resulting matrix" box.
Caution  1-2-3 writes over existing data in the range including data in hidden columns, rows, or sheets.

5. Click OK.
1-2-3 creates a matrix that contains the same number of rows as the first matrix and the same number of columns as 
the second matrix. 

{button ,AL(`H_MULTIPLYING_MATRIXES_DETAILS',1)} See details
{button ,AL(`H_USING_DATA_MATRIXES_OVER_EX',1)} See example
{button ,AL(`H_INVERTING_A_MATRIX_STEPS;H_USING_DATA_MATRIXES_OVER;',0)} See related topics



Details: Multiplying matrixes
You can multiply matrixes in any workbook file, whether it is active or on disk. When you specify the range where you 
want to put the results matrix, you can specify either the entire range or the first cell in the range.
Note Matrix multiplication algorithms by their nature propagate small errors.    Multiplying an ill-converted matrix (a 
matrix that contains numbers differing greatly in magnitude) or a very large matrix may result in less accurate results.

Multiplying 3D matrixes
A 3D matrix includes the same cells in two or more contiguous sheets. When you multiply 3D matrixes, both matrixes 
must be 3D, and both must contain the same number of sheets. The matrixes can be in different sheets, or in 
different workbooks. The 3D results matrix can also be in different sheets or workbooks from the the matrixes you're 
multiplying.
1-2-3 multiplies the first and second matrixes in each sheet and enters the results in the resulting matrix range in that 
sheet. For example, 1-2-3 multiplies the range in the first sheet of the first matrix by the range in the first sheet of the 
second matrix and enters the results in the first sheet, multiplies the range in the second sheet of the first matrix by 
the range in the second sheet of the second matrix and enters the results in the second sheet, and so on.

{button ,AL(`H_MULTIPLYING_MATRIXES_STEPS',1)} Go to procedure
{button ,AL(`H_USING_DATA_MATRIXES_OVER_EX',1)} See example



Inverting a matrix
You can use matrix inversion to solve problems involving probabilities or multiple variables.
1. Select the range containing the matrix you want to invert.

The range must have the same number of columns as rows, up to 80 columns and 80 rows.
2. Choose Range - Analyze - Invert Matrix.
3. Enter the range for the inverted matrix in the "To" box, or use the range selector to specify the range.

Caution  1-2-3 writes over existing data in the range including data in hidden columns, rows, or sheets.
4. Click OK.

{button ,AL(`H_INVERTING_A_MATRIX_DETAILS',1)} See details
{button ,AL(`H_USING_DATA_MATRIXES_OVER_EX',1)} See example
{button ,AL(`H_MULTIPLYING_MATRIXES_STEPS;H_USING_DATA_MATRIXES_OVER;',0)} See related topics



Details: Inverting a matrix
You can invert matrixes in any workbook file, whether it is active or on disk. When you specify the range where you 
want to put the inverted matrix, you can specify either the entire range or just the first cell in the range.
Note Matrix inversion algorithms by their nature propagate small errors. Inverting an ill-converted matrix (a matrix 
that contains numbers differing greatly in magnitude) may result in large errors.

Inverting 3D matrixes
A 3D matrix includes the same cells in two or more contiguous sheets. When you invert a 3D matrix, the matrix you 
want to invert and the results range must be square on each sheet, and contain the same number of sheets.
1-2-3 inverts the matrix in each sheet of the 3D range and enters the results in each sheet. The matrixes must be in 
the same workbook but can be in different sheets. Also, the 3D results matrix must be in the same workbook as the 
matrixes you're inverting, but can be in different sheets.
For example, 1-2-3 inverts the matrix in the first sheet of the range and enters the results in the first sheet, inverts the 
matrix in the second sheet and enters the results in the second sheet, and so on.

{button ,AL(`H_INVERTING_A_MATRIX_STEPS',1)} Go to procedure
{button ,AL(`H_USING_DATA_MATRIXES_OVER_EX',1)} See example



Overview: Alignment
The InfoBox makes it easy to change the alignment for both values and labels in cells or text blocks. 

Horizontal and vertical alignment
By default, 1-2-3 aligns values in cells horizontally to the right and labels in cells horizontally to the left, and aligns 
both values and labels in cells vertically to the bottom. The illustrations below show examples of horizontal and 
vertical alignment. 

Wrapping text in a cell
Wrapping text in cells is useful when text is too long to fit in one cell.

Aligning text across columns
You can center, right align, or evenly space text (or numbers entered as labels) across several columns. If column 
widths change, 1-2-3 automatically adjusts the alignment. 

For example, you can center Yearly Totals (cell A1)...

across columns A through D.

Rotating data
You can rotate data in a cell or text block. For example, the numbers below are rotated 45 degrees.



{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNM
ENT_OVER;H_CHANGING_ALIGNMENT_STEPS;H_ROTATING_DATA_STEPS;H_SPANNING_TEXT_ACROSS
_COLUMNS_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;',0)} See related topics



Aligning data in cells
You can align labels and values in cells. 
1. Select the range or collection.
2. Choose Range - Range Properties.

3. Click the Alignment tab in the InfoBox.

4. Select a horizontal alignment.
5. Select a vertical alignment.
6. (Optional) Move, collapse, or close the InfoBox.
Note Data appears vertically aligned in a cell only when the row is taller than the cell contents.

{button ,AL(`H_ALIGNING_DATA_IN_CELLS_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNM

ENT_OVER;H_CHANGING_ALIGNMENT_STEPS;H_ROTATING_DATA_STEPS;H_SPANNING_TEXT_ACROSS
_COLUMNS_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;H_STYLE_KEYS_OVER',0)} See related topics



Details: Aligning data in cells
Other ways to align data in cells
You can click the Alignment button in the status bar and select an alignment from a list of options. 

You can also align data in cells using a label-prefix character. For more information see Overview: Entering data.

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Left-aligns labels; right-aligns values

Left-aligns data

Right-aligns data

Centers data

Evenly spaces text in a cell or text block

Centers text across columns

{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS',1)} Go to procedure



Aligning data in text blocks
1. Click the text block.
2. Choose Drawing - Drawing Properties.

3. Click the Alignment tab in the InfoBox.

4. Select a horizontal alignment.
5. Select a vertical alignment.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ALIGNING_DATA_IN_TEXT_BLOCKS_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNM

ENT_OVER;H_EDITING_DATA_IN_TEXT_BLOCKS_STEPS;',0)} See related topics



Details: Aligning data in text blocks
Other ways to align data in text blocks
You can click the Alignment button in the status bar and select an alignment from the list of options. 

Troubleshooting
If the object or the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make 
style changes to a locked object or workbook. To unlock the object, use Drawing - Drawing Properties (Basics tab). To
unlock the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: Protecting 
data.

Related SmartIcons

Left-aligns labels; right-aligns values

Left-aligns data

Right-aligns data

Centers data

Evenly spaces text in a cell or text block

{button ,AL(`H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS',1)} Go to procedure



Spanning text across columns
You can align text across columns in a range. 
1. Select the range that you want to align the text across.

The text you want to align must be in the leftmost cell of the range. For example, to align the text in cell A1 across 
A1..D1, select A1..D1.

2. Choose Range - Range Properties.

3. Click the Alignment tab in the InfoBox.

4. Select a horizontal alignment.
5. Select "Align across columns."

6. (Optional) Move, collapse, or close the InfoBox.
When you align text across columns, make sure the cells to the right of the label you want to align are blank.

{button ,AL(`H_SPANNING_TEXT_ACROSS_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNMENT_OVER;H_ROTATING_DATA_STEPS;H_WRA

PPING_DATA_IN_A_CELL_STEPS;',0)} See related topics



Details: Spanning text across columns
You can't align numbers across columns unless you enter the number as a label using a label-prefix character.

Troubleshooting
If nothing happens when you select "Align across columns," check that all cells in the range in which you're aligning 
are blank. Also check the horizontal alignment you selected. Aligning across columns has no effect on general 
alignment or left alignment since text by default is left-aligned.
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Left-aligns labels; right-aligns values

Left-aligns data

Right-aligns data

Centers data

Evenly spaces text in a cell or text block

Centers text across columns

{button ,AL(`H_SPANNING_TEXT_ACROSS_COLUMNS_STEPS',1)} Go to procedure



Rotating data
When you rotate data in a cell, the row expands to fit the rotated data if the row height is set to "Fit largest font" on 
the Basics tab in the InfoBox.
1. Select the range or text block containing the data you want to rotate.
2. Right-click the selection and choose the Properties command.
3. Click the Alignment tab in the InfoBox.

4. Select an orientation.
To rotate text to a specified angle, select the last orientation choice and then click the arrows or enter a number in
the "Angle" box.

5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_ROTATING_DATA_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNM

ENT_OVER;H_SPANNING_TEXT_ACROSS_COLUMNS_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;',0
)} See related topics



Details: Rotating data
Printing rotated data
To print rotated data, both the printer and the printer driver must support rotation of installed fonts. 

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Rotates data in a cell 45 degrees

{button ,AL(`H_ROTATING_DATA_STEPS',1)} Go to procedure



Wrapping data in a cell
Wrapping text in cells is useful when text is too long to fit in one cell.

1. Select the range or collection. 
2. Choose Range - Range Properties.

3. Click the Alignment tab in the InfoBox.

4. Select "Wrap text in cell."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_WRAPPING_DATA_IN_A_CELL_DETAILS',1)} See details
{button ,AL(`H_ALIGNING_DATA_IN_CELLS_STEPS;H_ALIGNING_DATA_IN_TEXT_BLOCKS_STEPS;H_ALIGNM

ENT_OVER;H_CHANGING_ALIGNMENT_STEPS;H_ROTATING_DATA_STEPS;H_SPANNING_TEXT_ACROSS
_COLUMNS_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;',0)} See related topics



Details: Wrapping data in a cell
You can't wrap numbers in a cell.

Troubleshooting
1-2-3 adjusts row height to fit the wrapped text if the row height is set to "Fit largest font" on the Basics tab in the 
InfoBox.
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Left-aligns labels; right-aligns values

Left-aligns data

Right-aligns data

Centers data

Evenly spaces text in a cell or text block

Centers text across columns

{button ,AL(`H_WRAPPING_DATA_IN_A_CELL_STEPS',1)} Go to procedure



Horizontal alignment
Changes the horizontal position of text and values. Click one of these buttons in the InfoBox:

Left-aligns text; right-aligns values

Left-aligns text and values

Centers text and values

Right-aligns text and values

Evenly spaces text in a cell or text block
Note These buttons also appear in the status bar.



Vertical alignment
Changes the vertical position of text and values. Click one of these buttons in the InfoBox:

Aligns text and values to the top

Aligns text and values to the center

Aligns text and values to the bottom



Overview: Changing borders, lines, and colors
Simple enhancements to sheet data can improve its effectiveness. You can add borders, lines, color, and designer 
frames to your sheet to emphasize important data. 

Use the InfoBox or the status bar to style ranges and graphic objects.

Borders around ranges and graphic objects
You can add borders around cells and ranges. Borders are different than the grid lines that separate cells in the 
sheet. Graphic objects such as closed shapes, pictures, charts, maps, and text blocks also have borders. You can 
change the style and color of borders.

Designer frames
A designer frame is a special kind of border that you can add to cells, ranges, and any rectangular object except a 
button. The designer frame palette includes frames with drop shadows and beveled edges, which you can enhance 
with color.

Enhancing lines
Change the style, width, and color of lines, arcs, arrows, and freehand drawings to make them stand out. You can 
add arrowheads to the beginning, end, or both ends of a line. 

Colors and patterns
You can change the color of lines and borders, and change the background color of ranges, charts, maps, text 
blocks, and closed shapes (such as circles and rectangles). Then you can add a pattern and a pattern color to the 
background. You can also fill the interior of an arc, polyline, or freehand drawing with a color and a pattern.

Named styles and the style gallery
Using named styles, you can quickly apply the same styles to all the cells in a range or collection. You can redefine 
the named style to apply changes to all the cells using that named style.

You can also format ranges or collections with the style templates available in 1-2-3.

{button ,AL(`H_CHANGING_INTERIOR_COLOR_AND_PATTERN_STEPS;H_CHANGING_LINE_STYLES_STEPS;
H_CHANGING_GRAPHICS_BORDERS_STEPS;H_CHANGING_RANGE_BORDERS_STEPS;H_USING_DESIG
NER_FRAMES_STEPS;H_NAMED_STYLES_OVER;H_USING_THE_STYLE_GALLERY_STEPS;',0)} See 
related topics



Changing interior colors and patterns
You can add or change interior colors and patterns in cells, ranges, sheets, and many graphic objects. You can't 
change the interior color or pattern of a bitmap picture or an embedded object.
1. Select what you want to change.
2. Right-click the selection and choose the Properties command.
3. Click the Lines & Colors tab in the InfoBox.

4. Under Interior, select a background color, a pattern, and a pattern color.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_INTERIOR_COLOR_AND_PATTERN_DETAILS',1)} See details
{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_STEPS;H_CHANGING_BORDERS_LINES_AND_COLO

RS_OVER;H_CHANGING_LINE_STYLES_STEPS;H_CHANGING_GRAPHICS_BORDERS_STEPS;H_CHANGI
NG_RANGE_BORDERS_STEPS;H_USING_DESIGNER_FRAMES_STEPS;H_NAMED_STYLES_OVER;H_USI
NG_THE_STYLE_GALLERY_STEPS;',0)} See related topics



Details: Changing interior colors and patterns
Selecting pattern and color options

• Background color -- The color inside the range or graphic object behind any pattern. 
• Pattern -- The fill pattern inside the range or graphic object. Choose from 64 fill patterns, including transparent. 

Note In chart parts, the background color has no effect until you select a pattern other than transparent or solid.
• Pattern color -- The color of the pattern in the range or graphic object. If the pattern is set to transparent or to the 

solid background color, you see no change if you select pattern colors.
• Text color -- The color of the text in the selected range. You can also change text color using the Text Format tab 

in the InfoBox.

Other ways to change interior colors
You can use the status bar to change background color, pattern, or pattern color. The options available in the status 
bar change depending on what's selected. For example, you can use the status bar to change the background color, 
pattern, and pattern color of a rectangle, but you can change only the background color of a range.

Displaying negative values in red
When a range is selected, select "Negative values in red" to display negative numbers in red, for example, to show a 
debit. You can set this option for the entire sheet by using Sheet - Sheet Properties (Lines & Colors tab).

Troubleshooting
If the object or the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make 
style changes to a locked object or workbook. To unlock the object, use the Basics tab in the InfoBox for the object. 
To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: 
Protecting data.

Related SmartIcons

Opens the InfoBox and displays the Lines & Colors tab for ranges

Opens the InfoBox for drawings

Opens the InfoBox for charts

Opens the InfoBox for maps

{button ,AL(`H_CHANGING_INTERIOR_COLOR_AND_PATTERN_STEPS',1)} Go to procedure



Changing graphic object borders
You can change the border for a chart, map, picture, text block, or any closed shape.
1.  Select the graphic object with the border you want to change.
2. Right-click the selection and choose the Properties command.
3. Click the Lines & Colors tab in the InfoBox.

4. Under Border, select a line color, line style, and line width.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_GRAPHICS_BORDERS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_CHANGING_LINE_STYLES_STEPS;H_

CHANGING_RANGE_BORDERS_STEPS;H_USING_DESIGNER_FRAMES_STEPS;',0)} See related topics



Details: Changing graphic object borders
Other ways to change graphic object borders
You can also use the status bar to change the color, style, and width of graphic object borders.

Troubleshooting
If the object or the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make 
style changes to a locked object or workbook. To unlock the object, use the Basics tab in the InfoBox for the object. 
To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: 
Protecting data.

Related SmartIcons

Opens the InfoBox and displays the Lines & Colors tab for ranges

Opens the InfoBox for drawings

Opens the InfoBox for charts

Opens the InfoBox for maps

{button ,AL(`H_CHANGING_GRAPHICS_BORDERS_STEPS',1)} Go to procedure



Changing range borders
Change the border of a range to emphasize important data.
1. Select the range or collection.
2. Choose Range - Range Properties.

3. Click the Lines & Colors tab in the InfoBox.

4. Under Border, click the button that shows the border style you want.
5. Select a line style and color for the border.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_RANGE_BORDERS_DETAILS',1)} See details
{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_STEPS;H_CHANGING_BORDERS_LINES_AND_COLO

RS_OVER;H_CHANGING_LINE_STYLES_STEPS;H_CHANGING_GRAPHICS_BORDERS_STEPS;H_CHANGI
NG_RANGE_BORDERS_STEPS;H_USING_DESIGNER_FRAMES_STEPS;',0)} See related topics



Details: Changing range borders
Troubleshooting

• If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style 
changes in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more 
information, see Overview: Protecting data.

• If no border appears, make sure the line style is not set to "none."

Related SmartIcons

Opens the InfoBox and displays the Lines & Colors tab for ranges

Adds a border around the selected cell or range

Adds a border and drop shadow to the selected cell or range

{button ,AL(`H_CHANGING_RANGE_BORDERS_STEPS',1)} Go to procedure



Changing line styles
You can change line styles for any graphic object made from lines, such as an arrow, arc, or polyline.
1. Select the object.
2. Choose Drawing - Drawing Properties.

3. Click the Lines & Colors tab in the InfoBox.

4. Select a line color, style, and width.
5. (Optional) Select an arrowhead.
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_LINE_STYLES_DETAILS',1)} See details
{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_STEPS;H_CHANGING_BORDERS_LINES_AND_COLO

RS_OVER;H_CHANGING_GRAPHICS_BORDERS_STEPS;H_CHANGING_RANGE_BORDERS_STEPS;H_USI
NG_DESIGNER_FRAMES_STEPS;',0)} See related topics



Details: Changing line styles
Other ways to change line styles
You can also use the status bar to change line style, width, color, and arrowheads.

Lines and arrowheads
You can add an arrowhead at the beginning of a line, the end of a line, or at both ends.

Troubleshooting
If the object or the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make 
style changes to a locked object or workbook. To unlock the object, use Drawing - Drawing Properties (Basics tab). To
unlock the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: Protecting 
data.

{button ,AL(`H_CHANGING_LINE_STYLES_STEPS',1)} Go to procedure



Adding designer frames
You can add a designer frame to a cell, a range, and any rectangular object except a button.
1. Select what you want to frame.
2. Right-click the selection and choose the Properties command.
3. Click the Lines & Colors tab in the InfoBox.

4. Select "Designer frame," then select a frame style and a frame color.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_USING_DESIGNER_FRAMES_DETAILS',1)} See details
{button ,AL(`H_CHANGING_BORDERS_LINES_AND_COLORS_OVER;H_CHANGING_LINE_STYLES_STEPS;H_

CHANGING_GRAPHICS_BORDERS_STEPS;H_CHANGING_RANGE_BORDERS_STEPS;',0)} See related 
topics



Details: Adding designer frames
Troubleshooting
If the object or the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make 
style changes to a locked object or workbook. To unlock the object, use the Basics tab in the InfoBox for the object. 
To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: 
Protecting data.

Related SmartIcons

Adds a border around the selected cell or range

Adds a border and drop shadow to the selected cell or range

Opens the InfoBox and displays the Lines & Colors tab for ranges

Opens the InfoBox for drawings

Opens the InfoBox for charts

Opens the InfoBox for maps

{button ,AL(`H_USING_DESIGNER_FRAMES_STEPS',1)} Go to procedure



Using fast format to style a range
Fast format automatically copies the styles of the current range into other ranges you select.
1. Select the range containing the styles you want to copy.
2. Choose Range - Fast Format.

The mouse pointer changes to a paintbrush.

3. Select the ranges you want to format.
4. To turn off fast formatting, choose Range - Fast Format again, click the fast format icon, or press ESC.

{button ,AL(`H_USING_FAST_FORMAT_TO_STYLE_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_USING_THE_STYLE_GALLERY_STEPS;H_NAMED_STYLES_OVER;H_DELETING_A_NAMED_S

TYLE_STEPS;',0)} See related topics



Details: Using fast format to style a range
Other ways to turn off fast formatting
Fast formatting turns off when you press a key, click a status bar button or an InfoBox option, or click one of the 
SmartIcons.

Other ways to style a range
You can use the buttons in the status bar to change the styles of text or numbers. 

Using named styles
Click the Named Style button in the status bar and choose from a list of your personal styles to quickly format a range
of data. 

Troubleshooting
If the worksheet is locked, fast format is not available. You can't make style changes in a locked workbook. To unlock 
the workbook, use File - Workbook Properties (Security tab). For more information, see Overview: Protecting data.

Related SmartIcons

Applies a named style

Opens the gallery of style templates

Clears styles from the current selection 

{button ,AL(`H_USING_FAST_FORMAT_TO_STYLE_A_RANGE_STEPS',1)} Go to procedure



Overview: Named styles
A named style is a collection of styles that you can copy from a single cell and apply to other ranges. A named style 
can include number format, font, point size, bold, italics, underlining, borders, colors, pattern, and alignment.
Create named styles when you want to reuse styles that you frequently apply to data. The named styles that you 
create appear on the status bar.

Using named styles, you can quickly apply the same styles to all the cells in a range or collection. You can redefine 
the named style to apply changes to all the cells using that named style.

Style gallery
You can also choose from a selection of style templates available in the style gallery. For more information, see Using
style templates.

{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS;H_CREATING_A_NAMED_STYLE_STEPS;H_DELETING_
A_NAMED_STYLE_STEPS;H_REDEFINING_A_NAMED_STYLE_STEPS;H_REMOVING_A_NAMED_STYLE_S
TEPS;H_RENAMING_A_NAMED_STYLE_STEPS;H_RESETTING_A_NAMED_STYLE_STEPS;',0)} See related 
topics



Applying a named style
1. Select the range or collection you want to style.
2. Choose Range - Range Properties.

3. Click the Named Style tab in the InfoBox.

4. Select a named style from the "Style name" list.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_APPLYING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NAMED_STYLE_STEPS;H_NAMED_STYLES_OVER;H_REDEFINING_A_NAMED_

STYLE_STEPS;H_REMOVING_A_NAMED_STYLE_STEPS;H_RESETTING_A_NAMED_STYLE_STEPS;H_USI
NG_FAST_FORMAT_TO_STYLE_A_RANGE_STEPS;',0)} See related topics



Details: Applying a named style
Other ways to apply a named style
Click the Named Style button on the status bar to see a list of current named styles in the sheet. Click the named 
style to apply it to the current selection. If no named styles have been defined, "No style" appears by itself in the list.

The Named Style button displays the name of the style applied to the current selection. "No style" means the current 
selection isn't formatted with a named style.
Note The Named Style button does not appear on the status bar if the display area on your desktop is    640X480 
resolution.

Copying named styles
You can copy a named style from one workbook to another by selecting an example cell and choosing Edit - Copy 
and Edit - Paste.

Overriding a named style
Once a named style has been applied to a cell, you can still change the individual properties of the cell without 
breaking the link to that named style. If you redefine the named style, 1-2-3 changes only the properties you didn't 
override. You can click Reset to Style to change the cell's styles back to the original named style. 

Troubleshooting
The named style is not automatically applied to the example cell that defines it, so remember to include the example 
cell in the range you want to style.
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Applies a named style

Resets the selection to the current named style

Redefines a named style based on the selected cell

Creates a named style based on the selected cell

Copies a range's styles to another range

Opens the gallery of style templates

{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS',1)} Go to procedure
{button ,AL(`H_REDEFINING_A_NAMED_STYLE_STEPS',0)} See related topics



Creating a named style
You create a named style based on an example cell. 1-2-3 saves named styles with the workbook. Named style 
names can be up to 64 characters long and must be unique in the workbook.
1. Click the cell that has the styles you want to define as a named style.
2. Choose Range - Range Properties.

3. Select the Named Style tab in the InfoBox.

4. Click Create Style.
5. Enter a name for the new named style in the "Style name" box.
6. Click OK.
7. (Optional) Move, collapse, or close the InfoBox.
Note The named style is not automatically applied to the example cell that defines it. Remember to apply the style to 
the example cell.

{button ,AL(`H_CREATING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS;H_DELETING_A_NAMED_STYLE_STEPS;H_NAMED_STY

LES_OVER;H_REDEFINING_A_NAMED_STYLE_STEPS;H_RENAMING_A_NAMED_STYLE_STEPS;',0)} See 
related topics



Details: Creating a named style
Creating a named style with a range selected
A named style is based on a single cell. If you select a range, then 1-2-3 uses the styles of the top left cell of the 
range to create the named style.
To copy the styles of a range, use Range - Fast Format. To see a gallery of style templates for ranges, choose Range
- Range Properties and click Style Gallery on the Named Style tab in the InfoBox.

Named styles and sheet defaults 
A named style can contain a sheet default. If you change the sheet default, the named style changes to use the new 
sheet default. For example, you create a named style based on a cell using the sheet default background color. If you
later change the sheet default background color to yellow, the named style changes to use the default background 
color (yellow). All cells using that named style then change to a yellow background color. 
If you don't want your named style to use the sheet defaults, use Range - Range Properties to style the cell with a 
local setting before you create the named style. For information on sheet defaults, see Overview: Sheet defaults.

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Creates a named style based on the selected cell

Applies a named style

Redefines a named style based on the selected cell

Resets the selection to the current named style

Copies a range's styles to another range

Opens the gallery of style templates

{button ,AL(`H_CREATING_A_NAMED_STYLE_STEPS',1)} Go to procedure
{button ,AL(`H_USING_FAST_FORMAT_TO_STYLE_A_RANGE_STEPS;',0)} See related topics



Renaming a named style
You can change style names at any time to more accurately describe what the named style is being used for. Names 
for named styles must be unique in the workbook.
1. Choose Range - Range Properties.

2. Click the Named Style tab in the InfoBox.

3. Click Manage Styles.
4. Select the named style you want to rename from the "Style name" list.
5. Click Rename.
6. Enter the new name in the "To" box and click OK.
7. Click Done.
8. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_RENAMING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NAMED_STYLE_STEPS;H_DELETING_A_NAMED_STYLE_STEPS;H_NAMED_ST

YLES_OVER;H_REDEFINING_A_NAMED_STYLE_STEPS;H_RESETTING_A_NAMED_STYLE_STEPS;H_APP
LYING_A_NAMED_STYLE_STEPS;',0)} See related topics



Details: Renaming a named style
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Displays the Manage Styles dialog box

Resets the selection to the current named style

Redefines a named style based on the selected cell

Creates a named style based on the selected cell

{button ,AL(`H_RENAMING_A_NAMED_STYLE_STEPS',1)} Go to procedure



Redefining a named style
You redefine a named style using an example cell. When you redefine a named style, all the cells using the named 
style change to the new styles.
1. Click the cell that has the styles you want to use to redefine the named style.
2. Choose Range - Range Properties.

3. Click the Named Style tab in the InfoBox.

4. Click Redefine Style.
5. Select the named style you want to redefine.
6. Click OK.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_REDEFINING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NAMED_STYLE_STEPS;H_NAMED_STYLES_OVER;H_REMOVING_A_NAMED_S

TYLE_STEPS;H_RENAMING_A_NAMED_STYLE_STEPS;H_RESETTING_A_NAMED_STYLE_STEPS;H_APPL
YING_A_NAMED_STYLE_STEPS;',0)} See related topics



Details: Redefining a named style
Overriding a named style
Once a named style has been applied to a cell, you can still change the individual properties of the cell without 
breaking the link to that named style. If you redefine the named style, 1-2-3 changes only the properties you didn't 
override. You can click Reset to Style to change the cell's styles back to the original named style. 

Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Redefines a named style based on the selected cell

Resets the selection to the current named style

Creates a named style based on the selected cell

Applies a named style

{button ,AL(`H_REDEFINING_A_NAMED_STYLE_STEPS',1)} Go to procedure



Resetting a cell's styles to a named style
If you applied a named style to a cell and then changed the cell's styles, you can reset the cell back to the named 
style.
1. Select the range or collection that has the styles you want to reset.
2. Choose Range - Range Properties.

3. Click the Named Style tab in the InfoBox.

4. Click Reset to Style.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_RESETTING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS;H_CREATING_A_NAMED_STYLE_STEPS;H_NAMED_STY

LES_OVER;H_REDEFINING_A_NAMED_STYLE_STEPS;H_REMOVING_A_NAMED_STYLE_STEPS;',0)} See 
related topics



Details: Resetting a cell's styles to a named style
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Resets the selection to the current named style

Clears all styles, including number formats, from the current selection 

Creates a named style based on the selected cell

Applies a named style

Redefines a named style based on the selected cell

{button ,AL(`H_RESETTING_A_NAMED_STYLE_STEPS',1)} Go to procedure



Removing a named style from cells
Removing a named style from a cell removes the styles associated with the named style, but leaves any changes you
made after applying the named style.
1. Select the range or collection from which you want to remove the named style.
2. Choose Range - Range Properties.

3. Click the Named Style tab in the InfoBox.

4. Select "No style" from the "Style name" list.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_REMOVING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS;H_DELETING_A_NAMED_STYLE_STEPS;H_NAMED_STY

LES_OVER;H_REDEFINING_A_NAMED_STYLE_STEPS;H_RESETTING_A_NAMED_STYLE_STEPS;',0)} See 
related topics



Details: Removing a named style from cells
Other ways to remove named styles

• Click the Named Style button in the status bar and select "No style."
• Choose Edit - Clear Styles, which will remove all styles, not just the styles associated with the named style.

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Clears all styles, including number formats, from the current selection 

Redefines a named style based on the selected cell

Resets the selection to the current named style

{button ,AL(`H_REMOVING_A_NAMED_STYLE_STEPS',1)} Go to procedure



Deleting a named style
When you delete a named style, the cells formatted with that named style retain the styles, but are no longer linked to
the named style.
1. Choose Range - Range Properties.

2. Click the Named Style tab in the InfoBox.

3. Click Manage Styles.
4. From the "Style name" list, select the style you want to delete.
5. Click Delete. 
6. Click Done.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DELETING_A_NAMED_STYLE_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_NAMED_STYLE_STEPS;H_NAMED_STYLES_OVER;H_REDEFINING_A_NAMED_

STYLE_STEPS;H_RENAMING_A_NAMED_STYLE_STEPS;',0)} See related topics



Details: Deleting a named style
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Displays the Manage Styles dialog box

Clears all styles, including number formats, from the current selection 

Redefines a named style based on the selected cell

{button ,AL(`H_DELETING_A_NAMED_STYLE_STEPS',1)} Go to procedure



Using style templates
You can quickly format ranges or collections with the style templates available in 1-2-3.
1. Select the range you want to format.
2. Choose Range - Range Properties.

3. Click the Named Style tab in the InfoBox.

4. Click Style Gallery.
5. Select the template you want to use from the "Style templates" list.
6. Click OK.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_USING_THE_STYLE_GALLERY_DETAILS',1)} See details
{button ,AL(`H_APPLYING_A_NAMED_STYLE_STEPS;H_CREATING_A_NAMED_STYLE_STEPS;H_NAMED_STY

LES_OVER;H_USING_FAST_FORMAT_TO_STYLE_A_RANGE_STEPS;',0)} See related topics



Details: Using style templates
Troubleshooting
If the workbook is locked, the style options in the InfoBox are dimmed. You can't make style changes in a locked 
workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, see 
Overview: Protecting data.

Related SmartIcons

Opens the gallery of style templates

Copies a range's styles to another range

Pastes a cell's styles 

Creates a named style based on the selected cell

Applies a named style

{button ,AL(`H_USING_THE_STYLE_GALLERY_STEPS',1)} Go to procedure



Manage Styles dialog box for named styles
Use this dialog box to rename or delete named styles.

Choose a task
Renaming a named style
Deleting a named style

{button ,AL(`H_NAMED_STYLES_OVER;',0)} See related topics



Overview: Number formats
You can change the appearance of numbers by changing number formats. Number formats differentiate one kind of 
data from another; for example, currency from percentages. Number formats affect only how 1-2-3 displays numbers,
not how 1-2-3 stores or calculates with numbers.
You can change the number format for an entire sheet (the sheet default) or for a selected range or collection. The 
initial default number format for sheets is General. Use Sheet - Sheet Properties (Number Format tab) to change the 
default number format. Use Range - Range Properties (Number Format tab) to format numbers in a range or 
collection.

Categories of number formats
Number formats are grouped into the categories described below.

Frequently Used 
Initially, the Frequently Used category contains several common formats. You can add or delete formats from the list.
Number formats in this category appear on the Frequently Used list in the status bar, and are automatically 
recognized by 1-2-3 when you enter them.

Number
The Number category contains these formats:

• General format -- Displays up to 15 decimal places, a minus sign for negatives, no thousands separators, and no 
trailing zeros to the right of the decimal point. General format is the initial default number format.
Note If you enter a large decimal number in General format, 1-2-3 either rounds the number to fit the column 
width, displays scientific notation, or displays *** (asterisks) until you widen the column.

• Fixed format -- Displays up to 15 decimal places, a minus sign for negatives, and a leading zero for decimal 
values.

• Comma format -- Displays thousands separators and up to 15 decimal places, and parentheses for negative 
numbers. Comma format is the same as currency format without the currency symbol. You can change the 
negative number indicator from minus sign to parentheses using the regional or country settings for negative 
numbers in the operating system's control panel.

• Scientific format -- Displays scientific (exponential) notation, with up to 15 decimal places and an exponent of up 
to 3 digits.

• Percent format -- Displays numbers as percentages (the number multiplied by 100) with a percent sign and up to 
15 decimal places.

The table below shows the same number formatted in different ways.

Format name  1234.567 appears 
as

General  1234.567
Fixed  1234.57
Comma  1,234.57
Scientific  1.23E+003
Percent  123456.70%

Currency
Displays numbers with a currency symbol, thousands separators, and up to 15 decimal places. You can format 
different cells in the same workbook as different types of currency. For example, you can format one cell as US dollar 
and another cell as French franc. You can change the negative number indicator from minus sign to parentheses 
using the regional or country settings for negative numbers in the operating system's control panel.

ISO Currency
Displays numbers with the International Standards Organization (ISO) code, thousands separators, and up to 15 
decimal places. For example, the ISO code for $ (US dollar sign) is USD. See Details: Changing the currency symbol 
for the table of ISO currency formats.

Date
Displays a date number as a date. If a number falls outside the range of date numbers, 1-2-3 displays *** (asterisks) 
in the cell. See Details: Entering dates for the table of date formats.



Time
Displays a time number as a time. If a number falls outside the range of time numbers, 1-2-3 displays 12:00 AM or 
00:00 in the cell. See Details: Entering times for the table of time formats.
Note 1-2-3 will display any whole integer as 12:00 AM in Time format since Time format is derived from a fraction or 
decimal.

Text
• Label format -- Displays existing numbers with no thousands separators, and a minus sign for negative numbers. 

New entries in Label format display as text, compute to the value 0 (zero), and automatically use a label-prefix 
character that corresponds to the alignment set with Sheet - Sheet Properties. 
Note 1-2-3 lets you compute with numbers that you have changed to label format before you edit them. After you 
edit a number in Label format, 1-2-3 enters a label-prefix character in the cell and the cell computes to the value 0
(zero).

• Formula format -- Displays formulas written out, rather than as their computed values. This is useful for debugging
or printing formulas. 

{button ,AL(`H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS;H_SETTING_123_PREFERENCES_STEPS;H
_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS;H_FORMATTING_NUMBERS_STEPS;H_CHANGING_T
HE_CURRENCY_SYMBOL_STEPS;',0)} See related topics



Formatting numbers
Changing the number format affects only how 1-2-3 displays numbers, not how 1-2-3 stores or calculates with 
numbers.
1. Select the numbers you want to format.
2. Choose Range - Range Properties.

3. Click the Number Format tab in the InfoBox.

4. Select a format category.
5. Select a format from the "Current format" list.

Tip To add the number format to the status bar, select "Show in Frequently Used list."
6. (Optional) To reset the current selection to the sheet default, click Reset to Sheet Format.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FORMATTING_NUMBERS_DETAILS',1)} See details
{button ,AL(`H_NUMBER_FORMATS_OVER;H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS;H_SETTING_

123_PREFERENCES_STEPS;H_SETTING_A_DEFAULT_NUMBER_FORMAT_STEPS;H_LC_CHANGING_NU
MERIC_FORMATS_STEPS;',0)} See related topics



Details: Formatting numbers
Other ways to format numbers
You can use the status bar to format numbers in cells. Click the Number format button to display the Frequently Used
list of number formats. Only the formats included in the Frequently Used category on the Number format tab in the 
InfoBox are available from the status bar.

Automatic formatting
1-2-3 automatically formats a number if you enter it using a time format, a percent sign, or one of the formats in the 
Frequently Used category. For example, 

• If you enter 12:31:57, 1-2-3 automatically assigns a time format (23:59:59) to that cell.
• If you enter 12/31/57, 1-2-3 automatically assigns a date format (12/31/96) to that cell. 
• If you enter a number that is not a recognized date, time, or other format, 1-2-3 enters the number using the 

default format (initially, General format). 

Displaying parentheses
Selecting "Parentheses" on the Number Format tab encloses both positive and negative numbers in parentheses, 
except numbers formatted as dates, times, or text. You can also set this option for the entire sheet by using Sheet - 
Sheet Properties.

Negative number defaults for Comma and Currency formats
For both Comma and Currency number formats, 1-2-3 displays negative numbers using either parentheses or a 
minus sign based on operating system default settings.

Displaying negative values in red
You can display negative values in red, for example, to show a debit. To display negative values in red for a selected 
range, use Range - Range Properties (Lines & Color tab). You can also set this option for the entire sheet by using 
Sheet - Sheet Properties.

The effect of column width on numbers
If you format a number and 1-2-3 fills the cell with *** (asterisks), the column is not wide enough to display the 
number using the format you selected. 
If you enter a number in General format, but 1-2-3 displays the number in Scientific format, the number is too large to 
display in the column. To display the number, widen the column to at least one character wider than the width of the 
formatted number. 
If 1-2-3 still displays *** (asterisks) after you widen the column, the value is invalid, for example, a date greater than 
12-31-9999.

Numbers and the year 2000
1-2-3 is year 2000 ready. You can now enter dates with either a 2-digit (for example, 4/2/15) or 4-digit year (for 
example, 4/2/2015). For more information, see 1-2-3 and the year 2000. You can also control how 1-2-3 stores and 
displays a date. For information, see Setting options for dates.
Tip If you enter the year as 4 digits, you may need to widen the columns that contain dates. 

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Formats values as a percent with two decimal places

Formats values with the thousands separator and no decimal places



Formats values with the default currency format

{button ,AL(`H_FORMATTING_NUMBERS_STEPS',1)} Go to procedure
{button ,AL(`H_PROMOTING_A_NUMBER_FORMAT_STEPS;H_CHANGING_INTERNATIONAL_SETTINGS_STEP

S;H_SIZING_COLUMNS_STEPS;',0)} See related topics



Formatting numbers as currency
Changing the number format affects only how 1-2-3 displays numbers, not how 1-2-3 stores or calculates with 
numbers.
1. Select the numbers you want to format.
2. Choose Range - Range Properties.

3. Click the Number Format tab in the InfoBox.

4. Select "Currency" or "ISO Currency" from the "Category" list.
5. Select a currency format from the "Current format" list.

Tip To promote the number format to the status bar, click "Show in Frequently Used list."
6. (Optional) To reset the current selection to the sheet default, click "Reset to Sheet Format."
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_FORMATTING_NUMBERS_AS_CURRENCY_DETAILS',1)} See details
{button ,AL(`H_NUMBER_FORMATS_OVER;H_CHANGING_THE_CURRENCY_SYMBOL_STEPS;H_FORMATTIN

G_NUMBERS_STEPS;',0)} See related topics



Details: Formatting numbers as currency
Other ways to format numbers as currency
You can also use the status bar to change currency formats quickly. Click the Number format button to display the 
Frequently Used list of number formats. Only the formats included in the Frequently Used category on the Number 
Format tab in the InfoBox are available from the status bar.

Automatic formatting of currencies
1-2-3 automatically formats data as currency when you enter it if you use one of the currency formats in the 
Frequently Used category. For example, if French franc is on the Frequently Used list, and you enter 254.70 F, 1-2-3 
automatically assigns the French franc currency format (with two decimal places) to that cell.

Displaying negative values in red
You can display negative values in red, for example, to show a debit. To display negative values in red for a selected 
range, use Range - Range Properties (Lines & Color tab). You can also set this option for the entire sheet by using 
Sheet - Sheet Properties.

Negative number defaults for Comma and Currency formats
For both Comma and Currency number formats, 1-2-3 uses either parentheses or minus sign defaults based on 
default negative number settings from the Windows control panel.

The effect of column width on numbers
If you format a number and 1-2-3 fills the cell with *** (asterisks), the column is not wide enough to display the 
number using the format you selected. To display the number, widen the column to at least one character wider than 
the width of the formatted number. If 1-2-3 still displays *** (asterisks) after you widen the column, the value is invalid.

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

Related SmartIcons

Formats values with the default currency format

Formats values with the US dollar currency symbol, the default thousands separator, and two decimal places

Formats values with the British pound currency symbol, the default thousands separator, and two decimal places

Formats values with the Japanese yen currency symbol, the default thousands separator, and zero decimal places

{button ,AL(`H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS',1)} Go to procedure
{button ,AL(`H_SIZING_COLUMNS_STEPS;H_Promoting_a_number_format_steps;H_CHANGING_INTERNATIONA

L_SETTINGS_STEPS;',0)} See related topics



Adding a number format to the Frequently Used list
You can add any number format you use often to a list of frequently used formats.
1. Select an example cell that has the format you want to add to the status bar.
2. Choose Range - Range Properties.

3. Click the Number Format tab in the InfoBox.

4. Select "Show in Frequently Used list."
In addition to displaying in the Frequently Used list, the format you selected now appears when you click the 
Number format button in the status bar.

5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_PROMOTING_A_NUMBER_FORMAT_DETAILS',1)} See details
{button ,AL(`H_NUMBER_FORMATS_OVER;H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS;H_FORMATT

ING_NUMBERS_STEPS;',0)} See related topics



Details: Adding a number format to the Frequently Used list
Removing formats from the Frequently Used list
To remove a number format from the Frequently Used list, use the Number Format tab in the InfoBox. Select the 
"Frequently Used" category, select the formats you want to remove, and then deselect "Show in Frequently Used list."
The format of the current selection does not change, but the InfoBox changes to show that number format in its 
original category, and removes the format from the status bar.

Troubleshooting
If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style changes 
in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more information, 
see Overview: Protecting data.

{button ,AL(`H_PROMOTING_A_NUMBER_FORMAT_STEPS',1)} Go to procedure



Changing the currency symbol
You can change the symbol or International Standards Organization (ISO) code for a selected currency, and the 
position of the symbol or code.
1. Choose Range - Range Properties or Sheet - Sheet Properties.
2. Select "Currency" or "ISO Currency" from the "Category" list.
3. In the "Current format" list, select the currency whose symbol or ISO code you want to change.
4. Click Currency Options.
5. Enter the symbol or code in the "Symbol" box.
6. (Optional) Select a position for the currency symbol or code.
7. Click OK.

{button ,AL(`H_CHANGING_THE_CURRENCY_SYMBOL_DETAILS',1)} See details
{button ,AL(`H_NUMBER_FORMATS_OVER;H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS;H_FORMATT

ING_NUMBERS_STEPS;',0)} See related topics



Details: Changing the currency symbol
Entering the currency symbol
To enter a symbol character that you cannot type directly from your keyboard, you can use a compose sequence 
starting with ALT+F1 (COMPOSE). For example, to enter the character £ (British pound sterling symbol), press ALT+F1 
(COMPOSE) and type L=. You can also copy the currency symbol from the Windows Character Map. 

Changes to the currency symbol
These changes affect current and future sessions of 1-2-3 and are stored as default settings. They are specific to 
your copy of 1-2-3 and are not transferred when you give a workbook to someone else. 
Note You cannot enter a symbol or code that is already being used for another currency. Also, if you leave the 
"Symbol" box blank, the symbol for the selected currency reverts to the system default.

Table of currency symbols
The table below shows the number 1234.56 displayed as regular and ISO currencies: 

Currency name Regular currency ISO currency
Argentinean Peso A1,234.56 ARS 1,234.56
Australian Dollar A$1,234.56 AUD 1,234.56
Austrian Schilling 1,234.56 ÖS ATS 1,234.56
Belgian Franc 1,234.56 BF BEF 1,234.56
Brazilian Real R$ 1,234.56 BRL 1,234.56
British Pound £1,234.56 GBP 1,234.56
Canadian Dollar C$1,234.56 CAD 1,234.56
Chinese Yuan PRC¥1,234.56 CNY 1,234.56
Czech Koruna 1,234.56 Kc CZK 1,234.56
Danish Krone Dkr 1,234.56 DKK 1,234.56
ECU 1,234.56 ECU XEU 1,234.56
Euro 1,234.56 euro EUR 1,234.56
Finnish Markka 1,234.56 mk FIM 1,234.56
French Franc 1,234.56 F FRF 1,234.56
German Mark 1,234.56 DM DEM 1,234.56
Greek Drachma 1,234.56 Dr GRD 1,234.56
Hong Kong Dollar HK$1,234.56 HKD 1,234.56
Hungarian Forint 1,234.56 Ft HUF 1,234.56
Indian Rupee Rs 1,234.56 INR 1,234.56
Indonesian Rupiah Rp 1,234.56 IDR 1,234.56
Irish Punt IR£1,234.56 IEP 1,234.56
Italian Lira L. 1,234.56 ITL 1,234.56
Japanese Yen ¥1,234.56 JPY 1,234.56
Luxembourg Franc 1,234.56 LF LUF 1,234.56
Malaysian Ringgit Rm 1,234.56 MYR 1,234.56
Mexican Peso N$1,234.56 MXN 1,234.56
Netherlands Guilder F 1,234.56 NLG 1,234.56
New Zealand Dollar NZ$1,234.56 NZD 1,234.56
Norwegian Krone Nkr 1,234.56 NOK 1,234.56
Polish Zloty 1,234.56 Zl PLN 1,234.56
Portuguese Escudo 1,234.56 Esc. PTE 1,234.56
Romanian Leu 1,234.56 Lei ROL 1,234.56
Russian Ruble 1,234.56 R SUR 1,234.56



Singapore Dollar S$1,234.56 SGD 1,234.56
Slovakian Koruna 1,234.56 Sk SKK 1,234.56
Slovenian Tolar SIT 1,234.56 SIT 1,234.56
South African Rand R1,234.56 ZAR 1,234.56
South Korean Won W1,234.56 KRW 1,234.56
Spanish Peseta 1,234.56 Pts ESP 1,234.56
Swedish Krona 1,234.56 Skr SEK 1,234.56
Swiss Franc SFr 1,234.56 CHF 1,234.56
Taiwan Dollar NT$1,234.56 TWD 1,234.56
Thai Baht 1,234.56 Bt THB 1,234.56
US Dollar $1,234.56 USD 1,234.56
Other Country OTH 1,234.56 OTH 1,234.56

{button ,AL(`H_CHANGING_THE_CURRENCY_SYMBOL_STEPS',1)} Go to procedure
{button ,AL(`H_FORMATTING_NUMBERS_AS_CURRENCY_STEPS;H_FORMATTING_NUMBERS_STEPS;H_NU

MBER_FORMATS_OVER;H_ENTERING_NUMBERS_STEPS;',0)} See related topics



Changing text styles
Use the InfoBox to style labels and values in ranges, and text in graphic objects.
1. Select the range or graphic object containing the text.
2. Right-click the selection, and choose the Properties command.
3. Click the Text Format tab in the InfoBox.

4. Select a font, point size, color, and attribute(s).
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TEXT_FORMAT_DETAILS',1)} See details
{button ,AL(`H_REMOVING_FORMATTING_FROM_TEXT_STEPS;H_NAMED_STYLES_OVER;H_STYLE_KEYS_

OVER',0)} See related topics



Details: Changing text styles
Other ways to style text
You can also style text by using the buttons in the status bar. Click the button and select from a list of options.

Troubleshooting
• If the font name in the status bar is red, it means the font is not installed on your computer. 1-2-3 substitutes a 

similar font in its place. 
• If the workbook is locked, the style options in the InfoBox and status bar are dimmed. You can't make style 

changes in a locked workbook. To unlock the workbook, use File - Workbook Properties (Security tab). For more 
information, see Overview: Protecting data.

Styling text blocks
Changes you make to text blocks affect all the text in the text block. You can't style individual characters.

Removing attributes from text
To remove bold, italic, strikethrough, and all underlining from the selection, click the Text Format tab in the InfoBox 
and select "Normal" from the "Attributes" list; or click the icon shown below.

Related SmartIcons

Adds bold to data in a selection

Adds italics to data in a selection

Adds underlining to data in a selection

Adds double underlining to data in a selection

Changes the font, color, and attributes of data in ranges

Changes the font, color, and attributes of text in text blocks

{button ,AL(`H_CHANGING_TEXT_FORMAT_STEPS',1)} Go to procedure
{button ,AL(`H_USING_THE_STATUS_BAR_OVER;',0)} See related topics



Overview: Differences between TeamMail and TeamReview
TeamMail and TeamReview share the same distribution and routing feature, which uses your e-mail system.
With either TeamMail or TeamReview, you can send workbook data and a message to other 1-2-3 users in your 
workgroup, collect their input, and have their changes and additions returned to you automatically. However, 
TeamMail and TeamReview have different uses. 

When to use TeamMail
Use TeamMail when you want to: 

• Send a workbook and a message, or just a message, to a group. 
• Send all objects in a workbook (including Web tables, datalink tables, query tables, drawings, charts, and maps), 

and maintain versions, styles, settings, and other workbook properties.
• Let recipients add data to the workbook. To merge the changes into your original workbook, you can use Edit - 

Cut and Edit - Paste or File - TeamConsolidate - Merge Versions. 

When to use TeamReview
Use TeamReview when you want to:

• Send a message with a range of data that others can edit. 1-2-3 stores the range of data in a new workbook 
called the routed workbook. 
Before you send the routed workbook to recipients, you can copy and paste graphic objects such as charts, 
maps, Web tables, query tables, and datalink tables to the routed workbook. You can also add versions in the 
routed workbook before sending, and recipients can create versions along the route.

• Gather data from individuals and then automatically merge the returned data, including versions, into the original 
range. 
When you receive the routed range back from recipients, click the Merge button. You can specify whether 1-2-3 
writes over the original data or creates versions automatically based on the data you receive. 

{button ,AL(`H_TEAMMAIL123_OVER;H_TEAMREVIEW_OVER;H_MERGING_VERSIONS_AND_VERSION_GRO
UPS_STEPS;',0)} See related topics



Overview: TeamMail in 1-2-3
TeamMail lets you send an entire workbook, or just a message, using your e-mail system. 

What you can do as the originator of a workbook
If you distribute a workbook, you can distribute it to one or more people at once or route it sequentially to one person 
at a time, tracking its progress along the way. If you distribute a workbook and other team members change the data, 
you can later merge these changes into your original workbook by pasting in the returned data or by using File - 
TeamConsolidate - Merge Versions.
If you want to distribute a range of data that others can edit (rather than an entire workbook), use File - TeamReview.

What you can do as the recipient of a workbook
If you are the recipient of a workbook, you can make changes, add comments, and send it to the next person in the 
route list or back to the originator. If the originator granted permission, you can edit the route list. 

TeamMail compatibility
TeamMail works with Lotus Notes, Lotus cc:Mail™, and other e-mail applications that support Vendor Independent 
Messaging (VIM), Messaging Application Programming Interface (MAPI), or Common Messaging Call (CMC).
To use TeamMail with Lotus Notes on Windows NT, you must have version 4.0 or higher.
If someone sends you a 1-2-3 Release 5 file with TeamMail, you can open it in 1-2-3 Release 9, but you cannot 
continue the routing process. 
You cannot route a .123 workbook to a Release 5 user.

{button ,AL(`H_SENDING_A_MESSAGE_ONLY_WITH_TEAMMAIL_STEPS;H_SENDING_A_WORKBOOK_WITH_
TEAMMAIL_STEPS;H_DIFFERENCES_BETWEEN_TEAMMAIL_AND_TEAMREVIEW_OVER;H_MERGING_VE
RSIONS_AND_VERSION_GROUPS_STEPS;H_TEAMREVIEW_OVER;',0)} See related topics



Sending a workbook with TeamMail
You can attach the current workbook to a message, and then send it to a group of recipients all at once or route it 
sequentially to one person at a time.
1. Choose File - TeamMail.

2. Under Send, select "Workbook with message." 
3. Click OK. 
4. If prompted, type your e-mail password and any other required information in the Mail Login dialog box, and click 

OK.
5. Enter the names of the recipients and set tracking and delivery options on the Basics and Options tabs in the 

TeamMail dialog box. 
6. Click Send. 

{button ,AL(`H_DIFFERENCES_BETWEEN_TEAMMAIL_AND_TEAMREVIEW_OVER;H_RECEIVING_A_ROUTED
_RANGE_STEPS;H_TEAMMAIL_OVER;H_SENDING_A_MESSAGE_ONLY_WITH_TEAMMAIL_STEPS;H_DBO
X_BASICS_REF;H_DBOX_OPTIONS_REF;',0)} See related topics



Sending a message with TeamMail
You can send a message and, optionally, include a picture of the current selection in the message. Messages are 
sent to all recipients simultaneously rather than routed sequentially.
1. (Optional) To include a picture of a range or graphic object with your message, select the range or graphic object. 
2. Choose File - TeamMail.

3. Under Send, select "Message only." 
4. (Optional) Select "Paste in a picture of the selection" to include a picture of the selected range or object. 
5. Click OK.
6. If prompted, enter your e-mail password and any other required information in the Mail Login dialog box, and click

OK. 
7. Enter the names of the recipients and set tracking and delivery options on the Basics and Options tabs in the 

TeamMail dialog box. 
8. Click Send. 

{button ,AL(`H_SENDING_A_MESSAGE_ONLY_WITH_TEAMMAIL_DETAILS',1)} See details
{button ,AL(`H_DIFFERENCES_BETWEEN_TEAMMAIL_AND_TEAMREVIEW_OVER;H_TEAMMAIL_OVER;H_SE

NDING_A_WORKBOOK_WITH_TEAMMAIL_STEPS;H_DBOX_BASICS_REF;H_DBOX_OPTIONS_REF;',0)} 
See related topics



Details: Sending a message with TeamMail
Sending pictures of ranges and graphic objects
If you selected a range, it appears in a Notes e-mail as a table. If you selected a map, chart, or other graphic object, 
1-2-3 pastes it as a bitmap in your e-mail message. You can't send a collection or an entire sheet as a picture.
Note You can send pictures with a message only if you are using Lotus Notes or another e-mail system that supports
DDE paste commands.

{button ,AL(`H_SENDING_A_MESSAGE_ONLY_WITH_TEAMMAIL_STEPS',1)} Go to procedure



TeamMail dialog box
Use this dialog box to send a message, include pictures of 1-2-3 data, or attach a workbook to a mail message. 

Choose a task 
Sending a workbook with TeamMail
Sending a message with TeamMail

{button ,AL(`H_TEAMMAIL123_OVER;',0)} See related topics



Overview: TeamReview in 1-2-3
Using your e-mail system, TeamReview lets you send a range of workbook data to other 1-2-3 users. You can send a 
range to members of a team, collect their input, and have it returned to you automatically. 

What you can do as the originator of a routed range
When you want to send a range out for review, you select the range and create a list of recipients. 
You can send the range to all recipients at once, or route it from one person to the next, tracking its progress along 
the way. 
Recipients make their changes, add comments, and return the range to you. You can open it in 1-2-3 and merge the 
changes into your original workbook. 
For example, suppose you need figures from several different people to complete your department's budget. You tell 
1-2-3 who to send the budget to, and in what order, and specify that you want the range returned to you. Your co-
workers add their figures to the range and 1-2-3 automatically routes it to the next person on your list. When the 
range returns to you, 1-2-3 remembers where the range came from and can merge the updated range into your 
original workbook. 
You can choose to incorporate just the changes you want, to replace your original data with reviewers' changes, or to 
merge each reviewer's changes as a version of your original range. 

What you can do as the recipient of a routed range
When you receive an e-mail containing a routed range, you get an attached workbook containing the range. You can 
detach or launch the attached workbook. In the workbook, you can add or change data, make comments, and add 
drawings or charts.
You can then send the workbook along to the next recipient on the list. If the originator granted permission, you can 
edit the route list. If you are the last recipient, you can return the routed workbook to the originator. 

TeamReview compatibility
TeamReview works with Lotus Notes, Lotus cc:Mail, and other e-mail applications that support Vendor Independent 
Messaging (VIM), Messaging Application Programming Interface (MAPI), or Common Messaging Call (CMC). 
To use TeamReview with Lotus Notes on Windows NT, you must have Notes version 4.0 or higher.

{button ,AL(`H_TEAMMAIL123_OVER;H_RECEIVING_A_ROUTED_RANGE_STEPS;H_SENDING_A_RANGE_FO
R_REVIEW_STEPS;H_DIFFERENCES_BETWEEN_TEAMMAIL_AND_TEAMREVIEW_OVER;H_MERGING_DA
TA_INTO_A_WORKBOOK_STEPS;',0)} See related topics



Sending a range for review
You can send a range of data and a message to a list of recipients, either all at once, or one at a time in the order you
specify. 
1. Select the range you want to send. 

Note If you want to merge data when the routed range is returned to you, make sure you save the workbook 
before you send the range for review. 

2. Choose File - TeamReview. 

3. Select an option for sending formulas and click OK.
1-2-3 creates a new workbook containing the range, and the flow control window opens.

4. (Optional) Make changes to the routed workbook. 
Note 1-2-3 does not copy graphic objects, versions, or frames and links for Web tables, query tables, and 
datalink tables into the routed workbook. However, you can copy and paste them now before sending the 
workbook. You can merge the original data, including versions (but not graphic objects or tables), back into the 
original workbook. 

5. Click Send. 
6. If prompted, enter your e-mail password and any other required information in the Mail Login dialog box and click 

OK. 
7. In the TeamMail dialog box, enter the names of recipients, select whether to distribute the workbook 

simultaneously or route it sequentially, and set other tracking and delivery options. 
8. Click Send. 

{button ,AL(`H_SENDING_A_RANGE_FOR_REVIEW_DETAILS',1)} See details
{button ,AL(`H_TEAMREVIEW_OVER;H_RECEIVING_A_ROUTED_RANGE_STEPS;H_MERGING_DATA_INTO_A

_WORKBOOK_STEPS;H_DBOX_BASICS_REF;H_DBOX_OPTIONS_REF;',0)} See related topics



Details: Sending a range for review
What you can send in the selected range
The range you copy to the routed workbook can include cell data, cell comments, and scripts. Styles applied to the 
selected range are copied to the routed workbook. 
When the selection is a 3D range, 1-2-3 displays the range in the routed workbook starting on sheet A.
You cannot send graphic objects, outline settings, collections, or versions. In addition, frames and links for Web 
tables, query tables, and datalink tables cannot be sent (the data in the range is sent, but the link and frame are lost). 
If you want to include any of these objects, use TeamMail to send the entire workbook for review. For information, see
Sending a workbook with TeamMail.
If the range you send contains a version, 1-2-3 sends data from the current version only. You can copy and paste 
versions, graphic objects, and tables or adjust settings in the routed workbook, before you send it to the first recipient.
Note When you send a range for review, you can later merge any changes that fall within the range you sent 
originally. 

Formulas in the routed range
Selecting "Formulas and values" leaves formulas intact. Formulas that refer to data outside of the range you are 
sending will not evaluate correctly until the range is merged back into the original workbook.
Selecting "Values only" converts formulas in the range to their values.

Making changes in the routed workbook
The routed workbook contains a copy of the range you selected; it is not linked to the original workbook.Before 
sending, you can change data in the range, or add new data. For example, you might want only part of the data to be 
reviewed by the list of recipients. Or, you might want to delete certain data. Changes you make in the routed 
workbook are not reflected in the original workbook (unless you later merge the changes).
You can use the gray area surrounding the selected range to add data, make notes, and create charts or drawings. 
The additions you make here will be sent or routed to the next person, but only the range you originally selected can 
be merged back into your workbook. 

{button ,AL(`H_SENDING_A_RANGE_FOR_REVIEW_STEPS',1)} Go to procedure
{button ,AL(`;H_PROTECTING_DATA_OVER;',0)} See related topics



Receiving a range or workbook
When you receive a range or workbook in an e-mail, you can open it, make changes to the data, and send it to the 
next person in the route list or back to the originator. 
1. In your e-mail application, either launch the attachment to start 1-2-3 and open the workbook, or detach the 

workbook and then open it in 1-2-3 with File - Open.
2. Make changes to the workbook. 
3. (Optional) Add comments in the flow control window (titled TeamMail or TeamReview). 
4. Click the appropriate button in the flow control window. You will see one or more of these buttons, depending on 

what was sent and how:
• Send to Next -- Sends the workbook or range to the next person on the recipient list.
• Edit Route -- Edits the list of recipients. 
• Return to Originator -- Returns a workbook or range with your changes back to the originator. 
• Merge -- Combines changes to a routed range into your original workbook.
• Done -- Closes the flow control window.

{button ,AL(`H_RECEIVING_A_ROUTED_RANGE_DETAILS',1)} See details
{button ,AL(`H_TEAMREVIEW_OVER;H_SENDING_A_RANGE_FOR_REVIEW_STEPS;H_MERGING_DATA_INTO

_A_WORKBOOK_STEPS;',0)} See related topics



Details: Receiving a range or workbook
The flow control window, titled TeamReview or TeamMail depending on what was sent, stays open in 1-2-3 while you 
work with a routed range or workbook. 

Options for handling routed ranges and workbooks
The buttons available in the flow control window vary depending on whether you are a recipient or the orginator of the
routed range or workbook, and whether it was mailed to all recipients at once or routed from one to the next.

• Send to Next -- Displays the name of the next person on the list. Click OK to send the workbook. 
• Return to Originator -- You see this button if you are the last person on the route list and the originator selected 

the Return to Originator option, or if the range or workbook was sent to several recipients at once and the 
originator selected the Return to Originator option.

• Edit Route -- If the originator chose to let recipients change the route list, you see the Edit Route button. Clicking 
Edit Route opens the TeamMail dialog box so you can edit the list of recipients. 

• Merge -- You see this button if you are the originator of a TeamReview range that completed the route and was 
returned to you. Clicking Merge lets you merge the range into your original workbook.

• Done -- You see this button if you are the last person to receive a routed workbook, or the last person to receive a
routed range if the Return to Originator option was not selected. When you close the flow control window, 1-2-3 
creates a text block in the current sheet to contain the routing information. To keep this information, you must 
save the workbook.

Note To consolidate changes if you are the originator of a workbook sent with File - TeamMail, copy the data back to 
the original workbook with Edit - Copy or use File - TeamConsolidate - Merge Versions. 

Adding a comment
As the recipient of a range or workbook, you can enter or edit a comment in the "Comment" box in the flow control 
window. The comment appears next to your name in the "Contributor/Action" list. 

{button ,AL(`H_RECEIVING_A_ROUTED_RANGE_STEPS',1)} Go to procedure



Merging ranges into a workbook
When a range of data returns to you, you can merge it into your original workbook. When you merge the range, 1-2-3 
opens the original workbook and replaces the original range with the routed range, or creates versions for the range if
you request. You can only merge cells that are within the original range.
1. In your e-mail application, open the attached routed workbook. 
2. (Optional) If you do not want to merge the whole range, select the portion of the range that you want to merge.
3. Click Merge. 
4. Select "Entire routed range" or, if you're merging part of the range, select "Range." 
5. Click OK.
6. If the destination range already contains data, select whether to keep both new and existing data as versions of 

the original range or to replace (overwrite) the original data with the new data.    
7. To merge additional ranges, repeat steps 2 through 6.
8. (Optional) Save the routed workbook to keep a record of the merge.

{button ,AL(`H_MERGING_DATA_INTO_A_WORKBOOK_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_TEAMREVIEW_OVER;H_SENDING_A_RANGE_FOR_RE

VIEW_STEPS;H_RECEIVING_A_ROUTED_RANGE_STEPS;',0)} See related topics



Details: Merging ranges into a workbook
If 1-2-3 can't find the original workbook
If 1-2-3 can't find the original workbook in its original location, the Select Workbook dialog box appears so you can 
specify the correct file and location. 

Merging cells outside the original range
If the range that you are merging contains cells outside the original range, or if the range is completely outside the 
original range, 1-2-3 displays a message saying that only data within the routed range can be merged back into the 
original range. To merge data outside the routed range, use Edit - Copy and Edit - Paste or Team Consolidate - 
Merge Versions. 

Multiple merges
When you are the originator and a routed workbook is returned to you, you can merge as many times as necessary. 
For example, if a recipient adds data to different parts of the range, you can merge each part of the range separately.

Saving merge records
1-2-3 creates a merge record each time you merge data into the original workbook. The merge information appears in
the "Comment" box in the flow control window. The merge record provides detailed information about what was 
merged.
By saving the routed workbook, you can save merge records to keep an audit trail of the routed workbook's progress.

Merging and versions
If you choose to keep the original data as well as the new data from the routed range, 1-2-3 creates two versions for 
the range: Original Data, which contains the original data, and Merged 1, which contains the new data. If the original 
range is a named range, 1-2-3 creates the new versions using the original range name. If the original range is not 
named, but the routed range is named, 1-2-3 uses the name of the routed range. If neither range is named, 1-2-3 
names the range MERGED 1. For example, if neither range is named, 1-2-3 names the range MERGED 1, and then 
creates two versions for it: Original Data and Merged 1.
If the routed range and the original range have matching named ranges of the same size, versions in the routed 
range are merged into the corresponding ranges in the original file. 
If a routed range contains versioned ranges that do not exist in the original workbook, 1-2-3 creates those versions in 
the original workbook. If 1-2-3 merges all the versions within a version group, the version group is merged as well.
If a partial selection of the routed range is a versioned range, 1-2-3 merges all versions in that range only. If the 
selected range already has a range name, 1-2-3 uses that name instead of MERGED 1.
If any data is not merged, 1-2-3 records omissions in the merge record.

{button ,AL(`H_MERGING_DATA_INTO_A_WORKBOOK_STEPS',1)} Go to procedure
{button ,AL(`H_MERGING_VERSIONS_AND_VERSION_GROUPS_STEPS;',0)} See related topics



TeamReview Assistant dialog box
Use this dialog box to select a range to send instead of a single cell.

Choose a task
Sending a range for review
Selecting a range from a dialog box

{button ,AL(`H_TEAMREVIEW_OVER;',0)} See related topics



Overview: 1-2-3 Top 10 tasks
The Help topics in this book describe features you can use to perform the top ten most common spreadsheet tasks. 
Each Help topic gives you the basics and directs you to more detailed Help.
Click an item in the list below and have fun exploring.
Previewing and printing data 
Moving data in and out of 1-2-3
More power with @functions and formulas
Styling a sheet
Copying, moving, and filling
Charting and mapping your data 
Easy database access 
Automating 1-2-3 
Row and column operations
Starting smart with SmartMaster templates



Automating 1-2-3
Using LotusScript, you can automate simple 1-2-3 tasks and create complex custom applications.
Also, you can still run macros from previous releases of 1-2-3 and, using script equivalents to macro commands, you 
can convert your macros to LotusScript.

What is LotusScript?
LotusScript is an object-oriented, BASIC-compatible programming language used by all the SmartSuite products and 
Notes. You can create scripts to run within 1-2-3 and across products.
For reference Help about all the 1-2-3 LotusScript commands, see 1-2-3 LotusScript A-Z. 

The LotusScript IDE
1-2-3 provides an Integrated Development Environment (IDE) to facilitate writing, editing, recording, and debugging 
scripts. In the IDE, you can access all the objects you need to create all kinds of scripts.

The LotusScript Dialog Editor
Using the LotusScript Dialog Editor, you can create custom dialog boxes and attach scripts to them.

Let 1-2-3 create scripts for you
You can write scripts from scratch, and you can use 1-2-3 to record many useful scripts. The commands for running 
and recording scripts are on the Edit - Scripts & Macros menu.

Moving from macros to LotusScript
You still can run your existing macros, and you can create new ones. For information about writing, recording, 
running, and debugging macros, see Overview: 1-2-3 macros.
For information about macro compatibility between this release of 1-2-3 and previous releases, see Macro 
compatibility. For information about LotusScript equivalents to 1-2-3 Release 5 macro commands, see Overview: 1-2-
3 Release 5 macro command equivalents.
To review the current 1-2-3 macro commands, just type { (open brace) in a cell and press F3 (NAME). The Macro 
Keywords dialog box appears, and you can do the following:

• Browse through the list of commands and the brief descriptions of each command.
• Select a command from the list and click OK to insert the command and argument placeholders in the current 

cell.
If you have the CD edition of SmartSuite or 1-2-3, you can find the 1-2-3 macros Help file in the EXTRA directory, 
ready for you to install. Otherwise, if you have access to the World Wide Web, you can download a copy of 1-2-3 
macro reference Help and install it with your copy of 1-2-3. For more information, see Installing Help on macro 
commands.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_LOTUSSCRIPT_INDEX_TOPIC_OVER;H_123_CONVERTING_M
ACRO_BUTTONS_OVER;H_123_CREATING_A_BUTTON_STEPS;H_123_RUNNING_A_SCRIPT_STEPS;H_12
3_RECORDING_A_SCRIPT_STEPS;H_123_VIEWING_A_SCRIPT_STEPS;H_123_TURNING_RECORDING_O
FF_STEPS;H_CALLING_A_SCRIPT_FROM_A_MACRO_STEPS;H_ATTACHING_A_SCRIPT_TO_AN_ICON_ST
EPS;',0)} See related topics



Charting and mapping your data
The most powerful way to convey the significance of your numbers is displaying them as a chart or map.

Creating a chart
In one step, you can create a chart, complete with titles, labels, and a legend. After you've selected the range of data 
you want to chart, click this icon:

Then click    the sheet where you want your chart to appear, and 1-2-3 draws your chart. For more information, see 
Overview: Creating a chart in 1-2-3.

Changing chart type
By default, 1-2-3 creates a bar chart. If you want to display a different type of chart, you can:

• Change the default by using Chart - Chart Styles - Set Default Chart.
• Use the Type tab in the Chart Properties InfoBox or any of the chart type SmartIcons to change the type of a 

selected chart.

Mapping your data
Lotus Mapping lets you draw maps that represent your data geographically. For example, with just a click, you can 
create maps of population density by state or average rainfall by province. 
As with charting, you select a range of data to map. Then click this icon:

Click the sheet where you want your map to appear, and 1-2-3 draws your map. You can then enhance the map with 
colors, patterns, overlays, and pin characters. For more information, see Introducing maps in 1-2-3.

Manipulating parts of charts and maps
Manipulating and changing parts of charts and maps is simple. Just point to the part -- for example, the chart title or 
map legend -- and right-click to display a menu of commands you can use on that part. To display the InfoBox for 
working with part of a chart or map, just double-click the part.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_CREATING_A_CHART_IN_123_OVER;H_CREATING_A_CHART
_IN_123_STEPS;H_CHANGING_MAP_APPEARANCE_OVER;H_CREATING_A_MAP_STEPS;H_MODIFYING_
MAPS_OVER;H_PURCHASING_MORE_MAPS_OVER;H_SETTING_UP_MAP_DATA_STEPS;',0)} See related 
topics



Copying, moving, and filling
1-2-3 features a variety of ways to copy and move data. You can also quickly fill ranges with data.

Drag and Drop
You can drag and drop:

• Data in the same sheet, between sheets, and between open workbooks.
• Data between 1-2-3 and other programs that support OLE.
• Sheets within the same workbook.

For more information, see:
Copying and moving using drag and drop
Copying data from 1-2-3 with drag and drop
Copying data into 1-2-3 with drag and drop.
Copying a sheet 
Moving a sheet 

Copy, move, and fill commands
The commands to copy and move and fill are Edit - Copy, Edit - Cut, Edit - Paste, Range - Fill. You can also just click 
these SmartIcons:

Copy to the Clipboard

Cut to the Clipboard

Paste the Clipboard contents

Fill a range with data

Quick ways to copy formulas
You often want to copy formulas into cells below or to the right. Use Edit - Copy Right and Edit - Copy Down, or just 
click these SmartIcons:

Copy right

Copy down
For more information, see Copying right to fill a range and Copying down to fill a range.

SmartFill
Do you enter the same sequences of items over and over again -- for example, the days of the week, the months of 
the year, the names of your regional field offices? SmartFill can save you time and effort by automatically filling a 
range with this data.
If it's a common sequence like the days of the week, just enter the first item of the sequence and position the mouse 
pointer at the bottom right corner of the cell so it looks like this:

Then just drag to select the range you want to fill.
You can also create your own custom SmartFill lists, and you can fill ranges according to data already in the range. 
For more information about creating custom fill lists, see Overview: Creating custom SmartFill lists. For information 



about filling a range by example, see Overview: Filling ranges.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_FILLING_A_RANGE_USING_DRAGANDFILL_STEPS;H_COPYIN
G_AND_MOVING_FORMULAS_OVER;H_COPYING_AND_MOVING_OVER;H_123_COPYING_A_SHEET_STE
PS;H_123_S98_MOVING_A_SHEET_STEPS;H_123_COPYING_TO_FILL_A_3D_RANGE_STEPS',0)} See 
related topics



Easy database access
1-2-3 offers two ways to help you manage and analyze data contained in 1-2-3 or external database tables: 

• The Create - Database commands give you access to the many powerful database features of Lotus Approach. 
1-2-3 and Approach are installed together when you install 1-2-3. Using the Create - Database commands, you 
can access Approach to create query tables, data entry forms, reports, mailing labels, form letters, and dynamic 
crosstabs.    
For more information about using the Create - Database commands, see Overview: Working with 1-2-3 and 
Approach.    

• The Data Query Add-in (DQA) is included in this release of 1-2-3 to give you data query functionality that is similar
to that in 1-2-3 Release 5. When you load DQA, you can work with query tables created in 1-2-3 Release 5 or the 
Query Table Add-in from 1-2-3 97. You can also create new query tables and crosstabs.    
For more information about using DQA, see Overview: Data Query Add-in (DQA). 

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_DB_WORKING_WITH_DATABASE_TABLES_OVER',0)} See 
related topics



More power with @functions and formulas
To perform calculations in 1-2-3, you can use built-in formulas, called @functions, or you can create your own 
formulas.

Working with @functions
To use @functions, just click the @function selector.

Choose List All to see a list of the more than 200 @functions. 
You can:

•  Browse through the list and read a brief description of each @function, or click Help for more detailed information
on a selected @function.

• Select an @function and click OK to insert the @function and argument placeholders into the current cell.
For more information, see Overview: @Functions.

Popular @functions
The @Functions book in Help Contents contains an alphabetical list of @functions and a list of @functions organized
by category. Here's Help for some of the most popular @functions:
@AVG 
@IF 
@NPV 
@ROUND 
@SUM 
@TODAY 

Using SmartLabels
Using the SmartLabels feature, you can automatically create formulas below or to the right of a range by entering a 
recognized label. These labels can have formulas, formats, and synonyms associated with them. You can also 
customize the SmartLabels 1-2-3 provides or create your own SmartLabels. There are 8 predefined SmartLabels you 
can use, or you can create your own SmartLabel. For more information, see Working with SmartLabels.
For example, you just type a word such as "Total" or "Totals"    to sum columns or rows of values. To sum columns, 
enter Total to the left of the range you want to sum.

To sum rows, enter Total above the range you want to sum.

For more information, see Summing a range automatically.
You can also click this icon to sum values above and to the left:



Working with formulas
When you enter formulas, 1-2-3 displays the formula results in the sheet and the formula in the edit line. When you 
change data a formula refers to, the formula results automatically change.
For more information about formulas, see Overview: Using formulas.

Auditing a workbook
Have you ever opened a workbook and wondered where all the formulas are and how they work? To help yourself 
and others audit workbooks, you can use formula markers to identify cells containing formulas. You can also annotate
cells with comments about the cell contents.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_GUIDELINES_FOR_ENTERING_FORMULAS_OVER;H_USING_
FORMULAS_OVER;H_CREATING_A_CELL_COMMENT_STEPS;H_ENTERING_A_FORMULA_STEPS;H_ENT
ERING_AN_ATFUNCTION_STEPS;H_FUNCTION_FORMAT_OVER;',0)} See related topics



Moving data in and out of 1-2-3
1-2-3 provides many ways to move data in and out of your spreadsheets. You can:

• Open and save many different types of files. 
• Cut and paste and drag and drop data from one 1-2-3 workbook to another and between 1-2-3 and other 

programs.
• Use the Internet to move data in and out of 1-2-3.
• Move data between 1-2-3 and Notes.
• Use 1-2-3 team features to share data in and out of 1-2-3.

Using File - Open and File - Save As
You can use File - Open to bring in data from 1-2-3 workbooks and many other types of files, including Excel, dBASE,
Paradox, and text files. You can also combine files and parse data from the Open dialog box. For more information 
about opening files in 1-2-3, see Overview: Creating and opening files.
You can use File - Save As to save files in many different file formats, including Excel, dBASE, Paradox, and text. You
can save an entire file in these various file formats, or you can save just a selected range. For more information, see 
Overview: Closing and saving files.

Moving data between 1-2-3 and other programs
To move data between 1-2-3 and other programs, you can:

• Use Edit - Copy and Edit - Cut to move 1-2-3 data onto the Clipboard and then use Edit - Paste to bring the data 
into 1-2-3. For more information, see Copying and moving data from other applications into 1-2-3.

• Use Edit - Paste Special or Edit - Paste Link to create links between 1-2-3 and other programs. The link ensures 
that the data you bring into 1-2-3 is updated whenever the data in the other program changes. For more 
information, see What is an OLE link?

• Drag and drop data between 1-2-3 and other programs that support OLE. For more information, see Copying data
from 1-2-3 with drag and drop and Copying data into 1-2-3 with drag and drop.

Using the Internet
1-2-3 provides fast and easy ways to move data between your workbooks and the World Wide Web. You can use File
- Open to open World Wide Web and FTP files stored on the Internet. You can import HTML tables into 1-2-3 and 
much more.
You can:

• Use File - Save As to save your workbooks directly to the Internet. Just click the Internet button in the File - Save 
As dialog box and select the Internet site where you want to save your file. 

• Publish a 1-2-3 range to a Web site. The published range appears as an HTML table on the Web site you chose. 
Just select the range you want to publish to the Internet and click this icon:

• Perform a Web search on the content of a 1-2-3 cell. Just select the cell and click this icon:

For more information, see Overview: Working with Internet connections and Internet features. 

Using Notes
There are several convenient features for moving data between 1-2-3 and Notes. You can use:

• The Lotus Notes button in the Open dialog box to open files embedded in documents in a Notes database. For 
more information, see Opening a Notes file attachment from within 1-2-3.

• TeamConsolidate to distribute sheets to a Notes database for input from your colleagues. For more information, 
see Overview: Distributing workbooks with TeamConsolidate. 

• Notes/FX to exchange data in a 1-2-3 range with a document in a Notes database. When you change a value in a
range, the corresponding Notes field updates automatically, and vice versa. For more information, see Overview: 
Setting up Notes/FX.

Using 1-2-3 team features



1-2-3 has other team features for sharing data inside and outside 1-2-3. You can use:
• TeamReview to send ranges or entire workbooks to lists of colleagues using Lotus Notes, cc:Mail, or most any e-

mail system. For more information, see Overview: TeamReview in 1-2-3.
• TeamMail to send a message or a workbook. You can broadcast data or route it sequentially to one person at a 

time, tracking its progress along the way. For more information, see Overview: TeamMail in 1-2-3.
• Versions and version groups to move data in and out of 1-2-3. For example, use TeamConsolidate to distribute 

data and, after your colleagues enter their versions, merge the versions into a single workbook. You can also use 
TeamMail and TeamReview to distribute and collect versions. For information about working with versions, see 
Overview: Versions. 
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Previewing and printing data

Previewing
It's easy to preview your spreadsheets and make layout and data changes before printing. When you preview data, 1-
2-3 displays the Workbook window and the Preview window side by side, along with the Preview & Page Setup 
InfoBox, and the Previewing set of SmartIcons.
Previewing is live and dynamic. When you change data in the Workbook window or use the InfoBox to modify page 
layout, you immediately see the results in the Preview window. When your data and layout are all set, you can print 
directly from the Preview window without displaying the Print dialog box.

• To preview your presentation, click this icon:

• To zoom in and out, click anywhere in the Preview window.
• To view pages in a variety of ways, click these icons:

Preview one page 

Preview two pages

Preview four pages

Preview nine pages
• To display the next or previous page, click these icons:

Preview the next page

Preview the previous page
• To go to the page you want to display, click the arrows in the status bar:

• To close the Preview window, click the close box or this icon:

For more information on previewing, see Overview: The Preview window.

Printing
Printing is also flexible and direct.

• 1-2-3 prints everything -- data, charts, graphics -- exactly as you formatted it. To display the Print dialog box, click 
this icon:

• To by-pass the Print dialog box and quick-print a selected range, chart, or graphic, click this icon:

For more information on printing, see Overview: Printing.



{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_PRINT_QUICK_STEPS;H_PRINT_PREVIEW_KEY_MOUSE_SH
ORTCUTS_OVER;H_PRINT_SELECTING_A_PRINTER_STEPS;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS
;H_PRINT_A_WORKBOOK_STEPS;H_PRINT_A_SHEET_STEPS;H_PRINT_A_RANGE_STEPS;',0)} See 
related topics



Row and column operations
You often need to shift data around, add new data and blank areas, and change row heights and column widths. 1-2-
3 makes all these row and column operations easy. Once your sheet is all set, you can use outlining to expand and 
collapse rows and columns so you can view details or summary data.

Adding and deleting columns and rows
• To insert columns or rows, use Range - Insert, or click these SmartIcons:

Insert one or more columns to the left of the selected columns

Insert one or more rows above the selected rows
• To insert columns or rows immediately without displaying a dialog box, select as many entire columns or rows as 

you want to insert, and choose Range - Insert Column or Range - Insert Row.
• To delete columns or rows, use Range - Delete, or click these SmartIcons:

Delete all columns in the selected range

Delete all rows in the selected range
• To delete columns or rows immediately without displaying a dialog box, select as many entire columns or rows as 

you want to delete, and choose Range - Delete Column or Range - Delete Row.
• To delete columns or rows in a range without upsetting the layout of data around that range, select "Insert in 

selected range only" or "Delete in selected range only" in the Range - Insert or Range - Delete dialog box.

Changing row height and column width
• The quickest way to change column width is to position the mouse pointer on the column border right of the 

column letter, and drag the border right or left until the column is the width you want.

You can also double-click the column border to adjust the column to fit its widest entry.
• The quickest way to change row height is to position the mouse pointer on the bottom border of the row and drag 

the border up or down until the row is the height you want.

You can also double-click the row border to adjust the row to fit its tallest entry.
For more information, see Overview: Sizing columns and rows.

Hiding columns or rows
Hiding columns or rows is a good way to keep other users of your workbooks focused on what you want them to see 
rather than on confidential or distracting information.

• To hide columns, position the mouse pointer in the sheet frame on the right border of the column you want to hide
and drag left until the indicator shows 0 (zero).

• To hide rows, position the mouse pointer in the sheet frame on the bottom border of the row you want to hide and 
drag up until the indicator shows 0 (zero).

For more information, see Overview: Hiding data.



Outlining rows and columns of data
Outlining lets you expand and collapse rows and columns to see and print different levels of detail. You can create an 
outline with up to eight levels of rows and columns. You can collapse rows and columns of details to see just your 
summary data. When you need to see the details, it's easy to expand the rows and columns again.
For more information, see Overview: Creating an outline. 

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_DELETING_A_RANGE_STEPS;H_DELETING_COLUMNS_AND_
ROWS_STEPS;H_INSERTING_A_RANGE_STEPS;H_INSERTING_COLUMNS_AND_ROWS_STEPS;H_SIZING
_COLUMNS_STEPS;H_SIZING_ROWS_STEPS;H_HIDING_ROWS_STEPS;H_HIDING_COLUMNS_STEPS;H_
WORKING_WITH_OUTLINES_OVER;',0)} See related topics



Starting smart with SmartMaster templates
SmartMaster templates give you a quick start for creating many useful spreadsheets. Each SmartMaster provides a 
template for a common business or financial task, such as amortizing a loan; filling out a time sheet; creating 
budgets, invoices, sales plans, purchase orders, and expense reports.

Starting smart
You can access SmartMaster templates from the Welcome dialog box, or choose File - New Workbook and select the
SmartMaster you want.
Each SmartMaster template contains sample data to help you understand how the SmartMaster works. After looking 
over the sample data, you can replace it with your own data.
Formulas, print ranges, formatting, and charting are built into the templates for fast, great-looking results, and 
SmartMaster templates also include built-in buttons for printing or mailing data.
For more information, see Working with SmartMaster templates.

Custom SmartMaster templates
To create your own SmartMaster templates for sharing with your team, you can:

• Modify an existing SmartMaster and save it as a new template.
• Save a workbook in SmartMaster format.
• Create your own template, based on SHELL.12M, a starter template that comes with 1-2-3, and add a title and 

description for easy identification.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_CREATING_A_WORKBOOK_USING_A_SMARTMASTER_STEP
S;H_USING_SMARTMASTERS_STEPS;H_CREATING_A_SMARTMASTER_TEMPLATE_STEPS;',0)} See 
related topics



Styling a sheet
Use the 1-2-3 styling features to transform a simple sheet into a great-looking presentation.
The InfoBox and status bar give you one-stop shopping for all kinds of fonts, formats, colors, borders, designer 
frames, alignments, user-defined styles, and the Style Gallery of ready-made style templates.

The InfoBox
Use the InfoBox to style ranges, graphics, charts, and more. Just select what you want to style, right-click the 
selection, and choose the Properties command. Click the InfoBox tabs to see the styling options available to you. You
can leave the InfoBox open as you work, and you can move, collapse, or close the InfoBox if it covers data you want 
to see.
For more information on the InfoBox and how to use it, see Overview: The InfoBox and Using the InfoBox.

The status bar
The status bar at the bottom of the 1-2-3 window gives you quick access to fonts, font sizes, named styles, and 
number formats, including more than 40 international currency formats.
For more information about using the status bar, see Overview: Using the status bar.

Fast formatting
You can quickly paint a range with styles from another range. Select the range whose styles you want to copy and 
choose Range - Fast Format or click this icon:

Then just select the ranges you want to fast format.
For more information, see Using fast format to style a range.

The Style Gallery and designer frames
You can transform a simple spreadsheet into a beautiful presentation by choosing a template from the Style Gallery. 
You can also put designer frames around important data to emphasize it.
For more information, see Using style templates and Overview: Changing borders, lines, and colors.

{button ,AL(`H_123_TOP_TEN_TASKS_OVER;H_ALIGNMENT_OVER;H_NAMED_STYLES_OVER;H_STYLE_KEY
S_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;',0)} See 
related topics



Point mode
Lets you specify a range. 1-2-3 changes to Point mode when you:

• Click the range selector in a dialog box or in the InfoBox
• Highlight a cell or range that you want to include in a formula

{button ,AL(`H_USING_THE_STATUS_BAR_OVER',0)} See related topics



Edit mode
In Edit mode, you can change data in the current cell or in the contents box. 1-2-3 changes to Edit mode when you:

• Double-click a cell.
• Press F2 (EDIT) when you are typing an entry.
• Press F2 (EDIT) when 1-2-3 is in Ready mode.
• Click anywhere in the contents box.
• Type an entry that 1-2-3 cannot accept. 1-2-3 places the insertion point at the point where it detects an error.

Use the editing keys to change data when 1-2-3 is in Edit mode.

{button ,AL(`H_USING_THE_STATUS_BAR_OVER;H_EDITING_KEYS_OVER',0)} See related topics



Label mode
Indicates that the data you are entering is a label. 1-2-3 classifies an entry as a label if the first character you type is a
letter or a label-prefix character. A label can be up to 512 characters long.

{button ,AL(`H_USING_THE_STATUS_BAR_OVER;H_ENTERING_DATA_OVER',0)} See related topics



Mode indicator
Indicates the current mode 1-2-3 is in. The following indicators are available:

Indicator What it means
Edit You double-clicked a cell or pressed F2 (EDIT) to 

edit a cell, or you made an incorrect entry.
Error 1-2-3 is displaying an error message. 
Files You are in 1-2-3 Classic and 1-2-3 is displaying a 

list of file names.
Find You are in 1-2-3 Classic and 1-2-3 is displaying 

the results of the /Data Query Find command.
Label You are entering a label.
Menu You are choosing a menu command or selecting 

options in a dialog box.
Names You are in 1-2-3 Classic and 1-2-3 is displaying a 

list of range names.
Point You are selecting a range before choosing a 

command, while working in a dialog box or the 
InfoBox, or while entering a formula.

Ready 1-2-3 is ready for you to enter data or choose a 
command.

Value You are entering a value.
Wait 1-2-3 is completing a command or process, such 

as saving a file.

{button ,AL(`;H_USING_THE_STATUS_BAR_OVER;H_123_CLASSIC_OVER',0)} See related topics



Status indicator
Indicates the current state 1-2-3 is in. The following indicators are available:

Indicator What it means
Cmd 1-2-3 is running a script or macro.
End You pressed END to use with a pointer-movement 

key.
Grp The current sheet belongs to a set of grouped 

sheets.
PR The current cell is protected. This flag is displayed

only if the workbook is locked.
Rec You are recording a script.
U The current cell is unprotected.

{button ,AL(`H_USING_THE_STATUS_BAR_OVER;H_POINTERMOVEMENT_KEYS_OVER',0)} See related topics



Overview: Using the status bar
The status bar, located at the bottom of the 1-2-3 window, gives you information about the current selection and tells 
you what 1-2-3 is doing. You can click different buttons in the status bar to perform many functions.
The contents of the status bar change when you open the Preview window or select a:

• Range
• Query table
• Text block, chart, map, or button
• Line, shape, or other draw object
• OLE object

For example, when you open a workbook, you see the following status bar.
Note To see the entire status bar pictured below, either maximize the Help window or use the bottom scroll bar. 

However, when you select a group of graphic objects, several buttons change:

Some status bar buttons also change when you preview a file before you print it.

Selecting status bar options
The status bar contains many buttons that let you perform such operations as changing the typeface of a range of 
text, assigning a different color to a drawn object, or applying a named style to a range.
When you click certain status bar buttons, a pop-up list appears and you can pick another option. For example, if you 
click the typeface button, a list of other available typefaces appears. You can change the font of the selected cells by 
selecting a different font on the list. In other cases, a color library appears, allowing you to select a different color.
To change an option using the mouse, point to the new selection and click.
The right side of the status bar includes a status indicator, a mode indicator, and some buttons that perform a 
function. For example, the Circular reference button appears in the status bar when a formula refers to itself. To 
locate the circular reference, you click the button. 

Status and mode indicators
A status indicator shows the current state of 1-2-3, such as when 1-2-3 is running a script or the current cell is 
protected. For example, Cmd appears on the status bar when 1-2-3 is running a script or macro.
A mode indicator shows the current operating mode of 1-2-3, such as Ready or Edit. The mode indicator changes 
when you press certain keys or 1-2-3 performs certain actions. For example, when you select a menu command, the 
mode indicator changes to Menu, and you can select a command.
You cannot change status or mode indicators by clicking them.

Buttons that perform a function
The status bar also includes some buttons that perform specific functions. For example, you can click the Circular 
reference button to move to the first circular reference in the sheet. Similarly, you can click the Calc button to 
manually recalculate formulas. If you have an e-mail program running on your system that includes unread 
messages, you can access it by clicking the Mail button. And if you want to find out how to perform a particular task in
1-2-3, you can click the Expert button.

Using the keyboard to select status bar options
You can also use the keyboard to pick another option from a status bar button. After you click a button, use , ¯, ®, or 



¬ to move through the list of options. In lists of words, type the first letter of a word to move to the first word that 
begins with that letter. For example, type C to move to the first font that begins with the letter "C" in the font list. Press
ENTER to make the selection.

The progress indicator
When you save a file or open an existing file, the status bar indicates the percentage of the file saved or opened. The 
progress indicator includes:

• Descriptive text (opening, combining, or saving the file)
• The percentage complete
• A gauge, showing the percentage complete

Hiding the status bar
To hide the status bar, choose View - Hide Status Bar. To redisplay it, choose View - Show Status Bar.

{button ,AL(`H_EDIT_MODE_OVER;H_LABEL_MODE_OVER;H_PROGRESS_INDICATOR_OVER;H_VALUE_MOD
E_OVER;H_MODE_INDICATOR_OVER;H_STATUS_INDICATOR_OVER;H_SETTING_RECALCULATION_DEFA
ULTS_DETAILS;H_COMMON_ERRORS_IN_FORMULAS_OVER;H_123_POINT_MODE_OVER',0)} See related 
topics



Value mode
Indicates you are entering a value. 1-2-3 classifies an entry as a value if the first character you type is a number (0 
through 9) or any one of these characters:

+          -          @          .          (          #          $ (or the current currency symbol)
A value can also be a formula or an @function.

Editing values
Use the following keys when 1-2-3 is in Value mode:

Key Definition
F2 (EDIT) Switches between Value and Edit mode. When 1-

2-3 is in Edit mode, you can use all the editing 
keys. 

F4 Switches a cell or range reference among relative,
mixed, and absolute types.

F9 (CALC) Converts a formula to its current value.

{button ,AL(`H_USING_THE_STATUS_BAR_OVER',0)} See related topics



Overview: The InfoBox

What is the InfoBox?
The InfoBox is a fast and direct way to change the properties of an object. Properties are the characteristics of an 
object, such as color, name, size, and protection setting. 
You use the InfoBox to change the properties of an object or any of its parts. For example, you can change the 
properties for an entire sheet, a cell, a chart, the title of a chart, and so on. 
The InfoBox consists of a series of tabs. Each tab contains a category of properties you can change for the current 
selection.
The following illustration shows how to work with the InfoBox.

How the InfoBox works
When you open the InfoBox, it displays the current properties for the selected object. When you select a different 
object, the InfoBox changes to display the properties for that object, so you can leave the InfoBox open as you work. 
You can move, collapse, or close the InfoBox if it covers data you want to see. The "Properties for" box in the title bar 
of the InfoBox displays the type of object selected.

Opening the InfoBox
You can open the InfoBox by:

• Selecting an object and choosing Properties from the menu for that object.
For example, select a range and then choose Range Properties from the Range menu.

• Selecting an object and clicking the InfoBox icon. Look for the following symbol to identify icons that open the 
InfoBox for the selected object:

 
• Double-clicking the object (except for objects that contain text, such as cells, text blocks, and chart or map titles).
• Right-clicking the object and choosing the Properties command.

Changing properties 
Changes appear immediately in your selection as you select options in the InfoBox. You can make many changes to 
one object or make changes to several objects without closing the InfoBox. 
For example, you can select a range and change the background color, change the column width, and name the 
range. Then, without closing the InfoBox, you can select a chart, change the color of its border, and change it from a 
plain bar chart to a 3D bar chart. The changes appear as you make them, so you don't need to click OK or close the 
InfoBox before doing something else.
To undo the most recent change, choose Undo from the Edit menu. 
Note Undo affects only the most recent change. You cannot use Edit - Undo to undo all changes made in the 
InfoBox.

{button ,AL(`H_USING_THE_INFOBOX_STEPS;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SH
EET_AREAS_OVER;H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER;H_USIN
G_THE_STATUS_BAR_OVER;',0)} See related topics



Details: Using the InfoBox
When do InfoBox changes take effect?
In the InfoBox, when you select an option or pick from a list, your selection takes effect immediately. When you type 
something (such as a name or range address) in the InfoBox, 1-2-3 waits for you to confirm what you typed. Confirm 
the entry by pressing ENTER or clicking any InfoBox tab.

InfoBox tabs
Each tab in the InfoBox contains a category of properties you can change for the current selection. Examples of some
tabs appear below.    

Change font, size, color, and attributes for selected text

Change alignment for sheets, ranges, and text blocks

Change the number format for sheets, ranges, and charts

Change color, pattern, and line style for sheets, ranges, and graphic objects

Change basic properties such as an object's name

Bubble help for InfoBox tabs
To display a description of an InfoBox tab or a SmartIcon, hold the mouse pointer over the tab or icon.
To turn off bubble help for InfoBox tabs and SmartIcons, choose User Setup from the File menu, then choose 
SmartIcons Setup and deselect "Show icon descriptions (bubble help)."

The InfoBox and the Help window
If the Help window is open when you open the InfoBox, the Help window may cover the InfoBox. To see the InfoBox, 
move, minimize, or close the Help window.

{button ,AL(`H_USING_THE_INFOBOX_STEPS',1)} Go to procedure



Using the InfoBox
You can make changes to one object or several objects without closing the InfoBox.

 Show me a QuickDemo
1. Select what you want to modify.
2. Right-click the selection and choose the Properties command.
3. Click the tab for the properties you want to change.
4. Select one or more options.
5. (Optional) Move, collapse, or close the InfoBox.
Tip To open the InfoBox, click the InfoBox icon for the selected object. Look for this symbol on the icon:

{button ,AL(`H_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_THE_INFOBOX_OVER;H_INFOBOX_KEYS_OVER',0)} See related topics



Overview: Using formulas
A formula is an entry in a sheet that performs a calculation on numbers, text, or other formulas. When you use 
formulas in a sheet, your data becomes dynamic. When Recalculation is set to automatic, 1-2-3 recalculates the 
formula for you if you change data to which the formula refers.

Writing formulas
You enter a formula in a cell much as you enter any data into a sheet. Once you enter the formula, 1-2-3 displays the 
formula's result in the cell. To see the formula, look in the contents box. 

You can always type the numbers or text you want to calculate directly into the formula. You can also enter the data in
other cells, then use cell addresses or named ranges in the formula.
You can sum a range of data without entering a formula, using the 1-2-3 automatic summing feature.

Seeing which cells contain formulas
Formula markers let you quickly see which cells contain formulas. You can choose whether to display formula 
markers in the sheet. 

Use View - Set View Preferences to turn on formula markers.

Linking workbook files
A formula that refers to a range in another workbook is called a file reference or file link. A formula in one workbook 
that refers to a range in another workbook links the two workbooks. Formulas can refer to an active workbook or to a 
workbook file on disk.
You can create links to .123, .WK4, .WK3, and .WK1 files.

Using @functions
An @function is a built-in formula that performs a specialized calculation, such as finding the average of a column of 
numbers. See Overview: @Functions for more information.

{button ,AL(`H_SUMMING_A_RANGE_AUTOMATICALLY_STEPS;H_COMMON_ERRORS_IN_FORMULAS_OVER;
H_EDITING_A_FORMULA_STEPS;H_ENTERING_A_FORMULA_STEPS;H_GUIDELINES_FOR_ENTERING_F
ORMULAS_OVER;H_PARTS_OF_A_FORMULA_OVER;H_REFERRING_TO_OTHER_FILES_IN_FORMULAS_
STEPS;H_TYPES_OF_FORMULAS_OVER;H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;H_REFERRI
NG_TO_OTHER_FILES_IN_FORMULAS_DETAILS;H_USING_RANGE_ADDRESSES_IN_A_FORMULA_STEP
S',0)} See related topics



Types of formulas
1-2-3 has three types of formulas: numeric, text, and logical.

Numeric formulas
Numeric formulas perform simple arithmetic or complex calculations involving many variables and use one or more of
the arithmetic operators: + (addition), - (subtraction), * (multiplication), / (division), and ^ (exponentiation).
The following table shows some examples of simple numeric formulas:

Formula Result
25+5 30
15+A:A1 20, if A:A1 contains 5
22*A:A1/A:A2 11, if A:A1 contains 5 and A:A2 contains 10

Text formulas
Text formulas automatically change or combine text entered in cells. In a text formula, you must enclose text in " " 
(quotation marks). Text formulas use & (ampersand) to combine strings of text.
The following table shows two examples of text formulas:

Formula Result
+"New"&D6 New Totals, if D6 contains the text 

" Totals"
+"New"+" Totals" New Totals

Logical formulas
Logical formulas use a logical operator or a logical @function to evaluate whether a condition is true or false. The 
formula result is 1 if the condition is true, and 0 if the condition is false. Logical formulas use the operators listed 
below to evaluate various conditions.

Operator Result is true when
= Values are equal
< First value is less than second value
> First value is greater than second value
<= First value is less than or equal to second value
>= First value is greater than or equal to second 

value
<> Values are not equal
#AND# Both conditions are true
#OR# At least one condition is true
#NOT# Condition is false (If the condition is true, the 

result is false)
The following table shows some examples of logical formulas:

Formula Result
5>4 1 (True).
5>A:A1 1, if A:A1 is less than 5.
+A:A1=1#AND#A:A2=2 1, if A:A1 contains 1 and A:A2 

contains 2.
0, if either A:A1 or A:A2 contains 
another value.

+A:A1=1#OR#A:A2=2 1, if A:A1 contains 1 or A:A2 contains 
2.

#NOT#A:A1=0 1, if A:A1 contains any value other 
than 0 (zero).



{button ,AL(`H_USING_FORMULAS_OVER;H_PARTS_OF_A_FORMULA_OVER;H_GUIDELINES_FOR_ENTERIN
G_FORMULAS_OVER;H_ENTERING_A_FORMULA_STEPS',0)} See related topics



Parts of a formula
All formulas contain three basic elements: operands, operators, and separators.

Operands
Operands are the values or text that the formula operates on.

Oper
and

Descriptio
n

Examples

Value Number 450, -92, 
7.1E+12

Text Sequence 
of 
characters 
enclosed 
in double 
quotation 
marks

"Budget", 
"TOTAL", 
"1955 Hill 
Valley 
Road"

Although you can enter values or text for operands directly into a formula, you can often make a formula more useful 
by entering the addresses or names of cells that contain the values or text instead. Every time you change the data in
a cell referred to by a formula, the result of the formula changes.
You can enter a cell or range address in a formula by typing it, or you can select the range with the mouse or 
keyboard so that 1-2-3 enters the address for you. Selecting a range helps you avoid typing errors.

Operators
Operators are mathematical symbols, text characters, or logical statements that tell 1-2-3 what to do with the 
operands in a formula.

Type Operators Descriptio
n

Arithmetic 
operators

+, -, *, /, ^ Symbols 
for 
addition, 
subtraction
, and so on

Text 
operator

& Symbol for
combining 
strings

Logical 
operators

=, <, >, <=, 
>=, <>

Symbols 
for equal 
to, less 
than, and 
so on

#AND#, 
#OR#, 
#NOT#

Words set 
off with # 
that 
evaluate 
conditions

Parentheses
Parentheses let you combine various operations and multiple formulas in one formula. You can use parentheses in 
complex formulas to tell 1-2-3 the order in which you want the formulas calculated.
In the following example, the inside formula is set off from the outside formula with parentheses.

(A1+A2*(A3-A4))/A5



{button ,AL(`H_WHEN_AND_HOW_FORMULAS_RECALCULATE_OVER;H_USING_FORMULAS_OVER;H_ENTER
ING_A_FORMULA_STEPS;H_TYPES_OF_FORMULAS_OVER;H_GUIDELINES_FOR_ENTERING_FORMULAS
_OVER',0)} See related topics



Guidelines for entering formulas
Use these guidelines when entering a formula:

• Formulas can be up to 512 bytes in length.
• A formula can begin with a number or one of these characters: +, -, =, (, @, ., $, or #. 
• When the first element of a formula is a cell address or range name, begin the formula with +, -, =, (, or $.
• When the first character in a text formula is a " (quotation mark), begin the formula with ( or +.
• When a formula looks like a date (for example, 9/25/90), begin the formula with +.
• To enter an @function in a formula, you can select it with the @function selector. You can also type @, press F3 

(NAME), and then select the @function.

Blank cells
1-2-3 assigns the value 0 to blank cells whose addresses are used in formulas and in most @functions except 
statistical and text @functions. Most statistical @functions ignore blank cells, and text @functions using blank cells 
evaluate to ERR.

{button ,AL(`H_COMMON_ERRORS_IN_FORMULAS_OVER;H_ENTERING_A_FORMULA_STEPS;H_ENTERING_
AN_ATFUNCTION_STEPS;H_USING_FORMULAS_OVER;H_TYPES_OF_FORMULAS_OVER;H_PARTS_OF_A
_FORMULA_OVER',0)} See related topics



Entering a formula
You enter a formula in a cell much as you enter any data into a sheet. After you enter a formula in a cell, 1-2-3 
displays the formula in the contents box and the formula's result in the cell.
1. Select the cell where you want to enter the formula.
2. Type + to start the formula.
3. Type operands, operators, and parentheses as needed.
4. To complete the formula, press ENTER.
5. (Optional) To display the result if 1-2-3 displays *** (asterisks), widen the column.
If the formula results in ERR, or 1-2-3 does not accept the formula, check for common errors.

{button ,AL(`H_ENTERING_A_FORMULA_DETAILS',1)} See details
{button ,AL(`H_COMMON_ERRORS_IN_FORMULAS_OVER;H_EDITING_A_FORMULA_STEPS;H_GUIDELINES_

FOR_ENTERING_FORMULAS_OVER;H_PARTS_OF_A_FORMULA_OVER;H_REFERRING_TO_OTHER_FILE
S_IN_FORMULAS_STEPS;H_SIZING_COLUMNS_STEPS;H_USING_RANGE_NAMES_IN_A_FORMULA_STE
PS;H_USING_FORMULAS_OVER;H_USING_RANGE_ADDRESSES_IN_A_FORMULA_STEPS;H_123_PRINTI
NG_CELL_COMMENTS_AND_FORMULAS_STEPS',0)} See related topics



Details: Entering a formula
Calculating numeric formulas
The number of decimal places 1-2-3 displays for a calculated value depends on the number format of the cell. 1-2-3 
calculates the value to a precision of 15 digits regardless of how many it displays. Use an @function, such as 
@ROUND, to specify a precision of less than 15 digits.

Documenting a formula
You can annotate a formula by typing ; (semicolon) immediately after the formula and then typing the note. The note 
appears in the contents box only, unless you format the cell as text.
To add a comment to a cell containing a formula, use Range - Cell Comment.

Using formula markers
You can use formula markers to identify cells that contain formulas. Formula markers are turned off when you first 
start 1-2-3. To turn them on, use View - Set View Preferences.

Printing formulas
When you print a workbook, you can choose to print the formulas along with the cell contents. To print formulas, 
choose File - Preview & Page Setup, click the Include tab, and select "Formulas" in the "Show" list.

Formatting @function results
For selected @functions, 1-2-3 automatically formats the result using the number format of the specified arguments. 
For example, if A1..A4 is formatted as Japanese Yen, and you enter @SUM(A1..A4) in A5, 1-2-3 formats the result in 
A5 as Japanese Yen. 
1-2-3 does not automatically format the @function result if you:

• formatted the cell before entering the @function in it
• specified arguments that are in a different file
• combined an @function that 1-2-3 formats with an @function that 1-2-3 doesn't format

{button ,AL(`H_ENTERING_A_FORMULA_STEPS',1)} Go to procedure
{button ,AL(`;H_CREATING_A_CELL_COMMENT_STEPS;H_PRINT_CHANGING_SELECTION_STEPS;H_SETTIN

G_VIEW_PREFERENCES_FOR_WORKBOOKS_STEPS;H_ENTERING_AN_ATFUNCTION_DETAILS;',0)} See 
related topics



Using range names in a formula
You can use a range name in place of an address in a formula. 
1. Enter the formula up to the operator or ( (open parenthesis) that precedes the range name you want to enter.
2. Type the range name, or click the navigator and select the name from the list.
3. Complete the formula.
Tip When you are writing a formula, you can also press F3 (NAME) to see a list of range names for any active 
workbook.

{button ,AL(`H_USING_RANGE_NAMES_IN_A_FORMULA_DETAILS',1)} See details
{button ,AL(`H_ENTERING_A_FORMULA_STEPS;H_USING_RANGE_ADDRESSES_IN_A_FORMULA_STEPS',0)}

See related topics



Details: Using range names in a formula
If you plan to use a range name in a formula, you can enter it as a placeholder in the formula before you define the 
range name. The formula results in ERR until you define the range name.
To locate and change a range name that appears in formulas, use Edit - Find & Replace.
If you delete a range name that a formula uses, 1-2-3 replaces the range name with its associated address. For 
example, suppose that SALES is the name of B14..H14, and that your sheet contains the formula @SUM(SALES). If 
you delete the name SALES, 1-2-3 changes @SUM(SALES) to @SUM(B14..H14).

{button ,AL(`H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS',1)} Go to procedure



Referring to other workbook files in formulas
Formulas can refer to ranges in other workbook files as well as ranges in the current workbook. These formulas 
create links between workbook files.
Tip You can also create formula links between workbooks by copying the range to the clipboard, and choosing Edit - 
Paste Link.
1. Enter the formula up to the operator or ( (open parenthesis) that precedes the workbook reference.
2. If the other workbook is visible, use the mouse to select the range.

Otherwise, type the workbook reference using this format:
+<<workbook.ext>>range
Substitute the name of the workbook, extension, and range that you want. For example, 
+<<MYWORKBOOK.123>>@SUM(C10..P24)

3. Press ENTER.

{button ,AL(`H_REFERRING_TO_OTHER_FILES_IN_FORMULAS_DETAILS',1)} See details
{button ,AL(`H_ENTERING_A_FORMULA_STEPS;H_USING_FORMULAS_OVER;H_COPYING_DATA_FROM_123

_WITH_DRAG_AND_DROP_STEPS;H_UPDATING_FILE_LINKS_STEPS',0)} See related topics



Details: Referring to other workbook files in formulas
Other ways to specify a range in another workbook file
Press CTRL+PG UP or CTRL+PG DN to go to the other workbook and then use the keyboard to select the range.
If the other workbook is active, and the range you want to select has an assigned name, you can press F3 (NAME), 
choose the workbook from the "In workbook" list, and then select the named range.
When you refer to data in another workbook file using the format <<workbook.ext>>range, you don't need to include 
the path if the file is in the directory for workbook files specified using File - User Setup - 1-2-3 Preferences (File 
Locations tab). Keep in mind that if you move the workbook, you need to update the reference to reflect the 
workbook's new location.

Updating file links
1-2-3 automatically updates all file links when you open a workbook that refers to other active workbooks if 
Recalculation is set to automatic in the workbook that you open. For more information, see Setting recalculation 
defaults. 
If you open a workbook that has links to a workbook on disk, and "Update links when opening workbooks" is not 
turned on with File - User Setup - 1-2-3 Preferences (General tab), you need to update the links manually so the 
workbook uses current data from the linked workbook. To update the links, use Edit - Manage Links. For more 
information, see Updating file links.

{button ,AL(`H_REFERRING_TO_OTHER_FILES_IN_FORMULAS_STEPS',1)} Go to procedure



Editing a formula
1. Double-click the cell containing the formula, or select the cell and press F2 (EDIT).
2. Edit the formula.
3. Press ENTER.

{button ,AL(`H_COMMON_ERRORS_IN_FORMULAS_OVER;H_USING_FORMULAS_OVER',0)} See related topics



Common errors in formulas
If a formula results in ERR, or if 1-2-3 beeps instead of accepting the formula, don't panic. Examine the formula for 
obvious errors such as extra spaces, missing operators, or missing parentheses.

When a formula results in ERR
What happened Try this
You used zero as a 
denominator.

Don't divide by zero.

You used an undefined range 
name or text that you haven't 
yet defined as a range name.

Link the name with an 
address. For more 
information, see Naming a 
range. 

In a text formula, you referred 
to a cell that contains a value.

Correct the formula to refer to 
a cell that contains text.

You referred to a workbook file
that either doesn't exist or isn't
in the default directory.

Re-create the workbook file or
refer to an existing workbook 
file; or include the path to a 
workbook outside the default 
directory.

You moved data into the first 
or last cell of a range that is 
referred to in a formula.

Re-create the overwritten data
in a new location and then edit
the formula to refer to the new
location.

You moved data into the first 
or last cell of a named range 
referred to in the formula.

Re-create the range name, 
and then edit the formula to 
refer to the range name.

There's not enough available 
memory to calculate the 
formula.

Try closing extra windows or 
other applications, or quitting 
and re-opening 1-2-3.

Other problems
What happened Try this
Your numeric formula looks like
a date to 1-2-3, for example 
11/30, or 30-Aug (if Aug is a 
range name).

Enclose the formula in 
parentheses or start it with + 
or =. For example (11/30) or 
+30-Aug.

You entered a formula that 
begins with a range name, and 
it didn't evaluate.

Enclose the formula in 
parentheses or start it with +, 
-, or =.

You entered an address one 
way, for example with a sheet 
address, but 1-2-3 changed the
way the address looks, or 
changed the address to a 
range name.

Don't worry. 1-2-3 sometimes 
adjusts references you enter 
to show what's relevant. For 
example, if you have only one 
sheet, 1-2-3 doesn't show 
sheet letters in the formula. 
This will not hurt your 
formulas.

Finding circular references
A circular reference is a formula that refers directly or indirectly to itself. For example, if you enter the formula +A1+1 
in cell A1, you've created a direct circular reference.
When a formula contains a circular reference, the Circular reference button appears in the status bar. To locate a 
circular reference, click the button. 1-2-3 moves the cell pointer to the first circular reference.



{button ,AL(`H_GUIDELINES_FOR_ENTERING_FORMULAS_OVER',0)} See related topics



Summing a range automatically
You can sum a range of data by entering a recognized SmartLabel.

 Show me a QuickDemo
1. Enter the data in the sheet.
2. To sum columns, select the cell to the left of where you want to display the sums.

To sum rows, select the cell above where you want to display the sums. 
3. Enter the SmartLabel you want to use (total, subtotal, or grand total).
4. Press ENTER.

{button ,AL(`H_SUMMING_A_RANGE_AUTOMATICALLY_DETAILS',1)} See details
{button ,AL(`H_123_CREATING_A_SMARTLABEL_STEPS',0)} See related topics



Details: Summing a range automatically
There are nine SmartLabels: total, subtotal, grandtotal, average, maximum, minimum, median, standard deviation, 
and variance you can use to automatically create a formula below or to the right of a range. For more information, see
Working with SmartLabels.

How does 1-2-3 know what data to sum?
When you enter a SmartLabel such as total, subtotal, or grandtotal in a cell, 1-2-3 checks to see if there are numbers 
in columns above and to the right, or in rows below and to the left.
Note When you create a SmartLabel with a formula that includes @subtotal, 1-2-3 checks that range for any 
previous cells that include @subtotal. If there is a cell containing @subtotal, the range inserted into the SmartLabel's 
formula (in place of the 'list' argument) is a sub-range of the total range, starting from the cell below the previous 
@subtotal.
To sum columns, you must enter total, subtotal, or grandtotal to the left of the range where you want to create the 
sums.

To sum rows, enter total, subtotal, or grandtotal above the range where you want to create the sums.

When you sum columns, you can have up to 10 blank rows between the row where you want the totals to appear and
the numbers in the columns above. 
When you sum rows, you can have up to 10 blank columns between the column where you want the totals to appear 
and the numbers in the rows to the left.

Turning off automatic summing
To turn off automatic summing, deselect "Use SmartLabels to enter formulas and apply formats" on the 1-2-3 
Preferences (General tab). 

Automatic summing won't work if...
• You enter any word other than total, subtotal, grandtotal.
• The cells below (for rows) or to the right of (for columns) where you want to put the sum are not blank.
• You try to sum a 3D range. You must use a formula or @function instead.
• Automatic summing is turned off.

Related SmartIcons

Sums values above or to the left

{button ,AL(`H_SUMMING_A_RANGE_AUTOMATICALLY_STEPS',1)} Go to procedure



Using range addresses in a formula
You can use a cell or range address in a formula. 
1. Enter the formula up to the operator or ( (open parenthesis) that precedes the cell or range address you want to 

enter.
2. Type the cell or range address.
3. Complete the formula.

{button ,AL(`H_USING_RANGE_ADDRESSES_IN_A_FORMULA_DETAILS',1)} See details
{button ,AL(`H_ENTERING_A_FORMULA_STEPS;H_USING_RANGE_NAMES_IN_A_FORMULA_STEPS;H_USIN

G_FORMULAS_OVER',0)} See related topics



Details: Using range addresses in a formula
Other ways to enter a cell or range address in a formula
You can enter a cell or range address in a formula by selecting the range with the mouse or keyboard. When you 
select the range, 1-2-3 enters the address for you.

• To use the mouse, click the cell or drag to select a range.
• To use the keyboard, press , ¯, ¬, ®, or another pointer-movement key to move the cell pointer to the cell. For a 

range, move to a cell at the corner of the range, press . (period), and then use a pointer-movement key to 
highlight the other cells.

{button ,AL(`H_USING_RANGE_ADDRESSES_IN_A_FORMULA_STEPS',1)} Go to procedure



Updating file links
You can update links to all workbook files not in memory.
1. Choose Edit - Manage Links.

2. In the "Link type" list, select "1-2-3 file links."
3. Select the link you want to update.
4. Click Update All Now.
5. Click Done.

{button ,AL(`H_UPDATING_FILE_LINKS_DETAILS',1)} See details
{button ,AL(`;H_REFERRING_TO_OTHER_FILES_IN_FORMULAS_STEPS;H_UPDATING_LINKS_STEPS;H_USIN

G_FORMULAS_OVER',0)} See related topics



Details: Updating file links
Automatically updating file links
1-2-3 automatically updates all file links when you open a workbook that refers to other active workbooks if 
Recalculation is set to automatic in the workbook that you open. For more information, see Setting recalculation 
defaults.

{button ,AL(`H_UPDATING_FILE_LINKS_STEPS',1)} Go to procedure



Working with SmartLabels
Using SmartLabels, you can automatically create formulas below or to the right of a range by entering a recognized 
label. These labels can have formulas, number formats, and synonyms associated with them. You can also customize
the SmartLabels 1-2-3 provides or create your own SmartLabels.
SmartLabels are saved as part of 1-2-3, rather than the current workbook, so you can use SmartLabels with any 
workbook file. SmartLabels are case insensitive.

Predefined SmartLabels
There are nine predefined you can use to automatically create a formula below or to the right of a range. By default, 
SmartLabels do not apply number formats.

Label Formula Format Synonyms
total @sum(list) None totals
subtotal @subtotal(list) None sub total
grandtotal @grandtotal(list) None grand total
average @avg(list) None avg
maximum @max(list) None max
minimum @min(list) None min
median @median(list) None
standard 
deviation

@std(list) None std

variance @var(list) None var

Turning off SmartLabels
You can turn off SmartLabels by choosing File - User Setup - 1-2-3 Preferences and deselecting "Use SmartLabels to
enter formulas and apply formats." For more information, see Details: Setting 1-2-3 Options.

How does 1-2-3 know what data to sum?
When you enter a SmartLabel such as total, subtotal, or grandtotal in a cell, 1-2-3 checks to see if there are numbers 
in columns above and to the right, or in rows below and to the left.
To sum columns, you must enter total, subtotal, or grandtotal to the left of the range where you want to create the 
sums.

To sum rows, enter total, subtotal, or grandtotal above the range where you want to create the sums.

When you sum columns, you can have up to 10 blank rows between the row where you want the totals to appear and
the numbers in the columns above. 
When you sum rows, you can have up to 10 blank columns between the column where you want the totals to appear 
and the numbers in the rows to the left.

Automatic summing won't work if...
• You enter any word other than total, subtotal, grandtotal.
• The cells below (for rows) or to the right of (for columns) where you want to put the sum are not blank.
• You try to sum a 3D range. You must use a formula or @function instead.



• Automatic summing is turned off.

{button ,AL(`H_123_CREATING_A_SMARTLABEL_STEPS;H_123_EDITING_A_SMARTLABEL_STEPS;H_123_DE
LETING_A_SMARTLABEL_STEPS',0)} See related topics



SmartLabels Setup dialog box
Use this dialog box to create a custom SmartLabel or modify an existing SmartLabel.

Choose a task
Creating a SmartLabel
Editing a SmartLabel
Deleting a SmartLabel

{button ,AL(`H_CREATING_CUSTOM_FILL_LISTS_OVER;H_Filling_Ranges_OVER',0)} See related topics



Creating a SmartLabel
1. From the File menu, choose User Setup, and then choose SmartLabels Setup.
2. Type a name for the custom SmartLabel in the "SmartLabel text" box.
3. (Optional) Select a number format.
4. Specify a formula for the SmartLabel.

• You can type a formula in the "Formula" box.
• You can click the "Select @Function" button to select the @function you want to use for the formula.

5. Click Add to add the new SmartLabel to the "All SmartLabels" box.
6. Click Done.

{button ,AL(`H_123_CREATING_A_SMARTLABEL_DETAILS',1)} See details
{button ,AL(`H_123_SELECTING_A_FUNCTION_FOR_A_SMARTLABEL_STEPS;H_123_WORKING_WITH_SMAR

TLABELS_OVER',0)} See related topics



Details: Creating a SmartLabel
SmartLabel text
Type a name for the SmartLabel. 

All SmartLabels
All defined SmartLabels are listed in alphabetical order. When you select one of the SmartLabels in this list, 1-2-3 
displays all the information associated with that SmartLabel in the appropriate fields.

Number format
Select the format you want to apply when the SmartLabel name is typed into the sheet. These formats correspond to 
the formats listed in the Frequently Used List on the Number format tab of the Range InfoBox. This list also appears 
on the status bar. 

Decimals (spinner)
The default number format for a new SmartLabel is "None." If you select a format that requires decimals (Fixed, 
Scientific, Comma, Currency, Currency ISO, or Percent), the "Decimals" box appears.
Specify the number of decimal places you want to use. If you specify "0," decimal points and all numbers after them 
are removed. If you specify any other value, 1-2-3 adds the specified number of decimal places after the final numeric
digit in each relevant condition of the code string.

Formula
Specify the formula you want to apply when the SmartLabel is typed into the sheet. 
SmartLabels work best for list functions that work on values. For example, if you create a SmartLabel that uses 
@COUNT, and then try to use that SmartLabel on a column that contains only labels, nothing happens when you 
type the SmartLabel. 
If you specify a SmartLabel in the sheet which uses an incorrect formula, 1-2-3 displays "ERR" in the cells of the 
target range. For more information, see Common errors in formulas.

@Function button
Displays the Select @Function dialog box which lists @functions that use a "list" argument. For more information 
about @functions, see Overview: @Functions

Synonyms
Displays all of the SmartLabels that use the same format and formula as the SmartLabel selected in the "SmartLabel 
Text" box.

{button ,AL(`H_123_CREATING_A_SMARTLABEL_STEPS',1)} Go to procedure
{button ,AL(`H_123_SELECTING_A_FUNCTION_FOR_A_SMARTLABEL_STEPS;',0)} See related topics



Selecting an @function for a SmartLabel
Use the Select @Function dialog box to select an @function to use as the formula for the SmartLabel. 
1. In the "@Functions" box, select the @function you want to associate with the SmartLabel.

The available @functions use a "list" argument, which works best, but you can use other @functions if you 
want.
Tip To see detailed information about the selected @function, click Help.

2. Click OK to return to the SmartLabels Setup dialog box. 



Editing a SmartLabel
You can change the predefined SmartLabels that come with 1-2-3. 
Note If you decide you want to reset a SmartLabel back to its original state, see Working with SmartLabels for a list 
of the predefined SmartLabels. 
1. From the File menu, choose User Setup, and then choose SmartLabels Setup.
2. Select the SmartLabel you want to edit from the "All SmartLabels" box.
3. Change the SmartLabel text, number format, or formula associated with the SmartLabel.
4. Click Modify.
5. Click Done.

{button ,AL(`H_123_SELECTING_A_FUNCTION_FOR_A_SMARTLABEL_STEPS;H_123_WORKING_WITH_SMAR
TLABELS_OVER',0)} See related topics



Deleting a SmartLabel
1. From the File menu, choose User Setup, and then choose SmartLabels Setup.
2. Select the SmartLabel you want to delete from the "All SmartLabels" box.
3. Click Delete.
4. Click Done.

{button ,AL(`H_123_WORKING_WITH_SMARTLABELS_OVER',0)} See related topics



Overview: Using SmartIcons
SmartIcons are buttons that represent mouse shortcuts for 1-2-3 actions and commands. When you first load 1-2-3, a
set of SmartIcons appears in a bar at the top of the workspace.

To use an icon, simply click it.
To tell you what an icon does, bubble help appears by default when you position the mouse pointer over an icon. You 
can hide or show SmartIcons bubble help, or the set of SmartIcons.

Sets of SmartIcons
You can display several sets of icons at a time.
The set of icons that appears in the workspace changes depending on what is currently selected. For example, the 
set of icons that appears when a range is selected is different from the set that appears when a chart is selected.    
You can change which set of SmartIcons is displayed at any given time.
You can also change the position of each set of SmartIcons in the workspace.

{button ,AL(`H_HIDING_AND_SHOWING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_IN_THE_WORKSP
ACE_STEPS;H_SELECTING_AND_DISPLAYING_A_SET_OF_SMARTICONS_STEPS;H_HIDING_AND_SHOWI
NG_BUBBLE_HELP_STEPS;H_SIZING_SMARTICONS_STEPS;H_CUSTOMIZING_SMARTICONS_OVER;',0)} 
See related topics



Hiding and showing a set of SmartIcons
You can hide or show SmartIcons by doing one of the following:

• Choose View - Hide/Show SmartIcons.
• Click the Control menu for the set of SmartIcons, located at the far left of the set, or click the right mouse button 

when the pointer is on the set. Then choose to hide the particular set of SmartIcons, or all SmartIcons.

{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_PLACING_SMARTICO
NS_IN_THE_WORKSPACE_STEPS;H_SELECTING_AND_DISPLAYING_A_SET_OF_SMARTICONS_STEPS;',
0)} See related topics



Selecting and displaying a set of SmartIcons
You can choose which set of SmartIcons to display, and when each set is displayed.
1. Choose File - User Setup - SmartIcons Setup.

2. Under Bar to setup, choose the set of SmartIcons to display from the "Bar name" list.
3. Select an option from the "Bar can be displayed when context is" list.
4. Make sure "Bar is enabled to display during its context" is selected.
5. Click OK.

{button ,AL(`H_SELECTING_AND_DISPLAYING_A_SET_OF_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_HIDING_AND_SHOWING_SMARTICONS_STEPS;H_PLACING_SMARTICONS_IN_THE_WORKSP

ACE_STEPS;H_USING_SMARTICONS_OVER',0)} See related topics



Details: Selecting and displaying a set of SmartIcons
Options for setting up SmartIcons bars

• Bar name -- When you select a set of SmartIcons from this list, the set appears across the top of the dialog box.
• Bar can be displayed when context is -- You can decide when to display a set of SmartIcons: always; when you're

working in a range, a sheet, a chart, a map, a drawing, a web table, a query table, an OLE server, or an OLE 
object; or when you're using print preview.
For example, you are working with a map and want a custom set of map SmartIcons to display. First, select the 
custom set of SmartIcons in the "Bar name" list. Then select "A Map" from the "Bar can be displayed when 
context is" list.    Now you can display the custom set when you're working on a map.

• Bar is enabled to display during its context -- This option acts as an on/off display switch. If selected, it displays a 
specific set of SmartIcons whenever you're working with a specific type of data. Deselect this option to turn off the
display of a specific set of SmartIcons.

{button ,AL(`H_SELECTING_AND_DISPLAYING_A_SET_OF_SMARTICONS_STEPS',1)} Go to procedure



Moving a set of SmartIcons
You can move a set of SmartIcons wherever you want on the desktop.
1. Position the mouse pointer under the Control menu at the far left of the displayed set of SmartIcons.

The mouse pointer changes to the shape of a hand.
2. Drag the set of SmartIcons to the new location.
3. Release the mouse button.

{button ,AL(`H_PLACING_SMARTICONS_IN_THE_WORKSPACE_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_HIDING_AND_SHOWI

NG_SMARTICONS_STEPS;H_SELECTING_AND_DISPLAYING_A_SET_OF_SMARTICONS_STEPS',0)} See 
related topics



Details: Moving a set of SmartIcons
Moving the set of SmartIcons to a fixed position
You can position SmartIcons at the edges of the 1-2-3 window in a fixed position (left, right, top, or bottom). If you 
drag the SmartIcons bar to an edge, it will snap to and stay with that edge, even when the 1-2-3 window is moved.

Moving the set of SmartIcons to a floating position
You can display SmartIcons in a floating position anywhere inside or outside the 1-2-3 window. Dragging SmartIcons 
to a place other than an edge creates a floating palette. You can also drag one set of SmartIcons over another.

{button ,AL(`H_PLACING_SMARTICONS_IN_THE_WORKSPACE_STEPS',1)} Go to procedure



Overview: Customizing SmartIcons
1-2-3 includes many standard SmartIcons and sets of SmartIcons. You can use the icons and sets of icons as they 
are, or you can change them to suit your needs. You can create and edit custom icons to be part of a standard 1-2-3 
set, or you can create custom sets of SmartIcons. You can also:

• Add SmartIcons to a set
• Move SmartIcons within a set
• Remove SmartIcons from a set
• Delete individual SmartIcons or entire sets of SmartIcons
• Save new or changed SmartIcons and sets of SmartIcons
• Attach scripts or macros to SmartIcons

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS;H_CREATING_AN_ICON_STEPS;H_
EDITING_AN_ICON_STEPS;H_MOVING_AN_ICON_WITHIN_A_SET_OF_SMARTICONS_STEPS;H_REMOVIN
G_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_SAVING_A_SET_OF_SMARTICONS_STEPS;H_A
TTACHING_A_SCRIPT_TO_AN_ICON_STEPS;H_DELETING_A_SET_OF_SMARTICONS_STEPS;',0)} See 
related topics



Adding an icon to a set of SmartIcons
You can add an icon to a set of SmartIcons.
1. Choose File - User Setup - SmartIcons Setup.

2. From the "Bar name" list, select the set of SmartIcons to which you want to add the icon.
3. Click an icon in the "Available icons" list.
4. Drag the selected icon to the position you want in the displayed set.
5. Do one of the following:

• Click Save Set if you want to save the modified set of SmartIcons with a new name.
• Click OK to save the modified set with the current name, and display the modified set.

Note When you click OK, 1-2-3 replaces the old set of SmartIcons with the modified set. If you think you will want
to use the old set again, click Save Set and give the modified set a different name.

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_MOVING_AN_ICON_WITHIN_A_SET_OF_SMARTICON

S_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_STEPS;H_SAVING_A_SET_OF_SMA
RTICONS_STEPS;',0)} See related topics



Details: Adding an icon to a set of SmartIcons
Positioning an icon in the set
To position the new icon before an icon that already appears in the set, drag the new icon to the left of that icon.
To position the new icon after an icon that already appears in the set, drag the new icon to the right of that icon.

Adding a spacer icon
You can also add a spacer icon, which helps you to visually group the icons in the set.

{button ,AL(`H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_STEPS',1)} Go to procedure



Creating an icon
You create a new icon by editing and renaming a standard 1-2-3 icon, or by creating a new icon from scratch. When 
you save an icon, you give it a file name with the .BMP file extension.
1. Choose File - User Setup - SmartIcons Setup.

2. Click Edit Icon.
3. Click Create a New Blank Icon to create a new icon, or select an icon to modify from the "Available icons you can 

edit or copy" list.
4. Use the mouse buttons to apply or change colors.
5. Enter the icon's bubble help in the "Description" box.
6. Click Save As to name and save the new icon.
7. Attach a macro or script to the icon that will run when the icon is clicked.
8. If you make further changes to the icon, click Save to preserve the changes.
9. Click Done to return to the SmartIcons Setup dialog box.

The new icon appears in the list of available icons.
10. Click OK.

{button ,AL(`H_CREATING_AN_ICON_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_EDITING_AN_ICON_S

TEPS;',0)} See related topics



Details: Creating an icon
Applying colors
You create or edit an icon by applying or changing color. To select a color, click the "Left" or "Right" box under Mouse 
button colors and click a color from the palette that appears.

To apply the color, use the left or right mouse button and click where you want to apply color on the icon under 
"Picture editor." 1-2-3 applies the color and updates the Preview icon as you go along.

Starting from scratch
To create a new custom icon, click Create a New Blank Icon. 1-2-3 displays a blank icon under "Picture editor."

Creating a new icon from an existing one
To create a new icon based on an existing one, select an icon from the "Available icons you can edit or copy" list. If 
you select a standard 1-2-3 icon, 1-2-3 copies the icon, but not the file name, and displays it under "Picture editor." 
You must give this icon a new file name when you save it.

{button ,AL(`H_CREATING_AN_ICON_STEPS',1)} Go to procedure



Editing an icon
You can modify an existing custom icon by changing the icon's picture, colors, bubble help, or the attached script or 
macro. While you cannot modify the standard 1-2-3 SmartIcons, you can create a custom icon by copying a standard 
icon and modifying the copy.
1. Choose File - User Setup - SmartIcons Setup.

2. Click Edit Icon.
3. Select the icon in the "Available icons you can edit or copy" list.

The icon appears under "Picture editor."
4. Edit the icon by using the mouse buttons to apply or change colors.
5. (Optional) Change the icon's bubble help in the "Description" box.
6. Click Save As to name and save the new icon.
7. Attach a macro or script to the icon that will run when the icon is clicked.
8. If you make any further changes to the icon, click Save to preserve the changes.
9. Click Done to return to the SmartIcons Setup dialog box.

The new icon appears in the list of available icons.
10. Click OK.

{button ,AL(`H_EDITING_AN_ICON_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_CREATING_AN_ICON_STEPS;',0)} See related topics



Details: Editing an icon
Applying colors
You edit an icon by applying or changing color. To select a color, click the "Left" or "Right" box under Mouse button 
colors and click a color from the palette that appears.

To apply the color, use the left or right mouse button and click where you want to apply color on the icon under 
"Picture editor." 1-2-3 applies the color and updates the the Preview icon as you go along.

{button ,AL(`H_EDITING_AN_ICON_STEPS',1)} Go to procedure



Moving an icon within a set of SmartIcons
You can move an icon to a new position within a set of SmartIcons.
Tip If the set of SmartIcons containing the icon you want to move is displayed in the 1-2-3 window, hold down CTRL +
drag the icon to its new position in the displayed set.
1. Choose File - User Setup - SmartIcons Setup.

2. From the "Bar name" list, select the set of SmartIcons that contains the icon you want to move.
3. Click the icon you want to move, and drag it to its new location in the set of SmartIcons.
4. Do one of the following:

• Click Save Set if you want to save the modified set of SmartIcons with a new name.
• Click OK to save the modified set with the current name, and display the modified set.

Note When you click OK, 1-2-3 replaces the old set of SmartIcons with the modified set. If you think you will want
to use the old set again, click Save Set and give the modified set a different name.

{button ,AL(`H_MOVING_AN_ICON_WITHIN_A_SET_OF_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICO

NS_STEPS;H_SAVING_A_SET_OF_SMARTICONS_STEPS;H_ADDING_AN_ICON_TO_A_SET_OF_SMARTIC
ONS_STEPS',0)} See related topics



Details: Moving an icon within a set of SmartIcons
You don't need to be in the SmartIcons Setup dialog box to move an icon within a set of SmartIcons. Just hold CTRL 
as you drag the icon to its new position within a set of SmartIcons in your workspace.

{button ,AL(`H_MOVING_AN_ICON_WITHIN_A_SET_OF_SMARTICONS_STEPS',1)} Go to procedure



Removing an icon from a set of SmartIcons
You can remove an icon from a set of SmartIcons.
1. Choose File - User Setup - SmartIcons Setup.

2. From the "Bar name" list, select the set of SmartIcons that contains the icon you want to remove.
3. Click the icon you want to remove, and drag it off the set.
4. Do one of the following:

• Click Save Set if you want to save the modified set of SmartIcons with a new name.
• Click OK to save the modified set with the current name, and display the modified set.

Note When you click OK, 1-2-3 replaces the old set of SmartIcons with the modified set. If you think you will want
to use the old set again, click Save Set and give the modified set a different name.

{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_ADDING_AN_ICON_TO_A_SET_OF_SMARTICONS_ST
EPS;H_SAVING_A_SET_OF_SMARTICONS_STEPS;',0)} See related topics



Deleting a set of SmartIcons
If you delete a set of SmartIcons, 1-2-3 deletes the set but not the individual icons.
1. Choose File - User Setup - SmartIcons Setup.

2. Click Delete Set.
3. Select the set(s) of SmartIcons you want to delete.
4. Click OK.

1-2-3 deletes the selected sets of SmartIcons and returns you to the SmartIcons Setup dialog box.
5. Click OK.

{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_SAVING_A_SET_OF_S
MARTICONS_STEPS;',0)} See related topics



Saving a set of SmartIcons
You can save a modified set of SmartIcons with the current name or a new name. You can also save a custom set of 
SmartIcons.
1. Choose File - User Setup - SmartIcons Setup.

2. Select a set of SmartIcons from the "Bar name" list.
3. Add, move, or remove icons to create the set you want.
4. Click Save Set.

1-2-3 asks if you want to overwrite the current set, or create a new one.
5. Do one of the following:

• Click Overwrite to save the changed set of SmartIcons under the current name. Go to step 9.
• Click Save As New to save the set of SmartIcons under a new name. Go to step 6.

6. Enter a name for the set of SmartIcons in the "SmartIcons bar name" box.
7. Enter a new file name in the "SmartIcons file name" box.
8. (Optional) Click Browse to change the directory in which 1-2-3 saves the new set of SmartIcons.
9. Click OK.

1-2-3 saves the set of SmartIcons and returns you to the SmartIcons Setup dialog box.
10. Click OK.

{button ,AL(`H_SAVING_A_SET_OF_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_USING_SMARTICONS_OVER;H_CUSTOMIZING_SMARTICONS_OVER;H_ADDING_AN_ICON_T

O_A_SET_OF_SMARTICONS_STEPS;H_DELETING_A_SET_OF_SMARTICONS_STEPS;H_MOVING_AN_ICO
N_WITHIN_A_SET_OF_SMARTICONS_STEPS;H_REMOVING_AN_ICON_FROM_A_SET_OF_SMARTICONS_
STEPS;',0)} See related topics



Details: Saving a set of SmartIcons
Naming a set of SmartIcons
When you save a set of SmartIcons, the name appears in the "Bar name" list in the SmartIcons Setup dialog box.
You save a set of SmartIcons as an .SMI file. You save a custom icon as a .BMP file.

{button ,AL(`H_SAVING_A_SET_OF_SMARTICONS_STEPS',1)} Go to procedure



Changing the display size of SmartIcons
You can change the default display size for SmartIcons.
1. Choose File - User Setup - SmartIcons Setup.

2. Under SmartIcons preferences, select a size in the "Icon size" list.
3. Click OK.

{button ,AL(`H_SIZING_SMARTICONS_DETAILS',1)} See details
{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;',0)} See related topics



Details: Changing the display size of SmartIcons
Selecting the size
You may want to change the displayed size of SmartIcons based on the type of display adaptor and monitor you use, 
or just to make it easier to see them clearly. By default, SmartIcons are displayed as Regular. You can change the 
display size to Large.

{button ,AL(`H_SIZING_SMARTICONS_STEPS',1)} Go to procedure



SmartIcons Setup dialog box
You can review all sets of SmartIcons from this dialog box by selecting the icon sets from the "Bar name" list one at a 
time. The SmartIcons set you select appears at the top of the dialog box.
You can then add, move, and remove icons in the set, and save or delete sets of SmartIcons. You can also create 
and edit custom icons from this dialog box.

Choose a task
Adding an icon to a set of SmartIcons
Moving an icon within a set of SmartIcons
Removing an icon from a set of SmartIcons
Selecting and displaying a set of SmartIcons
Hiding and showing a set of SmartIcons
Hiding and showing bubble help
Changing the display size of SmartIcons

{button ,AL(`;H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER;H_CREATING_AN_ICON
_STEPS;H_EDITING_AN_ICON_STEPS;H_DELETING_A_SET_OF_SMARTICONS_STEPS;H_SAVING_A_SET
_OF_SMARTICONS',0)} See related topics



Attaching a script or macro to an icon
You must attach a script or macro to a custom icon before you can use the icon.
Note To run a script attached to an icon, you must open the script file first. To change the script attached to an icon, 
click Detach first, and then attach the new script.
1. Choose File - User Setup - SmartIcons Setup.

2. Click Edit Icon.
3. Create or edit the icon.
4. Save and name the new icon.
5. Click Attach Script.
6. Select "Script" or "Macro."
7. Select the script or enter the macro you want to attach to the icon.
8. Click Attach to return to the Edit SmartIcons dialog box.
9. Enter the icon's bubble help in the "Description" box if you haven't already.
10. Click Save.
11. Click Done to return to the SmartIcons Setup dialog box, and then click OK.

{button ,AL(`H_CREATING_AN_ICON_STEPS;H_CUSTOMIZING_SMARTICONS_OVER;H_EDITING_AN_ICON_S
TEPS;',0)} See related topics



Edit SmartIcons dialog box
You can create, edit, attach scripts and macros to, and save icons from this dialog box. You must attach a script or 
macro to a custom icon to use the icon.

Choose a task
Creating an icon
Editing an icon
Attaching a script or macro to an icon

{button ,AL(`H_CUSTOMIZING_SMARTICONS_OVER;H_USING_SMARTICONS_OVER',0)} See related topics



Hiding and showing bubble help
By default, 1-2-3 automatically displays bubble help when you position the mouse pointer over a particular icon or 
InfoBox tab. You can hide the bubble help if you want.
1. Choose File - User Setup - SmartIcons Setup.

2. Under SmartIcons preferences, do one of the following:
• Deselect "Show icon descriptions" to hide the bubble help.
• Select "Show icon descriptions" to show the bubble help.

3. Click OK.

{button ,AL(`H_USING_SMARTICONS_OVER;H_CUSTOMIZING_SMARTICONS_OVER;',0)} See related topics



Overview: 1-2-3 macros
A macro is a series of commands that automates a 1-2-3 task. You can use macros to automate repetitive tasks, 
streamline complex procedures, and create applications based on 1-2-3.

Creating macros
You create a macro by entering macro commands in a sheet. You can create macros to use just once or to use over 
and over again. 

 See related topics

Running and debugging macros
You run macros either by explicitly starting them or by having them start automatically when you open a workbook. If 
a macro you create doesn't work correctly, you need to find the error and fix it, a process called debugging. 
Note You cannot undo macros.

 See related topics

Using LotusScript
You can also automate your work using LotusScript, a scripting language built into all Lotus SmartSuite products. 
Using LotusScript, you can record keystrokes, mouse actions, and menu commands. LotusScript comes with a 
complete development environment for creating, debugging, and running scripts.
You can combine macros and scripts. You can also rewrite your macros in LotusScript.

 See related topics

Getting additional Help on macros
1-2-3 provides Help that explains how to use macros, but does not come with Help on individual macro commands. 
However, you can use the World Wide Web or call Lotus Customer Support to get macro command Help. See 
Installing Help on macro commands.

{button ,AL(`H_MACRO_COMPATIBILITY_OVER;H_123_RELEASE_5_MACRO_COMMAND_EQUIVALENTS_OVE
R;H_OBSOLETE_MACINTOSH_MACROS_OVER',0)} See related topics



Parts of a macro
A macro command contains three parts: a keyword, arguments, and argument separators. A macro is made up of one
or more macro commands.

Keyword
The first word in a macro command is the keyword, the macro command name. The keyword tells 1-2-3 what action 
to perform.

Arguments
An argument is the information you want 1-2-3 to use when it performs the command. Depending on the particular 
macro, an argument can be a single value, a range of cells, text, or a formula. 
Arguments can be required or optional. You must enter required arguments, but you can omit the optional ones. 
Optional arguments are enclosed in [ ] (brackets) in the descriptions you see in the Macro Keywords dialog box and 
in the Help on individual macro commands.
If a macro contains more than one optional argument, you must use the arguments sequentially. You can't use an 
optional argument without using the optional arguments that precede it. You can, however, use an optional argument 
without using subsequent optional arguments.

Argument separators
When you use more than one argument with a macro, you separate the arguments with an argument separator, 
typically a ; (semicolon). You can specify a different argument separator using the regional settings (country settings) 
in your operating system.

Quotation marks
Quotation marks enclose the text for text arguments. For example, the following macro uses the text argument Sales 
Forecast:

{EDIT-FIND "Sales Forecast"}
1-2-3 assumes that text not enclosed in quotation marks is a range name.

{button ,AL(`H_ARGUMENT_TYPES_OVER;H_CHANGING_THE_ARGUMENT_SEPARATOR_STEPS;H_INSTALLI
NG_MACRO_REFERENCE_HELP_STEPS',0)} See related topics



Writing a macro
You write macros by entering macro commands, with their arguments, in consecutive cells of a sheet. 
1. Select the cell where you want to enter a macro command.
2. Type {
3. Press F3 (NAME) to display the Macro Keywords dialog box.
4. If you know the category of the macro command you want, select it in the "Category" list.
5. Select the keyword from the "Macro keywords" list.
6. Click OK.

The macro command, with argument placeholders, appears in the cell. 
7. Replace any argument placeholders with the appropriate arguments.
8. Press ENTER.
9. Repeat these steps for each command in the macro.
After you create the macro, you can assign it a name, document it, and save it.

{button ,AL(`H_WRITING_A_MACRO_DETAILS',1)} See details
{button ,AL(`H_COMMON_ERRORS_IN_MACROS_OVER;H_NAMING_AND_DOCUMENTING_A_MACRO_STEPS

;H_SAVING_A_MACRO_STEPS;H_SYNTAX_RULES_FOR_MACROS_OVER;H_PARTS_OF_A_MACRO_OVER
;H_123_MACROS_OVER;H_ARGUMENT_TYPES_OVER;H_CALLING_A_SCRIPT_FROM_A_MACRO_STEPS;'
,0)} See related topics



Details: Writing a macro
You can enter macro commands in the workbook where you store your work or in a macro library, a workbook where 
you store only macros.

Entering macros by typing
You can also enter a macro command by typing the keyword and the appropriate arguments directly in the cell, and 
enclosing the entire expression in { } (braces).

Entering multiple macro commands in one cell
You can enter more than one command in a cell, up to 512 characters. In most cases, however, it's best to enter one 
command per cell, to make the macro easier to read and debug. Some commands, such as the {IF} command, must 
be followed by at least one more command in the same cell.

Checking the syntax of the macro
1-2-3 doesn't check the syntax of a macro command until you run the macro containing the command. When you run 
a macro that has incorrect syntax, 1-2-3 displays a message with the name and location of the incorrect command. 
You can use this information to debug the macro.

Using a macro with just one workbook
If you use a macro with only one workbook, it's simplest to enter the macro in that workbook, along with the data the 
workbook contains. However, when entering data, you must be careful not to overwrite your macros, and vice versa. 
To keep your data and macros intact, follow these guidelines:

• Put macros in a separate sheet rather than in a sheet containing other data. You can name the sheet to make it 
easier to find.

• If you want to put macros and other data in the same sheet, put the macros below and to the right of the data 
area. If you don't, inserting or deleting rows and columns in the data area may damage your macros.

If you put the macros and other data in the same sheet, name a cell at the beginning of the macros area with a range 
name such as Macros. This convention makes it easier to move between the macros area and the data area.

Using a macro with several workbooks
If you use a macro with several workbooks, you can store the macro in a macro library. A macro library is a workbook 
that contains only macros. You can organize a macro library by using a separate sheet for each group of related 
macros.
The macro library workbook must be active before you can run a macro stored there. However, you run the macro 
from the workbook you want it to work on.

{button ,AL(`H_WRITING_A_MACRO_STEPS',1)} Go to procedure



Syntax rules for macros

Starting and ending macros
• Start a macro command with { (open brace), and end it with } (closing brace).
• End a macro with a blank cell or a {QUIT} command.
• Start and end each macro command in the same cell.

Entering macro keywords
• Type the keyword immediately after the open brace, leaving no spaces before the keyword or in the keyword.
• Don't put any spaces between hyphenated words in multi-word keywords, and don't use underscores instead of 

hyphens. 
• You can type the keyword in any combination of uppercase and lowercase letters.

Using spaces
• If you include arguments in the command, separate the keyword from the first argument with one space. If you 

include no arguments, include no spaces.
• Do not leave any spaces between arguments.
• Other than a single space between the keyword and the first argument, the command should have no spaces 

except those that are part of text enclosed in " " (quotation marks).

Using arguments
• If a command includes two or more arguments, use an argument separator to separate each argument from the 

one that follows.
• If you omit an optional argument between two other arguments, enter an argument separator as a placeholder. 

For example, in the macro command {CONTENTS REPORT;INCOME;;117}, the argument separator takes the 
place of the omitted optional argument; 117 is the fourth argument.

• In text arguments, enclose literal text in quotation marks. 1-2-3 reads text not enclosed in quotation marks as a 
range name.

• To enter a quotation mark within text already enclosed in quotation marks, type two quotation marks. For 
example, to make the macro display the text Now using a "Custom" Macro, use the following command: 
{INDICATE "Now using a ""Custom"" Macro"}.

Working with text files
• You must open a text file with {OPEN} before using any other text-file manipulation commands.
• Only one text file can be open at a time. If a text file is open when 1-2-3 reaches an {OPEN} command, 1-2-3 

automatically closes the first text file before opening the new one. If a text file is open when a macro ends, 
however, 1-2-3 does not automatically close the text file. You must include a {CLOSE} command in the macro to 
close the file.

• After successfully executing a text-file manipulation command, 1-2-3 goes directly to the next cell in the macro, 
ignoring any macro instructions after the command in the same cell. If the command returns an error, the macro 
continues in the same cell as the command.

• Although some text-file manipulation commands change the contents of cells, 1-2-3 does not automatically 
recalculate formulas after executing these commands, even when sheet recalculation is set to Automatic. To force
recalculation after a text-file manipulation command, follow the command with {CALC}.

• The first byte-pointer position in a text file is reported as 0, not 1.



{button ,AL(`H_123_MACROS_OVER;H_WRITING_A_MACRO_STEPS;H_COMMON_ERRORS_IN_MACROS_OV
ER;H_PARTS_OF_A_MACRO_OVER;H_CHANGING_THE_ARGUMENT_SEPARATOR_STEPS;H_ARGUMENT
_TYPES_OVER;',0)} See related topics



Naming and documenting a macro
You name a macro so that you can easily identify and run it. You document a macro to help you or others remember 
what the macro does.

Naming a macro
1. Select the first cell of the macro.
2. Choose Range - Name, and enter a name for the macro in the "Name" box.

You can enter either a multiple-character name, just as you would use for a range, or you can enter a backslash 
macro name.

3. Click OK.

Documenting a macro
1. Select the cell immediately to the left of the macro's first cell.
2. If you are documenting a backslash name, type ' (apostrophe) in the cell. 
3. Type the name of the macro, and press ENTER.
4. In the rows above the macro, enter a brief description of the macro's function.
5. (Optional) To document macro commands or subroutines, enter a description in the cells to the right of the 

commands.

{button ,AL(`H_NAMING_AND_DOCUMENTING_A_MACRO_DETAILS',1)} See details
{button ,AL(`H_NAMING_AND_DOCUMENTING_A_MACRO_EX',1)} See example
{button ,AL(`H_123_MACROS_OVER;H_SAVING_A_MACRO_STEPS',0)} See related topics



Details: Naming and documenting a macro
Multiple-character names
A multiple-character name is an ordinary range name. This type of name is convenient for indicating what the macro 
does. You run a range-name macro with ALT+F3 (RUN) or Edit - Scripts & Macros - Run.

Backslash names
A backslash name consists of a \ (backslash) followed by a single letter; for example, \d. To run a macro with a 
backslash name, press CTRL+ the letter; for example, CTRL+D. Naming a macro \0 (backslash zero) creates an 
autoexecute macro that runs automatically every time you open the workbook containing the macro. 
If you use \ (backslash) and a letter to name a macro, and this letter corresponds to a keyboard shortcut using CTRL+ 
the letter, then the macro overrides the keyboard shortcut. For example, the keyboard shortcut for copying the current
selection is CTRL+C. If you name a macro \c, pressing CTRL+C will run the macro instead of copying the current 
selection.

Duplicate names
When naming your macros, be careful not to use names that duplicate built-in 1-2-3 script commands, macro 
commands, or key names. For example, if you name a macro PRINT and later try to use the 1-2-3 {PRINT} macro 
command, 1-2-3 will run your macro and not the 1-2-3 {PRINT} macro.
If you assign a name to a macro that is the same as a shortcut for a global script, 1-2-3 will run the script. For 
example, if you name a macro \d and also assign \d as the shortcut to a script, pressing CTRL+D will run the script, 
not the macro.
If you try to run a macro when macros with the same name exist in two or more active workbooks, 1-2-3 runs the 
macro in the current workbook.    

{button ,AL(`H_NAMING_AND_DOCUMENTING_A_MACRO_STEPS',1)} Go to procedure
{button ,AL(`H_CREATING_AN_AUTOEXECUTE_MACRO_STEPS;',0)} See related topics



Example: Documenting a macro
The following sheet shows a small macro and its documentation. The macro name is documented to the left of the 
macro, the description of the macro appears above, and each command has a short description to the right:
A       B                                     C
        This macro enters the company name in the current cell

Company {CELL-ENTER "Howard's Fancy Hats"}    Enters name
        {STYLE-FONT-ALL "CaslonOpenFace";24}  Sets font and point size
        {COLUMN-WIDTH 30}                     Widens column to fit



Saving a macro
It's a good idea to save a new macro before you run it for the first time. You save a macro the same way you save 
any other data: save the workbook containing the macro.
1. Make sure the cell pointer is in the workbook you want to save.
2. Choose File - Save to save the workbook containing the macro.

{button ,AL(`H_123_MACROS_OVER;H_SAVING_A_NEW_WORKBOOK_STEPS;H_SAVING_AN_EXISTING_FILE
_STEPS;',0)} See related topics



Running a macro
To make a macro perform the commands you entered, you run it. The workbook containing the macro must be active 
before you can run a macro in that workbook.
Caution You cannot undo a macro.
1. If necessary, move the cell pointer to the sheet area you want the macro to act on.
2. Choose Edit - Scripts & Macros - Run.

3. Select "Macro."
4. If the macro you want is in a different workbook, select that workbook in the "From" list.
5. Do one of the following:

• In the "Range" box, type the range name or address of the macro to run or use the range selector to specify 
the range.

• Select the macro name from the list of range names.
6. Click Run.
Note If the macro doesn't run as expected, or if you see a message when you run the macro, you need to debug the 
macro to find and fix the problem.

{button ,AL(`H_RUNNING_A_MACRO_DETAILS',1)} See details
{button ,AL(`H_123_MACROS_OVER;H_DEBUGGING_A_MACRO_STEPS;H_COMMON_ERRORS_IN_MACROS_

OVER;H_STOPPING_A_RUNNING_MACRO_STEPS;H_123_RUNNING_A_SCRIPT_STEPS;',0)} See related 
topics



Details: Running a macro
Other ways to run a macro
To run an unnamed macro, select the first cell of the macro and press ALT+F3 (RUN).
To run a backslash macro, press CTRL and the single-letter name simultaneously. For example, to run a macro 
named \a, press CTRL+A. The macro overrides any keyboard shortcut assigned to that letter.

Recalculating during a macro
Whether 1-2-3 recalculates formulas while a macro is running depends on the recalculation setting in the most 
recently opened workbook.

• When you set recalculation to Manual, 1-2-3 recalculates formulas only when it encounters a {CALC}, {RECALC},
or {RECALCCOL} command in a macro, or when you press F9 (CALC) during an interactive macro.

• When you set recalculation to Automatic, 1-2-3 recalculates formulas automatically whenever a command in a 
macro changes data in the workbook, with the exceptions noted below.

In general, macros run faster with recalculation set to Manual. When recalculation is set to Manual, however, a macro
may produce inaccurate results if the macro changes data and then uses the result of a formula that depends on that 
data. You can avoid inaccurate results by putting a {CALC}, {RECALC}, or {RECALCCOL} command in the macro at 
any point where data is likely to change.

Commands that don't cause automatic recalculation
The following macro commands change data but don't cause an automatic recalculation, even with recalculation set 
to Automatic: 

{ALERT} {FILESIZE} {LET}
{CHOOSE-FILE} {FOR} {LOOK}
{CHOOSE-ITEM} {GET} {PUT}
{CHOOSE-MANY} {GET-FORMULA} {READ}
{CHOOSE-ONE} {GET-LABEL} {READLN}
{CONTENTS} {GET-NUMBER} {SET}
{DEFINE} {GET-RANGE}
{DIALOG} {GETPOS}

Instead of recalculating data immediately after performing one of these commands, 1-2-3 defers recalculation until 
one of the following happens:

• You press ENTER or a pointer-movement key
• A macro command equivalent to ENTER or a pointer-movement key occurs in the macro
• A {CALC}, {RECALC}, or {RECALCCOL} occurs in the macro

{button ,AL(`H_RUNNING_A_MACRO_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_RECALCULATION_DEFAULTS_STEPS',0)} See related topics



Stopping a running macro
While a macro is running, you can't do anything else in 1-2-3. For this reason, you may sometimes want to stop a 
macro while it's running.
1. Press CTRL+BREAK while the macro is running.

Unless the macro contains a {BREAKOFF} command, 1-2-3 stops the macro after it completes the current 
command, and displays a message. 

2. Click OK to clear the message.
3. Resume working in 1-2-3.
Note You can't stop a macro that contains a {BREAKOFF} command. The {BREAKOFF} command prevents users 
from stopping a macro; the {BREAKON} command restores the ability to stop a macro.

{button ,AL(`H_123_MACROS_OVER;H_DEBUGGING_A_MACRO_STEPS;',0)} See related topics



Debugging a macro
Sometimes when you first run a macro, it doesn't do what you expect, or 1-2-3 displays a message. When a macro 
doesn't run correctly, you have to find and fix the problem.
1. Choose Edit - Scripts & Macros - Run.

2. Select "Macro."
3. Do one of the following:

• In the "Range" box, enter the range name or address of the macro to run.
• Select the macro name from the list of range names.

4. Click Step to display the Macro Trace window with the first command displayed.
5. Click Step again to execute the first command in the macro and display the next command.
6. Continue clicking Step to execute each command in the macro, one at a time.

If 1-2-3 encounters an error, it displays a message and stops the macro.
7. (Optional) If a command does not work as expected, click Stop to stop the macro at the cell containing the next 

macro command.
8. When the macro stops, click OK to dismiss the message, if one appears, and edit the macro.
Note Once macro execution stops, you must start executing the macro from the beginning to further debug the 
macro. You cannot continue macro execution where you left off, or correct a macro while it is running.

{button ,AL(`H_DEBUGGING_A_MACRO_DETAILS',1)} See details
{button ,AL(`H_123_MACROS_OVER;H_COMMON_ERRORS_IN_MACROS_OVER;H_SYNTAX_RULES_FOR_MA

CROS_OVER;',0)} See related topics



Details: Debugging a macro
Fixing problems in macros
If 1-2-3 displays a message when you try to run a macro, the problem is usually incorrect syntax, often caused by a 
typing or spelling error. You can correct these errors by editing the macro commands just as you edit any cell entry. 
The message tells you the name and location of the incorrect command.

Running a macro to completion
When using the Macro Trace window, you can run a macro to completion by clicking Continue Execution. You can 
click this button at any time before the macro stops. For example, you might click Step a few times to see how the 
first few commands work, and then click Continue Execution to run the rest of the macro to the end.
If 1-2-3 encounters an error in the macro after you've clicked Continue Execution, it displays a message and stops 
the macro.

{button ,AL(`H_DEBUGGING_A_MACRO_STEPS',1)} Go to procedure



Common errors in macros
When debugging a macro, check for the following common errors.

Typing errors
• Incorrectly spelled keywords, such as {INSERT-COLUMN} instead of {INSERT-COLUMNS}; or misspelled range 

names, such as Profits instead of Profit
• A missing hyphen or extra hyphens in a hyphenated macro keyword
• Underscores ( _ ) instead of hyphens ( - ) in a macro keyword

Extra spaces
Watch for spaces where there shouldn't be any, such as:

• Between the { (open brace) and the keyword in a macro command
• Between arguments
• In an @function within a command
• In a range name
• Before or after a hyphen in a hyphenated word
• As the last character in a cell

Punctuation problems
• Missing braces around a command
• Enclosing a command in ( ) (parentheses) or [ ] (square brackets) instead of { } (braces)
• Missing quotation marks around text arguments that must be enclosed in quotation marks; for example, {CELL-

ENTER Rates;Caption} instead of {CELL-ENTER "Rates";Caption}

Problems with arguments
• Missing required arguments
• Arguments of the wrong type; for example, a text argument where 1-2-3 expects a number
• Missing or misplaced argument separators, such as when you intentionally omit an optional argument between 

two other arguments
• Using an invalid argument separator; see Changing the argument separator for information

 Problems with references
• References to nonexistent ranges
• References to range names that are no longer associated with a range
• Range names or addresses without sheet letters or workbook file references, when you need these to specify a 

location argument

Duplicate names
Watch for script names, macro names, or subroutine names that duplicate macro keywords, such as Quit, Return, or 
Query.

Problems with recalculation
Be careful not to omit a {CALC}, {RECALC}, or {RECALCCOL} command after a macro command that changes data. 
1-2-3 recalculates formulas only when it encounters one of these commands if recalculation is set to Manual.

Macro ends too soon
Make sure your macro doesn't include a blank cell or a cell containing a value, which will end the macro before you 
meant it to.

{button ,AL(`H_123_MACROS_OVER;H_DEBUGGING_A_MACRO_STEPS;',0)} See related topics



Creating a macro that runs automatically
An autoexecute macro is a macro that runs automatically every time you open the workbook containing the macro.
1. Create the macro.
2. Select the first cell of the macro.
3. Choose Range - Name.
4. In the "Name" box, enter \0 (a backslash, followed by a zero), and click OK.
Note  You can have only one autoexecute macro in each workbook.

{button ,AL(`H_CREATING_AN_AUTOEXECUTE_MACRO_DETAILS',1)} See details
{button ,AL(`H_123_MACROS_OVER;H_NAMING_AND_DOCUMENTING_A_MACRO_DETAILS;',0)} See related 

topics



Details: Creating a macro that runs automatically
How the autoexecute setting affects macro results
The result of certain macros depends on the autoexecute setting in File - User Setup - 1-2-3 Preferences (General 
tab). For example, suppose a macro contains a {FILE-OPEN} command that opens a workbook containing an 
autoexecute macro. The macro would give different results depending on the autoexecute setting.

• If "Run file Opened scripts, autoexecute macros" is selected, 1-2-3 opens the workbook and runs the autoexecute
macro, but doesn't resume running the original macro.

• If "Run file Opened scripts, autoexecute macros" is not selected, 1-2-3 opens the workbook and continues 
running the original macro, but doesn't run the autoexecute macro.

Opening multiple files with autoexecute macros
If you open multiple files at once, 1-2-3 checks to see which files contain autoexecute macros. Of those files, 1-2-3 
runs only the macro in the last workbook opened.

Using explicit file names
Macros that do not contain explicit file names always operate on the current workbook. If you open more than one 
workbook at a time, the last workbook opened becomes the current workbook, even if that workbook doesn't have an 
autoexecute macro. When opening multiple files at once, it is possible to execute an autoexecute macro in one 
workbook on data in a different workbook, if that workbook was opened after the workbook containing the macro.
Therefore, if you open multiple files at once, be sure to use explicit file names in your autoexecute macros to ensure 
that the macro will execute against the correct workbook. For example, you should use complete file-name 
references in all range specifications, as in <<myfile>>A:A1..B6.

{button ,AL(`H_CREATING_AN_AUTOEXECUTE_MACRO_STEPS',1)} Go to procedure



Calling a script from a macro
You can call script subroutines from macros.
1. Select the cell where you want to enter the call to the script.
2. Type {
3. If the script is stored in another workbook, enter the name of the workbook file, enclosed in angle brackets (for 

example, <<myfile>>).
4. Enter the name of the script.
5. Type } and press ENTER.
6. Enter any other commands in your macro.

{button ,AL(`H_CALLING_A_SCRIPT_FROM_A_MACRO_DETAILS',1)} See details
{button ,AL(`H_CALLING_A_SCRIPT_FROM_A_MACRO_EX',1)} See example
{button ,AL(`H_123_MACROS_OVER;H_COMMON_ERRORS_IN_MACROS_OVER;H_NAMING_AND_DOCUMEN

TING_A_MACRO_STEPS;H_SAVING_A_MACRO_STEPS;H_SYNTAX_RULES_FOR_MACROS_OVER;H_PAR
TS_OF_A_MACRO_OVER;',0)} See related topics



Details: Calling a script from a macro
Duplicate names
When you call a script from a macro, be careful that your script name does not duplicate the name of a macro 
keyword or a named range.
When you specify a script name in a macro, 1-2-3 first checks whether the name is a macro keyword or a range. If 1-
2-3 finds a macro keyword by the specified name, it evaluates the command as a macro. If 1-2-3 finds a range by that
name, it looks for macro commands at that range. Only if it cannot find a macro keyword or a range name by the 
specified name does 1-2-3 look for a script to execute.

Running a script in another workbook
If your macro calls a script in another workbook, the workbook containing the script must be active when you run the 
macro.

Passing arguments to a script
To pass arguments to a script when you call it from a macro, enter the arguments in standard macro format:
{SCRIPTNAME argument1;argument2;...} 
Note When 1-2-3 is a DDE client, you cannot run a macro that calls a script subroutine.

{button ,AL(`H_CALLING_A_SCRIPT_FROM_A_MACRO_STEPS',1)} Go to procedure



Example: Calling a script from a macro
The following macro calls a script named GetData, which puts data in cells A1..B15. The macro then names the 
range and styles the data retrieved by GetData.
{GetData}
{RANGE-NAME-CREATE "DATA";A1..B15}
{STYLE-FONT-ATTRIBUTES "BOLD";"ON";"DATA"}



Changing the argument separator
The standard separator to use between macro and @function arguments is ; (semicolon). However, you can specify 
a different character.
1. From the Windows 95 Start menu, choose Settings.
2. From the Settings menu, choose Control Panel.
3. Double-click Regional Settings.
4. Click the Number tab.
5. In the "List separator" box, enter or select the separator you want to use.

You can use any character as the argument separator. Common separators to use are , (comma) and . (period).
Note ; (semi-colon) will work as an argument separator even if another character is selected in the "List 
separator" box.    The argument separator cannot be the same as the decimal symbol.

{button ,AL(`H_123_MACROS_OVER;H_FUNC_BASICS;H_PARTS_OF_A_MACRO_OVER;H_FUNCTION_FORMA
T_OVER;',0)} See related topics



Installing Help on macro commands
Help on macro commands is not installed by the Install program. If you have the 1-2-3 Release 9 or SmartSuite 
Release 9 CD-ROM, you can install macro Help from there. If not, you can download macro Help from the World 
Wide Web.
Once macro Help is copied to the correct location on your computer, you can access it by using Help - Help Topics or 
by clicking the Help button in the Macro Keywords dialog box.

Installing macro Help from the CD-ROM
1. Insert the CD-ROM in the appropriate drive.
2. Start the Windows Explorer.
3. Open the EXTRA\123\MACROHLP folder on the CD drive.
4. Select the files ssmn70en.hlp and ssmn70en.cnt, and choose Edit - Copy.
5. Open the folder where you installed 1-2-3 (typically \lotus\123), and choose Edit - Paste.

Macro Help will be available the next time you open Help for 1-2-3 Release 9. 
Tip If 1-2-3 Help was open when you installed macro help, close and reopen 1-2-3 Help before opening macro 
help topics.

Installing macro Help from the World Wide Web
Use this procedure to download a file that installs the macro help files on your computer.
1. Choose Help - Lotus Internet Support - Lotus Customer Support (or use your browser to go to 

www.support.lotus.com).

2. Scroll to the Product Support Pages list, select "1-2-3 for Windows," then click GO.
3. In the Hot Topics list, click the link for 1-2-3 Release 9 Macro Help File.
4. Click MACROS_9.EXE.
5. Select your 1-2-3 product directory (typically \lotus\123\) as the location for the file MACROS_9.EXE. 
6. Click Save.
7. Click the Windows 95 Start button, and then choose Run.
8. Type c:\lotus\123\macros_9.exe in the command line.
9. Click OK. 

MACROS_9.EXE installs the following files:
• ssmn70en.hlp
• ssmn70en.cnt

These files will be available the next time you open Help for 1-2-3 Release 9. 
Tip If 1-2-3 Help was open when you installed macro help, close and reopen 1-2-3 Help before opening macro 
help topics.

Note 1-2-3 will not automatically remove the macro Help files if you choose to uninstall 1-2-3. Instead, you will need 
to manually delete these files.

Using macro Help in translated versions of 1-2-3
Help on macro commands is designed for use with the worldwide English version of 1-2-3. If you have installed a 
translated version of 1-2-3 and want to use the macro Help files (ssmn70en.hlp, ssmn70en.cnt), please note the 
following:

• In Help Contents, the two macro command books, "Alphabetical List of Macros" and "Macros by Category" (and 
all information within these books) appear in English. 

• Some links and glossary pop-ups in macro Help will display errors because they refer to Help topics in the 
worldwide English version of 1-2-3. 

{button ,AL(`H_PHONE_NUMBERS_AND_HOURS_US_OVER;H_PHONE_NUMBERS_AND_HOURS_CANADA_O
VER;H_LOTUS_CUSTOMER_SUPPORT_INT_OVER;H_123_MACROS_OVER;',0)} See related topics





Help on macro commands
Use the Macro Keywords dialog box to enter the name of a macro command in a cell, along with argument 
placeholders. To display the dialog box, enter { (open brace) in a cell and press F3 (NAME).

Choose a topic
Writing a macro
Macro commands A-Z (available only if you have installed Help on macro commands)
Installing Help on macro commands

{button ,AL(`H_123_MACROS_OVER;H_MACRO_COMPATIBILITY_OVER;H_123_RELEASE_5_MACRO_COMMA
ND_EQUIVALENTS_OVER;H_OBSOLETE_MACINTOSH_MACROS_OVER',0)} See related topics



Macro compatibility
A number of macro commands that were supported in previous releases of 1-2-3 are no longer supported in 1-2-3. In 
addition, the behavior of some macros has changed.

Chart macro commands
These macro commands are no longer supported:

• {CHART-COLOR-RANGE}
• {CHART-PATTERN-RANGE}
• {CHART-SET-PREFERRED}
• {CHART-USE-PREFERRED}

In addition, the {CHART-TYPE} macro command for xy scatter charts works differently in this release. 1-2-3 no longer
supports stacked xy scatter charts. Therefore, {CHART-TYPE "xy";1}, {CHART-TYPE "xy";3}, and {CHART-TYPE 
"xy";5} all generate non-stacked xy scatter charts.

Database macro commands
These macro commands are no longer supported:

• {COMMIT}
• {CROSSTAB}
• {QUERY-UPGRADE}
• {ROLLBACK}

1-2-3 commits changes automatically. You cannot roll back changes once they are completed.

DDE and OLE macro commands
These macro commands are no longer supported:

• {LINK-TABLE}
• {DDE-TABLE}

These DDE macro commands were not supported in 1-2-3 97, but are supported in this release of 1-2-3.
• {DDE-ADVISE}
• {DDE-CLOSE}
• {DDE-EXECUTE}
• {DDE-OPEN}
• {DDE-POKE}
• {DDE-REQUEST}
• {DDE-UNADVISE}
• {DDE-USE}

Edit macro commands
The "query" argument in {EDIT-PASTE-SPECIAL} is not supported. If you use the argument, the macro stops and 1-
2-3 displays an error message.

File macro commands
The {FILE-SEAL-NETWORK-RESERVATION} macro is no longer supported.
When attempting to find a named print style to use, {PRINT-NAME-USE} looks first in the current workbook. If there is
no print style by that name in the current workbook, 1-2-3 looks for an .AL3 file. If it finds the .AL3 file, 1-2-3 creates a
new named print style in the current workbook using the file name.
{PRINT-NAME-ADD} never creates an .AL3 file, but instead adds a named print style to the current workbook. If there
is already a print style with that name, the macro stops and displays an error message.

Flow-of-control macro commands
These macro commands are no longer supported:

• {LOTUS-LAUNCH}



• {SYSTEM}

Solver macro commands
The {SOLVER-ANSWER-SAVE} macro is no longer supported.
To use other {SOLVER} macros, you must install the Solver add-in. You can install a trial version of Solver, available 
from both the 1-2-3 Customer Support Web site and the Frontline Systems Web site.    See Connecting to Lotus 
Customer Support. 
For more information about Solver, contact:

Frontline Systems, Inc.
PO Box 4288
Incline Village, NV 89450
Tel:          (702) 831-0300
Fax:        (702) 831-0314
Web:      http://www.frontsys.com
E-mail:    info@frontsys.com

The {BACKSOLVE} macro command works even if the Solver add-in is not installed.

Tools macro commands
These macro commands are no longer supported:

• {ADDIN-INVOKE}
• {REGISTER}
• {UNREGISTER}

In addition, the {AUDIT} macro command is no longer supported; instead, its functionality is provided through the 
Scripts.123 files, available in the Extra\123\Scripts directory on the 1-2-3 and SmartSuite CD-ROMs.

User environment macro commands
These macro commands are no longer supported:

• {FORM}
• {FORMBREAK}

Version Manager macro commands
These macro commands are no longer supported:

• {RANGE-VERSION?}
• {VERSION-INDEX-COPY}
• {VERSION-UPDATE}

{button ,AL(`H_123_CONVERTING_MACRO_BUTTONS_OVER;H_PHONE_NUMBERS_AND_HOURS_US_OVER;
H_PHONE_NUMBERS_AND_HOURS_CANADA_OVER;H_LOTUS_CUSTOMER_SUPPORT_INT_OVER;H_OB
SOLETE_MACINTOSH_MACROS_OVER',0)} See related topics



Obsolete 1-2-3 for Macintosh commands
The following table lists macro commands that worked with 1-2-3 for Macintosh and were supported in previous 
releases of 1-2-3 for Windows but are no longer supported. The second column lists the closest current 1-2-3 
command.

1-2-3 for Macintosh command Similar current 1-2-3 command
{DATA-DISTRIBUTION} {DISTRIBUTION}
{DATA-EXTERNAL-CONNECT} {DATABASE-CONNECT}
{DATA-EXTERNAL-CREATE-TABLE} {DATABASE-CREATE-TABLE}
{DATA-EXTERNAL-DISCONNECT} {DATABASE-DISCONNECT}
{DATA-EXTERNAL-SEND-COMMAND} {DATABASE-SEND-COMMAND}
{DATA-FILL} {FILL}
{DATA-MATRIX-INVERT} {MATRIX-INVERT}
{DATA-MATRIX-MULTIPLY} {MATRIX-MULTIPLY}
{DATA-PARSE} {PARSE}
{DATA-REGRESSION} {REGRESSION}
{DATA-REGRESSION-RESET} No similar macro available
{EDIT-CLEAR-CONTENTS} {EDIT-CLEAR}
{EDIT-CLEAR-STYLES} {EDIT-CLEAR}
{EDIT-MOVE-CELLS} {EDIT-QUICK-MOVE}
{FILE-PRINT} {PRINT}
{FILE-PRINT-NAME-ADD} {PRINT-NAME-ADD}
{FILE-PRINT-NAME-USE} {PRINT-NAME-USE}
{FILE-PRINT-RESET} {PRINT-RESET}
{FILE-PRINT-SELECTION} {PRINT}
{FILE-PRINT-SELECTION?} {PRINT?}
{FILE-PRINT?} {PRINT?}
{FILE-QUIT} {FILE-EXIT}
{GRAPH-NEW} No similar macro available
{GRAPH-VIEW} No similar macro available
{RANGE-FORMAT} {STYLE-NUMBER-FORMAT}
{RANGE-FORMAT-RESET} {STYLE-NUMBER-FORMAT-RESET}
{RANGE-GOTO} {EDIT-GOTO}
{RANGE-PROTECT} {PROTECT}
{RANGE-UNPROTECT} {UNPROTECT}
{ROW-HEIGHT-RESET} {ROW-HEIGHT-FIT-LARGEST}
{SELECT-ALL-SHEETS} {SELECT-ALL}
{SELECT-RANGE} {SELECT}
{SELECT-RANGE-APPEND} {SELECT-APPEND}
{STYLE-ALIGN} {STYLE-ALIGN-HORIZONTAL}
{STYLE-BACKGROUND-COLOR} {STYLE-INTERIOR}
{STYLE-BACKGROUND-PATTERN} {STYLE-INTERIOR}
{STYLE-FONT-EMPHASIS} {STYLE-FONT-ATTRIBUTES}
{STYLE-FOREGROUND-COLOR} {STYLE-INTERIOR}
{STYLE-TEXT-COLOR} {STYLE-INTERIOR}
{USER-SETUP-UPDATE} No similar macro available
{WINDOW-CLOSE} {FILE-CLOSE}



{button ,AL(`H_MACRO_COMPATIBILITY_OVER;',0)} See related topics



Run Scripts & Macros dialog box
Use this dialog box to run existing scripts and macros.

Choose a task
Running a macro
Running a script 
Debugging a macro 

{button ,AL(`H_123_MACROS_OVER;',0)} See related topics



Getting Help on a menu command
Help provides descriptions of the commands on each menu.
1. Click the command on the main menu (for example, File, Edit, View).
2. Press F1 (HELP) to see a Help topic describing each command on that menu.
Tip When you highlight a command, a description appears in the title bar of the 1-2-3 window.

{button ,AL(`H_GETTING_HELP_ON_A_MENU_COMMAND_DETAILS',1)} See details
{button ,AL(`H_USING_MENUS_OVER;H_123_COMMANDS_REF;',0)} See related topics



Details: Getting Help on a menu command
1-2-3 has context-sensitive Help for all menu commands, InfoBox tabs, and dialog boxes. 

Other ways to get Help
To display Help on a dialog box, click the Help button. To display Help on an InfoBox tab, click the ?... (question mark)
button in the top-right corner of the InfoBox.

{button ,AL(`H_GETTING_HELP_ON_A_MENU_COMMAND_STEPS',1)} Go to procedure



Overview: Using menus
1-2-3 commands appear on the main menu. To cancel out of a menu, press ESC one or more times.

The main menu
The 1-2-3 commands below always appear on the main menu when a workbook is active.

• File
• Edit
• View
• Create

• Sheet
• Window
• Help

One command on the menu changes, depending on your current selection. For example, if you select a range, the 
command changes to Range, but if you select a drawing, then the command changes to Drawing.

Depending on what you have selected, you will see one of the following commands:
• Chart
• Drawing
• Map 
• Preview
• Range

• Query Table
• Web Table
• <OLE object>
• <Name of control>

Note If you select an OLE object, the name of that object, such as Presentation or Document, appears in the menu.

Shortcut menus 
Shortcut menus display useful commands for working with the current selection. To display a shortcut menu, select a 
range or graphic object, then right-click the selection. For example, if you select a row and then right-click the 
selection, you will see menu commands appropriate for working with rows, as shown below. 

You can't display a shortcut menu while you are editing in a cell or text block, or while a dialog box is open.

The 1-2-3 Classic menu
1-2-3 Classic is the / (slash) command menu of 1-2-3 for DOS Release 3.1, available in the current release of 1-2-3. 
For more information, see Overview: 1-2-3 Classic.



{button ,AL(`H_CANCELLING_A_COMMAND_STEPS;H_GETTING_HELP_ON_A_MENU_COMMAND_STEPS;H_
UNDOING_A_COMMAND_STEPS;',0)} See related topics



Overview: Versions
As an individual or as part of a team, you can create and work with versions to perform what-if analyses and track 
spreadsheet changes. You can use versions to test business assumptions, devise strategies based on different 
business scenarios, or coordinate the contributions of a team or workgroup. 

What are versions?
Versions are sets of different data for the same named range. Each version has a name, a date and time of creation 
and modification, and the name of the person who created or last modified the version. You can also assign styles 
and protection settings to a version and attach a comment. 
For example, you can name a range Revenues and create three versions of the range: HighRev, with values of 600, 
500, 400, and 300; MedRev, with values of 500, 400, 300, and 200; and LowRev, with values of 400, 300, 200, and 
100. 
You can create versions of any named range. For example, as well as creating versions of Revenues, you might 
name another range Expenses and create versions named HighExp, MedExp, and LowExp. 
When you create versions for a named range, all the versions are stored in the cells of the range. 1-2-3 calculates 
using the values in the currently displayed version. Any style or data changes you make to cells update the version 
within that range automatically. 

Tracking changes to data
Using versions lets you track changes to data. With versions, you can always tell the who, when, what, and why of 
data.
Tracking is especially useful in a workgroup where different team members contribute to the same spreadsheet. You 
can always tell who created a version and when it was created or modified. From the comments, you can tell what 
type of data a version contains and why it was created or modified.

Using versions for what-if analysis
Formulas that refer to cells in a versioned range vary according to the version of the range currently displayed. 
Displaying different versions of a range and comparing the effect on other values in your spreadsheet is a good way 
to do simple what-if analysis. 
For example, you can create High and Low versions for a range named Sales and compare the effect of those 
versions on other values. 

{button ,AL(`;H_SHARING_VERSIONS_WITH_A_TEAM_OVER;H_WORKING_WITH_VERSION_GROUPS_OVER;
H_DELETING_VERSIONS_STEPS;H_DISPLAYING_VERSIONS_STEPS;H_CREATING_A_VERSION_STEPS;',
0)} See related topics



Overview: Sharing versions with a team
You can increase team productivity by sharing versions and version groups. For example, team members can 
collaborate on a sales projection by each entering their versions of projected sales and expenses. As the originator of
a shared workbook or range, you can distribute a workbook or range to a team, then consolidate the contributions of 
team members into your original workbook or range. 
You can share entire workbooks (or ranges within a workbook) on a network or without a network. 

Sharing an entire workbook
To share an entire workbook containing versioned ranges, use File - TeamMail. When you receive changes from team
members on your distribution list, you can use File - TeamConsolidate - Merge Versions to merge their changes into 
the master copy. 

 See related topics

Sharing a versioned range
To share just a versioned range in a workbook, use File - TeamReview. When the range has been distributed to team 
members, it is returned to you automatically, and you can then consolidate it back into a master workbook. The 
consolidation process creates versions automatically based on the changes received from team members. 

 See related topics

Sharing a workbook on a network
You can also share a workbook using a network and workbook reservations. Every team member can read the 
workbook containing the versions, but only the person who currently has the reservation can make changes. 

 See related topics



Creating a version
You can name a range and create versions at the same time, or you can create versions of previously named ranges.

 Show me a QuickDemo
1. Select the range. 
2. Choose Range - Version - New Version. 

3. If the range is not already named, enter a name in the "Name of range containing versions" box or accept the 
default name. 

4. Accept the default version name or enter a different name in the "Name of new version" box. 
5. (Optional) To copy data in the original named range into the new version, select "Use current data for new 

version." 
If you leave this option deselected, the new version is blank. 

6. (Optional) Click Next to enter a comment or set options.
7. Click Done. 

{button ,AL(`H_CREATING_A_VERSION_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_NAMING_A_RANGE_STEPS;H_CHANGING_VERSION_P

ROPERTIES_STEPS;H_DELETING_VERSIONS_STEPS;H_DISPLAYING_VERSIONS_STEPS;',0)} See related 
topics



Details: Creating a version
Displaying the version name and border

Displaying the version name and border makes it easy to:
• Identify ranges that contain versions. 
• Display a different version quickly by clicking the arrow next to the version name and selecting a version from 

the list. 
• Get quick access to commands for working with versions. Right-click the version name to display the shortcut 

menu. 

Renaming versions used in @functions
If you change the name of a version used in an @function, you can use Edit - Find & Replace to replace the old 
name with the new name in the @function. 

Turning on version names and borders for the whole workbook
To turn version names and borders on or off for the whole workbook, use File - Workbook Properties (View tab). 

Limitations
You can create versions of named ranges only if they contain 2000 or fewer cells. 

{button ,AL(`H_CREATING_A_VERSION_STEPS',1)} Go to procedure
{button ,AL(`H_SETTING_VIEW_PREFERENCES_FOR_WORKBOOKS_DETAILS;',0)} See related topics



Options: New Version dialog box (Step 2: Options tab) and Range InfoBox (Versions tab)

Name of current version
You can change the name here. This option appears only on the Range InfoBox (Versions tab).

Comment
The comment you enter in the New Version dialog box appears in the InfoBox when the version is displayed in 
the sheet. 

Show name and border around version
Displays the version name and a border around the named range. You can change whether the version name and
border are displayed by default with File - Workbook Properties (View tab). 

Keep styles with version
Retains the styles of the range; you can create a different style, for example, a background color, for each 
version. 

Protection
The protection setting you choose takes effect only after you lock the sheet or workbook.

• Unprotected. You can display, change, or delete the version unless any part of the versioned range is 
protected with cell protection. Cell protection does not take effect until the workbook is locked.

• Protected. Once the sheet or workbook is locked, you cannot change the version's data or properties, or 
delete it. You can display it in the sheet unless any part of the versioned range is protected with cell 
protection. 

• Hidden. Once the workbook is locked, the version name does not appear in lists of versioned ranges, and you
cannot display, change, or delete it. The InfoBox also does not display version information for a hidden 
version.

{button ,AL(`H_PROTECTING_DATA_OVER;H_WORKING_WITH_VERSIONS_OVER;H_CREATING_A_VERSION
_DETAILS;',0)} See related topics



Displaying a version
You can display different versions in a sheet. When you display a version, 1-2-3 recalculates all formulas and charts 
associated with the displayed version.

 Show me a QuickDemo
1. Choose Range - Version - Display Version. 

2. From the "Display version for range" list, select the range containing the version you want to display. 
3. From the list of versions, select the version you want to display. 
4. If the version is in a part of the sheet outside the displayed area and you want to see the version when you 

display it, select "Go to version when displayed." 
5. Click Display. 
6. (Optional) To display another version of the same range, repeat step 3; to display a version of a different named 

range, repeat steps 2 and 3. 
7. Click Done. 
Tip If the version name and borders are displayed in the sheet, you can click the arrow next to the name and select 
the version to display. 

{button ,AL(`H_DISPLAYING_VERSIONS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_CREATING_A_VERSION_STEPS;H_FINDING_RANGES_

AND_OTHER_OBJECTS_STEPS;H_DELETING_VERSIONS_STEPS;H_CHANGING_VERSION_PROPERTIES
_STEPS;',0)} See related topics



Details: Displaying a version
In a locked workbook, hidden versions don't appear in the list of versions. If all the versions in a range are hidden, the
range name does not appear in the "Display version for range" list.

{button ,AL(`H_DISPLAYING_VERSIONS_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_BOX_NEW_VERSION_TAB_OPTIONS_REF;H_PROTECTING_DATA_OVER',0)} See 

related topics



Changing version properties
You can use the InfoBox to change the version name, comment, and options for displaying, styling, and protecting 
versions. 
1. Select the named range containing the version you want to change.
2. Choose Range - Range Properties. 

3. Click the Version tab in the InfoBox. 

4. Change one or more properties.
5. (Optional) Move, collapse, or close the InfoBox.
Tip If the version name and borders are displayed in the sheet, you can rename the currently displayed version by 
clicking the name, typing a new name, and pressing ENTER. 
For a description of the options on this InfoBox tab, see Options.

{button ,AL(`H_CHANGING_VERSION_PROPERTIES_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_CREATING_A_VERSION_STEPS;H_DISPLAYING_VERSI

ONS_STEPS;H_FINDING_RANGES_AND_OTHER_OBJECTS_STEPS;H_DELETING_VERSIONS_STEPS;H_U
SING_THE_NAVIGATOR_TO_FIND_NAMED_RANGES_STEPS;',0)} See related topics



Details: Changing version properties
Displaying the version name and border
Displaying the version name and border makes it easy to:

• Identify ranges that contain versions. 
• Display a different version quickly by clicking the arrow next to the version name and selecting a version from 

the list. 
• Get quick access to commands for working with versions. Right-click the version name to display the shortcut 

menu. 
• Edit the version name.

Renaming versions used in @functions
If you change the name of a version used in an @function, you can use Edit - Find & Replace to replace the old 
name with the new name in the @function. 

Turning on version names and borders for the whole workbook
To turn version names and borders on or off for the whole workbook, use File - Workbook Properties (View tab). 

{button ,AL(`H_CHANGING_VERSION_PROPERTIES_STEPS',1)} Go to procedure



Deleting a version
1. Choose Range - Version - Delete Version. 

2. From the "Delete version for range" list, select the range containing the version you want to delete. 
3. From the list of versions, select the version to delete.
4. Click Delete.
5. (Optional) To delete another version, repeat steps 2 through 4.
6. Click Done.

{button ,AL(`H_DELETING_VERSIONS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_CREATING_A_VERSION_STEPS;H_DISPLAYING_VERSI

ONS_STEPS;H_CHANGING_VERSION_PROPERTIES_STEPS;',0)} See related topics



Details: Deleting a version
What happens when you delete a version? 
After you delete a version, 1-2-3 displays one of the remaining versions in the sheet. If there are no other versions for
the range, or if all other versions are hidden, the range contains the data for the last version you deleted, but no 
longer stores the data as a version.

Hidden and protected versions
You cannot delete protected or hidden versions in a locked sheet or workbook, or delete an unprotected version if it is
displayed in a locked workbook and one or more cells are protected. The names of hidden versions in a locked 
workbook do not appear in the list of versions. 

{button ,AL(`H_DELETING_VERSIONS_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;',0)} See related topics



Creating a version report
You can create a report showing selected versions and their effect on formulas. 1-2-3 creates the report in a new 
workbook.
1. Choose Range - Version - Report. 
2. From the "Report on this range" list, select the name of the range containing the versions you want to include in 

the report.
3. From the "Include these versions" list, click one or more versions.
4. (Optional) To see the effect of the selected versions on formulas in the sheet, enter the address or name of the 

range containing the formulas in the "Results of dependent formulas in this range" box.
5. (Optional) To include the data for the selected versions, select "Version data."
6. (Optional) To include the names of people who created or last modified the version, along with the date and time 

the version was created and modified, select "Creator, editors, and dates."
7. Under Arrange report, select "By columns" or "By rows."
8. Click OK.

{button ,AL(`H_CREATING_A_VERSION_REPORT_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_VERSION_REPORT_EX;',1)} See example
{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;',0)} See related topics



Details: Creating a version report
1-2-3 creates the version report in a new workbook, with the name REPORT followed by a number: for example, 
REPORT1.123. To view the workbook, choose Window and select the report name. You can print and save this as 
you would any other workbook. 

Specifying the range of formulas
If you specify a range in the "Results of dependent formulas in this range" box, 1-2-3 recalculates formulas in active 
files. Formulas will show the results of the respective versions in the report file. 
You can't specify a collection for the range of formulas.

{button ,AL(`H_CREATING_A_VERSION_REPORT_STEPS',1)} Go to procedure



Example: Creating a version report
The illustration below is an example of a version report. This report shows the name of the file containing the 
versions, the name and address of the versioned range, the reported versions, the version data, and the effect of the 
versions on the specified formula.

{button ,AL(`H_CREATING_A_VERSION_REPORT_STEPS;',0)} See related topics



Overview: Version groups
You can group versions of different named ranges and name the version group. For example, you can group the 
HighRev version of Revenues with the LowExp version of Expenses to create a version group named BestCase, or 
create a version group named WorstCase that combines the LowRev version of Revenues with the HighExp version 
of Expenses.

Using version groups for what-if analysis
Formulas that refer to cells in a versioned range vary according to the version of the range currently displayed. 
Displaying different versions of a range and comparing the effect on other values in your spreadsheet is a good way 
to do simple what-if analysis. 
With version groups, you can perform more complex what-if analyses. When you display a version group, all the 
versions in that group appear in the sheet, affecting any formulas that refer to the versions. You can combine versions
into many different groups, display these groups, and compare the various effects.

{button ,AL(`H_WORKING_WITH_VERSIONS_OVER;H_SHARING_VERSIONS_WITH_A_TEAM_OVER;H_CREATI
NG_A_VERSION_GROUP_STEPS;H_DISPLAYING_VERSION_GROUPS_STEPS;H_MODIFYING_A_VERSION
_GROUP_STEPS;H_DELETING_VERSION_GROUPS_STEPS;',0)} See related topics



Creating a version group
You can group versions and name the new version group.

 Show me a QuickDemo
1. Choose Range - Version - Version Groups.

2. Click New Group.
3. Enter a name in the "Name of version group" box or accept the default name.
4. To add a version to the new group, drag it from the "Available versions" list to the "Versions in group" list.

For each named range, you can select only one version to put in the new version group.
5. To remove a version from the group, drag it outside the "Versions in group" list. 
6. From the "Protection for group" list, select an option: "Protected," "Unprotected," or "Hidden." 
7. (Optional) In the "Comments" box, enter a comment about the version group.
8. Click OK to return to the Version Groups dialog box. 
9. Click Done. 

{button ,AL(`H_CREATING_A_VERSION_GROUP_DETAILS',1)} See details
{button ,AL(`;H_WORKING_WITH_VERSION_GROUPS_OVER;H_MODIFYING_A_VERSION_GROUP_STEPS;H_

DELETING_VERSION_GROUPS_STEPS;H_DISPLAYING_VERSION_GROUPS_STEPS;',0)} See related topics



Details: Creating a version group
Overlapping versioned ranges
Do not include overlapping versions in the same version group. This may result in unpredictable data or data loss in 
the overlapping cells of the version group. 

Expanding and collapsing the "Available versions" and "Versions in group" lists
You can expand and collapse the "Available versions" and the "Versions in group" lists by double-clicking range 
names. 

When a workbook is locked
When a workbook is locked, hidden version groups will not appear under "Version group." You cannot change the 
properties of protected versions or version groups. However, you can add a protected version to an unlocked version 
group. 
You cannot create a hidden version in a locked workbook. 
You can add protected versions to a new version group.

{button ,AL(`H_CREATING_A_VERSION_GROUP_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;',0)} See related topics



Displaying a version group
When you display a version group, all the versions in the group appear in the sheet.
1. Choose Range - Version - Version Groups.

2. From the "Version group" list, select the group you want to display.
3. Click Display Group.
4. (Optional) To display another version group, repeat steps 2 and 3.
5. Click Done. 
Tip If the version name and borders are displayed in the sheets, you can click the arrow next to the name of a version
in the group, and then select the version group to display. 

{button ,AL(`H_DISPLAYING_VERSION_GROUPS_DETAILS',1)} See details
{button ,AL(`H_WORKING_WITH_VERSION_GROUPS_OVER;H_CREATING_A_VERSION_GROUP_STEPS;H_M

ODIFYING_A_VERSION_GROUP_STEPS;H_DELETING_VERSION_GROUPS_STEPS;',0)} See related topics



Details: Displaying a version group
Hidden and protected versions
If a version group contains any hidden versions and the sheet or workbook containing that group is locked, 1-2-3 
does not display the hidden versions. 
1-2-3 also does not display a versioned range if it is protected with cell protection or if any cells within that range are 
protected. 

{button ,AL(`H_DISPLAYING_VERSION_GROUPS_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_BOX_NEW_VERSION_TAB_OPTIONS_REF;H_PROTECTING_DATA_OVER',0)} See 

related topics



Changing a version group
You can add or remove versions in a version group. 
1. Choose Range - Version - Version Groups.

2. From the "Version group" list, select the group you want to edit.
3. Click Edit Group. 
4. To rename the group, enter a new name in the "Name of version group" box.    
5. To add a version to the group, drag it from the "Available versions" list to the "Versions in group" list.
6. To remove a version from the group, drag it outside the "Versions in group" list.
7. From the "Protection for group" list, select an option: "Unprotected," "Protected," or "Hidden." 
8. In the "Comments" box, enter a comment. 
9. Click OK to return to the Version Groups dialog box. 
10. Click Done. 

{button ,AL(`H_MODIFYING_A_VERSION_GROUP_DETAILS',1)} See details
{button ,AL(`;H_WORKING_WITH_VERSION_GROUPS_OVER;H_CREATING_A_VERSION_GROUP_STEPS;H_DI

SPLAYING_VERSION_GROUPS_STEPS;H_DELETING_VERSION_GROUPS_STEPS;',0)} See related topics



Details: Changing a version group
Overlapping versioned ranges
Do not include overlapping versions in the same version group. This may result in unpredictable data or data loss in 
the overlapping cells of the version group. 

Protection settings
You can change the protection setting for a version group only if the sheet or workbook is unlocked. 
You can protect an unprotected version group in a locked workbook. 
You cannot edit the properties of a protected version group in a locked workbook. 
Hidden version groups in a locked workbook do not appear in the "Version group" list, so you cannot edit their 
properties. 

{button ,AL(`H_MODIFYING_A_VERSION_GROUP_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_BOX_NEW_VERSION_TAB_OPTIONS_REF;H_PROTECTING_DATA_OVER;',0)} See 

related topics



Deleting a version group
Deleting a version group does not delete the versions (or the data in the versions) that made up the group.
1. Choose Range - Version - Version Groups.

2. From the "Version group" list, select the group you want to delete. 
3. Click Delete Group.
4. (Optional) To delete another version group, repeat steps 2 and 3.
5. Click Done. 

{button ,AL(`H_DELETING_VERSION_GROUPS_DETAILS',1)} See details
{button ,AL(`;H_WORKING_WITH_VERSION_GROUPS_OVER;H_CREATING_A_VERSION_GROUP_STEPS;H_DI

SPLAYING_VERSIONS_STEPS;H_MODIFYING_A_VERSION_GROUP_STEPS;',0)} See related topics



Details: Deleting a version group
Protected or hidden versions
You cannot delete version groups that are protected or hidden if the workbook containing those version groups is 
locked.

{button ,AL(`H_DELETING_VERSION_GROUPS_STEPS',1)} Go to procedure
{button ,AL(`H_OPTIONS_BOX_NEW_VERSION_TAB_OPTIONS_REF;H_PROTECTING_DATA_OVER;',0)} See 

related topics



Version Groups dialog box
Choose a task

Creating a version group
Displaying a version group
Changing a version group
Deleting a version group

{button ,AL(`;H_WORKING_WITH_VERSION_GROUPS_OVER',0)} See related topics



Working with Web tables
When you create a Web table, 1-2-3 copies tabular data from the HTML file on the Web into a range on the sheet and
maintains a link to the source location. 

For example, you can extract stock quotes from a Web page and pull them into an investment portfolio, bring up-to-
date interest rates into a what-if table, or use budgeting information from your organization's intranet in a forecasting 
worksheet.
You can click the hyperlink in the Web table to launch your browser and go to the source Web page.
You can specify how often you want to refresh the data in the Web table. You can also use the data in your Web table
to perform calculations or build formulas just like any other data in your sheet. For example, you can use the Web 
data in @functions, query tables, and what-if tables.
As you can see from the picture above, Web tables include a hyperlink that displays the URL for the source as well 
as the data from an HTML table on the Web. Web tables can also include hyperlinks to other Web pages if they 
appear in the HTML table on the Web page.
Note The Web table title bar may appear on the bottom of the Web table if there is not enough room to display it on 
top.
In some ways, Web tables are like other objects in 1-2-3. When you select a Web table, you can move it, size it, 
change its properties, delete it, and save it with the workbook file.

Selecting and moving a Web table
You can select a Web table by clicking the Web table frame or title bar. The frame is selected and the Web Table 
menu appears on the menu bar. Handles appear on all sides and corners of the selected Web table. 

You can move a selected Web table by dragging it to a new location. 

Resizing and refreshing a Web table
You can resize a Web table by dragging a handle of the Web table to a new location.    When you change the size of 
the Web table range, 1-2-3 updates the data in the Web table with the source data on the Web, and updates the Web
table range and range size. You can specify whether you want to refresh manually or automatically.
You can also select a variable or fixed range size for your Web table. A variable range size shows all the data from 
the HTML table on the Web. A fixed range size limits the size of the Web table to the range you specify in 1-2-3. 

{button ,AL(`H_123_SELECTING_A_WEB_TABLE_STEPS;H_123_GET_DATA_FROM_WEB_STEPS;H_123_REFR
ESH_WEB_DATA_STEPS;H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;',0)} See related 
topics



Getting data from the Web
When you get data from the Web, you can create a Web table in the current sheet or another sheet in the workbook, 
but not in a different workbook.
1. From the File menu, choose Internet, and then choose Get Data from Web.
2. Specify the Web address in the "Web address (URL)" box.
3. Enter the range or use the range selector to select the location for the Web table.

• If you select one cell, 1-2-3 uses that cell as a starting point to enter the linked data.
• If you select a range, 1-2-3 limits the linked data to that range.

Caution 1-2-3 writes over any existing data in the range, including data in hidden columns, rows, or sheets. To 
avoid writing over existing data, select a cell or range in a blank area of the sheet.

4. (Optional) To ensure that the columns are always as wide as the numeric information, select "Adjust column 
widths to fit Web data."

5. Click OK.

{button ,AL(`H_123_GET_DATA_FROM_WEB_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_BREAKING_THE_CONNECTION_TO_THE_

WEB_STEPS;H_123_REFRESH_WEB_DATA_STEPS;H_123_SELECTING_A_WEB_TABLE_STEPS;H_123_M
OVING_WEB_TABLES_STEPS;H_123_PRINTING_WEB_TABLES_STEPS;H_123_DELETING_WEB_TABLES_
STEPS;H_123_RENAMING_A_WEB_TABLE_STEPS;H_123_SIZING_A_WEB_TABLE_STEPS;H_123_WORKIN
G_WITH_INTERNET_CONNECTIONS_OVER;',0)} See related topics



Details: Getting data from the Web
You can create a Web table from the Internet or an intranet.
Note You can click the hyperlink in the Web table to launch your browser and go to the source Web page.

Specifying the Web address (URL)
You can type the address of the Web page containing the information you want to bring into 1-2-3, select it from the 
list of recently used Web addresses, or browse to find the page you want. The maximum number of URLs displayed 
is 10. The character limit for the URL string is 255. 
Click Browse to launch the default Web browser, so you can find the URL (and copy it) or verify the one entered. If 
the "Web address (URL)" box is filled in, the browser opens to the specified URL. In the browser, you can copy the 
correct URL to the Clipboard, then return to 1-2-3 and paste it into the "Web address (URL)" box. 
If the "Web address (URL)" box is blank when you click Browse, 1-2-3 displays the Lotus home page 
(www.lotus.com). 

Selecting the sheet location for the Web table
To specify the range where you want to display the Web table, you can:

• Select a single cell - 1-2-3 uses this as the top left corner of the range and enters all the data in the sheet. 
• Select a range - 1-2-3 fills only the data that fits in this range into the sheet. If all the data does not fit in the 

selected range, the bottom (if more rows available) or right border (if more columns available) of the Web table 
displays as a dashed border.

You can drag the border to display more of the data.
Note A Web table range cannot span more than one sheet. You cannot specify a range in another file as the sheet 
location. Also, if the data retrieved is more than 65,536 rows or 256 columns, 1-2-3 retrieves only 65,536 rows and 
256 columns worth of data. 

Adjusting column widths to fit Web data
1-2-3 adjusts column widths in the Web table to fit the widest number in each column after the data is retrieved.

Web tables and versions
You can create a version inside or overlapping a Web table. If you version a Web table, the version frame appears on
top of the Web table frame. You can create a Web table on top of a version; however, doing so writes over the data in
the version. 

Web tables and query tables 
You can analyze or sort the data in a Web table by using the Web table as the source database table for a query 
table. 
The Web table data you want to analyze must be set up like a database table. For more information, see Overview: 
Query tables.

{button ,AL(`H_123_GET_DATA_FROM_WEB_STEPS',1)} Go to procedure
{button ,AL(`H_123_GETTING_READY_TO_CREATE_A_DQA_QUERY_TABLE_STEPS;H_DB_CREATING_QUER

Y_TABLE_STEPS;',0)} See related topics



Breaking the connection to the Web
You can disconnect the Web table from the source Web page if you no longer need to update the data. 
1. Select the Web table for which you want to break the connection.
2. From the Web Table menu, choose Break Connection to Web.
Tip You can also break the connection by right-clicking on the Web table frame and choosing Break Connection to 
Web.
When you disconnect the Web table, 1-2-3 removes the frame and URL. The data in the range is no longer 
connected to the Web and will not get refreshed. However, you can click the hyperlink to get to the source Web page.

{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_REFRESH_WEB_DATA_STEPS;H_123_DEL
ETING_WEB_TABLES_STEPS;',0)} See related topics



Refreshing data in a Web table
Every time you refresh data in a Web table, 1-2-3 updates the data in the Web table with the source data on the Web.
1-2-3 overwrites any changes you made to the Web table data since the last refresh.

Refreshing the current Web table
1. Select the Web table you want to refresh. 
2. From the Web Table menu, choose Refresh Now.
Tip You can also click the Refresh button on the Web table frame.

Refreshing one or more Web tables
1. From the File menu, choose Internet, and then choose Refresh Web Data.

2. Do one of the following:
• To refresh all Web tables in the current workbook, click Refresh All.
• To refresh one Web table, select the table in the list, and click Refresh. Then click Done.

{button ,AL(`H_123_REFRESH_WEB_DATA_DETAILS',1)} See details
{button ,AL(`H_123_SELECTING_REFRESH_OPTIONS_FOR_A_WEB_TABLE_STEPS;H_123_WORKING_WITH_

WEB_TABLES_OVER;H_123_BREAKING_THE_CONNECTION_TO_THE_WEB_STEPS;H_123_SIZING_A_WE
B_TABLE_STEPS;',0)} See related topics



Details: Refreshing data in a Web table
When you change the size of the Web table range, 1-2-3 refreshes the data. 
Using Web Table - Web Table Properties on the Refresh tab of the Web Table InfoBox, you can specify whether you 
want to refresh manually or automatically, and whether you want to refresh when you open the file.

{button ,AL(`H_123_REFRESH_WEB_DATA_STEPS',1)} Go to procedure



Deleting a Web table
You can delete the Web table and all its associated data.
1. Select the Web table you want to delete.
2. Press DEL.
Tip You can also delete a Web table by right-clicking the Web table frame and choosing Clear.

{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_BREAKING_THE_CONNECTION_TO_THE_
WEB_STEPS;',0)} See related topics



Moving a Web table
Moving a Web table by dragging
1. Select the Web table you want to move.
2. Drag the Web table frame (the title bar or border) to a new location.

Moving a Web table using the InfoBox
1. Click the Web table frame to select the Web table.
2. From the Web Table menu, choose Web Table Properties.
3. Click the Range tab.
4. Enter a different range or use the range selector to select the new location for the Web table.

Note If you specify a range of a different size, 1-2-3 refreshes the Web table.
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_123_MOVING_WEB_TABLES_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_DELETING_WEB_TABLES_STEPS;H_123_S

IZING_A_WEB_TABLE_STEPS;',0)} See related topics



Details: Moving a Web table
If you drag or paste data into either of the anchor cells for the Web table, even if the anchor cell is blank, a message 
appears indicating that you are about to write over an anchor cell. Overwriting an anchor cell disconnects the table 
from the Web and removes the Web table frame.

{button ,AL(`H_123_MOVING_WEB_TABLES_STEPS',1)} Go to procedure



Selecting a Web table
You can select a Web table by clicking the Web table frame or title bar. The frame is selected and the Web Table 
menu displays on the menu bar.    Handles appear on all sides and corners of the selected Web table. 
Note When you click a cell or select a range inside a Web table, you are selecting the data in the Web table range, 
not the Web table. To select all the cells inside the Web table, right-click the Web table frame and choose Select 
Table Range.
You can also choose Edit - Go To to select a Web table if it is out of view or if the frame is turned off. 

{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER',0)} See related topics



Sizing a Web table
When you resize a Web table, 1-2-3 refreshes the table. 
Caution You can size the Web table to be larger than the Web table data, and if you do, 1-2-3 writes over existing 
data in the range (including data in hidden columns, rows, or sheets), even if the Web table has no data to put there. 
If you accidentally write over data, you can choose Edit - Undo.

Sizing a Web table by dragging
1. Select the Web table you want to resize.
2. Drag a handle on the border of the Web table.

Sizing a Web table using the InfoBox
When you resize a Web table using the InfoBox, you can also set the table range to be a fixed or variable size.
1. Click the Web table frame to select the Web table.
2. From the Web Table menu, choose Web Table Properties.
3. Click the Range tab.

4. Enter a new range or use the range selector to select the new location for the Web table.
5. Under Size of range, select 'Variable" or "Fixed." 
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_123_SIZING_A_WEB_TABLE_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_MOVING_WEB_TABLES_STEPS;H_123_DE

LETING_WEB_TABLES_STEPS;',0)} See related topics



Details: Sizing a Web table
Determing the size of the table
When you create a Web table, 1-2-3 determines the size of the table based on how you selected the range when you 
created the table.

• If you selected one cell, 1-2-3 sets the table size to "Variable" and enters all the linked data in the sheet.
Note If a Web table is set to "Variable" and you specify a single cell as the new location, the range size will 
remain variable.

• If you selected a range larger than one cell, 1-2-3 sets the table size to "Fixed" and enters only the data that will fit
in the selected range.

However, you can resize the table at any time using the mouse or the InfoBox. See Sizing a Web table.

Selecting the range size
You can select a variable or fixed range size.

• Variable - Shows all the Web table data, starting at the top left cell of the range specified in the "Web table range" 
box. 

• Fixed - Limits the size of the Web table to the range specified in the "Web table range" box. 

Moving anchor cells
Whenever you move an anchor cell, 1-2-3 refreshes the table and deletes the data that is no longer within the Web 
table frame.

When you drag or paste data onto an anchor cell, a message appears indicating the link to the Web table will be 
broken. If you click OK, 1-2-3 removes the frame and the link to the source.

{button ,AL(`H_123_SIZING_A_WEB_TABLE_STEPS',1)} Go to procedure



Printing a Web table
1. Select the Web table you want to print.
2. From the File menu, choose Print.
3. (Optional) Click Preview & Page Setup to see how the Web table will print.
4. Click Print.
1-2-3 prints the Web table data, but not the frame.
Tip You can also right-click the Web table frame and choose Quick-Print.

{button ,AL(`H_123_PRINTING_WEB_TABLES_DETAILS',1)} See details
{button ,AL(`H_PRINT_CHANGING_SELECTION_DETAILS;H_PRINT_OBJECTS_CHARTS_MAPS_STEPS;H_123

_WORKING_WITH_WEB_TABLES_OVER;',0)} See related topics



Details: Printing a Web table
Printing a Web table with the frame and data
If you print a sheet or workbook that contains a Web table, 1-2-3 prints the frame and the data. 
If you select a range that contains the entire Web table (with frame), 1-2-3 prints the frame and the data. 
Note If "Charts, maps, drawings, and table frames" is deselected in the Show list in the Include panel of the Preview 
& Page Setup InfoBox, the Web table frame does not print. 

{button ,AL(`H_123_PRINTING_WEB_TABLES_STEPS',1)} Go to procedure



Changing a Web table name and source URL
1. Select the Web table for which you want to change the name and address.
2. From the Web Table menu, choose Web Table Properties.
3. Click the Basics tab.
4. Enter a Web table name In the "Web table name" box according to the naming conventions. 
5. In the "Web address (URL)" box, type the address of the Web page containing the information you want to bring 

into 1-2-3.
1-2-3 will bring in the new data as soon as you press ENTER or move to another option in the InfoBox.
Caution If the Web table is set to "Variable," the new data may write over existing data in the sheet. See Details: 
Sizing a Web table for more information.

6. To show or hide the Web table name and borders, select or deselect "Show name and borders."
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_123_RENAMING_A_WEB_TABLE_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_BREAKING_THE_CONNECTION_TO_THE_

WEB_STEPS;H_123_SELECTING_REFRESH_OPTIONS_FOR_A_WEB_TABLE_STEPS;',0)} See related topics



Details: Changing a Web table name and source URL
Hiding the name and border
You can hide the name and border of the Web table. When you deselect this option, 1-2-3 no longer displays the 
border, but you can still select the frame. Move the mouse to the edge of the range. When the mouse pointer 
changes to a hand, you can click to select the hidden frame.

Tip You can use Edit - Go To to select a Web table when the name and border are turned off.
To redisplay the hidden border, right-click a cell inside the Web table and choose Show Table Name and Border.

{button ,AL(`H_123_RENAMING_A_WEB_TABLE_STEPS',1)} Go to procedure



Selecting refresh options for a Web table
1. Select the Web table for which you want to select refresh options.
2. From the Web Table menu, choose Web Table Properties.
3. Click the Refresh tab.

4. If you want to refresh the Web table each time you open the file, select "Refresh when opening file."
5. If you want to let 1-2-3 change column widths to best fit the data, select "Adjust column widths to fit Web data on 

refresh." 
Note Deselecting this option does not affect the column widths of the current Web table, but sets the table to no 
longer readjust when refreshing.

6. Select the type of refresh.
7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_123_SELECTING_REFRESH_OPTIONS_FOR_A_WEB_TABLE_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_WEB_TABLES_OVER;H_123_BREAKING_THE_CONNECTION_TO_THE_

WEB_STEPS;H_123_REFRESH_WEB_DATA_STEPS;',0)} See related topics



Details: Selecting refresh options for a Web table
Selecting a refresh method
You can select how you want 1-2-3 to refresh Web tables.

• Manual - When you select "Manual," you must refresh the table using one of the methods described in Refreshing
data in a Web table.)

• Automatically refresh every xxx minutes - Performs a refresh on the Web table at the interval specified in the 
"minutes" box. 

{button ,AL(`H_123_SELECTING_REFRESH_OPTIONS_FOR_A_WEB_TABLE_STEPS',1)} Go to procedure



Overview: What-if tables and Backsolving
What-if tables display the results of substituting different values for formula variables. You can use what-if tables to 
evaluate questions such as "What if my sales went up 30%; how would that affect my profits?"
Backsolving is another way to answer what-if problems that use a formula. Backsolver lets you specify the result of a 
formula and find the value of one or more variables in the formula.

Setting up and calculating what-if tables
Before making a what-if calculation, you must set up the what-if table in a specific format in the sheet. To set up the 
table, you enter the formulas and the different values you want to substitute for formula variables.
Then you use Range - Analyze - What-if Table to calculate the formulas using every combination of values for the 
variables. You can substitute values for one, two, or three variables in formulas. The results appear in one-variable, 
two-variable, and three-variable what-if tables.

 See example

Backsolving what-if problems
Backsolver lets you specify the result of a formula and see how that changes the value of one or more variables in 
the formula.
For example, suppose the result of a formula is the monthly payment on a loan, and one of the formula variables is 
the loan amount. What if you can make a larger monthly payment; how would that affect the amount you can borrow?
You can use Backsolver to specify the larger formula result and see how that changes the loan amount variable.

 See example

{button ,AL(`H_SETTING_UP_A_ONE_VARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP_A_TWO_VARIABLE
_WHATIF_TABLE_STEPS;H_SETTING_UP_A_THREE_VARIABLE_WHATIF_TABLE_STEPS;H_CALCULATING
_WHATIF_TABLES_STEPS;H_CLEARING_WHATIF_TABLE_SETTINGS_STEPS;H_BACKSOLVING_WHATIF_P
ROBLEMS_STEPS;',0)} See related topics



Setting up a 1-variable what-if table
You set up a 1-variable what-if table before using Range - Analyze - What-if Table to calculate the results.
1. Decide where you want the table range and make sure there is room for the input values, the formula(s), and the 

results.
The height of the table range is one cell more than the number of input values, and the width is one cell more 
than the number of formulas.
Caution Set up the table in a blank part of the sheet so 1-2-3 does not write over existing data when you 
calculate the results.

2. Place the input cell outside the table range.
To make the input cell easy to locate, label it by entering text, such as "Input cell 1," in the adjacent cell to the left.

3. Leave the top left cell in the table range blank.
4. Enter the formula in the first row of the second column in the table range.

Each formula in the table must refer to this input cell. To verify that the formula works, you can enter a sample 
value in the input cell.
If you are using more than one formula, place each additional formula in the first row of the table range in an 
adjacent column to the right. Make sure each formula refers to the input cell.

5. Enter the input values in the first column of the table range starting in the second row.
6. To calculate the results, see Calculating what-if tables. 

{button ,AL(`H_A_1VARIABLE_WHATIF_TABLE_EX',1)} See example
{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_CALCULATING_WHATIF_TABLES_STEPS;H_C

LEARING_WHATIF_TABLE_SETTINGS_STEPS;H_SETTING_UP_A_THREE_VARIABLE_WHATIF_TABLE_STE
PS;H_SETTING_UP_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;',0)} See related topics



Setting up a 2-variable what-if table
You set up a 2-variable what-if table before using Range - Analyze - What-if Table to calculate the results.
1. Decide where you want the table range and make sure there is room for the two sets of input values, the formula, 

and the results.
The height of the table range is one cell more than the number of values for Input cell 1, and the width is one cell 
more than the number of values for Input cell 2.
Caution Set up the table in a blank part of the sheet so 1-2-3 does not write over existing data when you 
calculate the results.

2. Place the two input cells outside the table range.
To make the input cells easy to locate, label them by entering text, such as "Input cell 1" and "Input cell 2," in the 
adjacent cells to the left. 

3. Enter the formula in the top left cell of the table range.
This formula must refer to both input cells. To verify that the formula works, you can enter a sample value in each 
of the input cells.

4. In the first column of the table range, starting with the cell under the formula, enter the values for Input cell 1.
5. In the first row of the table range, starting with the first cell to the right of the formula, enter the values for Input 

cell 2.
6. To calculate the results, see Calculating what-if tables. 

{button ,AL(`H_A_2VARIABLE_WHATIF_TABLE_EX',1)} See example
{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_CALCULATING_WHATIF_TABLES_STEPS;H_C

LEARING_WHATIF_TABLE_SETTINGS_STEPS;H_SETTING_UP_A_ONE_VARIABLE_WHATIF_TABLE_STEP
S;H_SETTING_UP_A_THREE_VARIABLE_WHATIF_TABLE_STEPS;',0)} See related topics



Setting up a 3-variable what-if table
You set up a 3-variable what-if table before using Range - Analyze - What-if Table to calculate the results.
1. Decide where you want the 3D table range and make sure there is room for the input values, the formula, and the

results.
The table range must be in the same location in consecutive sheets, and it spans a number of sheets equal to the
number of values for Input cell 3.
Caution Set up the table range in blank areas of the sheets so 1-2-3 does not write over existing data when you 
calculate the results.

2. Place the three input cells outside the table range.
To make the input cells easy to locate, label them by entering text, such as "Input cell 1," "Input cell 2," and "Input 
cell 3" in the adjacent cells to the left.

3. Enter the formula in a cell outside the table range.
Make sure the formula refers to all three input cells. To verify that the formula works, you can enter a sample 
value in each of the input cells.

4. In the first column of the table range in the first sheet, starting in the second row of the table, enter the values for 
Input cell 1.

5. In the first row of the table range in the first sheet, starting in the second column of the table, enter the values for 
Input cell 2.

6. Enter the values for Input cell 1 and Input cell 2 to the same position in each sheet in the 3D table range.
In most cases, the values for these input cells are the same in each sheet, and you can copy them from one 
sheet to the others. These values, however, can also be different in each sheet.

7. Enter a value for Input cell 3 in the top left cell of the table range in each sheet.
8. To calculate the results, see Calculating what-if tables. 

{button ,AL(`H_A_3VARIABLE_WHATIF_TABLE_EX',1)} See example
{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_CALCULATING_WHATIF_TABLES_STEPS;H_C

LEARING_WHATIF_TABLE_SETTINGS_STEPS;H_SETTING_UP_A_ONE_VARIABLE_WHATIF_TABLE_STEP
S;H_SETTING_UP_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;',0)} See related topics



Example: 1-variable what-if table
A 1-variable what-if table displays the results of substituting different values for one variable in one or more formulas.

1-variable table with one formula
You can use a 1-variable table to calculate monthly payments for a 30-year mortgage of $80,000 at various interest 
rates. In this what-if problem, you substitute values for a single variable: the interest rate.
The illustration below shows how to set up this 1-variable table. You put the input cell outside the table range. You put
the formula(s) and the values for the input cell in the table range and leave room for the results.

After you use Range - Analyze - What-if Table to calculate the formula in a 1-variable table, the results appear in the 
results area, as shown below.

1-variable table with more than one formula
You can calculate more than one formula in a 1-variable what-if table, as long as the other formulas all use the same 
input values.
The table below is the same as the previous one, except that it contains an additional formula to calculate the 
monthly interest rate.

{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_A_2VARIABLE_WHATIF_TABLE_EX;H_A_3VAR
IABLE_WHATIF_TABLE_EX;H_CALCULATING_WHATIF_TABLES_STEPS;H_SETTING_UP_A_ONE_VARIABL
E_WHATIF_TABLE_STEPS;H_SETTING_UP_A_THREE_VARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP
_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;',0)} See related topics



Example: 2-variable what-if table
A 2-variable what-if table displays the result of calculating a formula by substituting different values for two variables.

2-variable table example
You can use a 2-variable table to calculate monthly payments for a 20-year mortgage of $80,000, $90,000, and 
$100,000 at various interest rates. In this what-if problem, you substitute values for two variables: the mortgage 
amount and the interest rate.
The illustration below shows how to set up this 2-variable table. The table range includes a single formula and the 
values for Input cell 1 and Input cell 2. You put the two input cells outside the table range.

After you use Range - Analyze - What-if Table to calculate the formula in a 2-variable table, the results appear in the 
results area, as shown below.

{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_A_1VARIABLE_WHATIF_TABLE_EX;H_A_3VAR
IABLE_WHATIF_TABLE_EX;H_CALCULATING_WHATIF_TABLES_STEPS;H_SETTING_UP_A_ONE_VARIABL
E_WHATIF_TABLE_STEPS;H_SETTING_UP_A_THREE_VARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP
_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;',0)} See related topics



Example: 3-variable what-if table
A 3-variable what-if table displays the results of calculating a formula by substituting different values for three 
variables.

3-variable table example
You can use a 3-variable table to calculate monthly payments for a mortgage of $80,000, $90,000, and $100,000 
using various interest rates, and a number of different terms, such as 10, 20, and 30 years. In this what-if problem, 
you substitute values for three variables: the mortgage amount, the interest rate, and the term of the loan.
The illustration below shows how to set up this 3-variable table with a 3D range that spans three sheets.

The table range in a 3-variable table always includes three sheets:
• In the first sheet, set up the formula and the three input cells outside the table range.
• On all three sheets, set up the values for Input cells 1, 2, and 3 inside the table range.
• The value for Input cell 3 goes in the upper left corner of the table range.
• In this example, the values for Input cells 1 and 2 are the same in all three sheets, but the value for Input cell 3, 

the term, is different in each sheet. 
After you use Range - Analyze - What-if Table to calculate the formula in a 3-variable table, the results appear in the 
results area of the table range in each sheet.

{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;H_A_1VARIABLE_WHATIF_TABLE_EX;H_A_2VAR
IABLE_WHATIF_TABLE_EX;H_CALCULATING_WHATIF_TABLES_STEPS;H_CLEARING_WHATIF_TABLE_SE
TTINGS_STEPS;H_SETTING_UP_A_ONE_VARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP_A_THREE_V
ARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;',0)} See 
related topics



Calculating what-if tables
After setting up a 1-variable, 2-variable, or 3-variable what-if table, you can calculate the table to see the results.

 See example
1. Select the table range. For a 3-variable table, select the 3D table range.

For 1-variable and 2-variable tables, the table range includes the formula(s) and input values, but not the input 
cell.
For a 3-variable table, the 3D table range includes the input values, but not the formula or the input cells. 

2. From the Range menu, choose Analyze, and then choose What-if Table.
3. Under "Select the number of input cell(s)," click 1, 2, or 3 depending on the type of table you are calculating.
4. Specify the input cell(s) in the appropriate input cell box(es).
5. For a 3-variable table, specify the cell that contains the formula in the "Formula cell" box.
6. Click OK.

{button ,AL(`H_CALCULATING_WHATIF_TABLES_DETAILS',1)} See details
{button ,AL(`H_SETTING_UP_A_ONE_VARIABLE_WHATIF_TABLE_STEPS;H_SETTING_UP_A_THREE_VARIABL

E_WHATIF_TABLE_STEPS;H_SETTING_UP_A_TWO_VARIABLE_WHATIF_TABLE_STEPS;H_WHATIF_TABLE
S_AND_BACKSOLVING_OVER;',0)} See related topics



Details: Calculating what-if tables
Recalculating what-if tables
To recalculate your most recently calculated what-if table, enter new input values in the sheet and press F8 (TABLE).

{button ,AL(`H_CALCULATING_WHATIF_TABLES_STEPS',1)} Go to procedure



Clearing what-if table settings
You can clear the table range and input cell settings for all what-if tables in the current workbook.
1. Make sure the cell pointer is in the workbook containing the what-if tables whose settings you want to clear.
2. From the Range menu, choose Analyze, and then choose What-if Table.
3. Click Reset.

{button ,AL(`H_CALCULATING_WHATIF_TABLES_STEPS;H_WHATIF_TABLES_AND_BACKSOLVING_OVER;',0)} 
See related topics



Backsolving what-if problems
You can specify the result of a formula and backsolve to find the value of one or more variables in the formula.
1. Choose Range - Analyze - Backsolver.

2. In the "Make the formula in this cell" box, specify the cell containing the formula.
3. In the "Equal to this value" box, enter the value you want as the result of the formula.
4. In the "By changing cell(s)" box, specify the range containing the variable(s) you want to change.
5. Click OK.
Note Backsolver changes the values of formula variables. If other formulas depend on these variables, 1-2-3 
recalculates these formulas. To change the variables back to their original values, press CTRL+Z or click Undo 
immediately after using Backsolver.

{button ,AL(`H_BACKSOLVING_WHATIF_PROBLEMS_DETAILS',1)} See details
{button ,AL(`H_BACKSOLVER_EXAMPLE_EX',1)} See example
{button ,AL(`H_WHATIF_TABLES_AND_BACKSOLVING_OVER;',0)} See related topics



Details: Backsolving what-if problems
Using Backsolver options
To backsolve what-if problems, enter data for the following options:

• Make the formula in this cell -- enter the address of a cell containing the formula you want to result in a specified 
value. If you enter a multi-cell range, Backsolver uses only the top left cell in the range. The formula in the cell 
whose address you enter must refer to the cell(s) specified in the "By changing cell(s)" box, either directly or 
indirectly. If the formula in the cell you specify contains @functions, each @function must result in a number; the 
formula cannot use string @functions.

• Equal to this value -- specify a numeric value you want as the result of the formula. You can enter a number, 
formula, or a cell reference. The cell you reference must contain a number or a formula that produces a number. 
If you enter a formula that contains @functions, these @functions must result in a number.

• By changing cell(s) -- enter the address of one or more cells containing the value(s) you want Backsolver to 
change. Do not enter the address of protected cells, formula cells, or blank cells. If you enter a range, Backsolver 
changes the value in each cell by the same percentage.

Note  If you enter formulas in the Backsolver dialog box, 1-2-3 evaluates these formulas when you choose OK. You 
cannot recalculate the formulas by pressing F9 (CALC) while in the dialog box. Also, the next time you open the dialog 
box, it contains the formula value but not the formula.

{button ,AL(`H_BACKSOLVING_WHATIF_PROBLEMS_STEPS',1)} Go to procedure



Example: Backsolving a what-if problem
You specify the formula result you want and indicate which variable(s) you want to change. Backsolver then 
calculates the formula to arrive at the specified result and changes the value of the variable(s) in the sheet.

Changing a single variable
The @PMT formula in the illustration below calculates a monthly loan payment based on a loan amount of $100,000, 
an interest rate of 12%, and a term of 30 years. Using these values, @PMT results in a monthly loan payment of 
$1,028.61.

What if you can afford a higher monthly payment of $1,200; how does that affect the amount of money you can 
borrow? You can specify $1,200 as the result of @PMT and backsolve to find the value of    the loan amount variable.
The illustration below shows how Backsolver recalculates @PMT to result in a monthly payment of $1,200, entering a
changed loan amount variable of $116,662 in cell B1.

Changing several variables
As well as using Backsolver to change the value of a single variable, you can also change more than one variable. 
You can change a range of variables by the same percentage so a formula results in the value you specify.
In the illustration below, the $299,603 result of @SUM depends on the values of the variables in the range B3..B6.

What if you reduce your total expenses to $179,000; how would that affect each budget item? As shown in the 
illustration below, you can use Backsolver to reduce all the budget items by the same percentage to result in your 
goal of $179,000.



{button ,AL(`H_BACKSOLVING_WHATIF_PROBLEMS_STEPS;H_WHATIF_TABLES_AND_BACKSOLVING_OVER;
',0)} See related topics



What-if Table dialog box
Use this dialog box to calculate a 1-variable, 2-variable, or 3-variable what-if table.

Choose a task
Calculating what-if tables
Overview: What-if tables and Backsolver
Setting up a 1-variable what-if table    
Setting up a 2-variable what-if table 
Setting up a 3-variable what-if table 

{button ,AL(`H_A_1VARIABLE_WHATIF_TABLE_EX;H_A_2VARIABLE_WHATIF_TABLE_EX;H_A_3VARIABLE_WH
ATIF_TABLE_EX;',0)} See related topics



Cascading windows
Cascading stacks all windows diagonally, with their title bars showing.
To cascade windows, choose Cascade from the Window menu.
1-2-3 displays the active window on top.

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_MOVING_WINDOWS_STEPS;H_SIZING_WINDOWS_STEPS;
H_TILING_WINDOWS_HORIZONTALLY_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS;',0)} See related 
topics



Details: Creating a new window
Scrolling through multiple Workbook windows
You scroll through each Workbook window independently.

Making changes in a workbook with multiple windows 
When you make changes in a Workbook window, the changes are reflected in all windows for that workbook.

How 1-2-3 names multiple windows for a workbook
1-2-3 automatically names each new window. For example, if you create a new window for a workbook named May 
Expenses, 1-2-3 names the new window May Expenses.123: Window 2. 1-2-3 names subsequent windows May 
Expenses.123: Window 3, and so forth.

Saving and closing a workbook with multiple windows
If you save a workbook with multiple windows, 1-2-3 saves the information for each window. 

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_CREATING_A_NEW_WINDOW_STEPS',1)} Go to procedure



Creating a new window
Create additional windows for a workbook to view different portions of the workbook simultaneously.
To create a new window for the current workbook, choose New Window from the Window menu.

{button ,AL(`H_CREATING_A_NEW_WINDOW_DETAILS',1)} See details
{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_SIZING_WINDOWS_STE

PS;H_SPLITTING_WINDOWS_STEPS;H_TILING_WINDOWS_HORIZONTALLY_STEPS;H_TILING_WINDOWS
_VERTICALLY_STEPS;H_VIEWING_OPEN_WINDOWS_STEPS;H_MOVING_WINDOWS_STEPS',0)} See 
related topics



Moving windows
To move a window, drag the title bar of the window to the new location.

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_SIZING_WINDOWS_STE
PS;H_TILING_WINDOWS_HORIZONTALLY_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS;',0)} See 
related topics



Sizing windows
You can change the dimensions of a window.
1. Position the mouse pointer on the border or corner of the window so that the mouse pointer changes shape.

2. Drag the border or corner.
3. Release the mouse button when the window is the size you want.

{button ,AL(`H_SIZING_WINDOWS_DETAILS',1)} See details
{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_MOVING_WINDOWS_ST

EPS;H_TILING_WINDOWS_HORIZONTALLY_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS;',0)} See 
related topics



Details: Sizing windows
Dragging a border sizes the window horizontally or vertically.    Dragging a corner sizes both horizontally and 
vertically. 

Other ways to size windows
Click this button To

Minimize the window to an icon
Expand the window to its maximum size
Restore the window to its previous size
Close the window

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_SIZING_WINDOWS_STEPS',1)} Go to procedure



Details: Splitting windows
Where 1-2-3 splits the window

If you select 1-2-3 splits the window
Top-Bottom Horizontally, above the cell pointer
Left-Right Vertically, to the left of the cell pointer
Four-way Horizontally and vertically, above and to the left 

of the cell pointer

Other ways to split windows
You can also split a window by dragging the horizontal or vertical splitter to where you want to split the window. 

Drag To split the window
Horizontally (top to bottom)
Vertically (left to right)

Adjusting the size of panes
You can drag the horizontal or vertical splitters to adjust the size of a pane. If the window is split four ways, you can 
adjust the size of all four panes by dragging the four-way splitter, located in the center of the four panes.

Note The four-way splitter is visible only when synchronized scrolling is turned off. 

Restoring a window to a single pane
You can restore a split window to one pane by choosing View - Clear Split, or by dragging the horizontal or vertical 
splitters.

Scrolling through split windows
Synchronized scrolling lets you scroll panes simultaneously in a split window:

• In a horizontal split, you can scroll the panes together horizontally.
• In a vertical split, you can scroll the panes together vertically.
• In a four-way split, you can scroll the panes together horizontally and vertically.

To change whether panes scroll individually or simultaneously, choose either Unsynchronize Split or Synchronize 
Split from the View menu.

{button ,AL(`H_SPLITTING_WINDOWS_STEPS',1)} Go to procedure



Splitting windows
You can split a window into panes to see more than one portion of a sheet at a time.
1. From the View menu, choose Split.
2. Select Top-Bottom, Left-Right, or Four-way.
3. (Optional) To scroll through panes individually, deselect "Synchronize scrolling."
4. Click OK.

{button ,AL(`H_SPLITTING_WINDOWS_DETAILS',1)} See details
{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_CREATING_A_NEW_WI

NDOW_STEPS;H_VIEWING_OPEN_WINDOWS_STEPS;',0)} See related topics



Tiling windows side by side
To tile all windows side by side, choose Tile Left-Right from the Window menu.
1-2-3 displays the active window in the top left corner.

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_MOVING_WINDOWS_ST
EPS;H_SIZING_WINDOWS_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS;',0)} See related topics



Tiling windows top to bottom
To tile all windows top to bottom, choose Tile Top-Bottom from the Window menu.
1-2-3 displays the active window in the top left corner.

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_MOVING_WINDOWS_ST
EPS;H_SIZING_WINDOWS_STEPS;H_TILING_WINDOWS_HORIZONTALLY_STEPS;',0)} See related topics



Viewing open windows
You can select which Workbook window is active.
1. From the Window menu, choose the name of the window you want to display.
2. (Optional) If you have more than nine windows open and do not see the window you want on the menu, choose 

More Windows.

Related SmartIcons

Arranges open windows diagonally

Arranges open windows side by side

Arranges open windows top to bottom

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_TILING_WINDOWS_HOR
IZONTALLY_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS',0)} See related topics



Overview: Workbook windows
Within the 1-2-3 window, each workbook appears in its own window. You can size, move, arrange, and close 
Workbook windows.

About Workbook windows
Initially, each 1-2-3 workbook appears in one window. You can create additional windows for the same workbook, and
you can split a window into panes to see different parts of the workbook simultaneously. A window can contain up to 
four panes. 
For example, if your workbook contains more than one sheet, you can create a new window and display a different 
sheet in each window. Or, you can split the window and display a different sheet in each pane.
Workbook windows let you view the same workbook in different windows:

Panes are views of a workbook in one window:

You can scroll the panes of a window together (synchronized scrolling) or independently. Workbook windows scroll 
independently. 
Although you can display multiple Workbook windows simultaneously, you can only work in one window at a time. 
The active window contains the cell pointer.

Manipulating Workbook windows
Using the mouse is the easiest and most efficient way to size, move, or close windows. You can also use the Window
commands and the commands in each window's Control menu.

{button ,AL(`H_WORKBOOK_WINDOWS_OVER;H_CASCADING_WINDOWS_STEPS;H_CREATING_A_NEW_WI
NDOW_STEPS;H_MOVING_WINDOWS_STEPS;H_SIZING_WINDOWS_STEPS;H_SPLITTING_WINDOWS_ST
EPS;H_TILING_WINDOWS_HORIZONTALLY_STEPS;H_TILING_WINDOWS_VERTICALLY_STEPS;H_VIEWIN
G_OPEN_WINDOWS_STEPS',0)} See related topics



Overview: Hiding data
Hiding cell contents, columns, rows, sheets, and graphic objects is a good way to keep other users of your workbooks
focused on what you want them to see rather than on confidential or distracting information.
For example, suppose you have a workbook with two sheets, one that contains data and a chart, and the other that 
contains macros and calculations. To help users focus on the data and the chart, you can hide the sheet containing 
the macros and calculations.
When you hide a sheet, 1-2-3 hides the tab of that sheet. When you hide a column or row, 1-2-3 hides the column 
letter or row number.

You can use the InfoBox to hide selected cells and graphic objects.

Protecting hidden data
You can hide cell contents, but until you protect the hidden cells and lock the sheet or workbook that contains them, 
the cell contents appear in the contents box and users can edit data in these cells. 
However, when you lock the sheet or the workbook, users cannot see or edit the contents of any protected and 
hidden cell. For more information, see Overview: Protecting data.

Effects of hiding cells, columns, rows, sheets, and graphic objects
• You cannot move the cell pointer to hidden sheets, columns, or rows.
• You cannot print hidden sheets, columns, rows, or graphic objects.
• You can perform 1-2-3 operations on ranges in hidden sheets, columns, or rows. 

To perform a command on a range in a hidden sheet, column, or row, you can type the address or range name in 
a dialog box or in the InfoBox, or you can select the surrounding sheets, columns, or rows.

• Formulas containing references to ranges in hidden sheets, columns, or rows still work correctly. When creating a 
formula that refers to data in a hidden sheet, column, or row, type the range name or address in the formula.

• You can prevent changes to hidden data only by protecting it and locking the sheet or workbook.

{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_STEPS;H_DISPLAYING_HIDDEN_ROWS_STEPS;H_DISPLAYI
NG_HIDDEN_SHEETS_STEPS;H_HIDING_CELL_CONTENTS_STEPS;H_HIDING_COLUMNS_OR_ROWS_US
ING_THE_INFOBOX_STEPS;H_DISPLAYING_HIDDEN_COLUMNS_OR_ROWS_USING_THE_INFOBOX_STE
PS;H_HIDING_COLUMNS_STEPS;H_HIDING_ROWS_STEPS;H_HIDING_SHEETS_STEPS;H_HIDING_OR_R
EDISPLAYING_GRAPHICS_STEPS;',0)} See related topics



Hiding cell contents
Hiding confidential or distracting information is often a good idea when sharing data. When you hide the data in 
selected cells, the cells appear to be empty. 
Want the big picture? See Overview: Hiding data.
1. Select the cells whose contents you want to hide.
2. From the Range menu, choose Range Properties.

3. Click the Security tab in the InfoBox. 

4. Select "Hide cell contents."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_HIDING_CELL_CONTENTS_DETAILS',1)} See details
{button ,AL(`H_HIDING_DATA_OVER;',0)} See related topics



Details: Hiding cell contents
Protecting hidden cells
If hidden cells are not protected and the sheet or workbook containing them is not locked, commands that enter new 
data can write over data in the hidden cells. When you select a hidden cell, the cell contents appear in the contents 
box.    
When you protect hidden cells and lock the sheet or workbook that contains them, users cannot see or edit the 
contents of these cells. 
When you select an unprotected hidden cell, "U" appears in the status indicator in the status bar. When you select a 
protected hidden cell, "PR" appears.

{button ,AL(`H_HIDING_CELL_CONTENTS_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_LOCKING_SHEE

T_CONTENTS_STEPS;',0)} See related topics



Hiding sheets
You can hide sheets to prevent display and printing of data. 
Want the big picture? See Overview: Hiding data.
1. Select the tab of each sheet you want to hide.
2. From the Sheet menu, choose Hide.

Tip When the sheet tab is selected, you can right-click the sheet tab, then from the shortcut menu, select Hide.
Note You cannot hide a sheet if it is the only sheet in the workbook.

{button ,AL(`H_HIDING_SHEETS_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_SHEETS_STEPS;H_HIDING_COLUMNS_STEPS;H_HIDING_DATA_OVER;

H_HIDING_ROWS_STEPS;H_SHEETS_OVER;H_HIDING_OR_SHOWING_TABS_STEPS',0)} See related topics



Details: Hiding sheets
Another way to hide sheets
You can hide the current sheet by choosing Sheet - Sheet Properties (Basics tab) and selecting "Hide sheet." 

Protecting and locking hidden data
If hidden sheets are not protected and the workbook containing them is not locked, commands that enter new data 
can write over data in the hidden sheets.

{button ,AL(`H_HIDING_SHEETS_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_LOCKING_SHEE

T_CONTENTS_STEPS;',0)} See related topics



Hiding columns
You can drag a column border to hide a column.
Want the big picture? See Overview: Hiding data.

 Show me a QuickDemo
1. Position the mouse pointer in the sheet frame on the right border of the column you want to hide.

2. Drag the column border left until the indicator shows the column size as 0 (zero) characters.
3. Release the mouse button.
Note If the current sheet is part of a group, hiding columns in this sheet hides these columns in all sheets in the 
group.

{button ,AL(`H_HIDING_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_HIDING_DATA_OVER;H_DISPLAYING_HIDDEN_COLUMNS_STEPS;H_HIDING_COLUMNS_OR_

ROWS_USING_THE_INFOBOX_STEPS;H_HIDING_ROWS_STEPS;H_GROUPING_SHEETS_STEPS;H_UNG
ROUPING_SHEETS_STEPS;',0)} See related topics



Details: Hiding columns
Other ways to hide columns
You can hide columns by choosing Range - Range Properties and selecting "Hide column" in the Basics panel of the 
InfoBox. You can also click the column letter to select the entire column you want to hide, right-click to display the 
shortcut menu, and then choose Hide Columns.

Hiding several columns at once
To hide more than one column at once, select the entire columns you want to hide and drag the right border of one of 
them. You can also use the InfoBox or shortcut menu to hide the selected columns.

Protecting hidden data
If hidden columns are not protected and the sheet or workbook containing them is not locked, commands that enter 
new data can write over data in the hidden columns.

{button ,AL(`H_HIDING_COLUMNS_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_LOCKING_SHEE

T_CONTENTS_STEPS;',0)} See related topics



Hiding rows
You can drag a row border to hide a row.
Want the big picture? See Overview: Hiding data.
1. Position the mouse pointer in the sheet frame on the bottom border of the row you want to hide.

2. Drag the row border up until the indicator shows the row size as 0 (zero) points.
3. Release the mouse button.
Note If the current sheet is part of a group, hiding rows in this sheet hides these rows in all sheets in the group.

{button ,AL(`H_HIDING_ROWS_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_ROWS_STEPS;H_HIDING_COLUMNS_OR_ROWS_USING_THE_INFOBO

X_STEPS;H_HIDING_DATA_OVER;H_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS_STEPS;H_H
IDING_COLUMNS_STEPS;',0)} See related topics



Details: Hiding rows
Other ways to hide rows
You can hide rows by choosing Range - Range Properties and selecting "Hide row" in the Basics panel of the 
InfoBox. You can also click the row number to select the entire row you want to hide, right-click to display the shortcut
menu, and then choose Hide Rows.

Hiding several rows at once
To hide more than one row at once, select the entire rows you want to hide and drag up the bottom border of one of 
them. You can also use the InfoBox or shortcut menu to hide the selected rows.

Protecting hidden data
If hidden rows are not protected and the sheet or workbook containing them is not locked, commands that enter new 
data can write over data in the hidden rows.

{button ,AL(`H_HIDING_ROWS_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;',0)} See related topics



Displaying hidden columns
You can drag a column border to display hidden columns.
Want the big picture? See Overview: Hiding data.
1. Position the mouse pointer in the sheet frame on the border of a hidden column.

The pointer changes to gray.
2. Drag the border of the hidden column right until the indicator displays the size you want.
3. Release the mouse button.
Note If the current sheet is part of a group, displaying columns in this sheet displays these columns in all sheets in 
the group.

{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_ROWS_STEPS;H_HIDING_COLUMNS_STEPS;H_HIDING_DATA_OVER;H

_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS_STEPS;',0)} See related topics



Details: Displaying hidden columns
Other ways to display hidden columns
You can also display hidden columns using the shortcut menu. Select entire columns on either side of the hidden 
one(s), right-click to display the shortcut menu, and choose Unhide Columns.    
For information about displaying hidden columns using the InfoBox, see Displaying hidden columns or rows using the
InfoBox.

Width of redisplayed columns
When you use the InfoBox or shortcut menu to display hidden columns, the width of the redisplayed column is the 
same as before it was hidden.

{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_STEPS',1)} Go to procedure



Displaying hidden rows
You can drag a row border to display hidden rows.
Want the big picture? See Overview: Hiding data.
1. Position the mouse pointer in the sheet frame on the border of a hidden row.

The pointer changes to gray.
2. Drag the border of the hidden row down until the indicator displays the size you want.
3. Release the mouse button.
Note If the current sheet is part of a group, displaying rows in this sheet displays these rows in all sheets in the 
group.

{button ,AL(`H_DISPLAYING_HIDDEN_ROWS_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_STEPS;H_HIDING_COLUMNS_STEPS;H_HIDING_DATA_OVE

R;H_HIDING_ROWS_STEPS;H_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS_STEPS;',0)} See 
related topics



Details: Displaying hidden rows
Other ways to display hidden rows
You can also display hidden rows using the shortcut menu. Select entire rows above and below the hidden one(s), 
right-click to display the shortcut menu, and choose Unhide Rows.
For information about displaying hidden rows using the InfoBox, see Displaying hidden columns or rows using the 
InfoBox.

Height of redisplayed rows
When you use the InfoBox or shortcut menu to display hidden rows, the height of the redisplayed row is the same as 
before it was hidden.

{button ,AL(`H_DISPLAYING_HIDDEN_ROWS_STEPS',1)} Go to procedure



Displaying hidden sheets
You can redisplay hidden sheets from anywhere in the workbook.
Want the big picture? See Overview: Hiding data.
1. From the Sheet menu, choose Unhide.

2. Select the sheet(s) you want to display.
3. Click OK.

{button ,AL(`H_DISPLAYING_HIDDEN_SHEETS_DETAILS',1)} See details
{button ,AL(`H_HIDING_DATA_OVER;H_HIDING_SHEETS_STEPS;H_SHEETS_OVER;H_HIDING_OR_SHOWING

_TABS_STEPS',0)} See related topics



Details: Displaying hidden sheets
Other ways to display hidden sheets
You can display hidden sheets using the shortcut menu. Select the tab of any sheet, right-click and choose Unhide 
from the shortcut menu. In the Unhide dialog box, select the sheet(s) you want to unhide, and click OK.

{button ,AL(`H_DISPLAYING_HIDDEN_SHEETS_STEPS',1)} Go to procedure



Hiding columns or rows using the InfoBox
You can use the InfoBox to hide columns and rows.
Want the big picture? See Overview: Hiding data.
1. Select at least one cell in each of the columns or rows you want to hide.
2. From the Range menu, choose Range Properties.

3. Click the Basics tab in the InfoBox.

4. Select "Hide column" or "Hide row."
5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_HIDING_COLUMNS_OR_ROWS_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_OR_ROWS_USING_THE_INFOBOX_STEPS;H_HIDING_COLU

MNS_STEPS;H_HIDING_DATA_OVER;H_HIDING_ROWS_STEPS;H_THE_INFOBOX_OVER;;H_DISPLAYING_
HIDDEN_COLUMNS_STEPS;H_DISPLAYING_HIDDEN_ROWS_STEPS',0)} See related topics



Details: Hiding columns or rows using the InfoBox
Other ways to hide columns and rows
You can use the mouse to hide columns and rows. For more information, see Hiding columns and Hiding rows.

Protecting hidden data
If hidden columns and rows are not protected and the sheet or workbook containing them is not locked, commands 
that enter new data can write over data in the hidden columns and rows.

{button ,AL(`H_HIDING_COLUMNS_OR_ROWS_USING_THE_INFOBOX_STEPS',1)} Go to procedure
{button ,AL(`H_PROTECTING_DATA_OVER;H_LOCKING_WORKBOOK_CONTENTS_STEPS;H_LOCKING_SHEE

T_CONTENTS_STEPS;H_PROTECTING_UNPROTECTED_CELLS_IN_A_LOCKED_WORKBOOK_STEPS;H_P
ROTECTING_UNPROTECTED_CELLS_IN_A_LOCKED_SHEET_STEPS;',0)} See related topics



Displaying hidden columns or rows using the InfoBox
You can use the InfoBox to redisplay hidden columns and rows.
Want the big picture? See Overview: Hiding data.
1. Select a range that spans the hidden columns or rows you want to display.

For example, to display column B, select a range with at least one cell in column A and one in column C.
2. From the Range menu, choose Range Properties.

3. Click the Basics tab in the InfoBox.

4. Deselect "Hide column" or "Hide row."
When a column or row is hidden, the "Hide column" or "Hide row" box is gray.

5. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_OR_ROWS_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_STEPS;H_DISPLAYING_HIDDEN_ROWS_STEPS;H_HIDING_

COLUMNS_OR_ROWS_USING_THE_INFOBOX_STEPS;H_HIDING_DATA_OVER;H_THE_INFOBOX_OVER;',
0)} See related topics



Details: Displaying hidden columns or rows using the InfoBox
Another way to display hidden columns and rows
You can use the mouse to display hidden columns and rows. For more information, see Displaying hidden columns 
and Displaying hidden rows.

Width and height of redisplayed columns and rows
When you use the InfoBox to display hidden columns or rows, the width of the redisplayed column and the height of 
the redisplayed row are the same as before they were hidden.

{button ,AL(`H_DISPLAYING_HIDDEN_COLUMNS_OR_ROWS_USING_THE_INFOBOX_STEPS',1)} Go to 
procedure



Inserting columns or rows
You can insert columns or rows in a sheet or group of sheets.
1. Select a range with at least one cell in as many columns or rows as you want to insert.
2. From the Range menu, choose Insert.
3. To insert columns, select "Columns."
4. To insert rows, select "Rows."
5. Click OK.
Note If the current sheet is part of a group, inserting columns or rows in this sheet inserts columns or rows in all 
sheets in the group.

{button ,AL(`H_INSERTING_COLUMNS_OR_ROWS_DETAILS',1)} See details
{button ,AL(`H_DELETING_A_RANGE_STEPS;H_DELETING_COLUMNS_OR_ROWS_STEPS;H_DELETING_SHE

ETS_STEPS;H_INSERTING_A_RANGE_STEPS;H_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS
_STEPS;H_CREATING_A_SHEET_STEPS',0)} See related topics



Details: Inserting columns or rows
Other ways to insert columns or rows
To insert columns or rows immediately without displaying a dialog box, select as many entire columns or rows as you 
want to insert, and then do one of the following:

• From the Range menu, choose Insert Columns or Insert Rows.
• Right-click and choose Insert Columns or Insert Rows from the shortcut menu.

How 1-2-3 inserts columns and rows
1-2-3 inserts new rows above the selected rows or range, and new columns to the left of the selected columns or 
range.

Styles of inserted columns or rows
Inserted columns and rows have the same styles and formats as the column to the left of the inserted columns or the 
row above the inserted rows.

Width and height of inserted columns or rows
Inserted columns have the same width as the column to the left of the inserted columns. Inserted rows have the same
height as the row above the inserted rows. For example, inserted records in a database table have the same height 
as the other records in the table.

How inserting columns and rows affects formulas
When you insert columns or rows, 1-2-3 redefines named ranges and, if necessary, adjusts addresses in formulas.
For example, if you entered the formula +E6*100 and then inserted two columns to the left of column E, 1-2-3 adjusts
the address so that the formula becomes +G6*100.
Note If you insert columns or rows just under or next to a range that a formula refers to, 1-2-3 does not adjust the 
formula; you must adjust the formula if you want to include the inserted cells.

How inserting columns or rows affects named ranges
If you insert columns or rows into a named range, the named range expands by the number of columns or rows you 
inserted. 

Related SmartIcons

Inserts one or more columns to the left of the selected columns

Inserts blank cells in the selected range and moves existing data down or right

Inserts one or more rows above the selected rows

Inserts one or more sheets before or after the current sheet

{button ,AL(`H_INSERTING_COLUMNS_OR_ROWS_STEPS',1)} Go to procedure



Inserting a range
You can insert a blank range and shift the selected range right or down.
1. Select a range where you want to insert a blank range of the same proportions.
2. From the Range menu, choose Insert.
3. Select "Insert in selected range only."
4. To shift the selected range right, select "Columns."
5. To shift the selected range down, select "Rows."
6. Click OK.

{button ,AL(`H_INSERTING_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_DELETING_A_RANGE_STEPS;H_DELETING_COLUMNS_OR_ROWS_STEPS;H_INSERTING_CO

LUMNS_OR_ROWS_STEPS;H_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS_STEPS;',0)} See 
related topics



Details: Inserting a range
Styles of inserted ranges
When you insert a range, it has the default styles and formats, not those of the range where you inserted it. The 
range that moves down or to the right keeps its original styles and formats.

How inserting a range affects named ranges
The top-left and bottom-right cells of a named range define the dimensions of the range.

• Inserting a range into a named range can expand it if the inserted range moves the bottom-right cell of the named
range.

• Inserting a range above or to the left of a named range can shrink it if the inserted range moves the top-left cell of 
the named range.

Related SmartIcons

Inserts blank cells in the selected range and moves existing data down or right

Inserts one or more columns to the left of the selected columns

Inserts one or more rows above the selected rows

Inserts one or more sheets before or after the current sheet

{button ,AL(`H_INSERTING_A_RANGE_STEPS',1)} Go to procedure



Deleting columns or rows
You can delete columns or rows from a sheet or group of sheets. Deleting a row or column deletes all the data in the 
row or column, including data that may be in a part of the sheet you cannot currently see.
1. Select a range with at least one cell in as many columns or rows as you want to delete.
2. From the Range menu, choose Delete.
3. To delete columns, select "Columns."
4. To delete rows, select "Rows."
5. Click OK.
Note If the current sheet is part of a group, deleting columns or rows in this sheet deletes columns or rows in all 
sheets in the group.

{button ,AL(`H_DELETING_COLUMNS_OR_ROWS_DETAILS',1)} See details
{button ,AL(`H_DELETING_A_RANGE_STEPS;H_DELETING_SHEETS_STEPS;H_INSERTING_COLUMNS_OR_R

OWS_STEPS;H_GROUPING_SHEETS_STEPS;H_UNGROUPING_SHEETS_STEPS;H_INSERTING_A_RANG
E_STEPS;',0)} See related topics



Details: Deleting columns or rows
Other ways to delete columns or rows
To delete columns or rows immediately without displaying a dialog box, select as many entire columns or rows as you
want to delete, and then do one of the following:

• From the Range menu, choose Delete Columns or Delete Rows.
• Right-click and choose Delete Columns or Delete Rows from the shortcut menu.

How 1-2-3 deletes columns and rows
When you delete columns, the columns to the right move left to take the place of what you deleted. When you delete 
rows, the rows below move up to take the place of what you deleted.

How deleting columns or rows affects formulas
If you delete a column or row containing a range that a formula refers to, the formula results in ERR. Any other 
formulas that depend on this formula also result in ERR.

How deleting columns or rows affects named ranges
If you delete columns or rows containing cells that are part of a named range, the named range shrinks by the 
number of columns or rows you deleted. 
If you delete an entire named range while deleting columns or rows, the range name becomes undefined, and you 
must name the range again to define it. 

Related SmartIcons

Deletes all columns in the selected range

Deletes all rows in the selected range

Deletes all sheets in the selected range

Deletes the selected range and moves existing data up or left

{button ,AL(`H_DELETING_COLUMNS_OR_ROWS_STEPS',1)} Go to procedure
{button ,AL(`H_NAMING_A_RANGE_STEPS;',0)} See related topics



Deleting a range
When you delete a range, you choose whether you want the cells to the right of the range to move left or the cells 
below the range to move up.
1. Select the range you want to delete.
2. From the Range menu, choose Delete.
3. Select "Delete in selected range only."
4. To delete the selected range and move existing data to the left, select "Columns."
5. To delete the selected range and move existing data up, select "Rows."
6. Click OK.
Note If the current sheet is part of a group, deleting a range in this sheet deletes the range in all sheets in the group.

{button ,AL(`H_DELETING_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_DELETING_COLUMNS_OR_ROWS_STEPS;H_DELETING_SHEETS_STEPS;H_INSERTING_A_R

ANGE_STEPS;H_DELETING_DATA_IN_RANGES_STEPS;H_GROUPING_SHEETS_STEPS;H_UNGROUPING
_SHEETS_STEPS;',0)} See related topics



Details: Deleting a range
How deleting a range affects formulas
If you delete a range that a formula refers to, the formula results in ERR. Any other formulas that depend on this 
formula also result in ERR.

How deleting a range affects named ranges
The top-left and bottom-right cells of a named range define the dimensions of the range.

• Deleting an entire named range results in the range name becoming undefined, and you must name the range 
again to define it.

• Deleting a range can affect the size of a named range. When the bottom-right cell of a named range moves 
because you deleted a range contained in the named range,    the named range becomes smaller.

Related SmartIcons

Deletes the selected range and moves existing data up or left

Deletes all columns in the selected range

Deletes all rows in the selected range

Deletes all sheets in the selected range

{button ,AL(`H_DELETING_A_RANGE_STEPS',1)} Go to procedure
{button ,AL(`H_NAMING_A_RANGE_STEPS;H_MOVING_A_FORMULA_STEPS;',0)} See related topics



Deleting sheets
You can delete sheets from a workbook using the Sheet menu or the shortcut menu. 
1. Select the tab of each sheet you want to delete.
2. From the Sheet menu, choose Delete Sheet.

Tip You can also right-click one of the selected sheet tabs, then choose Delete Sheet from the shortcut menu.
Note You cannot delete all the sheets in a workbook.

{button ,AL(`H_DELETING_SHEETS_DETAILS',1)} See details
{button ,AL(`H_CREATING_A_SHEET_STEPS;H_DELETING_COLUMNS_OR_ROWS_STEPS;H_GROUPING_SH

EETS_STEPS;H_UNGROUPING_SHEETS_STEPS;H_SHEETS_OVER;H_123_COPYING_A_SHEET_STEPS;H
_123_S98_MOVING_A_SHEET_STEPS',0)} See related topics



Details: Deleting sheets
Another way to delete sheets
Select a range with at least one cell in each sheet you want to delete, and choose Sheet - Delete Sheet. 

How deleting sheets affects formulas
If you delete a sheet containing a range that a formula refers to, the formula results in ERR. Any other formulas that 
depend on this formula also result in ERR.

How deleting sheets affects named ranges
If you delete sheets containing named ranges, the range names become undefined, and you must name the ranges 
again to define them. 

Related SmartIcons

Deletes all columns in the selected range

Deletes all rows in the selected range

Deletes the selected range and moves existing data up or left

{button ,AL(`H_DELETING_SHEETS_STEPS',1)} Go to procedure
{button ,AL(`H_NAMING_A_RANGE_STEPS;',0)} See related topics



Insert dialog box
Use this dialog box to insert ranges, columns, and rows.

Choose a task
Inserting columns or rows
Inserting a range

{button ,AL(`H_CREATING_A_SHEET_STEPS;',0)} See related topics



Delete dialog box
Use this dialog box to delete ranges, columns, and rows.

Choose a task
Deleting columns or rows
Deleting a range

{button ,AL(`H_DELETING_SHEETS_STEPS;',0)} See related topics



Overview: Sheets
A sheet is an electronic spreadsheet consisting of a grid of 256 columns and 65,536 rows.

Column letters and row numbers
Letters identifying each column in a sheet appear in the sheet frame above each column. Columns are lettered A to 
IV (A to Z, AA to AZ, BA to BZ, and so on to IV).
Numbers identifying each row appear in the sheet frame to the left of each row. Rows are numbered 1 to 65,536.
The intersection of a column and a row is called a cell. Each cell has an address consisting of a sheet letter followed 
by a : (colon), a column letter, and a row number. For example, cell A:A1 is in sheet A at the intersection of column A 
and row 1.

The current cell
The rectangular highlight in the sheet is called the cell pointer. The cell that contains the cell pointer is called the 
current cell. The sheet containing the current cell is called the current sheet. 
When a cell is current, you can enter data in that cell, edit the cell contents, and use the InfoBox and menu 
commands to affect the cell contents and style. To make another cell the current cell, you move the cell pointer.

Multiple-sheet workbooks
When you create a workbook, it initially has one sheet. You can create more sheets in the workbook up to a total of 
256 sheets. If you have more than one workbook open, the total number of sheets in all the open workbooks cannot 
exceed 256.
A letter identifies each sheet from A to IV. The letter for each sheet appears in the top left corner of the sheet and on 
the sheet tab.

Sheet tabs
Each sheet has a tab at the top. You can double-click the tab and enter a name for the sheet. You can also color the 
sheet tabs to organize your sheets visually. 

To go to and display any sheet in a multiple-sheet workbook, click its tab. You can also display more than one sheet 
at the same time by cascading or tiling windows. For more information, see Cascading windows, Tiling windows side 
by side, and Tiling windows top to bottom.
To select a 3D range, select the range on the first sheet in the range, and then SHIFT+click the tab of the last sheet in 
the range.
When you have more sheets than you can see in the Sheet window, you can click the tab-scroll arrows to scroll the 
tabs left or right without changing the current selection. SHIFT+click the tab-scroll arrows to scroll the tabs to the first 



or last sheet in the workbook.

Other ways to work with sheets
You can select a sheet tab by clicking the tab, then once the sheet is current, clicking the sheet tab again. When you 
select a sheet tab, the SmartIcon set for sheets appears and you can right-click to display the shortcut menu for 
working with sheets.

Grouping sheets
You can group contiguous sheets to apply styles, formats, and other settings from one sheet to other sheets in the 
group. Grouping sheets is a convenient way to make several sheets look the same.    For more information, see 
Overview: Grouping sheets. 

Freezing titles
You can freeze column and row titles to keep them in view as you scroll through the sheet. 

To freeze titles, you can drag a column or row border or use the View - Titles command. You can unfreeze titles when 
you no longer need to keep them in view.

{button ,AL(`H_CHANGING_TAB_COLOR_STEPS;H_CREATING_A_SHEET_STEPS;H_FREEZING_COLUMNS_A
ND_ROWS_AS_TITLES_STEPS;H_GROUPING_SHEETS_STEPS;H_HIDING_OR_SHOWING_TABS_STEPS;H
_NAMING_A_SHEET_STEPS;H_DELETING_SHEETS_STEPS;;H_SELECTING_SHEETS_STEPS;H_HIDING_S
HEETS_STEPS;H_123_COPYING_A_SHEET_STEPS;H_123_S98_MOVING_A_SHEET_STEPS;H_MOVING_A
_SHEET_STEPS',0)} See related topics



Creating a sheet
You can create new sheets and place them before or after the current sheet.
Want the big picture? See Overview: Sheets.
1. From the Create menu, choose Sheet.

2. Click the arrows or enter the number of sheets you want to create in the "Number of sheets" box.
3. Under Place, select an option.
4. Click OK.
Tip You can click the New Sheet button to create a new sheet after the current sheet.

{button ,AL(`H_CREATING_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_DELETING_SHEETS_STEPS;H_NAMING_A_SHEET_STEPS;H_MOVING_A_SHEET_STEPS;H_12

3_COPYING_A_SHEET_STEPS;H_123_S98_MOVING_A_SHEET_STEPS',0)} See related topics



Details: Creating a sheet
Another way to create sheets
To create a sheet using the shortcut menu, click a sheet tab to make the sheet current, click the sheet tab again to 
select it, right-click to display the shortcut menu, and then choose Create - Sheet.

How 1-2-3 inserts new sheets
• After current sheet -- Inserts new sheet(s) after the current sheet. If a 3D range is selected, this option inserts 

sheets after the sheet containing the cell pointer.
• Before current sheet -- Inserts new sheet(s) before the current sheet. If a 3D range is selected, this option inserts 

sheets before the sheet containing the cell pointer.

Restrictions on number of sheets
A workbook cannot contain more than 256 sheets.

How creating new sheets affects formulas
When you create new sheets, 1-2-3 redefines named ranges and, if necessary, adjusts addresses in formulas.
For example, if you entered the formula +A:A1+B:A1+C:A1 and then created three sheets after sheet A, 1-2-3 adjusts
the address so that the formula becomes +A:A1+E:A1+F:A1.

{button ,AL(`H_CREATING_A_SHEET_STEPS',1)} Go to procedure



Naming a sheet
When you name a sheet, the name replaces the sheet letter on the sheet tab, making it easier to find and identify 
information. The fastest way to name a sheet is to enter the name directly on the sheet tab. 
Want the big picture? See Overview: Sheets.

 Show me a QuickDemo
1. Double-click the tab of the sheet you want to name.
2. Enter a name according to the naming conventions.
3. Press ENTER. 

{button ,AL(`H_NAMING_A_SHEET_DETAILS',1)} See details
{button ,AL(`H_NAMING_A_SHEET_USING_THE_INFOBOX_STEPS;H_HIDING_OR_SHOWING_TABS_STEPS;H

_DELETING_A_SHEET_NAME_STEPS',0)} See related topics



Details: Naming a sheet
Duplicate sheet names
You cannot enter duplicate sheet names in the same workbook.

Naming sheets automatically
If 1-2-3 recognizes the name of the current sheet as part of a SmartFill sequence, you can automatically name sheets
that you create before or after the current sheet.
For example, suppose the current sheet is named January. If you click the New Sheet button twice, 1-2-3 places two 
new sheets after January and automatically names them February and March. If you use Create - Sheet to create two
sheets before the one named January, 1-2-3 automatically names them November and December.
The default SmartFill lists for sheet tabs are the same as the ones for filling ranges. You can also create custom 
SmartFill lists for naming sheets. For more information, see Overview: Creating custom SmartFill lists.

Using sheet names in formulas
When referring to a range in a formula or @function, you can use a sheet name in place of a sheet letter. For 
example, if the name of sheet B is Tokyo, you can refer to cell B5 in that sheet as Tokyo:B5.
If a sheet has a name, 1-2-3 converts sheet letters in formula references to the corresponding sheet names. For 
example, if the name of sheet A is Chicago, 1-2-3 converts the formula +A:A5-B:A3 to +Chicago:A5-B:A3.

{button ,AL(`H_NAMING_A_SHEET_STEPS',1)} Go to procedure



Naming a sheet using the InfoBox
You can use the InfoBox to change the name of the current sheet.
Want the big picture? See Overview: Sheets.
1. From the Sheet menu, choose Sheet Properties.

2. Click the Basics tab in the InfoBox.

3. Enter the sheet name in the "Sheet name" box.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_NAMING_A_SHEET_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_CHANGING_TAB_COLOR_STEPS;H_HIDING_OR_SHOWING_TABS_STEPS;H_NAMING_A_SHE

ET_STEPS;H_THE_INFOBOX_OVER;',0)} See related topics



Details: Naming a sheet using the InfoBox
Other ways to name a sheet
You can use the shortcut menu to open the InfoBox for sheets: click the sheet tab to make the sheet current, click the
sheet tab again to select it, right-click to display the shortcut menu, and then choose Sheet Properties. You can also 
enter the sheet name directly on the sheet tab: double-click the sheet tab, enter the new name, and press ENTER. 

Duplicate sheet names
You cannot enter duplicate sheet names in the same workbook.

Naming sheets automatically
If 1-2-3 recognizes the name of the current sheet as part of a SmartFill sequence, you can automatically name sheets
that you create before or after the current sheet.
For example, suppose the current sheet is named January. If you click the New Sheet button twice, 1-2-3 places two 
new sheets after January and automatically names them February and March. If you use Create - Sheet to create two
sheets before the one named January, 1-2-3 automatically names them November and December.
The default SmartFill lists for sheet tabs are the same as the ones for filling ranges. You can also create custom 
SmartFill lists for naming sheets. For more information, see Creating custom SmartFill lists.

Using sheet names in formulas
When referring to a range in a formula or @function, you can use a sheet name in place of a sheet letter. For 
example, if the name of sheet B is Tokyo, you can refer to cell B5 in that sheet as Tokyo:B5.
If a sheet has a name, 1-2-3 converts sheet letters in formula references to the corresponding sheet names. For 
example, if the name of sheet A is Chicago, 1-2-3 converts the formula +A:A5-B:A3 to +Chicago:A5-B:A3.

{button ,AL(`H_NAMING_A_SHEET_USING_THE_INFOBOX_STEPS',1)} Go to procedure



Deleting a sheet name
You can delete a sheet name so that the original sheet letter reappears on the sheet tab.
1. Double-click the sheet tab.
2. Press DEL or BACKSPACE.
3. Press ENTER.

{button ,AL(`H_DELETING_A_SHEET_NAME_DETAILS',1)} See details
{button ,AL(`H_CHANGING_TAB_COLOR_STEPS;H_DELETING_SHEETS_STEPS;H_HIDING_OR_SHOWING_TA

BS_STEPS;H_NAMING_A_SHEET_STEPS;H_123_MOVING_A_SHEET_STEPS',0)} See related topics



Details: Deleting a sheet name
How deleting sheet names affects formulas
When you delete a sheet name, 1-2-3 replaces the name with the correct sheet letter in formulas and @functions. 
For example, if the name of sheet B is Tokyo, and you delete the name, 1-2-3 changes the formula +Tokyo:A5-C:A3 
to +B:A5-C:A3.

{button ,AL(`H_DELETING_A_SHEET_NAME_STEPS',1)} Go to procedure



Hiding or showing sheet tabs
You can choose whether you want the sheet tabs to display.
Want the big picture? See Overview: Sheets.
1. From the File menu, choose Workbook Properties.

2. Click the View tab.

3. To hide tabs, deselect "Sheet tabs."
4. To show tabs, select "Sheet tabs."
5. Click OK.

{button ,AL(`H_HIDING_OR_SHOWING_TABS_DETAILS',1)} See details
{button ,AL(`H_CHANGING_TAB_COLOR_STEPS;H_NAMING_A_SHEET_STEPS;H_SHEET_NAVIGATION_KEYS

_OVER',0)} See related topics



Details: Hiding or showing sheet tabs
Another way to hide and show tabs
You can use View - Set View Preferences to hide and show sheet tabs. 

Other ways to navigate between sheets
When the sheet tabs are hidden, you can use CTRL+PG UP to go from one sheet to the next and CTRL+PG DN to go to
the previous sheet.

{button ,AL(`H_HIDING_OR_SHOWING_TABS_STEPS',1)} Go to procedure



Changing sheet tab color
To organize your sheets visually, you can assign a color to the tab of the current sheet.
1. From the Sheet menu, choose Sheet Properties.

2. Click the Basics tab in the InfoBox.

3. Select a color from the "Tab color" list.
4. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_CHANGING_TAB_COLOR_DETAILS',1)} See details
{button ,AL(`H_HIDING_OR_SHOWING_TABS_STEPS;H_NAMING_A_SHEET_STEPS;',0)} See related topics



Details: Changing sheet tab color
Other ways to change sheet tab color
You can also change sheet tab color using the shortcut menu. Select the tab, right-click to display the shortcut menu, 
choose Sheet properties, and select a color from the "Tab color" list on the Basics tab.

{button ,AL(`H_CHANGING_TAB_COLOR_STEPS',1)} Go to procedure



Overview: Grouping sheets
Grouping sheets is a convenient way to make sheets look the same. 
You can group contiguous sheets to apply styles, formats, and other settings of one sheet to other sheets in the 
group. For example, suppose you want twelve sheets to contain expense figures for each month of the year. Style 
one sheet and then group the twelve sheets to apply the same styles to the other sheets.

Effects of grouping sheets
1-2-3 applies the following styles, formats, and settings from the specified sheet to all other sheets in the group: 
number formats, fonts and text attributes, colors, alignments, row height, column width, protection settings, frozen 
titles, page breaks, and outlines. If you change a setting in any one grouped sheet, all sheets in the group change.
If you add or delete columns or rows in one sheet, 1-2-3 adds or deletes the same columns or rows in all the sheets 
in the group.
Sheet letters or names on the tabs of grouped sheets appear in italics. Also, when a grouped sheet is the current 
sheet, "Grp" appears in the status bar.

When not to group sheets
Do not group sheets if you want to keep styles or other settings unique to a particular sheet. When you group sheets, 
the settings of the specified sheet overwrite any existing ones in the other sheets in the group.
Note Ungrouping does not restore the styles, formats, and settings applied to a sheet before grouping.
Do not group sheets if you anticipate deleting columns or rows from one of the grouped sheets. When you delete 
columns or rows in one sheet in a group, 1-2-3 deletes the columns or rows from all the grouped sheets, and you can
lose data.
Tip Ungroup the sheets before you delete columns or rows from one sheet in a group. 

{button ,AL(`H_SHEETS_OVER;H_UNGROUPING_SHEETS_STEPS;H_GROUPING_SHEETS_STEPS',0)} See 
related topics



Grouping sheets
You can group contiguous sheets to apply styles, formats, and other settings of one sheet to other sheets in the 
group.
Want the big picture? See Overview: Grouping sheets.
1. From the Sheet menu, choose Group Sheets.

2. Specify the first sheet in the group in the "First sheet of group" box.
3. Specify the last sheet in the group in the "Last sheet of group" box.
4. In the "Copy styles from this sheet" list, click the sheet whose styles you want to apply to the group.
5. Click OK.
Caution You can lose data if you forget that sheets are grouped. For example, while sheets are grouped, if you 
delete a column in one sheet, you delete it in all sheets in the group.

{button ,AL(`H_GROUPING_SHEETS_DETAILS',1)} See details
{button ,AL(`H_SHEETS_OVER;H_UNGROUPING_SHEETS_STEPS;',0)} See related topics



Details: Grouping sheets
Sheet letters or names on the tabs of grouped sheets appear in italics. Also, when a grouped sheet is the current 
sheet, "Grp" appears in the status bar.

Effects of grouping sheets
1-2-3 applies the following styles, formats, and settings from the specified sheet to all other sheets in the group: 
number formats, fonts and text attributes, colors, alignments, row height, column width, protection settings, frozen 
titles, page breaks, and outlines. If you change a setting in any one grouped sheet, all sheets in the group change.
Do not group sheets if you want to keep styles or other settings unique to a particular sheet. When you group sheets, 
the settings of the specified sheet overwrite any existing ones in the other sheets in the group.
Ungrouping does not restore the styles, formats, and settings applied to a sheet before grouping.

Related SmartIcons

Groups sheets

Ungroups sheets

{button ,AL(`H_GROUPING_SHEETS_STEPS',1)} Go to procedure



Ungrouping sheets
You can ungroup sheets when you have finished making changes to the styles and formats of all the sheets at once, 
or if you want to make a change to a single sheet.
Want the big picture? See Overview: Grouping sheets.
From the Sheet menu, choose Clear Sheet Group.

{button ,AL(`H_UNGROUPING_SHEETS_DETAILS',1)} See details
{button ,AL(`H_GROUPING_SHEETS_STEPS;H_SHEETS_OVER;',0)} See related topics



Details: Ungrouping sheets
After you ungroup sheets, the "Grp" indicator no longer appears in the status bar.

{button ,AL(`H_UNGROUPING_SHEETS_STEPS',1)} Go to procedure



Freezing columns and rows as titles
You can drag the sheet border to freeze columns, rows, or both so column and row titles remain in view as you scroll 
through the sheet.
 Want the big picture? See Overview: Sheets.

 Show me a QuickDemo
1. To freeze columns, position the mouse pointer on the border of the sheet frame to the right of the row numbers 

and below the column letters, and then drag right to the last column you want to freeze.

2. To freeze rows, position the mouse pointer on the border of the sheet frame below the column letters and to the 
right of the row numbers, and then drag down to the last row you want to freeze.

Note No gridlines appear in the frozen title area. 

{button ,AL(`H_FREEZING_COLUMNS_AND_ROWS_AS_TITLES_DETAILS',1)} See details
{button ,AL(`H_CLEARING_FROZEN_TITLES_STEPS;H_FREEZING_TITLES_USING_THE_COMMAND_STEPS;H

_PRINT_ADDING_TITLES_ON_EACH_PAGE_STEPS',0)} See related topics



Details: Freezing columns and rows as titles
Sizing frozen columns or rows
You can size frozen columns and rows in the same way as you size other columns and rows. For more information, 
see Sizing columns or Sizing rows.

How sizing the Sheet window affects frozen titles
If you size the Sheet window so that only the frozen title area is visible, 1-2-3 unfreezes the titles. To restore them, 
increase the size of the Sheet window and freeze the titles again.

Editing frozen titles
To move the cell pointer into the title area, press HOME and then use the arrow keys to move the pointer where you 
want to enter or edit a title.

Putting graphic objects in the title area
You can put graphic objects, such as script or macro buttons, in the frozen title area. The graphic objects remain 
visible along with the titles as you scroll through the sheet. This way, you can scroll to data in the sheet and still have 
the button available to run a script or macro.

Printing frozen titles
The rows and columns that you freeze in a sheet appear as frozen titles only on the screen. To print frozen titles, you 
specify the columns and rows in the InfoBox for Preview & Page Setup. For more information, see Printing titles on 
each page.

{button ,AL(`H_FREEZING_COLUMNS_AND_ROWS_AS_TITLES_STEPS',1)} Go to procedure



Freezing titles using the command
You can freeze columns, rows, or both so column and row titles remain in view as you scroll through the sheet.
Want the big picture? See Overview: Sheets.
1. Do one of the following:

• To freeze columns, position the cell pointer one cell to the right of the columns you want to freeze.
• To freeze rows, position the cell pointer one cell below the rows you want to freeze.
• To freeze both columns and rows, position the cell pointer in the cell below the rows and to the right of the 

columns you want to freeze.

2. From the View menu, choose Titles.
3. Select one or both options.

Note Selecting both of these options freezes both rows and columns as titles. Deselecting these options clears 
frozen titles.

4. Click OK.
Note No gridlines appear in the frozen title area.

{button ,AL(`H_FREEZING_TITLES_USING_THE_COMMAND_DETAILS',1)} See details
{button ,AL(`H_CLEARING_FROZEN_TITLES_STEPS;H_FREEZING_COLUMNS_AND_ROWS_AS_TITLES_STEP

S;H_PRINT_ADDING_TITLES_ON_EACH_PAGE_STEPS',0)} See related topics



Details: Freezing titles using the command
How 1-2-3 freezes column and row titles
To freeze both columns and rows, select both options.

• Rows above current cell -- Freezes the rows above the cell pointer.
• Columns left of current cell -- Freezes the columns to the left of the cell pointer.

How sizing the Sheet window affects frozen titles
If you size the Sheet window so that only the frozen title area is visible, 1-2-3 unfreezes the titles. To restore them, 
increase the size of the Sheet window and freeze the titles again.

Sizing frozen columns or rows
You can size frozen columns and rows in the same way as you size other columns and rows. For more information, 
see Sizing columns or Sizing rows.

Editing frozen titles
To move the cell pointer into the title area, press HOME and then use the arrow keys to move the pointer where you 
want to enter or edit a title.

Putting graphic objects in the title area
You can put graphic objects, such as script or macro buttons, in the frozen title area. The graphic objects remain 
visible along with the titles as you scroll through the sheet. This way, you can scroll to data in the sheet and still have 
the button available to run a script or macro.

Printing frozen titles
The rows and columns that you freeze in a sheet appear as frozen titles only on the screen. To print frozen titles, you 
specify the columns and rows in the InfoBox for Preview & Page Setup. For more information, see Printing titles on 
each page.

{button ,AL(`H_FREEZING_TITLES_USING_THE_COMMAND_STEPS',1)} Go to procedure



Clearing frozen titles
To release columns or rows so they scroll with the rest of the sheet, you can clear the frozen titles.
1. Move the cell pointer to the sheet whose titles you want to clear.
2. From the View menu, choose Titles.
3. Deselect "Rows above current cell" to clear the row titles.
4. Deselect "Columns left of current cell" to clear the column titles.
5. Click OK.

{button ,AL(`H_CLEARING_FROZEN_TITLES_DETAILS',1)} See details
{button ,AL(`H_FREEZING_COLUMNS_AND_ROWS_AS_TITLES_STEPS;',0)} See related topics



Details: Clearing frozen titles
Other ways to clear frozen titles
To clear frozen column titles, position the mouse pointer on the right border of the last frozen column and drag left to 
the row numbers.
To clear frozen row titles, position the mouse pointer on the bottom border of the last frozen row and drag up to the 
column letters.

{button ,AL(`H_CLEARING_FROZEN_TITLES_STEPS',1)} Go to procedure



Overview: Selecting sheet areas
You select a sheet area to indicate where you want to enter data or perform a command. 

What you can select
You can select the following sheet areas:

• A cell -- The basic unit of a sheet formed by the intersection of a column and a row. Select a cell to enter or edit 
text, numbers, and formulas. 

• A range -- A block of cells that can be as small as a single cell, or as large as all the sheets in a workbook. A 
range is represented as the addresses of its top left and bottom right cells. Select a range to perform actions on a 
contiguous group of cells; for example, to copy, move, and style the cells, or to create a version.

• A 3D range -- A range that spans two or more contiguous sheets and includes the same cells in those sheets. 
• A collection -- A group of non-contiguous ranges, selected at the same time. The ranges can touch, not touch, or 

overlap. 

• A column or row -- You can move, copy, insert, and delete entire columns or rows, or create an outline by 
demoting columns or rows.

• A sheet -- A spreadsheet "page," consisting of a grid of 256 columns and 65,536 rows, in the workbook. Clicking 
the sheet letter selects all the cells in the sheet. Clicking the sheet tab selects the sheet as an object. For 
example, if you want to delete the contents of a sheet and leave the sheet blank, select the sheet letter and press 
DEL. If you want to delete a sheet, click the sheet tab and choose Sheet - Delete Sheet.

How to tell what's selected
Selection indicator
The selection indicator displays the address or name of the current selection.

"Properties for" box
The "Properties for" box at the top of the InfoBox tells you whether you are changing the properties for the currently 
selected range, sheet, or graphic object. 



Context menu
The context menu, located between Create and Sheet on the main menu, changes depending on what is selected. 
For example, if you select a drawing, you see Drawing in the menu, but if you select a range, that menu item changes
to Range.

{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS;H_QUICK_SUMMARY_OF_SELECTION
_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTING_A_COLLECTION_OF_RANGES_STEPS;H_SEL
ECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECTING_A_RANGE_STEPS;H_SELECTING_A_SINGL
E_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_STEPS;H_SELECTING_SHEETS_STEPS;H_QUICK
_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_OBJECTS_OVER',0)} See related topics



Selecting sheet areas
The table below summarizes the techniques for selecting sheet areas.

To select Do this
Cell Mouse: Click the cell.

Keyboard: Use the pointer-movement keys to move the cell 
pointer to the cell.

Range Mouse: Drag across the range.
Keyboard: Press SHIFT and use the pointer-movement keys 
to highlight the range.

3D range Mouse: Select the range in the first sheet, then SHIFT+click 
the tab of the last sheet in the range.
Keyboard: Select the range in the first sheet, then press 
CTRL+SHIFT+PGUP to extend the range to subsequent 
sheets. 

Collection Select the first range, then hold down CTRL and select the 
other ranges.

Column or row Click the column letter or row number.
Sheet To select the sheet, click the sheet tab once to make the 

sheet current, then click the tab again. 
All cells in a sheet Click the sheet letter in the sheet frame (not the sheet tab).

{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTIN
G_A_COLLECTION_OF_RANGES_STEPS;H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECT
ING_A_RANGE_STEPS;H_SELECTING_A_SINGLE_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_S
TEPS;H_SELECTING_SHEETS_STEPS;H_SELECTING_SHEET_AREAS_OVER;H_SELECTION_KEYS_OVER
',0)} See related topics



Selecting sheets
You can select the sheet tab to change the properties of the sheet (the sheet defaults), or you can select all the cells 
in the sheet.
To select the sheet tab, click the tab once to make the sheet current, then click the tab again.
To select all the cells in a sheet, click the sheet letter.

Tip Select multiple sheets to change the properties of several sheets at once. To select several sheets, select the first
sheet tab, then SHIFT+click or CTRL+click the other sheet tabs.

{button ,AL(`H_SELECTING_SHEETS_DETAILS',1)} See details
{button ,AL(`H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECTING_A_RANGE_STEPS;H_SELE

CTING_COLUMNS_OR_ROWS_STEPS;H_SELECTING_SHEET_AREAS_OVER;H_123_COPYING_A_SHEET
_STEPS;H_123_S98_MOVING_A_SHEET_STEPS',0)} See related topics



Details: Selecting sheets
To select a sheet, you must use the mouse. 

Making changes to entire sheets
Use Sheet - Sheet Properties to make changes to one or more entire sheets. See Overview: Sheet defaults for more 
information.

Canceling a selection
To cancel a selection, press ESC or click anywhere in the sheet.

Copying and moving sheets
You do not need to select a sheet to copy or move it. For more information, see Copying a sheet or Moving a sheet. 

{button ,AL(`H_SELECTING_SHEETS_STEPS',1)} Go to procedure



Selecting a single cell
To enter data in a cell or perform a command on a cell, you must select it.
To select a single cell, click the cell.
Tip If the cell you want to select isn't visible, use F5 (GOTO), or the scroll bars to find it.

{button ,AL(`H_SELECTING_A_SINGLE_CELL_DETAILS',1)} See details
{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS;H_QUICK_SUMMARY_OF_SELECTION

_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTING_A_COLLECTION_OF_RANGES_STEPS;H_SEL
ECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECTING_A_RANGE_STEPS;H_SELECTING_A_SINGL
E_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_STEPS;H_SELECTING_SHEETS_STEPS;H_SELEC
TING_SHEET_AREAS_OVER;',0)} See related topics



Details: Selecting a single cell
Other ways to select a single cell

• Use the pointer-movement keys to move the cell pointer to the cell.
• To select a cell and display the shortcut menu, right-click the cell.

{button ,AL(`H_SELECTING_A_SINGLE_CELL_STEPS',1)} Go to procedure



Selecting a range
To perform a command on a range, you must select the range.
1. Move the mouse pointer to a corner of the range.
2. Hold down the left mouse button and drag across the cells you want to select.
3. Release the mouse button when the range is highlighted.
Tip You can ALT+double-click any cell in a range to select the entire range, if the range borders a blank column or 
row. 

{button ,AL(`H_SELECTING_A_RANGE_DETAILS',1)} See details
{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTIN

G_A_COLLECTION_OF_RANGES_STEPS;H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECT
ING_A_RANGE_STEPS;H_SELECTING_A_SINGLE_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_S
TEPS;H_SELECTING_SHEETS_STEPS;H_SELECTING_SHEET_AREAS_OVER;H_SELECTING_A_RANGE_F
ROM_A_DIALOG_BOX_STEPS;H_SELECTION_KEYS_OVER',0)} See related topics



Details: Selecting a range
Other ways to select a range

• With the cell pointer in one corner of the range, SHIFT+click the diagonally opposite corner.
• With the cell pointer in one corner of the range, hold down SHIFT and use the pointer-movement keys to highlight 

the range.
• Press F4 to anchor the cell pointer, then use the pointer-movement keys to highlight the range.

Reshaping a selection
To extend or shrink a range to a particular cell, SHIFT+click that cell. 

Canceling a selection
To cancel a selection, press ESC or click anywhere in the sheet.

Selecting a range while using the InfoBox or a dialog box
While the InfoBox is displayed, you can select any range whose properties you want to change. In some dialog boxes
and InfoBox tabs, you can select a range by using the range selector.

{button ,AL(`H_SELECTING_A_RANGE_STEPS',1)} Go to procedure
{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS;H_SELECTION_KEYS_OVER',0)} See 

related topics



Selecting columns or rows
Selecting a column or row selects all the cells in that column or row.
To select a column or row, click the column letter or row number.

{button ,AL(`H_SELECTING_COLUMNS_OR_ROWS_DETAILS',1)} See details
{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTIN

G_A_COLLECTION_OF_RANGES_STEPS;H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECT
ING_A_RANGE_STEPS;H_SELECTING_A_SINGLE_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_S
TEPS;H_SELECTING_SHEETS_STEPS;H_SELECTING_SHEET_AREAS_OVER;',0)} See related topics



Details: Selecting columns or rows
To select rows or columns, you must use the mouse.

Selecting multiple columns or rows
To extend the selection to consecutive columns or rows, SHIFT+click the letter of the last column or the number of the 
last row in the range. You can also drag across column letters or row numbers.
To add non-consecutive columns or rows to your selection, CTRL+click the letter of each column or the number of 
each row.

Canceling a selection
To cancel a selection, press ESC or click anywhere in the sheet.

{button ,AL(`H_SELECTING_COLUMNS_OR_ROWS_STEPS',1)} Go to procedure



Selecting a collection of ranges
A collection can include single cells, ranges, 3D ranges, and entire columns, rows, and sheets. 
1. Select the first range in the collection.
2. Hold down CTRL while selecting the ranges you want to add to the collection.

3. (Optional) To add a range in another sheet, CTRL+click the sheet tab to display the sheet, and hold down CTRL 
while selecting the range.

Tip To remove a range from a collection, CTRL+click the range. To re-shape an individual range in a collection, hold 
down CTRL and drag within that range.

{button ,AL(`H_SELECTING_A_COLLECTION_OF_RANGES_DETAILS',1)} See details
{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTIN

G_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECTING_A_RANGE_STEPS;H_SELECTING_A_SINGLE_CE
LL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_STEPS;H_SELECTING_SHEETS_STEPS;H_SELECTING_
SHEET_AREAS_OVER;',0)} See related topics



Details: Selecting a collection of ranges
Adding a 3D range to a collection
Hold down CTRL while selecting the range in the first sheet of the 3D range and CTRL+SHIFT+click the sheet tab of 
the last sheet you want to include in the 3D range.

Canceling a selection
To cancel a selection, press ESC or click anywhere in the sheet.

Which commands apply to collections?
Not all commands that apply to ranges apply to collections. For example, you can't name or copy a collection. Most 
styling commands you perform in the InfoBox do apply to collections, with the exception of named style commands. 
If a command doesn't apply to a collection, 1-2-3 will either perform the command on the current range in the 
collection (the range containing the cell pointer) or display a message.

{button ,AL(`H_SELECTING_A_COLLECTION_OF_RANGES_STEPS',1)} Go to procedure



Selecting a range across sheets
To perform a command on a 3D range, you must first select the 2D range.
1. Select the range in the first sheet of the 3D range.
2. SHIFT+click the sheet tab of the last sheet you want to include in the range.
Tip To cancel a selection, press ESC or click anywhere in the sheet.

{button ,AL(`H_SELECTING_A_RANGE_ACROSS_SHEETS_DETAILS',1)} See details
{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS;H_QUICK_SUMMARY_OF_SELECTION

_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTING_A_COLLECTION_OF_RANGES_STEPS;H_SEL
ECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECTING_A_RANGE_STEPS;H_SELECTING_A_SINGL
E_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_STEPS;H_SELECTING_SHEETS_STEPS;H_SELEC
TING_SHEET_AREAS_OVER;',0)} See related topics



Details: Selecting a range across sheets
Selecting a range across sheets with the keyboard 
Select the range in the first sheet, then press CTRL+SHIFT+PG UP or CTRL+SHIFT+PG DN to extend your selection to 
the next sheet in the 3D range. 

Checking your selection
You can use the selection indicator to check the address of your 3D selection. 

{button ,AL(`H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS',1)} Go to procedure



Selecting a range from a dialog box
You can select a range from within some dialog boxes and InfoBox tabs by using the range selector. 
1. Click the range selector to hide the dialog box or InfoBox.

The pointer changes to the range selector pointer.

2. Select the range.
3. When you release the mouse button, the dialog box or InfoBox reappears, with the range address entered.
Tip You don't have to hide the dialog box or InfoBox to select a range. If the range is visible, click in the "Range" box 
and use the mouse to select the range.

{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_DETAILS',1)} See details
{button ,AL(`H_QUICK_SUMMARY_OF_SELECTION_TECHNIQUES_FOR_SHEET_AREAS_OVER;H_SELECTIN

G_A_COLLECTION_OF_RANGES_STEPS;H_SELECTING_A_RANGE_ACROSS_SHEETS_STEPS;H_SELECT
ING_A_RANGE_STEPS;H_SELECTING_A_SINGLE_CELL_STEPS;H_SELECTING_COLUMNS_OR_ROWS_S
TEPS;H_SELECTING_SHEETS_STEPS;H_SELECTING_SHEET_AREAS_OVER;',0)} See related topics



Details: Selecting a range from a dialog box
Specifying a range using the keyboard
In the dialog box or InfoBox, click in the "Range" box, then use the pointer movement keys to move the cell pointer to 
a corner of the range. Press . (period) to anchor the cell pointer, then use the pointer movement keys to select the 
range. Press ENTER to complete your selection. 
Note This method is not available in all dialog box or InfoBox situations. 1-2-3 must be in Point mode.

Specifying a range name using the navigator
In the dialog box or InfoBox, click in the "Range" box, then click the navigator and select from the list of named 
ranges in the current sheet.

{button ,AL(`H_SELECTING_A_RANGE_FROM_A_DIALOG_BOX_STEPS',1)} Go to procedure
{button ,AL(`H_123_POINT_MODE_OVER',0)} See related topics



Overview: Sizing columns and rows
You can change column width and row height by dragging the column or row border, or by using the InfoBox. 

Changing column width
You can change column width to fit a particular number of characters, or you can set the width to fit the widest entry 
in the column.
When a value is too wide to fit in a cell, it appears in Scientific format or as a line of *** (asterisks).

To display the value, widen the column.

Changing row height
1-2-3 automatically adjusts row height to match the height of the tallest font in the row, or to fit text that you wrap in a 
cell.
You can change row height to a particular number of points or reset it to fit the tallest font in the row.

{button ,AL(`H_FITTING_THE_TALLEST_ROW_ENTRY_STEPS;H_FITTING_THE_WIDEST_COLUMN_ENTRY_ST
EPS;H_SIZING_COLUMNS_STEPS;H_SIZING_COLUMNS_USING_THE_INFOBOX_STEPS;H_SIZING_ROWS
_STEPS;H_SIZING_ROWS_USING_THE_INFOBOX_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;',0)} 
See related topics



Sizing columns
You can size a column by dragging the column border.
Want the big picture?    See Overview: Sizing columns and rows.

 Show me a QuickDemo
1. Position the mouse pointer on the column border to the right of the column letter.

2. Drag the border right or left until the column is the width you want.
As you drag, an indicator appears displaying the column width in characters.

3. Release the mouse button.

{button ,AL(`H_SIZING_COLUMNS_DETAILS',1)} See details
{button ,AL(`H_SIZING_COLUMNS_USING_THE_INFOBOX_STEPS;H_SIZING_ROWS_STEPS;H_SIZING_ROWS

_USING_THE_INFOBOX_STEPS;H_FITTING_THE_WIDEST_COLUMN_ENTRY_STEPS;H_123_COPYING_C
OLUMN_WIDTHS_AND_ROW_HEIGHTS_STEPS',0)} See related topics



Details: Sizing columns
Setting the column width in characters
1-2-3 sizes columns in whole-character increments from 0 (zero) to 240 characters. Setting column width to 0 hides 
the column. For more information about displaying hidden columns, see Displaying hidden columns.

Sizing several columns at once
To size more than one column at once, select the columns and drag the border of one of them.
You can also select several entire columns and double-click the right border of one of them; each selected column 
adjusts to fit its widest entry.

How changing column width affects values
When a column is too narrow to display an entire value as formatted, the value appears in Scientific format or as a 
line of *** (asterisks). To display the value, you must widen the column to the width of the formatted value.

How changing column width affects labels
If a label is longer than the cell it occupies and the cells to the right are blank, 1-2-3 displays the label across the 
blank cells. If the cells to the right contain data, 1-2-3 displays only the part of the label that fits in the cell where it is 
entered.
To see the complete label, you must widen the column or wrap the text in the cell. For more information, see 
Wrapping data in a cell.

{button ,AL(`H_SIZING_COLUMNS_STEPS',1)} Go to procedure



Sizing rows
You can size a row by dragging the bottom row border.
Want the big picture?    See Overview: Sizing columns and rows.

 Show me a QuickDemo
1. Position the mouse pointer on the bottom border of the row.

2. Drag the border up or down until the row is the height you want.
As you drag, an indicator appears displaying row height in points.

3. Release the mouse button.

{button ,AL(`H_SIZING_ROWS_DETAILS',1)} See details
{button ,AL(`H_SIZING_COLUMNS_STEPS;H_SIZING_COLUMNS_USING_THE_INFOBOX_STEPS;H_SIZING_R

OWS_USING_THE_INFOBOX_STEPS;H_FITTING_THE_TALLEST_ROW_ENTRY_STEPS;H_123_COPYING_
COLUMN_WIDTHS_AND_ROW_HEIGHTS_STEPS',0)} See related topics



Details: Sizing rows
Setting the row height in points
1-2-3 sizes rows in points from 0 (zero) to 255 points. Setting row height to 0 hides the row. For more information 
about displaying hidden rows, see Displaying hidden rows.
When you set the row height to a specific number of points, it no longer adjusts automatically to match the largest 
font in the row. For more information about fitting the largest font in the row, see Fitting the tallest row entry.

How changing fonts affects row height
If you change data in a selected range to a smaller font and the rows in the range do not contain any data in a larger 
font, the row height decreases according to the new font height. Row height, however, does not decrease to less than
the default font size set for the sheet.
When you change row height, the heights of fonts in the row do not change.

Sizing several rows at once
To size more than one row at once, select the entire rows you want to size and drag the border of one of them.
You can also select several entire rows and double-click the bottom border of one of them; each row adjusts to fit its 
tallest entry.
Sizing rows to fit their tallest entry adjusts each row in the selected range to fit the largest font in the row or to fit the 
alignment orientation selected on the Alignment tab in the InfoBox.

{button ,AL(`H_SIZING_ROWS_STEPS',1)} Go to procedure



Sizing columns using the InfoBox
You can use the InfoBox to size columns to a particular width in characters, to the default width, or to fit the widest 
entry.
Want the big picture?    See Overview: Sizing columns and rows.
1. Select at least one cell in each column you want to size.
2. From the Range menu, choose Range Properties.

3. Click the Basics tab in the InfoBox.

4. To set the width in characters, select "Width" and click the arrows or enter a number in the "Width" box.
5. To reset the column to the default width, select "Default width."
6. To size the column to its widest entry, click the icon shown below.

7. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SIZING_COLUMNS_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_SIZING_COLUMNS_STEPS;H_SIZING_ROWS_STEPS;H_SIZING_ROWS_USING_THE_INFOBOX

_STEPS;H_FITTING_THE_WIDEST_COLUMN_ENTRY_STEPS;',0)} See related topics



Details: Sizing columns using the InfoBox
Setting column width
The Basics tab in the InfoBox has options for setting column width.

• Width -- Sizes columns in whole characters from 0 (zero) to 240 characters. Setting column width to 0 hides the 
column. For more information about displaying hidden columns, see Displaying hidden columns.

• Default width -- Sets columns to the default width. 1-2-3 adjusts columns to the default width set with Sheet - 
Sheet Properties. The initial default width is 9 characters.

How changing column width affects values
When a column is too narrow to display an entire value as formatted, the value appears in Scientific format or as a 
line of *** (asterisks). To display the value, you must widen the column to the width of the formatted value.

How changing column width affects labels
If a label is longer than the cell it occupies and the cells to the right are blank, 1-2-3 displays the label across the 
blank cells. If the cells to the right contain data, 1-2-3 displays only the part of the label that fits in the cell where it is 
entered.
To see the complete label, you must widen the column or wrap the text in the cell. For more information, see 
Wrapping data in a cell.

Sizing to a maximum of 240 characters
When you size a column to fit the widest entry, 1-2-3 widens the column to a maximum of 240 characters. If your 
widest entry exceeds this limit, 1-2-3 may display only the first 240 characters. No data is lost. When you click the cell
containing the widest entry, all the data appears in the contents box. 

{button ,AL(`H_SIZING_COLUMNS_USING_THE_INFOBOX_STEPS',1)} Go to procedure



Sizing rows using the InfoBox
You can use the InfoBox to size rows to a particular number of points or to fit the tallest font in the row.
Want the big picture?    See Overview: Sizing columns and rows.
1. Select at least one cell in each row you want to size.
2. From the Range menu, choose Range Properties.

3. Click the Basics tab in the InfoBox.

4. To set the height in points, select "Height" and click the arrows or enter a number in the "Height" box.
5. To size the row to its tallest entry, select "Fit largest font."
6. (Optional) Move, collapse, or close the InfoBox.

{button ,AL(`H_SIZING_ROWS_USING_THE_INFOBOX_DETAILS',1)} See details
{button ,AL(`H_SIZING_COLUMNS_STEPS;H_SIZING_COLUMNS_USING_THE_INFOBOX_STEPS;H_SIZING_R

OWS_STEPS;H_FITTING_THE_TALLEST_ROW_ENTRY_STEPS;',0)} See related topics



Details: Sizing rows using the InfoBox
Setting row height
The Basics tab in the InfoBox has options for setting the row height.

• Height -- Sets row height in points from 0 (zero) to 255 points. When you set the row height to a specific number 
of points, it no longer adjusts automatically to match the largest font in the row.

• Fit largest font -- Adjusts each row in the selected range to fit the largest font in the row or to fit the alignment 
orientation selected in the InfoBox Alignment tab.

How changing fonts affects row height
If you change data in a selected range to a smaller font and the rows in the range do not contain any data in a larger 
font, the row height decreases according to the new font height. Row height, however, does not decrease to less than
the default font size set for the sheet.
When you change row height, the heights of fonts in the row do not change.

Hiding and displaying rows
Setting row height to 0 hides the row. For information about displaying hidden rows, see Displaying hidden rows.

{button ,AL(`H_SIZING_ROWS_USING_THE_INFOBOX_STEPS',1)} Go to procedure



Fitting the widest column entry
You can use the mouse to change column width to fit the widest entry in the column.
Want the big picture?    See Overview: Sizing columns and rows.

 Show me a QuickDemo
1. Position the mouse pointer on the column border to the right of the column letter.

2. Double-click the border.
Tip If a column contains both text and numbers and you want to size it to fit the widest numerical entry, 
SHIFT+double-click the column border. You can also click the column letter to select the column, then right-click and 
choose Fit Widest Number from the shortcut menu.

{button ,AL(`H_FITTING_THE_WIDEST_COLUMN_ENTRY_DETAILS',1)} See details
{button ,AL(`H_FITTING_THE_TALLEST_ROW_ENTRY_STEPS;H_SIZING_COLUMNS_STEPS;H_SIZING_ROWS

_STEPS;H_WRAPPING_DATA_IN_A_CELL_STEPS;',0)} See related topics



Details: Fitting the widest column entry
Another way to fit the widest column entry
You can click the column letter to select the entire column, then right-click and choose Fit Widest Entry from the 
shortcut menu.

Sizing to a maximum of 240 characters
When you size a column to fit the widest entry, 1-2-3 widens the column to a maximum of 240 characters. If your 
widest entry exceeds this limit, 1-2-3 may display only the first 240 characters. No data is lost. When you click the cell
containing the widest entry, all the data appears in the contents box.

Sizing several columns at once
To fit the widest entry in more than one column at once, select the columns you want to size and double-click the right
border of one of them. Each selected column adjusts to fit its widest entry.

Related SmartIcons

 Sizes columns to fit the widest entries in the current selection

{button ,AL(`H_FITTING_THE_WIDEST_COLUMN_ENTRY_STEPS',1)} Go to procedure



Fitting the tallest row entry
You can use the mouse to change row height to fit the tallest font in the row.
Want the big picture?    See Overview: Sizing columns and rows.
1. Position the mouse pointer on the bottom border of the row.

2. Double-click the border.

{button ,AL(`H_FITTING_THE_TALLEST_ROW_ENTRY_DETAILS',1)} See details
{button ,AL(`H_SIZING_ROWS_USING_THE_INFOBOX_STEPS;H_FITTING_THE_WIDEST_COLUMN_ENTRY_S

TEPS;H_SIZING_COLUMNS_STEPS;H_SIZING_ROWS_STEPS;',0)} See related topics



Details: Fitting the tallest row entry
Another way to fit the tallest row entry
You can click the row number to select the entire row, then right-click and choose Fit Largest Font from the shortcut 
menu.

Sizing several rows at once
To fit the tallest entry in more than one row at once, select the entire rows you want to size and double-click the 
bottom border of one of them. Each selected row adjusts to fit its tallest entry. 
Sizing rows to fit their tallest entry adjusts each row in the selected range to fit the largest font in the row or to fit the 
alignment orientation specified on the Alignment tab in the InfoBox.

{button ,AL(`H_FITTING_THE_TALLEST_ROW_ENTRY_STEPS',1)} Go to procedure



Overview: Working with Internet connections
Using 1-2-3, you can open any workbook from an FTP (File Transfer Protocol) or a Web (World Wide Web)  server 
via the Internet. You can also save a workbook to an FTP server and publish a range on a Web page.

Getting setup
Before you can open or save a workbook on the Internet:

• Your computer and the server must both be connected to the Internet.
• Your computer must have a WinSock-compatible TCP/IP stack installed.
• The server must meet one of the following criteria:

• The server must be a public Web server.
• The server must support anonymous FTP.
• The server must support FTP and you must have an account with permission to access files.

Opening a workbook
When you open a workbook that resides on the Internet, 1-2-3 copies the workbook to your workstation where you 
can make changes. To write the changes to the FTP server, you must save the modified workbook to the Internet. 
You must also have Write permission to an FTP server to save changes.
You can maintain a list of addresses to FTP servers that you use often. You can also add, edit, or delete FTP 
connection information.

Accessing a server
Access to FTP servers can be anonymous or require a user ID and password. You can access an FTP server directly
or via a firewall (proxy server). 
Most companies use a proxy server as an intermediary between their local area networks and the Internet to prevent 
unauthorized users from accessing the network. If you are using an Internet service provider, you typically will not use
a proxy.

Connecting to a server automatically
If you regularly connect to the same server, you can set Internet options so that you automatically connect to that 
server when opening or saving a file on the Internet. You can also capture a transaction record of the date, time, and 
full path from which a file was copied when you open a workbook.

Tracking Internet messages
For each Internet connection, a log is kept of the messages sent to and from the Internet server. The log file is called 
LTSNET.LOG and is stored in the operating system's temporary directory. 1-2-3 maintains only a log of the most 
recent connection. Each time you connect to a server, the previous file is overwritten.

{button ,AL(`H_123_ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS;H_123_ADDING
_EDITING_OR_SETTING_A_DEFAULT_PROXY_STEPS;H_123_CONFIGURING_INTERNET_OPTIONS_STEP
S;H_123_CONNECTING_TO_LOTUS_CUSTOMER_SUPPORT_STEPS;H_123_CONNECTING_TO_THE_LOTU
S_FTP_SITE_STEPS;H_123_CONNECTING_TO_THE_LOTUS_HOME_PAGE_STEPS;H_123_CONNECTING_
TO_THE_LOTUS_REF_LIB_STEPS;H_123_EDITING_CONNECTION_INFORMATION_FOR_INTERNET_HOST
S_STEPS;H_123_OPENING_A_DOCUMENT_FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS;H_123_
OPENING_A_DOCUMENT_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_123_PUBLISHING_A_
RANGE_STEPS;H_123_SAVING_A_DOCUMENT_TO_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_123
_SEARCHING_INTERNET_STEPS;H_123_WEB_BUTTON_STEPS;H_123_SPECIFYING_PROXY_INFORMATI
ON_STEPS;',0)} See related topics



Connecting to the Lotus home page
1. Choose Help - Lotus Internet Support.
2. Choose Lotus Home Page.

{button ,AL(`;H_123_CONNECTING_TO_LOTUS_CUSTOMER_SUPPORT_STEPS;H_123_CONNECTING_TO_TH
E_LOTUS_FTP_SITE_STEPS;H_123_CONNECTING_TO_THE_LOTUS_REF_LIB_STEPS',0)} See related 
topics



Connecting to Lotus Customer Support
1. Choose Help - Lotus Internet Support.
2. Choose Lotus Customer Support.

{button ,AL(`;H_123_CONNECTING_TO_THE_LOTUS_FTP_SITE_STEPS;H_123_CONNECTING_TO_THE_LOTU
S_HOME_PAGE_STEPS;H_123_CONNECTING_TO_THE_LOTUS_REF_LIB_STEPS',0)} See related topics



Connecting to the Lotus FTP site
To open a document from or save a document to the Lotus FTP server. 
1. Choose Help - Lotus Internet Support.
2. Choose Lotus FTP Site.

{button ,AL(`;H_123_CONNECTING_TO_LOTUS_CUSTOMER_SUPPORT_STEPS;H_123_CONNECTING_TO_TH
E_LOTUS_HOME_PAGE_STEPS;H_123_CONNECTING_TO_THE_LOTUS_REF_LIB_STEPS',0)} See related 
topics



Connecting to the Lotus SmartSuite Reference Library page
To connect to the Reference Library home page, click the SmartSuite Reference Library icon in the set of Internet 
SmartIcons.

Note If you can't see the set of Internet SmartIcons, choose View - Show Internet Tools.

{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_CONNECTING_TO_LOTUS_C
USTOMER_SUPPORT_STEPS;H_123_CONNECTING_TO_THE_LOTUS_FTP_SITE_STEPS;H_123_CONNEC
TING_TO_THE_LOTUS_HOME_PAGE_STEPS',0)} See related topics



Opening a workbook from a Web server on the Internet
1. From the File menu, choose Open, and then click Internet.

2. Select "Web" as the server type.
Tip If you connect to the Internet using a proxy, click Setup to specify proxy information.

3. Specify the Web page address in the "Address" box.
4. Click Open.

{button ,AL(`H_123_OPENING_A_DOCUMENT_FROM_A_WEB_SERVER_ON_THE_INTERNET_DETAILS',1)} 
See details

{button ,AL(`H_123_OPENING_A_DOCUMENT_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS;H_123_
WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_SPECIFYING_PROXY_INFORMATION_STEPS;'
,0)} See related topics



Details: Opening a workbook from a Web server on the Internet
Server type
Enables you to select either "Web" (World Wide Web) or "FTP" (File Transfer Protocol).

Address
Displays a list of previously used Web page addresses.

{button ,AL(`H_123_OPENING_A_DOCUMENT_FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS',1)} Go to
procedure



Opening a workbook from an FTP server on the Internet
To open a document from an FTP server, you must first connect to the server.
1. From the File menu, choose Open, and then click Internet.

2. Select "FTP" as the server type.
3. Select an FTP server in the "FTP servers" box.

Tip If you want to connect to a server which is not on the list, click Setup to display the FTP Hosts tab of the 
Internet Setup dialog box, where you can define additional servers.
Note If you are specifying setup information for the first time, 1-2-3 displays the Internet Setup Assistant to help 
you get started.

4. To automatically connect to this server each time you open or save a file to the Internet, select “Auto-connect to 
this server next time.”

5. Click Connect.
1-2-3 connects to the server you specified. You can stop the connection process by clicking the Stop button. 
When the connection is successful, the Open from Internet dialog box expands to display the server’s directory 
tree, so you can select a file to open.

6. Specify the name of the file you want to open in the “File name” box.
7. Specify the type of file you want to open in the “Files of type” box.
8. Click Open.

{button ,AL(`H_123_OPENING_A_DOCUMENT_FROM_AN_FTP_SERVER_ON_THE_INTERNET_DETAILS',1)} 
See details

{button ,AL(`;H_123_OPENING_A_DOCUMENT_FROM_A_WEB_SERVER_ON_THE_INTERNET_STEPS;H_123_
ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS;H_123_WORKING_WITH_INTER
NET_CONNECTIONS_OVER;',0)} See related topics



Details: Opening a workbook from an FTP server on the Internet
Server type
Enables you to select either "Web" (World Wide Web) or "FTP" (File Transfer Protocol).

FTP servers
Lists the FTP servers you have defined connection information for. 

Auto-connect to this server next time
If you select this option, 1-2-3 automatically connects to this server whenever you open or save a file to the Internet. 
This server is the default server, and “(Default)” displays next to its name in the "FTP servers" box. You can only 
select one default server at a time.

Look in
Displays the current directory on the server. This option does not appear unless you have specified connection setup 
information.

Current Path
Displays the selected path on the FTP server, including all lower level directories. This option does not appear unless 
you have specified connection setup information. The box below the current path displays the available subdirectories
and files in the current directory. This option does not appear unless you have specified connection setup information.

File name
Specifies the name of the file you want to open. This option does not appear unless you have specified connection 
setup information.

Files of Type 
Lists the available file types. Select a file type to see that type of file in the directories and files box. This option does 
not appear unless you have specified connection setup information.

{button ,AL(`H_123_OPENING_A_DOCUMENT_FROM_AN_FTP_SERVER_ON_THE_INTERNET_STEPS',1)} Go 
to procedure



Saving a workbook to an FTP server on the Internet
To save a document to an FTP server, you must first connect to the server. Then you can specify the directory to save
the file in, and the file name. If this is the first time you have connected to the Internet, click Setup to display the 
Internet Setup Assistant. The assistant will walk you through the process of specifying information about the FTP 
server to which you want to connect and provide other information needed to connect to the Internet.
1. From the File menu, choose Save As, and then click Internet.
2. Select an FTP server to connect to from the "FTP servers" box.

Tip  If you want to connect to a server which is not on the list, click Setup to display the FTP Hosts tab of the 
Internet Setup dialog box, where you can define additional servers.
Note If you are specifying setup information for the first time, 1-2-3 displays the Internet Setup Assistant to help 
you get started.

3. To automatically connect to this server each time you open or save a file to the Internet, select “Auto-connect to 
this server next time."

4. Click Connect.
1-2-3 connects to the server you specified. You can stop the connection process by clicking the Stop button. 
When the connection is successful, the Save to Internet dialog box expands to display the server’s directory tree, 
so you can select a directory and file name.

5. Specify the directory you want to save the file to in the “Save in” box.
6. Specify the name of the file you want to save in the “File name” box.
7. Specify the format you want to use to save the file in the “Save as type” box.
8. Click Save.

{button ,AL(`H_123_SAVING_A_DOCUMENT_TO_AN_FTP_SERVER_ON_THE_INTERNET_DETAILS',1)} See 
details

{button ,AL(`;H_123_PUBLISHING_A_RANGE_STEPS;H_123_WORKING_WITH_INTERNET_CONNECTIONS_OV
ER;H_123_ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS;H_123_APPS_ODYSS
EY_AND_123_STEPS;',0)} See related topics



Details: Saving a workbook to an FTP server on the Internet
FTP servers
Lists the FTP servers you have defined connection information for. 

Auto-connect to this server next time
If you select this option, 1-2-3 automatically connects to this server whenever you open or save a file to the Internet. 
This server is the default server, and “(Default)” displays next to its name in the "FTP servers" box. You can only 
select one default server at a time.

Save in
Displays the current directory on the server.

Current Path
Displays the selected path on the FTP server, including all lower level directories. This option does not appear unless 
you have specified connection setup information. 
The box below the current path displays the available subdirectories and files in the current directory. This option 
does not appear unless you have specified connection setup information.

File name
Specifies the name of the file you want to save.

Files of type 
Lists the available file types. Select the format you want to use to save the file.

{button ,AL(`H_123_SAVING_A_DOCUMENT_TO_AN_FTP_SERVER_ON_THE_INTERNET_STEPS',1)} Go to 
procedure



Internet Setup: FTP Hosts panel
You can add, edit, or delete FTP connection information.

Choose a task
Adding connection information for FTP hosts
Deleting connection information for FTP hosts
Editing connection information for FTP hosts



Adding connection information for FTP hosts
Before you can connect to an FTP host, you must add the connection information to access it.
1. From the File menu, choose Internet, and then choose Setup.
2. Click the FTP Hosts tab.
3. Enter a description name for the host in the "Host description" box.
4. Enter the address, port, and other connection information.
5. Click Save.
6. To specify information for additional hosts, click New and repeat steps 3-5.
7. Click OK.

{button ,AL(`H_123_ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_EDITING_CONNECTION_INF

ORMATION_FOR_INTERNET_HOSTS_STEPS;H_123_DELETING_CONNECTION_INFORMATION_FOR_INTE
RNET_HOSTS_STEPS;H_123_SPECIFYING_PROXY_INFORMATION_STEPS;',0)} See related topics



Details: Adding connection information for FTP hosts

Host description
Type a name to identify the FTP server. This can be any name you want.

Host address
Type the address of the FTP server on the Internet. Typically, the address is specified in three parts, separated by 
periods, with the first part of the address being ‘ftp’. For example, ftp.lotus.com.

Port
Type the port the server uses to communicate. In most cases, you can accept the default option.

Initial directory
FTP servers have a directory structure much like that of your computer. Specify the starting directory you want to use 
when you connect to the server.

User ID
Type the User ID which was assigned to you to access the FTP server. User ID’s are typically case sensitive, so 
make sure to use correct capitalization.

Anonymous FTP
If you do not have a specific user ID to access the FTP server, you can probably access the server using anonymous 
FTP. The anonymous user name typically can read files from certain directories on the server, and usually cannot 
write files to the server.
If you select this option, the user ID is automatically changed to "anonymous."

Password
Type the password which was assigned to you to access the server. Passwords are typically case sensitive, so make 
sure to use correct capitalization. If you selected "Anonymous FTP," you should use your e-mail address as the 
password, for example mailuser@company.com.

Save Password
If you want to save the password information with the information about this server, select Save Password. The 
password will be stored from session to session; however, this means that anyone using your computer can access 
the ftp site. If you want the password remembered for this session of 1-2-3 only, deselect this option.

Use Proxy
Most companies use a proxy server as an intermediary between their local area networks and the Internet to prevent 
unauthorized users from accessing the network. A proxy is sometimes known as a firewall. If you are using an 
Internet service provider, you typically will not use a proxy.

If you use a proxy to access the Internet, select this option.

Passive
If the FTP server you are connecting to is a passive server, it does not provide any information about its directory 
structure to the computer connected to it, and does not provide any confirmation that commands issued to it are 
correct. If this is a passive server, select this option.

{button ,AL(`H_123_ADDING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS',1)} Go to 
procedure



Deleting connection information for FTP hosts
1. From the File menu, choose Internet, and then choose Setup.
2. Click the FTP Hosts tab.
3. Choose an Internet host from the "Host description" box.
4. Click Delete.
5. Click Yes to confirm the message.
6. Click OK.

{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_ADDING_CONNECTION_INFO
RMATION_FOR_INTERNET_HOSTS_STEPS;H_123_EDITING_CONNECTION_INFORMATION_FOR_INTERN
ET_HOSTS_STEPS;H_123_SPECIFYING_PROXY_INFORMATION_STEPS;',0)} See related topics



Editing connection information for FTP hosts
1. From the File menu, choose Internet, and then choose Setup.
2. Click the FTP Hosts tab.
3. Choose a host from the "Host description" box.
4. Make any changes to the connection information.
5. Click Save.
6. Click OK.

{button ,AL(`H_123_EDITING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_ADDING_CONNECTION_INFO

RMATION_FOR_INTERNET_HOSTS_STEPS;H_123_DELETING_CONNECTION_INFORMATION_FOR_INTER
NET_HOSTS_STEPS;H_123_SPECIFYING_PROXY_INFORMATION_STEPS;',0)} See related topics



Details: Editing connection information for FTP hosts

Host description
Type a name to identify the FTP server. This can be any name you want.

Host address
Type the address of the FTP server on the Internet. Typically, the address is specified in three parts, separated by 
periods, with the first part of the address being ‘ftp’. For example, ftp.lotus.com.

Port
Type the port the server uses to communicate. In most cases, you can accept the default option.

Initial directory
FTP servers have a directory structure much like that of your computer. Specify the starting directory you want to use 
when you connect to the server.

User ID
Type the User ID which was assigned to you to access the FTP server. User ID’s are typically case sensitive, so 
make sure to use correct capitalization.

Anonymous FTP
If you do not have a specific user ID to access the FTP server, you can probably access the server using anonymous 
FTP. The anonymous user name typically can read files from certain directories on the server, and usually cannot 
write files to the server.
If you select this option, the user ID is automatically changed to "anonymous."

Password
Type the password which was assigned to you to access the server. Passwords are typically case sensitive, so make 
sure to use correct capitalization. If you selected "Anonymous FTP," you should use your e-mail address as the 
password, for example mailuser@company.com.

Save Password
If you want to save the password information with the information about this server, select Save Password. The 
password will be stored from session to session; however, this means that anyone using your computer can access 
the ftp site. If you want the password remembered for this session of 1-2-3 only, deselect this option.

Use Proxy
Most companies use a proxy server as an intermediary between their local area networks and the Internet to prevent 
unauthorized users from accessing the network. A proxy is sometimes known as a firewall. If you are using an 
Internet service provider, you typically will not use a proxy.

If you use a proxy to access the Internet, select this option.

Passive
If the FTP server you are connecting to is a passive server, it does not provide any information about its directory 
structure to the computer connected to it, and does not provide any confirmation that commands issued to it are 
correct. If this is a passive server, select this option.

{button ,AL(`H_123_EDITING_CONNECTION_INFORMATION_FOR_INTERNET_HOSTS_STEPS',1)} Go to 
procedure



Typing a password
Whether you're accessing a remote system or confirming an FTP Host password, you need to enter the appropriate 
password to continue.
1. Enter the password.
2. Click OK.



Open from Internet dialog box
You can open any workbook from an FTP (File Transfer Protocol) or a Web (World Wide Web) server via the Internet.
When you open a workbook on the Internet, 1-2-3 copies the workbook to your workstation where you can make 
changes. 

Choose a task
Opening a workbook from an FTP server on the Internet
Opening a workbook from a Web server on the Internet



Searching for text on the Internet
You can search the Internet for text you have entered in a 1-2-3 cell. 1-2-3 will automatically launch your browser and
do a search of Yahoo! for the selected text.
1. Select the cell containing the text you want to search for.
2. Click the Search Internet icon in the set of Internet SmartIcons. 

Note If you can't see the set of Internet SmartIcons, choose View - Show Internet Tools.

{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;',0)} See related topics



Getting started with the Internet Setup Assistant
Before you can open a file from or save a file to the Internet, you must provide information about the FTP server(s) 
you want to use and information about your Internet connection. 1-2-3 simplifies the process by providing a series of 
dialog boxes for you to enter all the necessary information. Once you have completed the information requested in 
the dialog boxes, 1-2-3 will try to connect to the Internet using the information you provided.

Click Next to get started.



Configuring FTP server settings
When you use FTP to open a file from or save a file to the Internet, you communicate with a server which manages 
the process. You must provide information about the server you want to use in order to make the connection. You can
get the required information from your system administrator or from the person or organization in charge of the FTP 
server you want to use.

1. Enter a descriptive name for the server you want to access in the “Host description" box.

2. Enter the server’s address in the “Host address” box, and the port in the “Port” box.

3. Specify any additional information about the FTP server you want to use.

4. Click Next to configure proxy settings.

{button ,AL(`H_123_CONFIGURING_FTP_SERVER_SETTINGS_DETAILS',1)} See details



Details: Configuring FTP server settings

Host description
Type a name to identify the FTP server. This can be any name you want.

Host address
Type the address of the FTP server on the Internet. Typically, the address is specified in three parts, separated by 
periods, with the first part of the address being ‘ftp’. For example, ftp.lotus.com.

Port
Type the port the server uses to communicate. In most cases, you can accept the default option.

Initial directory
FTP servers have a directory structure much like that of your computer. Specify the starting directory you want to use 
when you connect to the server.

User ID
Type the User ID which was assigned to you to access the FTP server. User ID’s are typically case sensitive, so 
make sure to use correct capitalization.

Anonymous FTP
If you do not have a specific user ID to access the FTP server, you can probably access the server using anonymous 
FTP. The anonymous user name typically can read files from certain directories on the server, and usually cannot 
write files to the server.
If you select this option, the user ID is automatically changed to "anonymous."

Password
Type the password which was assigned to you to access the server. Passwords are typically case sensitive, so make 
sure to use correct capitalization. If you selected Anonymous FTP, you should use your e-mail address as the 
password, for example mailuser@company.com

Save Password
If you want to save the password information with the information about this server, select Save Password. The 
password will be stored from session to session, however, this means that anyone using your computer can access 
the ftp site. If you want the password remembered for this session of 1-2-3 only, deselect this option.

Use Proxy
Most companies use a proxy server as an intermediary between their local area networks and the Internet to prevent 
unauthorized users from accessing the network. A proxy is sometimes known as a firewall. If you are using an 
Internet service provider, you typically will not use a proxy.

If you use a proxy to access the Internet, select this option.

Passive
If the FTP server you are connecting to is a passive server, it does not provide any information about its directory 
structure to computer connected to it, and does not provide any confirmation that commands issued to it are correct. 
If this is a passive server, select this option.

{button ,AL(`H_123_CONFIGURING_FTP_SERVER_SETTINGS_STEPS',1)} Go to procedure



Configuring proxy settings
A proxy server is used as a bridge between a local area network and the Internet. It prevents unauthorized users from
accessing the network. 1-2-3 did not detect a proxy server was being used by your Internet browser program. If you 
connect to the Internet through an Internet service provider such as America Online or AT&T, this is probably correct. 
If you connect to the Internet through your company’s local area network, it probably uses a proxy server. You can 
check with your system administrator to make sure.

1. If you connect to the Internet through a proxy server, select “Connect through a proxy server.” If you connect 
directly, deselect this option, and skip steps 2-3.

2. Enter the address used for the proxy server. You can get the address from your system administrator.

3. Enter the port used to access the proxy server. You can typically accept the default option here.

4. Click Next to connect to the Internet.



Connecting to the Internet
You have completed all the information necessary to connect to the Internet. 1-2-3 will use this information to 
complete the connection. To change this information or add additional FTP hosts, choose File - Internet - Setup at 
any time.

• Click Back to review or change the information you provided.

• Click Save to save the information about the FTP host and proxy for use in future 1-2-3 sessions.

• Click Connect to connect to the Internet, and display the Open from Internet or Save to Internet dialog box.



Changing proxy settings
When you installed 1-2-3, it detected that your default browser uses a proxy to connect to the Internet. A proxy is a 
computer which sits between your company’s local area network and the Internet, and prevents unauthorized access.
The information about the proxy server was copied to 1-2-3, and that information will be used when you connect.

You can view or change this information if you want. You may want to do this if your computer has multiple ways of 
connecting to the Internet.

•  To view or change proxy settings, click Edit Proxies.

•  To continue with Internet setup, click Next.



Specifying proxy information
Most companies use a proxy server as an intermediary between their local area networks and the Internet to prevent 
unauthorized users from accessing the network. A proxy is sometimes known as a firewall. If you are using an 
Internet service provider, you typically will not use a proxy. For guidance using proxies, see your system 
administrator.
1. From the File menu, choose Internet, and then choose Setup.
2. Click the Proxies tab.
3. Specify the HTTP proxy settings.
4. Specify the FTP proxy settings.
5. Click OK.

{button ,AL(`H_123_SPECIFYING_PROXY_INFORMATION_DETAILS',1)} See details
{button ,AL(`H_123_WORKING_WITH_INTERNET_CONNECTIONS_OVER;H_123_ADDING_CONNECTION_INFO

RMATION_FOR_INTERNET_HOSTS_STEPS;',0)} See related topics



Details: Specifying proxy information
HTTP proxy settings

• Connect through a proxy server - If you connect to the Internet through a proxy server, select “Connect through a 
proxy server.” 

• HTTP proxy address - Type the address of the HTTP server on the Internet. Typically, the address is specified in 
three parts, separated by periods, with the first part of the address being "http." For example, http.lotus.com.

Type the port the server uses to communicate. In most cases, you can accept the default option.
• Secure proxy address - The address and port number for a secure proxy server. This information is automatically 

pre-filled from your default browser.
• Advanced - You can specify locations on the Internet or on an Intranet that should not use the proxy information 

you specified for HTTP proxy address. You can also specify a user ID and password for HTTP connections. If you
are not using a proxy to access Web pages, do not complete the information in this dialog box. For more 
information, see Setting advanced HTTP connection options

FTP proxy settings
• Connect through a proxy server - If you connect to the Internet through a proxy server, select “Connect through a 

proxy server.” 
• FTP Proxy address - Type the address of the FTP server on the Internet. Typically, the address is specified in 

three parts, separated by periods, with the first part of the address being "ftp." For example, ftp.lotus.com. This 
information is automatically pre-filled from your default browser.

Type the port the server uses to communicate. In most cases, you can accept the default option.

{button ,AL(`H_123_SPECIFYING_PROXY_INFORMATION_STEPS',1)} Go to procedure
{button ,AL(`H_123_SETTING_ADVANCED_HTTP_CONNECTION_OPTIONS_STEPS',0)} See related topics



Setting advanced HTTP connection options
These options enable you to specify locations on the Internet or on an intranet that should not use the proxy 
information you specified for HTTP proxy address. You can also specify a user ID and password for HTTP 
connections. If you are not using a proxy to access Web pages, do not complete the information in this dialog box.
1. From the File menu, choose Internet, and then choose Setup.
2. Click Proxies.
3. Select "Connect through a proxy server" under HTTP proxy settings and specify the proxy information.
4. Click Advanced.
5. Specify HTTP proxy exceptions.
6. Specify HTTP proxy settings.
7. Click OK to close the HTTP Advanced Options dialog box.
8. Click OK to close the Internet Setup dialog box.

{button ,AL(`H_123_SETTING_ADVANCED_HTTP_CONNECTION_OPTIONS_DETAILS',1)} See details
{button ,AL(`H_123_SPECIFYING_PROXY_INFORMATION_STEPS;H_123_WORKING_WITH_INTERNET_CONNE

CTIONS_OVER;',0)} See related topics



Details: Setting advanced HTTP connection options
The first time you connect to the Internet, 1-2-3 attempts to obtain the correct proxy information from your default 
Web browser. If you are able to open documents using your browser, the default settings are correct. 
Ask your system administrator for the correct settings to use in this dialog box.

HTTP proxy exceptions
You can specify Web sites that do not need to be accessed through a proxy. You can also specify that a proxy server 
not be used for intranet addresses.

Do not use a proxy server for
Specify Web site addresses that do not need to be accessed through a proxy server. For multiple sites, separate 
each site address with a semicolon.

Do not use proxy server for local (intranet) addresses
When you select this option, 1-2-3 does not use the proxy server to access sites on a local intranet. When you 
deselect this option, 1-2-3 does use the proxy server for intranet addresses.

HTTP proxy settings
• Host - Displays the current proxy for HTTP connections.
• Port - Displays the current port number used for HTTP connections.
• User ID - Enter the user ID that has access to the proxy server.
• Password - Enter the password for access to the proxy server.
• Save Password - Saves the password you type and automatically uses the new password when accessing Web 

pages. If you do not select this option, the password you type is used for the current 1-2-3 session only.

{button ,AL(`H_123_SETTING_ADVANCED_HTTP_CONNECTION_OPTIONS_STEPS',1)} Go to procedure



Opening a Notes file attachment from within 1-2-3
You can open file attachments stored in documents in a Lotus Notes database without leaving 1-2-3. You must use a 
32-bit version of Notes 4.5 or higher.
1. Choose File - Open.

2. Click Lotus Notes.
3. From the "Look in" or "Available Servers" box, select the server which contains the Notes database you want to 

access. The database can be either on your local hard drive or on a server to which you have access.
You can also click the "Add/Modify Notes Servers" icon to add a remote Notes server.

If prompted, enter your Lotus Notes password and then click OK.
4. From the "Available Servers" list, select the database that contains the Notes document you want to open. 

To choose a database located in a different directory, click Browse.
5. Select the Notes document that contains the file attachment you want to open. You must select the view in which 

the document appears and then the document in that view.
Tip Click the "+" to expand the appropriate database, view, and document category. (Not all views contain 
document categories.)

6. In the "File name" box, specify the attached file that you want to open. 
7. Click Open.

{button ,AL(`H_123_OPENING_A_WORKBOOK_FROM_A_NOTES_DATABASE_DETAILS',1)} See details
{button ,AL(`H_123_OPEN_FROM_NOTES_DB_OVER;H_OPTIONS_OPEN_FILE_REF;H_CREATING_AND_OPE

NING_FILES_OVER;H_SPECIFYING_A_FILE_OVER;',0)} See related topics



Details: Opening a Notes file attachment from within 1-2-3
Look in
Lists all available Lotus Notes servers.

Up One Level

Click this icon to move the current display up one level in the hierarchy. For example, if you have a Notes document 
selected, pressing this button selects the view or category that contains the document. If you have a Notes view 
selected, pressing this button selects the database that contains the view.

Add/Modify Notes Server

Click this icon to display the Add/Remove Servers dialog box.

Properties

Click this icon to display the properties for the selected file attachment.

Refresh

Click this icon to refresh the currently selected item. For example, if you have a Notes document selected, pressing 
this button refreshes the list of attachments contained within that document.

List/Details

Click these icons to toggle the display between items in an abbreviated list format and more detailed information 
about the servers, databases, documents, or attachments. For example, the Details view displays the file name, size, 
type, and last modified date for attachments.

File name
Type the Notes file attachment name in the "File name" box or select the server, database, document, and file in the 
"Available Servers" box. 

Files of type
Select the type of file you want to open. You do not have to specify an extension unless you are importing the file. You
can open the following types of files:

• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)
• Excel (.XLS, .XLT, .XLW)
• Quattro Pro (.WQ1, .WB1, .WB2)
• dBASE (.DBF)
• Paradox (.DB)

1-2-3 opens the file attachment in a separate window. 

Browse
Displays a Browse dialog box where you can specify a local Notes databases not stored in your Notes data directory.

{button ,AL(`H_123_OPENING_A_WORKBOOK_FROM_A_NOTES_DATABASE_STEPS',1)} Go to procedure



Saving a file to a Notes database
You can save files as attachments to documents in Lotus Notes databases. You must use a 32-bit version of Notes 
4.5 or higher.
1. Choose File - Save As.

2. Click Lotus Notes.
3. From the "Look in" or "Available Servers" box, select the server which contains the Notes database you want to 

access. The database can be either on your local hard drive or on a server to which you have access.
You can also click the "Add/Modify Notes Servers" icon to add a remote Notes server.

If prompted, enter your Lotus Notes password and then click OK.
4. From the "Available Servers" list, select the database that contains the Notes document in which you want to save

the file. 
To choose a database located in a different directory, click Browse.

5. Select the Notes document in which you want to save the file. You must select the view in which the document 
appears and then the document in that view.
Tip Click the "+" to expand the appropriate database, view, and document category. (Not all views contain 
document categories.)

6. Attach the file to a Notes document in one of the following ways:
• Double-click the "New" document icon and select a Notes form and field for the file attachment.

• Type a name for the attachment in the "File name" box and click Save.
• Select an existing file attachment and click Save. Click Yes to overwrite the existing file.

{button ,AL(`H_123_SAVING_A_WORKBOOK_TO_A_NOTES_DATABASE_DETAILS',1)} See details



Details: Saving a file to a Notes database
Look in
Lists all available Lotus Notes servers.

Up One Level

Click this icon to move the current display up one level in the hierarchy. For example, if you have a Notes document 
selected, pressing this button selects the view or category that contains the document. If you have a Notes view 
selected, pressing this button selects the database that contains the view.

Add/Modify Notes Server

Click this icon to display the Add/Remove Servers dialog box.

Properties

Click this icon to display the properties for the selected file attachment.

Refresh

Click this icon to refresh the currently selected item. For example, if you have a Notes document selected, pressing 
this button refreshes the list of attachments contained within that document.

List/Details

Click these icons to toggle the display between items in an abbreviated list format and more detailed information 
about the servers, databases, documents, or attachments. For example, the Details view displays the file name, size, 
type, and last modified date for attachments.

File name
Type the Notes file attachment name in the "File name" box or select the server, database, document, and file in the 
"Available Servers" list. 

Files of type
Select the type of file you want to save. You can save the following types of files:

• Lotus 1-2-3 Workbook (.123, .WK4, .WK3, .WK1, .WT4)
• Lotus 1-2-3 SmartMaster Template (.12M)
• Text (.TXT, .PRN, .CSV, .DAT, .OUT, .ASC)
• Excel (.XLS, .XLT, .XLW)
• Quattro Pro (.WQ1, .WB1, .WB2)
• dBASE (.DBF)
• Paradox (.DB) 

Browse
Displays a Browse dialog box where you can specify a local Notes databases not stored in your Notes data directory.

{button ,AL(`H_123_SAVING_A_WORKBOOK_TO_A_NOTES_DATABASE_STEPS',1)} Go to procedure



Selecting a Notes form and field
Use the Save to Lotus Notes dialog box to attach a file to a new Notes document.
1. From the Save to Lotus Notes/Domino dialog box, double-click the New icon.

2. Select the form for the Notes document from the "Form" box.
3. From the "Field in which you want to save the file" box, select where you want to save the file attachment.

Note The field you select must be a Rich Text Field (.rtf).
4. To add text into a field on the Notes form, click Other Fields.
5. Type the name for the file attachment in the "File name" box.
6. To save the document as a different file type, select the desired format in the "Save as type" box.
7. Click Done.

{button ,AL(`H_123_SELECTING_FORM_AND_FIELD_INFORMATION_DETAILS',1)} See details
{button ,AL(`H_123_SAVE_TO_NOTES_DB_OVER;H_123_SAVING_A_WORKBOOK_TO_A_NOTES_DATABASE_

STEPS',0)} See related topics



Details: Selecting a Notes form and field
Form
Select the form you want to save your file attachment into. 1-2-3 lists all of the forms available in the selected 
database.

Field in which you want to save the file
Select the field into which you want to save the attachment. 1-2-3 lists all of the rich text fields available for the 
selected form.

File name
Type a name for the file attachment.

Save as type
Select the type of file you want to save.

Other Fields
Allows you to select local Notes databases not stored in your Notes data directory.

{button ,AL(`H_123_SELECTING_FORM_AND_FIELD_INFORMATION_STEPS',1)} Go to procedure



Adding information for other fields
You can enter information into text fields in the Notes document before you save the attachment. 1-2-3 lists all 
available fields in the "Non-computed text fields" box.
1. Select the field into which you want to enter information.
2. Type the information in the "Text to display in selected field" box.
3. Repeat steps 1 - 2 for any additional fields.
4. Click Done to return to the Save to Lotus Notes dialog box.
5. Click Done.



Choosing a Notes database
Use the Browse dialog box to select the database which contains the Notes document you want to access.
1. From the "Files of type" box, select the file type you want.

The default is the Notes database file type.
2. From the "Look in" box, select the directory containing the database you want.
3. Select the database name from the list.
4. Click Open.

{button ,AL(`H_123_OPEN_FROM_NOTES_DB_OVER;H_123_OPENING_A_WORKBOOK_FROM_A_NOTES_DA
TABASE_STEPS;H_123_SAVE_TO_NOTES_DB_OVER;H_123_SAVING_A_WORKBOOK_TO_A_NOTES_DAT
ABASE_STEPS',0)} See related topics



Adding or removing servers
By default, all Notes servers on your local network display in your list of available Lotus Notes servers. If you want to 
display only certain Notes servers in your list, complete the following steps.
1. Deselect "Always include local servers in my server list."
2. To remove servers from your list, select the server in the "My Server List" box and click Remove.

To remove all servers from your list, click Remove All.
3. To add servers to your list, select the server in the "Local Notes servers" box and click Add.

Note The Add button is available only if you deselect "Always include local servers in my server list."
4. To add Notes servers that are not part of your local network, click Other.
5. Click OK.



Adding other servers
Use the Add Other Server dialog box to add a server that is not part of the local Lotus Notes network.
1. Enter the name of the Notes server in the "Server" box.
2. Click OK to return to the Add/Remove Servers dialog box.

If the server is available, it will be added to your list of available Lotus Notes servers.



Viewing attachment properties
Use the Attachment Properties dialog box to review information about the currently selected Notes file attachment.

File
The name of the file attachment.

Length
The size of the file attachment.

Created
The date the file attachment was created.

Modified
The most recent date the file attachment was modified.



Sheet
A sheet is an electronic spreadsheet consisting of a grid of 256 columns and 65,536 rows.

• Letters identifying each column appear in the sheet frame above each column.
• Numbers identifying each row appear in the sheet frame to the left of each row. 



title bar 
Displays the name of the current workbook and other information. When you highlight a command, the title bar 
displays a description of the command. You can move the 1-2-3 window by dragging the title bar.
The title bar also contains the window control buttons.



Overview: Parts of the 1-2-3 window

Tip Click the Maximize button  in the top right corner of the Help window to see the whole illustration.
In the sample 1-2-3 window below, each number identifies a different part of the window. To learn about each part, 
find the same number below the picture and click the text to display a description.

1. Title bar 7. SmartIcons    13. New Sheet button 
2. Menu bar 8. Sheet tab 14. Horizontal splitter
3. Selection indicator 9. Sheet frame 15. Scroll bar 
4. Navigator 10. Current cell 16. Vertical splitter 
5. @Function selector 11. Sheet 17. Status bar 
6. Contents box 12. Sheet scroll arrows 

{button ,AL(`H_THE_INFOBOX_OVER;H_SHEETS_OVER;H_USING_THE_STATUS_BAR_OVER;',0)} See related 
topics



@Function selector
Displays the @function menu. Select an @function from the menu to insert it in a cell. You can add your most-used 
@functions to the menu.



Close button
Closes the active window.



Column
Click the column letter to select the whole column. 



Contents box
Lets you edit the contents of a cell. Click in the contents box to start editing. After you finish, press ENTER or click the 
Confirm button:

To abandon an edit, press ESC or click the Cancel button: 

The Confirm and Cancel buttons appear only when you enter or edit data in the contents box.



Navigator
Displays the list of named ranges in the current workbook.



Selection indicator
Displays the address or name of the current selection. 



Horizontal splitter
Drag to divide the sheet into horizontal panes.



Maximize/Restore button

Maximizes the active window. If the window is already maximized, the Restore button appears .



Menu bar
Contains the commands you use with 1-2-3. Some commands in the menu change depending on the current 
selection.



Minimize button
Reduces the active window to an icon.



New Sheet button
Inserts a new sheet.



Row
Click the row number to select the whole row.



Scroll arrow
Click the scroll arrows to move within a window.



Scroll bar
Click the scroll arrows or drag the scroll box to move within a window.



Scroll box
Drag the scroll box to move within the window.



Current cell
The cell pointer marks the current cell with an outline. 



Sheet letter
Selects all cells in a sheet.



SmartIcons
SmartIcons are shortcuts for many tasks in 1-2-3. Choose File - User Setup - SmartIcons Setup to customize 
SmartIcons.



Sheet scroll arrows
Click the arrows to scroll left or right to sheet tabs not in view.



Alignment 
Changes the alignment of the current selection.



Status bar
The bar along the bottom of the 1-2-3 window. The status bar displays buttons that let you perform different tasks. For
example, you can change fonts, color, alignment, number format, fill pattern, and so on. 



Bold
Adds bold to the current selection. Click again to remove bold.



Background color
Changes the background color of the current selection.



Font color
Changes the font color of the current selection.



Font name
Displays a list of fonts that you can apply to the current selection.



Point size
Changes the point size of the current selection.



Italic
Adds italic to the current selection. Click again to remove italic.



Number format 
Changes the number format of the current selection. Click to display the list of frequently-used number formats.



Decimal places
Changes the number of decimal places for the current selection.



Mode indicator
Shows what mode 1-2-3 is in. For example, Point mode indicates you are selecting a range to work with; Edit mode 
indicates you are changing cell contents.



Named style
Displays a list of named styles that you can apply to the current selection. 



Underline 
Adds an underline to the current selection. Click again to remove underline.



Sheet tabs
Click the tabs to move from sheet to sheet.



Vertical splitter
Drag to divide the sheet into vertical panes.




